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Welcome!
Welcome to TextMaker! You have purchased a word processor that combines user-friendliness with powerful
features at a highly affordable price! TextMaker will enable you to complete your writing tasks quickly and
easily.

Note: This manual was written in order to describe how to use the program via the new ribbon user
interface. A description of its use via classic menus with toolbars can only be found in older manuals.

Tip: A table in the appendix shows you which ribbon command corresponds to which menu command:
Ribbon commands and corresponding menu commands

Some features of TextMaker

§ Available for Windows, Mac, Linux, Android and iOS 

§ Well-designed, ergonomic user interface – either with a modern "ribbon" or classic menus with toolbars

§ Practical document templates for creating new documents, such as pre-designed letterheads and flyers, in
no time

§ Advanced paragraph formatting such as automatic numbering, bullets, borders, shadows and patterns

§ Paragraph and character styles that enable you to apply your favorite formatting to text at the touch of a
button

§ Desktop publishing (DTP) features such as "master pages", drop caps, small caps, kerning, adjustable
character spacing and pitch

§ Embedding of pictures in numerous file formats, extensive drawing functions, TextArt module for font
effects

§ Document scanning – scanning via WIA is also supported in addition to TWAIN

§ Powerful table functions, including computational functions

§ File manager with search functions

§ Tables of contents and indexes, footnotes, outline view  (outliner)

§ Excellent spell check and hyphenation, large thesaurus

§ Integrated address book (database)

... and much more!

TextMaker is being developed continually. If, when working, you discover the need for a feature that is not yet
available, or if you have any other suggestions, please contact us as we want TextMaker to meet the needs of
users!
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Additional features in SoftMaker Office Professional and NX Universal

The even more powerful SoftMaker Office Professional and SoftMaker Office NX Universal include an
advanced version of TextMaker which offers the following additional features:

§ Duden Korrektor from Dudenverlag (spell check, hyphenation, grammar check) 

§ Research function – for looking up selected terms directly on online platforms

§ Read aloud – have the texts in your document read aloud to you

§ Finalize removes personal information from documents

§ Compress pictures compresses inserted pictures to reduce the size of the file

§ QR code/Barcode – generate your own QR codes or linear barcodes

Only available in SoftMaker Office NX Universal

§ Translation of documents into numerous languages using DeepL 

§ SmartChat – use the artificial intelligence of ChatGPT in TextMaker to create and edit AI-based texts

Android version and iOS version: Unlock locked commands

TextMaker is also available for Android and iOS devices and contains virtually all features of the Windows
version.

Some commands are locked in the Android/iOS version (recognizable by the lock in the command icon), but
they can be unlocked if necessary.

To unlock the commands, click on the command icon. The program opens a dialog box with the following
options: Users of SoftMaker Office NX Home and NX Universal can use their product key to unlock
commands. Users of other versions have the option of unlocking the features via Google Play/Apple App Store
(subject to a fee).
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Technical support
If you have any questions, our technical support team will be happy to assist you. You can reach us as follows:

Website

Our website provides the latest program updates, tips and tricks, free downloads and much more.

For more information, see: www.softmaker.com

Support forums

In our support forums, you can ask our technical support team any technical questions you may have, while also
communicating with other users.

These forums can be found at: forum.softmaker.com

Inquiries to our support team

If you have any problems with our software, we will happily assist you.

You can post your questions here: www.softmaker.com/en/support/customer-support

About this manual
TextMaker has a wide variety of functions – but don't worry: you don't have to master all of them! While you're
getting started, just use those you need. If you would like to make use of TextMaker's more advanced functions
at a later stage, you can still read the relevant pages in the manual.

This manual is structured as follows:

§ The chapter Installation and program startup deals with the installation of TextMaker. You also learn
how to start the program. 

§ The chapter Application window describes the individual components of TextMaker's main window.

§ The chapter Basics provides information on TextMaker's most important functions. It is ideal for beginners!

§ The chapter The TextMaker tour deals with the subject of text editing in tutorial form and shows you how
to use TextMaker by means of some practical examples.

§ The chapter Working with selections and the following chapters are the reference part of this manual.
These chapters are organized by subject and provide a detailed description of all functions of TextMaker.

https://www.softmaker.com/
https://forum.softmaker.com
https://www.softmaker.com/en/support/customer-support
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System requirements
In order to run this software, you require the following hardware and software:

Windows version

§ Windows 11, 10, 8 or 7 (32-bit or 64-bit) 

Mac version

§ macOS as of version 10.14 (Mojave) 
§ Intel or ARM-based CPU

Linux version

§ Any x86 Linux (64-bit) 

Android version

§ Android 9.0 or higher 
§ ARM-compatible CPU (32-bit or 64-bit)

iOS version

§ iOS 14.0 or higher 
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Installation and program startup
This chapter provides information on installing and starting TextMaker.

It is divided by operating system into the following sections:

§ Installing on Windows 

§ Installing on macOS

§ Installing on Linux

§ Installing on Android devices

§ Installing on iOS devices

Please read the section for your operating system.

Installing on Windows

Download

If you obtained the software by downloading it from our website, you will find installation instructions in the e-
mail that you automatically received after purchasing the software.

CD-ROM

If you obtained the software on a CD-ROM, please start the installation program provided in the root folder of
the CD. Then follow the installation program's instructions to install the software.

Starting the programs

To start the installed programs, use the Start menu (the button with the Windows logo) in the lower left corner
of the screen. You will find your SoftMaker Office applications in a sub-folder called SoftMaker Office.

Entering address upon initial start: When you start TextMaker for the first time, you will be asked to enter your name, address, phone number, etc. This
information is not used for registering the program. It is in fact required by TextMaker in order to automatically personalize the supplied document
templates for letters. You can always change this information at a later stage. For more information, see Settings, General tab.
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Installing on macOS
You will find information about installing the software in the e-mail that you automatically received after
purchasing it.

Is an error message displayed when you start the installation program?

Depending on your system settings, the following error message may be displayed when you try to start the
installation program:

This occurs when your system's security settings specify that only programs that have been downloaded from
the App Store may be run.

Clicking on the question mark in the upper right corner of the message reveals how you can still run the
installation program. You then see a help window in which the following procedure is recommended:

1. Close the error message.

2. Hold down the Ctrl key and click on the installation program.

3. A context menu is displayed. Choose the command Open.

4. You then see a message which asks you if you really want to open the program. Confirm this by clicking on
the Open button.

The installation program will now start.

Starting the programs

After the installation is complete, icons for each of the installed programs will be displayed in both the
Launchpad and the Dock at the bottom of the screen. To start one of the programs, simply click on its icon.
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Installing on Linux
You will find information about installing the software in the e-mail that you automatically received after
purchasing it.

Starting the programs

In most Linux distributions, the installation program automatically creates shortcut icons for all SoftMaker
Office applications in the menu. To start any of the applications, click on the corresponding icon.

Alternatively, the following scripts are available for starting the programs:

§ textmaker24 starts TextMaker. 

§ planmaker24 starts PlanMaker.

§ presentations24 starts Presentations.

You can execute these scripts in a shell, for example.

Entering address upon initial start: When you start TextMaker for the first time, you will be asked to enter your name, address, phone number, etc. This
information is not used for registering the program. It is in fact required by TextMaker in order to automatically personalize the supplied document
templates for letters. You can always change this information at a later stage (see Settings, General tab).

Installing on Android devices
If you download an application to your Android device via the Google Play Store, you don't need to do
anything, as the application will be automatically installed immediately after downloading it.

Installing on iOS devices
If you download an application to your iOS device via the Apple App Store, you don't need to do anything, as
the application will be automatically installed immediately after downloading it.
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Application window
The following pages contain an introduction to the individual components of the TextMaker user interface, both
for the ribbon interface and for the classic menu interface.

In all other chapters, this manual is designed for the user interface with the ribbon.

If you would like to continue working with the classic menu interface, a table in the appendix shows you
which ribbon command corresponds to which menu command: Ribbon commands and corresponding menu
commands.

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu). On the Appearance
tab, click on the User interface button.

Alternatively: Right-click on a free space in the ribbon or toolbar, and choose User interface.

Program window with the "Ribbon" user interface

TextMaker with the "Ribbon" user interface (Windows version)
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Tip: Even when using the ribbon user interface, the classic menu commands are always accessible in the

ribbon view. To access them, use the "hamburger menu" (the icon  to the left of the Quick access toolbar,
highlighted in red). There, you will find all familiar menu commands from the classic menu user interface.

Program window with the "Classic menus" user interface

TextMaker with the "Classic menu" user interface (Windows version)

Note: Most of the illustrations in this manual were produced with the Windows version of TextMaker. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Title bar
In the top line of the program, you will find the title bar.

This displays the program name and the name of the document that you are currently editing.
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If the document contains changes that have not yet been saved, an asterisk is displayed after its name.

User interface: Ribbon
If, in the settings, you have selected that you would prefer to use the Ribbon interface instead of Classic menus,
the upper area of the program window will look like this on your device:

The "Ribbon" (section) and the Quick access toolbar (below)

The ribbon

Ribbons are a modern type of user interface that combines menus and toolbars to simplify the use of the
software.

As you can see, the ribbon has several tabs whose tab headers are displayed at the top: File, Home, Insert, etc.
Each of these "ribbon tabs" contains logically combined groups (for example, on the ribbon tab Home: Edit,
Character, Paragraph, etc.) with related commands for a certain task area.

To switch to another ribbon tab, click on its tab header.

Tip: You can also switch between the ribbon tabs with a shortcut key: Use Ctrl+F12 to move to the next tab
and Ctrl+Shift+F12 to move to the previous tab. You can also scroll with the middle mouse wheel while
pointing to the top bar with the tabs.

Each icon represents a specific command. If you click on it, the corresponding command is chosen. In the group
Character on the ribbon tab Home, for example, you will find commands for formatting texts, such as font,
bold, italics, etc., which you can both read and change.

If you select a section of text beforehand, formatting changes will affect only the selected text. Otherwise, the
text that you subsequently type will be affected.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons are switches that you can enable or disable by clicking on them – for example, the B for bold.

There are also split buttons, where you can either click on the icon to directly apply the displayed command or
use the corresponding small arrow to the right of the icon to open its dropdown menu. This is the case, for
example, when choosing the font color.
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Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a text box called
a "tooltip", which describes the icon's function. This requires Show tooltips to have been enabled in the
settings.

The group arrows  in the bottom right corner of each command group indicate that there are other options and
commands available for that group. Simply click on this arrow to open the dialog box belonging to the group,
where you can make further settings.

The Quick access toolbar

The Quick access toolbar is displayed below the ribbon. It provides a choice of frequently used commands.

§ Touch mode 

If you enable this button, all icons in the ribbon will be slightly enlarged. This is useful when operating the
software with your finger (for example, on a tablet).

§ Dark/light document mode 

Switch between the usual white or a dark display of the document pages.

§ Create a new file 

This button opens a new document. For more information, see Starting a new document.

§ Open a file

This button opens an existing document. For more information, see Opening a document.

§ Save file 

This button saves the document that is open in the current window. For more information, see Saving a
document.

§ Undo 

This button undoes the last change made to the current document. You can also choose this command
several times in succession to undo the last x changes. For more information, see Undoing changes.

§ Redo 

This button restores the last undone change(s). For more information, see Undoing changes.

§ Object mode 

Switch between edit and object mode to make it easier to edit either text or objects. For more information,
see Object mode.

To the right of the Quick access toolbar, there is a double arrow . You can use its menu to add/remove
common buttons directly from the Quick access toolbar. You can also change the position of the Quick access
toolbar here and add additional icons via the command Customize (for Quick access toolbar and ribbon, see
below).

To the left of the Quick access toolbar, you will find the "hamburger-menu" . Even if you have selected
the "ribbon" as the user interface, the "hamburger menu" is still available in the Quick access toolbar in case
you would like to access the menu commands of the classic menu interface.
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Creating your own ribbon and Quick access toolbar

You can change the ribbon and the Quick access toolbar at will and add additional icons. To do so, either
choose File | Customize in the ribbon or right-click on a free space in the ribbon. In the following menu, you
will find the entries Customize ribbon or Customize Quick access toolbar to open a corresponding dialog box.

You can also hide the ribbon display completely (Minimize ribbon) or change the position of the Quick access
toolbar.

For more information, see Customizing the ribbon.
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User interface: Classic menus
If, in the settings, you have selected that you would prefer to use Classic menus instead of the Ribbon interface,
the upper area of the program window will look like this on your device:

Classic menus with toolbars (section)

The menu bar

The Menu bar is found directly under the title bar.

It contains all of TextMaker's commands in the form of clearly arranged menus. Click on a menu item to open a
menu and choose a command.

The Standard toolbar

The Standard toolbar is displayed below the menu bar. It contains icons for TextMaker's most frequently used
commands.

Toolbars such as the Standard toolbar enable quick access to the functions of a program. Each icon represents a
specific command. If you click on it, the corresponding command is chosen.

Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a tooltip that
describes the icon's function. This requires Show tooltips to have been enabled in the settings.

The Formatting toolbar

The Formatting toolbar can be found below the Standard toolbar. You can use it to both read and change the
most common text formatting (font, bold, italics, etc.).

If you select a section of text beforehand, formatting changes will affect only the selected text. Otherwise, the
text that you subsequently type will be affected.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons in the Formatting toolbar are switches that you can enable and disable by clicking on them – for
example, the B for bold.
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There are also split buttons, where you can either click on the icon to directly apply the displayed command or
use the corresponding small arrow to the right of the icon to open its dropdown menu. This is the case, for
example, when choosing the font color.

Additional toolbars

There are additional toolbars in TextMaker that you can enable and disable as you choose. To do so, either
choose the menu command View > Toolbars or right-click on one of the displayed toolbars. You then see a
menu in which you can select toolbars that you would like to have displayed.

Customizing toolbars

You can customize the default toolbars to your liking and even create your own toolbars. For more information,
see Customizing toolbars.
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User interface on Android/iOS
In addition to the ribbon and classic menus user interfaces, the Android/iOS version provides another option:
the toolbars user interface.

The toolbars interface is designed in a manner that makes it easier to use TextMaker on smartphones and
tablets. It constitutes a mixed form of the functionalities of ribbon and classic menus. On smartphones,
TextMaker is started by default with this toolbars interface the first time you open it, while it is opened by
default with the ribbon interface on tablets.

To switch the interface, choose the command File | Options  in the ribbon interface or choose Tools >
Options in the classic menu interface. In the following dialog box, the Appearance tab contains the dropdown
list User interface. Here, you can choose between toolbars, ribbon or classic menus with different colors.

Tip 1: In the toolbars interface, you reach this dialog box by opening the "hamburger menu"  to the left of
the toolbar and choosing the command Tools > Options.

Tip 2: The hamburger menu also contains all other menu commands of the classic menu interface.

Using the "toolbars" user interface

The toolbars user interface contains a bar with icons at the bottom of the program window, and each icon
represents a group of commands. If you click on a group icon, another bar opens with the corresponding group
commands.

Behind the File group icon , for example, you will find the commands Open document, Save document,
Print document, etc. To hide the displayed bar with the commands, simply click on the group icon again.

By default, the toolbar contains the following groups:

Group Commands (among others)

File Open document, Save document, Print document, etc.

Edit Undo, Format painter, Copy & Paste, Search, etc.

Character Font, Font size, Font color, Text styles (bold, italics, etc.)

Paragraph Line spacing, Paragraph alignment, Bulleted lists, etc.

Insert Objects (picture, table, text frame, AutoShape), Comments, Headers and footers, etc.

Layout Page setup, Chapter formatting, Hyphenation, Align objects, etc.

Review Spell check, Track changes, etc.

View Object mode, Zoom, Ruler, etc.
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"Keyboard" button

In Options , the System tab contains an option Show/hide keyboard automatically. Once this setting is
enabled, it automatically opens the on-screen keyboard when you type something into the document.

If you disable the option, this behavior is suppressed and a freely movable Keyboard button  is displayed
instead on the document. If you click on the button, the keyboard is shown. By clicking on the button again, you
hide the keyboard.

Note: This setting is possible in any user interface for smartphones and tablets. For tablets, the Keyboard button
is only freely movable on the document in the toolbars interface if you disable the above option. In the ribbon
and classic menus interfaces, the Keyboard button is displayed instead in a fixed manner in the upper left area
of the command bar.

For smartphones only: "View" button

TextMaker offers smartphone users an additional aid, the View  button, which is freely movable above the
document.

This enlarges the text section in which the cursor is currently positioned. If you click on this button, TextMaker
switches to edit mode. The enlarging of the section makes it easier for you to track what you are entering. If you
click on the button again, you switch back to the normal view and then have a better overview of the entire
document.

Note: Tablet users can also use this function by disabling "Desktop mode" in Options  (on the Appearance
tab). However, you will then lose the optimized display of TextMaker on your tablet.

Changing input mode

TextMaker supports the use of certain input modes of Android/iOS devices.

§ Android 

The command Input method enables you to switch to a different keyboard mode on an Android device.
TextMaker accesses the on-screen keyboard settings of your Android device for this purpose.

In the classic menus interface, you change the mode with the menu command View > Input method. In the

ribbon or toolbars user interfaces, you can choose this command via the hamburger menu .

§ iOS

If Scribble mode is enabled in TextMaker, you can write directly in a document on an iOS tablet using the
Apple Pencil. Your handwritten entries will then be converted directly into text. For other edits – for
example, those of objects – you have to disable the mode again.

In the classic menus interface, you enable or disable the mode with the menu command View > Scribble. In

the ribbon or toolbars user interfaces, you can choose this command via the hamburger menu .

Note: The command View > Scribble is only available for iOS tablets, but not for smartphones. Please also
ensure that you have enabled the option Apple Pencil > Scribble in the system settings of your iOS tablet.
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Unlocking locked commands

Some commands are locked in the Android/iOS version (recognizable by the lock in the command icon), but
they can be unlocked if necessary.

To unlock the commands, click on the command icon. The program opens a dialog box with the following
options: Users of SoftMaker Office NX Home and NX Universal can use their product key to unlock
commands. Users of other versions have the option of unlocking the features via Google Play/Apple App Store
(subject to a fee).

Customizing command groups

You can customize the default groups as desired by adding/removing commands. Note: However, you cannot
add or delete an entire group in the toolbars user interface.

In the hamburger menu , choose the command Tools > Customize. This opens the dialog box Customize
user interface, which is structured as follows:

§ On the left side, you will find all of the commands that are available in TextMaker. On the right side, the
dropdown list Customize contains the groups that are in the toolbar. The list below it displays the
commands that are currently in the selected group. 

§ You can add new commands to each group (or remove them, change their position or insert separators). This
works in a similar manner to that described for the classic menus with toolbars user interface in the
Customizing toolbar icons section. Difference: Instead of "toolbar icons", you customize "group icons".
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Context menu
Regardless of the user interface in which you work, there is also another way to choose commands: via the
context menu.

This menu contains different commands depending on the current situation. If, for example, you select some
text and then right-click to open the context menu, it offers commands for cutting, copying or formatting that
text.

Depending on what you have previously selected (text, objects, tables, etc.), you will be offered a variable –
contextual – selection of commands when opening the context menu. This makes it much easier for you to
quickly navigate to situational commands without a long search.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen and
hold your finger there for about a second.

Document tabs

Android/iOS: This function is not available for smartphones. For tablets, actions are possible with the tabs
within the same program window.
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A bar with document tabs can be seen above the document. It displays one tab for each open document.

The document tabs bar

The tabs can be used to perform the following actions:

§ To make a document become the active document, left-click its tab. This enables you to rapidly switch
between the open documents. 

§ To close a document, click on its tab with the middle mouse button.

Alternatively, left-click on the x icon displayed on the far right of each tab.

§ You can change the order of the tabs by dragging a tab to the desired position on the tab bar while holding
down the left mouse button. 

§ To release a tab and display it in a separate program window, drag it to a position outside the current
program window while holding down the left mouse button.

Of course, this can also be done in reverse: A program window that has been opened separately can be
dragged into the tab bar of an existing TextMaker program window.

By the way, documents can also be started in a new program window when they are opened. For more
information on working with multiple documents, see Working with multiple documents.

Horizontal ruler
Above the document itself, you will find the horizontal ruler, which is mostly called the ruler later in the
manual. This bar displays the indents and tabs for the current paragraph (or any paragraphs currently selected).

Indents and tabs are not only displayed there, they can also be changed via the mouse. You will learn how to do
this in the sections Indents and Tabs.

Tip: You can enable or disable the ruler in the ribbon interface via the command View | Horiz. ruler  (also
View > Horizontal ruler in the classic menu interface).

Sidebar
The bar on the right (or left) next to the document is called a sidebar. It is a particularly useful tool:

For example, you can use the "Document map"  function in the sidebar to display a list of all headings in a
document in order to navigate better within the document. If you double-click on one of the headings,
TextMaker immediately jumps to the corresponding heading in your document.
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Using the sidebar

Use the small toolbar at the top of the sidebar to select which function should be used in the sidebar (document
map, thumbnail preview, search, paragraph styles, character styles).

You can enable or disable the sidebar at any time:

To do so, choose the ribbon command View | group Windows | Sidebars  (in the classic menu interface:
View > Sidebars) and select the option Show sidebars. If you click on the enabled option again, you disable
the sidebar.

If you choose the command Sidebars  again while the sidebar is enabled, you can use the dropdown menu to
 freely arrange the individual functions in the sidebars to the left or right of the document. (If all functions are
set to Show right, for example, only the right sidebar would then be displayed.)

Tip: When the sidebar is enabled, it can also be collapsed or expanded by clicking on the narrow vertical
button at the edge of the sidebar. To adjust the width of the sidebar, drag the separator between the sidebar
and the document to the left or right with the mouse.

Functions of the sidebar

You can use the small toolbar at the top of the sidebar to choose which function the sidebar should currently
have. The following icons are available (from left to right):

Icon Function

Show document map. For more information, see Navigating with the sidebar.

Page thumbnails to display thumbnails of your current document. See example below.

Search for search terms in the text. For more information, see Searching with the sidebar.

Show, apply and edit paragraph styles. For more information, see Paragraph styles and the sidebar.

Show, apply and edit character styles. For more information, see Character styles and the sidebar.

By clicking on one of these icons, you can change the sidebar function at any time, depending on what you
need.

The toolbar also has a menu that you can expand by clicking on the black arrow to the right of the toolbar. The
menu contains two options that can be used to change the appearance of the toolbar as follows:

§ If you select the option Display as icons, all of the aforementioned functions will be displayed side by side
as icons in the toolbar. 

§ If, on the other hand, you select the option Display as list, only the currently selected function is displayed
at the top instead, but all other functions can be accessed via the dropdown menu.
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Example: The "Page thumbnails" function

The "Page thumbnails" function displays a page overview of the current document with small preview images
(thumbnails) in the sidebar. This gives you a better overview of multi-page documents and enables you to easily
navigate between the pages of a document.

To do so, click on the Page thumbnails icon  at the top of the sidebar.

To jump to a specific page in the document, simply click on the respective preview image in the thumbnail.

Status bar
The Status bar is found at the bottom of the program window.

Note: If you do not see the status bar, you will have to change the settings for it as described in Settings,
Appearance tab (for the ribbon interface) or as described in Showing and hiding toolbars (for the classic
menu interface).

You can read the following information in the status bar:

Example Explanation

Italics,
Textbox1,
etc.

Different information is displayed on the far left. If you hover the mouse cursor over a command icon,
the function of this command is displayed here. If you select an object, its name is displayed here. If you
move or resize an object, the current position/size is displayed, etc.

L 37   Col 8 The text cursor is positioned at line 37 and column 8 on the current page.

Section 1 The text cursor is positioned in section 1 of the document (see Multi-column page layouts).

Chapter 1 The text cursor is positioned in chapter 1 of the document (see Dividing a document into chapters).

Page 1 of 2 The text cursor is positioned on page 1 of a document with a total of 2 pages.

1 page* The text cursor counts 1 selected page. Select multiple pages as desired in order to count the number of
pages in a chosen section.

English The text in which the text cursor is currently positioned (or the currently selected text) is formatted in the
English language (see also Setting the language).

25 words This shows how many words are in the text. If you select text passages, only the selected words are
counted. (If you double-click on the display, the Statistics tab will open with further details)

Table cell If you have inserted a table, the currently selected table cells are displayed here.
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Ins This shows whether Insert mode (Ins) or Overwrite mode (Ovr) is enabled:

Ins: Insert mode is enabled – newly entered text will be inserted in front of existing text.

Ovr: Overwrite mode is enabled – newly entered text will be written over existing text.

The default setting is Ins. You can use the Ins key on your keyboard to switch between these two modes
(or by clicking on the Ins/Ovr display).

The Ins key can also be disabled. For more information, see Settings, General tab.

* This information is not displayed in the status bar by default. However, you can add this button to your own customized user interface. To do so, select
the "Count pages" button and add it to the status bar or another area (see "Tip: Configuring the status bar" below).

Tip: For certain display elements of the status bar, contextual dialog boxes open when you double-click with
the left mouse button.

Further elements of the status bar

§ Screen display 

On the right side of the status bar, there are also some buttons for displaying the document on the screen:

These buttons enable you to quickly switch between standard view, continuous view, master page view,
outline view and book layout, which you can also customize on the ribbon tab View (in the classic menu
interface: in the View menu). For more information, see Customizing the document display.

§ Zoom level 

The status bar also contains a zoom slider that allows you to change the zoom level for the document:

To do so, either drag the slider with your mouse or click on the plus or minus icon (see Zoom level).

Tip: Configuring the status bar

If you click on the double arrow  on the far right of the status bar, you will find the following options:

§ You can use the option Add/remove buttons to show or hide the individual preset elements of the status
bar. 

§ The option Customize opens the dialog box Customize user interface, where you can freely configure the
status bar from all commands available in TextMaker.

In the dialog box, select the item "Status bar" in the list Customize (top right). You can then add or remove
buttons from the status bar and change their order. For more information, see Customizing icons and groups
in the ribbon.

§ Reset this toolbar restores all changes made to the status bar back to their original state.
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Basics
This chapter provides a brief description of TextMaker's most important basic functions.

We recommend that you then take the TextMaker tour in the next chapter, which will guide you step by step
through the program by means of practical examples.

Note: Most of the illustrations in this manual were produced with the Windows version of TextMaker. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Entering text
When you start TextMaker, an empty document is opened automatically. Thus, you can start entering text
immediately.

Note: Once you have finished writing a line, do not press the Enter key¿ to start a new line. TextMaker
automatically transfers the last word in a line to the next line when there is not enough space for it.

You should press the Enter key¿ only in the following cases:

§ at the end of a paragraph 
§ to insert blank lines 

Thus, let TextMaker take care of line breaks within a paragraph.

Moving the text cursor
While editing text, you always see a blinking line. This is called the text cursor. When you type something, the
letters always appear where this text cursor is positioned.

You can move the text cursor anywhere between the beginning and end of the text. The direction keys on the
keyboard are provided for this purpose. For example, the arrow keys ß and à move the text cursor one
character to the left or right respectively.

Overall, the following direction keys are available for moving the text cursor:

Key Function

ß One character to the left
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à One character to the right

á One line up

â One line down

Home To the beginning of the line

End To the end of the line

Ctrl+á To the beginning of the current paragraph or, when pressed again, to the previous paragraph

Ctrl+â To the next paragraph

Ctrl+Home To the beginning of the document

Ctrl+End To the end of the document

Apart from that, you can also click on any part of the text with your mouse to position the text cursor there.

Android/iOS: In these versions, you can also simply tap on the desired position with your finger.

Deleting text
All users make typos occasionally and want to delete them again. TextMaker enables you to do so via numerous
options:

Deleting characters: To delete a character, use the Backspace keyÕ situated above the Enter key¿. This key
deletes the character to the left of the text cursor. The following text moves back automatically.

You can also delete in the opposite direction with the Del ("Delete") key. It deletes the character to the right
rather than to the left of the text cursor.

Deleting word on the right: If you place the cursor before the first letter of a word and then press Ctrl+Del, the
entire word is deleted. If the text cursor is positioned in the middle of the word, this key combination deletes
only the letters following the cursor to the end of the word.

The key combination Ctrl+BackspaceÕ works analogously for words to the left of the cursor.

Deleting a carriage return: You can remove a carriage return that was inserted by mistake. Try it: Type a multi-
line paragraph and then insert a carriage return in the middle of the paragraph by pressing the Enter key¿. The
following text jumps to the next line and the paragraph is divided. This may be done intentionally in certain
cases where a paragraph is too long and must be divided into two paragraphs. Here, however, it was a mistake –
so press the Backspace keyÕ to remove the carriage return.

Deleting long sections of text: The aforementioned delete keys are well suited for removing short sections of text,
but are far too laborious for deleting longer sections of text. For this reason, there is another deletion method
whereby you first select the text and then delete it completely, for example, by pressing the Del key. For more
information, see Working with selections.
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Undoing changes

In the Quick access toolbar, you can use the Undo button  to undo the last changes made to a document. If,
for example, you format text in a different font, all you have to do is choose the command Undo and it will be
undone again.

This not only works for formatting, but for virtually all text changes – for example, you can undo typing or the
deletion of text.

The command Undo can be applied repeatedly if necessary. For example, you can choose it five times to
reverse the last five changes. (Tip: You can set the maximum number of actions that can be reversed in the
Settings, General tab.)

If you click on the small arrow next to the Undo button, you will see a list of recent changes to which you can
revert. If you click on an entry in the list, several steps can be undone at the same time.

Redoing undone actions

There is also a counterpart to the command Undo: the Redo button  on the Quick access toolbar. This
restores the last action you undid. You can thus undo the cancellation of text changes.

This command can also be chosen several times in succession. If, for example, you choose the command Undo
five times, the last five text changes will be undone. If you then choose the command Redo five times, you will
restore the original text.

Again, you can use the small arrow next to the Redo button to select entries from the list of recent actions to
restore multiple steps at the same time.

Insert or overwrite?
Entering text is easy. You move the text cursor to the desired point in the document and start typing.

In TextMaker, Insert mode is enabled by default. If you type a character in this mode, it is inserted into the
existing text and shifts the following text forward.

Alternatively, you can switch to Overwrite mode. In this mode, the text you type overwrites the following text.

The status bar always shows which mode is currently enabled: If "Ins" is displayed there, the insert mode is
enabled. If "Ovr" is shown, you are working in overwrite mode.

You can use the Ins key on your keyboard to switch between these two modes.

Tip: The function of the Ins key can also be disabled for TextMaker. You will find the corresponding option
in the Settings, General tab.
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Starting a new document

To start a new document, choose the command File | New . (Click directly on the icon itself.) Incidentally,
this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see the templates you previously used. For more
information, see "List of document templates used" below.)

Tip: Use the key combination Ctrl+N to quickly open a new document with the current default template,
while skipping the dialog box shown below.

After you click on the File | New icon , the following dialog box appears:

 

The dialog box of the command File | New

If you just want to start a new document without having to deal with document templates at the moment, choose
the default template Normal.tmvx.

Tip: If you hover over a template (without clicking on it), more information about the template will be
displayed. This requires Show tooltips to have been enabled in the settings.

As soon as you confirm with OK , the new document will be created with the selected template.



42Basics

Using document templates

The above dialog box contains the following options:

Template: In addition to the folder of your selected language with the default Normal.tmvx template, you will
see some other folders in the list on the left of the dialog box. These folders contain predefined document
templates for letters and flyers, which you only have to fill in after opening them.

The Favorites folder always contains the default template as well as all "pinned" templates. They are

permanently displayed at the top in the list of the command File | New  for quick access. (For more
information, see the paragraph below "List of document templates used".)

Pinned templates are recognizable by the vertical pin icon . By clicking on the pin icon, you can pin or unpin
a template.

View: The templates can be displayed in the dialog box as small, medium or large preview images in the tile
view. Alternatively, a list view in text form is also possible.

Sort by: You can view the templates sorted by name or by date.

Available languages: Here, you can select the language(s) in which document templates are to be displayed.

Set as default: Change the default template by clicking on a template and then pressing this button. In future, a
new document will always be opened with this template.

For more information on creating your own document templates, see Document templates.

Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in
its own program window. If the option is disabled, the new document will be created with a new tab in the
existing program window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones, a separate program window is always opened, while in the
version for tablets, a new tab is always opened in the same program window.)

List of document templates used

If you click on the small arrow of the File | New button , the program opens a list of previously used
document templates, which you can apply directly:

Default template: The current default template is displayed here. If you just want to select the default
template, you can also click on it here in the list and skip the dialog box.

Unpinned templates: This is displayed if you have already used templates other than the default template. You
can thus use these templates directly from the list for a new document without performing a long search.

If you click on the pin icon  of a template, the status changes to Pinned templates: These are permanently
displayed at the top of the list (and in the Favorites folder of the dialog box, see above). You can unpin the

template by clicking on the pin icon  again.

If you click on the cross icon , you remove an entry completely from the list. The command Delete all
unpinned items deletes all entries from the list – except the pinned templates and the default template.
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The command More will take you again to the dialog box described above.

Opening a document

To open an existing document, choose the command File | Open  by clicking directly on the icon itself.
Incidentally, this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see a list of recently used files. See explanations in the
paragraph "List of recently opened files" below.)

After you have clicked directly on the Open icon , the program will display a dialog box which may look as
follows:

The dialog box of the command File | Open

This dialog box may look slightly different depending on the operating system, but its function always remains
the same. Use this dialog box to tell TextMaker which document to open.

To do so, you could simply type in the name of the file you want to open manually. However, the dropdown list
with the files is more convenient because all files are listed here in the current folder and can be easily selected.
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Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in its
own program window. If it is disabled, the document will be opened with a new tab in the existing program
window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones, a separate program window is always opened, while in the
version for tablets, a new tab is always opened in the same program window.)

Previewing a document

When the option Preview is enabled, a little box displaying a preview of the currently selected document is
displayed to the right of the dialog box.

Opening other file formats

In addition to opening documents created in TextMaker's default file format, you can also open files created
with other word processing applications. All you have to do is select the desired format from the list of file
types.

For more information, see Working with other file formats.

Using Quick paths

You can use the Quick path button to create and choose quick paths in order to quickly switch to a specified
folder when opening or saving files.

For more information, see Quick paths.

File manager

The File manager button opens the integrated file manager. This displays a list of your documents and allows
you to open, print, view or delete them, as well as perform searches.

For more information, see File manager.

List of recently opened files

If you click on the small arrow below the File | Open  button, you will see a list of recently opened files.
Simply click on one of these files to open it again.

In this file list, you can also select the following options:

If you click on the pin icon  of a file, it will appear in the list as a pinned file and will be displayed
permanently at the top of the list. Unpinned files will eventually be removed from the list of recently opened
files if the number of entries exceeds the limit that was set. For more information, see "Recently used files in
the File menu" in Settings, Files tab.
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Click on the pin icon  again to unpin the file or click on the cross icon  to remove an entry from the list.
The command Delete all unpinned items deletes all entries from the list – except the pinned files.

The command Browse documents will take you again to the dialog box described above.

Printing a document
To print the current document, choose the ribbon command File | Print.

The program will display a dialog box in which you can specify the pages and the number of copies to be
printed. The default setting is the printing of one copy of the whole document.

For more information on outputting documents, see Outputting documents.

Saving a document
When you have completed a document, you should save it to retain it permanently. To do so, click on the
ribbon command File | Save.

Tip: This command can also be found by default in the Quick access toolbar below the ribbon.

If the document does not yet have a name, TextMaker automatically prompts you to assign a file name to it
before saving it.

Saving under a different name or in a different location

TextMaker also has a ribbon command called File | Save as. This also saves your document, but you can first
assign it another name or select another folder in which to save it.

Saving in a different file format

You can use the ribbon command File | Save as to also save a document in the file format of another program.
To do so, select the desired format in the list Save as type. For more information, see Working with other file
formats.

Saving all open documents

If you have multiple documents open at the same time, you can use the ribbon command File | Save all to save
all of them at once. TextMaker checks whether the documents have been changed since they were last saved
and saves only those that have been changed.
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Removing personal information before saving ("Finalize")

You can use the ribbon command File | Finalize to remove certain personal data from the document (document
summary, track changes, comments) before saving it if you do not want this data to be visible when sharing the
file with others.

For more information, see Finalize document.

Exiting the application

To exit TextMaker, choose the command File | Close  and then File | Exit . Alternatively, just click on
the X icon on the far right of the title bar or tab.

If one of the open documents has been changed since it was last saved, TextMaker automatically asks you
whether you want to save it before closing it.
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The TextMaker tour
Welcome to the TextMaker tour!

On the next pages, we will introduce you to some of TextMaker's basic functions using practical examples.

When working through the exercises, don't be afraid to experiment with new commands as you become familiar
with them! Even if something goes completely wrong, it won't matter at all. For each new lesson section, we
have provided an example document which you can open and use as the basis for the next section.

Note: Most of the illustrations in this manual were produced with the Windows version of TextMaker. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Sample letter
Are you ready for the first exercise? Then start TextMaker now.

Note: When you start TextMaker for the first time, you will be asked to enter your name, address, phone
number, etc. This information is not used for registering the program. It is in fact required by TextMaker in
order to automatically personalize the supplied document templates for letters. You can always change this
information at a later stage. For more information, see Settings, General tab.

After the program starts, it always displays an empty document in which you can start typing immediately. The
text cursor blinks at the beginning of the document. When you type something, it always appears just behind
the text cursor, which moves forward to accommodate it.

We, at Escher Architects, would first like to start a simple letter. In other words, this letter should not just be
simple, but should also be of professional quality. At the end of this tour, you will have composed a fully-
fledged business letter with all the frills.

You might now be thinking: "This would be a lot easier if I chose the command File | New and selected one of
the prepared letter templates." This is true, of course, but you won't learn anything that way. If you are going to
take this tour, you will have to invest a little time – but then you will master the program's most important
functions and can immediately start adapting the templates to your needs!

Let's get started. First, type something resembling the following sample text. You don't have to copy it exactly
and can enter whatever text you want – the content doesn't matter.

Note: Press the Enter key¿ only at the places in the text that are indicated with the ¿ icon.
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Dear Sir or Madam,¿

¿

This year, we have not only built for you but also for ourselves. The new Escher Complex,
one of the most daring building projects in the country, will become our new home. We

would like to take this opportunity to invite you to our opening ceremony.¿

¿

The celebration will take place next Saturday afternoon at 38-42 Main Street. We will be
catering for your every need in terms of refreshments, and our event program will ensure

that you have an unforgettable afternoon.¿

¿

Bring your family along for a day of fun and entertainment!¿

¿

Typo: If you make a typo, you can delete it immediately by pressing the Backspace keyÕ. This key can be
found above the Enter key¿ on PC and Mac keyboards.

Your document should look something like this:

The finished typed text (For a better overview with minimized ribbon, see Showing and hiding the ribbon.)

We would now like to insert an address above the text of our letter as follows:

To get to the beginning of the document, press the key combination Ctrl+Home.

Then press the Enter key¿ seven times to insert blank lines. This creates space for our own address, which we
will enter later. By the way, you can also remove blank lines that you have inadvertently inserted by pressing
the Backspace keyÕ.

Next, press the á key once to position the text cursor in the blank line above the text of the letter.

Now, type the name and address of the person to whom the letter is to be sent, for example:
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Fred Smith¿

7 Shepherd's Way¿

Winchester Bay, Oregon 77123¿

Finally, insert additional blank lines by pressing the Enter key¿ twelve times to create a space between the
address and the text of the letter.

We have now created the most important elements of a simple letter and would first like to save them.

Saving the sample letter
Note: You will find more information about this topic in Saving a document.

To save a document, choose the command Save  on the ribbon tab File. This command can also be found in
the Quick access toolbar below the ribbon.

Tip: If you hover the mouse cursor over a command icon (without clicking), the program will display an info
text with an explanation of its function. This requires Show tooltips to have been enabled in the settings.
For some commands, a key combination is also displayed in brackets at the end of the info text, for example,
for the command Save (Ctrl+S). This is the shortcut key for this command. This means that you can also press
Ctrl+S to save your document.

Tip for the user interface "Classic menu": Alternatively, you can also use the underlined shortcut keys in the
menus in addition to the other shortcut keys. Type them while holding down the Alt key. To save the file, press
Alt+F for File and then S for Save.

The Save dialog box

Since our document does not yet have a name, the program automatically displays a dialog box that prompts
you to specify the file name when you choose the ribbon command File | Save.

There, type any name for the document in the box File name, or select a name from the file list if you would
like to overwrite an existing file.

Let's name the document Letter. Thus enter "Letter" in the box File name, and click on the Save button or
press the Enter key¿ to confirm your entry. TextMaker saves the file under the specified name and
automatically appends the extension .tmdx. Thus the full file name is Letter.tmdx.

In the following figure, you can see an example of the open dialog box when saving the document for the first
time. You can choose your preferred storage location within the folder structure:
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The next time you choose the command File | Save, the program will no longer display this dialog box because
the document now has a name. It will thus be saved immediately under its name.

You could also have closed the dialog box without saving. To do so, you would have clicked the Cancel button
or pressed Esc instead of Save. This "escape route" is available in all dialog boxes.

Simple formatting
We now come to the more interesting functions – for example, to text formatting, and thus to the use of fonts,
text styles (bold, italics, etc.), indents, etc.

First, we will insert a line with our return address above the address, as is customary for letters that are to be
sent in window envelopes.

Thus, let's position the text cursor two lines above the address (line 5) and type the address of our architecture
firm: You can set common hyphens between the name, street and place.

Escher & Sons, Architects - 78 Baker Street - Atlanta, GA 30009

However, this line is much too wide for the window of a window envelope, and so we would like to decrease
the font size slightly. This brings us to an important topic: selecting.
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First select, then format

Note: For more information on selecting, see Working with selections.

To subsequently change the formatting of a section of text, you must first select it to ensure that TextMaker
knows which area to change.

To select the lines containing the address of our architecture firm, proceed as follows:

Mouse: While holding down the mouse button, drag the mouse cursor from the beginning to the end of the text
you want to select. By the way, there is an easy way to select complete lines. Just click in the margin to the left
of the line. The complete line will be immediately selected.

Keyboard: If you prefer to work with the keyboard, you can select text by moving the text cursor while holding
down the Shift keyñ. In this case, select the address line by positioning the text cursor in front of the first
character via the Home key and then pressing the key combination Shift+â.

Android/iOS: If you are using these versions, please note that selecting text works slightly differently there.
For more information, see Selecting text and objects.

If you have selected the line with the address of the architecture firm, you can change the font size as required.
To do so, search for the command group Character on the ribbon tab Home.

The command group "Character"

Note: For more information about text formatting, see Character formatting and Paragraph formatting.

The font size of the selected text is displayed to the right of the font – a 10 point size is currently set. Click with
the mouse on the arrow to the right of "10". This opens a list of the most common font sizes. Select "8" from
the list.

Now also choose a different font. To do so, click on the arrow to the right of the font and choose the
MicroSquare font from the list. If you have not installed this font, you can choose any other font you like.

The MicroSquare font in 8 point size was set.

Thus, the sender's and receiver's addresses should look something like this:
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When something goes wrong...
Note: For more information about this topic, see Undoing changes.

TextMaker has a very practical feature: With the command Undo  in the Quick access toolbar, you can undo
any number of the last changes made. If, for example, you format text in a different font and then don't like it,
all you have to do is choose the command Undo and it will be undone again.

This not only works for formatting, but for virtually all text changes – for example, you can undo typing or the
deletion of text.

The command Undo can be applied repeatedly if necessary. For example, you can choose it five times to
reverse the last five changes.

By the way, there is also a counterpart to the command Undo: the command Redo  in the Quick access
toolbar. This restores the last action you undid. You can thus undo the cancellation of text changes.

Opening a file
Note: For more information about this topic, see Opening a document.

We will now open the example file Tour1.tmdx that is provided with the program. It contains the current state
of our sample letter. To open a document, choose the ribbon command File | Open.
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Now choose the command by clicking directly on the icon , whereupon a corresponding dialog box is
displayed.

Then switch to the folder with SoftMaker's example documents. Depending on the operating system, you will
find it as follows:

§ Windows: Open the folder SoftMaker\Samples in your Documents folder. 

§ macOS: Open the folder SoftMaker/Samples in your Documents folder.

§ Linux: Open the folder SoftMaker/Samples in your Home directory.

§ Android: Navigate to the folder SoftMaker/Samples on your SD card.

§ iOS: Navigate to the folder SoftMaker/Samples in your app folder.

Locate the Tour1.tmdx file and double-click the file to open it.

Creating a letterhead
Naturally, our letter needs an impressive letterhead, with the company name in a larger font and perhaps a line
that explains what our company has to offer.

Let's get to work! Use Ctrl+Home to move the text cursor to the beginning of the Tour1.tmdx document you
just opened. Now type:

Escher & Sons, Architects¿

Design and Planning of Construction Projects of all Sizes

The company name may appear slightly larger: Select the first line, format it on the ribbon tab Home | group
Character in the MicroSquare font, choose a font size of 32 points and enable bold print.

Is 32 not included in the list of font sizes? If not, it doesn't matter because the list only has the most common
sizes. You can enter values manually at any time. Simply click on the font size, enter "32" and confirm with the
Enter key¿.

You could even specify font sizes with a decimal point (for example, 11.6 points) to fit text exactly into the
available space.

Finally, the command group Character should look as follows:

Font was set to MicroSquare 32 point bold
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We now want to format the second line in MicroSquare 12 point italics. To do so, we must first select this line
as usual. However, do not use the command button to change the font size this time. Instead, click on the group
arrow  in the bottom right corner so that you can try out this method once.

The program opens a dialog box which offers all formatting options for characters at a glance.

The dialog box of the group Character on the ribbon tab Home

Note: For more information on this dialog box, see Character formatting.

The settings in this dialog box are distributed over several tabs. You can switch between them by clicking on
one of the tab headers along the top of the dialog box. As you can see, this dialog box has tabs for Font,
Spacing and Hyperlink. Since we only want to change the font, we can remain on the Font tab.

Open the dropdown list Font by clicking on the little arrow to its right, and choose the MicroSquare font. Then
choose the 12 point font size in the Size list to the right of the font list. Finally, enable italics by opening the
dropdown list Style and choosing the entry "Italic".

Click on the OK button to apply the changed formatting. Then save your document.

Paragraph alignment
Paragraph alignment refers to the manner in which TextMaker arranges text between the margins.
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You can change the paragraph alignment on the ribbon tab Home | group Paragraph.

This contains four icons that you can use to change the alignment via a mouse click:

   Left align paragraph

   Center paragraph

   Right align paragraph

   Justify paragraph

The company name should now be centered. To do so, move the text cursor in front of any character within the
company name "Escher & Sons, Architects" and click on the "Center" icon.

You can also change the paragraph alignment via the dialog box of the command group Paragraph. To do so,
click on the group arrow  in the bottom right corner and a dialog box will be displayed. Open the dropdown
list Alignment on the Paragraph tab. Then choose the desired paragraph alignment from this list.

Note: Paragraph formatting – that is, all formatting that you can perform in the group Paragraph – always
affects complete paragraphs. Thus if you want to change the paragraph format of a single paragraph, you
don't need to select it first, but simply move the text cursor to any position within the paragraph.

If, on the other hand, you want to change the formatting of several successive paragraphs, you must select them
beforehand. The selection may start anywhere within the first paragraph and end anywhere within the last
paragraph.

Let's try this out now. Select the command Undo  in the Quick access toolbar – the company name is then
left-justified again. Starting from any letter in the company name, hold the mouse button down and drag the
selection into the next line. Then click on the "Centered" icon. Both paragraphs will now be centered.

After you have done this, your application screen should look something like this:
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Letterhead in the sample letter (For a better overview with a hidden ribbon, see Showing and hiding the ribbon.)

We could now add "Best regards" to the letter and send it off. However, there are undoubtedly a few more
things that could be done to enhance this letterhead.

So let's start with some fine-tuning.

Tabs
Before going any further, you can open the Tour2.tmdx document and compare it with your results thus far. It
contains the current state of our sample document.

Many business letters include a line with information such as "Your reference", "Your letter of", etc. We want
to insert such a line now and become familiar with the use of tabs in the process.

Note: You insert tabs by pressing the Tab key. Although this key is labeled with two arrows F on most
keyboards, the label Tab is used in this manual in order to distinguish it more clearly from the direction
keys.

Now move the text cursor to the beginning of the 17th line and type the following line:

Your reference:[Tab]Your letter of:[Tab]Our reference:[Tab]Our letter of:[Tab]Date:

Then format this line in the MicroSquare font, 8 point.
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You have now inserted tabs into the text, but you have not yet determined their exact positions. To do so, set
tab stops. By default, TextMaker automatically puts a tab stop every 0.5 inch – but you generally should not
adopt this default setting which stems from the era of typewriters.

Tab stops can be set via the dialog box of the ribbon command Layout | Tabs  (see below) – or directly via
the horizontal rulerdisplayed above the document.

The horizontal ruler

If the ruler is not visible, you must first enable it on the ribbon tab View | Horiz. ruler .

You use the ruler to set tab stops as follows:

1. Select the paragraph in which the tab stops are to be set.

If you want to set up the tab stops for multiple paragraphs, you must first select these paragraphs as
previously described.

With respect to our example, please now select the line you just entered and the line below it because we
want the subsequent tab stops for the next line to be set in the same manner.

2. Choose the desired tab type.

To do so, click on the icon to the left of the horizontal ruler. Each time you click on the icon, the tab type
changes. The following types are available:

Left-aligned tab

Centered tab (the text is centered at the tab position)

Right-aligned tab (the text ends at the tab position)

Decimal tab (numbers are aligned to the decimal point)

Click on this icon now until Left tabs are chosen.

3. Click on the desired tab positions in the ruler.

Use the mouse to click on the ruler at the (approximate) positions of 1 inch, 3 inches, 4 inches and 5.5
inches in order to set tab stops at those positions. Note how the text is aligned accordingly.

By the way, you could have proceeded in the opposite manner: You could have defined the tab stops before you
typed the line "Your reference", etc., and then typed the text along with the tabs.

The ruler and text should now look something like this:
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The tab stops are now set and are displayed in the ruler.

If you don't like the position of a tab stop, you can move it directly in the ruler. If necessary, select the
paragraphs to be changed; then point at the tab stop with your mouse held down and drag it to a new position in
the ruler. Note: If you drag a tab stop downward out of the ruler, it will be deleted.

There is yet another way to proceed when setting tab stops.

Leave the two paragraphs selected and click on the Tabs icon  on the ribbon tab Layout | group Paragraph.
A dialog box opens and shows you the exact positions of the tab stops that are currently set. This dialog box is
handled as follows:

Action Procedure

Set new tab stops Enter the desired position in the field Tab. Click on Set.

Delete tab stops Select one of the existing tab stops in the list and click on Clear. To remove all tab
stops at once, click on Clear all.

Shift tab stops Delete the tab stop and set a new one.

Change the alignment Click on one of the existing tab stops in the list, choose a new alignment with
Alignment and click on Set.

Let's go back now to our sample letter:

Now that the tab stops for the line "Your reference", etc., and the line under it have been set, we want to enter
something in the second line.

Move the text cursor to the beginning of this line (L 18) and type, for example, the following:

MB[Tab]1/23/23[Tab]HG[Tab]1/17/23

Since this line was selected along with the line above it when the tab stops were set, you see that the same tab
stops are used here also.

What is still missing, of course, is today's date. We will let TextMaker insert it automatically in the next section
and thus enable you to become familiar with a very practical feature of TextMaker, namely the fields.
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Inserting the date and other fields
Today's date should be inserted in the area below "Date", which has remained empty up until now. However,
we don't want to type it manually, as we would rather leave this task to TextMaker.

To do so, press the Tab key again behind what you just entered in order to reach the correct position.

Then click on the small arrow next to the Field icon on the ribbon tab References | group Fields (alternatively,
Insert | group Text). The program opens the following dropdown menu:

In the dropdown menu, point with the mouse to the entry Date and time fields and another menu level will be
displayed. Click on the field Print date here.

Note: If you want to specify the format of the inserted date, you can open a dialog box with additional
options for fields by clicking directly on the Field icon . For more information, see Fields.

TextMaker now inserts the current date into the text, and the letterhead looks something like this:
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Fields are very practical aids. On the one hand, you have just saved yourself the trouble of manually typing the
current date. In addition, the field "Print date" is not a set value, but symbolizes the current date instead. It is
automatically updated when you print the document. Thus if you print the sample letter tomorrow, tomorrow's
date will appear in the same place.

Fields not only enable you to insert the date, but also allow your document's current page number or file name
to be output – and much more.

Furthermore, fields can be used to insert database fields from a database, as is required for a mail merge.

Footers
Before proceeding, you can open the Tour3.tmdx file. It contains the current state of the sample document.

You can set up headers and footers for each document – headers will be printed at the top and footers at the
bottom of each page.

For footers, click directly on the Footer icon  on the ribbon tab Insert. The cursor is set in the bottom page
margin. This is the area in which you can enter footers.

A contextual ribbon Header and Footer is now displayed, but we won't deal with that here, and thus switch
back to the ribbon tab Home instead.
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This time, we will select the MicroSquare font in 8 point before typing. Thus, set this font on the ribbon tab
Home | group Character. If text is entered now, it will appear immediately in the selected font.

For example, type the address of our architecture office as a footer. Under the address, you can also specify
such information as bank details, managing director, commercial register entry, etc. Of course, you don't have to
strictly follow the example if it is too much typing for you:

Escher & Sons, Architects - 78 Baker Street - Atlanta, GA 30009¿

Telephone: 555-555-4242 - Fax: 555-555-4243

First select and then center both footers with the icon  on the ribbon tab Home | group Paragraph so that
the footers ultimately look as follows on the screen:

To get back to the normal text after setting up the footers, simply click on any position in the text with the
mouse. If you subsequently want to edit the footers again, all you have to do is click again with the mouse on
one of the footers.

Give it a try: In the text, click on the line under "Bring your family along..." – and you will be back in the text.

This gives us an opportunity to place the complimentary close under the last line of the text. Enter a blank line
there with ¿ and type:

With best regards,¿

¿

¿

¿

M.C. Escher¿

Escher & Sons, Architects¿

This in fact completes our letter. In the last section, we would just like to insert a line above the footer to
emphasize it better.
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Inserting a separator above the footer
Note: For more information about this topic, see Borders and lines.

In a letter, a line is often drawn between the footer and the body text.

On the ribbon tab Home | group Paragraph, you will find the Borders button . This allows you to add a
complete border or individual border lines to the left, right, top or bottom of a paragraph.

To insert a border line above the footer, set the cursor in the first line of the footer. On the ribbon tab Home,
click on the black arrow next to the Borders icon for the dropdown menu and select Top.

The paragraph should now be displayed with a thin black line above it.

Normal text paragraphs can be furnished with lines via the same method as for footers. This also works for
some types of objects, such as table cells.

Inserting fold marks
You can now also insert fold marks into your document to fold the printout of the letter in the right places by
means of two small lines in the page margin.

On the ribbon tab Layout | group Page setup, click on the group arrow  in the bottom right corner and switch
to the Fold marks tab in the following dialog box:
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In the Tri-fold section, enable the option Show fold marks. This makes two marks in the document for
subsequent folding (one upper and one lower mark).

In the list below, select the option Three equal-sized parts. Explanation for the other two options DIN type A
and DIN type B: These options are mainly of interest to users who adhere to the DIN standards that are
common, for example, in Germany.

In the Pages list, the option Show fold marks on chapter's first page is already preset appropriately.
Explanation: The fold marks are thus only displayed on the first page of the document. Other settings (e.g. fold
marks on all pages) are, of course, also possible here.

Then confirm the insertion of the fold marks with OK.

Tip: You can also insert a central bi-fold mark as a mark that can be used as a punching orientation when
stapling documents. To do so, enable the option Show fold marks in the Bi-fold section further below in the
dialog box.

For more information about fold marks and bi-fold marks, see Fold marks.



64The TextMaker tour

Printing the sample letter
If you want, you can now print your first document for review. To do so, choose the ribbon command File |
Print.

The dialog box for File | Print

In the dialog box "Print", you can specify how many copies and which pages are to be printed. By default, one
copy of all pages is printed. Confirm with OK.

Tip: Before actually printing a document, you can preview the printout via the ribbon command File | Print
preview. This feature enables you to avoid wasting paper on test prints.

Finished!
Our TextMaker tour ends here. You now know many of the program's basic functions, and you should take
some time to explore them further.

It would be a good exercise, for example, to format the letter differently or to give it a more attractive font, etc.
You will find the final example document (for the completed TextMaker tour) in the Tour4.tmdx file.
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You can then study the rest of the manual. It has been intentionally structured so that you only need to read the
chapters that you really require. Thus, you can gradually familiarize yourself with the functions as you want to
use them.

Have fun with TextMaker!
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Working with selections
This chapter marks the beginning of the reference section of the manual. This part of the manual provides
detailed descriptions of all of TextMaker's functions organized into chapters by subject matter, as is customary
in a reference book.

The first chapter in the reference section is about working with selections. If you want to delete, copy or move a
part of a document, you must first select the relevant section of text. This also applies to objects (pictures,
drawings, etc.).

In addition, you must first select the relevant section of text before you can apply certain commands that will
change its formatting. If, for example, you select one word and then select a different font, only that word will
be formatted in the different font.

The following pages provide detailed information on working with selections. The following topics are
covered:

§ Selecting text and objects 

§ Moving, deleting and copying

§ Paste (special)

§ Inserting a document

Selecting text and objects
For some TextMaker commands, you can select a section of text (or an object) before you execute them. The
command is then applied only to the selected text or object.

The selection procedure differs depending on the operating system in use. Thus, this section is split into two
parts:

§ Selecting in the Windows, Mac or Linux version 

§ Selecting in the Android/iOS version

Selecting in the Windows, Mac or Linux version

In the Windows, Mac or Linux version of TextMaker, you can select something as follows:
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Selecting via the mouse

To select something via the mouse, proceed as follows:

§ Selecting text 

To select a section of text of any length, position the mouse cursor at the beginning of the section, press and
hold down the left mouse button, and drag the cursor to the end of the desired section.

To select a word, double-click on the word.

To select a whole line, click in the left margin of that line. You can select multiple lines by dragging the
mouse cursor up or down beside them in the left margin.

To select a whole paragraph, double-click in the left margin beside the paragraph. Also possible: Triple-
click directly in the paragraph.

To select the whole document, press and hold the Ctrl key and click in the left margin (beside any paragraph
of the document). (Mac users: Cmd key)

Alternatively, you can do the same with the ribbon command Home | Select all .

§ Selecting objects 

To select an object (for example, a picture, a drawing, etc.), simply click on it with the mouse. A frame will
then appear around the object to indicate that it is now selected.

To select multiple objects, switch to object mode (see Object mode).

Selecting via the keyboard

Alternatively, you can use the keyboard. To do so, proceed as follows:

§ Selecting text

Move the text cursor to the beginning of the text you want to select. Press the Shift keyñ, hold it down, and
then move the text cursor in any direction with the arrow keys.

For example, you can select the following:

a single character with Shift+ß or Shift+à

a single word with Ctrl+Shift+ß or Ctrl+Shift+à
(for Mac: Alt+Shift+ß or Alt+Shift+à)

whole pages with Shift+PageUpá or Shift+PageDownâ

To select the whole document, you can press the key combination Ctrl+Home, followed by the key
combination Ctrl+Shift+End.

Alternatively, you can do the same with the ribbon command Home | Select all .

§ Selecting objects 

Objects can only be selected with the mouse (see above).
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Selecting non-contiguous text sections

You can also select non-contiguous text parts with TextMaker (multiple selections of text). To do so, select a
word, line, paragraph, or any section of text in your document using the methods described above.

While holding down the Ctrl key, you can then select another text element elsewhere in the document with the
mouse.

(On a Mac, you have to use the Cmd key.)

If, for example, you want to select several words that are distributed non-contiguously in the text, proceed as
follows:

1. Select the first word you need – by double-clicking on it with the mouse, for example.

2. Press and hold down the Ctrl key.

3. Select the next word you need, which is located elsewhere in the text – by a single click on it with the
mouse.

In this way, add more words (or text segments) to the selection as required.

All the words on which you clicked are now selected across the board. You can format this selection as a unit or
copy it, etc. If you want to remove a word from the selection, you can do so via a single mouse click on the
relevant word.

Selecting in the Android/iOS version

Selecting works a little differently on Android/iOS devices. You can use either your finger or a mouse. Proceed
as follows:

§ Selecting text 

The easiest way to select a section of text is as follows:

Double-click on the word that you want to use as the starting point of the selection. The word should now be
selected. This is indicated by the large "handles" that appear in front of and behind the word:

These two handles represent the beginning and end of the selection. To extend the selection to additional
text, simply drag the two handles to the desired positions.

Tip: Use the ribbon command Home | Select all  to select the text of the whole document.

§ Selecting objects

To select an object (for example, a picture or drawing, etc.), simply click on it. A frame will then appear
around the object to indicate that it is now selected.
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To select all objects, switch to object mode (see Object mode).

Moving, deleting and copying
All operating systems that TextMaker supports have an extremely useful feature: the clipboard.

The clipboard works as follows: You select something in the document and then cut or copy the selected text to
the clipboard. You can then reinsert the selected text elsewhere in the document. The clipboard thus facilitates
the deletion, copying and moving of sections of text (as well as objects).

All necessary commands (except Delete) can be found on the ribbon tab Home | group Edit:

Command Explanation

Delete If you select a section of text (or object) and press the Del key, the text or object will be deleted
without being moved into the clipboard.

Cut The ribbon command Home | Cut also deletes the content of a selection – but not permanently.
This content is moved instead to the clipboard, where it remains available for subsequent insertion
anywhere in the document.

Copy The ribbon command Home | Copy copies the content of the selection to the clipboard.

Paste To paste the content of the clipboard into the text, place the cursor at the desired text position and
use the ribbon command Home | Paste (click directly on the icon). You can also insert the content
of the clipboard multiple times in this manner.

Paste special If you click on the small arrow below the icon rather than directly on it at Home | Paste, a
dropdown menu opens with additional options for pasting the content. For more information, see
Paste special.

These commands work in the same manner for objects such as pictures or drawings and also for table contents.
For more information, see also Deleting, copying, moving cell contents.

Moving and copying text with the mouse ("drag and drop")

Android/iOS: This function is not available in the Android or iOS version.

You can select a section of text with the mouse, drag it to another position and drop it there. With this
technique, known as drag and drop, you can move or copy text very quickly.

To do so, proceed as follows:

1. Select the section of text.

2. Position the mouse cursor on the selection.

3. Press the left mouse button and hold it down.

4. With the mouse button held down, drag the selection to the desired position.
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5. When you release the mouse button, the content of the selection is moved to the new position. Tip: When
you release the mouse button while pressing the Ctrl key, the text is copied to the new position, rather than
moved.

Paste (special)

There is a more powerful variant for the ribbon command Home | group Edit | Paste .

If, for example, you have copied text and click on the small arrow below the Paste icon, you can use the
dropdown menu to specify in which form the text from the clipboard should be pasted:

§ Paste: The default paste option will be used. (Adapt formatting to target is preset as the default option.) 

Tip: You can customize the default paste option in the Settings, General tab.

§ The entries Adapt formatting to target, Keep source formatting and Merge formatting provide you with
advanced formatting options for pasting. If you have copied formatted text (e.g. from a web page or another
document), you can use these options to integrate the formatting of the source text into the target text to suit
your preferences.

See also "Advanced formatting options when pasting" below.

§ Paste unformatted text: The original formatting of the copied text is removed, and it adopts the formatting
of the text passage where it is pasted.

§ Further entries (for example, Paste picture) appear in the dropdown menu depending on what you have
copied to the clipboard.

§ Paste special: Here, you can specify exactly how the content from the clipboard is to be pasted.

In detail:

When you use the commands Cut or Copy to save information to the clipboard, it is saved in multiple
formats simultaneously. If you have selected text, it appears in the clipboard in both formatted and
unformatted form.

When you choose the command Paste special, the program will display a dialog box with a list of all
formats in which the information currently stored in the clipboard is stored (text was copied in this
example).

If you select a format and then confirm with OK, the content of the clipboard will be pasted in the selected
format.
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For copied objects and tables, you get different entries in the dropdown menu than for copied text. Here, the
dialog box Paste special also displays a list of all formats stored in the clipboard from which you can choose.

Advanced formatting options when pasting

You can paste copied content from another source (for example, another program or TextMaker document)
with the formatting of the target text, the source text, or with a combination of both. If you want everything to
be less complex, you should paste unformatted text. See the aforementioned description in this case.

Click on the small arrow of the Paste  icon for the following paste options:

§ Adapt formatting to target 

The formatting style of the target document is retained, but "hard" formatting of the source document is
applied (manual adjustments of font size, bold print, etc.).

Example:

In your source document, the copied text contains a heading format of font size 18 from a paragraph style,
and some places are also manually formatted in bold and blue. In your target document, the text is formatted
in a heading format of font size 14 using a paragraph style.

As a result, the heading format with font size 14 from the target document is retained, but the bold and blue
manual formatting of the source document is applied.

§ Keep source formatting

The original formatting of the copied text is applied. Font size and other text styles, including hyperlinks,
appear like the formatting in the source document.

§ Merge formatting

This is a combination of the aforementioned two options: Basically, the original formatting of the copied
text is adapted to the target document, but certain formatting is retained from the source document (for
example, hyperlinks or text highlighted with the text marker).
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Note: These formatting options are particularly important if formatting styles have been used in the
source/target text. Keep source formatting gives you the most comprehensible result of all the options
offered. The other two options implement differentiated parameters based on assumptions of what the user is
most likely to expect at this point.

Setting the Default paste option

If you generally want to apply one of the "advanced formatting options" listed above when pasting, this can be
specifically set as the Default paste option in TextMaker.

Choose the ribbon command File | Options  and switch to the General tab. Select the desired default paste
option here (see above for a description of each option):

§ Adapt formatting to target 

§ Keep source formatting

§ Merge formatting

§ Paste unformatted text

If you click directly on the Paste icon  in future (or press Ctrl+V ), the copied content will always be pasted
with this formatting option.

Inserting a document

You can use the ribbon command Insert | Document  to insert a complete TextMaker document into the
current document.

Note: Object frames (for example, text frames, picture frames, etc.) will not be imported.

Proceed as follows:

1. Move the text cursor to the position in the current document at which the other document is to be inserted.

2. Choose the ribbon command Insert | Document  (in the group Text).

3. The program opens a dialog box in which you select the document to be inserted.

4. Confirm that it has been opened.

The selected document will now be inserted.
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Character formatting
On the ribbon tab Home | group Character, you will find the most frequently used commands to change the
appearance of single or multiple characters in the text.

Common commands: Via the icons of the command group "Character"

You can use the group icons to directly make the following settings:

§ Font and font size 

§ Text styles (for example, bold, italics, underlined)

§ Colors

§ Superscripts and subscripts

§ Resetting the character formatting

Additional options: In the dialog box of the command group "Character"

If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character, the
program opens a dialog box in which you will find additional options for character formatting.

The displayed dialog box has several tabs that you can switch between by clicking on one of the tab headers:

§ Font tab 

For selecting properties like Font and font size, other Text styles, Colors, Language, Hiding text, and
Protecting text

§ Spacing tab 

For changing properties like Superscripts and subscripts, Letter spacing and character pitch, and
enabling/disabling Kerning

§ Hyperlink tab 

For inserting and editing hyperlinks (for example, to web pages). For more information, see Using
hyperlinks.
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The Reset button on each tab can be used to undo all changes made in the open dialog box as long as you have
not confirmed them by pressing OK. For information on how to remove character formatting that is already
applied to the text, see Resetting the character formatting.

The Set as default button lets you apply changes to the character formatting as the new default setting for the
document. For more information, see Changing the default character formatting.

Changing character formatting

There are two ways to change character formatting:

§ To subsequently change the character formatting, select the desired text and apply the appropriate formatting
(font, font size, etc.) via the icons or via the dialog box. 

Android/iOS: If you are using these versions, please note that selecting text works slightly differently
there. For more information, see Selecting text and objects.

§ To change the character formatting as you type new text, select a different font and then simply continue
typing. From that point on, all text that you enter will appear in the new font – until you select a different
font again. 

See the following pages for more detailed information on character formatting.
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Font and font size
To change the font or font size of text, see the commands on the ribbon tab Home | group Character. Proceed
as follows:

Via the buttons of the command group "Character"

1. First, select the desired text.

2. Click on the small arrow to the right of Font or Font size.

3. Set the desired font and font size:

Font: Select the desired font from the dropdown list via a mouse click.

Font size: The dropdown list offers the most common font sizes, which you can select via a mouse click.
However, you can enter a different size manually at any time. Font sizes can be entered with a precision of a
tenth of a point – thus font sizes such as 12.7 are also allowed.

Tip: The icons  in the group Character can be used to increase or decrease the font size by one
level.

Font sizes are usually indicated in the unit of measure "point" (abbreviated as "pt"). As a rule, you should use
font sizes between 10 and 12 points for normal text, and a somewhat larger size, such as 14 to 18 pt, for
headings. Major headings may be even larger (24 pt, for example).

Shortcut keys

You can also enter the font and font size via the keyboard:

Command Windows/Linux Mac

Select font Ctrl+D Cmd+D

Decrease font size Ctrl+8 Cmd+8

Increase font size Ctrl+9 Cmd+9
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In the dialog box of the command group "Character"

If you only want to change the font and font size, these options in the dialog box are exactly the same as the
buttons described above. Thus, it is only advisable to use the dialog box if you also want to apply other
character formatting options that are unavailable as buttons or if you want to apply another default font.

On the ribbon tab Home | group Character, you open the dialog box via the group arrow  in the lower right
corner and select the Font tab in the dialog box.

To change the default font (only possible via the dialog box), see Changing the default character formatting.

Text styles
Text styles are character formatting options such as bold, italics, underlining, etc.

TextMaker offers the following text styles:

§ Italic: A slanted variant of the font. 

§ Bold: A stronger ("more pronounced") variant of the font.

§ Underline: The text is underlined (with various options for line styles and line colors).

§ SMALL CAPS*: Smaller uppercase letters are used instead of lowercase letters.

§ All caps*: All characters are output as uppercase letters.

§ ALL UPPERCASE**: All characters are converted into (real) capital letters.

§ all lowercase**: All characters are converted into (real) lowercase letters.

§ First Character Uppercase**: Each word begins with a (real) capital letter.

§ Strikethrough: The text is struck through.

§ Hidden*: The text no longer appears on the screen or on the printed page. For more information, see Hiding
text.

§ Protected*: The text cannot be edited. For more information, see Protecting text.

§ Superscripts and subscripts: for example, r2 and H2O. For more information, see Superscripts and

subscripts.

§ Font color, Background color* and Highlight text**: You can also change the color of text (see Font
color).

§ Language*: If necessary, you can also specify the language of a section of text (only required if you use
multiple languages in a document – see Setting the language).

* This option is only available via the dialog box of the command group "Character"
This option is only available via the icons of the command group "Character"
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Common commands: Via the icons of the command group "Character"

The most common text styles can be applied on the ribbon tab Home | group Character directly via the icons
of the group.

To apply text styles, proceed as follows:

1. Select the desired text.

2. Click on the icon for the text style you would like to enable or disable.

The B stands for bold, the I for italics and the U for simple underlining. Click on the small arrow next to the
U to open a dropdown menu with further options for underlining (for line style and line color).

The ab stands for strikethrough, the x2 for subscript and the x2 for superscript.

If you click directly on the Aa icon or also on the small arrow next to it, the program opens a dropdown
menu which allows you to apply Change capitalization to the text.

Note: Using the options for Change capitalization is an actual spelling change that is also perceived as such
by the spell check. In contrast, the All caps option in the dialog box (see below) is only an effect (such as
italics) for display.

Text styles can be combined (almost) as desired.

Additional options: Via the dialog box of the command group "Character"

For additional text styles that you cannot find via the buttons (for example, SMALL CAPS), open the dialog box.

On the ribbon tab Home | group Character, click on the group arrow  in the bottom right corner and switch to
the Font tab in the dialog box.

§ In the area Styles you will find small caps, all caps and strikethroughs. These can be enabled or disabled
there via a simple mouse click. 

Note: The All caps option in the Styles area is only a display effect and not an actual spelling change like
the Change capitalization button described above.

§ In the area Underline, you can use the dropdown lists to select different line styles and colors for underlined
text.
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§ To enable bold and/or italics, open the dropdown list Style (to the right of font size) and select the desired
entry: Regular, Italic, Bold or Bold Italic.

Shortcut keys

There are also shortcut keys for some text styles:

Command Windows/Linux Mac

Bold Ctrl+B Cmd+B

Italic Ctrl+I Cmd+I

Underline Ctrl+U Cmd+U

Superscript Ctrl+Shift+(Num+) Cmd+Shift+(Num+)

Subscript Ctrl+Shift+(Num-) Cmd+Shift+(Num-)

Remove superscript or subscript Ctrl+Shift+(Num*) Cmd+Shift+(Num*)

Change uppercase/lowercase of text 
(from "test" to "Test" to "TEST")

Shift+F3 Shift+F3

Note: (Num+) (Num-) (Num*) represent the keys on the numeric keypad, usually located on the right side of the keyboard.

Font color
You can change the color of the font itself or highlight the text background.

The commands for this purpose can be accessed via the ribbon tab Home | group Character.

Applying via the icons of the command group "Character"

For the Font color , proceed as follows:

1. Select the desired text and click on the small arrow to the right of the icon (i.e. not on the icon itself).

2. Select the desired color from the dropdown menu.

Tip: To format more text in the same color, select the text and then click on the icon itself because the last
color used will be applied again.
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Highlighting text: 

There is a Highlighter icon to the right of the font color icon. This icon works in exactly the same way, but
provides the selected text with a colored background – just like a highlighter. If you click on the small arrow of
the icon, you can select the option No highlighting in the dropdown list to remove the highlighting.

Note: This is an additional color that can only be applied via the icon. It is not the background color
mentioned below (which can only be selected via the dialog box). This is not necessarily logical, but Microsoft
Word offers this feature in exactly the same way, which is why it was implemented in TextMaker in the same
way for compatibility reasons.

Background color: In the dialog box of the command group "Character"

Insofar as only the font color is concerned, the options in the dialog box correspond exactly to the button
described above. However, in addition to the font color, you can also change the background color in the
dialog box.

Note: This is not the highlighter function mentioned above, but an additional color (which can only be applied
via the dialog box).

Proceed as follows:

1. Select the text and click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Font tab.

2. Open the dropdown list Background color and select the desired color.

Notes

§ Color lists only offer a few standard colors, but you can always compose your own colors. To do this, click
on the entry Define color... at the end of the dropdown list. For more information, see also Document
properties, Colors tab. 

§ The standard color known as Auto has a special feature: Text formatted in this color is normally displayed
in black. However, when you change the background color or the highlighter function of the text to a very
dark color, this color automatically switches to white (to ensure that the text remains readable).

Superscripts and subscripts
You can add a superscript (for example, r2) or a subscript (for example, H2O) to text. The commands for this

can be found on the ribbon tab Home | group Character.
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Applying via the icons of the command group "Character"

Select the text and click on the respective icon  for simple Subscripts or Superscripts.

Additional options: Via the dialog box of the command group "Character"

You can also adjust the Position and Size of the superscript or subscript text in the dialog box.

Select the text and click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enable Superscript or Subscript.

If required, also enter the percentage of the superscript or subscript text in the field Position. You can also use
a percentage in the field Size to determine how much the font size should be reduced. For example, enter 100
percent if you do not want the font to be reduced.

Shortcut keys

You can apply superscript/subscript even faster via the following shortcut keys:

Command Windows/Linux Mac

Superscript Ctrl+Shift+(Num+) Cmd+Shift+(Num+)

Subscript Ctrl+Shift+(Num-) Cmd+Shift+(Num-)

Remove superscript or subscript Ctrl+Shift+(Num*) Cmd+Shift+(Num*)

Note: (Num+) (Num-) (Num*) represent the keys on the numeric keypad, usually located on the right side of the keyboard.

Tip for Windows users: If you simply want to insert a superscript square number (m2) or cubic number (m3)
directly, the key combination AltGr+2 or AltGr+3 is also available. Use the number bar above the letters
rather than the numbers on the numeric keypad.

Letter spacing and character pitch
TextMaker also allows you to change the spacing and character pitch of text if necessary.

Letter spacing is the horizontal distance between characters. If values are less than 100%, the characters are
closer together. For values greater than 100%, the characters are further apart.
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Changing the character pitch changes the width of the characters themselves rather than the distance between
them, thus the characters are distorted.

To change these settings, click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enter the required values for Letter spacing or
Character pitch.

Note: Some printers do not support changing the character pitch for internal printer fonts. The font then
appears wider or narrower on the screen, but not on the printout.

Kerning
Certain pairs of letters look better when the spacing between these letters is reduced or increased a bit. Such
adjusting is known as kerning.

The following figure illustrates what is meant by kerning:

Above: without kerning. Below: with kerning

The upper text (without kerning) shows that the letters "V" and "A" are usually too far apart. This was
corrected for the lower text (with kerning).

This adjusting occurs fully automatically. All you have to do is enable kerning:

Select the desired text, and click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enable the option Use kerning.

TextMaker now automatically adjusts the spacing between all letters where this would improve the text
appearance.

Note: Not all fonts provide kerning information in their font data. This information is required to determine
which letter pairs to adjust and how. Almost all font collections published by SoftMaker include extensive
kerning information.
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Format painter
You can use the command Home | Format painter to instantly transfer the character formatting (font and font
size, text styles, etc.) from one character to other characters.

To do so, proceed as follows:

1. First, select the character whose format you want to transfer. You can also select multiple characters;
however, they should all have the same character format.

2. Click on the Format painter icon  on the ribbon tab Home | group Edit.

The mouse cursor then changes into a brush: 

3. Drag the mouse (with the mouse button held down) over the characters to which the format is to be
transferred.

Tip: If you press and hold the Ctrl key while you do this, both the character formatting and paragraph
formatting will be transferred.

4. If you want to transfer the format to other pieces of text, repeat step 3. as often as required.

5. When you are finished, click on the Format painter icon again or simply press the Esc key.

Shortcut keys

You can also use the keyboard to perform the Format painter function:

Command Windows/Linux Mac

Format painter (copying step) Ctrl+Shift+C Cmd+Shift+C

Format painter (pasting step) Ctrl+Shift+V Cmd+Shift+V

Hiding text
You can hide sections of text if necessary. Hidden text is usually only displayed on a screen but is not printed.

Application: Hidden text is ideal for comments or notes that you want to incorporate into a document so that,
for example, they will be displayed on a screen but will not appear on a printout.

Hiding text

To hide text, proceed as follows:
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1. Select the desired text.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character.

3. In the dialog box, switch to the Font tab.

4. Select the option Hidden.

The text is now hidden. It is displayed by default on a screen, but it does not appear on a printout.

Displaying/printing hidden text

By default, hidden text is visible on a screen but does not appear on a printout. However, you can use the
document's properties to specify whether hidden text is to be visible on the screen and whether it is to be
printed.

To do so, select the ribbon tab File | Properties and switch to the View tab in the dialog box. In the section
Hidden text, you will find the following options:

§ Show hidden text 

This option determines the visibility of hidden text on the screen.

This option is enabled by default. Thus hidden text is visible. Hidden text is displayed with a dotted
underline to distinguish it from normal text.

If you disable this option, hidden text will not be visible on the screen.

§ Print hidden text

The option Print hidden text determines the printing of hidden text along with the document's normal text.

If this option is disabled, hidden text will not be visible in the printout.

If you want all hidden text segments to be printed, you must enable this option.

Removing the "Hidden" formatting again

If you want to remove the Hidden formatting, proceed as follows:

1. Make sure that the option Show hidden text is enabled in the document properties (see above) so that you
can see the text.

2. Select the hidden text, and click on the group arrow  in the bottom right corner of the ribbon tab Home |
group Character. On the Font tab of the subsequent dialog box, disable the option Hidden.

The text is no longer hidden now.

Protecting text
You can protect a section of text to prevent it from being changed or deleted.
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Protecting text

To protect text, proceed as follows:

1. Select the desired text.

2. On the ribbon tab Home | group Character, click on the group arrow  to open the dialog box.

3. In the dialog box, switch to the Font tab.

4. Enable the option Protected.

Text that is protected in this manner cannot be edited. If you position the text cursor in such text and attempt to
insert or delete something, your attempts will have no effect.

Important note: If you select an unprotected text area that contains a protected section of text, you can still
delete it! Protection only prevents editing or deleting within the protected text itself.

Removing the "Protected" formatting

To remove the "Protected" attribute, select the protected section of text, open the dialog box again from the
ribbon tab Home | group Character (with the group arrow ) and disable the option Protected on the Font tab.

The text segment is no longer protected and can be edited as normal again.

Resetting the character formatting
TextMaker allows you to remove character formatting at any time. You will find the commands for this process
on the ribbon tab Home | group Character.

Applying via the icon in the command group "Character"

1. Select the relevant section of text.

2. Click on the Reset character formatting icon .

TextMaker now removes any character formatting that you have manually applied to this section of text.
However, the program retains paragraph formatting or character formatting from paragraph styles.

Note: This process also removes the character formatting Hidden and Protected. Thus hidden text becomes
visible again, and protected text can be edited again.

Shortcut key

You can also use the keyboard to choose the command Reset character formatting:
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Command Windows/Linux Mac

Resetting the character formatting Ctrl+Space Cmd+Space

Resetting in the dialog box of the command group "Character"

In the dialog box of the ribbon tab Home | group Character , you will also find a Reset button on each tab.
However, the use of this button differs from the above function: You can only use it to undo all changes made
in the open dialog box provided that you have not yet confirmed them with OK.

If the changes have already been confirmed with OK, they can only be undone via the Reset character
formatting icon described above.

Changing the default character formatting
The default character formatting settings can be changed at any time. This allows you, for example, to specify a
font other than the default font.

To do so, proceed as follows:

1. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character.

2. In the dialog box, set the character format (font, font size, etc.) that you want to save as the new default
setting.

3. Important: Do not click on OK, but click on the Set as default button.

4. TextMaker asks you if you want to change the default settings only for the current document or for all new
documents:

Change in this document only: If you select this option, the new default settings will affect only the
current document.

Change for all new documents: If you select this option, the change is made not only in the current
document, but also in the standard document template (Normal.tmvx). This means that all documents that
you create will use these settings in future.

5. Make a choice and confirm with OK.

6. Confirm again with OK to exit the dialog box completely.

The default character formatting settings have now been changed accordingly.

Note for advanced users: From a technical point of view, nothing else happens here other than that TextMaker
applies this setting to the "Normal" character style. For more information, see also "Normal" character style.



86Paragraph formatting

Paragraph formatting
On the ribbon tab Home | group Paragraph, you will find the most frequently used commands for determining
the formatting of paragraphs.

You can use the group icons to directly make the following settings:

§ Indents 

§ Line spacing

§ Paragraph alignment

§ Bulleted lists (or numbering)

§ Shading 

§ Borders and lines

§ Sorting text or tables

§ Showing non-printable characters

Additional options: In the dialog box of the command group "Paragraph"

If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph, a
dialog box opens with additional options for paragraph formatting:

§ Spacing above/below a paragraph

§ Changing the_character format for whole paragraphs

§ Tabs

§ Drop caps

§ Outline level

§ Hyphenation frequency (see Hyphenation)

§ Forcing a break before a paragraph (page break, column break)

§ Paragraph control (keeping certain paragraphs together, etc.)

§ Suppressing line numbers

More information can be found on the following pages.
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Paragraph formatting always applies to complete paragraphs. Changes to paragraph formatting always affect
the whole paragraph in which the text cursor is positioned. If you select multiple paragraphs, all selected
paragraphs will be affected.

Changing the paragraph formatting

You can change the paragraph formatting in two different ways:

§ To subsequently change the paragraph formatting, select the relevant paragraphs and make the required
changes via the icons or the dialog box. 

§ To change the paragraph formatting as you type new text, use the icons or the dialog box to set the desired
formatting without first selecting anything. The current paragraph is now reformatted accordingly.
Furthermore, any new paragraph that you start with the Enter key¿ will be formatted in the same way until
you change the paragraph formatting again.

Paragraph styles (for advanced users): You will find that paragraph styles can save you a considerable
amount of the work involved in formatting paragraphs. You can use them to apply predefined formats to
paragraphs very quickly. For more information, see Styles.

Units of measure: In TextMaker, dialog boxes not only accept values specified in the default unit of measure
inches*, but they also accept them in other units of measure. To enter a value in specific units, simply add one
of the following units of measure after the number:

Unit Explanation

cm Centimeter

in Inch – 1 in equals 2.54 cm.

pt Point – 72 pt equal 1 in.

pi Pica (character) – 1 pi equals 12 pt

* The default unit of measure depends on your computer's regional settings (on Windows). For information on other operating systems, see Settings,
Appearance tab.

If, for example, you type "7.62 cm" as the position for a tab, TextMaker puts it at 3 inches (7.62 cm).

Indents
You can use indents to temporarily change the left and right margins of paragraphs to move text in or out. The
indent for the first line of a paragraph can be specified separately.

Indents are always specified relative to the page margins. If, for example, the left page margin is set to 1 in and
you set the Left indent to 1.5 in, the text starts at 2.5 in.

Tip: You do not set the page margins themselves via indents, but via Layout | Page margins.
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Using the dialog box of the command group "Paragraph"

To use indents, place the text cursor in the desired paragraph or select multiple paragraphs. Then click on the
group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph, and switch to the
Paragraph tab in the dialog box.

You will find the options for changing the indents in the section Indents. There, you can set the Left indent,
the Right indent and the First line indent of a paragraph. Enter the desired values for the respective indents.

You can also enter negative values if you want to move text out instead of in, for example.

Using the icons of the command group "Paragraph"

The Left indent can also be applied via the two icons  on the ribbon tab Home | group Paragraph.
Here, you can also increase/decrease the indent by a preset default value.

To do so, place the text cursor in the desired paragraph or select several paragraphs, and click on the left icon to
increase the distance from the left margin. If you click on the right icon, the distance from the left margin is
decreased.

The default size of the indent is 0.5 in and depends on the Default width in the Tabs tab. For more information,
see Using tabs.

Using the horizontal ruler

You can also use the mouse to change indents directly in the horizontal ruler displayed above the document
(unless it has been hidden with the ribbon command View | Horiz. ruler).

To do so, place the text cursor in the desired paragraph or select several paragraphs. The indents are now shown
as small handles in the ruler:

The horizontal ruler (with colored indent handles)

To change an indent, click with the mouse on the corresponding handle (see figure), hold the mouse button
down and drag the handle to the desired position.

Note: When changing the Left indent, be careful to catch hold of the correct handle because only the lower
triangle will affect this indent. Likewise, the upper triangle will affect only the First line indent. On the other
hand, the rectangular handle under both triangles changes both the Left and First line indents together.

Shortcut keys

Indents can also be changed using the following shortcut keys:
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Command Windows/Linux Mac

Increase Left indent Ctrl+M Cmd+M

Decrease Left indent Ctrl+Shift+M Cmd+Shift+M

Increase hanging indent* Ctrl+T Cmd+T

Decrease hanging indent* Ctrl+Shift+T Cmd+Shift+T

* This corresponds to increasing the Left indent while decreasing the First line indent at the same time. As a result, the first line of the paragraph
maintains its position and only the indent of the lines below is increased.

Line spacing
Line spacing determines the spacing between the individual lines of a paragraph.

You will find the commands for this on the ribbon tab Home | group Paragraph.

Applying via the icon of the command group "Paragraph"

You can use the icon  to quickly and easily apply common line spacing.

Proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Click on the small arrow next to the icon for the dropdown menu.

3. Select the desired line spacing from the proposed values in the menu.

Tip: In the dialog box (see below), set a customized value in order to apply this value at any time via the
command Last in the dropdown menu of the icon.

To customize the line spacing, go to the dropdown menu of the icon and select the option More or click directly
on the icon itself. This opens a dialog box in which you will find further options for line spacing on the
Paragraph tab (see below).

Shortcut keys

For some common settings, there are also the following shortcut keys:

Command Windows/Linux Mac

Automatic single line spacing (1 line) Ctrl+1 Cmd+1

Automatic one and a half line spacing (1.5 lines) Ctrl+5 Cmd+5
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Command Windows/Linux Mac

Automatic double line spacing (2 lines) Ctrl+2 Cmd+2

Additional line spacing via the dialog box of the command group "Paragraph"

In the dialog box of the group, you can customize the values for the line spacing.

To do so, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph to open
the dialog box.

3. Switch to the Paragraph tab.

You will find the options for changing the line spacing in the section Line spacing:

4. First, use the dropdown list to select the method you want to use to specify the line spacing (see below).

5. Then enter the spacing in the edit box to its right.

When you confirm with OK, the line spacing will be changed according to your settings.

Methods of specifying the line spacing

In the dialog box, you can choose which method to use to define line spacing in the dropdown list Line
spacing.

The list has the following entries:

§ Single 

Automatic single line spacing.

Here, the optimum line spacing is determined automatically:

If you increase the font size in the paragraph, the line spacing will be increased accordingly.

If you decrease the font size, however, the line spacing will be decreased automatically.

§ Multiple 

Multiple automatic line spacing.

This corresponds to the option Single and thus also provides automatic line spacing. You can increase or
decrease this spacing by specifying the desired number of lines in the input field to the right of this option.

Some examples:

Enter "1.5" for lines to obtain one and a half times the automatic line spacing.

Enter "2" to get twice the automatic line spacing.

Enter "1" to get automatic single line spacing (corresponds to selecting the option Single).
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§ Exactly 

Exact line spacing.

Here, you can set the line spacing to an exact value in points. Here, the line spacing will not be
automatically adjusted to the font size.

Tip: The rule of thumb for visually appealing line spacing is:

Line spacing = font size x 1.2

In the case of a 10-point font, a line spacing of about 12 points would normally be appropriate.

§ At least 

Automatic line spacing with a given minimum.

This setting corresponds to the option Single, but prevents any reduction below the specified minimum
value.

Thus if you enter 12 points as the minimum value, the program uses automatic single line spacing by default.
If the automatic line spacing is less than 12 points (because you are using a very small font size), an exact
line spacing of 12 points is used instead.

By default, the line spacing is set to Single.

Spacing above/below a paragraph
In addition to line spacing, you can also define how much space should be kept above the first line and below
the last line of a paragraph.

To change this setting, open the dialog box of the ribbon tab Home | group Paragraph with the group arrow
in the bottom right corner, and switch to the Paragraph tab.

The section Paragraph spacing contains the following options:

Before

Here, you can set the spacing that is to be kept free above a paragraph.

More specifically, you specify the spacing between the last line of the previous paragraph and the first line of
the current paragraph.

After

Here, you can set the spacing below a paragraph.

More specifically, you specify the spacing between the last line of the current paragraph and the first line of the
next paragraph.



92Paragraph formatting

Suppress for paragraphs with the same paragraph style

This option was implemented primarily for the purpose of compatibility with Microsoft Word, where it also
exists.

Enabling the option has the following effects:

§ If the current paragraph and the previous paragraph use the same paragraph style, the Before spacing is
automatically suppressed. 

§ If the current paragraph and the next paragraph use the same paragraph style, the After spacing is
automatically suppressed.

This option is disabled by default.

Paragraph alignment
Text paragraphs can be aligned in the following ways:

   Left align

   Center

   Right align

   Justify (here, the words are distributed evenly over the available space)

Applying via the buttons of the command group "Paragraph"

To change the paragraph alignment via the ribbon buttons, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Choose the desired paragraph alignment on the ribbon tab Home | group Paragraph.

Shortcut keys

You can also use the following shortcut keys to change the paragraph alignment:

Command Windows/Linux Mac

Left align Ctrl+L Cmd+L

Center Ctrl+E Cmd+E
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Command Windows/Linux Mac

Right align Ctrl+R Cmd+R

Justify Ctrl+J Cmd+J

In the dialog box of the command group "Paragraph"

If you only want to change the paragraph alignment, the options in the dialog box are exactly the same as the
buttons described above. Thus, it is only advisable to use the dialog box if you also want to use other paragraph
formatting options that are not available as buttons.

You open the dialog box for paragraph alignment by clicking on the group arrow  in the bottom right corner of
the ribbon tab Home | group Paragraph. On the Paragraph tab, you will find the paragraph alignment in the
dropdown list Alignment.

Changing the_character format for whole paragraphs
If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph to open
the dialog box, you will see that the Paragraph tab contains a button labeled Character. You can use this
button to change the character formatting (font, text styles, etc.) for whole paragraphs.

This is especially useful for styles. For more information, see Paragraph styles.

To change the character formatting of whole paragraphs, select the desired paragraphs and click on the
Character button in the dialog box. The program will display another dialog box, which resembles that of the
ribbon tab Home | group Character. For more information, see Character formatting.

Tabs
A tab is a kind of "jump target" that you can use to position the text cursor at a specific point within a line. Tabs
are very useful for tables, for example.

You open the dialog box with the tab settings via the group arrow  in the bottom right corner of the ribbon tab
Home | group Paragraph (alternatively, via Layout | group Paragraph). In the dialog box, switch to the Tabs
tab.

Alternatively, just click directly on the icon  under Layout | group Paragraph to open the dialog box.

To work with tabs, two steps are required:

1. First, set the "tab stops" in the Tabs tab. You thus specify where tabs should be located.
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2. Once this is done, you can use the Tab key to insert tabs in the text at any time – that is, to make the text
cursor jump to the next tab stop.

For more information on using tabs, see the following pages.

Using tabs

By default, tab stops are preset at 0.5 inch intervals. However, these preset tab stops are merely relics from the
era of the typewriter, and you should take the opportunity to set your own tab stops.

Since tabs count as part of paragraph formatting, you can define different tab stops for each paragraph of the
document.

To set tab stops, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. On the ribbon tab Layout | group Paragraph, click on the Tabs icon .

3. Enter the desired position relative to the left margin under Tabs – the left margin corresponds to "0".

4. If desired, select another Alignment and another Tab leader for the tab (see below).

5. Don't forget: Click on the Set button.

6. If necessary, set up additional tab stops in the same way before you exit the dialog box with OK.

Once tab stops have been set, you can use the Tab key to insert tabs in the text to move from one tab stop to the
next.
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Note: You can also use this dialog box to enter the Default width for the predefined tab stops mentioned earlier
(0.5 inch by default). If you define your own tabs in a paragraph, however, the predefined tabs are overridden.

Tab alignment

You use the option Alignment in the above dialog box to specify the alignment of a tab stop.

Available options:

Alignment Explanation

Left This is a normal "left-aligned" tab stop. This tab stop determines where the following text begins.

Centered The text after the tab is centered on the tab position. This tab stop determines where the middle of
the text falls.

Right Here, the text after the tab is right-aligned. This tab stop determines where the text ends.

Decimal This option is used for formatting columns of numbers. The numbers are positioned in such a way
that their decimal points are vertically aligned.

Tip: To change the alignment of existing tab stops, click on the Tabs icon  on the ribbon tab Layout | group
Paragraph. Then select one of the set tab stops in the dialog box, change its alignment in the dropdown list
Alignment and confirm with Set.

Tab leader

You can also use the option Tab leader to specify a tab leader for a tab stop. This is then used to fill the space
that the tab skips.

Available options:

None A tab without a leader

Solid ___________ A tab with underscores as leaders

Dashed --------------- A tab with dashes as leaders

Dots .......................... A tab with dots as leaders (used frequently in tables of contents and indexes)

Middle dots ········· A tab with middle dots as leaders

Tip: To add leaders to existing tab stops, click on the Tabs icon  on the ribbon tab Layout | group
Paragraph. In the dialog box, select one of the set tab stops, choose the required character from the list Tab
leader, and confirm your selection with Set.

Deleting and moving tab stops

Once a tab stop has been created, it can be changed at any time:
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To do so, select the paragraphs whose tab stops you want to edit and open the dialog box via the Tabs icon 
on the ribbon tab Layout | group Paragraph.

Select one of the set tab stops in the list Tabs. The Clear button allows you to remove it. The Clear all button
removes all tab stops in the selected paragraphs.

It is not possible to move a tab stop to a new position via the command Tabs . You can only clear the tab
stop and then set a new one at the desired position. However, it is easier to move tabs via the ruler.

Using the horizontal ruler

All tab stops set in the current paragraph are displayed in the horizontal ruler (unless they were hidden with the

ribbon command View | Horiz. ruler ).

The horizontal ruler (after setting some left-aligned tabs)

Tab stops can also be easily set, moved and deleted via this ruler.

To set a tab, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Choose the desired tab type.

To do so, click on the icon to the left of the ruler. Each mouse click on the icon changes the tab type:

Left-aligned tab

Centered tab (the text is centered at the tab position)

Right-aligned tab (the text ends at the tab position)

Decimal tab (numbers are aligned to the decimal point)

3. Then simply click on the position on the ruler where you want to set the tab stop. Of course, you can also set
multiple tab stops directly by clicking on additional positions.

To move a tab stop, click on it on the ruler with the mouse and drag it to another position while still holding
down the mouse button.

To clear a tab stop, drag it downward outside the ruler.
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Bulleted lists
Lists in which each item is presented in its own paragraph preceded by a marker are usually much easier to read
than lists that are separated by commas.

Such markers (for example, little boxes, circles, arrows. etc.) are called bullets.

Creating bulleted lists is an easy task for TextMaker users: TextMaker can add bullets to paragraphs and
automatically indent them at the touch of a button.

You can even create lists whose items are numbered rather than bulleted. The paragraphs are then numbered
automatically with 1., 2., 3. etc. For more information, see Automatic numbering.

Adding bullets

You can find the commands for bullets via the icon  on the ribbon tab Home | group Paragraph.

Bullets can be added in different ways:

A. If you just want to add a bullet without any further selection, just click directly on the icon (not on the arrow
next to it). The default bullet or the last bullet you selected will be inserted.
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B. For a manageable selection of predefined bullets, click on the arrow next to the icon. A dropdown menu
appears with Default bullets, Custom bullets, and any previously used In the document bullets. Click on the
desired bullet to insert it directly.

C. If you want to customize bullets via the dialog box with all additional options, click on the arrow next to the
icon also, but select Format bullets. For the next steps in the dialog box, see the paragraph "Other options:
Via the dialog box Bullets and numbering" below.

Now type the text into the document. At the end of the paragraph, press the Enter key¿ to start a new
paragraph. TextMaker automatically indents the paragraph and adds a bullet.

Alternatively, you can also select existing text, of course, choose the command via one of the methods
described above, and thus add a bullet to this text.

Ending a list or removing bullets

To end a list or remove existing bullets, proceed as follows:

First, position the text cursor at the end of the last numbered paragraph and press the Enter key¿ to start a new
paragraph.

Alternatively: Select all paragraphs of the bulleted list if you want to completely remove the bullets for these
paragraphs.

As with the addition of bullets, there are now also different ways here:

A.Simply click again directly on the icon itself  to remove bullets.

B. Alternatively, click on the arrow next to the icon and select None from the dropdown menu.

C. To navigate via the dialog box, click on the arrow next to the icon, but select Format bullets. On the
Bullets and simple numbering tab, you will find the option None under Type.

Tip: If you want to wrap a new line in a list with bullets without creating a new bullet, simply insert a
manual line break with the shortcut key Shift+¿. The next line will then appear as body text.

Other options: Via the dialog box "Bullets and numbering"

To open the "Bullets" dialog box, click on the arrow next to the icon  on the ribbon tab Home | group
Paragraph. In the dropdown menu, select Format bullets.

Tip: If a bullet already exists, you can access the dialog box even faster by clicking directly on the bullet in the
text. Alternatively, you can access it via the context menu: Bullets and numbering.
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In the open dialog box, you can make the following settings for the bullets on the Bullets & simple numbering
tab:

§ Type 

Here, you can specify whether the paragraphs should be given a Bullet or Numbering. Thus select the
option Bullet here for bullets. (For more information about the option Numbering, see Simple numbering.)

Note: You can always convert a bulleted list into a numbered list by simply changing the "Type" to Numbering. You can also do it
the other way round, of course.

When you set the type to None, existing bullets or numbers are removed.

§ Default and Custom 

Here, you can select the bullet to be used. The Default row contains predefined bullets from which you can
choose, and you can create your own bullets in the Custom row (see below).

§ Color (only for default bullets) 

You can select a different color for the bullet in the dropdown list Color. In addition to the colors offered
here, you can define new colors at any time. For more information, see Document properties, Colors tab.
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Tip: If you set the color to "Auto", TextMaker automatically uses the font color of the paragraph to the
right of the bullet.

§ Size (only for default bullets) 

Here, you can change the size (in points) of the bullet.

Tip: If you select the option "Auto" here, TextMaker automatically uses the font size of the paragraph to
the right of the bullet.

§ Character button (only for custom bullets) 

For custom bullets, the Character button appears instead of the two options above. Click on this button if
you want to change the character format (font size, color, text styles, etc.) of the bullet.

Tip: If you do not change these settings, the bullet automatically uses the character format of the
paragraph to the right of the bullet (except for the font).

§ Horizontal position 

This option allows you to specify how far the text should be indented to the right to make room for the
bullets.

§ Vertical position 

This option allows you to specify the vertical position of the bullet on the line. If the value is negative, the
bullet is positioned lower. It is positioned higher if the value is positive.

§ Alignment 

This option is mainly relevant for flush alignment of numbers and numbered lists. Left reduces the distance
to the text, and right increases it.

§ Numbered lists tab 

This tab gives access to an additional option for creating lists with bullets or numbers: numbered lists. Here,
numbered lists can be saved and re-used whenever you need them. In addition, hierarchical numbering (1.,
1.1., 1.1.1., etc.) is also possible via numbered lists.

For more information on numbered lists, see Numbered lists.

Using custom bullets

If you do not like any of the bullets offered in the above dialog box, you can use any other character as a bullet
at any time.

In the middle of the dialog box, you will find two rows of bullets. The bullets in the Default row cannot be
changed. However, the bullets in the Custom row can be changed at will.

To do so, proceed as follows:

1. In the Custom row, click on the icon that you want to change.

2. Click on the Change button to the right of the row.

3. TextMaker's character table is now displayed. First, set the desired font.
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Tip for Windows users: Numerous characters suitable for bullets are included in the icon fonts Symbol and Wingdings.

4. Double-click on the desired character.

5. The selected character is now displayed in the list of available bullets. Click on OK to apply it.

Note: The dialog box has a total of six buttons for custom bullets. Thus, you are not limited to six different
types of bullets. The custom bullets can be redefined as often as you like – even within the same document.

Drop caps
A drop cap is a large ornamental letter at the start of a paragraph.

TextMaker is able to create such an ornamental letter automatically from the first character of a paragraph. The
remaining text of the paragraph flows around the drop cap automatically, but can still be edited as usual.

Note: Drop caps can only be used in paragraphs whose paragraph alignment has been set to left-aligned or
justified.

To use drop caps, proceed as follows:

Applying via the icon "Drop caps"

You can use the icon  on the ribbon tab Layout | group Paragraph to use preset drop caps.

1. To do so, place the text cursor in the paragraph to which you want to add a drop cap.

2. Click on the small arrow of the icon and select the desired type of drop caps from the dropdown menu.

If you want to customize the drop caps, select More in the dropdown menu or simply click directly on the icon
itself to open the dialog box (see next paragraph).

Other options: Via the dialog box of the command group "Paragraph"

To customize the drop caps, open the dialog box as described above by clicking on the icon (or using the group
arrow  of the group Paragraph on the ribbon tab Home  or on the ribbon tab Layout). If necessary, switch to
the Drop caps tab.

In addition to the desired type of drop caps, you can also set the appropriate Size of the font here. If you also
want the drop caps to be displayed in a different font, click on the Character button and set the desired
character formatting.

If necessary, also change the Margins for the drop caps.

Removing drop caps

To remove drop caps, click again on the arrow of the drop caps icon and select None. This entry also appears in
the dialog box.



102Paragraph formatting

Shading
You can choose the ribbon command Home | group Paragraph | Shading to highlight text paragraphs with
colored shading or a pattern.

Applying directly via the icon of the command group "Paragraph"

If you click on the small arrow next to the icon  Shading, the program will open a dropdown menu with
Standard colors and Color variations. You can apply these directly to the selected paragraph by hovering over
the colors with the mouse cursor (you can see the effect on the text in the preview) and then clicking on the
desired color.

Tip: The last selected color is displayed in the icon as a small horizontal bar. If you want to apply the same color to other paragraphs,
simply select them and click on the icon itself (not the arrow). TextMaker will then reapply the last selected color.

This also applies to other shading settings, such as Patterns or Shades, which you can only find in the dialog box. You open the dialog
box by clicking on the icon's arrow and choosing More. Detailed information on the options of the dialog box can be found below.

Removing shading: Click on Transparent in the dropdown menu to remove existing shading.

Other options: Via the dialog box of the command group "Paragraph"

The dialog box contains additional shading options. The option Shades allows you to mix colors individually,
and you can also apply different Patterns in the dialog box.

You open the dialog box by clicking on the arrow of the icon  and choosing More in the dropdown menu.

Alternatively: On the ribbon tab Home | group Paragraph, click on the group arrow  and switch to the
Shading tab.
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The following settings are possible:

§ Adding a shade 

A shade is a color shading that is mixed from the selected foreground color and background color.

To add a shade, set the Type to Shading and then make the desired settings:

First, set the desired Foreground and Background colors. (The background color is set to white by
default.)

In the section Shades, different mixtures of these two colors are now offered. Select one of these
suggestions. Alternatively, you can enter an exact percentage for the shade in the input field under Shading.
Values between 0 (100% background color) and 100 (100% foreground color) are allowed.

§ Adding a pattern

To add a pattern, click on one of the patterns in the section Patterns.

You can also select a different Foreground and Background color for the pattern.

§ Removing a shade or pattern 

If you want to remove existing shades or patterns, select None for Type.

Then confirm with OK.
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Borders and lines
Text paragraphs can be provided with a complete border or individual border lines at the top, bottom, left or
right.

You will find the commands for these options on the ribbon tab Home | group Paragraph.

Common borders and lines: Via the icon of the command group "Paragraph"

A selection of common borders and lines can be found via the icon Borders  under Home | group
Paragraph.

Proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Click on the icon's arrow for the dropdown menu and select an entry with the desired properties by clicking
on it.

Note: You can also combine individual lines to your liking by reopening the dropdown menu of the Borders
icon and adding another attribute, for example, first positioning a line at the top and then an additional line
at the bottom.

The text paragraph is now provided with the relevant lines.

Tip: If you then want to add exactly the same type of border to other paragraphs, simply select them and click on the icon itself (not the
arrow). TextMaker will then reapply the most recently selected type of border.

Removing borders/lines: Click on None in the dropdown menu. All borders/lines will then be completely
removed.

If you want to edit/remove individual border lines or define additional properties for borders and lines, click on
Borders in the dropdown menu. A dialog box opens with other options (see below).

Other options: Via the dialog box of the command group "Paragraph"

For additional options, such as the color or different thickness of lines, there are various options available in the
dialog box.

You open the dialog box by clicking on the arrow of the icon  and selecting Borders in the dropdown
menu.

Alternatively: On the ribbon tab Home | group Paragraph, click on the group arrow  and switch to the
Borders tab.
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Dialog box for border lines (here: for text paragraphs)

A similar dialog box also appears for table cells. You use both dialog boxes in the same manner.

Essentially, you use this dialog box as follows:

1. First, you specify what type of border line you want to apply (line style, thickness, color).

2. Then specify where this type of border line should be placed. To do so, simply click on the desired lines (or
their buttons) in the right half of the dialog box.

Let's take a closer look at the individual steps:

For example, to add border lines to a text paragraph, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. On the ribbon tab Home | group Paragraph, click on the group arrow  for the dialog box and switch to the
Borders tab.

3. First, specify what type of border line you want to apply. You have the following options:

Line style (single, double or dashed lines)

Thickness of the line

Color of the line

4. Then specify where you want to apply this type of border line (top, bottom, left, right, etc.).
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For this purpose, a preview box surrounded by a set of buttons is available in the right half of the dialog box.
Use it as follows:

A. In the preview in the right half of the dialog box, simply click directly on all lines to which a border line
is to be applied.

B. Alternatively, you can use the buttons that are displayed to the left and below the preview for this
purpose. Each button represents a specific line (see icon on the button).

C. The buttons above the preview are useful shortcuts:

The Outline button applies the currently set border line to all outer borders.

The Inside button does the same for all inner lines (the "gridlines" between the table cells).

The None button removes all lines at once.

5. Add as many lines as you like by simply repeating step 4.

Of course, you can always change the line style, thickness or color (step 3) before applying it (step 4).

6. When everything is as required, confirm with OK.

Detailed information on the individual options in this dialog box can be found below.

Editing or removing existing border lines in the dialog box

You can change the style, thickness or color of existing border lines or also remove them at any time. To do so,
open the dialog box again and proceed as follows:

§ Changing: To change the appearance of a line, first select the desired settings (style, thickness, color). Then,
in the preview, click on the line (or its button) to which you want to apply these settings. 

§ Removing: To remove a border line, click on that line (or its button) twice in the preview. Clicking once
applies the border line, while clicking it again removes it. 

Tip: The None button displayed above the preview removes all lines at once.

Dialog box options (detailed)

In the dialog box for border lines described above, the following adjustments are possible:

§ Line style 

This option determines the type of line to be drawn. You can choose between different variations of single,
double and dashed lines.

§ Thickness 

This option determines the width of the line.

§ Color 

Here, you can change the colors of the line.

In addition to the colors offered here, you can define new colors at any time. For more information, see
Document properties, Colors tab.
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§ Preview box 

A preview box is displayed in the right half of the dialog box. This shows what the border lines would look
like when applied after you exit the dialog box with OK.

The preview box is also used to apply and remove lines:

If you click on one of the lines in this preview, the corresponding line is enabled – or disabled when you
click it again. The settings currently selected in the dialog box (line style, line thickness, color) are used for
this purpose.

Alternatively, you can use the buttons to the left and below the preview for this purpose. Each button
represents a specific line, which is indicated by the icon on the button.

The buttons shown above the preview are shortcuts: None removes all lines at once, Outline adds lines to
all outer borders, Inside does the same for all inner lines (for example, for table cells).

§ Bounds 

Only for text paragraphs: This option determines where the lines should start and end.

Page margins: The lines extend from the left page margin to the right page margin.

Paragraph indents: The lines extend from the left to the right indent of paragraphs. This is the default
setting.

Text: The lines are as wide as the text they enclose.

§ Clearance 

Only for text paragraphs: This option determines the distance from the border lines to the text.
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Outline level
Long documents (for example, manuals) are usually provided with an outline.

To create and edit the outline of a document, TextMaker offers its own outline view with the ribbon command
View | group Views | Outline.

In the outline view, you can "designate" normal text as a heading and the outline level of existing headings as
higher or lower levels.

Program window in the outline view

Note: Normally, you should not manually change the outline level of headings via the dialog box of the
ribbon tab Home | group Paragraph, but you should do this work via the buttons of the outline view as
recommended in this example.
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If you want to manually change the outline level, go to the ribbon tab Home | group Paragraph and click on
the group arrow  to open the dialog box and switch to the Paragraph tab. Select the desired level there via the
option Outline level.

For more information on working with outlines, see Outlines.

Forcing a break before a paragraph
You can instruct TextMaker to always start the current paragraph with a new page or column.

Applying via the dialog box of the command group "Paragraph"

You can use the dialog box to give a paragraph the attribute "Always make a page break/column break before
this paragraph".

Open the dialog box on the ribbon tab Home | group Paragraph by clicking on the group arrow  in the bottom
right corner and switching to the Text flow tab. Enable the option Page break or Column break there.

From this point on, TextMaker will always break the page or column before this paragraph – even if the
paragraph is moved to another position in the text.

Application example: If you want a certain heading to always start with a new page, you can format this
heading with the attribute Page break. If you then move or copy the heading to another location, it will also
start there with a new page.

Different function via the "Break" icon

The commands for the page break/column break via the Break icon on the ribbon tab Insert (or Layout) seem
similar at first glance. However, they must be distinguished in their function from the Page break/Column break
options in the dialog box described above because they format the page rather than the paragraph.

For more information, see the following sections:

§ Page break: Inserting manual page breaks 

§ Column break: Multi-column page layouts

Paragraph control
Open the dialog box by clicking on the group arrow  in the bottom right corner of the ribbon tab Home | group
Paragraph.

On the Text flow tab, you can, among other things, set restrictions for automatic page breaks to prevent
unaesthetic page breaks.
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To do so, use the following options in the section Paragraph control:

§ Keep with next 

If this option is enabled, TextMaker prevents the current paragraph from being separated from the following
paragraph by an automatic page break. Instead, TextMaker inserts the break before the current paragraph.

If you have selected several paragraphs, these paragraphs and the next paragraph after them will be kept
together.

Application example: If you enable Keep with next for a heading, you can avoid the situation in which a
heading would fall at the end of a page and the related text would start on the following page.

§ Keep together

Enabling this option prevents TextMaker from inserting a page break in the middle of the paragraph.
TextMaker then puts the automatic page break before the paragraph instead, so that all of it falls on the next
page.

The same applies to column breaks (for multi-column text).

§ Avoid widows/orphans 

This option prevents the occurrence of widows or orphans in paragraphs. A widow or orphan occurs when a
single line of a paragraph is on one page, while the rest of the paragraph is on another page. Widows and
orphans are not particularly visually appealing and interfere with the reading of longer documents.

If you enable this option, the page break will be automatically corrected in such a case to ensure that at least
two lines of the paragraph appear on each page. If this is not possible because, for example, the paragraph
consists of only two lines, the whole paragraph is placed on the next page.

Non-breaking space

There is another way to control the text flow:

In certain cases, two words separated by a space must remain on the same line. TextMaker is unaware of this
and may put the words on separate lines when it automatically inserts line breaks.

An example: You want the price "USD 29.80" to be written as one unbroken unit. You can ensure this by
inserting a protected (non-breaking) space between "USD" and "29.80". To insert such a space, press the key
combination Ctrl+Shift+Space instead of just the space bar.

When printed, the non-breaking space looks exactly like a normal space. It differs only in directing TextMaker
to ensure that the designated words are not spread over two lines.

Suppressing line numbers
Open the dialog box by clicking on the group arrow  in the bottom right corner of the ribbon tab Home | group
Paragraph. 

The option Suppress line numbers on the Text flow tab has the following function:
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By using the ribbon command Layout | Line Numbers (in the group Section), line numbers are displayed in
the left margin of the page. If you do not want them to appear for a particular paragraph, simply enable the
option Suppress line numbers for that paragraph.

Note: Please note also for your paragraph styles that the option Suppress line numbers must be enabled or
disabled there as needed.

For more information on line numbers, see Adding line numbers.

Line break – insert manually
As an alternative to using the paragraph mark (with the Enter key¿), you can jump to the next line without
starting a new paragraph:

You set a manual line break via the Break icon on the ribbon tab Insert (or Layout). Click on the icon's black
arrow and select Line break. Alternatively, simply use the key combination Shift+¿.

The manual line break corresponds to the automatic line break, which causes the cursor to jump to the end of
the next line. However, the manual line break can be inserted anywhere in the line.

How does this differ from the paragraph mark? While the formatting of the paragraph also applies when using
the paragraph mark (for example, the set spacing before and after the paragraph), the line break only causes a
jump to the next line. You still remain in the same block of text within the paragraph.

Tip: If you want to wrap a new line in a bulleted list without creating a new bullet, simply use the manual
line break. The next line will then appear as body text.

Sorting text or tables

On the ribbon tab Home | group Paragraph, you will also find the Sort text/table icon . You can use it to
sort the contents of a table as well as ordinary paragraphs in the text.

For more information, see Sorting tables and Sorting text.

Showing non-printable characters

If you enable this icon  on the ribbon tab Home | group Paragraph, you can show formatting markers, such
as paragraph marks, tabs, spaces, etc., so that they are easier to recognize in the text.
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To hide the formatting marks, click on the icon again.

Note: You can also show non-printable characters in a differentiated manner via the ribbon command File |
Options, View tab by selecting only individual characters there. For more information, see Settings, View
tab.
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Page formatting
This chapter covers everything you need to know about formatting pages in TextMaker. It contains the
following sections:

§ Inserting manual page breaks 

If you want to start a new page before the text has reached the end of the current page, you can always insert
a manual page break. You will learn how to do this in this section.

§ Page setup

On the ribbon tab Layout | group Page setup, you define the page format of the document. This includes
settings such as page size, page orientation (portrait or landscape) and page margins.

§ Headers and footers 

Headers and footers are consistent lines of text that are printed at the top and bottom respectively of each
page of the document. This section describes how to create and edit them.

§ Master pages 

Headers and footers are parts of the master page. On the master page, you can insert any object frame – for
example, a picture frame with a watermark. These objects will then appear on each page of the document.

§ Dividing a document into chapters 

All page formatting options described in this chapter apply to the whole document by default. Thus, all
pages have the same paper format and the same headers and footers, etc. However, you can also divide a
document into chapters. Each chapter can have its own set of headers and footers and its own page format.
Read this section to learn more about it.

§ Changing the page background 

You can change the background of your document's pages at any time, for example, to add some color to
them. There are two commands for this, which work somewhat differently:
The ribbon command Layout | Background (in the group Section) and the ribbon command Layout |
Chapters. In this section, you will learn how to use these commands and what differences there are between
them.

§ Fold marks 

Insert practical marks into your document to fold the printout of a letter in the right places by means of two
fold marks or to be able to position the holes exactly when filing documents via a bi-fold in the middle.
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Inserting manual page breaks
TextMaker automatically fills the pages of a document by default. When the text reaches the end of a page, an
automatic page break is performed and the text continues on the next page. If you want to start a new page
before the text has reached the end of the current page, you can always insert a manual page break.

To do so, move the text cursor to the position at which the new page should start.
On the ribbon tab Insert (or ribbon tab Layout), click on the black arrow of the Break icon for the dropdown
menu and select Page break there. Alternatively, you can use the shortcut key Ctrl+¿.

TextMaker now inserts a forced page break.

Tip: If you have enabled the icon  for formatting marks on the ribbon tab Home | group Paragraph (see also
Showing non-printable characters), the manual page break will be displayed with a dotted line.

If you need to remove a manual page break that you have forced in this manner, you can do so by positioning
the text cursor at the beginning of the first paragraph following the break and pressing the Backspace keyÕ.

Specifying a page break before a certain paragraph

Note: This option, which differs in its properties from the function described above, can only be set via the
dialog box of the command group "Paragraph".

In addition to forcing a premature page break via the ribbon tab Insert | Break | Page break, you can also do it
in a different way and with a different function: by giving a paragraph the attribute "Always make a page break
before this paragraph".

To do so, place the text cursor in the desired paragraph, and click on the group arrow  in the bottom right
corner of the ribbon tab Home| group Paragraph to open the dialog box. Switch to the Text flow tab and
enable the option Page break there.

TextMaker will then always insert a page break before this paragraph – even if you move the paragraph to a
different place in the text.

Page setup
On the ribbon tab Layout | group Page setup, you can define the page format of a document. Here, you can set
such things as paper size, page orientation (portrait or landscape) and page margins.

Note: Changes to these settings always affect the whole document unless you divide it into chapters. Each
chapter can have its own page formatting. You should divide the document into chapters if, for example, you
want to change the paper size in the middle of the document. For more information, see Dividing a document
into chapters.
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Applying via the dialog box of the command group "Page setup"

On the ribbon tab Layout | group Page setup, click on the group arrow  in the lower right corner to open the
dialog box and switch to the Page format tab.

The following options are available in this dialog box:

§ Orientation 

Here, you can specify the Orientation of the document on the printed page: Portrait or Landscape.

§ Paper

You can specify the paper size for the printed pages here. The dropdown list Size contains all paper sizes
that are supported by the current printer. If you want to specify a size that is not listed, you can do so by
manually specifying values in the fields Width and Height.

§ Margins 

You can set the page margins here

§ Mirror margins 

Ideal for book printing The page margins that you would otherwise set as left and right margins change to
inner and outer margins when this option is enabled. The set distances to the page margins then appear with
an equal width to the inner margin and an equal width to the outer margin in a multi-page document.
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Tip: On the ribbon tab View, enable the option Book layout  so that you can view the result better. For
more information, see also Customizing the document display.

§ Gutter 

A gutter can be added in addition to the page margins. The gutter is an additional margin that, for example,
is required for the fold when such a document is printed and then bound or stapled together.

You can specify the position and size of the gutter.

Note: The option "Mirror margins" (see above) only permits the inside position.

§ Paper trays 

Only available in Windows version: If your printer has multiple paper trays, you can set the tray which the
printer should use. If you have selected the default setting Use printer setting, TextMaker does not affect
the paper feed. If, for example, you want the first page of your document to be printed on paper from tray 1
and the remaining pages on page from tray 2, you should change this setting accordingly.

There are also two more tabs in the dialog box "Page setup":

§  Chapter tab 

This tab contains settings for the chapter format, which is discussed in Dividing a document into chapters).

§ Fold marks tab 

On this tab, you can insert tri-fold marks and bi-fold marks at the beginning of each chapter. For more
information, see Fold marks.

Applying via the icons of the command group "Page setup"

Common settings of the dialog box can also be found via the icons on the ribbon tab Layout | group Page
setup. Click on the black arrow of the respective icon to open the corresponding dropdown menu.

Margins (corresponds to the options for Margins in the above dialog box):
You will find a selection of predefined values here. If required, select More in the dropdown menu to access the
dialog box for customizations.

Page orientation (corresponds to the options for Orientation in the above dialog box):
portrait or landscape

Page size (corresponds to the options for Paper in the above dialog):
Here you will find a selection of predefined values. If required, select More at the bottom of the dropdown menu or
click on the icon itself to perform customizations via the dialog box.
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Headers and footers
Headers and footers are consistent lines of text that are printed at the top and bottom respectively of each page
of the document.

Headers and footers are always inserted into the top and bottom margins respectively of pages. When you
change the margins of your document, the position and size of all headers and footers are adjusted
automatically.

The following pages contain everything you need to know about headers and footers.

Creating and editing headers and footers

To insert headers, click on the Header icon  on the ribbon tab Insert | group Header and footer.
Alternatively, click on the icon's arrow to apply an appropriate header format when inserting directly from the
dropdown menu with predefined formats.

TextMaker then positions the text cursor in the header frame in the top margin of the page. Here, you can enter
and format text as usual.

The header frame is initially only one line in size, but it expands automatically when you type more than one
line of text or start a new line by pressing the  Enter key¿.

To return to the normal text from the header frame, just click anywhere in the normal text with the mouse. If
you want to edit the headers again later, click in the header frame with the mouse. You can also just click again
on the Header icon or use the icon's arrow to select Edit headers in the dropdown menu.

The insertion and editing of footers is performed in a similar way. You use the Footer icon  on the ribbon tab
Insert to create footers in the bottom margin of the page. If you click on the icon's arrow, you will find a
selection of predefined formats and the command Edit footers.

Note: Headers and footers apply to the whole document by default. If you want to use different headers and
footers within the same document, you must divide the document into chapters. You can then enter different
headers and footers for each chapter. For more information, see Dividing a document into chapters.

Using the ribbon tab "Header and footer"

Once you have inserted a header or footer, you can switch to the contextual ribbon tab Header and footer for
editing.

This always appears automatically if you have placed the text cursor in a header or footer.
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The contextual ribbon tab "Header and footer"

The ribbon tab has the following buttons, from left to right:

§ Header set up or open existing ones (as described above) 

§ Footer set up or open existing ones (as described above)

§ Delete header or footer, see Deleting headers or footers

§ Page number insert, see Inserting a page number

§ Minimum height, see Changing the properties of headers and footers

§ Distance to page edge, see Changing the properties of headers and footers

§ Distance to text, see Changing the properties of headers and footers

§ Shading apply, see Changing the properties of headers and footers

§ Borders apply, see Changing the properties of headers and footers

§ Date/time insert, see Inserting date and time

§ Field insert, see Insert additional fields

§ Alignment tab insert, see Using alignment tabs

§ Go to the Next header or footer

§ Go to the Previous header or footer

§ Leave header/footer (closes the ribbon tab and returns the text cursor to the text)

Inserting a page number

Headers and footers often contain information such as page number, date, etc. You can enter this information in
TextMaker via fields. For more information, see Inserting other fields.

If you want to insert specific page numbers, you can do so very conveniently via the Page number button .
To do so, place the cursor in the desired position in the header or footer and click directly on the Page number
icon itself on the contextual ribbon tab Header and footer.

Alternatively, you will find the command Page number on the ribbon tab Insert | group Header and footer
(this also allows page numbers to be inserted into normal text at any time).

By clicking on the Page number icon , page numbers are thus inserted directly as a field in the cursor's
position without any other formatting.

You will also find additional formatting options for page numbers when you click on the small black arrow of
the Page number icon .

In the menu that appears, you have the following options:
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§ Header: Predefined page number formats that you can insert as a field in the header 

§ Footer: same, for footers

§ Current position: same, but the selected format is inserted directly in the current position of the cursor.
This can be the header or footer, but also any position in the text.

§ Insert page number: This option inserts a page number as a field in the current position of the text cursor
and opens the dialog box Insert field at the same time. The list entry "Page number" for inserting and
formatting this field is already preset here.

Note: This dialog box can also be accessed by double-clicking a previously inserted field in the document.

On the right side of the dialog box, there is a "Settings" button that opens another dialog box for formatting
the page numbers (see next paragraph).

§ Page number format: This option opens the dialog box Page numbers (see next paragraph).

Controlling page numbering

Page numbering in every document starts with "1" by default. If necessary, you can also instruct TextMaker to
start page numbering on the first page with a different number.

To do so, click on the small arrow of the Page number icon  and select Page number format in the
dropdown menu. In the open dialog box Page numbers, change the setting Numbering from Increment to
Value and enter the desired number next to it. If, for example, you type "42", the first page will have the page
number 42.

Note: In order for the document to display the page numbering you have selected here, you must also have
inserted a corresponding field for page numbers beforehand (for example, by clicking directly on the Page
number icon as described above).

For more information on this dialog box, see Formatting page numbers.

Inserting date and time

Information such as date or time, page number, etc., is often used in headers and footers. You can insert this
information via fields. For more information, see Inserting other fields.

If you want to insert a specific date/time, you can do so very conveniently via the  Date/time button. This
allows you to insert the current date or time either as a field or as fixed text. First, place the text cursor in the
desired position in the header or footer and click on the Date/time icon on the contextual ribbon tab Header
and footer | group Insert.

Alternatively, you will find the command Date/time on the ribbon tab Insert | group Text (this allows you to
insert the date/time into the normal text at any time).

Inserting the date and time as fixed text

In contrast to fields, a fixed text is created with the date or time, which is no longer automatically updated.
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By choosing the ribbon command Date/time, a dialog box appears. Here, you can choose whether the
header/footer should contain the date or time, and you can specify the format.

If you do not like any of the predefined formats, you can click on the New format button and type in your own
format using the abbreviations described in Inserting a field.

Inserting the date and time as fields

If you want the date or time to be inserted as a field rather than as fixed text, enable the option Insert as field in
the dialog box. TextMaker then creates a field (Print date or Print time). For information on the use of fields,
see Fields.

Tip: Using shortcut keys

To insert the current date or time (as fixed text), you can use the following shortcut keys:

§ Insert date: Ctrl+. (period) 

§ Insert time: Ctrl+Shift+. (period) 

When you press one of these key combinations, the date or time will be inserted immediately – without a dialog
box appearing.

Inserting other fields

Headers and footers often contain information such as page numbers or date/time. These frequently used
options can be quickly entered in TextMaker via the explicitly available buttons described in the previous two
sections.

Additional fields can be inserted via the Field button , which is also available directly on the ribbon tab
Header and footer.

To do so, set the cursor in the desired position in the header or footer. Choose the ribbon command Field by
clicking directly on the icon itself and select the desired field in the dialog box. Alternatively, click on the small
black arrow on the icon for a dropdown menu of presorted entries for fields.

For information about each type of field, see Fields.

Using alignment tabs

In addition to normal tabs, you can also use a very special type of tab, namely "alignment tabs", in headers and
footers.

Alignment tabs have the following special features:

§ They can only be inserted in headers and footers. 
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§ They ignore all tab settings that have been made in a paragraph (for example, with the ribbon command
Layout | Tabs) because:

§ They always align the following text relative to the page margins – either left-aligned, centered or right-
aligned.

The word "relative" is what makes this specific type of tab particularly interesting:

If, for example, you insert a centered alignment tab in the footer and add a field "Page number" behind it, this
field will be centered in the footer. So far, so good. If you now change the page margins or even set the page
format to landscape, however, the page number will still be centered in the footer. A normal centered tab stop
could not do such a thing, since normal tabs always have a specific absolute position.

To insert an alignment tab, proceed as follows:

1. Click in the header or footer to set the cursor there (or insert a new header/footer).

2. Click on the icon  on the contextual ribbon tab Header and footer to insert an alignment tab.

3. A dialog box appears. You can select the desired alignment for the tab and make some other settings (see
below) in this dialog box.

As soon as you confirm, the alignment tab is inserted and the text behind it is aligned accordingly.

Options of the dialog box

The options in this dialog box have the following functions:

§ Alignment 

This option determines the alignment of the alignment tab: left-aligned, centered or right-aligned (each
relative to the page margins).

§ Tab leader 

Here, as with normal tabs, you have the option of selecting a tab leader if desired in order to fill the area to
the left of the tab.

§ Relative to 

This option determines what the alignment tab should be aligned with: the page margins (without
considering paragraph indents) or the indents for the current paragraph.

Changing the properties of headers and footers

Like all types of frames, the header and footer frames (where the headers and footers are located) also have
certain properties that can be changed on the contextual ribbon tab Header and footer. For example, you can
adjust the height, change the distance to the text and to the edge of the page or add shading and borders to the
frame.



122Page formatting

Common options: Via the icons of the ribbon tab "Header and footer"

Use the buttons of the command groups Size and position and Format to apply common options directly.

First, click with the mouse in the header or footer frame – depending on whether you want to edit the headers or
footers – and customize the following properties according to your needs:

§ Command group Size and position 

You can enter the desired values in the respective input fields or increase/decrease the values with the small
arrow buttons. The following settings are possible:

Minimum height: Here, you can set the minimum height of the header or footer frame. The other option
Fixed values can be found in the dialog box, see below.

Distance to page edge: Distance between the frame and the edge of the page.

Distance to text: Distance between the frame and the body text.

§ Command group Format: Shading  

If you click on the small arrow on the Shading icon, you will see a dropdown menu with standard colors and
color variations that you can apply.

The last selected color is displayed as a horizontal bar in the icon. This "memory function" also applies to
other shading settings, such as patterns or shades (which can only be found in the dialog box). You open the
dialog box by clicking on the icon's black arrow and selecting More in the dropdown menu. For more
information, see below.

Removing shading: Click on Transparent in the dropdown menu to remove existing shading.

§ Command group Format: Borders  

If you click on the small arrow of the Borders icon, you will get a dropdown menu with common borders
and lines.

Tip: You can also combine individual lines to your liking by reopening the dropdown menu of the Borders
icon and adding another attribute, for example, first positioning a line at the top and then an additional line
at the bottom.

Removing borders/lines: Click on None in the dropdown menu. All borders/lines will then be completely
removed.

If you want to edit/remove individual border lines or define additional properties for borders and lines, click
on Borders in the dropdown menu. A dialog box opens with other options (see below).
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Other options: Via the dialog box of the ribbon tab "Header and footer"

The dialog box of the contextual ribbon tab Header and footer provides additional options for customizing
shading, borders/lines and the height of headers and footers.

To do so, proceed as follows:

1. Click with the mouse in the header or footer frame – depending on whether you want to edit the header or
the footer.

2. Open the dialog box via the arrow  in the group Format or, alternatively, in the group Size and position.
Both lead to the same dialog box.

The following settings can be made in this dialog box:

Properties tab

§ Height 

Here, you can change the height of the header or footer frame:

At least: This is the default setting. The height of the frame is adjusted automatically. The more text you
enter, the larger the frame becomes. In the input field to the right of it, you can enter the desired minimum
height if required.

Fixed: If you select this option, however, you can specify the exact height of the frame yourself. Note: If
this option is selected, TextMaker will display a red bar at the bottom edge of the frame whenever the
header or footer text does not fit completely within the frame. In this case, set the height to a larger value,
select the option At least or reduce the amount of text in the frame.

Note: TextMaker automatically adjusts the width of header and footer frames to the page margins.
However, you can always use paragraph indents in your headers and footers if you want them to be wider
or narrower.

§ Distance to page edge

Here, you can specify the amount of space TextMaker should leave between the frame and the (top or
bottom) edge of the page.

§ Distance to text 

Here, you can specify the amount of space TextMaker should leave between the frame and the body text.

Borders tab

Here, you can add individually designed border lines to the frame.

The controls on this tab correspond to those of the ribbon tab Home | Borders. For more information, see
Borders and lines.



124Page formatting

Shading tab

Here, you can add customized shading to the frame.

The controls on this tab correspond to those of the ribbon tab Home | Paragraph shading (see Shading).

Different headers/footers on the first page

Headers and footers are parts of the master page. For more information, see also Master pages. The content of
the master page is repeated on every page of the document by default.

If required, you can specify that a different master page should be used for the first page of the document
(including a different header and footer). This is useful, for example, when printing the first page of a letter on
a preprinted letterhead and the remaining pages on normal white paper.

To do so, select the ribbon command Layout | Chapter  and enable the option Different first page. From
now on, the headers and footers on the first page can be edited independently of the rest of the document.

Different headers/footers on left and right pages

In books, different headers and footers are often used on left-hand and right-hand pages. This makes it possible,
for example, to output the page number on the left in the footer of left-hand pages and on the right in the footer
of right-hand pages.

To enable different headers and footers for left-hand and right-hand pages, proceed as follows:

1. Choose the ribbon command Layout | Chapter .

2. Enable the option Different left and right pages.

You can now create different headers and footers for left-hand and right-hand pages.

More specifically: If you now create or edit a header on any left-hand page of the document, the header for the
right-hand pages will remain unaffected. Likewise, changes to the header on any right-hand page will affect
only the right-hand pages.

The same applies, of course, to footers.

Deleting headers or footers

You can remove the text from a header at any time by clicking in the header frame, selecting all the text and
then simply deleting it.



125Page formatting

You can also remove the header frame completely, although this is not usually necessary. To do so, proceed as
follows:

1. Position the text cursor within the header frame.

2. Click on the icon  in the contextual ribbon tab Header and footer.

The header frame is now removed along with all its content.

The procedure for removing footers is similar.
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Master pages
This chapter has already introduced you to headers and footers, which only have to be entered once but will
then appear on every page. This is a very useful thing, although TextMaker has yet another trick up its sleeve:

The content of the master page also appears on every page of the document. However, as its name implies, it is
not limited to a few lines in the top or bottom margins, but can fill the whole page.

Note: Please note that only frames are permitted on a master page (text frames, picture frames, etc.). Tip: If
you want to add text to a master page, you can still do so by simply inserting a text frame.

If, for example, you want to enhance a letter with a "watermark", simply insert a picture frame with a suitable
picture on the master page and set the option Text flow in the picture properties to "Behind text". The
watermark will then appear on every page of the document, and the text will flow right over it.

Editing the master page

If you want objects to appear on every page of a document or chapter, simply put them on the master page. To
do so, switch to the Master pages view and insert the objects there.

Note: Only frames (text frames, picture frames, etc.) and drawings can be put on master pages. For
information on how to work with these objects, see Frames and drawings.

You edit the master page as follows:

1. Use the ribbon tab View | Master pages to switch to the master page view.

2. Make the desired changes. To insert a picture, for example, go to the ribbon tab Insert | Picture; to insert
text, add a text frame using the command Insert | Text frame, etc.

3. When you are finished, choose the ribbon command View | Standard to exit the master page view
(alternatively: right-click to open the context menu and select Exit Master Page view).

All objects that you inserted on the master page will now appear on all pages of the document.

By the way, both the header and the footer are also parts of the master page. Apart from the fact that they are
automatically positioned in the top and bottom margins, they basically behave like text frames inserted into the
master page.

Different master pages in the same document

The master page applies to the whole document by default. If you want to use different master pages within a
single document, the document must be divided into chapters because each chapter has its own master page.
For more information, see Dividing a document into chapters.



127Page formatting

There, you will also learn how to set up a master page that applies only to the first page of the document, and
how to create different master pages for the left-hand and right-hand pages of the document.

Tip: In the Master pages view, the type of master page is displayed on the top of each master page. If, for
example, TextMaker displays "Chapter 7", right master page" there, the page itself is the master page for all
right-hand pages in chapter 7.

Locking master page objects in standard view

Objects that have been placed on a master page may be "locked" if desired in order to prevent them from being
moved accidentally with the mouse when the document is being edited in standard view.

To do so, choose the ribbon command File | Properties and switch to the View tab in the dialog box. Enable
the option Lock objects on master page in the section Locking.

Once locked, master page objects can be neither moved nor resized when the document is edited in standard
view. They can be changed only in the Master pages view (ribbon command View | Master pages).

Note: This setting affects only the current document.

Tip: Showing document text

By default, the master page does not display the document content from the standard view. If you still want to
see this text (and the objects) of your document displayed here in order to orient yourself better, TextMaker
provides the following function:

Simply right-click in the document in the master view and enable the command Show document text in the
context menu. If you click on this command again, the display will be disabled.

The display of this content does not affect the components of the master view and is merely a visual aid. You
also cannot edit this displayed content in the master view.
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Dividing a document into chapters
The page formatting options described in this chapter apply to the whole document by default. Thus, all pages
will have the same header and footer and the paper format will remain constant throughout the document, etc.

Chapters provide a way around this limitation. You can use the ribbon command Insert | Break | Chapter
break to divide a document into as many chapters as you want.

This has the following effects on the page formatting of the document:

§ Paper size, Page orientation and Page margins can be set separately for each chapter. 

§ Each chapter can have its own Master page and thus its own Headers and Footers.

§ The Page numbering can be reset to any initial value in a chapter if necessary. In addition, the format of the
page numbers can be set individually for each chapter.

§ If you enable the option Different left and right pages in the Chapter formatting dialog box, you can create
different headers, footers and master pages for left-hand and right-hand pages (for example, for a book).

§ For example, you can specify that a chapter should always start on a right-hand page. If the first page of a
chapter ends up being a left-hand page in this case, TextMaker automatically inserts a blank page in front of
it.

Dividing a document into chapters is not only useful if you are writing a longer work with individual "chapters"
in the traditional sense. You may also want to switch from portrait to landscape orientation in the middle of a
document so that you have more space for a wide table, for example.

To do so, insert a chapter break, set the paper orientation in the new chapter to Landscape and then create the
table. Below the table, insert another chapter break and set the paper orientation back to Portrait to enable you
to write the rest of the text in portrait format.

For more information on working with chapters, see the following pages.

Inserting and removing chapters

To create a new chapter, simply insert a chapter break into the text:

1. Move the text cursor to the position at which the new chapter should begin.

2. Choose the ribbon command Insert | Break | Chapter break.

Alternatively, you will find the command under Layout | Insert break | Chapter break.

The chapter break is now inserted. (Note: TextMaker always performs a page break at the beginning of a new
chapter.)
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Tip: The chapter in which the text cursor is currently positioned is displayed in the status bar at the bottom of
the TextMaker window.

Removing a chapter break

You can remove a chapter break by positioning the text cursor at the beginning of the first paragraph following
the break and then pressing the Backspace keyÕ. The chapter before the break is thus integrated into the
chapter after the break and also adopts its chapter formatting.

Tip: If you have enabled the icon  for formatting marks on the ribbon tab Home | group Paragraph (see
also Showing non-printable characters), the chapter break will be displayed with a dotted line.

Navigating chapters

You can use the ribbon command Home | group Search | Go to  to scroll to a specific chapter. To do so,
choose the command, select the option Chapter in the list and then select the desired chapter.

Chapters and page formatting

Important: A different page formatting can be applied to each chapter of a document.

To recapitulate – page formatting includes:

§ Page size, orientation and margins 

§ Headers, footers and master pages

§ Page numbers (initial value, format)

When you start a new document, it consists initially of a single chapter. If you change the page formatting, it
affects the whole document.

If you now divide the document into several chapters with the command Insert | Break  | Chapter break,
the new chapters initially assume the page formatting of the original document. This is because the following
applies:

Important: When you insert a chapter break, the resulting new chapter initially assumes the page formatting
and the master page of the current chapter. However, you can then change the page formatting and master
page separately in each chapter.

For each chapter, for example, you can now create different headers and footers or set a different paper size,
etc.
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Chapter formatting

Apart from the fact that the page formatting can be set differently in each chapter, there is also the chapter
formatting.

You can change the page formatting of a chapter via the familiar commands. For more information, see Page
formatting.

To change the chapter formatting, proceed as follows:

1. Position the text cursor anywhere within the desired chapter – or select multiple chapters to change all their
formatting simultaneously. The selection can start in any paragraph of the first chapter and end in any
paragraph of the last chapter.

2. Choose the ribbon command Layout | Chapter .

3. Make the desired changes (see below) and confirm with OK.

In the dialog box of this command, you can make the following settings:
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§ Master pages 

Changing the settings for the chapter's master page(s) (see also Master pages):

Different first page: If you enable this option, the first page of the chapter uses a master page that is
different from the other pages. This is useful if, for example, you want the first page of your document (or
chapter) to have a different header from those on the remaining pages.

Different left and right pages: You need this option if you want your document to be printed on both sides,
as is the case with a book, for example. If this option is enabled, TextMaker creates one master page for all
left-hand pages of the document – and another for all right-hand pages. This makes it possible, for example,
to place the page number on the left in the footer of left-hand pages and on the right in the footer of right-
hand pages.

Tip: In the Master pages view, the type of master page is displayed on the top of each master page. If, for
example, TextMaker displays "Chapter 7, right master page" there, the page itself is the master page for
all right-hand pages in chapter 7.

Borders and shading of master pages: Here, you can add borders or shading to master pages – and thus to
all corresponding document pages of the chapter. To do so, click on the Change button and then select the
master page for which you want to change these settings. The usual dialog box for applying border lines or
shading will then appear. For more information, see also Changing the page background.

§ Chapter starts on 

Whenever you insert a chapter break, TextMaker always makes a page break. Thus, new chapters always
start on a new page.

If you now change the option Chapter starts on from the default setting Either page to Right page, for
example, TextMaker will ensure that a chapter always starts on a right-hand page. If the beginning of the
chapter then ends up being on a left-hand page, TextMaker will automatically insert a blank page so that the
chapter starts again on the next right-hand page.

For example, it is customary for every chapter in a printed book to start on a right-hand page. This makes it
easier for the reader to find the beginning of new chapters when quickly flicking through a book.

§ Vertical alignment 

Here, you can change the vertical alignment of the body text on the page.

If, for example, you select Centered, the text is vertically centered on the page. If you select the option
Justified, the paragraphs are spaced evenly in such a manner that the body text starts right below the top
page margin and ends right above the bottom page margin.

§ Chapter number 

TextMaker automatically numbers chapters incrementally. You can always see the number of the current
chapter in the status bar.

If you change the option Chapter number from Increment (the default setting) to Value, you can specify
your own value for the chapter number. If, for example, you enter "5" as the number for the third chapter,
the document's chapters will have the numerical sequence 1, 2, 5, 6, 7, etc.

Tip: The chapter number can be inserted into the text (for example, in a header or footer) at any time via the

ribbon command Insert | Field .
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§ Page numbers button 

You can insert a field Page number into your document at any time in order to display the current page
number (for example, in the header or footer). This button opens a dialog box in which you can change the
format of the page numbers. You can also manually set the initial value for page numbering to a fixed value.

For more information, see Formatting page numbers.

§ Page format tab 

The Page format tab in this dialog box can be used to set the page format (paper size, orientation, margins,
etc.). For more information on each option, see Page setup.

Don't forget that you can specify a different page format for each chapter. Thus, if you have divided a
document into several chapters and you want to change the page formatting for the whole document, you
must first select the whole document.

Formatting page numbers

The dialog box Page numbers shown below can be used to change the format of the page numbers for the
current chapter. You can also manually set the initial value for page numbering to a fixed value.

In detail:

As described in the section Insert page number, the command Page number  on the ribbon tab Insert | group
Header and footer is used to insert a field that displays the current page number. The page number is usually
inserted in the header and footer, but it can also be inserted elsewhere in the normal text.

For formatting inserted page numbers, you have the following alternative methods:

§ If you double-click on the inserted Page number field, the dialog box Edit field opens. Click on the Settings
button here (only available if the option Use chapter settings is selected for Format). 

§ Alternatively, click on the small black arrow of the ribbon command Insert | group Header and footer |
Page number  and select Page number format.

§ Alternatively, choose the ribbon command Layout | Chapter and click on the Page numbers button.

Please note: To display page numbering in the document, you must first insert a corresponding field for
page numbers. You do not insert a field using the methods just described, but you can edit an existing Page
number field.

You can use any of the methods described above to open the following dialog box:
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Note: The options in this dialog box belong to chapter formatting. Thus, you can specify your own settings for
each chapter in a document.

Options of the dialog box

The following options are available in the dialog box:

§ Numbering 

TextMaker automatically numbers the pages of a document incrementally. Thus, the first page of the
document is page 1 and the second page is page 2, etc., by default.

If necessary, however, you can manually intervene in page numbering and set the page number for the first
page of a particular chapter to a specific value.

To do so, change the setting in the respective chapter from Increment to Value and enter the desired initial
value for the page numbering. This page number is then assigned to the first page of the current chapter.

If, for example, you have typed "42", the first page of the chapter will be page 42, the second page 43, etc.

§ Number format 

Here, you can change the number format of the page numbers.

Formats such as Arabic numbers (1, 2, 3, ...), letters (A, B, C, ...) and Roman numerals (I, II, III, ...) are
available.

§ Include heading number, Heading level and Separator 

If you select Include heading number, the page number will be preceded by the number of the current
heading.
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Note: This feature only works if numbering has been applied to the headings of your document. For more
information, see Numbering headings.

Under Heading level, you can choose which headings should be used for this purpose (Heading 1, Heading
2, etc.).

In addition, the option Separator allows you to specify which character should be used as a separator
between the heading number and the page number.

An example: When you add a field Page number on page 42 of a document and the corresponding level 1
heading (including its numbering) is "5. The larch", the following will be displayed for this field: 5.-42.

§ Apply to 

Here, you can choose whether to apply the changes made in this dialog box only to the current chapter or to
the whole document.

Note: If you have opened the dialog box via the ribbon command Layout | Chapter (Page numbers button), this option is
automatically set to the current chapter.

Changing the page background
As already mentioned in Chapter formatting, you can also change the background of the pages of a document
using the ribbon command Layout | Chapter – for example, color via shading.

However, there is another command for this that offers significantly more options: the ribbon command Layout
| Background.

In this section, you will learn how to use these two commands and the differences between them.

Layout | Background

You can use the ribbon command Layout | Background to change the page background for the whole
document. Use this command as follows:

1. Choose the ribbon command Layout | group Section | Background .

2. The program displays the dialog box "Background". 

3. Use the dropdown list Fill type to select the type of fill for the page background. You can select either a
solid color, a pattern, a picture (tiled) or different types of color gradients.

4. Change the desired settings and confirm with OK.

For more information on this dialog box, see Object properties, Fill tab. It describes the "Fill" tab for objects,
which is virtually identical to this dialog box.

Printing: Please note that this type of page background is only displayed on the screen by default – it does not
appear in printouts. However, there is a document option that allows you to change this: If you enable the
option Print page background in the dialog box of the ribbon command File | Properties (View tab), the page
background will also be printed.
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Layout | Chapter

The ribbon command Layout | Chapter works in a slightly different way:

You can use this command to change the page background for the current chapter (for its master page(s) to be
more precise).

Use this command as follows:

1. If you have divided your document into several chapters: Position the text cursor anywhere within the
desired chapter.

2. Choose the ribbon command Layout | Chapter .

3. The program displays the dialog box "Page setup".

4. Click on the Change button next to Borders and shading of master pages on the Chapter tab and select the
type of master page(s) of the chapter which should be changed.

5. Switch to the Shading tab.

6. For Type, select the desired type of fill for the page background. With this command, only color shades and
patterns are available.

7. Change the desired settings and confirm with OK.

For more information on this tab, see Shading. It describes the dialog box "Shading" for text paragraphs, which
is virtually identical to this tab.

Please note that if you have divided the document into several chapters, the above changes will only affect the
current chapter. For more information, see also Dividing a document into chapters.

Printing: This type of page background always appears in printouts. The aforementioned document option
Print page background has no effect here.
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Fold marks
It can be very useful at times if you see marks indicating where to fold printed letters or where the hole punch
should be used for filing. For this purpose, TextMaker has a practical solution: tri-fold and bi-fold marks.

You can select the pages of the document on which you would like these marks to appear (either only the first
page, only even/odd pages or all pages of the document).

If you have divided your document into chapters (see section Dividing a document into chapters), the selection
only applies to the selected chapters.

Note: If a new chapter is inserted after a chapter with existing tri-fold/bi-fold marks, the same marks will
also appear in the new chapter.

To insert tri-fold or bi-fold marks, proceed as follows:

Click on the group arrow  in the bottom right corner of the ribbon tab Layout | group Page setup to open the
dialog box and switch to the Fold marks tab.
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The dialog box contains the following options:

Tri-fold section

With tri-fold marks, you place a top and bottom mark in your document to indicate how to fold it. To do so,
enable the checkbox Show fold marks in the Tri-fold section.

From the two lists below, select the distances at which the fold marks should be placed on the page and on
which pages they should appear.

§ In the dropdown list Folding, you can choose between the following vertical distances: 

Three equal-sized parts: The fold marks divide the page into equal distances. This option is recommended;
the other two options are mainly of interest to users who adhere to the DIN standards that are common, for
example, in Germany.

A4 pages: small part on top (DIN type A): The fold marks divide the page into the distances 87 / 105 / 105
 mm when viewed from the top edge of the page (form A according to DIN 5008).

A4 pages: large part on top (DIN type B): The fold marks divide the page into the distances 105 / 105 / 87
 mm when viewed from the top edge of the page (form B according to DIN 5008).

Note: If the paper size on the Page format tab is set to an option other than A4, fold marks are always
automatically placed on the page as three equal-sized parts.

§ In the dropdown list Pages, you specify on which pages fold marks should appear: 

on the first page, on odd pages, on even pages or on all pages of the document. (A document that has not
been divided into chapters is simply treated as a single chapter.)

If you have divided your document into chapters, the selection only applies to the selected chapter and not
to the entire document. If you thus want to apply the selection to all chapters, you also have to select all
chapters beforehand.

Bi-fold section

With a bi-fold mark, you apply a central mark as an orientation point for punching a hole in the document. To
do so, enable the checkbox Show fold marks in the Bi-fold section.

In the dropdown list Pages below it, specify the pages on which the bi-fold marks should appear:

on the first page, on odd pages, on even pages or on all pages of the document. (A document that has not been
divided into chapters is simply treated as a single chapter.)

If you have divided your document into chapters, the selection only applies to the selected chapter and not to
the entire document. If you thus want to apply the selection to all chapters, you also have to select all chapters
beforehand.

Options section

§ Position 

Here, you can select whether the tri-fold/bi-fold marks should appear on the left, right or on both sides.
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§ Distance to page edge 

To change the lateral distance of the tri-fold/bi-fold marks, enter the desired value here or use the arrow
keys.

Changing tri-fold and bi-fold marks

For a normal document (not divided into chapters), you can easily change the tri-fold marks/bi-fold marks by
opening the above dialog box again and selecting different options in the dropdown lists described above. The
change is then applied to the entire document.

If you have divided your document into chapters and want to customize the display of the tri-fold marks/bi-fold
marks for a specific chapter only, first place the cursor in the corresponding chapter and then select different
options in the dropdown lists described above. The changes will then only be applied to the current chapter. To
apply the changes to all chapters, first select all chapters accordingly.

Removing tri-fold and bi-fold marks

To remove tri-fold or bi-fold marks, disable the corresponding checkbox in the above dialog box.

If you have divided the document into chapters, first place the text cursor in the relevant chapter from which
you want to remove the marks.
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Styles
Styles are very useful aids for advanced word processing users.

If you need a specific character or paragraph format frequently, it is worth creating a style for it. You can then
apply the style to any segment of text you like, and this text will be formatted as you have specified in the style
definition.

Furthermore: Using styles not only saves you time when you have to apply the same formatting repeatedly,
but also ensures that your document is formatted consistently. Such consistency is ensured by the fact that if
you change the formatting of a style, the program in turn changes the formatting of all text segments to
which this style has been applied!

In practical terms, styles work like this: You create a paragraph style called "Headings" for which you select a
larger, bold type, a centered alignment, etc. Now, you only have to apply that style to headings, and the
paragraph will be formatted accordingly.

By the way, you can define different styles for each document – they are saved within the document.

In this chapter, you will find detailed information on using styles. The following topics are covered:

§ Character styles 

In a character style, you can save a frequently needed character format (font, font size, text styles, etc.) and
then apply it repeatedly to any characters you like.

For this purpose, you will find the Character styles button  in the sidebar (above).

§ Paragraph styles 

You can save a frequently needed paragraph format (indents, tabs, alignment, etc.) in a paragraph style and
then apply it repeatedly to any paragraph you like.

For this purpose, you will find the Paragraph styles button  in the sidebar (above).

§ Managing styles 

TextMaker's integrated Manage styles tool allows you to copy character and paragraph styles back and forth
between documents and thus match their appearance.

This is the responsibility of the Manage styles tool, which you will find in the sidebar (below) via the
Organize button.

§ Document templates 

Styles that you want to use frequently can be saved in a document template.

Whenever you create a new document, TextMaker lets you select the document template to be used as the
basis for the document. All character and paragraph styles stored in this document template will also be
available in your new document.

For more information on the above topics, see the following pages.
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Character styles
In a character style, you can save a frequently needed character format (font, font size, text styles, etc.) and
then apply it repeatedly to any characters you like.

If, for example, you want to print small print sections of a contract in a different font and smaller size, simply
create an appropriate character style – lets call it "Small print" – and apply the style to those sections.

Note: The difference between character styles and paragraph styles (see Paragraph styles) is that character
styles contain only saved character formats, while paragraph styles contain both saved character formats and
saved paragraph formats (indents, tabs, alignment, etc.).

Accordingly, character styles are also applicable to individual characters, while paragraph styles are applicable
only to whole paragraphs.

The following pages contain detailed information on working with character styles. The following topics are
covered:

§ Creating character styles 

§ Applying character styles

§ Changing character styles

§ Scope of character styles

§ "Normal" character style

§ "Based on" character styles

§ Character styles and the sidebar

Note: On the following pages, the procedure is mainly described by means of a dialog box, which you can
reach by right-clicking with the mouse button and selecting Character style in the context menu. These
tasks can also be conveniently performed with the direct commands in the sidebar, which are described in
the last section Character styles and the sidebar.

If the sidebar is not visible, enable it on the ribbon tab View | group Windows | Sidebars.

Creating character styles

To create a character style, proceed as follows:

1. Right-click in the text to open the context menu and select the entry Character style.

The following dialog box opens:



141Styles

2. In the list on the left side of the dialog box, select the style on which you want your new character style to be
based. In the event of doubt, use the "Normal" style.

Note: The style of the section of text in which the text cursor was located before choosing the command Character style is always
preselected here in the dialog box. For information on changing the style basis – even afterwards – see "Based on" character styles.

3. Then click on the New button.

4. Give the character style any name you like.

5. The program will display a dialog box, which is very similar to the dialog box for the command group
Home | Character. Here, you can specify the desired character formatting (see Character formatting).

6. If you will need this style frequently, you can assign a shortcut key to it (see below).

7. When all the desired settings have been made, click on OK in the dialog box Character to create the style.

8. Exit the Character style dialog box with Close.

The style is now created and ready for use. You will learn how to use it shortly (in Applying character styles).

Creating character styles from existing text

Alternatively, you can first format some text as desired and then create a new style that assumes this exact
formatting. For this purpose, use the New from text button instead of the New button.

This procedure is useful if you have previously formatted text manually and want to have a character style that
has exactly the same character formatting.

To do so, proceed according to the following detailed steps:

1. Apply the desired character formatting (font, font size, etc.) to a section of text.
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2. Place the text cursor in this section of text or select it as both options work equally well.

3. Create a new character style via the command Character style as described above. Important: Use the New
from text button in the dialog box now instead of the New button.

A style created in this way will behave exactly like any other style. The only difference is that it assumes the
formatting of existing text when it is created. (Of course, you can still change the formatting of the style at any
time, regardless of this text.)

Using shortcut keys

If you need a style frequently, you can assign it a shortcut key at any time. The advantage of this is that you can
then enable the style very swiftly with one press of a key.

To assign a shortcut key to a style, click on the Edit button to open the dialog box and switch to the Style tab.
There, position the text cursor in the Shortcut key input field and press the desired key combination (starting
with Ctrl or Alt).

Note: If you press a key combination that is already assigned, the current assignment is displayed below the
input field Shortcut key. You should then press the Backspace keyÕ to delete your shortcut key and use a
different key combination. Otherwise, you will overwrite the key combination for another style or even for
one of TextMaker's commands.

We recommend that you always use key combinations that include the keys Ctrl and Shift since they are not
usually assigned.

Applying character styles

To apply a character style, proceed as follows:

1. Select the section of text to which you want to apply the character style.

2. Right-click in the text to open the context menu and select the command Character style.

3. In the list on the left side of the dialog box, select the desired style. 

Tip: A small preview of the selected style is shown in the right half of the dialog box. You can enable or
disable this preview via the >> or << buttons.

4. Click on Apply.

The formatting of the selected text immediately changes to that which you specified in the character style. In
addition, the character style becomes effective for subsequent entries that you type directly after the text.

Tip 1: If you frequently use styles, you should note the direct commands in the sidebar. You can use them to
apply and edit styles very swiftly. For more information, see Character styles and the sidebar.

Tip 2: If you have assigned a shortcut key to the style, you can apply the style even faster: Select the desired
text and press the assigned key combination.
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To remove the style from the text, assign the "Normal" character style to the text. Text to which a character
style has been assigned can still be formatted via the character formatting of the command group Home |
Character.l

Changing character styles

Of course, you can change character styles again at any time.

Important: If you change the formatting of a character style, this will automatically change the formatting of
all text that was formatted with this style! However, this automatic reformatting applies in a limited way to
text where you manually changed the formatting after you assigned the style (see next section).

To change a character style, proceed as follows:

1. Right-click in the text to open the context menu and select the command Character style.

2. In the dialog box, select the style you want to change from the list.

3. Click on Edit.

4. Make the desired changes to the style.

5. In the dialog box Character, click on OK.

6. Exit the dialog box Character style with Close.

The style has now been changed accordingly.

Determining which character styles are displayed in the dropdown list "Show"

By default, the dialog box Character style displays all available styles. If required, switch between the
following options to select which styles should appear in the list:

All styles: Show all available styles. These are all predefined styles and the styles you created yourself.

Styles in document: Show only the styles that are used in the document and the styles you created yourself.

Styles in use: Show only the styles that are actually used in the document.

Updating a character style from existing text

The Update from text button in the dialog box Character style allows you to update a style "from the text".

If you click on this button, the formatting of the currently selected text will be transferred to the selected style.
The style thus assumes the exact formatting of this section of text.

To do so, proceed as follows:
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1. Apply the desired character formatting (font, font size, etc.) to a section of text.

2. Place the text cursor in this section of text or select it as both options work equally well.

3. Right-click to open the context menu and select the entry Character style.

4. Select the desired style in the list.

5. Click on Update from text.

The style now "forgets" its previous formatting settings and assumes the formatting of the selected section of
text. (Of course, you can still change the formatting of the style at any time, regardless of this section of text.)

Deleting or renaming character styles

To delete a character style in the current document, select it in the above dialog box by clicking on it and then
click on the Delete button. To give a style a new name, click on Rename and type the new name.

Note: The predefined styles that you can choose under Show: All styles in the dialog box cannot be deleted. However, you can reset
these styles to their delivery state if you have changed them (when you reset them, they are deleted from Styles in document/Styles in
use). If you have changed predefined styles or already used them in the text, they appear in the list Show: Styles in document/Styles in use
and can be deleted from this list, but remain in the list Show: All styles in their delivery state. The default style "Normal" cannot be
deleted, reset, or renamed.

After you delete or reset a character style, the formatted sections of text in the document retain their formatting.
These sections of text are now directly assigned the character style on which the deleted style was based. For
more information, see "Based on" character styles. Those formatting options that were explicitly set in the
deleted style and now remain in the text are treated as if the text was formatted manually – and are thus retained
even if you change formatting later in the style.

If there are character styles based on the deleted style, they are now linked directly to the style basis of the
deleted style.

Deleting or renaming character styles in a document template

To delete or rename the styles in a document template, open the document template, make the changes there
and then save the template.

Scope of character styles

Did you change a character style and nothing happened in some of the sections of text that were assigned this
style? This happens because these sections of text were subsequently reformatted manually.

An example:

Let's assume that you define a style with the Arial font and apply it. If, for example, you now change the style's
font to Times New Roman, all sections that are formatted in this style will change accordingly.

However: If you subsequently selected a completely different font in one of these sections of text via the
command group Home | Character, the change to the character style no longer affects this section. That is to
say, manually applied character formatting takes precedence over styles.
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If you want the affected section of text to be "freed" from its manual formatting, choose the command Reset
character formatting on the ribbon tab Home | group Character. The section of text now has the formatting
specified in the character style again.

Tip: You can also reset the character formatting using the shortcut keys Ctrl+Space.

"Normal" character style

The character style called "Normal" is present by default in every document and has a special significance: it is
the default style for the text. When you start entering text in a new document, the "Normal" character style is
automatically used for the text.

If you change the "Normal" character style – for example, the font – the font of the entire text will be changed
(except for text that you have formatted manually in a different font via the ribbon tab Home | group
Character). Furthermore, subsequent text will appear in this default font which you have redefined as the
"Normal" character style for the document.

If you want to apply a different character style to your existing text instead of the default "Normal" style, select
the text and follow the instructions in Applying character styles. The selected character style then also becomes
effective for subsequent entries that you type directly after the text.

"Based on" character styles

When you create a new character style, as described at the beginning of this section, it is usually based on the
"Normal" character style. This means that the new character style is based on the formatting of the "Normal"
style. Changes to the formatting of the "Normal" style thus affect all other styles.

If you have already created your own character styles and used them in the text, the following occurs when you
choose the command Character style: In the list on the left side of the dialog box, the style of the currently
selected text is preselected – this may be the "Normal" character style or your own one – and is thus also preset
as the basis for a new style. In the list, change the style that you want to use as the basis for a new character
style, if necessary, before clicking the New button.

Please note: Subsequent changes to the formatting of the style basis will also change all styles based on it.
Only the formatting that you have already customized there will remain unchanged.

If, for example, you select a new font for the "Normal" style, the font will also change in all other character
styles – unless a different font was explicitly selected there.

Reassigning the style basis

In addition, you can reassign the style basis to a character style at any time with the option Based on.

To have a character style based on a style other than the one you previously selected, proceed as follows:

1. Right-click in the text to open the context menu and select the command Character style.
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2. In the list on the left side of the dialog box, select the character style whose basis you want to change.

Tip: If you click on the expand button >> on the bottom right, the description shows the style on which the selected character style is
currently based. Furthermore, you will find information here as to the formatting attributes of the character style that have been
modified differently from the style basis.

3. Click on the Edit button.

4. In the following dialog box, switch to the Style tab.

5. Important: In the dropdown list Based on, select the style basis to which the selected character style is to be
linked. In addition to the "Normal" style, you will also find some predefined styles and the styles you
created yourself – as well as "floating" styles. For more information, see below.

6. You can now also change the desired formatting of the character style, etc.

An application example:

Let's assume that you want to use a distinctive font for notes in a manual. However, they should also appear in
different font colors depending on the type of notes. You thus create character styles with different font colors
(for example, the styles Notes1, Notes2, etc).

If the character styles are based on each other, and you subsequently think that a different font would be more
appropriate for all notes, all you have to do is change the font in the character style that serves as the basis. All
styles based on it will then be formatted in this font, but the different font colors will remain unchanged for the
notes.

Based on: floating

When you create a new character style based on another style, all existing formatting attributes (font, font size,
font color, etc.) are generally copied from that style basis. You usually modify at least one of these attributes in
the new character style (for example, the font color: from black to red). If you then apply this character style to
a text, the text will be formatted with the modified attribute (font color: red).

However: The text will also be formatted with all other attributes of the style basis (font, font size, etc). If you
do not want this formatting, you can proceed in an alternative manner. On the Style tab, the dropdown list
Based on contains two special entries: (floating) and (floating, paragraph).

§ If you select the option (floating) and you apply the new character style to a text, only the formatting
attribute that you changed in the character style will take effect. If, for example, the font color was changed
in the new character style and you apply this "floating" character style to a text, you will only change its font
color, but all other formatting attributes of the text (font, font size, etc.) will be retained in their current
formatting. 

§ If you select the option (floating, paragraph) and you apply the new character style to a text, only the
modified formatting attribute will take effect also. However, all other formatting attributes of the text will be
reset to the character formatting of the current paragraph style.

Relative font size

If you have one style based on another, you can even specify the relative font size if you want. For example,
you can specify that the font size of style X should always be 80% of the font size of style Y.

To do so, proceed as follows:

1. Right-click in the text to open the context menu and select the entry Character style.

2. In the dialog box, select the style that you want to change from the list and click on Edit.
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3. Switch to the Style tab.

4. Enable the option Scale.

5. Enter the desired factor as a percentage, for example, 80.

6. Confirm with OK.

The font size of a style edited in this manner will always be 80% of the size specified for the style on which it is
based.

Character styles and the sidebar

On the previous pages, you learned how to create, apply and change character styles. For this purpose, the
procedure was mainly described via the dialog box of the command Character style (accessible, for example,
via the context menu or via the Organize button in the sidebar).

These tasks can also be implemented in TextMaker in a more convenient manner: via the direct commands in
the sidebar.

Showing sidebar and displaying character styles

The sidebar can display a list of all available character styles if desired. To format text with one of these styles,
for example, simply select the desired text and then double-click the style in the sidebar. You can also change,
organize and create character styles in the sidebar.

All you have to do is enable the sidebar and select the "Character styles" function in it:

1. If the sidebar is not visible, then enable it. You will find the command on the ribbon tab View | group
Windows | Sidebars. For more information, see Sidebar.

2. Then click on the icon  in the small toolbar at the top of the sidebar. This will switch the sidebar to the
"Character styles" function.

The sidebar displays the character styles in the document. The style applied to the currently selected text is
highlighted ("Normal" in this case):
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You can then perform the following actions in the sidebar:

Using character styles via the sidebar commands

§ Applying a character style 

First, select the characters to be formatted in your document. Then simply click to select the desired style in
the sidebar and click on the Apply button at the bottom of the sidebar.

Tip: Alternatively, you can simply double-click on the style in the sidebar to apply it to the selected text.

§ Editing a character style

Simply click to select the desired style in the sidebar. Then click on the Edit button at the bottom of the
sidebar.

§ Organizing character styles 

Simply click to select the desired style in the sidebar. Then click on the Organize button at the bottom of the
sidebar.

The program will display a menu with commands for organizing your styles (for creating, renaming,
deleting, etc.). Select the desired function there. Brief descriptions of the individual commands can be found
here. For more information, see Character styles.

Tip: This menu can be opened even faster: right-click on a style in the sidebar or click on the black arrow
next to the style. The dropdown menu also contains the Apply and Edit buttons described above.
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§ Creating a new character style 

In the sidebar, right-click on the style on which you want the new style to be based. The aforementioned
menu appears. Choose the command New there.

The command New from text, which is located in the menu directly below it, creates a new style based on
the selected style from the sidebar. However, the exact formatting of the section of text selected in the
document is applied.

§ Updating a character style from existing text 

You can update a character style directly with the formatting "from the text".

To do so, place the text cursor in the section of text that contains the desired formatting. In the sidebar,
right-click on the style that you want to format and select Update from text.

§ Deleting or renaming styles 

To delete a style in the current document, right-click on the style in the sidebar and choose Delete from the
menu. To give a style a new name, select Rename and type the new name.

Note: The predefined styles that you can choose under Show: All styles cannot be deleted. However, you can reset these styles to
their delivery state if you have changed them (when you reset them, they are deleted from Styles in document/Styles in use). If you
have changed predefined styles or already used them in the text, they appear in the list Show: Styles in document/Styles in use and
can be deleted from this list, but remain in the list Show: All styles in their delivery state. The default style "Normal" cannot be
deleted, reset, or renamed.

After you delete or reset a character style, the formatted sections of text in the document retain their
formatting. These sections of text are now directly assigned the character style on which the deleted style
was based (see "Based on" character styles). Those formatting options that were explicitly set in the deleted
style and now remain in the text are treated as if the text was formatted manually – and are thus retained
even if you change formatting later in the style.

If there are character styles based on the deleted style, they are now linked directly to the style basis of the
deleted style.

§ Opening the dialog box "Character style" 

You can also find and apply all the actions mentioned here in the classically arranged dialog box Character
style. To open this dialog box, click on the Organize button at the bottom of the sidebar and select
Character style. The commands of the dialog box were described in detail in Character styles.

§ Opening the dialog box for the "Manage styles" tool 

Click on the Organize button at the bottom of the sidebar and select Manage styles. A dialog box opens for
the integrated Manage styles tool, which you can use to manage the styles of documents for characters and
paragraphs. For more information, see Managing styles.

§ "Display hierarchically" checkbox 

If you enable the checkbox, the styles appear in the sidebar with a layered structure that shows how the
styles are based on each other.

§ "Preview" checkbox 

If you enable the checkbox, the formatting of the styles is displayed directly as a preview in the sidebar.

§ "Show" dropdown list 

You can choose which styles are shown here:
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All styles: Show all available styles. These are all predefined styles and the styles you created yourself.

Styles in document: Show only the styles that are used in the document and the styles you created yourself.

Styles in use: Show only the styles that are actually used in the document.

"Based on" character styles 

The manner in which you allow character styles to be based on another style works in the sidebar similar to via
the dialog box. For more information, see "Based on" character styles:

In the sidebar, select the style on which you want your new character style to be based before you choose the
command New.

To base a character style on a style other than the one that was previously selected, select the style to be
adjusted in the sidebar and click on the Edit button. In the following dialog box, you can change the style basis
on the Style tab.

Tip: The style basis on which a style is based and the formatting attributes which are explicitly set in the
style are visible in the sidebar via a tooltip. This tooltip is displayed when you hover over a style. This
requires Show tooltips to have been enabled.
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Paragraph styles
You can save a frequently used paragraph format (indents, tabs, alignment, etc.) in a paragraph style and then
apply it repeatedly to any paragraph you like.

If, for example, you want the headings in your document to be in large bold type and centered, simply create a
paragraph style called "Heading" and apply it to the desired paragraphs.

Note: The difference between character styles (see Character styles) and paragraph styles is that character
styles contain only saved character formatting (font, text styles, etc.), while paragraph styles contain both
character formatting and paragraph formatting.

Furthermore, character styles are also applicable to individual characters, while paragraph styles are applicable
only to whole paragraphs.

The following pages contain detailed information on working with paragraph styles. The following topics are
covered:

§ Creating paragraph styles 

§ Applying paragraph styles

§ Changing paragraph styles

§ Scope of paragraph styles

§ "Normal" paragraph style

§ "Based on" paragraph styles

§ Paragraph styles and the sidebar

Note: On the following pages, the procedure is mainly described by means of a dialog box, which you can
reach by right-clicking with the mouse button and selecting Paragraph style in the context menu. These
tasks can also be conveniently performed with the direct commands in the sidebar, which are described in
the last section Paragraph styles and the sidebar.

If the sidebar is not visible, enable it on the ribbon tab View | group Windows | Sidebars.

Creating paragraph styles

To create a paragraph style, proceed as follows:

1. Right-click in the text to open the context menu and select the command Paragraph style.

The following dialog box opens:
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2. In the list on the left side of the dialog box, select the style on which you want your new paragraph style to
be based. In the event of doubt, use the "Normal" style.

Note: The style of the section of text in which the text cursor was located before choosing the command Paragraph style is always
preselected here in the dialog box. For information on changing the style basis – even afterwards – see "Based on" paragraph styles.

3. Click on the New button in the dialog box.

4. Give the paragraph style whatever name you like.

5. The program will display a dialog box which is very similar to the dialog box for the command group Home
| Paragraph. Here, you can specify the desired paragraph formatting. For more information, see Paragraph
formatting.

6. If you will need this style frequently, you can assign a shortcut key to it (see below).

7. When you have made all desired settings, click on OK in the dialog box Paragraph to create the style.

8. Exit the dialog box Paragraph style with Close.

The style is now created and ready for use. You will soon learn how to use it. For more information, see
Applying paragraph styles.

Creating paragraph styles from selected text

Alternatively, you can first format some text as desired and then create a new style that assumes this exact
formatting. For this purpose, use the New from text button instead of the New button.

This procedure is useful if you have previously formatted paragraphs manually and now want to create a
paragraph style with exactly the same paragraph formatting.

To do so, proceed according to the following detailed steps:
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1. Apply the desired paragraph formatting (indents, line spacing, paragraph alignment, etc.) to one or more
paragraphs.

2. Place the text cursor inside one of these paragraphs or select the paragraphs (both methods produce the same
result).

3. Create a new paragraph style via the command Paragraph style, as described above. Important: Use the
New from text button in the dialog box now instead of the New button.

A paragraph style created in this manner will behave like any other paragraph style. The only difference is that
it assumes its initial formatting from existing text. Of course, you can change its formatting options at any time.

The option "Next style" – or: Which style should be applied to the next paragraph?

Each time you complete a paragraph with a specific style by pressing the Enter¿ key, the same style is
automatically applied to the next paragraph.

However, this is impractical in some cases. For example, headings usually consist of just a single line followed
by normal text, and when you have typed a heading, you usually want to revert to the "Normal" style.

Therefore, for each paragraph style, you can specify the style to be applied to the next paragraph once the
current paragraph is completed by pressing Enter¿. To do so, click on the Edit button to open the dialog box
and switch to the Style tab. There, select the desired style in the Next style dropdown list – thus the "Normal"
style in our example.

Using shortcut keys

If you need a style frequently, you can assign it a shortcut key at any time. The advantage of this is that you can
then enable the style very swiftly with one press of a key.

To assign a shortcut key to a style, click on the Edit button to open the dialog box and switch to the Style tab.
There, position the text cursor in the Shortcut key input field and press the desired key combination (starting
with Ctrl or Alt).

Note: If you press a key combination that is already assigned, the current assignment is displayed below the
input field Shortcut key. You should then press the Backspace keyÕ to delete your shortcut key and use a
different key combination. Otherwise, you will overwrite the key combination for another style or even for
one of TextMaker's commands.

We recommend that you always use key combinations that include the keys Ctrl and Shift since they are not
usually assigned.

Applying paragraph styles

 To apply a paragraph style, proceed as follows:

1. Place the text cursor in the paragraph to which you want to apply the style (or select multiple paragraphs).

2. Right-click in the text to open the context menu and select the command Paragraph style.

3. In the list on the left side of the dialog box, select the desired style.
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Tip: A small preview of the selected style is shown in the right half of the dialog box. You can enable or
disable this preview via the >> or << buttons.

4. Click on Apply.

The formatting of the selected paragraphs immediately changes to the formatting specified for the paragraph
style.

Tip 1: The ribbon tab Home | group Styles always displays the paragraph style selected for the current
paragraph. You can switch to a different style here at any time by expanding the list and clicking on the
desired style.

Tip 2: You can also change the paragraph style in the sidebar by double-clicking on the desired style. The
sidebar contains many other direct commands that enable you to conveniently edit styles. For more
information, see Paragraph styles and the sidebar.

Tip 3: If you assigned a shortcut key to the style, you can apply styles even faster: simply press the assigned
key combination.

Changing paragraph styles

Of course, you can change paragraph styles again at any time.

Important: Changing the formatting of a paragraph style automatically changes the formatting of all
paragraphs to which that style was applied! However, this automatic reformatting applies in a limited way to
paragraphs where you manually changed the paragraph formatting after you assigned the style (see the next
section).

To change a paragraph style, proceed as follows:

1. Right-click in the text to open the context menu and select the command Paragraph style.

2. In the dialog box, select the style you want to change from the list.

3. Click on Edit.

4. Make the desired changes to the style.

5. In the dialog box Paragraph, click on OK.

6. Exit the dialog box Paragraph style with Close.

The style has now been changed accordingly.

Determining which paragraph styles are displayed in the dropdown list "Show"
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By default, the dialog box Paragraph style only shows the styles that are used in the document. If required,
switch between the following options to select which styles should appear in the list:

All styles: Show all available styles. These are all predefined styles and the styles you created yourself.

Styles in document: Show only the styles that are used in the document and the styles you created yourself.

Styles in use: Show only the styles that are actually used in the document.

Updating a paragraph style from existing text

The Update from text button in the dialog box Paragraph style allows you to update a style "from the text".

If you click on this button, the formatting of the currently selected text will be transferred to the selected style.
The style thus assumes the exact formatting of this section of text.

To do so, proceed as follows:

1. Apply the desired paragraph formatting (indents, line spacing, paragraph alignment, etc.) to one or more
paragraphs.

2. Place the text cursor inside one of these paragraphs or select the paragraphs (both methods produce the same
result).

3. Right-click to open the context menu, and select the entry Paragraph style.

5. Select the desired style from the list.

6. Click on Update from text.

The style will now "forget" its previous formatting settings and will assume the formatting of the selected
section of text. (Of course, you can still change the formatting of the style at any time, regardless of this section
of text.)

Deleting or renaming paragraph styles

To delete a style in the current document, select it in the above dialog box by clicking on it and then click on
the Delete button. To give a style a new name, click on Rename and type the new name.

Note: The predefined styles that you can choose under Show: All styles in the dialog box cannot be deleted. However, you can reset
these styles to their delivery state if you have changed them (when you reset them, they are deleted from Styles in document/Styles in
use). If you have changed predefined styles or already used them in the text, they appear in the list Show: Styles in document/Styles in use
and can be deleted from this list, but remain in the list Show: All styles in their delivery state. The default style "Normal" cannot be
deleted, reset, or renamed.

After you delete or reset a paragraph style, the formatted sections of text in the document retain their
formatting. These sections of text are now directly assigned the paragraph style on which the deleted style was
based. For information, see "Based on" paragraph styles. Those formatting options that were explicitly set in
the deleted style and now remain in the text are treated as if the text was formatted manually – and are thus
retained even if you change formatting later in the style.

If there are paragraph styles based on the deleted style, they are now linked directly to the style basis of the
deleted style.
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Deleting or renaming paragraph styles in a document template

To delete or rename the styles in a document template, open the document template, make the changes there
and then save the template.

Scope of paragraph styles

Did you change a paragraph style but the formatting of some of the paragraphs to which this style had been
applied didn't change accordingly? This is because these paragraphs were subsequently reformatted manually.

An example:

Let's assume that you define a style specifying the paragraph alignment to be centered. If you subsequently
change the style's alignment to right-aligned, all paragraphs formatted in that style will change accordingly.

However: If you subsequently selected a different paragraph alignment for one of these paragraphs via the
command group Home | Paragraph, the change to the style no longer affects this paragraph. Manually applied
paragraph formats thus take precedence over styles.

If you want such a paragraph to be "exempt" from manual formatting, simply select it and reapply the original
paragraph style (using the steps described in Applying paragraph styles). The format of the paragraph will
revert to that specified in the style, and subsequent changes to the style will affect the paragraph.

"Normal" paragraph style

The paragraph style called "Normal" is present by default in every document and has a special significance: it is
the default style of paragraph formatting in the document. When you start entering text in a new document, the
"Normal" paragraph style is automatically used for the text.

If you change the "Normal" paragraph style – for example, the line spacing – the line spacing of the entire text
will be changed (except for paragraphs where you have set a different line spacing manually via the ribbon tab
Home | group Paragraph). Furthermore, subsequent text will appear with this line spacing which you have
defined in this manner as the new default spacing in the "Normal" paragraph style for the document.

If you want to apply a different paragraph style to your existing text instead of the default "Normal" style, select
the text and follow the instructions in Applying paragraph styles.

"Based on" paragraph styles

When you create a new paragraph style, as described at the beginning of this section, it is usually based on the
"Normal" paragraph style. This means that the new paragraph style is based on the formatting of the "Normal"
style. Changes to the formatting of the "Normal" style thus affect all other styles.
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If you have already created your own paragraph styles and used them in the text, the following occurs when you
choose the command Paragraph style: In the list on the left side of the dialog box, the style of the currently
selected paragraph is preselected – this may be the "Normal" paragraph style or your own one – and is thus also
preset as the basis for a new style. In the list, change the style that you want to use as the basis for a new
paragraph style, if necessary, before clicking the New button.

Please note: Subsequent changes to the formatting of the style basis will also change all styles based on it.
Only the formatting that you have already customized there will remain unchanged.

If, for example, you select a new line spacing for the "Normal" style, it will also change in all paragraph
styles (except for those styles where you have explicitly specified a different line spacing).

Reassigning the style basis

In addition, you can reassign the style basis to a paragraph style at any time with the option Based on.

To have a paragraph style based on a style other than the one you previously selected, proceed as follows:

1. Right-click in the text to open the context menu and select the command Paragraph style.

2. In the list on the left side of the dialog box, select the paragraph style whose basis you want to change.

Tip: If you click on the expand button >> on the bottom right, the description shows the style on which the selected paragraph style
is currently based. Furthermore, you will find information here as to the formatting attributes of the paragraph style that have been
modified differently from the style basis.

3. Click on the Edit button.

4. In the following dialog box, switch to the Style tab.

5. Important: In the dropdown list Based on, select the style basis to which the selected paragraph style is to
be linked. In addition to the the "Normal" style, you will also find some predefined styles and the styles you
created yourself.

6. You can now also change the desired formatting of the paragraph style, etc.

An application example:

The print version of this manual illustrates the use of linked paragraph styles. Here, the paragraph styles for all
heading levels are based on a single paragraph style that specifies, among other things, an increased spacing
from the previous paragraph.

When we subsequently decided that the spacing we had chosen was too small, we only had to increase it in the
single underlying style, and the spacing of all headings was increased. If we had based the styles on "Normal",
we would have had to change each of these heading styles separately.

Paragraph styles and the sidebar

On the previous pages, you learned how to create, apply and change paragraph styles. For this purpose, the
procedure was mainly described via the dialog box of the command Paragraph style (accessible, for example,
via the context menu or via the Organize button in the sidebar).
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These tasks can also be implemented in TextMaker in a more convenient manner: via the direct commands in
the sidebar.

Showing sidebar and displaying paragraph styles

The sidebar can display a list of all available paragraph styles if desired. To format a paragraph with one of
these styles, for example, simply position the text cursor in the paragraph and then double-click on the style in
the sidebar. You can also change, organize and create paragraph styles in the sidebar.

All you have to do is enable the sidebar and select the "Paragraph styles" function in it:

1. If the sidebar is not visible, then enable it. You will find the command on the ribbon tab View | group
Windows | Sidebars. For more information, see Sidebar.

2. Then click on the icon  in the small toolbar at the top of the sidebar. This will switch the sidebar to the
"Paragraph styles" function.

The sidebar displays the paragraph styles in the document. The style applied to the currently selected text is
highlighted ("Normal" in this case):

You can then perform the following actions in the sidebar:

Using paragraph styles via the sidebar commands

§ Applying a paragraph style 

Place the text cursor in the desired paragraph in the text (or select several paragraphs). Simply click to select
the desired style in the sidebar and click on the Apply button at the bottom of the sidebar.

Tip: Alternatively, you can simply double-click on the style in the sidebar to apply it to the selected text.
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§ Changing a paragraph style

Simply click to select the desired style in the sidebar. Then click on the Edit button at the bottom of the
sidebar.

§ Organizing paragraph styles 

Simply click to select the desired style in the sidebar. Then click on the Organize button at the bottom of the
sidebar.

The program will display a menu with commands for organizing your styles (for creating, renaming,
deleting, etc.). Select the desired function there. Short descriptions of the individual commands can be found
here. For more information, see Paragraph styles.

Tip: This menu can be opened even faster: right-click on a style in the sidebar or click on the black arrow
next to the style. The dropdown menu also contains the Apply and Edit buttons described above.

§ Creating a new paragraph style 

In the sidebar, right-click on the style on which you want the new style to be based. The aforementioned
menu appears. Choose the command New there.

The command New from text, which is located in the menu directly below it, creates a new style based on
the selected style from the sidebar. However, the exact formatting of the section of text selected in the
document is applied.

§ Updating a paragraph style from existing text 

You can update a paragraph style directly with the formatting "from the text".

To do so, place the text cursor in the section of text that contains the desired formatting. In the sidebar,
right-click on the style that you want to format and select Update from text.

§ Deleting or renaming styles 

To delete a style in the current document, right-click on the style in the sidebar and choose Delete from the
menu. To give a style a new name, select Rename and type the new name.

Note: The predefined styles that you can choose under Show: All styles cannot be deleted. However, you can reset these styles to
their delivery state if you have changed them (when you reset them, they are deleted from Styles in document/Styles in use). If you
have changed predefined styles or already used them in the text, they appear in the list Show: Styles in document/Styles in use and
can be deleted from this list, but remain in the list Show: All styles in their delivery state. The default style "Normal" cannot be
deleted, reset, or renamed.

After you delete or reset a paragraph style, the formatted sections of text in the document retain their
formatting. These sections of text are now directly assigned the character style on which the deleted style
was based. For more information, see "Based on" character styles. Those formatting options that were
explicitly set in the deleted style and now remain in the text are treated as if the text was formatted manually
– and are thus retained even if you change formatting later in the style.

If there are paragraph styles based on the deleted style, they are now linked directly to the style basis of the
deleted style.

§ Opening the dialog box "Paragraph style" 

You can also find and apply all the actions mentioned here in the classically arranged dialog box Paragraph
style. To open this dialog box, click on the Organize button at the bottom of the sidebar and select
Paragraph style. The commands of the dialog box were described in detail in Paragraph styles.
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§ Opening the dialog box for the "Manage styles" tool 

Click on the Organize button at the bottom of the sidebar and select Manage styles. A dialog box opens for
the integrated Manage styles tool, which you can use to manage the styles of documents for characters and
paragraphs. For more information, see Managing styles.

§ "Display hierarchically" checkbox

If you enable the checkbox, the styles appear in the sidebar with a layered structure that shows how the
styles are based on each other.

§ "Preview" checkbox

If you enable the checkbox, the formatting of the styles is displayed directly as a preview in the sidebar.

§ "Show" dropdown list

You can choose which styles are shown here:

All styles: Show all available styles. These are all predefined styles and the styles you created yourself.

Styles in document: Show only the styles that are used in the document and the styles you created yourself.

Styles in use: Show only the styles that are actually used in the document.

"Based on" paragraph styles

The manner in which you allow paragraph styles to be based on another style works in the sidebar similar to via
the dialog box. For more information, see "Based on" paragraph styles:

In the sidebar, select the style that you want your new paragraph style to be based on before you choose the
command New.

To base a paragraph style on a style other than the one that was previously selected, select the style to be
adjusted in the sidebar and click on the Edit button. In the following dialog box, you can change the style basis
on the Style tab.

Tip: The style basis on which a style is based and the formatting attributes which are explicitly set in the
style are visible in the sidebar via a tooltip. This tooltip is displayed when you hover over a style. This
requires Show tooltips to have been enabled.
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Managing styles
TextMaker's integrated Manage styles tool allows you to manage the styles of documents. Its main purpose is to
copy character and paragraph styles from one document to another.

To start the "Manage styles" tool, proceed as follows in the sidebar:

Note: If the sidebar is not visible, enable it on the ribbon tab View | group Windows | Sidebars. For more
information, see Sidebar.

1. Click on one of the Paragraph styles  or Character styles  icons in the small toolbar (at the top of
the sidebar).

2. Choose the command Manage styles via the Organize button (at the bottom of the sidebar).

The following dialog box opens:

By default, the list on the left side of the dialog box displays the styles of the current document, while the list
on the right is empty.

You use the "Manage styles" dialog box via the following controls:
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Style list on the left side

In the style list on the left side of the dialog box, all paragraph styles and character styles of the current
document are displayed. You can select one or more styles in the list and click on one of the buttons of the
dialog box to perform the desired action. To select multiple styles, press and hold the Ctrl key and then click on
each entry that you want to select.

If you would like to open a different document in the list, click on the Open button and select the desired file.

Style list on the right side

The style list on the right side works just like that on the left side. You can open a second document in it at any
time. To do so, use the Open button located below the list on the right side. You can now copy styles back and
forth between the two documents.

>> and << buttons

You can use these buttons to copy styles back and forth between the two documents that are open in the dialog
box.

To do so, select one or more styles in either list. Then click on the >> button to copy the style(s) from the list on
the left to that on the right side. The << button copies styles from the list on the right to that on the left side.

If you try to copy a style that already exists in the target document, TextMaker first asks you if you would like
to overwrite it.

Rename button

This button can be used to rename styles. To do so, select the desired style, click on the Rename button and
enter the new name.

Note: The "Normal" default style cannot be renamed.

Delete button

This button can be used to delete styles. To do so, select the desired style(s) and click on theDelete button.

Note: The "Normal" default style cannot be deleted.

Close button

Use this button to close the "Manage styles" tool.
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Document templates
As you learned in the previous sections, character and paragraph styles are always saved in the document in
which they were created. If you want to use such styles in other documents also, you should save them in a
document template.

Each time you choose the ribbon command File | New , TextMaker allows you to select a document template
as the basis for the new document. If, at this point, you select a document template that you have created, the
new document will have the same character and paragraph styles that you saved in the template.

Document templates can also include text – for example, your letterhead. Thus, you can kill two birds with one
stone: You can create a document template with your letterhead and your favorite styles for letters, another for
annual reports and so on.

Templates linked to a database

It gets even better: You can assign a database to a document template and then insert database fields into it.
When you create a new document based on this template, the TextMaker database appears automatically and
lets you select a record and insert its fields into your letterhead, your fax form, etc. (The database fields
themselves are physically replaced in the document by the content of the inserted record.)

Creating a letter becomes child's play: Simply choose the command File | New, select the letter template and
the recipient's name and address – and you will obtain a fully completed letterhead.

Tip: TextMaker contains numerous predefined document templates for letters, flyers, etc. Try them out –
just choose the ribbon command File | New (click on the icon itself to open the dialog box), and then select
one of the templates in the subfolders.

For more information, see Importing individual addresses.

For general information on working with document templates, see the next pages.

Creating document templates

To create a new document template, proceed as follows:

1. Start a new document or open a document or document template that you want to use as the basis for the
new template.

2. Edit the text in the document if you want the document template to contain text also.

3. Make any desired changes to the character and paragraph styles.

4. If you want, you can even change settings in the dialog boxes Layout | group Page setup (group arrow )
and File | Properties. These settings will then also be saved in the document template.
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5. Choose the ribbon command File | Save as.

6. Select the entry Template from the dropdown list Save as type.

7. At this point, TextMaker switches automatically to the folder where the document templates are located.
Android/iOS: This step is not supported here. Navigate manually to the folder "SoftMaker/TextMaker NX templates".

8. Type a name for the template in the File name input field.

9. Confirm that you want to save it.

Organizing templates in several folders: You can use the New folder button at any time to create a new folder
under the Templates folder, then switch to the new folder and save the template there. In this way, templates
can be stored in separate folders according to their use. The document templates supplied with TextMaker are
organized according to such types as business letters, personal letters and flyers.

Using document templates

To use a document template, simply start a new document with the command File | New. You can specify on
which document template this is to be based.

Proceed as follows:

1. Choose the ribbon command File | New  to open the dialog box. (Click directly on the icon itself.)

2. You can select the required document template in the dialog box.

In the Template list on the left, you will also see some folders with predefined document templates for
writing letters and flyers.

3. After you have selected a template, confirm with OK.

The system now creates a new document for which all character and paragraph styles saved in the document
template become available. The settings defined in the dialog boxes Layout | group Page setup (via the group
arrow ) and File | Properties are also adopted from the template.

In addition: If the document template also contains text, this text is displayed accordingly in the new document
and can be edited just like normal text.

Tip: TextMaker is supplied with various predefined document templates for business letters and personal
letters. These templates include complete letterheads and are linked to the address database
addressbook.sqlite. They make your daily paperwork a lot easier – see Importing individual addresses
for more information!

Editing document templates

Changing a document template is no different from editing a normal document. You open the template, make
your changes and save the document template.
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Important: Of course, changing a document template will affect all documents that are subsequently created
on the basis of this template.

To change a document template, proceed as follows:

1. Choose the ribbon command File | Open (click directly on the icon itself).

2. Select Template from the dropdown list of file types.

3. Select the template to be changed and confirm that it has been opened.

4. Make the desired changes to the text or to the character and paragraph styles.

5. Choose the ribbon command File | Save to save the changed template.

Of course, you could also save the template under a different name via the ribbon command File | Save as if
you did not want to overwrite the original template.

"Normal.tmvx" document template

The Normal.tmvx document template is the default template for new documents. If you choose the command
File | New, this template will always be set. It contains no text and only the default "Normal" character and
paragraph styles as well as some styles for headings.

Accordingly, the Normal.tmvx template is a suitable basis for creating a completely new document template
from scratch.

Important: You should not usually change the Normal.tmvx default template. If you want to do this
anyway, you should be aware that Normal.tmvx contains the default values for page, paragraph and
character formatting as well as many other default values. A change affects all documents which are then
created based on the Normal.tmvx default template.

If, for example, you want to change the default font for all documents that will be created in future based on the
Normal.tmvx template, open this template, change the character formatting of the "Normal" paragraph style,
and save the template.

You can also choose a different default template for new files:

To do so, choose the ribbon command File | New  (click directly on the icon itself), select the desired
template in the dialog box and click on Set as default. From now on, TextMaker will always offer this template
as the default template when you create a new document.
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Multi-column page layouts
Text can be laid out in multiple columns next to each other in TextMaker. You can change the number of
columns within a document as often as you like. To format text in columns, use the ribbon command Layout |
group Section | Columns.

Entering text in a multi-column text area is not much different from entering it in a single-column area. The
only difference is that when you reach the end of the first column, your text is not continued on a new page, but
is continued in the next column on the same page. In other words: a column break is automatically inserted. A
page break is inserted only when you continue typing past the end of the last column.

Manual column break: If the text is formatted in columns, you can also instruct TextMaker to perform a manual
column break before the automatic column break:

1. Place the text cursor in the desired position.

2. Click on the arrow of the Break icon on the ribbon tab Insert  (or Layout) and select Column break.
TextMaker then breaks the column immediately.

Tip: You can also use the key combination Ctrl + Shift + Enter for this purpose.

See the following pages for more information on setting up multi-column text.

Changing the number of columns
To reformat a single column passage of text to a three-column passage for example, you only have to select the
text and change the number of columns via the ribbon command Columns.

Via the "Columns" icon

For up to three columns, you can easily use the predefined entries of the Columns icon  on the ribbon tab
Layout | group Section.

To do so, proceed as follows:

1. Select the text area whose number of columns you want to change.

2. Click on the small arrow of the Columns icon  and select a predefined column layout from the menu that
appears: up to three columns (of the same size); a two-column layout with a narrower column on the left or a
two-column layout with a narrower column on the right.

The selected column layout will now be applied to the selected text. To do so, TextMaker automatically sets up
a separate section in the document with the required section breaks. (For more information, see also What are
sections?)

If, on the other hand, you want to apply a specific column layout to the entire document, simply place the
cursor in the text (do not select anything). Then select the desired number of columns as described above. Note:
This only works if your document is not divided into sections. 
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In the dialog box below, the option Apply to also provides even more differentiated methods of specifying
which part of the document should be divided into columns. The dialog box also provides numerous other
options, such as a larger number of columns.

Tip: If you want to use different numbers of columns on the same page, you must define sections and
proceed as follows: In the dialog box shown below, disable Page break and set the Height to Auto.

Other options: Via the dialog box "Section"

Additional options for setting up multi-column text can be found in the dialog box "Section".

To do so, proceed as follows:

1. Select the text whose columns you want to adjust.

2. Click directly on the Columns icon  to open the dialog box.

Alternatively: Click on the small arrow of the icon and select More in the dropdown menu.

The system displays the following dialog box:

Specify the number of columns and their format in this dialog box:
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§ Presets section 

Here, you can select one of several predefined column layouts by clicking on it.

§ Columns section

This option lets you specify the number, width and spacing of columns.

Enter the desired number of columns for Number.

Specify the width and spacing of the columns in Width and Spacing respectively. If Equal column width
is enabled, all columns will have the same width and spacing. If this option is disabled, you can specify a
different width and spacing for each column.

§ Height section 

This option lets you specify the height of the columns:

Auto: If you select this setting, TextMaker automatically adjusts the column height to fit the text length so
that all columns are of equal height.

Page height: With this setting, the column height is set equal to the page height, regardless of the text
length.

Fixed height: If you select this setting, you can set a fixed column height.

§ Page break 

If this option is enabled, TextMaker inserts a page break before the multi-column section.

§ Restart auto numbers 

This option is not relevant for multi-column layout. If it is enabled, it resets the "Auto number" field in the
relevant section to one. For information on using this field, see Numbering with auto numbers.

§ Text direction 

You can use this option to change the text direction of a multi-column section of text in Arabic. If you set
the direction to right-to-left, the column on the far right becomes the first column (instead of the column on
the far left). For more information, see also Working with Arabic text.

§ Margins button 

Here, you can specify the margins of the section, including the amount of blank space TextMaker should
insert above and below the section.

§ Gutter line button 

Click on this button if you want a vertical line to be displayed between the columns of multi-column text.

When you click it, the program displays a dialog box in which you can select the desired line style,
thickness, etc.

If you want to remove the line, simply select No line as the Line style.

§ Apply to: 

In the dropdown list, specify which parts of the document are to be affected by the settings made in this
dialog box:

Whole document: the entire document.
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Note: The following options in the list refer to defined sections. A section is a passage of text with the
same number of columns. For more information, see What are sections? Furthermore, the available
options will vary depending on what you have selected in the text.

This point forward: the passage of text from the current position of the text cursor to the end of the
document. In this case, a new section is automatically defined after the cursor.

Selected text: the section of text currently selected in the document. In this case, a new section is
automatically defined for the selected passage of text.

Current section: the current section of text.

Selected sections: all sections included in the current selection.

To end of section: the text from the text cursor to the end of the current section.

What are sections?
The term "section" was mentioned several times in this chapter. What are sections? A section is a passage of
text in which you can, for example, format the number of columns uniformly, separately from the rest of the
text.

Note: Defining sections is primarily performed for multi-column text, but it is also relevant for restarting
Auto numbers or displaying Line numbers.

Example: In the middle of an otherwise single-column document, a section of text is formatted in two columns.
The prerequisite for such a presentation of your text is that the text is divided into several sections. You can do
so manually using the Insert section break feature (see below). You can then format a separate number of
columns for each section.

By doing this, you have created three sections: a single-column section at the beginning of the document, a two-
column section in the middle and another single-column section at the end.
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If you would rather format the two-column section in the middle as three columns, simply place the text cursor
anywhere within this section, and choose the command Columns on the ribbon tab Layout | group Section.
Then change the number of columns to 3. The two-column section will then become a three-column section.

Inserting section break manually

Choose the ribbon command Layout | group Page setup | Insert break (click on the icon’s arrow and select
the entry Section break) to specify the beginning of a new section. Before choosing the command, place the
cursor in the text where you want the new section to begin. The section will be valid from this point until the
next section break (if one is inserted), otherwise until the end of the document.

In this way, documents can be divided into several sections. Each section can be formatted with a different
number of columns.

Tip 1: If you enable the icon  for displaying the formatting marks on the ribbon tab Home | group
Paragraph, you can see the breaks for better orientation in the document.

Tip 2: The number of the current section (Section1, Section2, etc.) is displayed in the status bar.

Section breaks are inserted automatically when columns are defined

If you format a text segment with multiple columns using the command Columns (see previous section), a
separate section with the required section breaks is automatically created by TextMaker. To do so, proceed as
follows:

1. Select the passage of text that is to have a different number of columns than the rest of the document.

2. Click on the arrow of the Columns icon  on the ribbon tab Layout | group Section.

3. Select the desired number of columns.

Tip: Clicking directly on the Columns icon will open a dialog box in which you can make further settings
(see previous section).

A separate section with the selected number of columns is now defined for the selected passage of text, and the
document is divided into several sections by the automatically inserted section breaks.

It is thus unnecessary to insert section breaks manually.

Page break before sections

By default, TextMaker does not insert a page break between two sections, but simply lets the text continue from
one section to the next. If, on the other hand, you want to always have a page break before a specific section,
move the text cursor to this section. Open the dialog box "Section" by clicking directly on the Columns icon on
the ribbon tab Layout | group Section, and enable the option Page break in this dialog box.
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Searching and replacing
This chapter explains the functions for searching and replacing text and formatting.

§ Search and replace 

You can use the ribbon command Home | Search to search for terms in the text or use the ribbon command
Home | Replace to replace them with other terms.

If, for example, a text contained several occurrences of the name "Smith" misspelled as "Smyth", you could
direct TextMaker to replace all occurrences of "Smyth" with "Smith".

If necessary, you can use Advanced search options to define your search more specifically. You can also
search and replace formatting, such as character or paragraph formatting.

§ Bookmarks

Bookmarks provide another way of quickly finding specific points in the document. To do so, you set a
bookmark at the desired point in the document and give it a name. You can now jump to such points in the
document at any time by choosing the ribbon command Home | Go to. You can insert as many bookmarks
as you like in a document.

§ The command Go to 

The command Go to also allows you to scroll to specific points in the document – for example, to a specific
page, a specific chapter, a specific object, etc.

§ Searching with the sidebar 

In addition to the ribbon command Home | Search for searching for terms in the text, there is another option
whereby you enable the sidebar and use the search function integrated there.

§ Navigating with the sidebar 

You can navigate quickly and directly in the document map in a document by enabling the sidebar. This
displays all headings, bookmarks, objects, etc. on the right edge of the window. Simply click with the mouse
to jump to the corresponding point in the document.

See the following pages for more information.

Tip: Using shortcut keys

The following shortcut keys are available for the search and replace functions:

Command Windows/Linux Mac

Search Ctrl+F Cmd+F

Replace Ctrl+H Cmd+H

Search again F3 F3

Go to F5 or Ctrl+G F5 or Cmd+G
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Note: If the sidebar is enabled, Ctrl+F / Cmd+F initially opens the search function in the sidebar rather than in the dialog box. If you use
the key combination a second time, you will finally reach the dialog box.

Search

You can search a document for a specific term using the ribbon command Home | Search .

It is even possible to search for formatting – for example, for all passages in bold print. For more information,
see Searching/replacing formatting.

You perform a text search as follows:

1. Choose the ribbon command Home | Search .

Note: If the sidebar is enabled, you must click on the command Home | Search a second time in order to open the above dialog box
(or press Ctrl+F). Alternatively, you can work with the search function in the sidebar. For more information, see Searching with the
sidebar.

2. Under Search for in the dialog box, enter the text for which you want to search.

3. Enable the desired search options (see Advanced search options) if required.

4. Click on the Search button to start the search.

When TextMaker finds the search text, it jumps to its position in the document and selects it.

You now have the following options:

A.You can click on Search again to proceed to the next occurrence of the search text.

B. You can close the dialog box by choosing Close.
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It is not only possible to search for a specific text, but you can also replace it with something else. For more
information, see the next section.

Replace
Sometimes, you want to do more than just find a term in the text. You also want an easy way of replacing it
with another term. The ribbon command Home | Replace (in the Search group) is used for this purpose.

Proceed as follows:

1. Choose the ribbon command Home | Replace .

2. Under Search for, enter the text for which you want to search.

3. Under Replace with, enter the text that is to replace the search text.

4. Enable the desired search options (see Advanced search options) if required.

5. Click on the Search button to start the search.

When TextMaker finds the search text, it scrolls to its position in the document and selects it.

You now have the following options:

A.You can click on Replace, whereupon the search term is replaced with the replacement term and TextMaker
jumps to the next occurrence of the search term.

B. You can click on Search again, whereupon TextMaker jumps to the next occurrence of the search term –
without replacing the term.

C. You can click on Replace all, whereupon TextMaker replaces all other occurrences of the search term in the
text.

D.You can close the dialog box by choosing Close.

Tip: It is even possible to search for formatting and replace it with different formatting, for example, replacing
bold passages with passages in italics. For more information, see Searching/replacing formatting.

Repeating a search/replace
To repeat a search or replace operation or to continue it after canceling, choose the ribbon command Home |

Search again  or simply press the F3 key.

TextMaker continues the search and displays the next occurrence of the search term.
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Tip: To continue a search, you can also use the following key combinations: Ctrl+PageDownâ to jump to
the next occurrence and Ctrl+PageUpá to jump to the previous occurrence.

Advanced search options

In the dialog box of the ribbon command Home | Search  or Home | Replace , you can click on the
Enlarge button, which expands the dialog box and offers additional options.

Clicking on Reduce makes the dialog box smaller again.

The enlarged Search and replace dialog box offers the following additional options:

"Options" section

Here, you can change the following settings for the search operation:

§ Case-sensitive 

The case of letters in the search term is ignored by default. Thus, if you search for "house", not only
"house", but also "House", "HOUSE", "HouSe", etc. will be found.

If you enable this option, however, the program will only find those occurrences of the search term where
the cases of the letters correspond exactly to the cases of the letters in the search term. Thus, if you search
for "house", only "house" will be found.

§ Whole words only

If you enable this option, the search term will only be found if it occurs as a separate word.

Thus, if you search for "test", it will be found only when it occurs as a separate word and not when it forms
part of another word like "testament" or "protest".

§ Search from top 

TextMaker usually starts a search at the current position of the text cursor. If you enable the option Search
from top, however, TextMaker starts at the beginning of the document.

If the option Search backwards is enabled, the option Search from end appears here instead. This works
accordingly.

§ Search backwards 

If you enable this option, the search is performed backwards, that is, from the current position of the text
cursor to the beginning of the text.

§ Search all frames 

By default, TextMaker searches only in the text frame in which the text cursor is currently positioned. If the
text cursor is in the body text, only the body text is searched. If you enable this option, however, TextMaker
searches the body text and all existing text frames (including headers and footers).
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"Reset" button

The Reset button deletes the content of the Search for field or the Replace with field (including formatting) –
depending on which of these two fields contains the text cursor.

"Format" button

The Format button allows you to search documents for specific formatting – for example, for all sections of
text in bold print or for all centered paragraphs.

Click on this button and set the formatting for which you want to search.

For more information on this function, see the next section (Searching/replacing formatting).

"Special" button

The Special button allows you to search a document for special characters and to use wildcards such as "Any
character":

§ Any number (^#) – if you specify, for example, a search for "200^#", TextMaker will find occurrences of
2000 through 2009. 

§ Any letter (^$) – if you specify, for example, a search for "^$", TextMaker will find occurrences of a
through z and A through Z (including all letters with umlauts or other accents).

§ Any character (^?) – TextMaker searches for any character whatsoever (letter, number or special
character).

§ Any smart quote (^q) – TextMaker searches for any type of smart quote. (In contrast, neutral quotes like
"or" will not be found.)

§ Caret (^^) – searches for the character "^" (caret).

§ Non-breaking space (^n) – TextMaker searches for non-breaking spaces.

§ Tab (^t) – TextMaker searches for tabs.

§ Line break (^z) – TextMaker searches for manual line breaks (inserted with Shift+¿).

§ Paragraph mark (^a) – TextMaker searches for the paragraph mark that is at the end of each paragraph.

§ Page break (^p) – TextMaker searches for manual page breaks inserted with the command Insert | Break |
Page break.

§ Section break (^s) – TextMaker searches for section breaks inserted with the command Insert | Break |
Section break.

§ Chapter break (^c) – TextMaker searches for chapter breaks inserted with the command Insert | Break |
Chapter break.

To insert such a wildcard into the search term, click on the Special button, and then select the desired
placeholder by clicking on it.
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You can repeat and combine these wildcards as desired within the same search term. Furthermore, you can use
them in combination with normal text. A search for "^#^# gallons of ^$^$^$" would yield all occurrences of
this form – for example, "10 gallons of oil", "42 gallons of gas", etc.

Searching/replacing formatting
The ribbon commands Home | Search and Home | Replace allow you to search for formatting as well as text –
and even to replace the specified formatting with other formatting as required.

You can thus replace a specific font that occurs repeatedly in the text with another font, for example.

To search for formatting, proceed as follows:

1. Choose the ribbon command Home | Search .

2. If the Format button is not displayed in the dialog, click on the Enlarge button to expand the search dialog.

3. Delete any previous search term in the Search for field by clicking on the Reset button.

4. Click on the Format button.

5. Select the type of formatting for which you want to search: character formatting, paragraph formatting,
character styles or paragraph styles.

6. The program opens a dialog box in which you specify the formatting for which you want to search. Then
confirm with OK.

7. You can now start the search by clicking on the Search button.

To search for formatting and replace it with other formatting, proceed as follows:

1. Choose the ribbon command Home | Replace .

2. Use the Format button to specify the formatting for which you want to search (see above) and then confirm
with OK.

3. Click in the input field Replace with.

4. Use the Format button again to specify the formatting that is to replace the formatting specified above as
the search term. Confirm with OK again.

5. You can now start the search with the Search button.

When TextMaker finds an occurrence of the search term, it displays the occurrence in the document.

To continue searching, click on the Search again button. Alternatively, if you want to replace the formatting,
click on the Replace button. If you click on Replace all, TextMaker will replace all occurrences of the
formatting you are searching for in the text with the new formatting.
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Tip: You can use this function, for example, to replace one font with another throughout the document.
However, experts would use styles in this case (see Styles) because they provide a much more elegant means
of performing this task. If you change the font in a style, all sections of text that are formatted with this style
are automatically changed accordingly.

By the way, searching for text and formatting can also be combined. Thus you can search for a specific search
term with a specific formatting. For example, if you enter "TextMaker" as the search term and also specify bold
character formatting for the search, the search will find every occurrence of "TextMaker" in bold characters in
the document.

Bookmarks
As with a book, you can also add markers to TextMaker documents to quickly retrieve important passages of
text, for example. These markers are called bookmarks.

To insert a bookmark, choose the command Insert | Bookmark at the desired position in the text and give the
bookmark a name. Once you have marked a position in the text in this way, you can jump to it at any time with
the command Home | Go to.

Setting bookmarks

To mark a position in the text, set a bookmark there. To do so, proceed as follows:

1. Move the text cursor to the position in the text where you want to set the bookmark.

2. Choose the ribbon command Insert | group Links | Bookmark .

3. Type in any name for the bookmark.

Note: Bookmark names may contain only letters, numbers and underscores. Special characters are not allowed. The first character
must always be a letter.

4. Click on OK to set the bookmark.

You can create as many bookmarks as you want in any document.

Retrieving bookmarks

To retrieve a bookmarked position in the text, proceed as follows:

1. Choose the ribbon command Home | Go to  or press F5.

2. Select Bookmark from the Go to list.

3. Select the desired bookmark from the list or enter its name manually.

4. Confirm with Go to if necessary.

TextMaker now moves the text cursor to the position in the text where you created the bookmark.

Tip: Alternatively, use the sidebar to retrieve bookmarks. For more information, see Navigating with the sidebar.
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Deleting bookmarks

If you no longer need a bookmark, you can delete it at any time. To do so, proceed as follows:

1. Choose the ribbon command Insert | Bookmark .

2. Select the bookmark you want to delete from the list or enter its name manually.

3. Click on Delete.

Alternatively, click on Delete all to remove all bookmarks.

Note: When you delete a passage of text containing a bookmark, the bookmark is deleted automatically.

Displaying bookmarks in the document

Bookmarks are invisible by default. However, you can make them visible if required. To do so, enable the
option Display bookmarks in the document in the dialog box of the ribbon command Insert | Bookmark.
Bookmarks are then displayed in the text (surrounded by angle brackets).

Alternatively, you can use the ribbon command Toggle bookmarks  directly on the ribbon tab View | group
Fields to change the mode.

Note: You will also find the corresponding option as Show bookmarks in the dialog box of the ribbon command File | Properties, View
tab.

Go to
You can use the command Home | Go to (in the group Search) to jump to a specific location in the document –
for example, to a specific page or bookmark.

To jump to a specific page, for example, proceed as follows:

1. Choose the ribbon command Home | Go to .

2. In this dialog box, select the option Page in the Go to list.

3. Enter the desired page number and press the Enter key¿ or the Go to button. The page will then be opened
immediately.

4. Click Close to exit the dialog box.

If you select one of the other options in the Go to list, you can also perform the following operations with this
command:

Option Function

Page Jump to the specified page (as described above)

Chapter Jump to the specified chapter
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Bookmark Jump to the specified bookmark

Footnote Jump to the specified footnote

Footnote text Jump to the footnote text of the specified footnote

Object Jump to the selected object (picture, table, etc.)

Table of contents Jump to the document's table of contents

Index Jump to the document's index

Bibliography Jump to the document's bibliography

Bibliography field Jump to the specified bibliography field of the document

Heading Jump to the specified heading of the document

etc.

Tip: Using the buttons at the bottom of the vertical scrollbar

You can also use the three buttons in the bottom right corner of the document window to jump to specific points
in the document.

You use these buttons as follows:

§ If you click on the button with the red dot, a small menu will appear. In it, you can select which "Go to"
operation you want to perform. 

§ If you click on the button with the up arrow, TextMaker will jump to the previous position. If, for example,
you selected "Page" in the menu, the previous page will be displayed.

§ If you click on the button with the down arrow, TextMaker will jump to the next position, for example, to
the next page.

Searching with the sidebar
In addition to the ribbon command Home | Search described in the section Searching, which starts searching
for terms in a text via a dialog box, TextMaker provides another practical option whereby you use the sidebar
to search for a specific term in a document.

To do so, you must enable the sidebar:

Note: If the sidebar is already enabled, choosing the ribbon command Home | Search (or Ctrl+F) will open
the search function in the sidebar. Choose this command a second time to use the search function in the usual
way via the dialog box.
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1. If the sidebar is not visible, then enable it. You will find the command on the ribbon tab View | group
Windows | Sidebars. For more information, see Sidebar.

2. Then click on the magnifying glass icon  in the small toolbar at the top of the sidebar. This will switch
the sidebar to the "Search" function.

Here, you will find a search function that is equipped with options similar to the dialog box of the ribbon
command Home | Search.

Enter a search term under Search for and then click on the Search button. There are additional options above
this button, which you can set before searching if required. For more information, see Advanced search options.

The Results list shows all hits found in the document, including the text surrounding them. In addition,
TextMaker jumps from the text cursor's position to the first occurrence of the search term in the text. If you
click on the Search button again, you will reach the next occurrence of the search term.

Tip: Click on a hit in the list to jump to the respective occurrence in the document.

Mini toolbar for navigating between occurrences of the search term

At the bottom of the sidebar, there is also a mini toolbar that allows you to move between the occurrences:

The buttons mean the following (from left to right):

§ jump to the first occurrence in the document 

§ jump to the previous occurrence in the document

§ jump to the next occurrence in the document

§ jump to the last occurrence in the document

Opening the dialog box "Search and replace" via the sidebar

The dialog box Search and replace with advanced search options can also be opened directly via the sidebar:

§ The Advanced button at the bottom of the sidebar opens the dialog box Search and replace. For more
information, see Search.

Alternatively: Choose the ribbon command Home | Search (or Ctrl+F) again.

§ If you click on the Replace button to the right, you will reach the "Replace" tab of this dialog box directly,
similar to the ribbon command Home | Replace (or Ctrl+H). For more information, see Replace.

Disabling search via the sidebar

You have to disable the sidebar if you want the the dialog box Search and replace, rather than the sidebar, to be
displayed directly when you choose the ribbon command Home | Search (or Ctrl+F).

This can be done on the ribbon tab View | group Windows | Sidebars  by clicking on the small arrow of the
icon and disabling the option Show sidebars.
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Navigating with the sidebar
In addition to the ribbon command Home | Go to (see Go to ), there is another useful tool for navigating within
documents: the sidebar.

You can display a list of all headings in the document, among other things, in the sidebar. To jump to a specific
heading, simply click on the corresponding entry in the list. Alternatively, the sidebar can list all bookmarks,
objects, footnotes, and other parts of the document.

All you have to do is enable the sidebar and select its navigation function.

1. If the sidebar is not visible, then enable it. You will find the command on the ribbon tab View | group
Windows | Sidebars. For more information, see Sidebar.

2. Then click on the icon with the compass needle  in the small toolbar at the top of the sidebar. This will
switch the sidebar to the "Document map" function.

The sidebar now lists all headings in the document (if any), for example. To jump to a specific heading, simply
click on the corresponding list entry.

Which parts of the document can be displayed?

It is not only possible to jump to headings in the same way, but also to other parts of the document. For this
purpose, open the dropdown list Document content at the top of the sidebar and select what you would like the
sidebar to display.

You can choose from among the following parts of the document:
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Option Function

Headings Sidebar displays all headings in the document

Bookmarks Sidebar displays all bookmarks

Tables Sidebar displays all tables

Pictures Sidebar displays all pictures

Objects Sidebar displays all objects (pictures, drawings, tables, etc.)

Footnotes Sidebar displays all footnotes (these are in the footnote area)

Footnote references Sidebar displays all footnote references (these are in the text)

Endnotes Sidebar displays all endnotes (these are in the endnote area)

Endnote references Sidebar displays all endnote references (these are in the text)

Comments Displays all comments

Captions Displays all captions (for images, etc.)

The list in the sidebar then displays the desired content. If you click on one of the list entries, TextMaker will
immediately jump to the relevant position in the document.

Tip: At the bottom of the sidebar, you will find buttons with which you can navigate between the entries in the
list (forward, back, start, end). For certain parts, there are also options regarding the display structure
(alphabetical sorting enabled/disabled, limiting outline levels).
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Fields

You can insert different types of "fields" into the text by choosing the ribbon command Insert | Field  (in
the group Text). The command can also be found under References (or Mailings) | Field.

Fields are placeholders that symbolize a specific piece of information. The "Print date" field, for example,
stands for the current date; the "Page number" field stands for the current page number, etc. The available fields
can even contain content from fields of a database that are needed for mail merges.

Whenever a document is opened or printed, all the fields it contains are updated automatically. Thus, if you
reprint a document with the "Print date" field tomorrow, tomorrow's date will appear in the printout. Apart from
that, you can manually update the fields of a document at any time by choosing the ribbon command

References (or Mailings) | Update fields .

Fields can be formatted, deleted, copied, and moved like normal text, but their content cannot be edited directly.

The following pages provide detailed information on the use of fields.

Inserting a field
To insert a field into the text, proceed as follows:

1. Move the text cursor to the desired position.

2. Choose the ribbon command Insert | group Text | Field .

Alternatively: Choose References | group Fields | Field or also Mailings | group Insert | Field.

You can use the Field button to take two different paths:

Common options: Via the arrow of the "Field" button

For a pre-sorted selection of common fields, click on the black arrow on the Field icon and select a suitable
entry directly from its dropdown menu (see below for an explanation of the fields).
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The field is displayed as a preview in the text if you hover over it in the dropdown menu and is inserted as soon
as you click on the desired entry.

You will also find another entry in the dropdown menu: Calculation (not available in the dialog box below).
This inserts a formula as a field in the text. For more information on this function, see Inserting calculations.

The dropdown menu also contains the entry More, which opens the following dialog box with additional
options.

Additional options: Via the dialog box

You can also open the dialog box by clicking directly on the Field icon  itself.

Select the type of field to be inserted from the Field type list.
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You can then change the type or manner in which the field is displayed in the right half of the dialog box – in
the figure here, for example, the format in which the print date should be output.

When you have made your selection, click on Insert.

The field is then inserted into the text and is displayed there. You usually see the result of the field
immediately. Thus, if you insert, for example, the "Print date" field, the current date will be displayed in the
text.

List of all available field types

The dialog box above contains the following field types:

§ Creation date 

The date on which the current document was created

§ Creation time

The time at which the current document was created

§ Print date 

The current date. This field – like all field types – is updated automatically when you print the document.

§ Print time 

The current time. This field is automatically updated when the document is printed.

§ Date last changed 

The date on which the current document was last changed (that is, saved)

§ Time last changed 

The time at which the current document was last changed (that is, saved)

Note: For all of the aforementioned fields with date or time, you can also define the display format via the
New format button. (Only these formats can be deleted again.) For more information, see Defining your
own date and time formats.

§ Database field 

The content of a field from a database that has been assigned to the document. The specific database field to
be inserted is selected from the Field name list. For more information, see also Database.

§ Database info 

The following information about the database assigned to the document: Database name only (file name of
the database), Full database name (the file name of the database with the path name), Database record
number (the record number of the current record) and Record count (number of records in the database).

§ Page number 

The current page number, see Formatting page numbers

§ Page count 

The total number of pages in the document
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§ Chapter number 

The number of the current chapter. For more information, see also Dividing a document into chapters.

§ Sequence number 

The sequential number that is automatically inserted into captions. For more information, see Captions and
tables of figures.

§ Style reference 

You can use this field to search the document backwards for text in the selected style and then display that
text. This allows you to display, for example, the current main heading (which is usually formatted in the
paragraph style "Heading 1") in the text. For more information, see Style references.

§ File name 

The file name of the current document, optionally with the complete path (for example, C:
\Documents\Test.tmdx) or without the path (for example, Test.tmdx)

§ Summary 

Information about the current document (Subject, Author, Keywords, etc.). You can edit the content of these
fields by clicking on the Summary button. For more information, see also Document summary.

§ Last edited by 

This field contains the name or initials of the user who last changed (that is, saved) the document.

To enter your name and initials, choose the ribbon command File | Options, switch to the General tab in the
dialog box and click on the User info button.

§ User info 

This field contains various personal details that can be edited via the User info button.

You can insert one of these fields in the text if you want your name, address, telephone number, etc. to
appear in the document. These field types are used, for example, in the document templates supplied with
the program.

Note: Alternatively, you can also edit your user info by choosing the ribbon command File | Options,
switching to the General tab and clicking on the User info button.

§ Auto number 

This field generates a sequential number. For more information, see Automatic numbering.

Editing and updating fields
You can edit or update fields at any time by proceeding as follows:
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Editing fields

If you want to edit an existing field, for example, to change its date format, simply select the field in the text
and choose the ribbon command Insert | Field again. Alternatively: Choose References | Field or Mailings |
Field.

Again, select either the path via the small black arrow of the dropdown menu icon or click directly on the icon
itself to open the dialog box. Make the desired changes, and the selected field in the text will be replaced
accordingly.

Tip: You can also open the dialog box by double-clicking directly on the field.

Updating fields

When you open and print a document, all the fields it contains will be updated automatically. Thus, if you print
a document containing the "Print date" field tomorrow, tomorrow's date will appear in the field.

You can manually update the fields at any time by choosing the ribbon command References | Update fields

 or by pressing the F9 key. All fields and calculations in the document will then be updated.

Displaying field names and shading fields
If you want to check the location of various fields in a document, you can enable the option Field names at any
time. TextMaker then displays the field names in curly brackets instead of their results – for example, {Print
time} for the "Print time" field.

This option can be enabled and disabled on the ribbon tab References (or Mailings or View) | group Fields |
Field names. The enabled mode is indicated by the darker color of the button.

Alternatively, you can find this setting as the Display field names checkbox in the dialog box by choosing the
ribbon command File | Properties on the View tab.

The respective mode, which you have enabled using one of the aforementioned alternative options, is applied as
the same setting to all of these places.

Tip: You can switch the option Display field names even faster using the shortcut keys Alt+F9. The
respective mode that you have enabled is also applied here to the button and the dialog box.

In the aforementioned command group Fields (as in the dialog), you will also find an option called Shade
fields. If you enable this option, all fields in the document will be grayed out so that they can be more easily
distinguished from normal text. The enabled mode is also applied here in the same way.

Note: The two options Field names and Shade fields only affect the current document.
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Defining your own date and time formats
For fields that return a date or time, you can specify the display format yourself if you do not like any of the
predefined formats.

To do so, open the dialog box by clicking on the icon itself with the ribbon command Insert | Field . In the
dialog box, select the desired date or time field and then click on the New format button.

Tip: You can also change the display format via the ribbon command Insert | Date/time. For more
information, see the next section.

The program displays another dialog box in which you can specify the display format by entering abbreviations.
As you enter these abbreviations, TextMaker shows an example of the result.

Any combination of the following abbreviations can be used in your specified format (pay attention to case!):

Abbreviation Meaning Example

d Day 2

dd Day with two digits 02

ddd Weekday abbreviated to three letters Mon

dddd Weekday spelled out Monday

m Month 4

mm Month with two digits 04

mmm Name of the month abbreviated to three letters Apr

mmmm Name of the month spelled out April

yy Year with two digits 18

yyyy Year with four digits 2018

h Hour (12-hour format) 8

hh Hour with two digits (12-hour format) 08

H Hour (24-hour format) 8

HH Hour with two digits (24-hour format) 08

M Minute 5
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MM Minute with two digits 05

S Second 0

SS Second with two digits 00

am Show am/pm after the time am

AM Show AM/PM after the time AM

In addition, you can use any separator (period, slash, etc.) in your entry.

Example: If you enter "dddd, d. mmmm yyyy" as the format in the Print date field, the date 4/26/2018 will be
represented as "Wednesday, 26 April 2018".

Change language: You can also change the current language of a section of text in the status bar. If you format
text in another language, month names, weekdays, and times in date and time fields will be automatically
displayed in that language. For more information, see also Formatting text in another language.

Inserting the date and time as text
You can use the ribbon command Insert | Date/time (in the group Text) to insert the current date or time into
the document as fixed text.

Unlike the fields described on the previous pages, this command uses the current date or time to create a fixed
text that will no longer be updated automatically.

If you choose the ribbon command Insert | Date/time , a dialog box appears. Here, you can select whether
the text should contain the date or time, and you can specify the format.

If you do not like any of the predefined formats, you can click on the New format button and type in your own
format, while using the abbreviations described in the previous section.

If you want the date or time to be inserted as a field, rather than as fixed text, enable the option Insert as field in
the dialog box. TextMaker then creates a field Print date or Print time. For more information on the use of
fields, see the previous sections.

Tip 1: Using shortcut keys

For inserting the date or time (as fixed text), there are the following shortcut keys:

§ Insert date: Ctrl+. (period) 

§ Insert time: Ctrl+Shift+. (period) 

When you press one of these key combinations, the date or time will be inserted immediately – without a dialog
box appearing.
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Tip 2: Changing language

If you want to insert the date and time in a format of another language, simply change the current language in
the status line for the section of text, and then choose the command Date/time as described above. For more
information, see also Formatting text in another language.
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Inserting special characters
Some characters, such as the copyright sign, the degree sign and the accented characters used in some
languages, cannot be entered into text directly with the keyboard. With TextMaker, you can easily insert these
special characters into the text via the built-in character table.

To do so, proceed as follows:

1. Open the dialog box via the ribbon command Insert | Symbol  (in the group Text) by clicking directly
on the icon.
Tip: If you click on the icon's arrow rather than directly on the icon itself, a small selection of the last used special characters will open for quick use.
If you click on More here, you will open the dialog box again.

2. The dialog box displays all characters available in the currently selected font. You can select a different font
from the dropdown list Font if necessary.

3. You can use the dropdown list Set to jump to a specific section of the character set. For example, you can
select Cyrillic to view the Cyrillic characters (provided the selected font contains such characters).
Note: Many fonts contain only a few of the available character sets. A particularly large reservoir of characters is available in the standard fonts
supplied with your operating system. In Windows, for example, these include such fonts as Arial, Tahoma and Times New Roman.

4. Select the character to insert with the arrow keys and press Enter¿ or double-click on the character to insert
it into the text.
Tip: If you know the Unicode of the character you want to insert (for example, 20AC for the Euro sign €), you can enter it in the Code field. The
program will then jump directly to the corresponding character.

5. You can now insert more characters in the same way or exit the dialog box with the Close button.

Tip for Windows users: Most versions of Windows include two icon fonts named Symbol and Wingdings.
These fonts contain numerous useful symbols (phone symbols, bullets, etc.).

Using shortcut keys

If you need to insert a special character frequently, you can always give it a shortcut key. The advantage of
doing so is that you can then apply the character very quickly with one press of a key.

To assign a shortcut key to a special character, proceed as follows:

1. Choose the ribbon command Insert | Symbol  to open the dialog box.

2. Select the special character to which you want to assign a shortcut key.

3. Click on the Change button next to the option Shortcut key.

4. Another dialog box appears. In the Press new shortcut key input field, press the desired key combination
(starting with Ctrl or Alt).

We recommend that you always use key combinations that include the keys Ctrl and Shift since they are not
usually assigned. If you press a key combination that is already assigned, its current assignment will be
displayed just below the Press new shortcut key input field. You should then press the Backspace keyÕ
to delete your shortcut key and use a different key combination. Otherwise, you will overwrite the key
combination of another TextMaker command.
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5. Don't forget: Click on Add to assign this shortcut to the character.

6. Confirm with OK and exit the main dialog box with Close.

From now on, you can insert this special character into the text by pressing the relevant key combination.

Note: The shortcut key only remembers the selected character but not the selected font.

Inserting special characters via their character code

There is another method for inserting special characters: by typing in its hexadecimal character code (Unicode)
and then pressing the key combination Ctrl+Alt+Shift+X.

If, for example, you type 20AC and then press this key combination, you will get a euro sign € because it has
the character code 20AC in the Unicode character table.

Tip: The Unicode value will be displayed in the aforementioned dialog box when you click on a special character.

Inserting special characters via Alt + numeric keypad

Here is yet another method for inserting a special character, via its ASCII code: Press and hold down the Alt
key and enter the respective sequence of numbers (only possible via the numeric keypad!). Please also ensure
that the numeric keypad is enabled by pressing the Num key.

If, for example, you type Alt+0128, you will obtain a euro sign € as soon as you release the Alt key.

Tip: You can display the ASCII code of a special character in Windows via the search term "Character map".

Mac/Linux: On some systems (including macOS and several Linux distributions), these shortcut keys do not
work.

Applying selected formatting and special characters via the "Character" icon

The ribbon command Insert | Character  (in the group Text) opens a dropdown menu with some special
formatting and special characters, such as:

§ Soft hyphen / non-breaking hyphen: see Hyphenation 

§ Non-breaking space: see Paragraph control

§ Dashes and spaces of different widths

§ Ellipsis and some other useful special characters.

Tip: If you click on the icon  on the far right of the character in the dropdown menu, you can assign your
own shortcut key to the character.

For more information on changing the keyboard mapping, see Customizing shortcut keys. You can edit the
shortcut keys for special characters described in this section by selecting the "Characters" entry in the upper left
list Categories in the dialog box.
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Automatic numbering
TextMaker has several functions for generating automatically generated numbering. In this chapter, you will
learn everything you need to know about this topic:

§ Simple numbering 

The first section introduces the command Numbering  on the ribbon tab Home | group Paragraph.
This command is useful for numbering paragraphs. A number is inserted to the left of each successive
paragraph and the paragraph is indented accordingly.

§ Numbered lists

If desired, you can also use the command Numbered lists  in the same command group to apply
hierarchical numbering (1., 1.1., 1.1.1., etc.). In addition, the Advanced functions section explains how to
create your own numbered lists and how to save and repeatedly apply the layout and settings of a paragraph
numbering.

§ Numbered headings 

You can also use numbered lists to automatically number the headings of a document. For more information,
see Numbering headings.

§ Numbering with auto numbers 

Besides the aforementioned methods for numbering paragraphs, you can insert an Auto number field
anywhere in the text. All occurrences of this field are automatically numbered consecutively.

§ Adding line numbers 

In addition, you can have TextMaker show line numbers next to the document text. The line numbers are
shown in the left page margin and are also printed.

For more information on these topics, see the following pages in the aforementioned order.

Simple numbering

The Bulleted lists section describes how to use the command Bullets  on the ribbon tab Home | group
Paragraph to add a "bullet" to certain paragraphs.

Right next to it is the command for applying Numbering  to paragraphs. TextMaker automatically
indents the paragraphs at the left to make room for the numbers and then assigns a sequential number to the
paragraphs.



194Automatic numbering

Paragraphs with numbering

You can use as many numbered bullets as you want within a document. The numbering is automatically reset to
one at the start of each new list.

Applying numbering

You will find the commands for numbering via the Numbering icon  on the ribbon tab Home | group
Paragraph.

Numbering can be applied in different ways after you have selected the relevant paragraphs:

A. If you only want to apply a numbering without any further changes, simply click directly on the icon itself
(not on the arrow next to it). The default numbering or the last numbering you selected will then be used.

B. For a selection of predefined numbering options, click on the arrow next to the icon. A dropdown menu
appears with default numbering and any numbering previously used in the document. Click on the desired
numbering to insert it directly.

C. If you want to adjust numbering via the dialog box with all additional options, however, click on the arrow
next to the icon, and select Format numbering. For further steps in the dialog box, see "Other options: Via
the dialog box Bullets and numbering" below.

The selected paragraphs are now numbered.

Note: You can use as many numbered lists as you want within a document. The numbering automatically
starts again for each group of contiguous paragraphs. More specifically: If there is an unnumbered paragraph
in front of a numbered paragraph, the numbered paragraph's number is automatically reset to "1".
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Skipping numbering

You can pause the numbering for a paragraph and then resume it for a subsequent paragraph.

To do so, place the text cursor in the relevant paragraph and choose one of the following paths:

A.Click on the arrow next to the icon  and select Skip numbering from the dropdown menu.

B. To navigate via the dialog box, click on the arrow next to the icon, but now select Format numbering. On
the Bullets and simple numbering tab, enable the option Skip numbering.

The selected paragraph's number has now been removed, and only its indentation is retained. The numbering
resumes for the following paragraph.

Tip: You can also easily access the option Skip numbering via the context menu.

Discontinuing or removing numbering

To discontinue numbering paragraphs or to remove a previously applied numbering, proceed as follows:

First, position the text cursor at the end of the last numbered paragraph and press Enter¿ to start a new
paragraph. Alternatively: Select the numbered paragraphs if you want to completely remove the numbering of
these paragraphs.

In this case also – as when applying numbering – different paths are possible:

A.Simply click again directly on the icon itself  to remove the numbering.

B. Alternatively, click on the arrow next to the icon and select None from the dropdown menu.

C. To navigate via the dialog box, click on the arrow next to the icon, but now select Format numbering. On
the Bullets and simple numberings tab, you will find the option None under Type.

Tip: You can also easily access the option Remove numbering via the context menu.

Other options: Via the dialog box "Bullets and numbering"

To open the numbering dialog box, click on the arrow next to the icon  on the ribbon tab Home | group
Paragraph. Select Format numbering from the dropdown menu.

Tip: If numbering already exists, you can access the dialog box even faster by clicking on the numbering
directly in the text. Alternatively, you can navigate via the context menu by selecting the entry Bullets and
numbering.
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In the open dialog box, you can make the following settings for numbering on the Bullets and simple
numbering tab:

§ Type 

Here, you can specify either Numbering or a Bullet for the selected paragraph(s). Select the Numbering
option for numbering. (For information on the option Bullet, see Bulleted lists.)

Note: You can always convert a numbered list into a bulleted list simply by changing the "Type" to Bullet. You can also do it the
other way round, of course.

If you set the type to None, existing bullets or numbers are removed.

§ Before and After

If necessary, you can specify text to be added before and/or after the number that TextMaker will assign to
the paragraph. If, for example, you want the numbers to be surrounded by dashes (-1-, -2-, -3- etc.), select
the Format "1, 2, 3, ..." and enter "-" in the Before and After fields.

§ Format 

Here, you specify the format of the numbering. In addition to the usual Arabic numbers (1, 2, 3, etc.), you
can also select letters (A, B, C, etc.) or Roman numerals (I, II, III, etc.).
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§ Numbering starts with ... 

TextMaker starts every numbered list at "1" by default. If you want to use a different start value, enter "5"
here, for example, and the numbering will start at "5".

Tip: Furthermore, you can also do the following (of particular interest for legal texts): If, for example,
you have set the numbering a, b, c, etc., for the above option Format, and have entered the start value
"aa", you create numbering like aa, bb, cc, etc. Alternatively, if you enter the start value "aaa", you create
numbering like aaa, bbb, ccc, etc.).

§ Skip numbering 

Within a numbered list, you often require a paragraph for which the numbering is to be temporarily
suspended, but then resumed for the following paragraph. To do so, position the text cursor in the numbered
paragraph that you want to exclude from the numbering and select the option Skip numbering.

The selected paragraph's number is then removed, and only its indentation is retained. The numbering
resumes for the following paragraph.

§ Character button 

You can click on this button to change the character formatting (font and font size, text styles, etc.) for the
numbers.

§ Horizontal position 

This option allows you to specify how far the text should be indented to the right to make room for the
numbers.

§ Vertical position 

This option allows you to specify the vertical position of the numbers. If the value is negative, the number is
positioned lower. It is positioned higher if the value is positive.

§ Alignment 

This option determines how the numbers that are below each other are aligned: left-aligned, centered, or
right-aligned (especially relevant when transitioning to two-digit or three-digit numbers).

§ Numbered lists tab 

This tab gives access to an additional option for creating lists with bullets or numbers: numbered lists. Here,
numbered lists can be saved and re-used whenever you need them. In addition, hierarchical numbering (1.,
1.1., 1.1.1., etc.) is also possible via numbered lists.

For information on numbered lists, see the next section.

Numbered lists
If you want to use a certain type of numbering more frequently in a document, you can use numbered lists from
either predefined templates or individually created numbered lists. To do so, you can open the relevant dialog
box in which you can specify the desired numbering type and format.

You can then apply a numbered list to any paragraphs. The paragraphs will then be given the exact numbering
format that you specified in your numbered list.
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A further advantage: If you subsequently change the formatting of the numbered list, all paragraphs formatted
with this list will change accordingly.

Using hierarchical lists

An additional advantage of numbered lists is that hierarchical numberings can also be created. While simple
lists (like 1., 2., 3. etc.) have only one level, hierarchical lists can have several levels. For example, a
hierarchical list may look as follows:

1.
1.1.
1.2.
2.
3.
etc.

In the above example, the two paragraphs under 1. have second-level numbering: 1.1 and 1.2.

For more information on creating numbered lists, see the next pages.

Applying numbered lists

The commands for numbered lists can be found via the Numbered lists icon  on the ribbon tab Home |
group Paragraph.

You can use this button to directly apply and edit predefined lists or to create your own custom lists and then
apply them. For more information, see Advanced functions: Creating your own numbered lists).

Applying finished lists directly with the icon's dropdown menu

If you want to access predefined lists immediately without creating your own list, proceed as follows:

1. Position the text cursor in the paragraph to which you want to apply the numbered list, or select multiple
paragraphs.

2. On the ribbon tab Home | group Paragraph, click on the small arrow of the Numbered lists icon .

3. In the dropdown menu, you will find predefined numbered lists in the New lists section. If you have already
used numbered lists in the document, an additional section named In the document appears. Here, the
program displays the numbered lists already used in the document, which you can reapply directly.

Note: As soon as you have applied a numbered list for the first time, TextMaker gives this numbered list an
automatically generated name (Numbered list1, Numbered list2, etc.). You can see this name in the dropdown
menu of the Numbered lists icon  in the In the document section when you hover over a list here with the
mouse.

Tip: The numbered lists used and their names can also be found via the dropdown menu entry Format numbered lists in the dialog box.
For more information, see the paragraph "Using lists via the dialog box" below..

The information on the name of the numbered list is not completely unimportant, since you can decide at any
time when using numbered lists whether you want to continue with previous numbering or restart numbering:
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§ Continue numbering: Select the paragraph at which you want to continue the previous numbering. In the In
the document section of the dropdown list of the Numbered lists icon , select the numbered list that you
have already used and want to continue using. 

Tip: If several lists are displayed here and you don't know exactly which list is the right one to continue using: The applied list is
highlighted in blue in the dropdown menu of the Numbered lists icon when you place the cursor in the relevant paragraph.

Alternatively, simply click directly on the icon itself to reapply the last numbering used.

§ Start new numbering: In the dropdown menu of the icon Numbered lists , select a different numbered list
in either the In the document section or in the New lists section. This can then also have the same format,
but still starts with the numbering from the beginning. 

Tip: If you click directly on the icon itself , the following functions are performed depending on the
context:
a. If a list has not yet been inserted in the document, the dialog box opens (see below).
b. If a list has already been inserted in the document, the last numbering is continued.
c. If you select paragraphs that already contain numbering, the numbering is removed.

Other options in the dropdown menu of the icon

You will also find the following entries in the dropdown menu of the command Home | Numbered lists :

§ None in the Remove list section: To remove numbering from a paragraph, select the desired paragraph and
choose this option. 

§ Skip numbering: Within a numbered list, you often require a paragraph for which the numbering is to be
temporarily suspended, but then resumed for the following paragraph. To do so, position the text cursor in
the relevant paragraph and enable this option.

§ There is also a Heading lists section that can be used to automatically number all headings in a document.
For more information, see Numbering headings.

§ To further customize numbered lists – for example, by inserting additional hierarchical levels 1.1. and 1.2.
or 1.1.1, etc. – select the entry Format numbered lists in the dropdown menu to open the dialog box. (For
more information, see the following paragraphs.)

Tip: If numbering already exists, you can access the dialog box even faster by clicking on the numbering
directly in the text. Alternatively, you can navigate via the context menu by selecting the entry Bullets and
numbering.

Using lists via the dialog box

Choose the path via the dialog box if you want to make further adjustments to numbered lists. For example, you
can set additional levels, rename, edit or completely delete the numbered list in the dialog box.

Proceed as follows:

1. Position the text cursor in the paragraph to which you want to apply the numbered list or select several
paragraphs.

2. Under Home | Numbered lists , click on the icon's small arrow and select Format numbered lists to
open the dialog box.
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3. Switch to the Numbered lists tab.

4. Select the desired numbered list.

Note: Lists only appear here if numbered lists have already been used in the document. You must therefore
have already used one of the predefined lists in the dropdown menu as described above or define your own
list using the New button. For more information, see Creating your own numbered lists.

If required, you can now also set a different list level for the selected paragraph or rename, edit or
completely delete a list. Learn more about this in the paragraph "Options of the dialog box" below.

6. Click on Apply.

The paragraphs are now formatted with the relevant numbering.

Note: If you apply a hierarchical list with the option Use paragraph's outline level as list level enabled (in
the dialog box of the Edit button), numbering appears only for headings. Normal text (paragraphs with
outline level zero) will have no numbering.

Options of the dialog box

The options in the dialog box of the command Home | Numbered lists  | Format numbered lists have the
following functions:

§ Numbered lists in the upper left window 

The predefined or newly created numbered lists that were previously used in the document are displayed
here. If you select one of the numbered lists, you can either Apply it directly, Edit it or Rename it.

The entry None removes the numbering from the selected paragraph.

§  New button

Use this button to create a new individually defined numbered list. For more information, see Creating your
own numbered lists.

§ Edit button 

If you want to customize a numbered list, select it from the list on the left side of the dialog box and use the
Edit button to make individual customizations for numbering. For more information on the individual
options, see Creating your own numbered lists.

Note: Changes to a numbered list affect all paragraphs that were previously formatted with this numbered
list.

§ Delete button

To delete a numbered list completely from the document, select it in the list on the left side of the dialog box
and then click on the Delete button.

Note: When you delete a numbered list, the numbering is removed from all paragraphs that were
formatted with this list.
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§ Rename button

To rename the numbered list, select it from the list on the left side of the dialog box, click on the Rename
button and type a new name.

§ Preview

The hierarchical list level of the selected paragraph is displayed here. Here, you can set another level and
apply it directly by clicking on the desired level, as with the next option List level.

§ List level 

You can set the hierarchical list level here. If you set this option to 1, for example, the paragraph will be
formatted as a list item at level 1 and will have a number of the form "1", while if you set the option to 3, the
paragraph will have a number of the form "1.1.1", etc.

Note: The list level cannot be specified if you have enabled the option Use paragraph's outline level as list
level in the dialog box of the Edit button because TextMaker then automatically uses the outline level of the
paragraph as the list level.

§ Skip numbering

Within a numbered list, you often require a paragraph for which the numbering is to be temporarily
suspended, but then resumed for the following paragraph. To do so, position the text cursor in the relevant
paragraph and select the option Skip numbering.

The selected paragraph's number is then removed, and only its indentation is retained. The numbering
resumes for the following paragraph.

Tip: You can also easily access the option Skip numbering via the context menu or directly via the
dropdown menu of the Numbered lists icon (by clicking on the icon's small arrow).

§ Restart numbering

This option restarts the numbering for this paragraph and thus resets the number to 1.

Note: If several paragraphs are selected when you choose this command, the numbering is reset only for the
first selected paragraph.

Click on the Apply button to apply the changes to the selected paragraphs.

For information on creating custom lists, see Creating your own numbered lists.

Changing numbered lists

You can change the numbered lists used for the document at any time.

To do so, proceed as follows:

1. On the ribbon tab Home | group Paragraph, click on the small arrow of the Numbered lists icon 
and select Format numbered lists in the dropdown menu to open the dialog box.

2. Switch to the Numbered lists tab.
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3. Click to select the numbered list that you want to edit.

4. Click on the Edit button.

5. Make the desired changes. For information on the options, see Creating your own numbered lists.

6. Confirm with OK.

The numbered list has now been changed accordingly. If you want to apply the changed list to the paragraphs
that are currently selected, click on Apply. Otherwise, click on Close.

Note: Changes to a numbered list affect all paragraphs that were previously formatted with this numbered
list.

Deleting and renaming numbered lists

To delete a numbered list completely from the document, select the list in the aforementioned dialog box and
click on the Delete button.

Note: When you delete a numbered list, the numbering is removed from all paragraphs that were formatted
with this list.

You can also rename numbered lists at any time. To do so, click on the Rename button in the aforementioned
dialog box and type in the new name.

Advanced functions: Creating your own numbered lists

You can create new numbered lists and edit them in a customized manner. For example, you can customize the
number formats for each level.

To create a new numbered list, proceed as follows:

1. If you want to apply the new numbered list immediately after creating it, first select the desired paragraphs.

2. On the ribbon tab Home | group Paragraph, click on the small arrow of the Numbered lists icon 
and select Format numbered lists to open the dialog box.

3. Switch to the Numbered lists tab.

4. Click on the New button.

5. Enter any name for the new numbered list. Select one of the predefined styles and confirm with OK.

If you now want to customize the style, click on the Edit button rather than on OK, and make further
settings for the numbering if necessary (see below).

The new numbered list has now been created. If you want to apply the changed list to the paragraphs that are
currently selected, click on Apply. Otherwise, click on Close.

You can now use the numbered lists created with the New button at any time. For more information on applying
numbered lists, see Applying numbered lists.
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The Edit button opens a dialog box in which you can make the following settings for the selected numbered
list:

General options

§ Simple list or Hierarchical list 

The option you select here is crucial for the appearance of the numbered list because it determines the type
of list:

Select Simple list for a simple numbering with only one level (thus 1., 2., 3. etc.)

Select Hierarchical list for a hierarchical numbering with multiple levels (for example, 1., 1.1., 1.1.1., etc.)

§ Use paragraph's outline level as list level

This option is available only if the list type Hierarchical list was enabled.

If this option is enabled, the outline level of each paragraph is automatically used as the level for numbering
the list. If, for example, a paragraph has an outline level of 3 (thus a third-order heading), it becomes a level
3 list item when the list is applied (for example, "1.1.1").

Note: If this option is enabled, the numbering appears only for headings. Normal text (text with outline
level zero) has no numbering.

For more information on working with outlines, see Outlines.

If the option Use paragraph's outline level as list level is not enabled, you can set the list level manually
via the option List level in the main dialog box. For more information, see also Applying numbered lists.

§ Level 

This option is available only if the list type Hierarchical list was enabled.

Here, you can click to select the level of the list you want to change. If you click on "3", for example, you
can change the settings for the third level.

Each level of a hierarchical list can have its own settings. For example, you can set the color for the numbers
at level 1 to blue, and the color for the numbers at all other levels to black.

§ Preview 

The Preview field shows how the numbering will look with the current settings.

Here, you can also select which level you want to edit (as in the aforementioned Level field) for hierarchical
lists. To do so, click on the desired level in the preview.

§ Display higher levels 

This option is available only for list levels of 2 or higher in hierarchical lists.

If this option is enabled, the number applied to the numbering contains all list levels. List level 3 uses the
number "1.5.9.", for example.

If this option is not enabled, only the number for the current level is applied (thus only "9." in the above
example).
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§ Don't restart the level 

This option is available only for list levels of 2 or higher in hierarchical lists.

If this option is enabled, the number of this list level is not reset to 1 if this level follows a higher level.

Thus, if you enable this option for level 2, for example, the result will be as illustrated below:

Option disabled: Option enabled:

1. 1.

1.1 1.1

1.2 1.2

2. 2.

2.1 2.3

As you can see from the last item of the above example, the 2nd level is continued with 2.3 instead of being
reset to 2.1 if this option is enabled.

§ Reset button 

If you ever make a major mistake while editing a numbered list, you can click on the Reset button to start
again. This discards your changes and restores the original settings (for all list levels).

The other options in this dialog box allow you to change the appearance of the numbered list (see the following
pages).

As mentioned above, each level of a hierarchical list can have its own settings. Thus, before setting any of
these options, click in the Level field to select the level whose settings you want to change.

Options for bullets

If you have selected the option Bullet for Type, the following options appear in the dialog box:

§ Bullet section 

Here, you can select the bullet to be used.

The Default row contains predefined bullets from which you can choose, while the Custom row contains
user-defined bullets. To do so, click on one of the bullets in the Custom row, then click on the Change
button to the right of that row and select the character to be used as the bullet.

§ Color (only for default bullets) 

You can select a different color for the bullet from the dropdown list Color. In addition to the colors offered
here, you can define new colors at any time. For more information, see Document properties, Colors tab.

Tip: If you set the color to "Auto", TextMaker automatically uses the font color of the paragraph to the right
of the bullet.

§ Size (only for default bullets) 

Here, you can change the size (in points) of the bullet.

Tip: If you select the option "Auto" here, TextMaker automatically uses the font size of the paragraph to the
right of the bullet.
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§ Character button (only for custom bullets) 

For custom bullets, the Character button appears instead of the two options above. Click on this button if
you want to change the character format (font size, color, text styles, etc.) of the bullet.

Tip: If you do not change these settings, the bullet automatically uses the character format of the paragraph
to the right of the bullet.

§ Horizontal position 

This option allows you to specify how far the text should be indented to the right to make room for the
bullets.

§ Alignment 

This option is mainly relevant for flush alignment of Numbering (see below). Left reduces the distance to the
text, and Right increases it.

§ Vertical position 

This option allows you to specify the vertical position of the bullet on the line. If the value is negative, the
bullet is positioned lower. It is positioned higher if the value is positive.

§ Additional indent 

This setting allows you to indent the entire text (including number) further to the right or to the left with an
additional indent.

Options for numbering

If you have selected the option Numbering for Type, the following options appear in the dialog box:

§ Numbering text 

You can use this option and the next one to change the format of the numbering.

The option Numbering text is filled in automatically by the program. However, you can always make
changes. {1} is the placeholder for the number in the selected format (see next option). If {1} is entered
here, the numbers will be displayed in the form 1, 2, 3, etc. If you enter -{1}-, however, the numbers will
appear in the form -1-, -2-, -3-, etc.

If the numbering contains multiple levels, the placeholders are called {1}, {2}, {3} (for the number of the
first, second, third level), etc.

§ Format 

Here, you specify the format for the numbering. In addition to the usual "1., 2., 3., ...", you can select letters
(A, B, C, ...) or Roman numerals (I, II, III, ...).

§ Numbering starts with ... 

If you want the numbering to start with a value other than "1", then you can enter the start value "5" here, for
example, and the numbering will start with "5".

This option takes effect only when the numbering starts again or is reset via the option Restart numbering
in the main dialog box of the command.
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Tip: Furthermore, you can also do the following (of particular interest for legal texts): If, for example,
you have set the numbering a, b, c, etc., for the above option Format, and have entered the start value
"aa", you create numbering like aa, bb, cc, etc. Alternatively, if you enter the start value "aaa", you create
numbering like aaa, bbb, ccc, etc.).

§ Character button 

You can click on this button to change the character formatting (font and font size, text styles, etc.) of the
numbers.

§ Horizontal position 

This option allows you to specify how far the text should be indented to the right to make room for the
numbers.

§ Alignment 

This option determines how the numbers that are below each other are aligned: left-aligned, centered, or
right-aligned (especially relevant when transitioning to two-digit or three-digit numbers).

§ Vertical position 

This option allows you to specify the vertical position of the numbers. If the value is negative, the number is
positioned lower. It is positioned higher if the value is positive.

§ Additional indent 

This setting allows you to indent the entire text (including number) further to the right or to the left with an
additional indent.

Numbered headings
Numbered lists can also be used for automatic numbering of all headings in a document. For more information,
see Numbering headings.

Numbering with auto numbers
In addition to the automatic paragraph numbering presented on the previous pages, you can also manually
create numbering by inserting an Auto number anywhere in the text.

The "Auto number" is a field that symbolizes a sequential number. The first instance of the auto number in a
document always returns a "1", the next instance returns "2", etc.

If you insert another auto number later in the middle of the document, all subsequent auto numbers will be
increased by one. If you delete a section of text that contains an auto number, all subsequent auto numbers will
be reduced by one.
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To insert an auto number, proceed as follows:

1. Move the text cursor to the place at which the auto number is to be inserted.

2. Choose the ribbon command Insert (or References) | Field  for the dialog box (click directly on the icon
itself).

3. Select the "Auto number" field from the list Field type.

4. Click on Insert.

The auto number now appears in the text.

Resetting auto numbers

If you need multiple numberings with auto numbers within a document, you can reset the auto number to one at
any time.

To do so, proceed as follows:

1. Move the text cursor to the place at which the numbering should be reset.

2. Insert a section break with the ribbon command Insert | Break | Section break.

3. On the ribbon tab Layout | group Section, open the dialog box via the group arrow  and choose the
Columns tab.

4. Make sure that the option This point forward is selected in the dialog box under Apply to.

5. Enable the option Restart auto numbers.

6. Confirm with OK.

Don't be surprised that the Section dialog box is primarily about text columns. "Sections" are primarily
responsible for multi-column page layouts; they can also be used to reset auto numbers.

Adding line numbers
Apart from the various types of numbering presented in the previous sections, TextMaker provides a function
that displays line numbers next to a document's text. The line numbers are shown in the left margin and are also
printed.

To instruct TextMaker to show line numbers, proceed as follows:

Applying line numbers directly via the ribbon button

1. Select the specific section of text for which line numbers are to be shown.

2. Choose the ribbon command Layout | group Section | Line numbers . (Click on the small arrow of the
icon for the dropdown menu.)

3. In the dropdown menu, choose between the following settings:
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Continuous: The numbering is sequentially numbered throughout the document.

Restart on every page: Numbering starts with 1 at the beginning of each new page.

Restart at beginning of this section: Numbering starts with 1 at the beginning of the current section.
Tip: You can define new sections with the ribbon command Layout | group Page setup | Insert break | Section break . For more information, see
What are sections?

The line numbers are now displayed.

The entry No line numbers in the dropdown menu disables the display of the line numbers again. The entry
More takes you to the dialog box with additional options (see below).

Suppressing line numbers

To skip the line numbering for certain paragraphs, select these paragraphs and open the dialog box via the
group arrow  on the ribbon tab Home | group Paragraph. Switch to the Text flow tab and enable Suppress
line numbers there.

Applying line numbers via the dialog box

You can also apply line numbers via the dialog box, and additional options are available here.

1. Select the specific section of text for which line numbers are to be shown.

2. Choose the ribbon command Layout | group Section | Line numbers  to open the dialog box. (Click
directly on the icon itself.)

Alternatively: Click on the small arrow of the icon and select the entry More in the dropdown menu.

3. The Line numbers tab appears.

4. Enable the option Show line numbers.

5. Where applicable, change the desired settings for the numbering (see below).

6. Confirm with OK.

The line numbers are now displayed.

Additional options of the dialog box

In the dialog box of the command group Layout | group Section | Line numbers , you can enable Show line
numbers and then make the following additional settings:

§ Options section 

Here, you can set the following options:

First line number determines the number with which the line numbering should start.

Count by determines the interval between numbered lines. If you enter 5, for example, line numbers will
appear only at lines 5, 10, 15, 20, etc.

Distance to text determines the amount of blank space TextMaker should leave between the line numbers
and the text.
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Position determines where the line numbers should be displayed: in the left or right page margin or in the
inner or outer page margin (for documents with opposite pages, for example, books).

§ Numbering section 

This option determines if and when to restart numbering:

Restart at beginning of this section: The numbering is reset to 1 only at the beginning of the current
section. Tip: You can define new sections with the ribbon command Insert | Break | Section break.

Restart on every page: The numbering is reset to 1 at the beginning of every page of the document.

Continuous: The numbering is sequentially numbered throughout the document.

There is also the option Skip empty paragraphs. If this is enabled, the numbering skips all paragraphs that
are completely empty.

§ Apply to: 

This option determines which part of the document will be affected by the settings made in this dialog box:

Whole document: the entire document.

This point forward: the section of text from the text cursor to the end of the document.

Selected text: the section of text currently selected in the document.

Current section: the current section of text. Tip: You can use the ribbon command Insert | Break | Section
break to divide the document into as many sections as you want.

Selected sections: all sections included in the current selection.

To end of section: the text from the text cursor to the end of the current section.
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Inserting breaks

In the dropdown menu of the Break icon  on the ribbon tab Insert (or Layout), you have commands for
inserting different types of breaks.

Click on the small arrow  of the Break icon to select from the break types shown below. For information on
how the individual commands work, see the specified sections:

§ Line break 

See Line break – insert manually 

§ Column break and Section break 

See Multi-column page layouts and What are sections?

§ Page break 

See Inserting manual page breaks 

§ Chapter break 

See Dividing a document into chapters and Outlined documents and chapters

Note: The last selected command from the dropdown menu of the Break icon is marked and the icon
assumes the appearance of this command. You can then use this command again by simply clicking directly
on the icon itself.

Shortcut key

You can also use the keyboard for the following commands:

Command Windows/Linux Mac

Insert line break Shift+¿ Shift+¿

Insert column break Ctrl+Shift+¿ Cmd+Shift+¿

Insert page break Ctrl+¿ Cmd+¿



211Tables

Tables
Would you like to clearly arrange text, numbers or pictures next to each other in tabular form in a document?
Then simply insert a table into the document.

Of course, you could also use tabs if you only want to set up a simple list, but tables offer the following
advantages:

§ Text is automatically wrapped to multiple lines within a table cell if it does not fit in. The height of the table
row adjusts automatically. 

§ You can easily select individual cells (or complete rows and columns) in tables, and then delete, copy, move
or format their content.

§ Table cells can have borders, a grid of gutter lines or a shaded background.

§ You can even perform calculations with the contents of tables. For more information, see Calculations in the
text.

In this chapter, you will learn everything you need to know about working with tables. This information covers
the following topics:

§ Inserting tables 

§ Ribbon tab "Table"

§ Moving in tables

§ Selecting table cells and cell contents

§ Deleting, copying, moving cell contents

§ Deleting and inserting table cells

§ Splitting and merging table cells

§ Formatting tables

§ Converting a table into text

§ Converting text into a table

§ Sorting tables

§ Sorting text
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See the following pages for more information.

Inserting tables
To insert a table into the text, move the text cursor to the desired position and use one of the following
methods:

Inserting quickly via the grid

Tables with a limited number of rows/columns and without further adjustments can be inserted directly via the
grid (the table can also be further adjusted at any time afterwards):

Click on the small arrow of the icon  on the ribbon tab Insert | group Table and move the mouse over the
expanded grid. Above the grid, you will see how many rows and columns you are currently selecting (you will
also see a preview of the table in the document).

As soon as the table has the desired dimensions, click with the mouse into the grid and TextMaker will insert
the table into the document.

Tip: To move a table, select the entire table with the mouse or with the command Select table. Then click in
the middle of any cell of the selected table (while still holding down the mouse button) and drag the table
elsewhere in the document. If you press the Ctrl key at the same time, the table will be copied.

Inserting via the dialog box with additional options

If you want to insert a table with any number of rows/columns and also adjust the inner margins, select the
method via the dialog box:

1. Click on the icon itself  on the ribbon tab Insert | group Table. Alternatively, click on the icon's small
arrow and select the entry Insert table below the grid.
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2. The program displays a dialog box in which you can specify the number of rows and columns the table
should contain.

In the section below, you can also specify the inner margins for the table cells if necessary.

3. As soon as you confirm with OK, TextMaker inserts the table into the document.

Ribbon tab "Table"
Once you have created a table, you can switch to the contextual ribbon tab Table for editing. This always
appears automatically on the far right as an additional tab if you have set the text cursor in a table.

The contextual ribbon tab "Table", left section

The contextual ribbon tab "Table", right section

The ribbon tab has the following buttons, from left to right:

§ Select: Select the whole table, current rows/columns or individual cells. 
For more information, see Selecting table cells and cell contents.

§ Properties: Format tables and change other properties of the table.
 For more information, see Changing general table properties.
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§ Table styles (and all other commands of the "Style" group): Adjust the formatting of the table style. For more
information, see Table styles.

§ Shading of the selected cells can be changed with this option. For more information, see Changing cell
properties.

§ Borders of the selected cells can be changed with this option. For more information, see Changing cell
properties.

§ Text alignment of the selected cells can be changed with this option. For more information, see Changing cell
properties.

§ Cell orientation: Rotates the content of the selected cells. For more information, see Changing cell properties.

§ Delete cells: Delete individual cells, delete rows/columns or delete the entire table.
For more information, see Deleting and inserting table cells.

§ Insert rows: Insert rows or individual cells above/below.
For more information, see Deleting and inserting table cells.

§ Insert columns: Insert columns or individual cells left/right.
For more information, see Deleting and inserting table cells.

§ Repeat table row: This option repeats the contents of the selected row as a header at the beginning of each
page if the table spans multiple pages. For more information, see Changing row properties.

§ Distribute rows, columns: This option ensures the equal spacing of selected rows/columns of a table.
For more information, see Distributing rows and columns evenly.

§ Row height: See Changing row properties.

§ Cell width: See Changing cell properties.

§ Merge cells: Connect adjacent table cells to form a single cell.
For more information, see Merging table cells.

§ Split cells: Divide a table cell into several cells. For more information, see Splitting table cells.

§ Split table: Split the table horizontally into two tables. For more information, see Splitting tables.

§ Sort table: Sort rows in a table. For more information, see Sorting tables.

§ Convert table to text: Convert table into normal body text. For more information, see Converting a table into
text.

For more information on the commands, see the specified sections.

Moving in tables
You can enter, edit and format text within tables in the usual manner. After inserting a new table, TextMaker
automatically places the text cursor in the first table cell so that you can start typing immediately.
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You can also type multiple lines of text within a cell – the lines will be broken and the row height will be
adjusted automatically. Alternatively, press the Enter key¿ to start a new paragraph within the cell.

You insert pictures into a table cell as usual via the command on the ribbon tab Insert | group Objects, which is
described in Pictures. Of course, you can also insert other types of objects – for example, OLE objects, form
objects, etc.

To move the text cursor from one table cell to another, you can press the Tab key to move to the next cell or
Shift+Tab to move to the previous cell. To move the text cursor from row to row, use the arrow keys â and á.

You can also click in the desired cell using the mouse.

Note: As you can see, the Tab key cannot be used to insert tabs within table cells. You must use the key
combination Ctrl+Tab in tables for this purpose.

Selecting table cells and cell contents
Selecting text within a cell works in the same way as selecting normal text with the mouse. For more
information, see Selecting text and objects.

To select complete table cells and their contents, proceed as follows:

Selecting via the mouse

§ Select the entire table or table area: Click in the first cell to be selected and then drag the mouse with the
mouse button pressed to the last desired cell. 

§ Select entire columns/rows: Click in the area directly above a column to select the column. To select a
row, click in the area directly to the left of the row.

§ Select a single cell: In rare cases, you only need to select a single cell. This is done via the following
"trick": Drag the mouse cursor from the cell you want to select to an adjacent cell and back again.

Alternatively, click in the table cell with the mouse and then press Shift+à to select the entire cell. To select
additional cells, continue pressing Shift+à or Shift+â.

Selecting with the commands of the ribbon tab "Table"

On the contextual ribbon tab Table, choose the command Select  (in the group Table). This opens a
submenu in which you can select whether the entire table, the current row/column or the current cell should be
selected.
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Deleting, copying, moving cell contents
To delete, copy or move the contents of table cells, select them and then use the familiar commands:

Command Explanation

Delete Press the Del key on the keyboard to delete the contents of all currently selected cells – without them
ending up in the clipboard.

Cut The command Home | Cut cuts the contents of the selected cells and puts them in the clipboard.

Copy The command Home | Copy copies the contents of the selected cells to the clipboard.

Paste Home | Paste (click directly on the icon itself) pastes the contents of the clipboard. Before using this
command, position the text cursor in the desired table cell.

Paste special If you click on the small arrow below the icon rather than directly on it at Home | Paste, a dropdown
menu opens with additional options for pasting the content. For more information, see Paste special.

Note: Bear in mind that these commands apply only to the contents of the cells. Thus, if you select some
cells and press the Del key, for example, only the contents of the cells are removed; the cells themselves
remain unchanged. For more information on deleting/inserting complete table cells (including their
contents), see the next section.

Deleting and inserting table cells
In the previous section, you learned how to delete, copy or move the contents of table cells.

In contrast, this section describes how you can completely delete cells from a table and insert additional cells in
a table.

The information covers the following topics:

§ Deleting cells from a table 

§ Inserting cells in a table

Deleting cells from a table

To completely delete cells (including their contents) from a table, proceed as follows:
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1. Select the cells to be deleted.

Tip: To do so, don't just press the Del key because this only deletes the contents of the table cells, and not
the table cells themselves.

2. Choose the ribbon command Table | Delete cells  (click on the icon itself). The selected cells are
deleted.

Alternatively, click on the icon's arrow and select exactly what you want to delete from the submenu:

Delete rows: deletes all rows within the selection

Delete columns: deletes all columns within the selection

Delete cells: deletes only the currently selected cells

Delete table: deletes the entire table

The table cells are now removed.

Inserting cells in a table

To add additional cells to a table, proceed as follows:

Inserting rows

1. Position the text cursor in the cell before or after which the new cells are to be inserted.

2. Choose the ribbon command Table | Insert rows  (click on the icon itself). A row is inserted below the
current cell.

Alternatively, click on the icon's arrow and select exactly what you want to insert from the submenu:

Insert row above: inserts a row above the current cell

Insert row below: inserts a row below the current cell

Insert cells: displays a dialog box with additional options (see below)

The rows or cells are now added to the table.

Note: If you have selected several rows, the following applies to the commands described above: The
program will add as many rows as you selected previously. Furthermore, if you select several rows, the
option Insert cells does not open a dialog box. Instead, the program inserts the selected number of rows
directly below those selected.

Inserting columns

1. Position the text cursor in the cell before or after which the new cells are to be inserted.
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2. Choose the ribbon command Table | Insert columns  (click on the icon itself). A column is inserted to
the right of the current cell.

Alternatively, click on the icon's arrow and select exactly what you want to insert from the submenu:

Insert column left: inserts a column to the left of the current cell

Insert column right: inserts a column to the right of the current cell

Insert cells: displays a dialog box with additional options (see below)

The rows or cells are now added to the table.

Note: If you have selected several columns, the following applies to the commands described above: The
program will add as many columns as you selected previously. Furthermore, if more than one column is
selected, the option Insert cells does not open a dialog box. Instead, the program inserts the selected number
of columns directly to the right of those selected.

Options

If you select the option Insert cells when using the above procedure for rows or columns, the program displays
a dialog box. Here, you can specify how the new cells are to be inserted.

The dialog box provides the following options:

Option Explanation

Entire rows Complete rows of cells are inserted.

Entire columns Complete columns of cells are inserted.

Single cells Individual cells are inserted. If, for example, you selected 4x4 cells before choosing the command,
4x4 cells will be inserted.

In addition, the option Number allows you to specify the number of cells to be inserted. If, for example, you
select the option Entire rows and then set the Number to 10, ten rows will be inserted instead of only one row.

Finally, click on Insert above to insert the new cells before the current cell – or on Insert below to insert them
after the current cell.
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Tip: Appending an additional row quickly to the end of a table

You can also append an additional row to the end of a table by simply pressing the Tab key when the text
cursor is in the last cell of the table. TextMaker then automatically extends the table by adding a new row.

Splitting and merging table cells
You can divide a table cell into several cells at any time – or merge several table cells into a single cell. You
can also split or merge complete tables.

You will learn how to do this in this section. The information covers the following topics:

§ Splitting table cells 

§ Merging table cells

§ Splitting tables

§ Merging tables

Splitting table cells

You can split a table cell at any time, thus dividing it into several cells.

To do so, proceed as follows:

1. Position the text cursor in the cell that you want to split.

2. Choose the ribbon command Table | group Merge and split | Split cells .

3. A dialog box appears. In this dialog box, enter the number of rows and columns into which the cell should
be split.

4. Confirm with OK.

The cell is now split accordingly.

Splitting several cells at once

You can also select several adjacent cells before choosing the command Split cells. In this case, these cells are
all split.

Note the option Join selected cells before splitting? in the dialog box of this command:

§ If you select the option Treat the selection as one cell and split it, the selected cells will be merged into a
single cell before splitting. 
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§ If you select the option Each selected cell will be split individually, however, each of the selected cells
will be split into the specified number of rows and columns.

Merging table cells

You can merge several adjacent table cells at any time. They are then merged into a single cell.

To do so, proceed as follows:

1. Select the cells to be merged.

2. Choose the ribbon command Table | group Merge and split | Merge cells .

The cells are now merged into one cell.

In this process, the contents of the original cells are not lost; they are combined in the resulting cell. The
content of each original cell is placed in a separate paragraph.

Splitting tables

You can use the command Table | Split table to split a table horizontally. The original table then becomes two
tables.

To do so, proceed as follows:

1. Position the text cursor in any cell of the row above which the table is to be split.

2. Choose the ribbon command Table | group Merge and split | Split table .

The table is now split into two separate tables.

Merging tables

You can merge two tables into a single table.

1. Delete (or move) all text between the two tables so that they are separated by only an empty paragraph.

2. Position the text cursor in this empty paragraph.

3. Press the Del key.

The two tables are now combined into one table.
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Formatting tables
Several commands are available for formatting tables. These commands are presented in the following sections:

§ Distributing rows and columns evenly 

You can use the ribbon commands Table | Distribute rows or Table | Distribute columns to adjust
selected rows/columns to a uniform height or width.

§ Changing row properties 

You can use the ribbon command Table | Properties | Row properties to change the formatting of the rows
in a table. This includes the row height and options for the row behavior when a page break occurs.

§ Changing cell properties 

Use the ribbon command Table | Properties | Cell properties to format individual table cells. You can use
it to change the width, alignment and margins of cells, and to add borders or shading to cells.

§ Changing general table properties 

Choose the ribbon command Table | Properties | Table properties to change the formatting of entire
tables. For example, this command can change the border and shading of all table cells at once. Furthermore,
the command allows you to make settings for positioning the table.

§ Table styles 

The ribbon command Table | Table styles is a particularly useful option. It provides predefined table styles
that can be used to format an entire table at the touch of a button.

See the following pages for more information.

Distributing rows and columns evenly

By default, rows and columns of a table are distributed evenly, which means that all cells are the same size.
However, you can change both the row height and column width as desired by dragging and dropping any of the
inner or outer borders of the table.

Note: To specify the exact row height, see Changing row properties, or for the column width, see Changing
cell properties.

There is also the option of distributing rows and columns evenly across the table again: You can use the ribbon
commands Table | Distribute rows and Table | Distribute columns to evenly distribute the selected rows or
columns of a table.

If you want rows of a table to have the same height, proceed as follows:

1. Select the desired rows (all or only some) of a table.
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2. Choose the ribbon command Table | group Cells | Distribute rows .

3. As a result, the selected rows have the same height.

If you want the columns of a table to have the same width, proceed as follows:

1. Select the desired columns (all or only some) of a table.

2. Choose the ribbon command Table | group Cells | Distribute columns .

3. As a result, the selected columns have the same width.

Changing row properties

The ribbon command Table | Properties  | Row properties opens a dialog box in which you can change the
formatting of the rows in a table.

Before choosing this command, select the rows whose format is to be changed. If you do not select any rows,
the changes will be applied only to the row in which the text cursor is positioned.

Tip: If you only want to change the Row height , you will also find this option directly on the
ribbon tab Table | group Cell size.

The dialog box Row properties provides advanced customization options:

Height

Here, you can change the height of the table row. The following options are available:

§ Auto 

This is the default setting. If it is selected, TextMaker determines the optimum height for the rows
automatically (by adjusting it to the actual space requirement of the cell contents).

§ Exact 

If you select this option, you can specify the desired row height exactly in inches. However, the row will
then always assume this height, even if it is not enough to fully display the contents of the cells.
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§ At least 

This option represents a combination of the two options above. If you enter "1 in" here, for example, the
height of the rows will be set to exactly 1 inch, provided that this height is sufficient for the contents of the
cells. If you enter more text in a cell than can be accommodated within 1 inch, however, TextMaker will
automatically increase the row height.

Keep together with next row

By enabling this option, you ensure that the selected rows and (!) the row immediately following are always
kept together. If TextMaker determines that an automatic page break should fall between any of these rows, it
will insert the break before them, thus ensuring that they remain together on one page.

Page break at row

If you enable this option, TextMaker always starts a new page before this table row.

Allow page break in row

This option is disabled by default. This means that if an automatic page break ends up in the middle of this
table row, TextMaker would not allow it and would start a new page above the table row instead.

This improves legibility by preventing the cell contents in this table row from being "torn apart" and distributed
over two pages by a page break.

If you enable this option, however, TextMaker will no longer prevent an automatic page break from being
performed in the middle of the table row. It will now allow part of the cell contents to end up on one page and
part on the other page.

Repeat as header row

This option is only available in the first rows of a table.

It only affects tables that span multiple pages. When it is enabled, TextMaker repeats the contents of the
selected table rows at the beginning of each page.

This is useful, for example, if the first two rows of the table contain headings that are to be repeated on each
page. In this case, select the first two rows and enable this option for them.

Tip: You will also find this option directly as a ribbon command: Table | group Cells | Repeat table row.

Changing cell properties

The contextual ribbon tab Table contains several commands (or a dialog box) with which the appearance of the
current table cell can be changed. Of course, you can select several cells (or complete rows and columns) before
choosing the commands described below to change their properties together.
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Common options: Via the icons of the ribbon tab "Table"

For the quick application of selected cell properties, you can use the following icons of the ribbon tab Table
directly:

§ Cell width  (in the group Cell size): Here, you can specify the exact width. Enter the desired
value or use the small arrow buttons to increase/decrease the value. 

§ Text alignment  (in the group Format): Here, you can specify how the cell content is to be aligned
within the cell. Different combinations of left, right, top, bottom, centered are possible. 

§ Cell orientation  (in the group Format): Here, you can rotate the cell content by a specific angle so that
the text is displayed vertically, for example.

§ Shading  (in the group Format): Here, you can apply shading to the selected cells. To do so, select the
desired cells and then click on the icon's arrow instead of the icon itself. The program opens a dropdown
menu in which you can click to select the desired type of shading. 

If you then want to apply the exact same type of shading to other cells, simply select them and click on the
icon itself (not the arrow). TextMaker will then reapply the last selected type of shading.

For individual adjustments, select the entry More via the icon's arrow. The program opens a dialog box that
corresponds to the dialog box of the command Home | group Paragraph | Paragraph shading. For more
information, see Shading.

§ Borders  (in the group Format): Here, you can provide selected cells with a complete border or
individual border lines at the top, bottom, left or right. 

This option provides the same functionality as above for shading.

For individual adjustments, select the entry Borders via the icon's arrow. The program opens a dialog box
that corresponds to the dialog box of the command Home | group Paragraph | Borders. For more
information, see Borders and lines.

Advanced options can be found via the dialog box below.

Additional options: Via the dialog box

You open the dialog box with the ribbon command Table | Properties  | Cell properties.
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In the dialog box, the Format tab offers the following options:

Size

Here, you can change the Width of the selected cells by choosing from among the following options:

§ Fixed 

If you select this option, you can specify the width exactly. Enter the desired value to the right of it.

§ Percent

If you select this option, you can enter the desired width as a percentage of the overall table width.

For example, each cell in a table of three columns has a default width of 33.3%. If, for example, you want
the first column to be twice as wide as the other two columns, enter "50" for all cells in the first column and
"25" for the cells in the second and third columns.

§ Auto 

If you select this option, TextMaker automatically determines an appropriate width. In this case, the cell
widths will be evenly divided into the available space.

Any of these three options can be applied in any combination within the same table. For example, you can
create a table where the cells in the first column have a fixed width, but the other columns are set to "Auto". If
you then increase the width of the first column, the other columns will automatically become narrower
accordingly.
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Tip: Cell widths can also be changed with the mouse. To do so, drag the right border of a cell left or right
with your mouse. If you have not selected anything, the width of the entire column changes. If you have
selected specific cells, however, only their width changes.

Vertical alignment

This setting determines how the cell contents should be aligned within the cell:

Option Explanation

Top The cell content will be aligned to the top edge of the cell. (This is the default setting.)

Centered The cell content will be centered between the top and bottom edges of the cell.

Bottom The cell content will be aligned to the bottom edge of the cell.

Justified The lines of text within the cell are vertically justified and are thus evenly distributed so that the text
starts exactly at the top edge of the cell and ends exactly at the bottom edge.

Rotate by...

Here, you can specify the angle of rotation for the cell content.

Margins

Here, you can change the inner margins of the selected cells.

Options

If you enable the option Text locked, you will not be able to change the contents of the selected table cells
when the document is edited in form mode.

However, this option is disabled by default; thus the cells can also be edited in form mode.

For more information, see Protecting contents of form objects.

Borders tab

On this tab, you can apply border lines and gridlines to the selected cells (or change the existing lines).

The options on this tab correspond to those in the dialog box of the command Home | Borders. For more
information, see Borders and lines.

Note: If you have selected several cells, you can change the gridlines between the cells in addition to the outer
borders.

Shading tab

Here, you can specify a shading for the selected cells.
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The options on this tab correspond to those in the dialog box of the command Home | Paragraph shading. For
more information, see Shading.

Changing general table properties

You can make general settings for tables via the dialog box of the ribbon command Table | Properties. These
always apply to the entire table. For example, this command allows you to change the borders and shading of
all table cells at once. Furthermore, the command allows you to make settings for positioning the table.

To open this dialog box, position the text cursor in any table cell and then choose the ribbon command Table |

Properties . (Click directly on the icon itself.)

Alternatively, open the dialog box by clicking on the small arrow of the icon and selecting Table properties
from the dropdown menu.

The following settings can be made in this dialog box:

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Note: The option Text locked mentioned there does not apply to tables because, in tables, you can use the

command Table | Properties  | Cell properties to protect each individual cell against changes (see the
option Text locked in Changing cell properties). Of course, you can also protect the entire table from changes
by selecting all its cells and then enabling the option Text locked for all cells.

Text direction: For text in Arabic script, you can also change the writing direction of the table. If you set the
direction to right-to-left, the column on the far right becomes the first column (instead of the column on the far
left). For more information, see also Working with Arabic text.

Layout tab

You can use this tab to make settings for positioning the table:

§ Alignment 

Here, you can change the alignment of the table from left-aligned to centered or right-aligned.
Note: Of course, this is only visible for tables that do not span the entire page width.

Left indent: Here, you can indent the table to the right by the specified value.

§ Wrapping 

Here, you can specify whether the body text in the document should or should not surround the table:

None: This is the default setting: The body text does not surround the table.

Surrounding: If you select this setting, however, the body text surrounds the table, similar to text that wraps
around a text frame.

Furthermore, selecting the option Surrounding has the following additional effects:
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1. An icon with four arrows is displayed at the top left corner of a table whenever the text cursor is inside
the table. You can move the table freely by dragging this icon with the mouse.

2. In addition, the Position button becomes available in the dialog box. This opens another dialog box in
which advanced settings for positioning the table can be made:

Horizontal and Vertical: Here, you can specify the exact horizontal and vertical positions of the table.
Tip: Apart from entering fixed values into the Position field, you can also open its dropdown list and
select one of the predefined settings. For example, the entry "Right" will position the table right-aligned
with the right page margin.

Distance from surrounding text: Here, you can change the outside margins of the table – thus specify
how much space should be left between the table and the surrounding text.

Move with text: When you insert a table, it is automatically anchored to the paragraph located below its
top left corner. "Anchored" means that the table will always appear on the page where this paragraph is
located. If you move this paragraph to the next page, the table will also end up there. If you disable this
option, however, the table will always stay on the page where it is right now.

Borders tab

Here, you can change borders and gridlines for the entire table.

The options on this tab correspond to those in the dialog box of the command Home | Borders. For more
information, see Borders and lines.

Note: Here, you can change the gridlines between the cells in addition to the outer borders.

Shading tab

Here, you can apply shading to the entire table.

The options on this tab correspond to those in the dialog box of the command Home | Paragraph shading. For
more information, see Shading.

Table styles

The ribbon command Table | Table styles  is a particularly useful option. It provides predefined table styles
that can be used to format an entire table at the touch of a button.

To do so, position the cursor in any cell of the desired table and then choose this command.

The program displays a dropdown menu with a list of all available table styles. You can use the small
thumbnails in the list to preview the desired appearance of the table and apply it to the table.

Selecting another table style changes the overall appearance of a table in terms of its coloring and structure.
Select the desired style by clicking directly on it. The entire table will be reformatted accordingly.

The options next to the Table styles icon in the command group Style allow you to customize the appearance
of the table after applying a table style:



229Tables

§ Header row 

This option enables/disables the header row for column headings at the top of the table.

§ Total row 

This option enables/disables the total row at the bottom of the table.

§ First column and Last column 

If you enable this option, the first and/or the last column in the table will be highlighted.

§ Banded rows and Banded columns 

This option enables/disables the alternating color highlighting for every second row/column.

Tip: If you miss the familiar AutoFormat for tables from previous versions, you can still add it to your
individual user interface and use it. For more information, see Customizing icons and groups in the ribbon.

Selecting table styles via the dialog box

You can also select table styles by clicking on the group arrow  for the dialog box on the ribbon tab Table |
group Style. In the open dialog box, you will find the same options as described above.

Note: Here, you can see the effects for Header row, Total row, First/Last column, Banded rows/columns
directly in the small thumbnails in the dialog box list.

Converting a table into text
You can use the ribbon command Table | Convert table to text to convert a table into normal body text.

An example: You want to convert a table with 2x2 cells into a list where the table cells will be separated by
semicolons.

To do so, proceed as follows:

1. Position the text cursor in any cell of the table.

2. Choose the ribbon command Table | group Data | Convert table to text .

3. Select the desired Separator, which is the Semicolon in this case.

4. Confirm with OK.

The table is now converted into normal body text – from left to right and top to bottom.

Thus, if you convert the following table ...

Cell1 Cell2

Cell3 Cell4

... you will get the following text:
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Cell1;Cell2
Cell3;Cell4

Each row becomes a separate paragraph. The Separator is inserted between the cells of a row. Depending on
the separator you select, you will get the following results:

Separator Result

Paragraph break Here, a new paragraph is started for each separate cell in the table.

Tabs A new paragraph is started after each row of the table. The cells within a row are separated by
tabs.

Semicolon A new paragraph is started after each row of the table. The cells within a row are separated by
semicolons (;).

User-defined Here, you can specify the separator yourself. To do so, enter the desired character in the input
field. You can enter more than one character if desired.

If, for example, you enter a comma followed by a space as the separator, the cell contents of
every line will be separated by a comma and a space accordingly.

The reverse is also possible as you can convert text in tabular form into a table. (See next section.)

Converting text into a table
The previous section described how to convert a table into paragraphs of text. The reverse is also possible as

you can convert text in tabular form into a table by choosing the command Insert | Table  | Convert text to
table.

To do so, proceed as follows:

1. Select the paragraphs of text that you want to convert into a table.

2. Choose the ribbon command Insert | Table  | Convert text to table.

3. First, select the Separator that will be used to separate the entries in the text (see below).

4. Then specify the number of rows and columns that the table should have. (TextMaker automatically
suggests appropriate values by default.)

5. Confirm with OK.

The text is now converted into a table. Each line of text becomes a row in the table.

An example:

You want to convert the following list of addresses into a table:

Peter;Miller;24 Main Street;12345;Whitneyville, AK
Thomas;Meyer;1733 University Drive;54321;Knoxville, TN
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To do so, choose the command Insert | Table  | Convert text to table and select semicolons as the
Separator. As a result, you get the following table:

Peter Miller 24 Main Street 12345 Whitneyville, AK

Thomas Meyer 1733 University Drive 54321 Knoxville, TN

Options of the dialog box

The options in the dialog box for this command have the following functions:

§ Rows and Columns 

You don't usually have to worry about these settings. If you have specified the separator correctly,
TextMaker automatically determines how many rows and columns the resulting table should have and
suggests these values.

However, you can also enter your own values if necessary.

§ Separator

This is the most important setting: Here, you specify which character TextMaker should use to recognize the
separator for each entry.

You can choose from among the following:

Paragraph break: Each entry is in its own paragraph.

Tabs: The entries are separated by tabs.

Semicolon: The entries are separated by semicolons (;).

You can also enter any other separator under User-defined if the entries are separated by slashes or
commas, for example. It is also possible to enter multiple characters here.

Note: The separator must not occur within an entry; if it does, TextMaker will of course treat it as such
and make two entries out of one entry.

§ Remove quotation marks 

If you enable this option, TextMaker will remove all surrounding quotation marks (") from the text during
conversion.

This is useful if you want to convert a list in which all entries are enclosed within quotation marks:
("Henry"; "Meyer"; ...). Many database programs generate such lists.

§ Remove leading/trailing spaces 

If you enable this option, TextMaker will remove all leading and trailing spaces from the text entries when
they are converted. (However, spaces within text entries will not be removed.)

Note: The reverse is also possible as you can convert tables into text. (See previous section.)
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Sorting tables
You can let TextMaker sort the rows of a table by choosing the ribbon command Table | Sort table.

Note: This command is applicable only to tables. If you want to sort ordinary paragraphs of text, see the next
section Sorting text.

To have TextMaker sort the rows of a table, proceed as follows:

1. Position the text cursor in any cell of the table.

Alternatively: If you want only part of the table to be sorted, select the rows to be sorted.

2. Choose the ribbon command Table | group Data | Sort table .

Alternatively, you will find the command on the ribbon tab Home | group Paragraph | Sort text/table. For
more information, see the next paragraph  Sorting text.

3. In the dialog box, select the column whose contents are to be used as the basis of the sort. If desired, you can
specify multiple columns as sort criteria (see below).

4. Confirm with OK.

The table rows are now sorted according to the contents of the selected column(s).

The options in the dialog box for this command have the following functions:

Sort by:

Here, you specify the column whose contents are to be used as the basis of the sort.

You can also specify the sort order: Ascending (A..Z) or Descending (Z..A).

Type

Normally, you use the default setting Text for this option. If the column contains dates, however, select Date. If
it contains numbers, select Number.

Background information: Columns can contain text, numbers or dates. This affects the sort order. For example,
dates are sorted correctly only if you select Date as the type – the Text type would not attempt to recognize
days, months and years in a date.

Then sort by

You can specify more than one sort criterion if necessary.

If, for example, the first column contains last names, and the second column contains first names, you can
select the first column for Sort by and the second column for Then sort by. As a result, the rows of the table
will be sorted by last name and those rows containing the same last name will then be sorted by first name.
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First row contains headings

If the first row of your table contains headings, you should enable this option to prevent TextMaker from
including the first row in the sort.

Example: A table contains addresses. The first row contains headings like "Name", "Street", "City", etc. In a
case like this, you should enable this option to ensure that the headings remain in the first row and are not
included in the sort.

Case-sensitive

If you enable this option, sorting distinguishes between uppercase and lowercase letters. For example, all words
that begin with a lowercase letter end up in front of the words that begin with a capital letter:

Disabled: Apples, bananas, Cherries. Enabled: bananas, Apples, Cherries.

Include cell formats

This option determines whether only the contents of the cells or also their formatting should be sorted:

Disabled: Only the cell contents are sorted; the original formatting of the table is thus retained.

Enabled: Each row that is moved to a different place by sorting takes its formatting (shading, margins,
alignment, rotation) to the new position.

Sorting text
Not only can you sort the contents of a table, as described in the previous section, but also ordinary paragraphs
in the text. To do so, use the ribbon command Home | Sort text/table.

Note: This command is applicable to both paragraphs of text and tables. If you want to sort tables, see the
previous section Sorting tables.

Proceed as follows for paragraphs of text:

1. Select the paragraphs of text to be sorted.

2. Choose the ribbon command Home | group Paragraph | Sort text/table .

3. Select either an ascending or descending sort order.

4. Confirm with OK.

The paragraphs are now sorted accordingly.

The dialog box of the sort command has some additional options that you don't usually need. These options
include:
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Sort by:

Normally, all you need to specify here is the sort order: Ascending (A..Z) or Descending (Z..A).

The specification of a column as the basis for the sort is only useful if the selected paragraphs are organized
like a table – that is, when they contain tabs or another separator. (See also the option Separator.)

Then sort by

You can specify more than one sort criterion if necessary.

If, for example, the first column contains last names, and the second column contains first names, you can
select the first column for Sort by and the second column for Then sort by. The paragraphs will be sorted first
by last name. Paragraphs containing the same last name will also be sorted by first name.

Separator

You only have to set the option Separator when sorting paragraphs that are organized like a table.

If the paragraphs contain, for example, names, street addresses, city names, you can tell TextMaker which
separator separates the individual components of the address:

§ Spaces 
§ Tabs 
§ User-defined (Here, you can enter the separator yourself.) 

An example:

You want to sort the following three paragraphs:

Peter Miller[Tab]5 University Ave.[Tab]Pleasantville, NY 12345
Thomas Chris Howe[Tab]24 Park Drive[Tab]Cambridge, NJ 21220
Claudia Fisher[Tab]1024 13th Street[Tab]Forest Park, IL 98765

In this case, you should set Tabs as separators because the individual components of the address (name, street,
city) are separated by tabs.

Advantage: You can now sort by Column 1, Column 2 or Column 3 in the dialog box of the sort command.
Column 1 stands for the names, Column 2 for the streets, Column 3 for the cities.

If you selected Spaces as the separator, however, TextMaker would consider each word as a "column", which
would naturally be unhelpful because, for example, the name can sometimes consist of two or three words.

First paragraph contains headings

If the first of the selected paragraphs contains headings, you should enable this option so that TextMaker does
not include the first paragraph when sorting.

Example: The selected paragraphs contain addresses. The first paragraph includes headings such as "Name",
"Street", "City", etc. In this case, you should enable this option to ensure that this paragraph will not be
included when sorting, but will remain the first paragraph.
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Case-sensitive

If you enable this option, sorting distinguishes between uppercase and lowercase letters. For example, all words
that begin with a lowercase letter end up in front of the words that begin with a capital letter:

Disabled: Apples, bananas, Cherries. Enabled: bananas, Apples, Cherries.
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Pictures
You can insert pictures into your document at any time. You can choose whether to embed the picture directly
in the body text or to insert it in a freely movable "frame":

§ Inserting pictures into the text 

You can insert pictures directly into the body text by choosing the ribbon command Insert | Objects group |

Picture. To do so, click on the small arrow of the icon and disable Insert as frame  in the dropdown
menu.

TextMaker treats a picture that has been inserted with this command as if it were a letter within the text. It
becomes part of the body text. Thus, if you type something right in front of the picture, it will be pushed
forward like a letter in order to accommodate the text.

§ Inserting picture frames 

Alternatively, pictures can be inserted in the form of picture frames via the ribbon command Insert | group

 Objects | Picture. To do so, click on the small arrow of the icon and enable Insert as frame  in the
dropdown menu.

By default, picture frames are anchored at fixed positions on the page – thus they do not move when text is
added or deleted above them. Of course, you can move picture frames at any time.

This chapter covers only the insertion of pictures directly into the text. For more information about picture
frames, see Frames and drawings.

This chapter covers the following topics:

§ Inserting pictures into the text 

§ Scanning pictures

§ Inserting pictures from the gallery/camera (Android and iOS)

§ Changing position and size of pictures

§ Compressing pictures

§ Changing picture properties via the ribbon tab

§ Changing picture properties via the dialog box

See the following pages for more information.
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Inserting pictures into the text
To insert a picture directly into the body text, proceed as follows:

1. Move the text cursor to the desired position.

2. On the ribbon tab Insert | group Objects | Picture , click on the arrow of the icon.

In the dropdown menu, disable  Insert as frame if it is enabled.

3. In the dropdown menu, select From file.

Tip: You can also choose this command by clicking on the icon itself. However, you cannot enable or
disable the option Insert as frame. The last set state is automatically applied.

4. The program displays a dialog box in which you specify the picture to be inserted. Select the desired picture
file and confirm with OK.

The picture is now inserted into the text.

Isn't the picture visible? If you can't see the picture in the document after you have inserted it, you have probably
disabled the display of pictures, that is, you have enabled the option Use placeholders for pictures. To display
the pictures again, choose the ribbon command File | Properties, switch to the View tab and switch this option
back to Show pictures.

Options of the dialog box

The options in the above dialog box mean the following:

§ Save within document 

If the option is enabled, TextMaker saves a copy of the picture in the document and uses this copy instead of
the original.

Note: If this option is enabled, the file size of the document may increase significantly.

If it is disabled, however, TextMaker saves only a reference to the original picture file in the document.
Changes to the original picture file are thus always available in an updated form in TextMaker.
Tip: You can see the location of the original picture file in the picture properties. Right-click on the picture to open the context menu, and select
Picture: Properties. In the dialog box, switch to the Properties tab and take a look under File name.

Note: If the file path of the picture file changes, however, it will no longer be displayed in the document.

§ Copy to document's folder

If the option is enabled, TextMaker creates a copy of the picture file in the folder in which the document is
located and saves a reference to this copy instead of to the original.

This option is available only if the document has already been saved previously.

Inserting as picture frame

As mentioned in the introduction, pictures can also be inserted as picture frames. Proceed as described above
using the ribbon command Insert | group Objects | Picture, but enable Insert as frame in the dropdown menu.
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The difference is that frames are fixed at a fixed position on the page, thus they don't move when you insert or
delete text above the frame.

Tip: Pictures that have been inserted into the normal body text without a frame can still be subsequently
converted into a picture frame and vice versa using the ribbon command Convert. For more information, see
Converting between frame and embedded object.

For more information on picture frames, see Picture frames.

Scanning pictures

Note: Scanning pictures directly into a document is possible only with the Windows version of TextMaker.

With TextMaker for Windows, you can scan originals directly into a document. You must have connected a
scanner to your computer and installed the corresponding software.

To scan something into the current document, proceed as follows:

1. Turn on the scanner and insert the original that is to be scanned.

2. Move the text cursor to the position in the document where you want to insert the scanned result.

3. On the ribbon tab Insert | group Objects | Picture , click on the arrow of the icon.

In the dropdown menu, disable  Insert as frame if it is enabled.

4. Select From scanner in the dropdown menu.

TextMaker now enables your scanner's software. Make the desired settings (see scanner manual) and start the
scanning process. When this is complete, the scanned result will appear as a picture in the TextMaker
document.

Scanning as a picture frame

The aforementioned procedure inserts the scanned picture directly into the body text. Alternatively, you can

include the picture as a picture frame. Proceed as described above using the command Insert | Picture  |
From scanner, but first enable Insert as frame in the dropdown menu.

The difference is that frames are fixed at a fixed position on the page, thus they don't move when you insert or
delete text above them.

For more information on picture frames, see Picture frames.

Selecting another source

If several scanners are connected to your PC, you can use the command Insert | Picture  | Select source to

decide from which of these sources you want to scan when you use the command Insert | Picture  | From
scanner.
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Inserting pictures from the gallery/camera (Android and iOS)

Note: This function is available only in the Android and iOS version.

In the Android/iOS version, you can also insert pictures via the Gallery or Camera application on your device.

To do so, proceed as follows:

Inserting a picture from the gallery

1. Position the text cursor where you want to insert the picture.

2. Choose the command Insert | group Objects | Picture  | From gallery. Before doing so, disable Insert as
frame in the dropdown menu if it is enabled.

3. Your Android/iOS device automatically opens its Gallery app. Select the desired picture by tapping on it.

The picture is now inserted.

Inserting a picture from the camera

1. Position the text cursor where you want to insert the picture.

2. Choose the command Insert | group Objects | Picture  | From camera. Before doing so, disable Insert
as frame in the dropdown menu if it is enabled.

3. Your Android device/iOS automatically opens its Camera app. Take a picture.

The picture is now inserted.

Inserting as a picture frame

The aforementioned procedure inserts the picture directly into the body text. Alternatively, you can include the

picture as a picture frame. Proceed as described above using the command Insert | Picture  | From gallery
(or From camera), but first enable Insert as frame in the dropdown menu.

The difference is that pictures frames are fixed at a fixed position on the page, thus they don't move when you
insert or delete text above them. This type of manipulation is useful, for example, for newspaper-style
documents.

For more information on picture frames, see Picture frames.

Changing position and size of pictures
You can change the position of a picture as follows:
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§ Cut and Paste 

You can move an embedded picture exactly like sections of text: Select the picture and cut it via the ribbon
command Home | Cut. Then set the text cursor to the target position and paste the picture there via the
ribbon command Home | Paste.

§ Using the mouse

Alternatively, you can use the mouse to move embedded pictures: Click to select the picture and then drag it
to the desired target position (with the mouse button held down).

The size of a picture can be changed as follows:

§ Dragging the handles on the selection frame 

Click on the picture to select it. A blue selection frame then appears around the picture, which also contains
some round "handles". When you drag one of these handles with the mouse, the size of the picture is
changed accordingly.

§ Via the dialog box 

You can also specify the size of a picture exactly in numeric values. To do this, double-click on the picture
with the mouse. The size can be specified exactly on the Format tab. For more information on this dialog
box, see Object properties, Format tab.

§ Via the ribbon tab 

If you have selected the picture, you will also find input fields for the Width and Height of the picture in
the group Resize on the far right of the contextual ribbon tab Picture. Type the desired values here or
increase/reduce the values with the small arrow keys next to the input field.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

Compressing pictures

This feature is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

You can use the command Compress pictures  to reduce the memory size of images in TextMaker. In this
way, you reduce the file size of the document and save capacity on your device or when sharing the document.

You can use the command effectively if your document contains pictures that were embedded in the document
when you inserted them using the option Save within document (see Inserting pictures into the text).

Note: Pictures that were instead saved in the document as a reference to an external picture file are not affected
by compression. However, when executing the command, you have the option of subsequently embedding these
pictures in the document and compressing them here at the same time.

Proceed as follows:



241Pictures

1. In your document, select one or more pictures that you want to compress. However, selecting multiple
pictures at once is only possible for picture frames . An additional ribbon tab Picture appears at the top right
of the ribbon.

Tip: If you want to compress all pictures of the document, just choose the ribbon command File | group
File management | Compress all pictures and continue with step 2.a.

2. Choose the ribbon command Picture | group Adjust | Compress pictures .

2.a If your selection contains only pictures that have been saved in the document, the dialog box "Compress
pictures" opens immediately.

2.b If your selection contains pictures that have not been saved in the document, a message appears before
the dialog box opens, asking whether you want to embed these pictures now (see description below).

3. In the Resolution section of the dialog box, choose between the predefined qualities or enter a custom
resolution.

In the Options section, you will find two more settings (see description below).

4. Confirm with OK.

After saving the document, you will notice a change in the file size.

Other options

§ Delete cropped areas of the pictures 

If you have cropped an image in your document using the command Pictures | Cropping and you do not
need the truncated remainder, enable this option. Once you press OK, the cropped image area will be
deleted and only the crop will be retained.

§ Embed and compress external pictures

This option allows you to embed and compress pictures in the document that you did not insert using the
option Save in document, but which are only saved in the document as a reference to the original external
file.

To explain this option, the following cases may occur:

a. You have selected only pictures that were not saved in the document. After choosing the command
Compress pictures, a message appears asking if you want to subsequently embed the pictures. If you click
on Yes, this option is already preselected in the following dialog box.

b. If pictures are selected that have already been saved in the document, this message also appears. If you
click on Yes (or also No), this option is freely selectable in the following dialog box.

c. If you have selected only pictures that have already been saved in the document, this message does not
appear. This option is not selectable in the dialog box.
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Changing picture properties via the ribbon tab
Numerous properties of pictures can be changed directly via the buttons of the contextual ribbon tab Picture.

The contextual ribbon tab "Picture", left section

The contextual ribbon tab "Picture", right section

This ribbon tab appears automatically when you select a picture. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ Cropping: You can enable/disable crop mode via this button. In this mode, the mouse cursor appears with an
additional crop icon. Drag the borders of the picture with the mouse to crop the picture accordingly. To exit
the mode, click on the button again. You can also use the button's small arrow to select a cropping from
different shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the picture. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the picture – for example, other color
modes (grayscale, black/white, etc.) and variations where the image was colored. For more information, see
also the next section ("Picture tab").

§ Compress pictures: Reduce the memory size of images in your document. For more information, see also
Compressing pictures.

§ Change source: Replace the picture with another one (formatting is retained).
 This corresponds to the File button in the dialog box. For more information, see next section ("Picture
tab").?

§ Reset: Reset the image-specific changes made to the picture, such as brightness, shading, rotate object, etc.,
to their default values. The non-image-specific settings are not reset, for example, line thickness and photo
frames.
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§ Photo frame: This option allows you to apply a photo frame effect to a picture.

§ AutoShape effects: This option is available as a ribbon command only for picture frames. For more
information, see Picture frames.

Note: You can still apply shape effects via the dialog box (double-click on the picture), even for embedded
pictures without picture frames. The relevant options can be found on the Shadow, 3D and Effects tabs. For
more information, see Changing picture properties via the dialog box.

§ Fill color: This option is available as a ribbon command only for picture frames. However, you will find the
options in the dialog box on the Fill tab.

§ Line color, Line thickness: These options are available as a ribbon command only for picture frames.
However, you will find the options in the dialog box on the Lines tab.

§ Wrapping mode: This option is available only for picture frames. For more information, see Picture frames.

§ Bring to front, Send to back: These options are available only for picture frames. For more information, see
Picture frames.

§ Rotate object: This option allows you to rotate a picture in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option is available only for picture frames. For more information, see Picture frames.

§ Group: This option is available only for picture frames. For more information, see Picture frames.

§ Duplicate: This option allows you to create an immediate copy of the selected picture.

§ Convert: This option converts a picture that is embedded in the body text into a picture frame and vice versa.

§ Width, Height: These options change the size of the picture. For more information, see Changing position and
size of pictures.

Many (but not all) of these functions and some additional options can be found in the Object properties dialog
box. You open the dialog box by double-clicking on the picture. For more information, see the next section.

Changing picture properties via the dialog box
The properties of an object can be edited centrally via the Object properties dialog box. An object's properties
include, for example, its size, margins and numerous other settings options.

To change the properties of a picture, click on it first to select it. Then open the dialog box by clicking on the
group arrow  in the bottom right corner of any command group on the contextual ribbon tab Picture.

Tip: You can open this dialog box faster by double-clicking on the picture or by right-clicking on the picture
and selecting Picture: Properties from the context menu.

The following options are available in this dialog box:
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Layout, Format, Fill tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Layout: On this tab, you can only change the outside margins of the picture. The other options are available
only for picture frames. For more information, see Object properties, Layout tab. 

§ Format: Here, you can resize the picture and rotate it. For more information, see Object properties, Format
tab.

§ Fill: This option allows you to change the fill. It is only visible for pictures with transparent areas. For more
information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply 3D effects. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. It also displays information about the picture
you are using. For more information, see Object properties, Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the picture. For more information,
see Object properties, AutoShapes tab.

For pictures, there is an additional tab with further options:

Picture tab

On the Picture tab, you can make settings that are specific to pictures:

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Picture |
group Adjust.

§ Variants 

This list offers some predefined variations of the picture – for example, different color modes (grayscale,
black & white, etc.) as well as colored variants of the image.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

Tip: You will also find these variants via the command Recolor picture directly on the contextual ribbon tab Picture.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma (an alternative way to change brightness).

§ More button 

This button opens a dialog box with the following additional options:

If you enable the option Mix with color and select a color below, the picture will be colored accordingly.
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The options in the Cropping section can be used to crop the picture. This is useful if you only need part of
the picture. If, for example, the upper quarter of the picture is to be truncated, first select Use relative
values and enter the number "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the picture will not be truncated, but will be extended
with a frame.

Tip: You will also find a corresponding command Cropping directly on the contextual ribbon tab Picture. For more information,
see the previous section Changing picture properties via the ribbon tab.

§ Transparency section 

Here, you can make settings for the transparency of the picture:

Use picture settings: TextMaker reads from the picture file which parts of the picture have been marked as
transparent and displays the picture accordingly. Note: Only pictures in GIF or PNG format contain such
transparency information.

No transparency: The picture will not be displayed transparently, even if it is a picture file with
transparency information.

Color: This option lets you select the color to be displayed transparently. If, for example, you select white,
all white areas of the picture will become transparent.

§ Sample 

In the small toolbar below the sample, you will find the option Pick transparent color (the pipette icon).
You can use it to make certain colored parts of the picture transparent, for example, to remove a distracting
background from the picture. To do so, use the pipette icon to click on an area of the thumbnail that you
want to make transparent.

The other toolbar buttons help you to fine-tune the picture (Zoom in, Zoom out, Pan picture), but they do
not affect the appearance of the picture in the document.

Note: You must first select a tool in the toolbar by clicking on it with the mouse. You can then work on the
thumbnail with the enabled tool.

§ File button 

You can use this button to replace the picture with another one and the formatting will be retained.

Tip: This corresponds to the command Change source on the contextual ribbon tab Picture.

§ Export button 

This option is available only for pictures that are saved in the document. You can use this button to export
the picture, that is, to save a copy of it on your hard disk under any name. The dialog box "Save as" appears
for this purpose.

If you enable the option Create a link to file here, TextMaker also replaces the picture saved in the
document with a reference to the destination file. Thus, the picture is no longer saved within the document.

§  Compress picture button 

This button allows you to reduce the memory size of pictures in your document.

Tip: This corresponds to the command Compress pictures on the contextual ribbon tab Picture. For more information on this
command, see Compressing pictures.
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Charts

In the iOS version, the creation of new charts is locked. (To unlock the command, see Welcome.)

You can use charts to graphically display numeric values.

In this chapter, you will learn everything you need to know about charts. It is divided into the following
sections:

§ Inserting charts 

First, you will learn how to create a chart. The most convenient way is to take a small "detour" via the
PlanMaker spreadsheet application. You can also simply insert an empty chart and manually type in the
values to be displayed.

§ Editing charts 

This section contains all the information you need to edit charts. You will learn how to enter/edit the
numeric values to be displayed in a chart, how to work with the individual chart elements (data series, axes,
legend, etc.) and how to change the general properties of charts.

§ Saving charts as pictures 

The command Save as picture, which you can access via the context menu by right-clicking on the chart,
allows you to save a picture of a chart in a picture file.

Inserting charts

In the iOS version, the creation of charts is locked. (To unlock the command, see Welcome.)

There are two ways to insert a chart into a document:

§ Inserting charts via PlanMaker 

The most convenient way: Create or open a chart in the spreadsheet application PlanMaker and copy it to
the clipboard. Then switch to TextMaker and paste it there.

§ Inserting charts manually

Alternatively, you can simply create a new empty chart using the ribbon command Insert | Chart frame 
in TextMaker. You then enter the numeric values to be displayed in a dialog box, which you can open with
the Edit data button.

More information can be found on the following pages.
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Inserting charts via PlanMaker

The most convenient way to insert a chart is to take a little "detour" and use the PlanMaker spreadsheet
application to create the chart. Then copy the chart to the clipboard, switch to TextMaker and paste it there.

The advantage of this method is that PlanMaker is simply the most suitable option for entering data and also for
creating charts. It has many features that you can only find in a spreadsheet application. (Of course, this method
only works if you have PlanMaker installed.)

Proceed as follows:

1. In PlanMaker (not in TextMaker!), enter the numeric values to be displayed in table cells.

Alternatively, you can simply open a file that already contains this data.

2. Select the cells with this data and choose the ribbon command Insert | Chart frame to create a chart. (For
more information, see the "Charts" chapter in the PlanMaker manual.)

Alternatively, you can simply open a file that already contains the desired chart.

3. If the chart is not already selected, click on it to select it.

4. Use the ribbon command Home | Copy to copy the chart to the clipboard.

5. Switch to TextMaker.

6. Place the cursor where you want to insert the chart.

7. Use the ribbon command Home | Paste to insert the chart.

The chart now appears in the document as an embedded object in the body text. To set the chart with a fixed
position on the page, you can insert it as a chart frame (see below).

Note: The chart is not converted into a picture when it is inserted, but remains a chart. Thus, you can
subsequently change its chart type or edit its data and settings at any time, for example.

Inserting as a chart frame

Alternatively, you can insert the chart as a frame. To do so, simply switch to object mode before inserting it
into TextMaker by choosing the ribbon command View | Object mode. Alternatively, convert the inserted chart
on the contextual ribbon tab Chart into a frame using the command Convert (or via Convert to object frame
from the context menu).

The difference is that frames are fixed at a fixed position on the page, thus they don't move when you insert or
delete text above them. You also have more options for editing individual chart elements in frames.

For more information about frames, see Frames and drawings.

Inserting as an OLE object

A chart copied and pasted as described above has no connection to the original chart in PlanMaker. Thus, if you
subsequently change the original in PlanMaker, this will have no effect on its copy in TextMaker.
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If you want to insert a chart that maintains a connection to the original chart in PlanMaker, you must insert it as
an OLE object. To do so, use the ribbon command Insert | OLE object frame and select PlanMaker Chart as
the object type.

For more information on handling OLE objects, see OLE objects.

Inserting charts manually

The previous section described how to create charts using PlanMaker and then copy them to your TextMaker
document. Alternatively, you can simply insert an empty chart into the TextMaker document and then manually
fill it with data. 

To do so, proceed as follows:

Step 1: Insert an empty chart

First, insert an empty chart as follows:

1. Move the text cursor to the desired position in your TextMaker document.

2. Choose the ribbon command Insert | group Objects | Chart frame  to open the dialog box. (Click on the
icon itself.)

Alternatively, you can click on the small arrow of the icon to list a dropdown menu with various chart types that you can insert
directly by clicking on them. If you choose More here, the dialog box will be shown again.

3. In the dialog box, you can specify which type of chart you want to insert. To do so, select the required
Chart type and Subtype.

For more information about chart types, see Changing the chart type.

4. Confirm with OK.

5. The chart is now inserted as a chart frame with a fixed position on the page.

You can then move or resize the chart:

To move the chart, click on it and (with the left mouse button still held down) drag it to the desired position.

To resize it, drag one of the round handles surrounding the chart.

Note: To embed the chart without a frame in the body text, select the command Convert on the contextual
ribbon tab Chart after inserting it. By clicking on the button again, the chart is converted back into a chart
frame. The difference is that frames are fixed at a fixed position on the page, thus they don't move when you
insert or delete text above them.

For more information on frames, see Frames and drawings.

Step 2: Enter the data to be displayed

When you create a new chart, it is filled with the values 1, 2, 3, 4 by default. These values are just sample
values to ensure that the chart is not completely empty when displayed. You should enter your own values here,
of course.



249Charts

To do so, proceed as follows:

1. If the chart is no longer selected, click on it to select it.

The contextual ribbon tab Chart appears as soon as a chart has been selected.

2. Choose the ribbon command Chart | Edit data .

3. A dialog box appears. In the Y values column, enter the values to be displayed in the chart.

Don't worry about the other columns and options; they are irrelevant for most chart types. (For more
information on this dialog box, see Entering/editing the data of a chart.)

4. When you have finished entering the values, confirm with OK.

The chart now updates and displays the values that you have entered.

If you want to change the values again later, select the chart and choose the ribbon command Chart | Edit data
again.

Editing charts

In the iOS version, the creation of charts is locked. (To unlock the command, see Welcome.)

You will learn how to edit existing charts in the next sections. The information covers the following topics:

§ Changing the chart type 

Use the ribbon command Chart | Chart type to determine the form in which the data will be represented in
the chart – for example, as bars, lines or in the form of a pie chart, etc.

§ Entering/editing the data of a chart 

You can use the ribbon command Chart | Edit data to edit the data of a chart – thus enter or change the
numeric values to be displayed.

§ Showing/hiding chart elements 

A chart contains various elements, such as data series, axes, a legend, etc. You can use the ribbon command
Chart | Add chart element to show or hide certain elements of the chart if necessary.

§ Editing chart elements 

You can select the elements of a chart by clicking on them and then edit them. You will learn how to do this
in this section.

§ Changing chart properties via the dialog box 

In addition to the properties of individual chart elements, there are also common chart properties that you
can change. These include various layout options, the chart type, settings for the data series, etc. You can
change these options on the contextual ribbon tab Chart (see below) or in the Properties dialog box
(accessible via the context menu).
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For basic information about working with objects, see Frames and drawings.

Using the ribbon tab "Chart"

When you select a chart, the contextual ribbon tab Chart appears automatically.

The contextual ribbon tab "Chart", left section

The contextual ribbon tab "Chart", right section

This ribbon tab contains icons for the most important functions for editing charts:

Note: Some of the functions are only available if the chart is created as a frame. For more information, see
Inserting charts. Use the command Chart | Convert to convert the chart into a frame.

§ New object: This option allows you to insert a new object into the document, and different object types are
available. 

§ Chart type/Chart subtype: This option allows you to select a chart type. (A subtype is only available for some
chart types.) For more information, see Changing the chart type.

§ Edit data: This option allows you to enter and change numeric values for the chart. For more information, see
Entering/editing the data of a chart.

§ Chart colors: This option allows you to change the color scheme of the chart.

§ Add element: This option allows you to show or hide chart elements such as axis titles, gridlines, legends,
etc. For more information, see Showing/hiding chart elements.

§ List of all chart elements contained in the chart. If you click on an element in the list, it will be selected in the
chart – if you select an element in the chart, it will be displayed in the list.

§ Edit properties: You click on this option to edit the selected chart element and the corresponding dialog box
opens. For more information, see Editing chart elements.

§ Fill color, Line color, Line style, Line thickness: You can use these options to change the fill and border lines of
the selected chart elements. For more information, see Editing chart elements.

§ Text wrapping: This option determines how the body text that surrounds the chart frame should behave. For
more information, see Object properties, Layout tab.
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§ Bring to front, Send to back: These options arrange the order of overlapping object frames. For more
information, see Changing the order of frames.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing frames.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping frames.

§ Duplicate: This option allows you to create an immediate copy of the selected chart.

§ Convert: This option converts a chart frame into a chart integrated in the body text and vice versa.

§ Width, Height: These options change the size of the chart. For more information, see Changing the size and
margins of objects.

Using the dialog box

Many (but not all) of these functions and some additional options can be found in the Object properties dialog
box that you open via the context menu (entry Chart: Properties).

Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner of any
command group of the ribbon tab Chart.

All options of the dialog box are explained in Changing chart properties via the dialog box.

Changing the chart type

The chart type determines how data will be displayed in a chart – for example, as columns, bars, lines, etc.

To change the chart type, proceed as follows:

Directly via the icons of the command group "Type"

Many chart types can be used directly via the icons of the command group Type on the contextual ribbon tab
Chart:

1. Select the chart by clicking on it.

2. Click on the Chart type icon  on the ribbon tab Chart | group Type.

3. Select the desired Chart type from the dropdown menu (see below for explanations of the different chart
types). You may use the icon below it to select a Chart subtype (only available for certain chart types).

Additional options via the dialog box of the command group "Type"

You will find some more options via the dialog box of the command group Type on the contextual ribbon tab
Chart. Here, you can also survey the possible appearance of the chart in a preview.

1. Select the chart by clicking on it.
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2. On the ribbon tab Chart | group Type, click on the group arrow  in the bottom right corner.

3. In the dialog box, switch to the ribbon tab Chart type.

4. Select the desired Chart type and Subtype.

Tip: A small preview of the currently selected chart will be shown in the right half of the dialog box. You
can enable or disable this preview at any time using the >> button or the << button.

The following chart types are available:

   Column chart

Column charts are a good way to compare values. Each value is represented by a correspondingly high
column.

   Bar chart

Bar charts correspond to column charts; however, the values are displayed horizontally rather than vertically.

   Line chart

Line charts display values as points and/or connecting lines.

   Area chart

Area charts are line charts where the space between the X axis and the individual lines is filled with color.

   XY scatter chart

XY scatter charts display values as points and/or lines. Unlike line charts, the data area must contain both the
X and Y coordinates of the data points.

   Bubble chart

Bubble charts display values as filled circles ("bubbles"). Bubble charts are usually based on data series
containing three values: X coordinate, Y coordinate, and bubble size.
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   Radar chart

Radar charts display values in a web. The zero point is in the center of the web.

   Surface chart

Surface charts display values as a three-dimensional shape. Areas plotted in the same color indicate that they
contain similar values.

The values to be displayed should have the following structure:

(Z values determine the height.)

   Pie chart

Pie charts are well suited to displaying the percentage of individual values of the total value. The size of each
"pie slice" shows the ratio of the value to the total and to the other values.

Tip: You can highlight values by extracting the related slice of the pie from the pie. Select the slice of the pie
and extract it via the mouse.

   Doughnut chart

Doughnut charts, like pie charts, show the percentage of individual values of the total value. Unlike pie charts,
however, they can display any number of data series (rings) and not just a single series.

       Cylinder, Cone and Pyramid charts

Cylinder, Cone and Pyramid charts correspond to column and bar charts. However, they use cylinders, cones
or pyramids instead of columns/bars to display the values.
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   Stock chart

Stock charts (also known as general high-low charts) are suitable for displaying the development of stock
prices, among other things. They enable the highest price, lowest price and closing price to be seen at a glance,
for example.

The following subtypes are available:

§ Stock chart (High, Low, Close) 

This type of chart displays the following values: highest price, lowest price, closing price.

It requires 3 data series in the above order.

An example of the possible structure of the data (with the date added in column A):

§ Stock chart (Open, High, Low, Close) 

This type of chart displays the following values: opening price, highest price, lowest price, closing price.

It requires 4 data series in the above order.

§ Stock chart (Volume, High, Low, Close) 

This type of chart displays the following values: trading volume, highest price, lowest price, closing price.

It requires 4 data series in the above order.

The trading volume is displayed as an additional column with its own value axis.

§ Stock chart (Volume, Open, High, Low, Close) 

This type of chart displays the following values: trading volume, opening price, highest price, lowest price,
closing price.

It requires 5 data series in the above order.

The trading volume is displayed as an additional column with its own value axis.

   Box plot chart

Box plots (or box and whisker plots) are useful for data analysis in statistics. Detailed explanations relating to
the application of box plots would go beyond the scope of this manual. You can find further information on
them via your preferred Internet search engine.



255Charts

There are two subtypes: Horizontal and Vertical.

Depending on the number of data series passed to the chart, different variants of box plots will be rendered:

Note: You can display any type of value in a box plot. The following lists show examples only.

§ 3-point box plot 

This box plot displays, for example, the following values:

Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)

This box plot requires exactly 3 data series in the above order.

§ 5-point box plot 

This box plot displays, for example, the following values:

Lower whisker (line below the box)
Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)

This box plot requires exactly 5 data series in the above order.

§ 7-point box plot 

This box plot displays, for example, the following values:

Minimum (as a single marker)
Lower whisker (line below the box)
Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)
Maximum (as a single marker)

This box plot requires exactly 7 data series in the above order.

Entering/editing the data of a chart

When you create a new chart, the values 1, 2, 3, and 4 are entered in it by default. These values are just sample
values to ensure that the chart is not completely empty when displayed.

You can use the ribbon command Chart | Edit data to edit these values at any time and enter your own values.

Proceed as follows:

1. Click to select the relevant chart and the contextual ribbon tab Chart will appear.

2. Choose the command Chart | Edit data  here.

3. The dialog box "Data source" opens. In the Y values column, enter the values to be displayed in the chart.

Don't worry about the other columns and options; they are irrelevant for most chart types.

(For more information on all options in this dialog box, see below.)
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4. Confirm with OK.

The chart now updates and displays the values that you have entered.

Alternatively, you can open this dialog box by right-clicking on the chart and selecting Chart: Properties from
the context menu.

In the following dialog box "Object properties", switch to the Series tab, and click on the Edit button there to
open the dialog box "Data source".

Options of the dialog box

The aforementioned dialog box "Data source" has the following options:

§ Series 

Here, you can select which series to display in the dialog box in the case of charts with multiple data series.

Tip: To manage the data series of a chart, right-click on the chart and choose the command Chart:
Properties in the context menu. Switch to the Series tab. On this tab, you can add, delete and edit data
series.

§ Rename button 

This button allows you to rename the data series that is currently selected in the Series list. Tip: This name
is also displayed in the legend of a chart.

The largest part of the dialog box is occupied by a table where you can enter the values:

§ X values 

The left column represents the X values. These values are required only by a few special chart types (for
example, XY scatter charts). For all other chart types, this column is set to Automatic by default (via the
appropriate checkbox above this column).

§ Y values 

The middle column represents the Y values. Here, you usually enter the values to be displayed in the chart.

§ Bubble sizes 

The right column is only to be filled for bubble charts and determines the size of the bubbles.

§ Insert row button: This option inserts an additional row above the current row. 

§ Append row button: This option appends an additional row below the last row.

§ Delete row button: This option deletes the current row.

§ Paste button: This option overwrites the values in the current data series with the values that are currently
on the clipboard.

Copy the desired Y values to the clipboard beforehand. Use a new line for each value.

See also the following notes.
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Some notes on the "Paste" button:

§ The Paste button can fill only one data series with data at a time. This means that you cannot copy, for
example, a whole table to the clipboard and then paste it as multiple data series. 

Tip: However, you can achieve this at any time via a small "detour": Paste the contents of the table into the
PlanMaker spreadsheet application (as table cells), create the chart from it, copy it to the clipboard, and then
paste it into TextMaker. For more information, see also Inserting charts via PlanMaker.

§ If you want to insert X and Y values using the Paste button, first disable the Automatic checkbox above the
X values column. The clipboard must, of course, contain two values in each row (X and Y). Separate them
with a tab, a semicolon or the list separator set in your system. 

§ The same applies to bubble charts. Here, the clipboard can contain up to three values per row: X, Y and the
bubble size.

§ Text strings on the clipboard normally return the value 0 (zero). If a text string also contains numbers,
however, the first number is extracted from it.

Some examples:

"Euro" returns the value 0.

"50 Euro" returns the value 50.

"Euro 50" returns the value 50.

"50 Euro, 20 Cent" also returns the value 50. (Only the first number is always taken into account.)

Adding/deleting data series

If you want to add a new data series to the chart or remove an existing data series, right-click on the chart and
choose the command Chart: Properties in the context menu. In the following dialog box "Object properties",
switch to the Series tab.

Click on the Add button here to add a data series. The new data series then appears in the list on the upper left
of this dialog box. Then press the Edit button, and enter the values to be displayed in the following dialog box
"Data source", as described above.

To remove a data series, select it in the list on the upper left of the dialog box "Object Properties", and click on
the Delete button.

Showing/hiding chart elements

Certain elements of the chart can be shown or hidden if necessary. Some of them are shown automatically when
you create the chart, for example, the axes and the legend.

Tip: See Editing chart elements for an illustration of the most important chart elements.

The following elements can be shown/hidden:

§ Axes and axis titles 
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§ Chart title

§ Data_labels

§ Error bars

§ Gridlines

§ Legend

§ Lines

§ Trendline

§ Up/down bars

For more information, see the following sections.

Showing/hiding axes and axis titles

The horizontal X axis of a chart is also known as the category axis.

The vertical Y axis of a chart is also known as the value axis.

The Z axis of a chart is also known as the series axis. It is only available for certain three-dimensional chart
types.

Note: The X axis and Y axis are shown automatically when the chart is created.

To show or hide an axis, proceed as follows:

Via the "Add chart element" icon

You can use the Add chart element icon  on the contextual ribbon tab Chart to show or hide the X axis
and/or Y axis (the Z axis only in the dialog box, see below).

To do so, select the chart and use the ribbon command Add chart element  to select the entry Axis. In the
following submenu, you can use the entry Primary horizontal to show or hide the X axis and Primary vertical
to show or hide the Y axis.

The entry More takes you to a dialog box with additional options (see below).

Axis title: To add, change or remove axis titles, proceed as follows:

§ Adding axis title 

If you want to add an axis title to the axis, choose the ribbon command Add chart element and then select
the entry Axis title. Primary horizontal shows an axis title for the X axis, while Primary vertical shows it
for the Y axis.

The entry More also takes you to the dialog box here (see below).
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§ Changing an axis title 

To rename an axis, double-click on the axis title and switch to the Text tab in the following dialog box.
Enter the desired text here.

§ Removing an axis title 

To remove an axis title, hide it again via the command Add chart element or select it directly in the chart
and press the Del key.

Via the dialog box

For additional axis options (for example, the Z axis or secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Axis (or Axis title) and select
More in the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties. 

3. Switch to the Elements tab.

Axes: The checkbox in front of each axis can be used to enable/disable the display of the relevant axis.

Axis title: To the right of the axis, you can give it a name. This will then be displayed below/next to the
axis.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.

Editing axes and axis titles

For more information on editing the properties of axes, see Category axis (X axis), Value axis (Y axis) and
Series axis (Z axis).

For information on editing the properties of the axis title, see Axis title.

Showing/hiding chart titles

You can show or hide a chart title for the chart. The title will then be displayed above the chart.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Chart title. In
the following submenu, select Above chart to add a chart title. If you select None, the chart title will be
removed.

If you select More, you will be taken to the dialog box (see below) where you can rename the chart title.

Alternatively: Double-click on the chart title and you can then rename the title on the Text tab.
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To remove a chart title, select it and press the Del key.

Via the dialog box

To show or hide the chart title via the dialog box, proceed as follows:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Chart title and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. On the Elements tab, you will find an input field for the Chart title at the top. Type the desired title here.

To delete the chart title, simply remove the text from this input field.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.

For information on editing the properties of the chart title, see Chart title.

Showing/hiding data labels

The data points of a chart can be labeled. This allows you to display the exact value of the data points in the
chart.

To show or hide data labels, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Data labels.
In the following submenu, you can choose between different options for positioning the data label (left,
centered, above, etc.). A check mark in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

Tip: To remove a single label, select it and press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options for data labeling, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Data labels and select More
in the following submenu to open the dialog box.
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Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Data labels tab and make the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Data labels" tab.

Showing/hiding error bars

Note: This chart element is only available for certain two-dimensional chart types, such as column, bar and
line charts.

You can draw error bars for the data points of a data series. Error bars display the possible/tolerable error of
the values in the form of a line with a short dash at the end.

To show or hide error bars, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Error bars.
In the following submenu, you can choose from a predefined selection for displaying the values. A check mark
in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

Additional options for error bars can be found via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Error bars and select More in
the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Error bar tab and select the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Error bar" tab.

Showing/hiding gridlines

Showing gridlines in a chart can improve the legibility of its values. Gridlines are a network of lines that extend
across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:
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§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.

You can enable gridlines separately for each axis.

To show or hide gridlines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Gridlines. In
the following submenu, you can enable or disable horizontal (for the Y axis) and vertical (for the X axis) major
gridlines and minor gridlines for the primary axis. A check mark in front of them indicates the gridlines which
are currently enabled.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options (for example, gridlines for secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Gridlines and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties. 

3. Switch to the Elements tab and enable the option Major grid and/or Minor grid for the desired axes.

For more information on editing gridlines, see Gridlines.

Showing/hiding the legend

If desired, you can show (or hide) a legend in the chart. A legend is a small box that shows which data series
are displayed in which color/pattern.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Legend. In
the following submenu, you can specify where to position the legend. A check mark in front of it indicates the
option which is currently enabled.

You can hide the legend by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:
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1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Legend and select More in the
following submenu to open the dialog box.

Alternatively: Select the legend and right-click to open the context menu and select the entry Legend:
Properties.

3. On the Legend tab, specify where the legend should be positioned. If you select the option Custom, the
legend can be moved to any position (using the mouse). If you select the option None, the legend will not be
displayed.

Tip: If you choose the entry Chart: Properties via the context menu, the main dialog box for charts
opens. You will find the option Legend here also on the Elements tab.

For more information on editing the properties of a legend, see Legend.

Showing/hiding lines

Note: This option can only be used for line charts and area charts.

You can use the options for lines, for example, to illustrate the spacing between the individual data series in a
line chart.

The following types of lines are available:

§ Drop lines are lines displayed from the data points to the horizontal axis. 

§ High-low lines are lines displayed between the highest and lowest data points (for two or more data series).

To show/hide drop lines or high-low lines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Lines. In the
following submenu, you can choose between Drop lines and High-low lines. A check mark in front of it
indicates the option which is currently enabled.

You can hide the lines by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Lines and select More in the
following submenu to open the dialog box.
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Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Options tab and enable the desired settings.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.

Showing/hiding the trendline

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Other limitation: They are not available for stacked chart types.

If desired, you can add trendlines to the data series of a chart.

Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

To show/hide trendlines, proceed as follows:

Via the "Add chart element" icon

Select the desired data series to which you want to add a trendline.

Use the ribbon command Chart | Add chart element  to choose the entry Add trendline. In the following
submenu, select one of the predefined trendline types.

The entry Remove all removes all trendlines (select the chart for this purpose). To remove individual
trendlines, select the desired trendline and then choose Remove all or simply press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

You will find more trendline types and additional options via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Add trendline and select
More in the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Add trendline.

3. Switch to the Trend tab and enable the desired settings.

For more information on the options of the dialog box, see Trendlines.
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Showing/hiding up/down bars

Note: This option can only be used for line charts.

You can use the option Up/down bars to display bars between the first and last data series, for example, in a
line chart with two or more data series.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element   to choose the entry Up/down
bars. In the following submenu, select the same entry.

You can use the entry None to remove the up/down bars.

The entry More takes you to the dialog box (see below) where you can also set the spacing between the bars.

Via the dialog box

Choose the path via the dialog box to make further settings:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Up/down bars and select
More in the following submenu to open the dialog box.

Alternatively: Select any data series and right-click to open the context menu and select the entry Series:
Properties.

3. Switch to the Options tab and enable the checkbox in front of Show up/down bars with gap. In the input
field below, you can set the gap between the bars.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.
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Editing chart elements

Charts consist of several components. In addition to the data series themselves, for example, there are axes, a
legend, etc. These individual components of a chart are called the chart elements.

The following figure shows the most important chart elements:

Series 1, Series 2, etc. represent the chart's data series.

Three-dimensional chart types contain some additional chart elements (floor, walls, etc.), which will also be
described on the following pages.

Each of these chart elements can be selected at the click of a mouse and then edited.

Selecting chart elements

To select a chart element, first click on the chart itself to select it and then click on the desired chart element.
To select a data series, for example, click on any value within this series.

Note: To select a single value within a data series, first click on the data series and then click on the desired
single value.

Tip: Alternatively, you can select chart elements by expanding the list of elements on the ribbon tab Chart |
group Chart elements and selecting the desired element from it. Here, you can always see which chart
element is currently selected.



267Charts

Changing the position and size of chart elements

The position and size of some chart elements (for example, the legend) can be changed. To move an element,
select it and then drag it to the desired position. To change its size, drag one of the handles surrounding the
element.

Changing the fill and borders of chart elements

The fill color and border lines of chart elements can be applied directly with the buttons of the command group
Chart elements on the ribbon tab Chart. To do so, select a chart element and make the desired adjustments
using the buttons Fill color, Line color, Line style and Line thickness.

Note: In the case of the buttons Fill color and Line color, the last color that you used will be applied again when you click directly on the
icon itself. By clicking on the icon's arrow, you open the color palette.

Only for the Fill color button: If you click on the icon's arrow, you can use the entry More Fills to also apply more complex fills. For
more information, see Object properties, Fill tab. By clicking on the entry More colors, you reach a dialog box with color definitions,
which you use according to the descriptions of the section Document properties, Colors tab.

You will also find fill and border settings via the dialog box of the chart elements (see next paragraph). You can
also change other properties here, depending on the type of chart element.

Changing properties of chart elements

In addition to changing the properties of the chart itself, as described later in Changing chart properties via the
dialog box, you can also edit the properties of individual chart elements.

To change the properties of a chart's legend, for example, proceed as follows:

1. Select the chart by clicking on it.

2. Right-click on the legend to open its context menu.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen
and hold your finger there for about a second.

3. In the context menu, choose the command Legend: Properties (not the command Chart: Properties).

A dialog box will now appear in which you can make the desired settings.

Tip: Alternatively, you open the dialog box via the ribbon command Edit properties .

Even faster: Open the dialog box by double-clicking on the desired element.

The properties that you can change in this dialog box depend on the type of chart element for which you opened
it. The following sections provide more information about all available chart elements and their respective
properties:

§ Chart area 
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§ Plot area

§ Walls (three-dimensional charts only)

§ Floor (three-dimensional charts only)

§ Corners (three-dimensional charts only)

§ Data series and data points

§ Trendlines

§ Category axis (X axis)

§ Value axis (Y axis)

§ Series axis (Z axis)

§ Axis title

§ Chart title

§ Gridlines

§ Legend

Chart area

The chart area is the entire area of a chart frame.

Edit properties: To change the properties of the chart area, select it, right-click to open the context menu and
choose the command Chart area: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the chart area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the entire chart. Auto gives the chart a thin gray standard line as a border.
None removes the border. The option Custom lets you customize the line style.

If you enable the option Shadow, the chart frame will also be highlighted with a shadow. The Adjust button
opens additional settings for the appearance of the shadow effect.

§ Fill section 

Here, you can change the fill of the chart area. Auto gives the chart area a white fill area. The fill will be
transparent if you use the option None. You can use the option Color to customize the color for the fill.
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If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

Here, you can change the text formatting for all chart elements.

To do so, select the desired font, font size, alignment, etc.

Important: Changes will affect all chart elements, even if they were previously formatted in a different font.

Plot area

The plot area of a chart is the area where the data series, axes and gridlines are drawn.

Changing properties: To change the properties of the plot area, select it, right-click it and choose the command
Plot area: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the plot area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the plot area. To do so, use the option Custom to select the desired line style.
The option None removes the border.

§ Fill section 

Here, you can change the fill of the plot area. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.



270Charts

Walls (three-dimensional charts only)

 Walls are the back walls of charts that use a three-dimensional chart type.

Changing properties: To change the properties of the walls, select one of the walls, right-click it and choose the
command Walls: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the walls.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the walls. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the walls. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Floor (three-dimensional charts only)

Floors are only present in three-dimensional chart types.

Changing properties: To change the properties of the floor, select it, right-click it and choose the command
Floor: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the floor.

You can make the following settings:
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Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the floor. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the floor. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Corners (three-dimensional charts only)

Corners are only present in three-dimensional chart types.

Changing properties: To change the properties of the corners, select one of them, right-click it and choose the
command Corners: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements.

You can make the following settings:

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Data series and data points

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, pie segments, etc., depending on the chart type selected.

A data series is the graphical representation of a column or row of cell values on which the chart is based. Each
data series, in turn, consists of multiple data points, thus the individual cell values.
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Changing properties: To change the properties of data series or single data points, proceed as follows:

§ If you click on any of the data points of a data series, the entire data series will be selected. You can now
edit the properties of this data series by right-clicking on it to open the context menu and then choosing the
command Series: Properties. 

§ If you click on the same data point once again, only this single data point will be selected. The command in
the context menu is then called Point: Properties.

Tip: Alternatively, you can choose these commands via the Edit properties icon  on the ribbon tab
Chart | group Chart elements after you have selected the data series (or the data point).

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section (or Line section) 

Here, you can change the line style used to draw the graph. To do so, use the option Custom to select the
desired line style. The option None removes the line.

If you enable the option Shadow, the graph will also be highlighted with a shadow. You can use the Adjust
button to make other settings for the appearance of the shadow effect. (For some chart types, the option
Smooth line appears here instead, which enables you to give the graph a smoother gradient.)

§ Fill section 

Here, you can change the fill of the data series/data points. Auto gives the fill area a standard color. The fill
will be transparent if you use the option None. You can use the option Color to customize the color for the
fill. The color for negative values can be assigned a different color for certain chart types.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

§ Marker section (available only for certain chart types) 

Some chart types (for example, certain types of line charts) draw markers for each data point. Here, you can
customize the appearance of such markers.

3D format tab

Note: The options on this tab are available only for certain chart types.

Use this tab to add a light effect or bevels to the data points to be displayed.

§ Material 

Here, you can select the material that should be simulated to display the data points.
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§ Light 

Here, you can select the type of light that should be simulated.

§ Angle 

Here, you can change the angle of the light source.

Tip: The above effects usually look better if you also use the following option to add bevels to the data
points.

§ Bevels section 

Here, you can add a bevel effect to the graphical representation of the data points. If you apply these options
to a bar chart, for example, the edges of the bars will be rounded. The larger the value, the rounder the edges
will be displayed.

Data labels tab

Use this tab to add labels to the selected data points. This is useful, for example, if you want to have the exact
values displayed for each data point.

§ Display section 

Here, you can specify the type of label to be displayed. The default option is Don't show, thus no label is
displayed. If, for example, you select the option Show value, the value of the relevant data point will be
displayed, while the option Show data point will display its name, etc.

§ Display legend key in label 

If you enable this option, the legend keys of the relevant data points will be displayed before the labels. The
legend key is a small square in the same color as the data point.

§ Placement section 

Here, you specify where the label should be placed (relative to the respective data point).

Note: If you label data points, you can also click on these labels in the chart. Thus, you can change their
properties by selecting a different font or changing the text you want to display, for example.

The following program response also applies here: Clicking once selects all labels of a data series, while
clicking again selects a single label.

Error bar Y tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to add error bars to the data points of the selected data series. Error bars display the
possible/tolerable error of the values in the form of a line with a short dash at the end.
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Chart with "Plus" and "Minus" error bars

To add error bars, select the desired type of error bar in the Display section: Plus only displays a positive error
bar, Minus only displays a negative error bar, Plus and minus displays both error bars.

The option Show as lets you determine the appearance of the error bars: with or without short dashes at the
ends.

In the Value section, you can change the length of the indicator line. If, for example, you select the option
Fixed, the line will always have the specified length, while if you select the option Percent, the length will
correspond to the specified percentage of the respective Y value, etc.

Error bar X tab

Note: This tab is only available for XY scatter charts and bubble charts.

This tab is identical to the Error bar Y tab (see above), except that it displays error bars for the X values instead
of the Y values.

Helper lines tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to display various guides in the chart. If, for example, you enable the option Average, a
dashed line indicating the average value of the selected data series will be displayed in the chart.

You can enable guides for Average, Minimum/maximum, Standard deviation, and Linear approximation
(linear trend).

Tip: You can use the ribbon command Chart | Add chart element  | Add trendline to show other types of
trendlines in the chart if necessary. For more information, see Trendlines.

Options tab

This tab shows different settings for displaying the data series/data points, depending on the chart type, for
greater clarification of the results.

For a line chart, for example, you will find the following settings:
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Note: For other chart types, you will find different settings on the Options tab.

§ Displaying drop lines 

If you enable this option, lines will be drawn from the data points to the horizontal axis.

§ Displaying high-low lines 

If you enable this option, lines will be displayed between the highest and lowest data points (for two or more
data series).

§ Up/down bars with gap 

You can use this option to display bars between the first and last data series, for example, in a line chart with
two or more data series. In the input field below, you can also set the gap between the bars.

For the above options, you can choose between different settings of the display in the section Empty cells are
... in case individual data points are missing.

If you select the option Vary color for each data point, the data points will be automatically colored with
different colors (not available if there are multiple data series).

Tip: You can also format these chart elements, if enabled, by selecting them and right-clicking to open the
context menu where you choose the relevant entry (Drop lines, High-low lines, Up/down bars):
Properties.

Trendlines

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Furthermore, they should not be stacked.

If desired, you can have a trendline shown for each data series of the chart. For more information, see
Showing/hiding the trendline.

Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

Changing properties: To change the properties of a trendline, select it, right-click it and choose the command
Trendline: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the trendline.

You can make the following settings:
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Format tab

§ Line section 

Here, you can change the appearance of the trendline. Auto uses a thick black standard line. None removes
the line. The option Custom lets you customize the line style.

Trendline tab

§ Type section 

Here, you can select the type of trendline to be displayed. In addition to linear trendlines (i.e. simple best-fit
lines), trendlines such as exponential or polynomial trendlines can also be displayed.

The available types of trendlines are based on the following formulas:

Linear: y = ax + b

Polynomial: y = b + c1x + c2x
2 + c3x

3 + ... + c6x
6

Exponential: y = cebx   (e = Euler's number)

Logarithmic: y = c ln(x) + b

Potential: y = cxb

Moving average: f(xi) = (xi + xi-1 + xi-2 + ... + xi-n+1) / n

§ Based on series 

Here, you can specify the data series for which the trendline is to be displayed.

§ Forecast section 

Here, you can extend the trendline beyond the existing data points.

If, for example, there are 3 data points (for example, the sales results for the 1st, 2nd and 3rd year), you can
enter a 1 for Forward. The line is then extended by an additional period (1 data point), thus displaying a
forecast for sales in the 4th year.

§ Crossing point 

Here, you can force the trendline to intersect the Y axis at a specific Y coordinate. This option is available
only for certain types of trendlines.

§ Show formula in chart 

If this option is enabled, the formula used to calculate the trendline will be displayed in the chart.

§ Show correlation in chart 

If this option is enabled, the correlation coefficient R2 of the data series will be displayed in the chart.
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§ Name section 

Here, you can change the name of the trendline if desired. This name is displayed in the legend. To do so,
select the option Custom and enter the desired name.

Category axis (X axis)

The X axis of a chart is also called the category axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Changing properties: To change the properties of the category axis, select it, right-click it and choose the
command Category axis: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

Note: If the category axis contains date values, other settings appear here that are similar to the scaling
options of the value axis (Y axis). For more information, see the descriptions in the next section Value axis
(Y axis), "Scale tab".

§ Axis ends... section 

This option allows you to determine where to end the visible part of the axis: In categories or Between
categories.
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Explanation: The first, second, third, etc., data point of all data series is called the category of a chart.

§ Number of categories between... section 

By default, TextMaker makes a tick mark on the axis for each category and labels it. You can change these
intervals via the following options:

The option Tick marks determines which categories are marked with a tick mark. Enter 1, and a tick mark
is set for every category. Enter 2, and a tick mark is set for every second category, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark is labeled. Enter 2,
and every second tick mark is labeled, etc.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis): At low end (where the category axis begins), At high end (where the category axis ends) or at the
specified category number.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. The order of the categories is also reversed
accordingly; the chart thus starts with the last category and ends with the first category.

Font tab

Use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Value axis (Y axis)

The Y axis of a chart is also called the value axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Changing properties: To change the properties of the value axis, select it, right-click it and choose the command
Value axis: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.
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§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether axis labels should be displayed and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Lowest value and Highest value sections 

These options determine where the visible part of the axis should begin and where it should end. Select
either the option Auto, which results in TextMaker automatically determining the most appropriate values,
or select Custom and enter the desired value yourself.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis):

If Auto is selected, TextMaker automatically determines the most appropriate value, and if Maximum value
is selected, the X axis is positioned at the end of the Y axis. You specify your own Y value if you select
Custom value.

§ Major step value section 

Here, you can set the interval for the tick marks and labels on the axis. If you select the option Auto,
TextMaker automatically determines the most appropriate values.

§ Minor step value section 

Here, you can set the interval between minor tick marks on the axis. If you select the option Auto,
TextMaker automatically determines the most appropriate values.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. In a column chart, for example, the columns are
no longer drawn from bottom to top, but from top to bottom.

§ Logarithmic scale 

If this option is enabled, the axis will use a logarithmic scale (for example, 10, 100, 1000, etc.) rather than a
linear scale.

Font tab

You can use this tab to change the formatting of the axis labels.
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In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Series axis (Z axis)

The Z axis of a chart is also called the series axis. It is only available for certain three-dimensional chart types.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Changing properties: To change the properties of the series axis, select it, right-click it and choose the command
Series Axis: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Number of series between... section 

By default, TextMaker makes a tick mark on the axis for each data series and labels it. You can change these
intervals via the following options:

The option Tick marks determines which data series are marked with a tick mark. Enter 1, and a tick mark
will be set for every data series. Enter 2, and a tick mark will be set for every second data series, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark will be labeled.
Enter 2, and every second tick mark will be labeled, etc.
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§ Invert axis direction 

If this option is enabled, the direction of the axis will be reversed. The order of the data series will also be
reversed accordingly; the chart will thus start with the last series and end with the first series.

Font tab

You can use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Axis title

You can name each axis. This will then be displayed below/next to the axis. For more information, see
Showing/hiding axes and axis titles.

Edit properties: To change the properties of the axis title, select it and right-click to open the context menu and
choose the command (Category/Value) axis title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the axis title. To do so, use the option Custom to select
the desired line style. The option None removes the border.

If you enable the option Shadow, the axis title will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the axis title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.
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Text tab

Here, enter the desired axis title. If you delete the text completely from the input field, the axis title, as a chart
element, will be removed.

Font tab

On this tab, you can change the formatting of the axis title.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Chart title

Here, you can enter a title for the chart. This is then displayed above the chart. For more information, see
Showing/hiding chart titles.

Edit properties: To change the properties of the chart title, select it and right-click to open the context menu and
choose the command Chart title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the chart title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the chart title. To do so, use the option Custom to
select the desired line style. The option None removes the border.

If you enable the option Shadow, you can also highlight the chart title with a shadow.

§ Fill section 

Here, you can change the fill of the chart title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.
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Text tab

Here, enter the desired title of the chart. If you delete the text completely from the input field, the chart title, as
a chart element, will be removed.

Font tab

On this tab, you can change the formatting of the chart title.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Gridlines

You can show gridlines to make the values in a chart easier to read. (For more information, see Showing/hiding
gridlines.)

Gridlines are a network of lines that extend across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:

§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.

Changing properties: To change the properties of the major grid of the value axis, for example, select one of its
gridlines, right-click on it and choose the command Value axis major gridlines: Properties from the context
menu.

Tip: Alternatively, you can chose this command via the Edit properties icon  on the ribbon tab Chart.

You can make the following settings:

Format tab

Tip: The appearance of the lines can also be conveniently adjusted directly via the buttons of the ribbon tab
Chart | group Chart elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the gridlines. Auto uses thin gray standard lines. None
removes the lines. The option Custom lets you customize the line style.

Changing the scale of gridlines

To change the distances between the gridlines, select the corresponding axis, choose its properties and make the
desired changes on the Scale tab.
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Legend

If desired, you can show a legend in the chart. For more information, see Showing/hiding the legend.

A legend is a small box that shows which data series are displayed in which color/pattern.

Changing properties: To change the properties of the legend, select it, right-click it and choose the command
Legend: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the legend.

Note: If you only want to edit a single legend entry (you can also apply a formatting to it that differs from that of the legend as a whole),
then click again in the area of the desired legend entry after selecting the legend. You can now choose the command Legend entry:
Properties via the context menu.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style of the legend's border. To do so, use the option Custom to select the
desired line style. The option None removes the border.

If you enable the option Shadow, the legend will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the legend. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

You can use this tab to change the character format (font, font size, text styles, etc.) of the legend.

Legend tab

Here, you can specify where the legend should be displayed.

If you select the option Custom, the legend can be moved to any position (using the mouse).

If you select None, the legend will be hidden.
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Changing chart properties via the dialog box

The previous sections discussed how to edit the properties of specific chart elements. This section discusses the
properties of the chart itself.

To change the properties of a chart, click to select the chart and right-click to open the context menu. Select the
entry Chart: Properties.

Tip: Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner
of any command group of the ribbon tab Chart.

The following settings can be made in this dialog box:

Layout tab

On the Layout tab, you can change the chart's wrap margins. For chart frames, you can also change the position
and the text wrapping.

For more information, see Object properties, Layout tab.

Format tab

You can use this tab to change the size of the chart.

For more information, see Object properties, Format tab.

Properties tab

Here, you can change the general settings of the chart.

For more information, see Object properties, Properties tab.

Chart type tab

Here, you can change the chart type:

First, select the desired Chart type on the left and then the desired Subtype on the right. For more information
on the available chart types, see Changing the chart type.

Color palette: You can change the color scheme of the chart here.

Reset all settings in chart: This option restores any changes you made to the properties of the chart back to
their original state.

On the right side of the dialog box, a Preview shows the result of your customizations. If necessary, use the

button  to open the preview.

Series tab

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, etc., depending on the chart type selected.
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The Series tab allows you to make settings for each data series of a chart. Here, you can also enter and change
the numeric values that you want to display in the chart (via the Edit button).

In the Series list, select the series you want to change. Then make the desired settings:

§ Series 

The Series list contains a list of all data series currently included in the chart.

You can use the arrow buttons to the right of the list to change the order of the data series.

Use the Add and Delete buttons to add or remove data series.

The Edit button can be used to edit the numeric values contained in the selected data series. For more
information, see also Entering/editing the data of a chart.

§ Data sources section

Here, you can specify which data should represent the selected data series.

The fields in this section are filled in automatically, and there is usually no need to change them.

Note: Do not manually edit the fields in this section. Use the Edit button instead (located below the
Series list). It opens a dialog box where you can enter/edit these values in a more convenient manner. For
more information on this dialog box, see Entering/editing the data of a chart.

The following fields can be found here:

Name: The name of the data series. This field can also be left empty, whereupon the data series receives an
automatically generated name (for example, "Series 1", "Series 2", etc.).

Y values: The Y values for each data point of the data series. To edit these values, it is best to use the Edit
button (located below the Series list).

Explanation: For most chart types, the Y values are the values that should be displayed in the chart. For example, the Y values
determine the height of the columns in a column chart.

X values: The X values of the data series. To edit these values, also use the Edit button (located below the
Series list).

Explanation: For most chart types, the X values are irrelevant and are set to "Auto" (i.e. automatic) because they are only used to
label the category axis (X axis). XY scatter charts and bubble charts are the exception, however, as the X and Y values determine
the coordinates of the data points in these charts.

Bubble sizes: For bubble charts, there is a third parameter in addition to X and Y values: the size of the
bubbles for each data point. You should use the Edit button to edit the values here also.

§ Display this series as section 

Here, you can specify how the selected data series is displayed in the chart. If, for example, you have
selected a column chart as the chart type, but want a particular series to appear as a line chart, you select the
option Lines for this data series.

§ Use secondary axis for this series 

If you enable this option, a secondary value axis (Y axis) will be added to the chart for this data series.
Secondary value axes can have a different scale to primary value axes.

Explanation: It is useful to represent specific data series on a secondary axis if these data series require an axis with a completely
different scale because they contain significantly larger values than the other data series.
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Elements tab

On the Elements tab, you can show/hide and label the various chart elements:

§ Chart title 

Here, you can enter a title for the chart. The title will then be displayed above the chart.

§ Primary axes section 

Here, you can make settings for the primary axes:

You can use the checkbox in front of each axis to enable/disable the display of this axis.

To the right of the checkbox, you can give the axis a name. This will then be displayed below/next to the
axis as an axis title.

The Major grid and Minor grid options determine whether gridlines should be displayed in the background
of the chart. These grids make it easier to read the values.

§ Secondary axes section 

If the chart has secondary axes, you can configure them here, similar to the primary axes (see above).

§ Legend 

Here, you can specify the position of the legend. A legend is a small box that shows which data series are
displayed in which color/pattern.

3D view tab

Note: This tab is only available for three-dimensional chart types.

On the 3D view tab, you can change the 3D effect for the chart (for three-dimensional chart types).

§ Rotation angle and Elevation angle 

Here, you can set the viewing angle (in degrees) from which the viewer sees the chart. Rotation angle
rotates the chart around the vertical axis, while Elevation angle rotates the chart around the horizontal axis.

§ Perspective 

If this option is enabled, the chart will be distorted in perspective. You can also specify the amount of
distortion (from 0 to 100%).

§ Height and Depth 

Here, you can change the height and depth of the chart (as a percentage of its original size).

Radar tab

Note: This tab is only available for radar charts.

On the Radar tab, you can make additional settings for displaying the chart (for radar charts).
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§ Starting angle 

This option allows you to rotate the chart by the specified angle.

§ Orientation 

This option specifies whether the values should be arranged clockwise or counterclockwise.

§ Round radar chart 

If this option is enabled, pie segments are drawn between the axes instead of lines.

§ Polar coordinates 

If this option is enabled, polar coordinates are used instead of Cartesian coordinates. The polar coordinates
are only available if Round radar chart is enabled.

If Angle between axes is set to x, an axis will be plotted every x degrees.

If Angle between axis descriptions is set to x, an axis label will be plotted every x degrees.

§ Limit plot area to radar 

If this option is enabled, only the area inside the radar will be filled. If it is disabled, the entire rectangle
surrounding the radar will also be filled.

Saving charts as pictures
You can save an image of a chart as a picture file at any time. This makes it easier to share the chart with others
or to insert it into a web page or any other document.

To do so, proceed as follows:

1. Click to select the desired chart.

2. Right-click on the chart and choose the command Save as picture from the context menu.

3. In the Save as type list, select the desired picture format.
Tip: The PNG format is always a good choice here since it offers good and completely lossless compression.

4. Enter the file name under which you want to save the picture and confirm with OK.

5. Another dialog box appears. Select the desired resolution for the picture or manually enter your own values
for the width and height. Then confirm with OK.

TextMaker now creates a corresponding picture file with an image of the chart.
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OLE objects

Note: The use of OLE objects is only possible with the Windows version of TextMaker.

With TextMaker for Windows, you can embed objects created with other applications (drawings, pictures, etc.)
in your document.

Example: You can use the ribbon command Insert | OLE object frame (click directly on the icon itself) to
start the Windows Paint program from TextMaker and draw something in it. If you exit Paint, the drawing will
appear in the TextMaker document. It is now embedded in the document.

Advantage: You only have to double-click the drawing in the TextMaker document and Paint will then be
restarted automatically. If you now edit the drawing in it and exit Paint again, your changes will be imported by
TextMaker.

For this to work, the application that you choose must support OLE. OLE stands for Object Linking and
Embedding. The object that is imported from the other application into TextMaker is called an OLE object.

In this chapter, you will learn everything you need to know about OLE objects. The information covers the
following topics:

§ Inserting OLE objects 

§ Editing OLE objects

§ Editing links to OLE objects

§ Changing position and size of OLE objects

§ Changing OLE object properties via the ribbon tab

§ Changing OLE object properties via the dialog box

§ Using the SoftMaker Equation Editor

See the following pages for more information.

Inserting OLE objects

Note: The use of OLE objects is only possible with the Windows version of TextMaker.

By choosing the ribbon command Insert | OLE object frame  (click directly on the icon itself), you can
embed an object that you have created with another application into a TextMaker document. After embedding
such an object, you can still edit it with the application that you originally used to create it.
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The command opens a dialog box with a list of all applications that can provide OLE objects. The entries which
are displayed here depend on the OLE-enabled programs that are installed on your system.

If you select "Paintbrush Picture", for example, a window from Window’s Paint program (called Paintbrush in
some versions of Windows) will open. Create a picture in it and then exit Paint. The picture is now embedded
in your document. It can be edited again at any time – simply double-click on the picture in the document.

To insert an OLE object into a document, proceed as follows:

1. Position the text cursor where you want to insert the object in the document.

2. Choose the ribbon command Insert | group Objects | OLE object frame . To do so, click directly on the
icon itself.

3. A dialog box appears. From the list Object Type, select the source application from which you want
TextMaker to receive the OLE object.

4. When you confirm with OK, TextMaker will start the application that corresponds to the selected object
type.

5. Create the object in the application.

6. Exit the application.

7. The application may now ask if you want to update the object in the TextMaker document. Confirm this
with "Yes".

The OLE object created in the other application is now created in the TextMaker document as an OLE object
frame.

Tip: If you click on the icon's arrow under Insert | OLE object frame instead of on the icon itself, you will
find a small selection of useful applications for quick access: PlanMaker worksheet object, PlanMaker chart
object and Presentations object. For other applications, select More to access the dialog box described
above.

Converting OLE object frame into an OLE object (without frame)

OLE objects are automatically inserted in TextMaker as fixed OLE object frames on the page. To convert the
OLE object frame into an OLE object included in the body text without a frame, proceed as follows:

Select the object after inserting it and choose the command Convert on the ribbon tab OLE object (in the
group Objects) or select the entry Convert to embedded object via the context menu.

To differentiate: An OLE object inserted into the text without a frame is treated by TextMaker as if it were a
letter in the middle of the text. Thus, it is integrated into the body text. In contrast, OLE object frames are
anchored at fixed positions on the page by default – thus they do not change their position when you insert or
delete text above the picture. Of course, you can also move OLE object frames at any time. For more
information, see Changing position and size of OLE objects.

Creating an OLE object from a file

If you don't want to create a new OLE object, but want to embed an existing file from another application as an
OLE object, you still choose the ribbon command Insert | OLE object frame, but you select the option Create
from File in this case.
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The appearance of the dialog box changes: Instead of the list Object Type, the File input field is displayed.
Here, enter the full file name or click on the Browse button to open a dialog box that will enable you to search
your hard disk for the file.

If you specify a file and confirm with OK, the file will be inserted as an OLE object.

In doing so, Windows checks the file name extension to see if it is associated with a program that can be started
and it responds accordingly. If the file name extension is not registered, only an icon will appear for the
embedded file. If, on the other hand, Windows can associate the name extension with an OLE-enabled program,
the content of the embedded file will be displayed.

Creating a link to the original file

For the option Create from File in the aforementioned dialog box, you can also select whether the file to be
inserted should be embedded or linked. If you leave the option Link disabled, TextMaker will insert a copy of
the file into the document as an OLE object and save this copy in the document – thus the object will be
embedded in the usual way.

If, on the other hand, you enable the option Link, TextMaker will insert the OLE object in the form of a link to
the original file. This does not change anything in terms of use. If you subsequently change the original file of
the OLE object with another program and reopen the TextMaker document, however, the OLE object will have
also changed accordingly – the OLE object will thus be linked to the original file.

Editing OLE objects
Existing OLE objects can be edited as follows:

Select the OLE object and click on the OLE object icon  on the contextual ribbon tab OLE object. Select
Edit from the dropdown menu.

Tip: Alternatively, simply double-click on the OLE object to edit it. The object will be opened immediately
in the associated application, where it can be edited.

Another alternative: You can also use the context menu to edit an OLE object. Proceed as follows:

1. Click on the OLE object to select it.

2. Right-click on the OLE object to open the context menu and select the menu item with the object name (for
example, Bitmap object). Selecting this menu item opens a submenu containing all OLE commands that are
available for this object. There is a command Edit for editing the object. Choose this command.

3. The source application associated with the OLE object will now start. Make the desired changes.

To return to TextMaker, simply exit the object's source application. When exiting some applications, you will
be asked if you want to update the object in the TextMaker document. Answer "Yes" – your changes will be
discarded otherwise.
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Editing links to OLE objects
If you have created an OLE object from a file and enabled the option Link, you can edit this link to the source
file. To do so, right-click on the OLE object to open the context menu and choose the command Link.

Alternatively, simply click on the Edit link icon  on the contextual ribbon tab OLE object.

The program will display a dialog box which lists all links in the current document. When you select a link, the
file name and type of the associated source file are displayed in the lower part of the dialog box.

The buttons of the dialog box allow you to perform the following actions:

Button Function

Update now This button updates the OLE object. Use this button if the source file has been changed by
another program and the changes are not visible in the TextMaker document.

Open source This button starts the application associated with the OLE object and lets you edit the object in
it. Tip: Double-clicking on the object has the same effect.

Change source This button lets you select a different file as the source for the OLE object.

Break link/
Remove

This severs the link to the source file. The object is then embedded permanently in the
TextMaker document. Changes to the source file no longer have any effect on the document.
However, the object can still be edited by double-clicking on it.

Update:
Automatic or
Manual

If you have selected the option Automatic, changes that you make to the source file using the
Open Source button are always updated automatically for the OLE object. If Manual is
selected, changes to the source file are not updated for the OLE object until you click on the
Update Now button.

Changing position and size of OLE objects
The position of an OLE object can be changed via either of the following two methods:

§ Cut and Paste 

You can cut and paste embedded OLE objects exactly like sections of text: Select the object and cut it using
the ribbon command Home | Cut. Then set the text cursor to the desired target position and paste the object
there using the ribbon command Home | Paste.

§ Using the mouse

Alternatively, you can use the mouse to move an embedded OLE object: Select the object with a (single!)
mouse click and drag it to the desired target position (with the mouse button still held down).

The size of an OLE object can be changed via the following methods:
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§ Dragging the handles on the selection frame 

Click on the object to select it. The object will then be surrounded by a blue selection frame which also
contains some round "handles". When you drag one of these handles with the mouse, the size of the object is
changed accordingly.

§ Using the dialog box 

You can also resize an OLE object via the dialog box. Right-click on the object to open the context menu
and select the entry OLE object properties. On the Format tab, these settings can be specified exactly in
numeric values. For more information on this dialog box, see Object properties, Format tab.

§ Via the ribbon tab 

If you have selected the OLE object, you will also find input fields for the Width and Height of the object
in the group Resize on the far right of the contextual ribbon tab OLE object. Type the desired values here or
increase/reduce the values with the small arrow keys next to the input field.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

If the option Keep scaling is enabled, changes to the size of an OLE object within its source application will
automatically affect the object in TextMaker. If it is disabled, the object will always remain the same size in
TextMaker. (Note: Not all OLE source applications support this feature.)

Changing OLE object properties via the ribbon tab
Numerous properties of OLE objects can be changed directly via the buttons of the contextual ribbon tab OLE
object.

The contextual ribbon tab "OLE object", left section

The contextual ribbon tab "OLE object", right section

This ribbon tab appears automatically when you select an OLE object. It contains the following buttons (from
left to right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 



294OLE objects

§ OLE object: You can Edit, Open or permanently Convert the selected object here.

§ Edit link: If you have created an OLE object from a file and enabled the option Link, you can edit this link to
the source file. For more information, see Editing links to OLE objects.

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the object. Drag these handles with the mouse to crop the object accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the object. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the object – for example, other color
modes (grayscale, black/white, etc.) and variations where the object was colored. For more information, see
also the next section ("Picture tab").

§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab. However, this
function is not supported by all OLE applications. 

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Text wrapping: This option determines how the body text that surrounds the object should behave. For more
information, see Object properties, Layout tab.

§ Bring to front, Send to back: These options arrange the order of overlapping object frames. For more
information, see Changing the order of frames.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing frames.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping frames. 

§ Duplicate: This option creates an immediate copy of the selected object.

§ Convert: This option converts an object frame into an object included in the body text and vice versa.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of OLE objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.
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Changing OLE object properties via the dialog box
The properties of an object can be edited centrally using the Object properties dialog box. An object's
properties include, for example, its size, margins and numerous other settings options.

To edit the properties of an OLE object, first click on it to select it. Then open the dialog box by clicking on the
group arrow  in the bottom right corner of any command group on the contextual ribbon tab OLE object.

Alternatively: Right-click on the OLE object to open the context menu and select the entry OLE object
properties.

The following settings can be made in this dialog box:

Layout, Format, Fill tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Layout: On this tab, you can set the wrap margins of the OLE object. In the case of frames, you can also
change the position and the text wrapping of the object. For more information, see Object properties, Layout
tab. 

§ Format: You can change the size of the OLE object here. For more information, see Object properties,
Format tab.

§ Fill: This option allows you to change the fill. However, this function is not supported by all OLE
applications. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the object. For more information,
see Object properties, AutoShapes tab.

In the case of OLE objects, there is an additional tab with further options:

Picture tab

On the Picture tab, you can make settings that affect the graphical representation of the OLE object.

Note: Depending on the type of OLE object, some of these options may not have a function.

Available options:
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§ Variants 

This list offers some predefined variations – for example, different color modes (grayscale, black & white,
etc.) as well as colored variants of the object.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma (an alternative way to change brightness).

§ More button 

This button opens a dialog box with additional settings:

If you enable the option Mix with color and select a color below it, the object will be colored accordingly.

The options in the Cropping section can be used to crop the object. This is useful if you only need a section
of the object. If, for example, you want the upper quarter of the object to be truncated, first select Use
relative values and enter "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the object will not be truncated, but will be extended
with a frame instead.

Using the SoftMaker Equation Editor

Note: The SoftMaker Equation Editor is available only for Windows and is not included in all versions of
TextMaker.

The SoftMaker Equation Editor allows you to graphically display mathematical and technical equations.

TextMaker communicates with the Equation Editor via OLE, as described in the previous sections. In order to
add a graphical representation of an equation to your document, insert an OLE object that uses the Equation
Editor as the source application.

To do so, proceed as follows:

1. Move the text cursor to the desired position in the document.

2. In TextMaker, choose the ribbon command Insert | OLE object frame. To do so, click directly on the icon
itself.

3. In the list Object Type of the dialog box, select SoftMaker Equation Editor.

4. Confirm with OK to start the Equation Editor.

Tip: You can insert an equation even faster via the ribbon command Insert | Equation .

5. Create the desired equation.

6. When the equation is complete, simply exit the Equation Editor.
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The equation is now embedded in the TextMaker document as an OLE object.

You can subsequently edit objects created with the Equation Editor at any time by double-clicking on them.
The Equation Editor is then restarted and opens the equation. Make the desired changes and then simply exit
the Equation Editor again.

You can also change the properties of the Equation Editor object by right-clicking on the Equation Editor
object, opening the context menu, and choosing the command OLE object properties.

Information from the creators of the Equation Editor

The SoftMaker Equation Editor is a special version of the MathType program from Maths for More (WIRIS). If you frequently use equations in your
documents, you might find that MathType itself is even better suited to your needs than the SoftMaker Equation Editor.
While just as easy to use as the Equation Editor, MathType has a number of additional functions that can help you to become more productive and create
more complex equations.

MathType is available in English, German and other languages. For information about how to purchase MathType, contact your software vendor or
WIRIS directly.

Maths for More, S.L.
Calle Roger de Flor, 223
08025 Barcelona
Spain

Phone WIRIS Europe: +34 932 804 805

Phone WIRIS America: +1 562 432 2920

E-Mail: sales@wiris.com

Website: www.wiris.com
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Frames and drawings
In the previous chapters, you learned how to insert pictures and other objects directly into the body text.
Otherwise, pictures and other objects can also be inserted in the form of frames.

The difference:

Frames occupy fixed positions on the page by default. Of course, you can move a frame at any time; but unless
you do so deliberately, it will retain its fixed position on the page. This means that a frame does not move if you
add or delete text above it.

Thus frames are useful in all documents in which, for example, a text box or a picture should always remain at
a specific position on the page.

Incidentally, a frame may easily be inserted over existing body text. The text is then automatically rewrapped so
that it "flows around" the frame.

In this chapter, you will learn everything you need to know about the general use of frames and drawings:

§ Frames – basic functions 

Here, you will learn about basic functions such as inserting, selecting and editing frames and other objects.
You will also learn about more unusual options, such as how to hide objects, group them, etc. The other
settings that you will find in the dialog box Object properties will also be explained in a separate section.

There will then be a detailed presentation of the individual types of frames:

§ Text frames contain a text box with text. 

§ Picture frames contain a picture.

§ Drawings are frames that contain drawing objects such as lines, rectangles or other shapes.
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§ Forms (see Form objects in detail)

§ QR codes/barcodes are codes that are generated for scanning and are inserted as picture frames.

§ Chart frames and OLE object frames are not listed separately in this chapter because TextMaker inserts
these objects as frames by default when creating them. They are already described in Charts and OLE
objects based on frames. Of course, the general descriptions of frames in the following sections also apply to
these objects.

Frames – basic functions
In this section, you will find basic functions for working with frames, drawings and other objects:

§ Inserting frames 

§ Selecting objects

§ Object mode

§ Changing the position, size and margins of objects

§ Rotating and flipping objects

§ Changing the order of frames

§ Duplicating objects

§ Changing the names of objects

Other, less frequently used functions for working with frames, drawings and other objects will be covered in the
following sections:

§ Converting between frame and embedded object 

§ Aligning and distributing frames

§ Grouping frames

§ Hiding objects

§ Changing the AutoShape of frames

§ Combining shapes

§ Editing shapes retroactively

The options of the dialog box Object properties will then be explained:

§ Changing object properties via the dialog box 
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Inserting frames

As you learned in the introduction to this chapter, pictures and other objects can be inserted both directly into
the body text as well as in the form of frames. Thus, you can also use picture frames, for example, in addition to
pictures.

The difference:

A frame occupies a fixed position on the page. As long as you don't deliberately move it, it will always remain
in its fixed position on the page. A frame does not move even if you enter or delete text above it.

To insert a picture frame, for example, perform the following steps:

1. On the ribbon tab Insert | group Objects | Picture , click on the arrow of the icon. In the dropdown
menu, enable the checkbox Insert as frame.

2. A dialog box appears. Select the desired picture file and confirm with OK.

3. The picture frame is now inserted.

You can then move or resize the frame:

To move it, click on the picture frame with the mouse, and then drag it (while still holding down the mouse
button) to the desired position.

To adjust its size, drag one of the round handles surrounding the frame.

The process for inserting other types of frames is similar.

Note: As soon as you have inserted an object, an additional contextual ribbon tab Object (or picture, chart,
etc.) will appear on the far right and will enable you to conveniently edit the object properties via the
corresponding buttons.

For more information on the different types of frames and how to adjust their properties, see Text frames,
Picture frames, etc.

Selecting objects

If you want to edit an object, you must first select it. For most types of objects, it is sufficient to simply click on
the desired object. A frame will then appear around the object to indicate that it is now selected.

Note: This does not work with text fields, text frames and other objects that have transparent fills. To select
such an object, click on its border or switch to object mode (see next section), where all types of objects can
be easily selected by clicking on them.

Once an object has been selected, you can no longer change the normal text, but only edit the selected object. If
you want to continue working on the text, simply click with the mouse on the desired position in the text. This
will deselect the object.
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Object mode

Object mode provides the easiest way to work with frames, drawings and all other objects.

Normally, you work with TextMaker in edit mode. In this mode, text can be entered, edited, formated, etc.

If you switch to object mode, you will no longer be able to edit the text. However, this mode offers many
functions that make working with objects easier. In object mode, for example, you can select all types of
objects with a click of the mouse.

Note: As long as you are in object mode, you only have functions for creating and editing objects. You can
no longer enter text, and most of the commands are unavailable.

Switching between edit mode and object mode

There are several ways to switch between edit mode and object mode:

§ Choose the ribbon command View | Object mode  to access object mode. Choose the command again to
return to edit mode. 

§ Click on the icon  in the Quick access toolbar to switch between edit and object mode.

§ You can also right-click anywhere in the document. This will open a context menu in which you can choose
the command Object mode or Exit object mode.

§ The quickest method is to hover over any free position within the document and double-click on it with the
right mouse button to switch between edit and object mode.

§ You can also return to edit mode from object mode at any time by double-clicking anywhere in the text
where no object is located.

Selecting objects in object mode

In object mode, you can select any type of object simply by clicking on it with the mouse.

This is especially useful for objects with transparent fills (for example, text frames) because such objects can
only be selected in edit mode by a targeted mouse click on the margin of the object. In object mode, however,
you can simply click on such objects anywhere to select them.

In the case of frames or drawings, you can also select several objects at once. To do so, drag a frame around the
desired objects with the mouse. Alternatively, you can click successively on several objects while holding down
the Shift keyñ to select them together.

Tip: Use the ribbon command Home | Select all  to select all objects.

Jumping from object to object

In object mode, you can also "jump back and forth" between objects using the following buttons:
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Key Function

Tab Select next object

Shift+Tab Select previous object

Changing the position, size and margins of objects

On the following pages, you will learn how to change the position, size and wrap margins of objects.

Changing the position of objects

Objects can be moved as desired. Simply click on the object to select it, and then proceed using one of the
following methods:

§ With the mouse: While holding down the mouse button, drag the selected object to the desired position. 

You will also find such a handle  on frames and drawings for moving the object with the mouse. This
makes it easier for you to handle small objects.

§ With the keyboard: For frames and drawings, you can alternatively use the arrow keys to move the
currently selected object. 

§ Via the dialog box: For frames and drawings, right-click on the object to open the context menu and select
the last entry Properties. In the dialog box, switch to the Layout tab. You can specify the exact position
there.

Tip: This tab also gives you access to a number of advanced options: You can set the position of the frame relative to the page
margin, for example. For more information, see Object properties, Layout tab.

Note: The "anchor" of an object determines on which page it is displayed

Note: This section applies only to frames and drawings.

When you insert a frame or drawing, you will notice that an anchor is displayed to the left of the paragraph:

The anchor for the selected object is displayed at the top left.

An object's anchor determines the page on which the object is displayed. More specifically:
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Important: A frame or drawing that is anchored to a paragraph always appears on the page on which the
corresponding paragraph is located.

If you insert so much text above this paragraph that the paragraph ends up on the next page, the anchored object
will also move to the next page.

An object's anchor can be moved at any time. To do so, select the object and then drag the anchor to another
paragraph while holding down the mouse button.

Setting an anchor on a fixed page

You can also disable the aforementioned behavior for any object to ensure that the object will always remain on
a specific page:

Select the object, right-click on it to access the context menu and then select the last entry Properties to open
the dialog box. Switch to the Layout tab and set the option Object to Fix on page. Then enter the number of
the page on which you want the object to appear.

The object is then no longer anchored to a paragraph and will always remain on the specified page. When you
select the object, an anchor will no longer appear to the left of a paragraph because a non-movable anchor will
appear in the upper left corner of the page instead.

For information on what the other anchor options in this dialog box mean, see Object properties, Layout tab.

Changing the size and margins of objects

You can change the size and margins of objects via the following methods:

Dragging the handles on the selection frame

§ Click on the object to select it. The object will then be surrounded by a blue selection frame which also
contains some round "handles". When you drag one of these handles with the mouse, the size of the object is
changed accordingly. 

§ In the case of frames and drawings, you can also change the wrap margins:

The inside (solid) lines of the selection frame represent the object's size.
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The outside (dashed) lines represent the object's wrap margins. If you drag one of these lines, the
corresponding wrap margin will be enlarged or reduced.

Via the dialog box

You can also resize objects via the dialog box. To do so, right-click on the object to open the context menu and
select the last entry Properties. On the Format tab, these settings can be specified exactly in numeric values.
For more information on this dialog box, see Object properties, Format tab.

Via the ribbon tab

If you have selected an object, you will also find input fields for the Width and Height in the group Resize on
the far right of the object-specific ribbon tab. Type the desired values here or increase/reduce the values with
the small arrow keys next to the input field.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on width
(and vice versa).

For OLE objects, an additional option named Keep scaling is available. If it is enabled, any changes made to
the object's size within its source application will automatically affect the object in TextMaker. If it is disabled,
the object will always remain the same size in TextMaker. (Note: Not all OLE source applications support this
feature.)

Preventing changes in an object's position and size

By locking an object, you can prevent it from being moved or resized with the mouse or the arrow keys on the
keyboard.

Select the object, right-click on it to access the context menu and then select the last entry Properties to open
the dialog box. On the Properties tab, enable the option Locked.

Now the object can no longer be moved with the mouse, and it cannot be resized by dragging its boundary lines.
The object also cannot be moved with the arrow keys of the keyboard. The position and size can only be
changed by entering values in the dialog box.

If you disable the option Locked again, the position and size of the object can also be changed with the mouse.

Rotating and flipping objects

Note: Only drawings and pictures can be rotated and flipped; this is not possible for other types of objects.

When you select an object that can be rotated, an additional green handle will appear on one of its borders. If
you drag this handle with the mouse, the object will rotate.

Tip: If you hold down the Shift keyñ, the rotation occurs at exactly 22.5° angles.
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Furthermore, there are the following ways in which you can also flip (mirror) drawings and pictures in addition
to rotating them:

§ You can use the Rotate object button  on the object-specific ribbon tab. 

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

§ You can do so via the context menu (right-click on the object) by selecting the entry Rotate or flip.

§ You can also set the desired rotation angle manually in the dialog box. Right-click on the object to open the
context menu and select the last entry Properties. In the dialog box, switch to the Format tab and enter the
angle in the Rotation section. In the Flip section, you can flip the object vertically or horizontally.

Changing the order of frames

If several frames/drawings overlap, you can change the display order of these objects (which object is in the
foreground, which is in the background, etc.).

To do so, proceed as follows:

1. Right-click on the desired object.

2. Choose the command Order from the context menu. The program opens a submenu with the following
commands:

Bring to front: This option brings the object in front of all other objects.

Send to back: This option sends the object behind all other objects.

Bring forward one level: This option brings the object forward by one level.

Send backward one level: This option sends the object back by one level.

Tip: You can also execute these commands on the object-specific ribbon tab on the far right via the Bring to
front and Send to back buttons (in the group Position).
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Duplicating objects

To obtain a duplicate of an object, you can copy it to the clipboard in the usual way and then paste it back from
there.

Alternatively, you can also use the Duplicate button  on the object-specific ribbon tab. This command
immediately creates a copy of the selected object.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

Tip: Duplicating an object is even faster with the mouse: If you drag an object while holding down the Ctrl
key, you immediately obtain a duplicate of that object.

Changing the names of objects

Every object in a document must have a unique name. This is necessary so that you can, for example, perform
calculations on the contents of table cells or text fields.

Normally, you do not have to worry about these names as they are automatically assigned by TextMaker: If you
insert a rectangle into an empty document, it is automatically called "Rectangle1". If you insert a picture, it is
called "Picture1", the next picture is called "Picture2", etc.

Tip: The name of the currently selected object is displayed on the left in the status bar.

However, you can change the names of objects at any time. If, for example, you have created a Form that
contains a text field for entering the place of residence, you would naturally name this field "Place of
residence". To do so, right-click on the text field to access the context menu and select the last entry Properties
to open the dialog box. Switch to the Properties tab and change the entry in the Name field.

Remember that names must be unique. If you attempt to assign a name to an object that is already in use for
another object, TextMaker will reject it and display an error message.

The purpose of names

Why is it necessary to assign unique names to objects?

First and foremost, these names are necessary for performing calculations on the contents of objects. For
example, to multiply the contents of cell C3 in a table called "Table1" by two, you can insert the following
calculation:  Table1.C3 * 2

For more information on calculations with objects, see Objects in calculations.
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Converting between frame and embedded object

You can convert a frame (for example, a picture frame) into an object that is embedded in the text (for example,
a picture) at any time.

To do so, proceed as follows:

1. Select the desired object.

2. Right-click on the object to open its context menu.

3. In the context menu, choose the command Convert to embedded object.

The picture frame is now converted into an "ordinary" picture that is embedded in the text.

Of course, the reverse way is also possible: If you select an embedded object (for example, a picture) and
choose the command Convert to object frame in the context menu, the picture will become a picture frame.

Tip: With the Convert button (in the group Objects) on the object-specific ribbon tab, you can also convert
a frame into an embedded object and vice versa.

For a clear description of how a frame differs from an embedded object, see Frames and drawings.

Aligning and distributing frames

To align or evenly distribute two or more frames/drawings, select them and click on the Align objects button

 on the object-specific ribbon tab.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

In the displayed dropdown menu of Align objects, select the desired alignment or distribution:

§ Align left: This option aligns objects to the left edge of the object placed furthest left. 

§ Align center: This option aligns the objects horizontally centered to each other.

§ Align right: This option aligns the objects to the right edge of the object placed furthest right.

§ Align top: This option aligns the objects to the top edge of the top object.

§ Align middle: This option aligns the objects vertically centered to each other.

§ Align bottom: This option aligns the objects to the bottom edge of the bottom object.

§ Distribute horizontally: This option distributes objects evenly between the left edge of the object furthest
left and the right edge of the object furthest right.
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§ Distribute vertically: This option distributes objects evenly between the top edge of the top object and the
bottom edge of the bottom object.

The last two commands only work if at least three objects are selected.

Tip: You will also find the commands for aligning and distributing objects in the context menu by right-
clicking on the selected objects and selecting the entry Align or distribute.

Grouping frames

When you group several frames or drawings, you combine them into a unit that can be selected and treated like
a single object.

In practice, this means the following:

If you click on an object that belongs to a group, the entire group is selected. You can then move the group, and
all objects of the group will also be moved.

Once the group is selected, clicking subsequently on a single object of the group will enable you to edit that
object separately. It can then be moved, rotated, enlarged/reduced, provided with text or even deleted within the
grouping.

To group objects, proceed as follows:

1. Select the frames or drawings to be grouped. To do so, click on the objects successively while holding down
the Shift keyñ.

Alternatively: Switch to Object mode  and drag a rectangle around all objects to be selected while
holding down the mouse button.

2. Click on the Group icon  (in the Objects group) on the object-specific ribbon tab. Alternatively: Right-
click on the selected objects and choose Group in the context menu.

Ungrouping objects

To ungroup objects, proceed as follows:

1. Select the group by clicking (once) on one of the objects in it.

2. Click on the Group icon  again or choose the command Ungroup via the context menu.

Hiding objects

If necessary, you can hide an object so that it will not appear on the screen and/or on a printout.

Select the desired object and right-click to open the context menu. Select the last entry Properties to open the
dialog box, switch to the Properties tab and proceed as follows:
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§ If you disable the option Visible, the object will no longer be displayed on the screen. 

§ If you disable the option Printable, the object will no longer appear in the printout.

Tip: Show hidden objects anyway

If you have inadvertently made an object invisible, you can always choose the ribbon command File |
Properties and enable the option Show invisible objects on the View tab. Now all hidden objects are
displayed again. Thus, you can now select the object and enable the option Visible to make it visible again.

Changing the AutoShape of frames

Frames and drawings can be replaced afterwards with another shape using the ribbon command Change

AutoShape , while retaining the existing formatting.

Tip: For more options for changing the shape of frames and drawings, see Combining shapes and Editing
shapes retroactively.

Replacing the shape of drawings and text frames

To replace the shape of drawings (AutoShapes, lines, curves, TextArt objects) or text frames with another
shape, proceed as follows:

1. Select the desired object.

2. Click on the Change AutoShape button  on the contextual ribbon tab Object | group Edit.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the last entry
Properties. In the dialog box, switch to the "AutoShapes" tab.

3. Select the desired new shape in the list.

The contours of the object will then change to the selected shape.

Replacing the shape of picture frames

To replace the shape of picture frames with another shape, proceed as follows:

1. Select the desired object.

2. Click on the small arrow of the Cropping icon  on the contextual ribbon tab Picture | group Size and
select the entry Change shape in the dropdown menu that appears.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the entry
Change shape there.

3. Select the desired new shape from the list.

The contours of the picture frame will then change to the selected shape.
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Tip: The command Photo frame  on the contextual ribbon tab Picture | group Format provides another
method of changing the shape of picture frames. Here you can choose from different variants. Some of these

variants display handles  that enable you to further adjust certain parameters of the shape by dragging them.
You can also use the small square  in the center to display the shadow with a varying offset.

Combining shapes

Note: This function is only available for drawings and text frames; it is not possible for other types of
objects.

In TextMaker, you can combine two or more shapes into one overall shape using the command Combine

objects , and different variants of the merge can be selected. This allows you to quickly create individual
drawing objects.

Important: The new overall shape always assumes the formatting of the first selected object.

Proceed as follows:

1. Select two or more objects (drawings/text frames) that you want to combine.

To do so, click on the objects successively while holding down the Shift keyñ.

Alternatively: Switch to Object mode  and drag a rectangle around all objects to be selected while
holding down the mouse button.

2. Choose the command Combine objects  (in the group Edit) on the contextual ribbon tab Object.

Alternatively, you will find the command in the context menu after right-clicking on the selected objects.

3. In the dropdown menu, select the desired variant for combining the objects (see below).

Variants of the command "Combine objects"

As mentioned at the start, the first selected object is the reference object whose formatting will be applied to the
new overall shape when each variant of the command Combine objects is chosen. This is the fill color, for
example, in the following illustrations.

The following variants are available:

§ Union 

This option creates a new common shape with a consistent outer contour of all selected shapes:
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§ Combine 

The non-overlapping parts of the shapes are preserved, while the overlapping areas become transparent:

§ Fragment 

New separate shapes are formed along the intersecting lines of overlapping shapes. These can then be moved
individually – as shown on the far right in the following figure:

§ Intersect 

This is the counterpart to Combine. Only the overlapping area is preserved, and the non-overlapping areas
disappear:

§ Subtract 

The overlapping areas are removed from the first selected shape, and the following selected shapes
themselves disappear:

You can move the new shape like a "normal" object, resize it, add text to it, etc. There are also black corners or
vertices that allow you to customize the contours of the shape. For more information, see the next section
Editing shapes retroactively).
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Editing shapes retroactively

There are several methods of retroactively adjusting the shape of objects:

§ Frames and drawings can be given a different AutoShape via the command Change AutoShape  (in the
group Edit). For more information, see Changing the AutoShape of frames. 

§ You can also use the command Combine objects  (in the group Edit) to combine two or more shapes
into one overall shape. For more information, see Combining shapes.

§ Additional handles  are displayed for some types of AutoShapes. If you drag one of these handles, a
parameter controlling the shape of the object is changed. For stars, for example, the length of the points can
be changed, and for rounded rectangles, the rounding of the corners can be changed.

For picture frames whose shape has been changed via the ribbon command Photo frame  (in the group
Format), these handles also appear for some variants.

In this section, the command Edit points  is used to describe a very individual method of customizing the
shape of certain objects (drawings, text frames or picture frames) to your liking – by editing points of the object
via the "Bezier tools". Technically, you use this command to convert an AutoShape into a curve.

To do so, proceed as follows:

1. Select the object and choose the command Edit points  on the contextual ribbon tab Object | group Edit.

Tip: For picture frames, you will find the command only via the context menu (right-click on the object).

After switching to "Bezier Mode" via the command Edit points, you will see small black corners or vertices
on the object's contour line (Note: Bezier mode remains constantly for the object once enabled).

2. Drag the black points via the mouse to change the shape.

3. Optional: For shapes with curves, a blue line (tangent) with a small square (handle) also appears when you
left-click on one of the black points. Use the mouse to take hold of the blue square in order to change the
angle of inclination and length of the curve. See also the next section "Other options via the context menu".

Note: If you ensure that you are positioned exactly on the points (or the line segments, see below) with the
mouse, the mouse cursor will then change to crosshairs .

Other options via the context menu

You will find additional editing options in the context menu by right-clicking on one of the small black points
or on a line segment of the object.

For points, you can choose between the following options in the context menu:

§ Auto point 

The angle and length of the tangent are set to a default value for automatic smoothing. No tangent for
adjusting the angle and length appears accordingly for this option.
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§ Straight point

A blue tangent appears. Both tangent halves are firmly connected, by angle and length. If one handle is
moved, the other handle changes analogously in terms of angle and length.

§ Smooth point

A blue tangent appears. Only the angle of the two tangent halves is connected, but not the length. If one
handle is moved, the other handle changes analogously in terms of angle. The length (and thus the gradient
of the curve) can be set independently.

§ Corner point

A blue tangent appears. Both tangent halves can be moved independently, both by angle and length.

§ Delete point

This option removes the selected point from the contour line.

For line segments, the context menu provides the following options:

§ Straight segment

The selected line segment between two points is straightened.

§ Curved segment

The selected line segment between two points becomes a curved line.

§ Add point

This option adds another editing point to the selected line segment.

§ Open curve/Close curve

You use Open curve to remove the line segment between two points. The option Close curve closes an
open shape and inserts a new line segment between the open ends.

The entry Curve properties opens a dialog box where you can edit the properties of the created shape (fill, line
color, etc.) as with any other object. For more information, see Changing object properties via the dialog box.
Many of these options can also be found directly on the contextual ribbon tab Object (or Picture).
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Changing object properties via the dialog box

The properties of an object include, for example, its size, borders, etc. These properties can be edited centrally
using the dialog box Object properties.

Note: Many object properties can also be conveniently edited directly via the icons of the contextual ribbon tab
Object (or Picture, Chart, etc.). Information about these ribbon tabs can be found in the respective section of
the corresponding object. However, some other options can only be set via the dialog box.

To change the properties of an object via the dialog box, right-click on the object frame to open the context
menu and select the last entry Properties. A corresponding dialog box appears.

Tip: For most types of objects, double-clicking on the object provides a quick alternative way to open this
dialog box.

The dialog box has several tabs that you can switch between by clicking on one of the tab headers at the top.

You will find detailed information on each tab and the options it contains on the following pages.

Object properties, Layout tab

On the Layout tab, you can set the wrap margins of the object. For objects inserted as a frame, the position and
text wrapping of the object can also be changed.

Available options:

"Horizontal position" section (only available for objects inserted as a frame)

Note: You can only change the position of objects inserted directly into the text (i.e. not inserted as a frame)
by cutting the object and pasting it elsewhere.

For objects inserted as a frame, on the other hand, you can specify here where the object should be placed.

Normally, all you have to do is enter the desired spacing from the left edge of the page via the option Offset.
Thus if you set the Offset to "2 in", the left edge of the object will appear 2 inches from the left edge of the
page.

However, the options Position and Relative to offer several other ways of setting the position. For example,
you can set the position relative to the margin. If you subsequently increase the left margin, the object will
move to the right accordingly. You can also align the object right, for example, to make it end exactly 2 inches
before the right margin.

For the horizontal position, you can choose between the following options:
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Position: With the option Position, you specify how the object is to be aligned:

Option Effect

Left The object is positioned from the left. If, for example, you set Offset to 2 in, the object will start 2 in
from the left edge of the page.

Centered Align object so that it is centered. If the offset is set to 0 in, the object is centered horizontally in the
center of the page. If the offset is 2 in, the center of the object is positioned 2 in to the right of the center
of the page, etc.

Right The object is positioned from the right. For example, the right edge of the object would end 2 inches
from the right edge of the page.

Inside The object is positioned from the left if it falls on a right-hand page (odd page number) – or from the
right if it falls on a left-hand page.*

Outside The object is positioned from the right if it falls on a right-hand page (odd page number) – or from the
left if it falls on a left-hand page.*

* These two options only behave as described above if the option Different left and right pages has been enabled with the
ribbon command Layout | Chapter. Otherwise, TextMaker treats all pages as right-hand pages.

Relative to: Use the option Relative to to specify to what the set Offset should refer:

Option Effect

Page The offset is relative to the page (more specifically: to the page edges). The page margins are not taken
into account.

Page margins The offset is relative to the page margins. If you increase or decrease the margins, the object moves
accordingly.

Paragraph The offset is relative to the position of the paragraph to which the object is anchored. The indents of
this paragraph are not taken into account.

Note: If this paragraph falls, for example, in the right column of a two-columned document, the object
anchored to this paragraph is also moved to the right column.

For information on anchors, see Changing the position of objects.

Indent This option behaves like "Paragraph", except that the paragraph's indent is taken into account.

Thus if Position is set to "Left", for example, and you increase the left indent of the paragraph by 0.5
in, the object will move to the right by 0.5 in.

Left margin, 
Right margin,
 etc.

Here, the offset is relative to the respective page margin. If, for example, you set the Offset to 0 in, the
Position to "Left" and select "Right margin" for Relative to, the left edge of the object will be
positioned exactly where the right margin starts.

Offset: Finally, you can set the desired offset via the option Offset.

Example: If Position is set to "Left", Relative to "Page margins" and Offset to 2 in, the left edge of the object
will appear 2 in from the left page margin. If this margin is 1 in wide, the left edge of the object will be 3 in
from the left page edge.
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"Vertical position" section (only available for objects inserted as a frame)

The same goes for setting the vertical positioning as for setting the horizontal positioning: You can use the
default settings and simply enter the distance from the top of the page at which you want the object to be
positioned for the option Offset.

Alternatively, you can use advanced options to specify the position:

Position: With the option Position, you specify how the object is to be aligned:

Option Effect

Top The object is positioned from the top. If the offset is 2 in, for example, the top of the object will be
positioned 2 in from the top edge of the page, top page margin, etc.

Centered The object is positioned from the center. If, for example, the offset is 0 in, the object is centered
vertically in the center of the page. If the offset is 2 in, the center of the object is positioned 2 in below
the center of the page, etc.

Bottom The object is positioned from the bottom. If the offset is 2 in, for example, the bottom of the object will
be positioned 2 in from the bottom of the page, bottom page margin, etc.

Relative to: Use the option Relative to to specify to what the set offset should refer:

Option Effect

Page The offset is relative to the page (more specifically: to the edges of the pages). The page margins are
not taken into account.

Page margins The offset is relative to the page margins. If you increase or decrease the margins, the object moves
accordingly.

Paragraph The offset is relative to the position of the paragraph to which the object is anchored.

Note: If you select this option, the object moves with the paragraph. If you insert a new line of text
above the paragraph, the object also drops down a line.

For information on anchors, see Changing the position of objects.

Top margin, 
Bottom margin,
etc.

Here, the Offset is relative to the respective page margin. If, for example, you set the Offset to 0 in, the
Position to "Top" and select "Bottom margin" for Relative to, the top of the object will be positioned
exactly where the bottom margin starts.

Offset: Finally, you can set the desired offset via the option Offset.

Example: If Position is set to "Top", Relative to to "Page margins", and Offset to 2 in, the top of the object
will be positioned 2 in below the top page margin. Thus, if the page margin is 1 in wide, the top of the object
will be 3 in from the left page margin.

"Wrap margins" section

Here, you can change the object's wrap margins.



317Frames and drawings

Tip: The wrap margins can also be changed by dragging the outer (dashed) borders of the object.

"Text wrapping" section (only available for objects inserted as a frame)

For objects inserted as a frame, you specify here how the body text surrounding the frame should behave.

Available options (from left to right):

Option Explanation

Line The body text is broken above the frame and continued below it.

Square The body text wraps around the frame in a rectangular shape. (This is the default setting.)

Contour The body text wraps as precisely as possible around the contours of the object contained in the frame
(known as "contour set").

This only works for pictures that contain transparencies and also for drawings.

Behind text The body text simply runs through the frame. It is displayed behind the frame.

In front of text The body text also runs through the frame. However, it is displayed in front of the frame.

Note: The "text wrapping" options are not available for objects whose anchors are located in a table cell.

For information on anchors, see Changing the position of objects.

"Contour" section (only available for objects inserted as a frame)

If you selected either the option Square or Contour for Text wrapping, you can specify here the side(s) of the
frame around which the text should wrap.

Available options (from left to right):

Option Explanation

Both The body text wraps around both sides of the frame.

Left It wraps only around the left side.

Right It wraps only around the right side.

Larger side It only wraps around the side of the frame where there is more space.

"Object" section (only available for objects inserted as a frame)

When you insert an object as a frame, this object automatically places an "anchor" in the text paragraph to the
left of where you insert it.

If the anchor moves because you have inserted/removed text paragraphs above the anchor, for example, the
object remains in its original position by default. If you enable the option Move with text, however, the object
moves in parallel with its anchored text paragraph.
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As soon as the anchor moves to another page, the object also lands on that page (even if the option Move with
text is disabled).  With the setting Fix on page, on the other hand, the object always remains on the page whose
page number you set here. Thus, it is anchored to the specified page rather than to a paragraph.

For more information on using anchors, see Changing the position of objects.

"When the object is moved" section (only available for objects inserted as a frame)

If you have selected the option Move with text in the Object section, you can specify how the object's anchor
should behave when you move the object:

If the default setting Move anchor to the nearest paragraph is selected, the anchor moves with the object.
Thus if you move the object, the object's original anchor is removed and a new anchor is set in the paragraph to
the left of the object's target position.

If, on the other hand, you select the option Keep anchor at current paragraph, the object's anchor always
remains attached to the paragraph to which it is currently anchored – even if you move the object.

Object properties, Format tab

You can use the Format tab to make settings with respect to the format of the object, such as resizing it.

Available options:

§ Size section 

You can resize the object here. To do so, enter the desired Width and Height.

For objects that contain text (for example, text frames), you can either specify an exact fixed width and
height or let TextMaker automatically adjust the size of the frame to accommodate the text that it contains.
To do the latter, select the option Growing for Width or Height and enter the desired minimum and
maximum values. If the option Auto is selected, the frame will always be automatically adjusted to
accommodate the text it contains.

Note on Height for text frames: Since the options Fixed (with the value to the right of it) and Growing (with the Max value to the
right of it) specify a limit, a red bar will appear at the bottom of a text frame when there is no longer enough space for the text. In
order for the red bar to be displayed, however, the option Overflow mark must also be enabled on the "View" tab of the dialog box
of the command File | Options.

§ Scaling section

Alternatively you can change an object's size by specifying the width as a percentage of the original width in
Horz. scaling and the height as a percentage of the original height in Vert. scaling.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

There is an additional option named Keep scaling for OLE objects. If this option is enabled, any changes
made to the OLE object's size within its source application will automatically affect the object in
TextMaker. If it is disabled, the object will always remain the same size in TextMaker. (Note: Not all OLE
source applications support this feature.)
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§ Rotation section 

This option is only available for drawings and pictures.

Here, you can rotate the object. To do so, enter the angle at which you want to rotate the object clockwise.

§ Flip section 

This option is only available for drawings and pictures.

Here, you can flip the object vertically or horizontally.

Object properties, Fill tab

Note: This tab is only available for certain types of objects. For pictures, changes to the fill affect only the
transparent parts of the picture.

You can use the Fill tab to specify with what the object should be filled.

First, select the desired type of fill in the dropdown list Fill type. You can then make various settings for each
fill type.

The following fill types and settings are available:

Tip: You can also apply some of these options directly on the object-specific ribbon tab via the command
Fill color in the group Format.

§ No fill 

If you select the first fill type in the list, the object is not filled and thus remains transparent.

§ Solid color

This fill type fills the object with a uniform color shade. Select the desired color in the list Colors.

Tip: Color lists only offer a few standard colors, but you can always compose your own colors. To do so,
click on More colors and then proceed as described in Document properties, Colors tab.

If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency). If, for example, you set the
transparency value to 25, the fill will have 25% transparency.

§ Pattern 

This fill type fills the object with a pattern. In the list Patterns, select the type of pattern and then set the
desired color for the foreground and background.

If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency).

§ Picture 

This fill type fills the object with a picture file. You can use the Open button to determine the picture file
which you want to use for the fill. The most recently used picture files are displayed in the list Pictures and
can be selected there by clicking on them with the mouse.
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Additional options:

Rotate with object: If you enable this option, the picture will also be rotated whenever you rotate the object
to be filled.

Mirror type: This option allows you to mirror the picture horizontally or vertically.

Transparency: If desired, you can use this option to change the transparency of the fill. You can enter any
value between 0% (no transparency) and 100% (full transparency).

Tile as texture: If this option is enabled, the picture is repeated in the object like a tile pattern.

You can then use the settings in the Tile options section to change the size and position of the tiles: X scale
and Y scale change the size (in percent), while X offset and Y offset change the position. The option
Alignment can be used to determine to which edge of the object the tiles should be aligned.

If the option Tile as texture is disabled, only Offsets (relative to the edges of the object) can be set for the
picture.

Save: You can use this button to export the currently selected picture, that is, to save a copy of it under any
name on your hard disk.

§ Linear gradient, Rectangular gradient, etc. 

The bottom five fill types are different types of color gradients. First, select the desired type of gradient in
the dropdown list Fill type and then select one of the subtypes in the list Variants.

In the Options section, you can specify the appearance of the gradient even more precisely:

X offset and Y offset enable you to move the center of the gradient. The Angle option allows you to set the
angle of rotation.

Tip: You can also change these settings by using the mouse to move or rotate the cross-hair displayed in
the Sample field.

If you enable the option Double gradient, for example, a black-white gradient will become a black-white-
black gradient.

In the Colors section, you can change the colors for the gradient as follows:

To change a color, first click on one of the small triangles below the bar representing the gradient. The left
triangle stands for the initial color, while the right triangle stands for the final color:

Then select the desired color from the dropdown list Color below.

You can use the option Transparency to change the transparency of the selected color if desired. You can
enter any value between 0% (no transparency) and 100% (full transparency).

Additional colors can be added to the gradient by double-clicking on the desired position in the bar and
selecting a color. In the same way, namely by double-clicking on the triangle, additional colors can also be
deleted from the gradient.
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Object properties, Lines tab

Note: This tab is only available for certain types of objects.

Use the Lines tab to specify the type of lines to use for the object. For drawings, this applies to the lines used to
draw the object; for all other objects, it applies to the lines that border the object.

Available options:

Tip: Many of these options can also be found directly on the object-specific ribbon tab in the command
group Format.

§ Variants 

Here, you can select the desired line style.

The entries in this list are merely default variants. If required, you can specify the appearance of the lines
more precisely via the options of the dialog box.

§ Color 

This option lets you specify the color of the lines.

§ Dashed 

Here, you can specify whether solid or dashed lines should be used.

§ Thickness 

Here, you can specify the exact thickness of the lines (in points).

§ Transparency 

If desired, you can use the option Transparency to change the transparency of the lines. You can enter any
value between 0% (no transparency) and 100% (full transparency).

§ Start point and End point 

These options are only available for lines, curves and connectors.

Here, you can specify whether an icon should be drawn at the start point or end point of the line. If, for
example, you select an arrow icon for the end point, the line will look like an arrow. If necessary, you can
also change the Width and the Height of the icon.

Object properties, Shadow tab

Note: This tab is only available for certain types of objects.

Use the Shadow tab to add a shadow to the object.

Available options:



322Frames and drawings

Tip: You can also apply many of these options directly on the object-specific ribbon tab via the command
AutoShape effects in the group Format.

§ Variants 

Here, you can select the desired type of shadow.

The entries in this list are only default variants; the other options in the dialog box allow you to specify the
appearance of the shadow even more precisely if necessary.

§ Scaling

Here, you can change the size of the shadow (relative to the size of the object).

§ Offset 

Here, you can change the position of the shadow (relative to the object).

§ Perspective 

Here, you can change the Skew angle of the shadow.

For certain variants of the "Perspective Shadows" type, the Horizon can also be changed, which distorts the
shadow in perspective. If Horizon is a positive value, the shadow is in front of the object; if it is negative,
the shadow is behind the object.

§ Color 

Here, you can change the color of the shadow.

§ Blur 

If you enter a value greater than zero here, a blur effect is added to the shadow. The larger the value, the
softer the edges of the shadow are drawn.

§ Transparency 

Here, you can change the transparency of the shadow. You can enter any value between 0% (no
transparency) and 100% (full transparency). If, for example, you set the transparency value to 25, the
shadow will have 25% transparency.

Object properties, 3D tab

Note: This tab is only available for pictures, text frames and drawings.

Use the 3D tab to add a three-dimensional effect to the object.

Select the desired type of 3D effect in the Variants section. The entries in this list are only default variants; the
other options on the 3D tab allow you to specify the appearance of the effect even more precisely if required.

In the preview field Sample, you can follow the result of your adjustments and finally confirm with OK if you
want to apply the settings.
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Object properties, Effects tab

Note: This tab is only available for certain types of objects.

On the Effects tab, you can add various effects to the object.

The following effects and options are available:

§ Reflection 

If you enable the option Use reflection effect, the object is displayed as if it was located on a reflective
surface. The following variations are possible:

Visible part of object: This option specifies how much of the object should be visible in the reflection (in
percent).

Starting transparency: The reflection is softly faded out downwards. This value determines how
transparent the reflection should be at the top (in percent).

Y offset: This option moves the reflection upwards or downwards.

§ Soft edges

If you enable the option Use soft edges effect, the borders of the object will be given a blur effect. The
following variations are possible:

Width: This option specifies the width of the blur effect.

§ Glow 

If you enable the option Use glow effect, the borders of the object will be surrounded by a glow effect. The
following variations are possible:

Width: This option specifies the width of the glow effect.

Color: This option specifies the color of the glow effect.

Object properties, Properties tab

On the Properties tab, you can change the general settings for an object.

Available options:

§ Name 

TextMaker automatically assigns a unique name to every object in a document. For example, rectangles are
called rectangle1, ...2, ...3, etc. If desired, you can enter another name here.

Tip: The name of the currently selected object is displayed on the left in the status bar.

For more information on using names for objects, see Changing the names of objects.
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§ Visible 

This option is enabled by default. It causes the object to be displayed on the screen. (For more information,
see also Hiding objects.)

If you disable this option, the object becomes invisible.

§ Printable 

This option is enabled by default. It causes the object to appear in the printout when you print the document.
(For more information, see also Hiding objects).

If you disable this option, the object will not be printed.

§ Locked 

If you enable this option, the size of the object and its position (in the case of objects inserted as a frame)
cannot be changed with the mouse or keyboard. Position and size can then only be changed by entering
values in this dialog box (Object properties, Format tab).

§ Tab stop 

This option is only available for form objects (for example, text fields and text frames, checkboxes and
dropdown lists).

In form mode, you can jump back and forth among form objects by pressing the Tab key or the F11 key.
(For more information, see also Changing the tab order).

If you disable the option Tab stop, however, this object will be skipped.

§ Text locked 

This option is only available for objects that contain text (for example, text fields and text frames).

If this option is enabled, the text contained in the object cannot be changed while the document is edited in
form mode.

However, this option is disabled by default, thus allowing the text in the object to be edited even in form
mode.

For more information, see Protecting contents of form objects.

§ Link 

This option only works for objects that are inserted as frames and not for embedded objects.

You can enter a hyperlink here – to a website, for example. To do so, click on the Select button, select the
type of link and specify the desired target. The target is opened when the user clicks on the object.

In the Bookmark field, you can also specify the target position in the document to be opened.

In the case of pictures, the File name of the picture is displayed on this tab, while some information about the
picture that was used (resolution, color depth, etc.) is displayed at the top right.

Object properties, AutoShapes tab

Note: This tab is only available for pictures, text frames and AutoShape drawings.



325Frames and drawings

On the AutoShapes tab, you can assign an AutoShape to the object. Thus you can turn a rectangle into a speech
balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.

Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon
tab Object. For more information, see Changing the AutoShape of frames.

For more information on AutoShapes, see Inserting drawings.

Additional tabs

There are additional tabs with more options for some object types. For information on these tabs, see the
section on the relevant object.

Changing the default settings for objects

You can change the default settings for objects at any time. This is particularly relevant for drawings
(AutoShapes and lines). For certain other objects, there are restrictions on applying the default settings.

If, for example, you don't like the default line thickness for drawings, simply set it to a different value. You can
also alter other default settings – for example, the default fill for drawings as well as the settings for shadows
and 3D effects.

Note: Changes to the default settings for objects only affect objects that you insert afterwards. Existing
objects remain untouched.

To change the default settings for objects, use the Set as default button in the dialog box Object properties.

For example, the default line thickness for drawings can be changed as follows:

1. Insert a new drawing (or click on an existing drawing).

2. Right-click on the object to access the context menu and select the last entry Properties to open the dialog
box.

3. Make the desired settings. To change the default setting for the line thickness, for example, switch to the
Lines tab and simply set the desired line thickness.

4. Important: Click on the Set as default button and not on OK.

5. The program displays another dialog box in which you can also limit which default settings should be
changed if necessary. As a rule, there is no need to change anything in this dialog box.

6. If you confirm with OK, the settings currently made in the dialog box will be set as the default settings for
new drawings.
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7. Confirm again with OK to exit the dialog box completely.

All drawings that you insert from now on will use the line thickness set in this way by default.

Note: The default settings for objects can be set separately for each document.

This concludes the general description of frames and drawings. The following sections present the various
types of frames in detail:

§ Text frames 

§ Picture frames

§ Drawings

§ Forms (see Form objects in detail)
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Text frames
With the help of text frames, you can insert text boxes into a document. For example, you can highlight
especially important information by placing it in such a box.

Like all types of frames, a text frame occupies a fixed position on the page. Thus it does not move when you
add or remove body text above it. The normal body text is automatically wrapped around the frame – it "flows
around" the frame.

Note: Text frames, by the way, are just AutoShapes (in this case, simple rectangles) to which text has been
added.

In this section, you will learn everything you need to know about working with text frames. The information
covers the following topics:

§ Inserting text frames 

§ Changing text frame properties via the ribbon tab

§ Changing text frame properties via the dialog box

§ Changing the text area

§ Linking text frames

See the following pages for more information.
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Inserting text frames

To insert a text frame, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Text frame .

2. The text frame is now inserted.

You can then move or resize the text frame:

Important: Click with the mouse on the border of the text frame in order to move it. While still holding the
mouse button down, drag the text frame to the desired position.

To resize the text frame, drag one of the round handles surrounding it.

The text frame is now created, and you can start entering text in it immediately.

Important: If a red bar* is displayed at the bottom margin of a text frame, this indicates that the text does
not fit completely into the frame. In this case, you must either enlarge the frame or reduce the amount of text.

* The red bar appears only if the option Overflow mark is enabled on the "View" tab of the dialog box of the command File | Options.
For Object properties on the "Format" tab, the defined limit specified by the options Fixed or Growing (Max value) for the Height must
be reached.

To move from a text frame back to the normal body text, click anywhere in the body text. Conversely, you
move from the body text back to the text frame by clicking into the frame.

Text frames are allowed to easily cover existing text – this is then automatically wrapped in such a way that it
flows around the frame.

Changing text frame properties via the ribbon tab

Numerous properties of text frames can be changed directly via the buttons of the contextual ribbon tab Object.

The contextual ribbon tab "Object", left section
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The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a text frame by clicking on its border. It contains the
following buttons (from left to right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates: This option allows you to apply various predefined color formats to the text field.

§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit borders for the text field or
the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape: This option allows you to assign a different AutoShape to the text frame (formatting is
retained). For more information, see Changing the AutoShape of frames.

§ Edit points: This option allows you to give the text frame an individual shape with the "Bezier tools". For
more information, see Editing shapes retroactively.

§ Combine objects: This option allows you to combine two or more shapes from different variants into one
overall shape. For more information, see Combining shapes.

§ Text rotation: This option allows you to rotate the inner text by the specified angle.

§ Vertical alignment: This option determines how the inner text should be aligned between the top and bottom
edges of the frame.

§ Change text area: This option allows you to adjust the size of the inner text area. For more information, see
Changing the text area.

§ Link text frames: This option allows you to run text over multiple, interconnected text frames. For more
information, see Linking text frames.

§ Text wrapping: This option determines how the body text that surrounds the object should behave. For more
information, see Object properties, Layout tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of frames.

§ Rotate object: This option is not available for text frames.
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§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing frames.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping frames.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Convert: This option converts an object frame into an object included in the body text and vice versa.

§ Width, Height: These options change the size of the object. For more information, see Changing the size and
margins of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.

Changing text frame properties via the dialog box

To edit the properties of a text frame via the dialog box, first select it. To do so, click on the border surrounding
the text frame or simply click on it in object mode (View | Object mode). Then right-click to open the context
menu and select Properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the contextual
ribbon tab Object.

Tip: If you are using object mode, you can also access this dialog box instantly by double-clicking on the
text frame.

The following settings can be made in the dialog box:

Layout, Format, Fill tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Layout: On this tab, you can change the position and wrap margins of the frame and specify how the body
text should flow around it. For more information, see Object properties, Layout tab. 

§ Format: This option allows you to resize the frame. For more information, see Object properties, Format tab.

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.
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§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

In the case of text frames, there are two additional tabs with further options:

Inner text tab

You can use this tab to change settings for the text in the text frame.

Note: An AutoShape must contain text in order to be treated as a text frame. Thus, select the AutoShape and
type something in it, and then the Inner text tab will also be available.

Available options:

§ Inner margins section 

Here, you can change the margins between the text frame and the text it contains. If you enable the option
Automatic, TextMaker will automatically determine suitable margins.

§ Overlapping objects section 

This setting determines what should happen if the text frame overlaps with another frame.

If the default setting Ignore object is enabled, TextMaker will do nothing. In the area of overlap, the
contents of both frames will thus be printed on top of each other.

If, on the other hand, you enable the option Wrap text, TextMaker will automatically wrap the text in this
frame so that it flows around the area of overlap.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the frame:

Option Explanation

Top The text is aligned to the top edge of the frame. (This is the default setting.)

Centered The text is centered between the top and bottom edges of the frame.

Bottom The text is aligned to the bottom edge of the frame.

Justified The lines of text are vertically justified and are thus evenly distributed so that the text starts exactly
at the top edge of the frame and ends exactly at the bottom edge.
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AutoShapes tab

A text frame is actually an AutoShape that has been filled with text. AutoShapes are predefined shapes (such as
rectangles, ellipses, arrows, speech bubbles, etc.).

By default, a simple rectangle is used as an AutoShape for text frames. However, you can assign a different
AutoShape to the text frame at any time. Simply select the desired shape from the AutoShapes tab.

Note: Text frames have no border lines by default. Therefore, if you select a different AutoShape here, the
shape will only be visible when you add border lines. To do so, select the desired line style on the Lines tab.

For more information on AutoShapes, see Drawings.

Changing the text area

For text frames, and also for AutoShapes to which text has been added, you can resize the text area for the inner
text in TextMaker.

To do so, proceed as follows:

1. Click on the frame of the object to select it.

2. Choose the command Change text area  on the contextual ribbon tab Object | group Inner text (or via
the context menu by right-clicking on the text frame).

Note: For drawings (AutoShapes, curves, etc.), you must first add text to the shape so that you can use the commands for the inner
text.

3. The frame of the inner text is now selected and some round navy "handles" appear. Drag one of these
handles via the mouse to resize the text area.

When your adjustments are complete, choose the command Change text area again or simply click anywhere
in the document.

Linking text frames

TextMaker allows you to run text across multiple interlinked text frames, similar to a DTP program. If two
frames are linked, text that exceeds the limits of the first frame is automatically continued in the second frame.

Let's assume that you have created two text frames on one page and that you want the text to flow from the first
to the second frame. You would link these frames as follows:

1. Click on the View | Object mode button  to enable object mode.

2. Choose the command Link text frames  on the contextual ribbon tab Object | group Inner text (or via
the context menu by right-clicking on the text frame).
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3. First click on the text frame in which you want the text to begin. Pay attention to how the two hooks on the
mouse cursor change: It is only when the hooks connect that you have selected the text frame correctly.

4. Then click on the text frame to be linked. Important: This text frame must be empty! Also pay attention to
the two hooks here.

5. Click on the View | Object mode button again to exit object mode.

If you now insert text into the first frame, it will continue in the second frame as soon as it no longer fits into
the first frame.

You can also link more than two frames together. To do so, link the first frame to the second frame, then the
second to the third, etc.

Removing the link between frames

To remove an existing link, choose the command Link text frames  again in object mode and then click on
the first of the two linked frames. TextMaker will then ask you if you want to remove the link.

Alternatively, use the context menu (right-click on the frame that was linked first) to choose the command
Unlink text frames.

Tip: To locate linked text frames more easily, right-click on one of the text frames to use the commands
Next text frame or Previous text frame in the context menu.

Picture frames
Picture frames differ from fixed pictures in the text (see Pictures) as follows:

Like all types of frames, a picture frame occupies a fixed position on the page. Thus, it does not move when you
add or remove body text above it.

In this section, you will learn everything you need to know about working with picture frames. The information
covers the following topics:

§ Inserting picture frames 

§ Changing picture frame properties via the ribbon tab

§ Changing picture frame properties via the dialog box

See the following pages for more information.
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Inserting picture frames

To insert a picture frame, proceed as follows:

1. On the ribbon tab Insert | group Objects | Picture , click on the arrow of the icon.

In the dropdown menu, enable the checkbox  Insert as frame.

2. In the dropdown menu, select From file.

Tip: You can also choose this command by clicking on the icon itself. However, you cannot enable or
disable the option Insert as frame. The last set state is automatically applied.

3. A dialog box appears. Select the desired picture file and confirm with OK.

4. The picture frame is now inserted.

You can then move or resize the frame:

To move it, click on the picture frame with the mouse, and then drag it (while still holding down the mouse
button) to the desired position.

To adjust its size, drag one of the round handles surrounding the picture frame.

A picture frame is allowed to easily cover existing text – this is then automatically wrapped in such a way that
it flows around the frame.

Tip: Picture frames can still be subsequently converted into a picture that is embedded in the body text
without a frame and vice versa using the ribbon command Convert. For more information, see Converting
between frame and embedded object.

Options of the dialog box

The options in the above dialog box mean the following:

§ Save within document 

If the option is enabled, TextMaker saves a copy of the picture in the document and uses this copy instead of
the original.

Note: If this option is enabled, the file size of the document may increase significantly.

If it is disabled, however, TextMaker saves only a reference to the original picture file in the document.
Changes to the original picture file are thus always available in an updated form in TextMaker.
Tip: You can see the location of the original picture file in the picture properties. Right-click on the picture to open the context menu, and select
Picture properties. In the dialog box, switch to the Properties tab and take a look under File name.

Note: If the file path of the picture file changes, however, it will no longer be displayed in the document.

§ Copy to document's folder 

If the option is enabled, TextMaker creates a copy of the picture file in the folder in which the document is
located and saves a reference to this copy instead of to the original.

This option is available only if the document has already been saved.
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Scanning pictures/Selecting source

By using the small arrow of the Insert | group Objects | Picture icon, you not only find the option From file,
but also the entries From scanner and Select source that let you scan originals directly into a document. For
more information, see Scanning pictures.

Inserting pictures from the gallery/camera (Android and iOS)

Note: This function is available only in the Android and iOS version.

In the Android/iOS version, you can also insert pictures as picture frames via the Gallery or Camera application
on your device.

For more information, see Inserting pictures from the gallery/camera (Android and iOS).

Compressing pictures

You can use the command Compress pictures  to reduce the memory size of images in TextMaker. For
more information, see Compressing pictures.

Changing picture frame properties via the ribbon tab

Numerous properties of picture frames can be changed directly via the buttons of the contextual ribbon tab
Picture.

The contextual ribbon tab "Picture", left section

The contextual ribbon tab "Picture", right section

This ribbon tab appears automatically when you select a picture frame. It contains the following buttons (from
left to right):
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§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the picture. Drag these handles with the mouse to crop the picture accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the picture. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the picture – for example, other color
modes (grayscale, black/white, etc.) and variations where the image was colored. For more information, see
also the next section ("Picture tab").

§ Compress pictures: Reduce the memory size of images in your document. For more information, see also
Compressing pictures.

§ Change source: Replace the picture with another one (formatting is retained).
This corresponds to the File button in the dialog box. For more information, see the next section ("Picture
tab").

§ Reset: Reset the image-specific changes made to the picture, such as brightness, shading, rotate object, etc.,
to their default values. The non-image-specific settings are not reset, for example, line thickness and photo
frame.

§ Photo frame: This option allows you to apply a photo frame effect to a picture.

§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Text wrapping: This option determines how the body text that surrounds the picture should behave. For more
information, see Object Properties, Layout tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of frames.

§ Rotate object: This option allows you to rotate a picture in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing frames.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping frames.

§ Duplicate: This option allows you to create an immediate copy of the selected picture.

§ Convert: This option converts a picture frame into a picture that is embedded in the body text and vice versa.
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§ Width, Height: These options change the size of the picture. For more information, see Changing the size and
margins of objects.

Many (but not all) of these functions and some additional options can be found in the Object properties dialog
box. You open the dialog box by double-clicking on the picture. For more information, see the next section.

Changing picture frame properties via the dialog box

To edit the properties of a picture frame via the dialog box, first select it by clicking on it. Then right-click to
open the context menu and select Picture properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the ribbon tab
Picture.

Tip: This dialog box can also be opened by double-clicking on the picture frame.

The following settings can be made in the dialog box:

Layout, Format, Fill tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Layout: On this tab, you can change the position and wrap margins of the frame and specify how the body
text should flow around it. For more information, see Object properties, Layout tab. 

§ Format: Here, you can resize the frame and rotate it. For more information, see Object properties, Format
tab.

§ Fill: This option allows you to change the fill. It is only visible for pictures with transparent areas. For more
information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply 3D effects. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. It also displays information about the picture
you are using. For more information, see Object properties, Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the picture. For more information,
see Object properties, AutoShapes tab.

In the case of pictures, there is an additional tab with further options:
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Picture tab

On the Picture tab, you can make settings that are specific to pictures.

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Picture |
group Adjust.

§ Variants 

This list offers some predefined variations of the picture – for example, different color modes (grayscale,
black & white, etc.) as well as colored variants of the image.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

Tip: You will also find these variants via the command Recolor picture directly on the contextual ribbon tab Picture.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma (an alternative way to change brightness).

§ More button 

This button opens a dialog box with additional settings:

If you enable the option Mix with color and select a color below it, the object will be colored accordingly.

The options in the Cropping section can be used to crop the picture. This is useful if you only need part of
the picture. If, for example, the upper quarter of the picture is to be truncated, first select Use relative
values and enter the number "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the picture will not be truncated, but will be extended
with a frame.

Tip: You will also find a corresponding command Cropping directly on the contextual ribbon tab Picture. For more information,
see the previous section Changing picture frame properties via the ribbon tab.

§ Transparency section 

Here, you can make settings for the transparency of the picture:

Use picture settings: TextMaker reads from the picture file which parts of the picture have been marked as
transparent and displays the picture accordingly. Note: Only pictures in GIF or PNG format contain such
transparency information.

No transparency: If this option is enabled, the picture will not be displayed transparently, even if it is a
picture file with transparency information.

Color: This option lets you select the color to be displayed transparently. If, for example, you select white,
all white areas of the picture will become transparent.

§ Sample 

In the small toolbar below the sample, you will find the option Pick transparent color (the pipette icon).
You can use it to make certain colored parts of the picture transparent, for example, to remove a distracting
background from the picture. To do so, use the pipette icon to click on an area of the thumbnail that you
want to make transparent.
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The other toolbar buttons help you to fine-tune the picture (Zoom in, Zoom out, Pan picture), but they do
not affect the appearance of the picture in the document.

Note: You must first select a tool in the toolbar by clicking on it with the mouse. You can then work on the
thumbnail with the enabled tool.

§ File button 

You can use this button to replace the picture with another one and the formatting will be retained.

Tip: This corresponds to the command Change source on the contextual ribbon tab Picture.

§ Export button 

This option is available only for pictures that are saved in the document. You can use this button to export
the picture, that is, to save a copy of it on your hard disk under any name. The dialog box "Save as" appears
for this purpose.

If you enable the option Create a link to file here, TextMaker also replaces the picture saved in the
document with a reference to the destination file. Thus, the picture is no longer saved within the document.

§  Compress picture button 

This button allows you to reduce the memory size of pictures in your document.

Tip: This corresponds to the command Compress pictures on the contextual ribbon tab Picture. For more information on this
command, see Compressing pictures.
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Drawings
TextMaker provides several tools for creating drawings. You can insert the following types of drawing objects
into your documents:

§ Lines and curves (lines, arrows, connectors, curves) 

§ AutoShapes (various types of predefined shapes)

§ TextArt objects (lettering with effects)

Drawings behave like frames: They always remain in the same place on the page, even if you delete or insert
lines of text above them. The normal body text is automatically wrapped around the drawing's border lines – it
"flows" around the drawing.

In this section, you will learn everything you need to know about working with drawings. The information
covers the following topics:

§ Inserting drawings 

§ Adding text to AutoShapes

§ Changing drawing properties via the ribbon tab

§ Changing drawing properties via the dialog box

See the following pages for more information.

Inserting drawings

To insert a drawing, for example, a rectangle, proceed as follows:

1. Choose the ribbon command Insert | group Objects | AutoShape . Select the desired AutoShape – a
rectangle in this case.

2. Hold down the left mouse button and draw a frame of the desired size in the document.

3. The rectangle is now inserted.

You can then move or resize the rectangle:

To move the rectangle, click on it and (while still holding the mouse button down) drag it to the desired
position.

To adjust its size, drag one of the round handles surrounding the rectangle.

The application of drawings differs somewhat depending on the drawing tool used. The following is a list of all
available drawing objects and information on how to handle them:

Note: You can adjust the shape of drawings retroactively at any time. For more information, see Editing
shapes retroactively.
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AutoShape

You can insert AutoShapes using the AutoShape  tool. These are predefined shapes for various purposes –
standard shapes such as rectangles, but also symbols for flowcharts, stars, speech bubbles and many more.

As soon as you have selected an AutoShape, simply drag a frame of the desired size in the document while
holding down the left mouse button. If you want, you can then move the AutoShape with the mouse or resize it
by dragging one of the round handles at its corners.

Note: Additional handles  are displayed in some types of AutoShapes when they are selected. If you drag one
of these handles, a parameter controlling the shape of the object is changed. For stars, for example, the length of
the points can be changed, and for rounded rectangles, the rounding of the corners can be changed.

Tip: You can even enter text in an AutoShape – just like you can in a text frame. For more information, see
Adding text to AutoShapes.

Lines and curves

Use the Lines tool  on the ribbon tab Insert to draw lines and curves.

When you click on this icon, a list of available line and curve tools opens. Select the desired tool and then use it
as follows:

§ Lines 

You can use the tools at the top of the list to draw simple lines and arrows. After clicking on the desired
tool, simply draw a line in the document while holding down the mouse button. Tip: If you hold down the
Shift keyñ, the line is limited to 45° angles.

Note: Arrows are nothing more than ordinary lines for which an arrowhead was selected in the object properties (Lines tab) by
selecting the option Start point and/or End point.

§ Connectors (straight, elbow and curved)

You can use these tools to drag connectors between two objects. The difference between the three types of
connectors can be seen in the following figure:

To do so, select one of these tools, and then drag the mouse cursor from one object to another while holding
down the mouse button. When you move the mouse cursor over an object, small blue rectangles will appear
at various points on the object. These show where the line can "dock" to the object. You can influence the

course of curved and angled connectors by dragging the diamond handle  via the mouse.

Tip: You can change the type of connectors retroactively at any time. Right-click on the line to open the
context menu and choose between a straight, elbow or curved connector. Also available in the context menu:
The option Create new connector causes the shortest connection between two objects.
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§ Curves 

The tools at the bottom of the list are used to draw curves:

You can use the Curve tool  to draw Bezier curves.

To do so, click on the starting point and then on any number of other positions. The curve "follows" your
mouse clicks automatically.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

You can use the Freehand form tool  to draw curves in the same manner as if you were using a pencil.

To draw freehand, move the mouse to the desired starting point, press and hold the left mouse button and
then start drawing as if using a pencil. Alternatively, you can release the mouse button and click on
another location where a straight line will be drawn.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

Note: The small black points on the contour line of curves enable you to further adjust the shape. Use the
mouse to drag such a point to another position. Further options can be found in the context menu by right-
clicking on the curve. For more information, see Editing shapes retroactively.

TextArt

You can insert TextArt objects using the TextArt object tool  on the ribbon tab Insert. TextArt objects are
used to create text effects.

If you enable this tool, a dialog box appears. Enter your text in the dialog box and then click on Variants to
select one of the predefined effects to be applied to the text. Then confirm with OK.

For information on the other options for TextArt objects, see Text tab.

Adding text to AutoShapes

You can add text to an AutoShape if desired. This text is then displayed within the AutoShape – exactly as it
would be in a text frame.

To do so, proceed as follows:

1. Select the desired AutoShape.

2. Right-click on it to open its context menu.

3. Choose the command Add text.

The cursor flashes in the AutoShape. Thus, you can now type text inside the AutoShape.

Tip: There is another faster way to add text to an AutoShape: Select the AutoShape and just start typing.

You can use the commands of the ribbon tab Home | group Character and group Paragraph to format the text
according to your needs.
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When you have finished adding text, click anywhere outside the object. If you want to edit the text again later,
select the AutoShape again and choose the command Edit text from the context menu.

Important: If a red bar* is displayed at the bottom margin of a text frame, this indicates that the text does
not fit completely into the frame. In this case, you must either enlarge the object or reduce the amount of
text.

* The red bar appears only if the option Overflow mark is enabled on the "View" tab of the dialog box of the command File | Options.
For Object properties on the "Format" tab, the defined limit specified by the options Fixed or Growing (Max value) for the Height must
be reached.

Note: By the way, the text frames presented at the beginning of this chapter are nothing more than AutoShapes
(simple rectangles in this case) to which text has been added. Thus, all information in Text frames applies
equally to AutoShapes to which text has been added.

Changing drawing properties via the ribbon tab

Numerous properties of drawings can be changed directly via the buttons of the contextual ribbon tab Object.

The contextual ribbon tab "Object", left section

The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a drawing. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates: This option allows you to apply various predefined color formats to the drawing.

§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see next section.
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§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit border lines for the drawing
or the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape: This option allows you to assign a different AutoShape to the drawing (formatting is
retained). For more information, see Changing the AutoShape of frames.

§ Edit points: This option allows you to give the drawing an individual shape with the "Bezier tools". For more
information, see Editing shapes retroactively.

§ Combine objects: This option allows you to combine two or more shapes from different variants into one
overall shape. For more information, see Combining shapes.

§ Command group Inner text: The commands of this group are only possible for shapes to which text has been
added. For more information, see Adding text to AutoShapes.

Text rotation: This option allows you to rotate the inner text by the specified angle.

Vertical alignment: This option enables you to determine how the inner text should be aligned between the
top and bottom edges of the frame.

Change text area: This option allows you to adjust the size of the inner text area. For more information,
see Changing the text area.

Link text frames: This option lets inner text run over several interconnected text frames. For more
information, see Linking text frames.

§ Text wrapping: This option determines how the body text that surrounds the object should behave. For more
information, see Object properties, Layout tab. 

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of frames.

§ Rotate object: This option allows you to rotate a drawing in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing frames.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping frames.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Convert: This option converts an object frame into an object included in the body text and vice versa.

§ Width, Height: These options change the size of the object. For more information, see Changing the size and
margins of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.
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Changing drawing properties via the dialog box

To edit the properties of a drawing via the dialog box, first select it by clicking on it. Then right-click to open
the context menu and select the last entry Properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the contextual
ribbon tab Object.

Tip: This dialog box can also be opened by double-clicking on the drawing.

The following settings can be made in the dialog box:

Layout, Format, Fill tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Layout: On this tab, you can change the position and wrap margins of the drawing and specify how the body
text should flow around it. For more information, see Object properties, Layout tab. 

§ Format: You can change the size of the drawing here. For more information, see Object properties, Format
tab.

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: Here, you can change the line style of the lines used to draw the object. For more information, see
Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

Furthermore, some types of drawings have additional tabs with additional options. (For more information, see
the following pages.)

AutoShapes tab (available only for AutoShapes)

This tab appears for drawing objects only for AutoShapes.

On the AutoShapes tab, you can assign a different AutoShape to the object. Thus you can turn a rectangle into
a speech balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.
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Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon
tab Object. For more information, see Changing the AutoShape of frames.

For more information on AutoShapes, see Inserting drawings.

Inner text tab (available only for AutoShapes with text)

This tab appears only for AutoShapes to which text has been added (see Add text to AutoShapes) and for Text
frames.

You can use this tab to change settings for the text in the text frame.

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Object |
group Inner text.

Available options:

§ Inner margins section 

Here, you can change the inner margins for the text. If you enable the option Automatic, TextMaker will
automatically determine suitable margins.

§ Overlapping objects section

This setting determines what should happen if the object overlaps with another object.

If the default setting Ignore object is enabled, TextMaker will do nothing. In the area of overlap, the
contents of both objects will thus be printed on top of each other.

If, on the other hand, you enable the option Wrap text, TextMaker will automatically wrap the text in this
object so that it flows around the area of overlap.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the
drawing:

Option Explanation

Top The text is aligned to the top edge of the object. (This is the default setting.)

Centered The text is centered between the top and bottom edges.

Bottom The text is aligned to the bottom edge of the object.

Justified The lines of text are vertically justified and are thus evenly distributed so that the text starts exactly
at the top edge of the object and ends exactly at the bottom edge.
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Text tab (available only for TextArt objects)

This tab appears only for TextArt objects. You can use this tab to select the desired TextArt effect as well as to
enter and format the text to be displayed.

Available options:

§ Text 

Here, you can type the text to be displayed.

§ Variants 

In this list, you can select the effect with which the text should be displayed.

§ Font section 

Here you can change the font and enable/disable the text styles Bold and Italic.

If you enable the option Same height, all letters (including lowercase letters) will be stretched to a uniform
height.

§ Spacing section 

The Characters option changes the spacing between characters. If values are less than 100%, the characters
are closer together. For values greater than 100%, the characters are further apart.

The option Lines changes the line spacing. This setting only affects text that consists of multiple lines.

§ Alignment section 

Here, you can change the alignment of the text. This setting only affects text that consists of multiple lines.

§ Vertical text 

If you enable this option, the letters of the text will be rotated by 90 degrees.

Transformation tab (available only for TextArt objects)

This tab appears only for TextArt objects.

You can use this tab to specify the type of shaping effect to be applied to the text. To do so, click on the desired
type of transformation.
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Forms
Forms are documents "to be filled in".

For example, you can use TextMaker to create a form for leave requests. If any of your employees wanted to
apply for leave, they would simply open this predefined form, enter their name and the dates on which they
wanted to begin and end their vacation and print the form. They would then have a completed leave request to
submit.

The creation of forms is actually quite simple: You only have to insert form objects at the places in the
document that are to be filled in later – for example, text fields for text input.

Whenever you want to fill in a prepared form, you should enable form mode. In this mode, only form objects
can be filled in – the rest of the document and most of TextMaker's functions are locked. This prevents users
from changing those parts of the form that shouldn't be changed.

In this chapter, you will learn how to work with forms:

§ Filling in forms 

The first section explains how to fill in prepared forms.

§ Creating forms

In the next section, you will learn how to create your own forms.



349Forms

To create a form, you insert form objects into all places that you want to fill in later: for example, text fields
and text frames for text entries, checkboxes for checking and dropdown lists to select an entry from several
specified options.

§ Form objects in detail 

In this section, the available types of form objects are described in detail.

§ Forms – advanced functions 

Finally, you will learn about some functions for advanced users: functions for changing the tab order, for
protecting forms from being changed and for performing calculations.

Filling in forms
First, we will focus on filling in prepared forms. The procedure for creating your own forms is then described
(in Creating forms).

Forms differ from other documents in only one respect: they contain form objects in the places where
something is to be filled in later.

In the following section, you will learn about the different types of form objects that may be included in a form
and how they are to be filled in:

§ Text fields and Text (field) frames (for entering text) 

To fill in a text field or frame, you simply position the text cursor in it and type the desired text.

§ Dropdown lists and Dropdown list frames (for dropdown menus) 

When you click on a dropdown list, it opens. You can then click to select one of the entries.
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§ Checkboxes and Checkbox frames (for checking) 

If you click on the box with the mouse, a little check mark appears in it, indicating that the associated item
has been selected. If you click on it a second time, the check mark is removed.

Moving the text cursor in forms

You can move the text cursor within forms as follows:

§ You can move the text cursor to the desired position in the usual way by using the arrow keys or clicking
with the mouse. 

§ You can use the Ctrl+F11 key to jump to the next form object and Ctrl+Shift+F11 to jump to the previous
form object.

§ In form mode (see below), the text cursor can only be moved between form objects. In this mode, you can
use the Tab key to jump between form objects.

Form mode

It is recommended that you always enable form mode when filling in forms. This will save you a great deal of
work.

Form mode can be enabled and disabled with the ribbon command View | Form mode .

You will know whether or not form mode is enabled from the program's title bar: If "(Form mode)" is displayed
there after the name of the document, the mode is enabled.

In form mode, TextMaker's behavior changes as follows:

§ You can use the keys Tab and Shift+Tab to jump from one form object to the next object or previous object
respectively. 

§ Only form objects can be filled in, and the normal text is no longer editable.

§ Most of the ribbon commands are "grayed out" and are thus no longer available. This is to ensure that those
parts of the form that should not be filled in are not changed.

In form mode, you can thus fill out a form with the same degree of convenience that you experience when you
use a database program's input mask.

Note: When you open a document that was in form mode when it was last saved, form mode is re-enabled
automatically.

If form mode cannot be disabled

You will encounter some forms in which the author has blocked the ability to disable form mode by protecting
it with a password. This is done to prevent unauthorized persons from changing those parts of the form that are
not intended to be changed.

If a form is protected in this manner, an attempt to disable form mode will result in a prompt for a password.
You will be able to disable form mode only by entering the correct password.
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To learn how to lock the form mode in TextMaker with a password so that other users cannot change the rest of
the text, see Protecting forms.

Shade form objects

You will also find an option called Shade form objects  on the ribbon tab View | group Forms. If it is
enabled, all form objects (text fields, checkboxes, dropdown lists, etc.) are highlighted in the text with a light
gray shading. This makes them stand out more from the rest of the form.

Creating forms
To create a form, simply create a normal document and insert form objects into the places that you want to fill
in later.

For more information on creating forms, see the following pages. The information covers the following topics:

§ Types of form objects 

§ Inserting form objects

§ Editing form objects

§ Preparing an example form

See the following pages for more information.

Types of form objects

The following types of form objects can be used in forms:

Form object Explanation

Text fields Text fields are intended for free text such as "Name", "Street", etc. The user who fills in
the form can enter any text in it.

Text (field) frames These are like text fields but are in a frame (see below).

Note: Text (field) frames can only be used as form objects by converting an inserted
text field. For more information, see Text (field) frames.

Checkboxes Checkboxes are appropriate for Yes/No entries. If the user clicks on a checkbox, it is
selected (i.e., checked). If he clicks on it again, the check mark is removed.

Checkbox frames These are like checkboxes but are in a frame (see below).
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Dropdowns If the user clicks on a dropdown list, it opens to allow predefined list entries to be
selected. List items cannot be entered manually.

Dropdown frames These are like dropdown lists but are in a frame (see below).

In addition, there are two types of form objects that cannot be filled in and are only intended for applying
labels:

Labels Here, you can enter any labels that should be displayed in the form.

Groupboxes Groupboxes are rectangles that can be labeled in the top left corner. They can be used
for the visual grouping of related parts of a form.

Of course, forms can also contain all other types of objects and normal text in addition to the aforementioned
form objects.

For more information on the individual types of form objects, see Form objects in detail.

Should form objects be inserted with or without frames?

As you may have noticed, some form objects can be inserted with or without frames:

§ Checkboxes and checkbox frames 

§ Dropdowns and dropdown frames 

The difference between normal objects and object frames:

Normal objects (for example, dropdowns) are inserted directly into the text. They are integrated into the text
flow – just like a letter. Such objects are easier to use and are thus the best choice for most types of forms.

Objects in frames (for example, dropdown frames), on the other hand, can be positioned anywhere on the
page. They can always be moved with the mouse, but once positioned, they remain fixed in place on the page –
even when text lines are added or deleted above them.

Inserting form objects

To insert a form object into the text, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Form object .

2. Select the desired type of object from the dropdown menu.

3. For some types of form objects, the program displays a dialog box in which you can make various settings
for the object. Then confirm with OK.

The object is now inserted.

For more information on the individual types of form objects, see Form objects in detail.
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Editing form objects

Like all other types of objects, form objects can be edited after being selected with a mouse click. You can
delete them, move them, copy them or change their properties by right-clicking them to open the context menu
and choosing the command (Form object:) Properties etc.

Tip: Furthermore, you can use the ribbon command Insert | Form object | Tab order to change the order of
the form objects which is applied when the user jumps from one object to another in form mode using the
Tab key. For more information, see Changing the tab order.

For general information on working with objects, see Frames and drawings.

Preparing an example form

We come now to a practical example where we will prepare a form for recording client data. The form should
contain some text fields for entering the client's address, a dropdown list for recording the client's gender and a
checkbox for checking if the client is new.

Start a new document with the ribbon command File | New . Then proceed as follows:

Text fields for free text entries

The first line of the form should contain a text field for entering the client's name. The best way to proceed is to
first provide a description of what is to be entered in this field – for example, "Name:". Then insert the text
field to the right of it.

Proceed as follows:
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1. Type "Name:" and then insert a tab with the Tab key.

2. Insert a Text field with the ribbon command Insert | group Objects | Form object .

3. The text cursor is now positioned in the text field. Press the à key to return to the main text.

4. Press the Enter key¿ twice.

The first line of the form is now complete. Create two further lines below in the same manner with the labels
"Street:" and "City:".

Dropdown lists

A dropdown list should now be inserted below the three text fields. Dropdown lists allow users to choose from
among several alternatives.

Proceed as follows:

1. Type "Gender:" and then press Tab.

2. Choose the ribbon command Insert | group Objects | Form object  to select the entry Dropdown.

3. You now have to enter the values that are to appear in the list. Enter "Male" in the New entry field and click
on Add. Then enter "Female" and click Add again.

4. Exit the dialog box with OK.

5. Press the Enter key¿ twice.

Checkboxes for Yes/No entries

Finally, a checkbox should be inserted. Checkboxes can be used for Yes/No entries. If the box is checked, this
means "Yes". If it is not checked, it means "No".

Thus, we will add a checkbox that should only be checked if the client is new:

1. Type "New customer?" and then press Tab.

2. Choose the ribbon command Insert | group Objects | Form object  to select the entry Checkbox.

3. In the dialog box that now appears, you can enter a text if necessary on the Form object tab, which should
appear next to the checkbox. For example, type "Yes".

4. Exit the dialog box with OK.

5. Press the Enter key¿ twice.

To align the form objects vertically, you should now select all the lines you have entered and then use the
ribbon command Layout | group Paragraph | Tabs to set a tab stop at the appropriate place – for example, at
1.2 in.
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Our form is now complete.

You can now save the document and test it. For more information, see also Filling in forms.

The best way to test the form is to choose the ribbon command View | Form mode  to enable form mode.

Form objects in detail
In this section, the individual types of form objects are described in detail. The following objects are covered:

§ Text fields 

§ Text (field) frames

§ Checkboxes

§ Checkbox frames

§ Dropdown lists

§ Dropdown list frames

§ Labels and groupboxes

Text fields

You can use the ribbon command Insert | group Objects | Form object | Text field to insert a text field.

Text fields are often found in forms. You can enter free text in them. Thus, they are suitable for information
such as name, street, city, etc.
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Using text fields

To fill in a text field, simply click in the field to position the text cursor there and enter the text.

Changing the properties of text fields

Place the mouse cursor at the edge of the text field, right-click to access the context menu and select Text field:
Properties to open the dialog box.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

Tip: Enable  Object mode on the ribbon tab View in order to access the dialog box even faster by
double-clicking on the text field.

In the open dialog box, you can change the properties of the text field, such as size, margins, and numerous
other setting options:

Format tab

On this tab, you can change the format of the text field:

§ Size section 

Here, you can change the Size of the text field.

You can either specify an exact width and height or allow the text field to expand automatically to
accommodate the relevant text. To do so, select the option Growing for Width or Height and enter the
desired minimum and maximum values.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the text
field:

Option Explanation

Top The text is aligned to the top edge of the text field. (This is the default setting.)

Centered The text is centered between the top and bottom edges.

Bottom The text is aligned to the top edge of the text field.

Justified The lines of text are vertically justified and are thus evenly distributed so that the text starts exactly
at the top edge of the text field and ends exactly at the bottom edge.
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Margins tab

On this tab, you can change the margins of the text field:

§ Wrap margins section 

Here, you can change the wrap margins.

§ Inner margins section 

Here, you can change the inner margins.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Borders tab

With this tab, you can give the text field a full border or individual border lines.

The options on this tab correspond to those of the ribbon command Home | group Paragraph | Borders. For
more information, see Borders and lines).

Shading tab

With this tab, you can apply shading to the text field using a color or a pattern.

The options on this tab correspond to those of the ribbon command Home | group Paragraph | Borders. For
more information, see Shading.

Options of the contextual ribbon tab "Object"

If you select a text field by placing the mouse cursor on the frame of the text field, the contextual ribbon tab
Object appears automatically.

However, you can only apply some general options for objects here:

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ Link text frames: This option is only possible for text frames. For more information, see Text frames.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Convert: This option converts a text field included in the body text into a text field frame and vice versa.
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§ Width, Height: These options change the size of the object. For more information, see Changing the size and
margins of objects. 

For text (field) frames, there are many more options on the ribbon tab. For more information, see next section.

Text (field) frames

Text (field) frames cannot be inserted directly via the ribbon command Insert | Form object. However, you
can insert a text field and convert it into a frame.

To do so, place the mouse cursor at the edge of the text field and choose the ribbon command Convert on the
contextual ribbon tab Object that appears. Alternatively: Right-click on the text field to open the context menu
and select the entry Convert to object frame.

Tip: Use the ribbon command Insert | Text frame  to directly insert a text frame. This corresponds to a
text field converted into a frame.

A text frame is filled in just like a text field (see previous section): you simply position the text cursor in the
field and start typing.

The difference between a text frame and a text field: A text frame, like all other types of frames, has a fixed
position on the page. Thus, it does not move when you add or remove body text above it. The normal body text
is automatically wrapped around the frame's border lines – it flows "around" the frame.

For information on text fields, see the previous section. For more information on text frames and on the options
of the contextual ribbon tab Object, see Text frames.

Checkboxes

You can use the ribbon command Insert | group Objects | Form object | Checkbox to insert a checkbox.

Checkboxes can be used in Forms for Yes/No entries. If the box is checked, it stands for Yes; if it is unchecked,
it means No.

Using checkboxes

Simply click on the box (not the text!) to give it a check mark – in other words: to check it. If you click on it
again, the check mark is removed.



359Forms

Changing the properties of checkboxes

If you select a checkbox with the mouse cursor, you can right-click on it to access the context menu and select
Checkbox: Properties to open the dialog box.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The following options are available:

Layout tab

This option is only available for checkbox frames.

On this tab, you can change the object's position and outside margins, among other things. For more
information, see Object properties, Layout tab.

Format tab

This option is only available for checkbox frames.

On this tab, you can change the size of the object. For more information, see Object properties, Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the checkbox itself:

§ Text 

Here, you can enter the text that is to be displayed to the right of the checkbox.

§ Value section 

Here, you can specify whether or not the checkbox should be checked. This corresponds to checking the
checkbox directly in the document.

§ 3D effect 

If you enable this option, the checkbox is drawn with a 3D effect.

For checkbox frames, you can also specify the character format (font, size, color, etc.) of the text.
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Options of the contextual ribbon tab "Object"

If you click to select a checkbox, the contextual ribbon tab Object appears automatically.

However, you can only apply some general options for objects here:

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ Link text frames: This option is only possible for text frames. For more information, see Text frames.

§ Text wrapping: This option determines how the body text that surrounds the object should behave. For more
information, see Object properties, Layout tab.

§ Bring to front, Send to back: These options are only available for checkbox frames. They allow you to arrange
the order of overlapping object frames. For more information, see Changing the order of frames.

§ Align objects: This option is only available for checkbox frames. It allows you to align or evenly distribute
two or more object frames. For more information, see Aligning and distributing frames.

§ Group: This option is only available for checkbox frames. It allows you to combine several selected objects
into one unit, which can then be treated like a single object. For more information, see Grouping frames.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Convert: This option converts a checkbox included in the body text into a checkbox frame and vice versa.

§ Width, Height: These options change the size of the object. For more information, see Changing the size and
margins of objects.

Checkbox frames

You can use the ribbon command Insert | group Objects | Form object | Checkbox frame to insert a checkbox
frame.

Checkbox frames are used and function in the same way as checkboxes. For more information, see previous
section.

The difference: A checkbox frame, like all types of frames, has a fixed position on the page. Thus, it does not
move when you add or remove body text above it. The normal body text is automatically wrapped around the
frame's border lines – it flows "around" the frame.
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Dropdown lists

You can use the ribbon command Insert | group Objects | Form object | Dropdown to insert a dropdown list.

You encounter dropdown lists in many dialog boxes. They allow you to select just one option from a choice of
several alternatives. Such lists are ideal for forms because they reduce the required amount of typing when
filling in forms and prevent typing errors.

Using dropdown lists

Click on the arrow to the right of the list to open the list. You can now select an entry by clicking on it.

Changing the properties of dropdown lists

By right-clicking on the edge of the dropdown list, you can select Dropdown: Properties from the context
menu to change the properties of this object via the dialog box.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The following options are available:

Layout tab

This option is only available for dropdown list frames.

On this tab, you can change the object's position and wrap margins, among other things. For more information,
see Object properties, Layout tab.

Format tab

This option is only available for dropdown list frames.

On this tab, you can change the size of the object. For more information, see Object properties, Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.
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Form object tab

On this tab, you can make settings for the dropdown list itself:

§ List entries section 

Here, you specify the items that should appear in the dropdown list. To do so, proceed as follows:

To add an item: Enter the name of the item in the New entry field and press Enter¿ or click on the Add
button.

To remove an item: Select the item in the list of entries and click on the Remove button.

To change an item: Remove the item and reinsert it.

To change the order: Select one of the items in the list and click on one of the small arrows to the right of the
list to move the item up or down.

§ Lines (max.) 

This option is only available for dropdown list frames. It determines the maximum number of lines to be
displayed when the list is opened.

§ Use additional inner margins 

This option is only available for dropdown lists. By default, TextMaker makes dropdown lists just big
enough to contain the relevant text. If you enable this option, it will add small inner margins. The object will
be enlarged automatically.

§ 3D effect 

If you enable this option, the list will be drawn with a 3D effect.

For dropdown list frames, you can also specify the character format (font, size, color, etc.) for the list items.

Options of the contextual ribbon tab "Object"

If you click to select a dropdown list, the contextual ribbon tab Object appears automatically.

However, you can only apply some general options for objects here:

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document. 

§ Link text frames: This option is only possible for text frames. For more information, see Text frames.

§ Text wrapping: This option determines how the body text that surrounds the object should behave. For more
information, see Object properties, Layout tab.
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§ Bring to front, Send to back: These options are only available for dropdown list frames. They allow you to
arrange the order of overlapping object frames. For more information, see Changing the order of frames.

§ Align objects: This option is only available for dropdown list frames. It allows you to align or evenly
distribute two or more object frames. For more information, see Aligning and distributing frames.

§ Group: This option is only available for dropdown list frames. It allows you to combine several selected
objects into one unit, which can then be treated like a single object. For more information, see Grouping
frames.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Convert: This option converts a dropdown list included in the body text into a dropdown list frame and vice
versa.

§ Width, Height: These options change the size of the object. For more information, see Changing the size and
margins of objects.

Dropdown list frames

You can use the ribbon command Insert | group Objects | Form object | Dropdown frame to insert a
dropdown list frame.

Dropdown list frames are used and function in the same way as dropdown lists. For more information, see
previous section).

The difference: A dropdown list frame, like all types of frames, has a fixed position on the page. Thus, it does
not move when you add or remove body text above it. The normal body text is automatically wrapped around
the frame's border lines – it flows "around" the frame.

Note: Unlike dropdown lists, dropdown list frames always appear with a border line in the printout. This setting
cannot be changed in TextMaker, but you can use the following trick to work around it if you do not like the
border in the printout: Insert a Dropdown list into a text frame.

Labels and groupboxes

In addition to the form objects described above, there are two types of form objects that cannot be filled in and
are only intended for applying labels:

§ Labels 

Labels: Here, you can enter any labels that should be displayed in the form.

§ Groupboxes

Groupboxes are rectangles that can be labeled in the top left corner. They can be used for the visual
grouping of related parts of a form.



364Forms

To insert a label or a groupbox, choose the ribbon command Insert | group Objects | Form object | Label or
Group box.

The corresponding form object is then inserted as a frame. Now move it with the mouse to the desired position.
To change its size, drag one of the round handles surrounding the object.

Note: To embed labels/groupboxes without frames in the body text, choose the command Convert on the
contextual ribbon tab Object after inserting them. Click on the button again to convert the object back into a
frame. The difference is that frames are fixed at a fixed position on the page, thus they don't move when you
insert or delete text above them.

Using labels and groupboxes

In contrast to all other types of form objects, you cannot fill in labels and groupboxes. They can only be used to
add (non-editable) labels to the form.

Changing the properties of labels and groupboxes

If you right-click on a label or groupbox, you can choose the entry Form object: Properties from the context
menu to change the properties of this object via the dialog box.

Tip: Open the dialog box by double-clicking on the groupbox or the label.

The following options are available:

Layout tab

On this tab, you can change the object's position and wrap margins, among other things. For more information,
see Object properties, Layout tab.

Format tab

On this tab, you can change the size of the object. For more information, see Object properties, Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the text that you want the label or group field to display:
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§ Text section 

Here, you can enter the text to be displayed.

§ 3D effect 

This option is only available for groupboxes. If you enable this option, the groupbox is drawn with a 3D
effect.

You can also specify the character format (font, size, color, etc.) for the text.

Options of the contextual ribbon tab "Object"

If you click to select a label or a groupbox, the contextual ribbon tab Object appears automatically.

However, you can only apply some general options for objects here:

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ Link text frames: This option is only possible for text frames. For more information, see Text frames.

§ Text wrapping: This option determines how the body text that surrounds the object should behave. For more
information, see Object properties, Layout tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of frames.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing frames.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping frames.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Convert: This option converts a dropdown list included in the body text into a dropdown list frame and vice
versa.

§ Width, Height: These options change the size of the object. For more information, see Changing the size and
margins of objects.
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Forms – advanced functions
To conclude this chapter on forms, let's take a look at some form functions for advanced users:

§ Changing the tab order 

§ Protecting contents of form objects 

§ Protecting forms 

§ Calculating with form objects 

See the following pages for more information.

Changing the tab order

As previously mentioned in the Filling in forms section, you can use Ctrl+F11 to jump back and forth between
form objects: Ctrl+F11 takes you to the next form object and Ctrl+Shift+F11 takes you to the previous one.

In form mode, you also have the option of using Tab and Shift+Tab to perform these functions.

The order in which you jump among the form objects can be specified with the ribbon command Insert | Form
object | Tab order.

Choose this command to open the "Tab order" dialog box. In the list Objects, select the form object whose
position you want to change in the tab order. Then click on one of the arrow buttons to the right of the list to
move the object up or down in the list. The position of the object in the tab order changes accordingly.

Use the Rearrange button to restore the original order.

Protecting contents of form objects

In certain situations, you also want forms to have form objects that cannot be changed in form mode – for
example, text frames with explanations.

This can be achieved by enabling the option Text locked in the object properties dialog box. If this option is
enabled, the contents of the object cannot be changed in form mode. In addition, it is no longer possible to click
on it in form mode or to jump to it with the Tab key.

To protect the contents of a form object, proceed as follows:

1. If form mode is currently enabled, exit this mode with the ribbon command View | Form mode.

2. Click to select the object to be protected.
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3. Right-click on the edge of the object to open the context menu. Choose the last entry Properties here.

4. Switch to the Properties tab.

5. Enable the option Text locked there.

6. Confirm with OK.

The contents of this object are now protected.

Special features of tables

For tables, you can even specify for each table cell whether their contents should be protected against changes
in form mode. To do so, select the desired cells, choose the ribbon command Table | Properties | Cell
properties, switch to the Format tab and enable the option Text locked.

The contents of these cells can no longer be edited in form mode and they are skipped when the Tab key is
pressed to jump to the next cell.

Of course, you can also protect whole tables. To do so, simply select the whole table and then proceed as
described above.

Protecting forms

Before you use a newly created form, you should protect it from being changed. After all, only the form objects
are to be filled in and the form itself should no longer be able to be changed.

To protect a form, you have the following options:

Using form mode

If you enable the form mode presented in the Filling in forms section, you can only fill in form objects. The
other parts of the document can then no longer be edited, and most TextMaker commands are no longer
available.

Form mode can be enabled and disabled with the ribbon command View | Form mode . Alternatively, form
mode can be activated or deactivated on the Form tab in the dialog box of the command File | Properties.

Note: Bear in mind that users who fill in the form can disable form mode at any time unless you prevent them
from doing so by locking form mode with a password (see below).

Saving the form in form mode

Tip: When you save a document in form mode, form mode is automatically re-enabled the next time the
document is opened.
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Locking form mode with a password

You can prevent other users from disabling form mode by locking it with a password.

To do so, choose the ribbon command File | Properties and switch to the Form tab. Enable form mode by
enabling the option Form mode active. Then enter a Password to deactivate form mode and confirm with
OK. Then save the document.

When a user subsequently opens the document and attempts to disable form mode, he or she will be prompted
to enter the password. Thus, users will be able to disable form mode only if they have the correct password.

Important: If you save a document with a password in form mode and then forget the password, you will no
longer be able to disable this mode. Thus, note the password and keep it in a safe place!

Tip: Saving forms as document templates

It is generally recommended that you save forms as document templates. This will always guarantee that the
original file cannot be changed. When you have saved a form as a document template, you can use the ribbon
command File | New to create new documents based on the content of this template without opening the
template itself for editing.

For more information on using document templates, see Document templates.

Calculating with form objects

You can read the contents of form objects and perform calculations on them using the ribbon command Insert |

group Text | Field  | Calculation. For example, the formula "Textbox1.Value * 2" reads the numeric value in
the text field named "Textbox1" and multiplies it by two.

For more information, see Objects in calculations.
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QR codes/Barcodes

This feature is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

You can use the ribbon command Insert | QR code/barcode frame  in TextMaker to generate your own QR
barcodes or some common types of linear barcodes and insert them into the current document. The resulting
object corresponds to a picture frame.

Linear barcodes contain a series of lines with different widths, which you know from everyday items (food,
books, tickets, etc.).

QR codes, on the other hand, are primarily used to encode URLs that can be accessed by scanning them. In
practice, you can use this format, for example, to issue invoices including a QR code to your customers. After
scanning the code, the customer will be taken directly to the web page you have defined.

All types of codes that you create in TextMaker can be scanned with a standard scanner app directly from the
screen or from the printout of the document. Use the scanner that is integrated into your smartphone, for
example.

To create and insert a QR code/barcode, proceed as follows:

1. Choose the ribbon command Insert | group Objects | QR code/Barcode frame .

2. This will then open a dialog box in which you can select under Type whether you want to generate a QR
code or one of the available linear barcodes. For explanations of the different types, see "Options of the
dialog box" below.

3. Enter the desired URL, text, or number in the field below.

Note: For the types Barcode EAN-13 and Barcode EAN-8, you can only enter numbers.

4. Click on Insert. The QR code or barcode is now inserted as a picture frame.

You can then move or resize the picture frame:

To move it, click on the picture frame with the mouse, and then drag it (while still holding down the mouse
button) to the desired position.

To adjust its size, drag one of the round handles surrounding the picture frame.

A picture frame is allowed to easily cover existing text – this is then automatically wrapped in such a way that
it flows around the frame.

Tip: Picture frames can still be subsequently converted into a picture that is embedded in the body text
without a frame and vice versa using the ribbon command Convert. For more information, see Converting
between frame and embedded object.
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Options of the dialog box

After choosing the ribbon command QR code/barcode frame , you can select from the following types of
codes in the dialog box:

§ QR code 

A QR code is a two-dimensional code that can accommodate large amounts of data. You can enter all
numbers and characters here, and there is no limit on the length of the entry.

§ Barcode128

Code128 is an alphanumeric bar code with high data density. You can use numbers and characters of the
ASCII code here, and there is no limit on the length of the entry.

The option With text can only be selected for this type. If it is enabled, the entered text is displayed below
the barcode. If the option is disabled, the display of the text is suppressed.

§ Barcode EAN-13

An EAN-13 code is a numeric barcode. 12 digits must be entered, while the 13th digit is a check digit that is
automatically generated and added at the end.

§ Barcode EAN-8

An EAN-8 code is a numeric barcode. 7 digits must be entered, while the 8th digit is a check digit that is
automatically generated and added at the end.

Changing properties of QR code/barcode objects

An inserted QR code/barcode is actually nothing more than a picture frame. To change the properties, right-
click on the object and select Picture properties in the context menu. In the dialog box that appears, switch to
the QR code/Barcode tab, where you can change the type of barcode and the data for a URL, text or number.

You can use the Export button to save a copy of the barcode picture in PNG format on the hard disk. The
dialog box "Save as" appears for this purpose.

All other options of the dialog box (or on the contextual ribbon tab Picture) correspond to a large extent to the
properties of picture frames as described in the Picture frames section.

If you have converted the inserted QR code/barcode into a picture that is embedded in the normal body text,
you will find the descriptions for adjusting the picture properties in the Pictures section.
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Language tools
TextMaker has always differentiated itself with its powerful language tools (spell check, thesaurus, etc.). This
chapter provides a comprehensive introduction to all available language tools. It consists of the following
sections:

§ Setting the language 

The default language for spell check, hyphenation and thesaurus can be set via the ribbon command File |
Options (Language tab).

You can also assign a different language to individual sections of text via the dialog box of the ribbon tab
Home | group Character  – for example, if you want to use Spanish quotations in an English document.

§ Spell check 

The spell check checks a document's text for typos and suggests corrections in the event of errors.

§ Hyphenation 

Automatic hyphenation hyphenates long words at the end of lines. This is performed automatically as you
type.

§ Duden Korrektor 

Only included in SoftMaker Office Professional and NX Universal: With these versions of SoftMaker
Office, TextMaker also contains the Duden Korrektor from Dudenverlag in addition to its existing language
tools.

It has modules for spell check and hyphenation that can be used instead of the built-in modules.
Furthermore, a module for checking grammar is available.

§ Auto correction 

With Auto correction, you can have TextMaker automatically correct typical careless mistakes when
entering text – for example, if you often type "yuo" instead of "you". In addition, you will find many other
useful auto correct functions here.

§ SmartText 

You can use SmartText to define abbreviations for frequently used phrases – for example, "BR" for "Best
regards".

§ Thesaurus 

The large thesaurus integrated into TextMaker shows you synonyms (words of the same or related meaning)
for a word. Thesauri are also available for many foreign languages.

§ Translation 

Only included in SoftMaker Office NX Universal: TextMaker can automatically translate text sections or
even an entire document into another language for you.
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§ Research 

Only included in SoftMaker Office Professional and NX Universal: Look up terms on online research
platforms (Wikipedia, Oxford dictionary, Cambridge dictionary, etc.) directly from the document.

§ SmartChat 

Only included in SoftMaker Office NX Universal: Create AI-based texts in TextMaker.

§ Read aloud 

Only included in SoftMaker Office Professional and NX Universal: Have the texts in your TextMaker
document read aloud to you.

Setting the language
If you have installed more than one language, you can change the language for the spell check, hyphenation and
thesaurus at any time.

To change the language, you have the following options:

§ Setting the default language 

Usually, it is sufficient to set the default language with the ribbon command File | Options . The spell
check, hyphenation and thesaurus are usually always based on the default language.

§ Formatting text in another language 

If necessary, you can format sections of text in another language at any time via the dialog box of the ribbon
tab Home | group Character  (even faster: Click on the Current language field in the status bar).

More specifically: The whole document is formatted in the Default language by default. Thus the spell check,
hyphenation and thesaurus use the default language specified in the settings. If you format a section of text in
another language (for example, in Spanish), however, the spell check, hyphenation and thesaurus are based on
the Spanish language for this section.

For more information, see the following pages.

Setting the default language

By setting the default language, you specify which language the spell check, hyphenation and thesaurus should
use by default. Thus, set the language in which you usually write your documents here.

To do so, proceed as follows:

1. Choose the ribbon command File | Options  to open the dialog box.

Alternatively: Choose the ribbon command Review | Spell check  | Settings.

2. Switch to the Language tab.
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3. Select the desired language from the list "Default language".

Note: Please note that there are two entries in this list for German:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

When you create new documents, they are always formatted in the default language by default. Of course, you
can also write documents that contain text (wholly or partially) in other languages. For more information, see
the next section.

Formatting text in another language

In the last section, you learned how to set the default language that TextMaker should use by default for the
spell check, hyphenation and thesaurus.

Furthermore, you can format any sections of text in another language – for example, if you want to use a
Spanish quotation in a document that is mostly in English.

(Tip: This also applies to the date format when inserting Date/time.)

To do so, proceed as follows:

1. Select the section of text whose language you want to change.

2. On the ribbon tab Home | group Character, click on the group arrow  in the bottom right corner to open
the dialog box.

3. Select the desired language in the list Language on the Font tab.

The spell check, hyphenation and thesaurus know that this section of text is in another language and they
provide the appropriate results.

In addition, the dropdown list Language contains two entries with a special meaning:

§ The language "Default" 

This is the default setting.

By default, all documents that you create are formatted in the "default" language. You can set the default
language with the ribbon command File | Options as described in the previous section.

§ The language "No language" 

If you format a section of text with the language set as "No language", it will be ignored by the spell check.
In addition, no hyphenation will be applied.
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Tip: You can format the section of text in another language even faster as follows:

Set the desired language on the ribbon tab Review | group Spelling | Change language . Alternatively,
just click on the language field in the status bar.

Application examples

Some application examples in summary:

If you write documents solely in your native language:

Simply set the desired default language on the Language tab in the dialog box of the ribbon command File |

Options .

If you occasionally write entire documents in a foreign language:

In this case, it is not advisable to change the default language in the settings to this foreign language. Although
this would lead to the desired result, it would only have a temporary effect. If you then set your original default
language again and reopen the document, TextMaker checks the spelling and hyphenation in your original
language again instead of in the foreign language.

It makes more sense to select the whole document, open the dialog box of the ribbon tab Home | group
Character  and change the Language to the desired foreign language instead of "Default". This enables
TextMaker to know the document's language both now and in the future.

Tip: It is much faster to set this language option using the  Change language button on the ribbon tab
Review | group Spelling. Alternatively, just click on the language field in the status bar.

If you write documents with some foreign language citations:

Simply select the foreign language part, open the dialog box on the ribbon tab Home | group Character  and
set the Language to the desired foreign language instead of "Default".

You can change the language in a document as often as you like and even mix several languages.
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Spell check
The spell check checks a document's text for typos and suggests corrections in the event of errors.

This section describes the different spell check tools in detail. The information covers the following topics:

§ Manual spell check 

The manual spell check lets you check and correct possible spelling errors in an entire document.

§ Checking the spelling as you type 

The option Check spelling as you type constantly checks all text in the document for spelling errors.
Misspelled words have red wavy underlines. They can be corrected manually or via a context menu with
suggested words.

§ Conversion to the new German spelling 

If you compose documents in German, the option "Check spelling as you type" can also help you to apply
the reformed German spelling rules.

§ Editing user dictionaries 

When you teach the spell check new words, they are added to your user dictionary. You can edit this
dictionary at any time, for example, to delete incorrect entries.

For more information on these topics in the above order, see the following pages.

Note: The spell check relies on the dictionaries having been installed and enabled. For more information, see
Installing dictionaries.

Manual spell check

You choose the ribbon command Review | Spell check  to start the subsequent spell check. Tip: You can
also choose this command with the F7 key.

When you choose this command, you are first asked whether the spelling should be checked from the current
cursor position or for the whole document. Choose your preferred option, and then start the spell check by
clicking on OK.

TextMaker now checks the text word for word for spelling errors. If the spell check encounters an unfamiliar
word, it stops and displays the word in a dialog box:
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Here, you can choose between correcting the word, adding it to the dictionary or simply ignoring the supposed
error. The list under Change to will also contain some suggestions for the correct spelling of the word (if any
are found).

You can use the dialog buttons to specify what to do with the unfamiliar word:

Button Function

Change This option lets you correct the misspelled word. Before you use this button, type the correct
spelling in the Word input field or select one of the suggested words from the list Change to.

Change all This option works like the Change button, but changes all further instances of the word (from here
to the end of the document).

Ignore This option instructs TextMaker to ignore this spelling error and continue with the spell check.

Ignore all This option instructs TextMaker to ignore all further instances of this word.

Note: TextMaker only remembers the list of ignored words temporarily. When you exit
TextMaker, it forgets it. If you want TextMaker to learn words permanently, use the command
Add instead.

Add This option instructs TextMaker to add the word to the user dictionary and thus increase its
vocabulary.

Use this option for correctly spelled words that TextMaker does not yet know. TextMaker
remembers these words permanently, even after a restart.

If you want to exit the spell check before it reaches the end of the document, click on Close.

Is the spell check not working correctly? If the spell check classifies many words in a section of text as incorrectly
spelled, although their spelling is definitely correct, then the section of text was probably formatted in the
wrong language.

In this case, select the section of text and use the Change language button  on the ribbon tab Review |
group Spelling to set the language back to "Default" (or to the language in which it was written).
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Checking the spelling as you type

The option Check spelling as you type constantly checks the whole text for spelling errors. All misspelled
words are marked with a red underline.

Enabling the option "Check spelling as you type"

To enable the function Check spelling as you type, choose the ribbon command File | Options to open the
dialog box, switch to the Language tab and enable the option Check spelling as you type.

Tip: You can also enable this setting directly via the  icon on the ribbon tab Review | Spell check. Click
on the small arrow of the icon and select the entry Check spelling as you type there.

TextMaker will now examine the entire document for spelling errors on a continuous basis. It will not only
recognize existing spelling errors in the document, but will also immediately examine changes and additions to
the text for correct spelling. (The latter is performed as soon as a word is terminated by the space bar.)

Correcting misspelled words

Misspelled words are indicated with red wavy underlines on the screen. This allows you to see all misspelled
words at a glance so that you can either correct them immediately or at a later time.

To correct one of these words underlined in red, either just change its spelling manually or right-click on the
word to open the spell check's context menu.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen and
hold your finger there for about a second.

The context menu contains the following items:

Item Function

List of 
suggestions

The upper part of the context menu offers suggestions for the correct spelling of the word if any
are found by TextMaker. If you click on one of them, it will replace the word in the text.

If TextMaker finds a large number of suggestions, an additional menu item called More
suggestions appears. If you click on this item, a dialog box will appear with all suggestions that
were found. For more information, see Manual spell check.

Ignore word This option ignores the spelling error (for all instances of this word) and removes the red
underline.

Use this option for words that are spelled correctly but should not be learned. When you exit
TextMaker, it "forgets" the ignored words.

Add word This option instructs TextMaker to add the word to the user dictionary and thus increase its
vocabulary.

Use this option for correctly spelled words that TextMaker does not yet know. TextMaker
remembers these words permanently.
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Add to 
Auto correction

In the case of a typical typo, add the correct spelling in the Auto correct list. For more information,
see Auto correction.

As soon as you correct the spelling (or allow TextMaker to ignore or add the word), the red underline
disappears automatically.

Blue underlined words: If you have also enabled the option Underline old German spellings in blue in the
dialog box File | Options, you may also see blue underlined words in addition to red underlined words. These
are words that correspond to the old German spelling but have to be written differently since the new spelling
was introduced. For more information, see the next section.

Is the spell check not working correctly? If the spell check classifies many words in a section of text as incorrectly
spelled, although their spelling is definitely correct, then the section of text was probably formatted in the
wrong language.

In this case, select the section of text and use the Change language button  on the ribbon tab Review |
group Spelling to set the language back to "Default" (or to the language in which it was written).

Tip: Jumping to the previous/next spelling error

If the option Check spelling as you type is enabled, the three buttons in the bottom right corner of the document
window can also be used to jump to the previous/next spelling error.

To do so, click on the button with the red dot. A small menu appears. Select the option Spelling error from it.

The buttons can now be used as follows:

§ Click on the button with the up arrow to jump to the previous spelling error. 

§ Click on the button with the down arrow to jump to the next spelling error.

For more information on these three buttons, see Go to....

Note: If you have also enabled the Duden grammar check (only included in SoftMaker Office Professional
and NX Universal), the arrows will jump to the previous/next spelling or grammar error.

Conversion to the new German spelling

As you may have already noticed, TextMaker offers two entries for German in lists for selecting the language:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".
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Thus, you can decide for yourself whether you would prefer to use the old or the new German spelling:

Using the old spelling

If you select the language "German (Germany, old)", the spell check, hyphenation and thesaurus will continue
to follow the old spelling rules.

Using the new spelling

If you want to write documents in the new German spelling, on the other hand, select the language "German
(Germany)". In this case, the aforementioned function Check spelling as you type will provide you with a
useful tool if desired:

If you use the dialog box to enable the option Underline old German spellings in blue, a blue underline is
added to all words that correspond to the old German spelling but should be written differently according to the
new spelling.

If you right-click on such a word, you will be offered the permitted spellings. You can also find out why this
word should be spelled differently – and thus refresh your knowledge of the new spelling rules.

For more information on this topic, see the following pages.

Enabling conversion to the new German spelling

To enable checking and converting to the new spelling in texts composed in German, you must proceed as
follows:

1. Choose the ribbon command File | Options  to open the dialog box.

Alternatively: Choose the ribbon command Review | Spell check  | Settings.

2. Switch to the Language tab.

3. Enable the option Check spelling as you type.

4. Also enable the option Underline old German spellings in blue.

5. Confirm with OK.

Note: The option Underline old German spellings in blue only works for text in the language "German
(Germany)", "German (Austria)" or "German (Switzerland)". It is irrelevant for all other languages.

TextMaker now permanently checks the document in the background for words that should be written
differently since the 1996 spelling reform. Such words are underlined in blue. On the following pages, you will
learn how to convert these words into the new German spellings. 
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Correcting words with old German spellings

If, as described in the previous section, you have selected the option Underline old German spellings in blue,
German words whose spelling was changed during the spelling reform are indicated with a blue underscore.

To correct one of these underlined words, just change its spelling manually or right-click on the word to open
the spell check's context menu.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen and
hold your finger there for about a second.

The context menu contains the following items:

Item Function

List of 
suggestions

All spellings that are correct (according to the reformed German spelling rules) are displayed in
the upper part of the menu. If you click on one of them, TextMaker will replace the word in the
text with it.

Info This option opens a dialog box with additional options and information. For more information, see
Info command of the spell check.

Ignore word The option ignores the supposed spelling error and removes the blue underline.

Use this option for words that are spelled correctly but should not be learned. When you exit
TextMaker, it "forgets" the ignored words.

Add word This option instructs TextMaker to add the word to the user dictionary.

TextMaker remembers such words permanently; they will no longer be underlined in blue (see
note!)

Note: Use the command Add word only for those German words underlined in blue that are in fact correctly
spelled according to the new German spelling rules. If you allow the addition of words with old spellings,
rather than new spellings, you will be supplying TextMaker with incorrectly spelled words.

Info command of the spell check

If you open the context menu of the spell check, as described in the last section, an additional entry appears for
German words spelled in the old way: the Info command. This command contains additional options and shows
information about the rule governing the change in the word's spelling under the German spelling reform.

This command's dialog box provides the following functions:

Item Function

List of 
suggestions

All spellings that are correct according to the spelling reform are displayed here. If you click on
one and then click on the Change button, TextMaker replaces the word in the text with it.
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Change This option lets you correct the word after you have chosen the correct spelling from the list of
suggestions.

If TextMaker ever makes an incorrect suggestion, you can enter the correct spelling in the Change
to field manually.

SmartText This option lets you define a SmartText entry. For more information, see SmartText.

Ignore This option instructs TextMaker to ignore this spelling error.

Ignore all This option instructs TextMaker to ignore all further instances of this word.

Note: TextMaker only remembers the list of ignored words temporarily. When you exit
TextMaker, it forgets it. If you want TextMaker to learn words permanently, use the command
Add instead:

Add This option instructs TextMaker to add the word to the user dictionary.

TextMaker remembers such words permanently; they will no longer be underlined in blue (see
note!)

Close This option closes the dialog box without applying a change.

Note: Use the command Add only for those German words underlined in blue that are actually spelled
correctly according to the new German spelling rules. If, on the other hand, you allow the addition of words
with old spellings, rather than new spellings, you will be supplying TextMaker with incorrectly spelled
words!

Editing user dictionaries

When you teach the spell check new words, they are added to your user dictionary. You can edit this dictionary
at any time, for example, to delete incorrect entries.

To do so, click on the small arrow of the icon on the ribbon tab Review | Spell check  and select Edit user
dictionaries from the dropdown menu. The program displays a dialog box with the following buttons and
options:

§ Language 

There is a separate user dictionary for each language. You can select the user dictionary to be edited from
the dropdown list Language.

Note: Note that there are two entries for each German in this list: "German (Germany)" stands for the new
spelling and "German (Germany, old)" for the old spelling. The same applies to "German (Austria)" and
"German (Switzerland)".

§ Entries 

This list contains all words that have been added to your user dictionary (for the selected language).
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§ "Close" button 

This option closes the dialog box.

§ "Add" button 

This button enables you to manually add a word to your user dictionary. To do so, type the desired word into
the dialog box that appears after you press this button.

Words added in this way are treated exactly the same as words that were added using the Add button in the
spell check.

§ "Change" button 

Use this button to edit the word that is currently selected in the list. This is useful for misspelled words that
you have added to your user dictionary accidentally. By clicking on the button, you open a dialog box where
you can correct the spelling of the word.

§ "Delete" button 

This button deletes the word currently selected in the list from your user dictionary.

The spell check will therefore regard this word as misspelled again in the future.
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Hyphenation
Automatic hyphenation hyphenates long words at the end of lines. This ensures that the right margin of the text
does not appear too "frayed".

Hyphenation works fully automatically as you type. Thus, you usually do not have to concern yourself with it at
all.

All you have to do is make sure that you have set the correct language because hyphenation will naturally
produce incorrect results if, for example, you have an English text separated according to German hyphenation
rules.

Setting the language

Detailed instructions on setting the language for spell check and hyphenation were provided at the start of this
chapter. For more information, see Setting the language.

Here's a brief summary:

§ Setting the default language 

By setting the default language, you specify the language which the spell check and hyphenation will use by
default.

To set the default language, choose the command File | Options , switch to the Language tab in the
dialog box and select the desired language from the list "Default language".

Normally, you choose your native language here – and then you never have to worry about this setting again.

§ Formatting sections of text in another language 

You can also select a different language for individual sections of text at any time. This is useful, for
example, if you want to use Spanish quotations in an English document.

To do so, select the foreign language section of text and use the Change language button  (ribbon tab
Review | group Spelling) to select the language in which this section of text is written.

You can change the language as often as you want within a document and, of course, format a whole
document in another language.

Setting the hyphenation frequency

If desired, you can specify how often you want the hyphenation function to separate words – or disable
hyphenation completely. This setting can be set separately for each paragraph.

To do so, select the relevant paragraphs and open the dialog box by clicking on the group arrow  in the bottom
right corner of the ribbon tab Home | group Paragraph. Switch to the Text flow tab. Then select the desired
setting in the dropdown list Hyphenation.

Tip: Alternatively, you can find these settings on the ribbon tab Review | Hyphenation .

The following options are available:
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Option Explanation

None No hyphenation is performed.

Always Any amount of consecutive hyphenation is attempted (default setting).

Every 2 lines Hyphenation is attempted only in every second line.

Every 3 lines Hyphenation is attempted only in every third line.

If you select None, you completely disable hyphenation for the selected paragraphs, whereas if you select
Always, the program tries to hyphenate any line of a paragraph.

When do you use the other two options? It is not always a good idea to hyphenate at every point possible. For
text in narrow columns, for example, this may lead to words being split at the end of almost every line and thus
to a reduction in the document's legibility. Thus, you may want to use the option Every 2 lines or Every 3 lines
to instruct TextMaker to attempt hyphenation only in every second or third line.

Completely disabling hyphenation for a document

Apart from the aforementioned options, you can completely enable or disable hyphenation for the current
document.

On the ribbon tab Review | Hyphenation , choose the command Automatic hyphenation from the
dropdown menu to switch the mode.

Automatic hyphenation is enabled by default. This is evident from the check mark that is displayed before the
command Automatic hyphenation. To disable the hyphenation, choose this command and the check mark will
disappear. Automatic hyphenation is now completely disabled (for the current document). Hyphens will no
longer be inserted automatically and the existing ones will be removed.

If you choose this command once more, automatic hyphenation will be enabled again.

By the way, the same option is also available in the Settings, Language tab. If you enable or disable the option
Use automatic hyphenation for this document there, it is identical to choosing the command Review |
Hyphenation  | Automatic hyphenation.

Note: This setting is a document option. This means that it affects only the current document and its state is
saved in the document. Thus, you can decide whether or not automatic hyphenation should be performed for
each individual document.

Tip: If you want to save the currently selected state of the hyphenation (on/off) as a global setting for future
documents, use the Set as default button in the Settings, Language tab.

Disabling hyphenation for a word or a section of text

You can also disable hyphenation for a specific section of text, for example, a certain word.

Select the section of text and use the Change language button  (ribbon tab Review | group Spelling) to set
the setting No language.

Note: Please note that this will also disable the spell check in the selected section of text.
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Inserting "soft hyphens"

TextMaker has a very sophisticated hyphenation module that only very rarely makes mistakes. If the program
does not hyphenate a word in the desired place, you can always correct it by inserting a soft hyphen (also known
as an optional hyphen).

To do so, place the text cursor at the point where you want the word to be hyphenated and press the key
combination Ctrl+Hyphen. From now on, TextMaker will only hyphenate the word at this point.

If a word contains multiple syllables, you can also insert several soft hyphens (for example, one after each
syllable).

Tip: Soft hyphens are not displayed in the document by default. However, you can make them visible at any
time by choosing the ribbon command File | Options, switching to the View tab and enabling the option Soft
hyphens. This will display all soft hyphens as hyphens with a gray background.

Inserting "non-breaking" hyphens

If a word (or a number) that contains a hyphen is located at the end of a line, TextMaker may use this hyphen to
hyphenate the word. In certain cases, this is not desirable.

In the case of a phone number like 936386-0, for example, you do not want the zero to be separated from the
rest of the phone number by hyphenation. The number is ultimately easier to read if it is not distributed over
two lines, but is instead moved completely to the next line.

If you want to prevent TextMaker from performing hyphenation at a hyphen that a word contains, insert a non-
breaking hyphen instead of a regular hyphen. You can insert this by pressing the key combination
Ctrl+Shift+Hyphen.

You could also call this character a "non-separating hyphen" because it looks like a normal hyphen, but
prevents hyphenation from being performed at this point.



386Language tools

Duden Korrektor

This feature is only included in SoftMaker Office Professional and NX Universal. It is not available in the
Android or iOS version.

In SoftMaker Office Professional/NX Universal, TextMaker also contains the Duden Korrektor from
Dudenverlag in addition to its existing language tools.

This includes spell check and hyphenation modules that can be used instead of the built-in modules. A
grammar check module is also available.

Note: All modules of the Duden Korrektor only work for text in the language "German (Germany, Austria,
Switzerland, etc.)".

The following sections contain a detailed description of the Duden Korrektor. The information covers the
following topics:

§ Using the Duden spell check 

Duden Korrektor can also check the spelling in your documents:

Simply enable the option Use Duden Korrektor for German spell check in the settings. From now on, the
spell check will no longer use the spell check module integrated in TextMaker, but will use the spell check
module of the Duden Korrektor instead.

§ Using the Duden hyphenation 

The same applies to automatic hyphenation:

To do so, enable the option Use Duden Korrektor for German hyphenation in the settings. Once this has
been done, hyphenation will be performed by the corresponding module of the Duden Korrektor rather than
by the module integrated in TextMaker.

§ Using the Duden grammar check 

The option Use Duden Korrektor for German grammar check adds a particularly interesting new feature
to TextMaker:

The Duden grammar check basically works in the same manner as the function Check spelling as you type.
However, it searches for grammatical errors rather than spelling errors. Grammatical errors are underlined in
green. If you point to such an error with the mouse, an explanation will appear.

§ Configuring Duden Korrektor 

In the last section, you will become familiar with the dialog box Duden Korrektor options, which you can
use to configure the individual modules of the Duden Korrektor to your liking.

For more information on these topics in the above order, see the following pages.
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Using the Duden spell check

This feature is only included in SoftMaker Office Professional and NX Universal. It is not available in the
Android or iOS version.

The Duden Korrektor has a spell check module.

If you enable this option, TextMaker uses the spell check module of the Duden Korrektor rather than its own
module. This is characterized primarily by the fact that it uses the official Duden dictionary.

Note: The Duden spell check only works for text in the language "German (Germany, Austria, Switzerland,
etc.)".

Enabling the Duden spell check

To enable the Duden spell check, choose the ribbon command File | Options  to open the dialog box, switch
to the Language tab and enable the option Use Duden Korrektor for German spell check.

Tip: Alternatively, open the dialog box with the ribbon command Review | Spell check  | Settings.

From now on, the spelling module of the Duden Korrektor will be used for the spell check (see also
Configuring Duden Korrektor) instead of the module integrated into TextMaker.

Note: The operation of the spell check does not change at all. You can continue to run the spell check manually
as described in Spell check or let it run automatically in the background.

Using the Duden hyphenation

This feature is only included in SoftMaker Office Professional and NX Universal. It is not available in the
Android or iOS version.

The Duden Korrektor has an automatic hyphenation module, among other things.

If you enable this option, TextMaker uses the hyphenation module of the Duden Korrektor for automatic
hyphenation rather than its own module. This is characterized primarily by the fact that it can use the official
Duden dictionary to determine the permissible separations.

Note: The Duden hyphenation only works for text in the language "German (Germany, Austria, Switzerland,
etc.)".

Enabling Duden hyphenation

To enable Duden hyphenation, choose the ribbon command File | Options  to open the dialog box, switch to
the Language tab and enable the option Use Duden Korrektor for German hyphenation.

Tip: Alternatively, open the dialog box with the ribbon command Review | Spell check  | Settings.
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From now on, the hyphenation module of the Duden Korrektor will be used (see also Configuring Duden
Korrektor) instead of the module integrated into TextMaker for automatic hyphenation.

Note: The operation of the hyphenation function does not change at all. Thus, it will continue to run completely
automatically if you don't intervene, and it will separate words automatically. For more information, see
Hyphenation.

Using the Duden grammar check

This feature is only included in SoftMaker Office Professional and NX Universal. It is not available in the
Android or iOS version.

The Duden Korrektor also has a grammar check in addition to the spell check and hyphenation modules.

This works according to the same principle as the option Check spelling as you type. However, it searches for
grammatical errors rather than spelling errors. If an error is found, the grammar check marks it with a green
underline.

Note: The Duden grammar check only works for text in the language "German (Germany, Austria,
Switzerland, etc.)".

Enabling the Duden grammar check

To enable the Duden grammar check, choose the ribbon command File | Options  to open the dialog box,
switch to the Language tab and enable the option Use Duden Korrektor for German grammar check.

Tip: Alternatively, open the dialog box with the ribbon command Review | Spell check  | Settings.

From now on, the grammar check permanently checks the entire document in the background for grammatical
errors. It not only detects existing errors, but also immediately checks text changes and new entries for errors –
with the following restriction:

Note: When editing and adding text, note that the grammar check in TextMaker always works in
paragraphs. Thus, when you edit the content of a paragraph, its grammar is only checked when you leave the
paragraph – for example, when you move the cursor out with the direction keys, click outside the paragraph
or start a new paragraph with the Enter key¿.

Note: It should also be noted that checking the grammar of a text is a very complex task, even for the most
modern computers. Thus, the grammar check may occasionally consider formulations to be wrong when they
are actually correct. In such cases, simply use the command Ignore rule here (see below).

Correcting grammatical errors

Sentences with a grammatical error are marked on the screen with a green underline. This allows you to see all
grammatical errors at a glance so that you can either correct them immediately or at a later time.

To correct a grammatical error, just manually edit the part of the sentence that is underlined in green.
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Tip: If you hover over a grammatical error (without clicking), the program will display an info box with an
explanation of the error.

By right-clicking on a grammatical error, you can also open a context menu that contains the following
functions:

Item Function

List of
suggestions

For some types of grammar errors, a suggestion for the correct spelling is offered at the top of
the menu. If you click on it, the incorrect text will be replaced accordingly.

Info This option displays explanations of the grammatical error.

Ignore rule here This option ignores the applied grammatical rule at this one point and removes the green
underline.

This command is especially useful when the grammar check has incorrectly underlined text in
green that is actually correct.

Always ignore rule This option always ignores the applied grammar rule from now on in all documents.

Use this command if you want the grammar check to generally ignore a particular grammatical
rule.

TextMaker remembers this change permanently. (However, you can re-enable disabled rules in
the Options dialog box of Duden Korrektor at any time. For more information, see Configuring
Duden Korrektor.)

Tip: Jumping to the previous/next grammatical error

When the grammar check has been enabled, the three buttons in the lower right corner of the document window
can also be used to jump to the previous/next grammatical error.

Click on the button with the red dot. A small menu appears. Select the option Spelling error from it.

You can now use the buttons as follows:

§ Click on the up arrow to jump to the previous grammatical error. 

§ Click on the down arrow to jump to the next grammatical error.

For more information on these three buttons, see Go to....

Note: If you have also enabled Check spelling as you type, the arrows will jump to the previous/next spelling
error or grammatical error.
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Configuring Duden Korrektor

This feature is only included in SoftMaker Office Professional and NX Universal. It is not available in the
Android or iOS version.

TextMaker contains a dialog box with settings for all modules of the Duden Korrektor. This allows you to
configure the Duden Korrektor and customize the style check to your preferred writing style.

You can open this dialog box as follows:

1. Choose the ribbon command File | Options  to open the dialog box.

Alternatively: Choose the ribbon command Review | Spell check  | Settings.

2. Switch to the Language tab.

3. Click on the Duden Korrektor options button.

The dialog box contains the following settings:

Checking style for spelling and grammar

Due to the 1996 spelling reform, several spellings are now permitted for numerous German words – for
example, Foto or Photo.

This setting allows you to specify which of these alternative spellings should be considered correct by the spell
check and grammar check. You can choose between the following options:

Duden recommendations: If more than one spelling of a word is allowed, only the spelling recommended by
the Duden editorial staff should be considered correct.

Conservative: If several spellings are allowed, only the old spelling should be considered correct. Right:
Photo. Wrong: Foto.

Progressive: If several spellings are allowed, only the new ("reformed") spelling should be considered correct.
Right: Foto. Wrong: Photo.

Permissive: If several spellings are allowed, all spellings are considered correct – i.e., both Photo and Foto.

Press agencies: If several spellings are allowed, the German press agencies' preferred spelling is considered
correct.

"Grammar check" section

§ Show tooltips 

If this option is enabled, the Duden grammar check displays an info box with information about the type of
grammatical error when you hover with the mouse over one of the green underlined grammatical errors in
the text.
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"Spell check" section

§ Show tooltips 

If this option is enabled, the spell check displays an info box with information about the type of spelling
error when you hover with the mouse over one of the red underlined spelling errors in the text. (Of course,
this only works if the option Check spelling as you type is enabled.)

"Hyphenation" section

§ Hyphenation style 

Due to the 1996 spelling reform, there are now numerous German words which may be hyphenated in
several ways. Before the reform, for example, the word magnet was always separated into ma-gnet; the
alternative separation of mag-net is now also permitted.

You can use this setting to specify which variant is to be used in such cases. You can choose between the
following options:

Conservative: If several hyphenation variants are permitted for a word, use only the old hyphenation. Right.
Ma-gnet. Wrong: Mag-net.

Progressive: If several variants are permitted, use only the new ("reformed") separation. Right: Mag-net.
Wrong: Ma-gnet.

By pronunciation: If several variants are allowed, use the variant that corresponds to the pronunciation of
the word. In the case of Magnet, that would be Ma-gnet.

Combined (all variants): Use all permitted variants of separations. Depending on the space required,
Magnet can be separated as either Mag-net or Ma-gnet.

§ Allow separations within word stems 

This option has the following effect:

On: Allow all permitted hyphenations, including those within word stems.

Off: Do not allow separations within word stems. This is especially true for words with prefixes and words
composed of several words:

If this option is disabled, for example, the German word heim-kom-men will be hyphenated as heim-kommen
and Ta-fel-was-ser as Tafel-wasser.

§ Allow unaesthetic hyphenation 

This option has the following effect:

On: Allow all permitted hyphenations, even unaesthetic ones.

Off (recommended): Do not allow separations that are unaesthetic or confusing.

If this option is disabled, for example, the German word so-zi-al is hyphenated as so-zial. In addition,
confusing separations such as Urin-stinkt (urine stinks in German) instead of "Urinstinkt" (basic instinct in
German) or Reim-port instead of "Reimport" are no longer allowed.
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"Grammar and spell check rules" section

All grammar and spell check rules appear in this list with their enabled status (check mark = enabled). To find a
rule more quickly, you can use the dropdown list to limit the display from Alle Einträge (All entries) to a
specific category. Note: Text style analysis can be found in particular in the Stilprüfung (style check) and
Erweiterte Stilprüfung (advanced style check) sections. It is only included in NX Universal.

Enable or disable rules according to your needs by clicking on the checkbox and confirming with OK.

Disabled rules are ignored by the spelling and grammar check; thus no errors are reported with respect to this
rule.

Background information:

There are two reasons why rules may appear as disabled in this list:

§ Rules that you disabled yourself: 

As described in Using the Duden grammar check, you can disable rules by right-clicking on one of the
underlined grammatical errors and selecting the command Always ignore rule from the context menu that
appears.

All rules disabled in this way appear in this list without a check mark and can be enabled again if you
change your mind.

§ Rules that are disabled by default: 

Some rules are disabled by default for various reasons. For example, a percent sign may be preceded by a
space character, but it does not have to be. Thus, the corresponding rule is initially set to disabled.

Note: The check rules used here are only highlighted in the text after completing the paragraph and not while
typing.

You can restore the default settings for this list at any time by clicking on the Reset all button. Any rules you
changed will then be reset to their original status.
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Auto correction
You're bound to be familiar with making the same typos over and over again when writing. For example, you
want to write "you", but the text ends up as "yuo", which was not your intention. In such cases, TextMaker
intervenes via Auto correction and corrects such common typos automatically.

The ribbon command Review | group Spelling | Auto correction  opens a dialog box in which you can
specify the settings for automatic correction.

Apart from the ability to avoid these accidental typos as in the example above, there are other useful auto
correction functions in the dialog box:

§ Capitalize first letter of sentences 

§ Correct capitalization of first TWo LEtters

§ Special replacements: For example, automatically create a smiley from the combination :-)

§ Automatically convert quotation marks to the typographically correct characters when typing

§ Format URLs as hyperlinks

§ Add superscript to ordinal numbers

Tip 1: Automatic correction is triggered as soon as a term is terminated with the space bar, the Enter key ¿
or with a punctuation mark.

Tip 2: If you want to undo an unwanted auto correction in your document, use the Undo command  or
press the key combination Ctrl+Z immediately after the auto correction.

The following pages contain detailed explanations about all auto correction functions.

Options tab

You can adjust the auto correction settings according to your needs.

Note: Auto correction is a global setting. Changes you make here will thus be applied to every document.

To do so, choose the ribbon command Review | group Spelling | Auto correction , and the following dialog
box will appear:
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On the Options tab, you will find the following auto correction functions:

"Auto correction" section

§ Automatically correct common typos 

This option ensures that typical typing errors are corrected. If, for example, you type "thier", TextMaker
automatically corrects this word to "their".

A list containing common typos is pre-installed for some languages. You will find this list on the Auto
correction tab, where you can delete existing pairs of terms or add new ones. For more information, see
Auto correction tab.

§ Capitalize first letter of sentences

If this option is enabled, TextMaker automatically capitalizes the first letter of every sentence you type –
even if you accidentally enter a lowercase letter.
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If, for example, you typed the sentence "this is a new sentence.", it would be corrected automatically to
"This is a new sentence.".

Exception list: For certain terms, however, it may be undesirable for this automatic correction to occur (for
example, after an abbreviation such as "max."). Switch to the First letter tab, where you can add terms that
should be excluded from this correction. For more information, see First letter tab.

§ Correct first TWo UPpercase LEtters

If this option is enabled, TextMaker automatically corrects the case of words whose first two letters have
been capitalized inadvertently.

If, for example, you typed the word "HEnry", it would be corrected automatically to "Henry".

Exception list: If, however, you want to exclude certain expressions from this correction (for example,
"BSc"), then switch to the Initial caps tab. Here, you can add terms where two capital letters at the
beginning should not be corrected. For more information, see Initial Caps tab.

§ Expand SmartText entries

As described in SmartText, you can create SmartText entries with TextMaker (for example, "br" for "Best
regards").

If this option is enabled, your SmartText entries can be directly expanded as the text is entered. To do so,
simply type the abbreviation for the SmartText (for example, "br") and then a space, Enter¿ or a punctuation
mark, and TextMaker will automatically replace the abbreviation with the SmartText content.

If this option is disabled, however, SmartText entries can only be inserted via the dialog box of the ribbon
command Insert | group Text | SmartText.

Tip: The option "Expand SmartText entries" can also be enabled or disabled in this dialog box.

"Special replacements" section

TextMaker can trigger some special characters automatically as soon as you type a certain combination of
characters in your text. For example, three dots in a row ("...") are converted to ellipsis points. Enable or disable
the desired options in this section.

Tip: On the ribbon tab Insert | group Text you can use the commands Character and Symbol to find other
common characters and symbols that you can insert manually into your text.

Smart quotes

TextMaker can automatically convert double quotes (") and single quotes (') as they are typed to ensure that
they are typographically correct for the selected language. Here, set the desired language or select "None" if
you want TextMaker to leave your quote marks unchanged.

If, for example, you type "Text" or 'Text', the relevant setting will produce the following results:

Setting "Text" 'Text'

Auto*

None (no change) "Text" 'Text'

German „Text“ ‚Text‘
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Swiss German »Text« ›Text‹

English “Text” ‘Text’

French** «Text» ‹Text›

Swedish ”Text” ’Text’

Polish „Text” ‚Text’

* A special position is assumed by the option Auto: If you select this option, TextMaker automatically
determines the language and converts the quotes accordingly. This means that either the default language
specified on the Language tab in File | Options  is used or the language specified on the Font tab in the dialog
box of the command group Home | Character .

** For the single quote in the French setting, please note the following: the closing quote is first executed as an
apostrophe ('). If you press the single quote on the keyboard once again, it will be converted into the single
guillemet (›).

Tip: You can use the command Undo  (or the key combination Ctrl+Z) to convert smart quotes into
"neutral" quotes immediately after typing. The simple smart quote then becomes an apostrophe, while the
double smart quote becomes a normal double quote.

Automatically add spacing around punctuation marks (French only)

Enable the option to automatically add spaces both before punctuation marks : ; ! ? as well as between quotes «
text » ‹ text ›. This option is only effective if French is the assigned language in the following settings:

§ In the dialog box of the command File | Options, Language tab: French 

§ Also in the dialog box of the command group Home | Character  on the Font tab: French or Default

"Formatting corrections" section

§ Format URLs as hyperlinks 

If this option is enabled, URLs (web page addresses) are automatically formatted as hyperlinks immediately
after entering them.

If, for example, you type "www.softmaker.de" in the text, it will automatically be converted into a clickable
hyperlink and displayed accordingly (usually blue and underlined).

§ Superscript ordinal numbers

This option only supports the following languages: English, French, Italian, Portuguese and Spanish.

In these languages, superscripts are usually added to abbreviated ordinal numbers – for example 1st, 2nd, 3rd

in the English language.

If this option is enabled, superscripts are added automatically whenever you enter such a number. If, for
example, you type "2nd" in an English text and then press the space bar, it will be automatically reformatted
as "2nd" – the "nd" will be converted into a superscript.
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Note: This option only works with text in one of the supported languages. For information on how to set
the language of text, see Setting the language.

Auto correction tab

If the  Automatically correct common typos function is enabled on the Options tab, common typos can be
corrected automatically by TextMaker.

On the Auto correction tab, you will find a list where you can enter typical typos and their corresponding
correct spelling. An extensive list is already provided for many languages.

You can add new word pairs to this list, or edit or delete existing word pairs.

Note: The list is automatically linked to the language in which your current text section is formatted. For
more information, see Setting the language. However, you can also edit the lists for other languages
independently at the top of the Auto correction tab.

Add new word pairs to auto correction

1. On the Auto correction tab, click in the Replace field and enter the term here as you typically misspell it.

2. Then click in the With field and enter the correct spelling for this term here.

3. Click on the Add button.

Add further word pairs to this list in this way.

The newly added terms are now included in the auto correction list and the incorrect spelling will be
automatically corrected with the right spelling in future.

Tip: Alternatively, you can also create a new word pair if you have enabled Checking the spelling as you type.
In this case, a word that TextMaker does not know will be underlined in red by the spell checker. If you want
auto correction to correct this word in future, right-click on the word and select Add to Auto correction in the
context menu. In the following dialog box, you can add the new word pair to your auto correction list.

Edit existing word pairs

1. On the Auto correction tab, click on the word pair that you want to change in the lower list.

2. In the Replace and With fields, adjust the incorrect and correct spelling to your liking:

If you change something in the Replace field (left side, for the wrong spelling), pressing the Add button will
add the new word pair to the auto correction list. The original word pair also remains in the list.

If you change something in the With field (right side, for the correct spelling), pressing the Replace button
will overwrite the original word pair in the auto correction list.
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Delete word pairs

1. In the lower list on the Auto correction tab, click on the term that should no longer trigger an automatic
correction.

2. Click on the Delete button.

The term is deleted and will not be detected by auto correction in future.

First letter tab

If the Auto correction function Capitalize first letter of sentences is enabled on the Options tab, TextMaker
automatically capitalizes the first letter at the beginning of a sentence – even if you have accidentally typed a
lowercase letter.

Here, on the First letter tab, you can set exceptions to this rule: 

This applies, for example, to abbreviations such as "amt.", "fig.", "p.m.", which end with a period and thus
indicate the end of a sentence without actually being one. Thus, there is no desire here for TextMaker to
automatically capitalize the next word.

Enter the appropriate abbreviations in the exception list on the First letter tab. An extensive list is already
provided for many languages.

You can add new entries to this list or delete existing entries.

Note: The list is automatically linked to the language in which your current text section is formatted. For
more information, see Setting the language. However, you can also edit the lists for other languages
independently at the top of the Auto correction tab.

Initial Caps tab

If the auto correction function Correct first Two UPpercase LEtters is enabled on the Options tab,
TextMaker automatically corrects the case of words whose first two letters have been capitalized inadvertently.

Here, on the Initial caps tab, you can set exceptions to this rule:

This applies, for example, to terms such as "BSc", "DAdmin", "CDs", where it is not at all desirable for the
combination of two capital letters at the beginning of the word to be corrected.

Enter the appropriate terms in the exception list on the Initial caps tab. An extensive list is already provided for
many languages.

You can add new entries to this list or delete existing entries.
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Note: The list is automatically linked to the language in which your current text section is formatted. For
more information, see Setting the language. However, you can also edit the lists for other languages
independently at the top of the Auto correction tab.



400Language tools

SmartText
TextMaker's SmartText function can save you a lot of work: You can create SmartText entries for frequently
used phrases and then insert them instantly in the text.

For example, create a SmartText entry called "req" with the content "We were delighted to receive your
request". You can now retrieve this SmartText entry at any time: To do so, simply type "req" in the text and
then press the space bar, the Enter key¿ or a punctuation mark. The abbreviation "req" will be replaced
immediately by "We were delighted to receive your request".

In this way, you can create your personal "computer steno" with TextMaker and save a lot of time when typing.

In this section, you will learn about working with SmartText entries:

§ Creating SmartText entries 

New SmartText entries can be created in a dialog-box-controlled manner with the ribbon command Insert |
group Text | SmartText or via the spell check. Each SmartText entry must have a name (for example, "req")
and the desired content (for example, "We were delighted to receive your request").

§ Inserting SmartText entries 

If the option Expand SmartText entries is enabled in the program settings, SmartText entries can be
inserted very easily: To do so, type the name of the SmartText entry and then press the space bar, Enter¿ or
a punctuation mark. The name will be immediately replaced by the content of the SmartText entry.

Alternatively, entries can be inserted manually with the ribbon command Insert | group Text | SmartText.

§ Editing SmartText entries 

Not only can you create new SmartText entries with the ribbon command Insert | group Text | SmartText,
but you can also edit, format, rename or delete existing ones.

For more information, see the following pages.

Creating SmartText entries

You can create SmartText as follows:

For example, to create a SmartText entry called "req" and the content "We were delighted to receive your
request", proceed as follows:

1. Choose the ribbon command Insert | group Text | SmartText .

2. Click on the New button to create a new SmartText entry.

3. Give the SmartText entry a name ("req" in our example).

The SmartText entry can be retrieved later by its name.

4. Confirm with OK. You now return to the main dialog box.
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5. Now, type the text for the SmartText entry in the large input field on the right (in our example: "We were
delighted to receive your request").

6. If you want TextMaker to remember the formatting of the SmartText entry, you must enable the option
Apply formatting. You can now use the miniature formatting toolbar above the input field to set the font,
text styles and color.

7. Click on Save to save your new SmartText entry.

8. Exit the dialog box with Close.

The SmartText entry has now been created. You will find out how to insert it in the next section (Inserting
SmartText entries).

Inserting SmartText entries

You can now insert the SmartText entry created in the previous section at any time.

This is very simple: Type the name of the SmartText entry in the text – "req" in our example – and then a space,
a punctuation mark or Enter¿. TextMaker will immediately replace "req" with the content of the SmartText
entry: "We were delighted to receive your request".

Note: If this does not work, the option Expand SmartText entries is disabled. Choose the ribbon command
Review | Auto correction and enable this option again in the dialog box (or in the dialog box of the
command Insert | group Text | SmartText).

Alternatively, you can access the defined SmartText entries via the dialog box by choosing the ribbon command
Insert | group Text | SmartText, selecting the desired SmartText entry on the left side of the dialog box, and
then clicking on the Insert button.

In this context, the option Apply formatting means the following:

Off: This option is disabled by default. The SmartText entry is thus inserted without formatting – i.e., in the
currently selected font.

On: If this option is enabled, however, the SmartText entry is inserted in the font and font size that you set in
the dialog box when creating the entry. Text styles and font color are also reproduced.

Tip: Do not expand SmartText entries

If you do not want a defined SmartText entry to be inserted when you type in the text, then use the key
combination Alt+. (period) in the place directly behind the SmartText entry. In this case, the specified addition
is then suppressed.
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Editing SmartText entries

By choosing the ribbon command Insert | group Text | SmartText , you can still edit the already created
SmartText entries via the dialog box:

§ Creating a new SmartText entry 

Click on the New button to create a new SmartText entry in the dialog box. For more information, see
Creating SmartText entries.

§ Deleting a SmartText entry 

To delete a SmartText entry, select it in the list SmartText entries on the left of the dialog box and then
click on the Delete button.

§ Renaming a SmartText entry 

To change the name of a SmartText entry, select it in the list on the left, and click on the Rename button.
The program displays a dialog box in which you can enter the new name.

§ Editing a SmartText entry 

To edit an entry, select it in the list on the left and then click in the large input field on the right of the dialog
box. You can now change the content of the SmartText entry.

Furthermore, you can change the formatting by using the miniature formatting toolbar above the input field.
Of course, this only works if the option Apply formatting has been enabled.

When you have made the desired changes, click on the Save button.

§ Inserting a SmartText entry 

To insert a SmartText entry into the text, select it in the list on the left of the dialog box and click on the
Insert button. For more information, see also Inserting SmartText entries).

You can finally exit the dialog box with the Close button. If the enabled SmartText entry has been changed but
not yet saved, TextMaker will ask automatically if it should save the changes.
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Thesaurus

In the iOS version, the command is locked. (To unlock the command, see Welcome.)

You can use the ribbon command Review | group Language tools | Thesaurus  to instruct TextMaker to
display synonyms (terms with the same or similar meaning) for a word.

This function can help you express yourself precisely and avoid repetition. Even if you have a large vocabulary,
the thesaurus may still find alternative words. This function is particularly useful for foreign languages.

A particularly large thesaurus is available for German. It was created under the guidance of a renowned German
linguist over many years and contains no less than 400,000 synonyms. It would be hard to find a more
comprehensive thesaurus in any other word processor.

Thesaurus dictionaries are also available and are pre-installed for many other common languages.

Note for Android/iOS: In these versions, the thesaurus dictionaries are not pre-installed. As soon as you access thesaurus, the program
will ask you if you want to install the dictionary for the current language.

Using the thesaurus

To open the thesaurus, type a word or move the text cursor to an existing word.

Then choose the ribbon command Review | group Language tools | Thesaurus .

TextMaker now searches for the word in the thesaurus. If the word is not found, words with similar spellings
are displayed for selection. Otherwise, synonyms for the word are displayed.

Note: If a word has several meanings, several entries are displayed in the list Meaning. First, select the
desired meaning and then view the corresponding synonyms that appear in the list Synonyms as a result.
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You can now click to select a word from the list Synonyms and then choose one of the following functions via
the buttons:

Look up This option looks for alternatives to the selected synonym.

Replace This option replaces the word in the text with the selected synonym.

Close This option exits the thesaurus.

Changing language for the thesaurus

Thesaurus dictionaries are available and are pre-installed in TextMaker for several common languages. Usually,
the thesaurus opens in the language you have set as the Default language. If you change the default language,
you can use the thesaurus in another language.

Apart from this setting, the thesaurus will open in a different language provided you have formatted the text
accordingly. To do so, proceed as follows:

On the ribbon tab Review | group Spelling | Change language , change the language for the selected text.
Alternatively, click on the language field in the status bar.

If you now access the thesaurus, it will open in the language in which your text is formatted.

Note: Formatting the text in this way also changes the language for spell checking and hyphenation of the
selected text.
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Translation

This feature is only included in SoftMaker Office NX Universal. It is not available in the Android or iOS
version.

With the ribbon command Review | Translation in TextMaker, you can translate individual text sections or
even an entire document into the language of your choice in an instant.

Note: The translation is done by the online translation service DeepL rather than done locally on your computer. You must thus be
connected to the Internet to use the translation feature.

To translate your text, proceed as follows:

1. In your document, select a passage of text up to the point where you want the translation to end. If you want
to translate a single paragraph, simply place the text cursor in the corresponding paragraph.

If you want to translate the entire document, you do not have to select anything.

2. Then choose the ribbon command Review | group Language tools | Translation , which will open a
dropdown menu.

3. Enable the option Translate selected text here to translate the selected text section (or the option Translate
paragraph if you have selected a single paragraph).

If you want to translate the entire document, enable the option Translate document here.

4. Now select the Source language in the dropdown menu.

Note: The option Automatic uses the default language set for your TextMaker document or the language in
which your text is formatted. For more information, see Setting the language. If the text to be translated is in
a different language, select the appropriate language manually in the list Source language. With the entry
More, you can open an extended list with all languages that are available in TextMaker.

5. Then select the desired translation language from the list Target language in the menu. You will also find
an extended list here with all available languages via the entry More.

Tip: Alternatively, you can open a dialog box via the menu entry Settings. The source language and the
target language can also be selected here – clearly arranged next to each other.

6. Finally, click on Translate now in the dropdown menu.

The selected passage of text is then replaced by the translated text in the target language.

Note: If you have selected the option Translate document, you will be prompted to save the translation as a
new file. (TextMaker will suggest the original file name with an abbreviation at the end.) This step protects
you from accidental data loss, as the translation action cannot be undone if you translate the entire document.

If you have only translated individual passages of text, you can continue working in the original document.
Since this translation action can be undone, it is not absolutely necessary to save the translated text separately
as a new file.
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Research

This feature is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

You can use the Research function to look up the meaning of the terms you selected in TextMaker directly in
online dictionaries and encyclopedias. TextMaker suggests various online research platforms (Wikipedia,
Oxford dictionary, Cambridge dictionary, etc.) that you can open interactively for your search.

To do so, proceed as follows:

1. Select one or more terms in your document.

2. Choose the ribbon command Review | group Language tools | Research .

3. In the dropdown menu, click on the desired platform on which you want to look up your research term.

The selected online platform will then be opened directly with the results for your selected term.

Available categories

In the open dropdown menu of the Research icon , you can choose from the following categories:

§ Recently used 

The platforms most recently used by the research function are displayed here for quick access again (the last
3 searches).

§ English (depending on the selected language)

General reference books are displayed here in the language you selected in the settings (see "More" below).

§ German - English (depending on the selected languages)

If you have selected multiple languages in the settings (see "More" below), this category will appear with
translation platforms corresponding to the selected languages.

§ More

You use the entry More to open a dialog box with the settings. Here, you specify the languages for which
TextMaker should suggest research platforms to you. Enable the desired language(s) by clicking on the
respective checkbox.

This results in the menu of the Research icon displaying the general reference books and translation
platforms for all languages you selected, insofar as they are available in these languages.



407Language tools

SmartChat

This feature is only included in SoftMaker Office NX Universal. It is not available in the Android or iOS
version.

The ribbon command Review | SmartChat allows you to create AI-based texts. TextMaker uses the
capabilities of artificial intelligence (AI), which tries to understand a human question in order to generate a
meaningful human-like response.

Note: The processing is performed by the online service ChatGPT rather than performed locally on your computer. You must thus be
connected to the Internet to use this feature.

Choose the ribbon command Review | group Language tools | SmartChat  and select from among the
available uses of the AI in the menu that appears:

Summarize text

This option lets the AI summarize your text. In the open dialog box, choose whether you want to summarize
only the text section (which you must have selected beforehand) or your entire document.

Specify the appropriate text length and the desired output language for the summary, and then click on the
Summarize button. If you don’t like the summary, press this button again to obtain another result – the
previous text will be overwritten.

Insert the result directly into your open document using the Insert button. If you have chosen Whole document,
the result will be inserted at the cursor position. If you have chosen Selected text, the result will replace the
selection.

Alternatively, you can copy the result to the clipboard using the Copy button and then paste it into TextMaker
or into another program.

Write a story

You can instruct the AI to write an article using the keywords you suggest. In the open dialog box, enter the
topics relevant to your article.

Choose the text style, an appropriate text length and the desired output language of the article you want to
create. For some languages that use different types of personal pronouns depending on the desired formality (in
German, for example, it is the formal "Sie" versus the informal "Du"), the appropriate Formality can also be
set.

Click on the Write story button to create the text. If you don’t like the result, press this button again to obtain
another suggestion – the previous text will be overwritten.

Insert the result directly into your open document using the Create button. The result will be inserted at the
cursor position.

Alternatively, you can copy the result to the clipboard using the Copy button and then paste it into TextMaker
or into another program.
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Improve style and grammar

Use AI to improve the style and grammar of the existing text in your document. In the open dialog box, choose
whether you only want to check the text section (which you must have selected beforehand) or your entire
document.

You can have the text improved in the current language or choose another language into which the text should
be converted. If you don’t like the suggestion, press the Suggestions button again to obtain another result – the
previous text will be overwritten.

Insert the result directly into your open document using the Insert button. If you have chosen Whole document,
the result will be inserted at the cursor position. If you have chosen Selected text, the result will replace the
selection.

Alternatively, you can copy the result to the clipboard using the Copy button and then paste it into TextMaker
or into another program.

Review text

Use AI to evaluate the existing text in your document with regard to its readability:

§ The AI analyzes the comprehensibility of the existing text. 

§ Suggestions for improvement are offered to make the text easier to understand.

§ The school level required to understand the text is assessed.

In the open dialog box, choose whether you only want to check the text section (which you must have selected
beforehand) or your entire document.

You can output the result of the analysis in the current language of your text or select a different language in
which to formulate the result. If you don't like the result of the analysis, press the Review button again to get
another result. The previous result will be overwritten.

Insert the result of the analysis directly into your open document using the Insert button. If you have chosen
Whole document, the result will be inserted at the cursor position. If you have chosen Selected text, the result
will replace the selection.

Alternatively, you can copy the result of the analysis to the clipboard using the Copy button and then paste it
into TextMaker or into another program.

Talk to the AI

Enter into a direct dialog with the AI-driven module and receive an AI-based response to a question you have
asked.

The response will be written in the language in which your question was formulated. If you press the Answer
button again, you will obtain another result – the previous answer will be overwritten.

Insert the result directly into your open document using the Insert button. The result will be inserted at the
cursor position. If text has been selected in your document, the result will replace the selection.

Alternatively, you can copy the result to the clipboard using the Copy button and then paste it into TextMaker
or into another program.
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Read aloud

This feature is only available in SoftMaker Office Professional and NX Universal and is only supported
for the Windows version. It is not available in the versions for Mac, Linux and Android/iOS.

The ribbon command Review | Speak lets all or part of the text in your TextMaker document be read aloud to
you. This is also possible for text included in tables or form objects.

If you are working with different languages in your document, format the text in the desired language on the
ribbon tab Review | group Spelling | Change language beforehand. For more information, see Formatting text
in another language. This allows TextMaker to recognize which language should be used for reading aloud.

To have the text read aloud, please proceed as follows:

1. Place the cursor at the point where you want TextMaker to start reading aloud.

Note: If only part of the text is to be read aloud, select this text section.

2. Choose the ribbon command Review | Speak , the Text-to-speech module will open.

3. If necessary, click on the Options button before playback to adjust the settings for the speech output. For
example, you can add the language pack required for a language in the dialog box if this language has not
yet been installed in the Windows language settings. For more information on this and the other options in
the dialog box, see the paragraph "Text-to-speech options" below.

4. Press the arrow button  to start. Adjust the Volume and Speed as needed by using the sliders.

The button  pauses the reading aloud. Press  again to continue.

The button  jumps to the previous paragraph and  jumps to the next paragraph.

The button  stops the reading aloud. If you now start again with , the reading aloud resumes wherever
the cursor is positioned or at the beginning of the selected text section.

5. Click on Close to exit the Text-to-speech module.

Text-to-speech options

If you click on the Options button in the Text-to-speech module, the program opens a dialog box in which you
can make settings for the speech output.

The following options are available:

§ "Tables" section 

The program not only reads out the normal text passages in your document but also text that is included in
tables. For this purpose, you can choose between two methods of reading tables.
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Speak cells by row: After the first cell of the table has been read out, TextMaker jumps to the cell to the
right of it for further reading. Once the last cell in the horizontal direction is reached, the program jumps to
the next row and continues there with the cell on the far left.

Speak cells by columns: After the first cell of the table is read out, TextMaker jumps to the cell below it for
further reading. Once the last cell in the vertical direction is reached, the program jumps to the next column
and continues there with the top cell.

§ "Options" section

Spell numbers: With this option enabled, numbers are pronounced distinctly to make it easier to recognize
the occurrence of a number. This option is very useful for enumerations with numbers, for example.

Spell punctuation: Enable this option if you want the separators and punctuation marks (. ; , ? ! – "" etc.) to
be expressed as in dictation to make it easier to recognize them.

§ Language/Voices

There are different voices available for reading aloud. In the list Language, first select the language for
which the available voices are to be displayed. Then click on the desired voice for this language in the list
Voices below.

If necessary, click on the Add Installed Voices button to add more voices to the list.

§ New language packs

TextMaker can only read aloud texts in the languages that have been installed in the Windows language
settings. If the language required for reading aloud is missing here, you can access the Windows language
settings directly via the New language packs button. Add the missing language in the "Preferred languages"
section.
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Database
TextMaker has an easy-to-use SQLite-compatible and dBASE-compatible database module that is seamlessly
integrated into the word processor. This provides all the functions you need to manage addresses and other
information. You can enter and edit data, search for specific data and much more.

Note: When editing a database, TextMaker creates an additional file with the extension username.selx.
This contains information about the structure of the database (for example, the selected character set,
selected records for a mail merge, etc.) and must thus always be moved when changing the storage location if
you want to access this information. 
When moving the database to another computer, it is also necessary to adjust the user name in the file
extension to the user name of the computer.

In this chapter, you will learn everything you need to know about working with databases in TextMaker.

§ Opening a database 

In the first section, you will learn how to open a database. The ribbon command Mailings | group Database
| Edit database is responsible for this option.

§ Creating a new database 

Although the supplied addressbook.sqlite database is sufficient for many users for managing their
addresses, TextMaker allows you to create new databases in SQLite or dBASE format at any time. You will
learn how to do it in this section.

§ Using the database module 

You will then become familiar with the powerful database module that is integrated into TextMaker. This
module allows you to edit databases and also includes several advanced database functions – for selecting,
sorting and deleting records, for example.

§ For advanced users: Changing the database structure 

You can change the structure of existing databases at any time. For example, you can add/delete fields or
change the properties of fields (name, type length, etc.).

§ Importing individual addresses (via document templates) 

Here, you will learn how easy it is to write everyday documents with TextMaker: You choose the command
File | New and select one of the letter templates supplied with the program. The database then appears.
Simply select the desired addressee, click on Insert and TextMaker will create a fully completed letterhead
for you.

§ Creating lists and labels 

Lists and labels can also be easily produced with TextMaker. In the case of address labels, for example, you
select the desired database and place the database fields in the desired arrangement in a large input field.
You then select the format of the labels from a list and that's it – printing can begin.
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§ Printing envelopes 

You can also print envelopes in a similar manner. All you have to do is to select the paper format of the
envelope and specify the sender and recipient.

§ Mail merge (see next chapter) 

Creating mail merges in TextMaker is surprisingly easy: You create a normal letter, place database fields in
it and select the database records to be printed. The mail merge can then be printed. For more information,
see Mail merge.

Opening a database

To open a database, choose the command Edit database  on the ribbon tab Mailings | group Database. The
program displays a file dialog in which you can select which database to open.

The following formats are supported:

File extension Description

*.sqlite or *.db Databases in SQLite format. The SQLite format is a modern and widely used database format in
which you can store several tables in one file.

*.dbf Databases in dBASE format. The dBASE format is a widely used database format that is still
supported by many database programs today.

*.pmdx Open data from a PlanMaker file as a database (read-only, cannot be edited).

*.xlsx Open data from an Excel file as a database (read-only, cannot be edited).

*.txt or *.csv Open data from a text file as a database (read only, cannot be edited).

Depending on which file format you have chosen to open a database, the program will display another dialog
box (for example, for selecting the desired table, a suitable character set, etc.). Notes on the file format options
can be found below.

Once you have selected your options, the records will be opened in the database module. Here, you can
navigate between the records of the database and edit them. For more information, see Using the database
module.

Notes on the database format SQLite

TextMaker can open all SQLite databases in the formats .sqlite and .db.

After you have opened an SQLite database with the aforementioned command Edit database, another dialog
box appears if the database contains several tables (which is quite possible with SQLite databases). In this case,
select the desired table as the data source and confirm with OK.

If the SQLite database consists of only one table, this dialog box is skipped.
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Notes on the dBASE database format

TextMaker can open all databases in dBASE format.

After you have opened a dBASE database (.dbf) with the aforementioned command Edit database, another
dialog box may appear. It provides you with various character sets for opening your database. Depending on
which character set is used in your dBASE database, you may need to select a suitable character set.

The following character set variants are supported:

Character set Description

dBASE/DOS Databases with DOS character set.

dBASE/Windows Databases with Windows character set: Western Europe or Cyrillic (for the Russian alphabet).

dBASE/Unicode
(UTF-8)

Databases with Unicode character set. This is a variant of the dBASE format developed by
SoftMaker that also supports complex character sets (for example, Asian scripts). However, such
databases can only be edited with a few programs (apart from SoftMaker Office).

In the dialog box, select the desired character set from the list and confirm with OK.

Tip: If you are not sure which character set is used by the database to be opened, first select a character set from the top list of the dialog
box and look in the preview window to see whether accented characters (for example, umlauts) are displayed correctly. If this is not the
case, try a different character set.

Notes on PlanMaker and Excel files

If you want to use records from a PlanMaker or Excel file for a database, another dialog box appears after you
choose the aforementioned command Edit database. Here, you can select the worksheet in which the desired
records are to be found.

In the dialog box, you can also specify whether the first row of the PlanMaker/Excel file contains column
headings for the records. In this case, enable the option First row contains field names so that the headings in
the database are used as field names. If there are no column headings for the records, disable the option.
TextMaker will then assign automatically generated field names "Field1", "Field2", etc.

Note: Records from PlanMaker or Excel files can only be displayed in the database module. Editing is not
possible here.

Notes on text files

If you want to use records from a text file (.txt or .csv) for a database, another dialog box appears after you
choose the aforementioned command Edit database. You can select the appropriate character set and set
further options:

Character set: Here, specify the character set to be used to open the database.

Tip: If you are unsure as to which character set to use, first select a character set from the top list of the dialog box and check in the
preview window whether accented characters (for example, umlauts) are displayed correctly. If this is not the case, try a different
character set.
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First row contains field names: If the first line of the text file contains headings for the records, the headings
are used as field names in the database if this option is enabled. If no headings are included, disable the option.
TextMaker will then assign automatically generated field names "Field1", "Field2", etc.

Separator: Here, you define which separator character separates the individual values in the text file from each
other. The entry User-defined can be used to define additional characters.

Text marker: If the values in your text file are surrounded by text markers (double or single quotation marks),
you can suppress the inclusion of these characters in the database by selecting the appropriate option. With the
None option, the text markers are included in the database in addition to the values.

Note: Records from a text file can only be read in the database module. Editing is not possible here.

Creating a new database
Not only can you use existing databases with TextMaker, but you also create new databases – both in SQLite
format and in dBASE format.

SQLite: The SQLite format is a fast, flexible and widely used SQL database that you can access locally (i.e.
without the usual database server). Several tables can also be created in a SQLite database.

dBASE: The dBASE format is a database format that is still supported by many database programs.

Use the ribbon command Mailings | group Database | New database  to create a new database and follow
the descriptions of one of the following sections depending on the desired database format:

§ Creating a new SQLite database 

§ Creating a new dBASE database 

Creating a new SQLite database

To create a new SQLite database (.sqlite), proceed as follows:

1. Choose the ribbon command Mailings | group Database | New database .

2. Select the entry "SQLite database" from the list Save as type in the file dialog.

3. Create your own file name, select a storage location and confirm saving it.

Note: If you want to create an additional table in an existing SQLite database, select the desired SQLite
database to which you want to add the new table.

4. The following dialog box appears. If necessary, change the proposed table name.

5. Now create the first database field:
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Enter a unique name for the field under Name and select a suitable field type for Type. For more detailed
explanations of the field types, see below.

Default value: If you want to create a new field that outputs a fixed value for all records, you must type this
value here as the default value. As a result, each record contains the same content specified here for this
field.

Values must be unique: If you enable this option, you specify that the record values for the relevant field
may only occur once in all records. This is particularly useful if you want to assign a unique key (an ID) in a
field for each record, for example, when creating customer numbers.

Tip: In the list Fields, you can read the selected information for each field.

6. Once you have made all the specifications for a field, click on Append to add the new field after the last
field. If other fields are already defined, you can also click on Insert to insert the new field ahead of the
current field.

7. Repeat steps 5 and 6 for each additional field to be included in the database.

Tip: If you make an error when specifying the field name, field type, etc., and only notice this fact after you
have clicked on the Append button, you can go back and correct the error. Click on the relevant field in the
list Fields, correct your entries below and click on Replace. You can also delete fields that were created
incorrectly by choosing Delete.

8. When all desired fields have been entered, click on the Create button.|

The database has now been created. You can now close the database or, if necessary, perform further steps on
the open database in the database module. For more information, see Using the database module.



416Database

With the command Change structure  in the database module, the structure of the created database can be
changed retroactively at any time. For more information, see Changing the database structure.

Notes on the field type

The option Type in the above dialog box allows you to specify the field type of a field. This determines the type
of data to be entered in the field. The following field types are possible:

Field type Allowed entries

TEXT Text fields allow any type of input.

REAL NUMBER Fields for (real) numbers only accept numbers as input, and even decimal numbers are allowed
here. You can even perform calculations with the content of such fields. For more information, see
Calculations in the text.

INTEGER Fields for integers only accept numbers as input, and decimal numbers are not allowed here. As
above, you can also perform calculations with it.

LOGICAL Logical fields (Bool) are intended for Yes/No entries. The allowed entries are limited to Y for Yes

or N for No.

DATE Date fields are intended for dates.

TIME Time fields are intended for times.

DATETIME A combination of the Date and Time fields.

LONG TEXT This field for long text behaves in a slightly different manner to "normal" fields. It allows any input
and is intended for entering additional notes for a record. Several lines are also possible. Long text
fields can only be viewed and edited in the database, as these types of fields cannot be inserted into
documents or printed.

BINARY Binary fields allow arbitrary, unstructured data objects, such as image files or programs

Tip: For numbers such as phone numbers, zip codes, etc., select the "TEXT" field type. Here, numeric fields
like "INTEGER" or "REAL NUMBER" are of no advantage – on the contrary: If you try to enter a phone
number like "001-555-5555" in a numeric field, TextMaker will not allow the "-" because only numbers are
allowed; furthermore, the leading zeros will be automatically removed.

Creating a new dBASE database

To create a new dBASE database (.dbf), proceed as follows:

1. Choose the ribbon command Mailings | group Database | New database .

2. Select "dBASE" from the list Save as type in the file dialog.
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3. Create your own file name, select a storage location and confirm your entry.

4. The following dialog box appears: If necessary, change the character set. For further explanations, see
below.

5. Now create the first database field:

Enter a unique name for the field under Name and select a suitable field type for Type. If necessary, enter
the desired Length and the number of decimal places for Dec.. For further explanations, see below.

6. Once you have made all the specifications for a field, click on Append to add the new field after the last
field.

If other fields are already defined, you can also click on Insert to insert the new field ahead of the current
field.

7. Repeat steps 5 and 6 for each additional field to be included in the database. You can create a maximum of
254 fields, but the total length of all fields must not exceed 4000 characters.

Tip: If you make an error when specifying the field name, field type, etc., and only notice this fact after you
have clicked on the Append button, you can go back and correct the error. Click on the relevant field in the
list Fields, correct your entries below and click on Replace. You can also delete fields that were created
incorrectly by choosing Delete.

8. When all desired fields have been entered, click on the Create button.

The database has now been created. You can now close the database or, if necessary, perform further steps on
the open database in the database module. For more information,? see Using the database module.

With the command Change structure  in the database module, the structure of the created database can be
changed retroactively at any time. For more information, see Changing the database structure.
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Notes on the field type

The option Type in the above dialog box allows you to specify the field type of a field. This determines the type
of data to be entered in the field. The following field types are possible (the maximum permissible field length
in parentheses):

Field type (length) Allowed entries

Character (1 to 254) Character fields allow any type of input.

Numeric (1 to 19) Numeric fields only accept numbers as input. You can set the desired number of decimal places
with Decimals. You can even perform calculations with the content of such fields. For more
information, see Calculations in the text.

Date (always 8) Date fields are intended for dates.

Logical (always 1) Logical fields are intended for Yes/No entries. The allowed entries are limited to Y for Yes or N
for No.

Memo (always 10) Memo fields behave in a different manner to "normal" fields. They accept any type of input and
allow you to enter additional notes for a record. Memo fields can only be viewed and edited in the
database, but you cannot insert or print these types of fields into documents. Their width is always
given as 10, but you can actually enter up to 4000 characters in each memo field.

Tip: For numbers such as phone numbers, zip codes, etc., select "Character" rather than "Numeric". Numeric
fields are of no advantage here – on the contrary: If you try to enter a phone number like "001-555-5555" in a
numeric field, TextMaker will not allow the "-" because only numbers are allowed; furthermore, the leading
zeros will be automatically removed.

Notes on the supported database formats

The dBASE format is available in different versions. If you use the ribbon command Mailings | New database,
you can select the desired variant via the option Character set in the dialog box shown above.

The following variants are supported:

Character set Description

dBASE/DOS Databases with DOS character set.

dBASE/Windows Databases with Windows character set: Western Europe or Cyrillic (for the Russian alphabet).

dBASE/Unicode
(UTF-8)

Databases with Unicode character set. This is a variant of the dBASE format developed by
SoftMaker that also supports complex character sets (for example, Asian scripts). However, such
databases can only be edited with a few programs (apart from SoftMaker Office).

Note: Most dBASE databases are stored in the format dBASE/DOS. Windows database programs also
generally use the DOS format instead of the Windows format.
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Note on the database format dBASE/Unicode

In addition to the usual formats dBASE/DOS and dBASE/Windows, TextMaker also supports databases in the
format dBASE/Unicode (UTF-8).

This format is a variant of the format dBASE developed by SoftMaker that also supports complex character sets
(for example, Asian scripts). This means that you can also store Chinese text in such databases, for example,
which is not possible with databases in the formats dBASE/DOS and dBASE/Windows.

However, please note the following when using this format:

Important: Databases in the format dBASE/Unicode (UTF-8) are not dBASE-compatible and can only be
edited with a few programs (apart from SoftMaker Office). Thus, you should use this format only if it is
important for this database to support the Unicode character set, for example, to enter Asian scripts in it.

Using the database module
If you open an existing database or create a new database as described in the last two sections, the TextMaker
database module appears.

The database module not only allows you to edit your databases, but also includes several advanced database
functions. This section contains a detailed description of all functions of the database module.

The information covers the following topics:

§ Main window of database module 

§ List and form view

§ Scrolling through records

§ Searching a database

§ Adding and editing records

§ Deleting and restoring records

§ Sorting a database

§ Closing a database

§ For advanced users: Changing the database structure 

See the following pages for more information.
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Main window of database module

TextMaker comes with an example database called addressbook.sqlite. On Windows, this file can be
found in the SoftMaker folder below your user directory.

If you open the database with the command Edit database  (on the ribbon tab Mailings | group Database),
you are presented with a database window.

This database module may look as follows:

The example database addressbook.sqlite (in the form view)

If you see a tabular list of records instead, you can always choose the ribbon command Form/list (in the group
View) to switch between the list view and the form view shown above.

If you like, you can use the example database addressbook.sqlite as your personal address database. It
contains all the database fields needed to store addresses:

On the screen, you can now see the first record of the database, which consists of several fields. A data field is
an information unit, for example, the first name. All information that you enter for a person (salutation, name,
address, etc.) constitutes a record.
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Information in the status bar

In the status bar at the bottom of the program window, you can read the following information:

§ First, the number of the current record (the record number) and the total number of records in the database
are displayed ("Record 1 of X"). 

§ To the right of it, the program displays the following status information: Selected if the record is selected. 

For more information on selecting records, see Selecting data records.

§ On the far right in the form view, you can see the field type of the current field, which determines which
entries are allowed in the field: 

For SQLite:

Field type Allowed entries

Text Any entries

Real Number Real numbers (with decimals)

Integer Integers (no decimals)

Logical Only Y for "Yes" or N for "No"

Date Dates

Time Times

Datetime Combination of dates and times

Long text Any entries for notes (long text)

Binary Unstructured data objects, such as image files or programs

For dBASE:

Field type Allowed entries

Character Any

Numeric Numbers

Date Dates in the format MM/DD/YY (for example, "04/16/18")
or in the format MM/DD/YYYY (for example, "04/16/2018")

Logical Only Y for "Yes" or N for "No"

Long text Any input for notes

§ The maximum length of the field is displayed after the field type. 

Which century? Note when filling in date fields for dBASE: If you enter a two-digit year between 0 and 29,
TextMaker automatically prefixes "20...". For years between 30 and 99, TextMaker prefixes "19...".

The entry "01/01/29" is interpreted as 1/1/2029.

The entry "01/01/30", on the other hand, is interpreted as 1/1/1930.
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Ribbon commands in the database module

The database module contains the following command groups for working with the database:

Command group Description of commands

Edit Use the commands known from Moving, deleting and copying to easily edit the contents of records
(only available in the form view).

Navigation Use the small toolbar to navigate between records (see Scrolling through records) or use the
commands Search/Search again to find specific search terms in the database. For more information,
see Searching a database.

Records Append adds a new record, and Duplicate creates a duplicate of a record. For more information, see
Adding and editing data records.

Delete: This button can be used to temporarily or permanently delete and restore records. For more
information, see Deleting and restoring records.

Sort: This option allows you to rearrange the records of the database. For more information, see
Sorting a database.

Select: Use this button to find commands to limit the records for mail merge printing. For more
information, see Selecting records for a mail merge.

View Form / list view: This option allows you to switch between form view (as shown in the figure above)
and list view. For more information, see List and form view.

Show only selected data records: This option hides all records that are not selected (useful for mail
merge printing).

Update: This option rereads the database in case it was changed by another application as a multi-
user database.

Manage Save as SQLite table: Use this command to convert the open database into SQLite format if the
current database is in an inconvenient format.

Table settings (only available for SQLite): Here, specify which field type should be used for
display: text, number, date, etc. For more information, see Changing the database structure.

Change structure: Here, you can change the structure of the existing database. For more
information, see Changing the database structure.

Windows Here, you can switch to full screen mode or between the windows.

Close database Exit the database module. The database is saved automatically.
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List and form view

The database module can display databases in two different ways:

§ The list view offers the best overview of the database. Here, you see several records listed one after another
in tabular form. 

§ The form view is more useful for viewing individual records. Here, the fields of a single record are displayed
as in a form.

Note: You cannot enter data in list view. This is only possible in form view.

To switch between list and form view, click on the Form / list view button (in the group View). If the button
appears dark, the form view is enabled, otherwise the list view is enabled.

Tip: You can switch very quickly between these two views with the F2 key. Furthermore, a double-click on
a record in list view displays the record in form view.

Scrolling through records

To move between the records of a database, both keys and icons are available in the command group
Navigation of the database module:

Key Icon Function

In form view: PageUpá
In list view: á

To the previous record

In form view: PageDownâ
In list view: â 

To the next record

Ctrl+Alt+PageUpá Go to the previous selected record

Ctrl+Alt+PageDownâ Go to the next selected record

Ctrl+PageUpá Go to the first record

Ctrl+PageDownâ Go to the last record

Accessing a record by its record number

The record number is a simple counter. The first record has the number 1, the tenth 10, etc. The record number
of the current record is displayed at the bottom left in the status bar.
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You can access a record directly in the database module via its record number.

Simply enter the desired record number in the input field of the command group Navigation. The
corresponding record is then opened immediately. (Alternatively: Press the F5 key.)

Note: For information on navigating between the selected records for a mail merge, see also Selecting records
for a mail merge.

Searching a database

You can use the Search icon  (in the group Navigation) to search the database in the database module for a
term.

If you enter a search term and confirm with OK, TextMaker starts searching. As soon as the term is found in a
record, TextMaker displays the record and ends the search process.

Continuing the search

Use the Search again icon  (in the group Navigation) to instruct TextMaker to display the next occurrence
of the search term.

Notes on search terms

Date fields: If you want to search for dates in date fields, you must enter them in the format MM/DD/YYYY –
thus for September 25, 2018, you must type 09/25/2018.

Long text fields: Long text fields cannot be searched via the search function.
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Wildcard searches with "?": By entering one or more question marks within the search term, you can widen the
search. The question mark represents any character. Thus, when you search for "Me?er", you will find "Meyer"
and "Meier", among other names.

Options in the dialog box "Search"

You can use the options in the "Search" dialog box to influence the search as follows:

§ In field 

Select the setting All fields if you want to search all fields in the database. Alternatively, you can select a
specific field if you only want to search this field.

§ Search from beginning 

If this switch is enabled, TextMaker starts the search at the first data record; thus it will search the complete
database. Otherwise, the search starts at the current data record.

§ Search backwards 

If this switch is enabled, the database is searched in reverse record order.

§ Case-sensitive 

If this switch is enabled, the case of the search term is taken into account. A search for "House" would only
find "House" – "HOUSE", "house", etc., would not be found.

§ Search only selected records 

If this switch is enabled, only the selected records are searched, otherwise all records are searched. For more
information, see also Selecting data records).

§ Accuracy 

This option specifies how closely the content of a field must match the search term:

Search term anywhere in the field: This option finds all records in which the search term occurs anywhere
in the fields being searched.

Field begins with the search term: This option finds only those records in which the search term occurs at
the beginning of the fields being searched. If you search for "Fish", only fields beginning with "Fish" will be
found (for example, "Fisher" also), but not fields with the content "Ralph Fisher".

Field matches the search term: Here, the search function finds only records in which the field content
completely matches the search term. Thus if you search for "fish", only fields with the exact content "fish"
will be found, but fields with "fisherman" will not be found.

Adding and editing records

In databases that are in SQLite or dBASE format, you can edit existing records in the database module or add
new records.
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Note: If you have opened a database in other formats (.pmdx, .xlsx, text files), you cannot edit the records.
However, you can save these formats in SQLite format from within the TextMaker database module and then
open and edit them as an SQLite database.

To save such formats, choose the command Save as SQLite table  (in the group Manage of the database
module).

Editing record

Important: Records can only be changed in the form view of the database module. To switch between list
and form view, click on the Form / list view button (in the group View). If the button appears dark, the form
view is enabled, otherwise the list view is enabled.

To edit a record, simply position the text cursor in the desired data field and make your changes. You can move
to the next data field with the Tab key and to the previous data field with Shift+Tab.

Note: To save changes to a record, you do not have to choose any special command, as changes to the
current record are saved automatically when you scroll to another record or exit the database.

Appending a new record

If you want to add an additional entry to your database, choose the ribbon command Append  (in the group
Records) in the database module.

TextMaker adds an empty data record to the database and positions the text cursor in the first field of the
record. You can start filling in the record immediately.

New records are always appended after existing records.

Tip: If you have reached the last record, you can also create a new record with the  key (scroll to the next
record).

Duplicating a record

You can use the ribbon command Duplicate  (in the group Records) to create a duplicate of a record. To do
so, scroll to the desired record and then choose this command.

Duplicated data records are always appended at the end of the database, just like newly created records.

Updating records

The ribbon command Update  (in the group View group) is used to re-read the database in case it has been
changed by an application other than the multi-user database.
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Deleting and restoring records

Records that are no longer needed can be deleted in the database module at any time.

Deleting current record

To delete the current record, choose the ribbon command Delete  (in the group Records) in the database
module. Click directly on the icon itself or use the icon's arrow to access the entry Current record.

However, the record is only marked for deletion and is not deleted immediately. The actual deletion of all

records marked for deletion is done by cleaning up the database via the command Delete  | Clean up
database (see below).

Deleting all selected records

Use the command (Delete) Selected records to select all currently selected records for deletion. This is useful
if you want to delete a large number of records.

To do so, click on the arrow of the Delete icon  and choose Selected records  from the dropdown menu.

For more information on working with selections, see Selecting records for a mail merge.

Restoring deleted records (dBASE only)

You can use the command Delete  | Restore deleted records to deselect all records currently marked for
deletion.

Really removing deleted records (dBASE only)

If you really want to remove all records marked for deletion, let TextMaker clean up the database. The

command Delete  | Clean up database is responsible for this process. After a prompt, it permanently
removes all records marked for deletion from the database file.

Sorting a database

You can also sort databases.

To do so, choose the ribbon command Sort  (in the group Records) in the database module.
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In the dialog box for Field 1, select the field by which you want to sort.

You can also sort by two fields: For example, to sort all records by last name, and the records containing the
same last names by first name, select Name1 under Field 1 and First name under Field 2.

As soon as you confirm with OK, the records are rearranged and the database is saved in the new order.

Note: Sorting physically regroups the records in the database. This action cannot be undone.

Closing a database

If you want to close the database that is currently open, click on the Close database icon  in the database
module. The database is automatically saved and then closed.

For advanced users: Changing the database structure

This section is for advanced users. In general, it is unnecessary to adjust the data structure of existing databases.

For more information on how to create a completely new database, see Creating a new database. You can also
use TextMaker to change the structure of an existing SQLite or dBASE database – for example, add/delete
fields or change the properties of fields (name, type, length, etc.).

To do so, proceed as follows:

1. It is always a good idea to create a backup copy of your database before making changes to its structure.

2. Open the desired database with the command Edit database , as described in Opening a database. The
database module appears.
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3. In the database module in the group Manage, choose the command Change structure .

4. The program displays a dialog box that corresponds to that of the command Create database (see Creating
a new database) and presents all fields in the database. Make the desired changes to the database structure in
the dialog box. For more information, see below.

5. When you are finished, click on the Save button. Use the Cancel button to discard your entries.

Note: If you save your entries in this dialog box by choosing Save, the existing database is overwritten.

Your changes will now be applied. You can now close the database module or, if necessary, perform further
steps on the open database in the database module.

Tip: We recommend that you open the resulting database briefly after closing it and check the result.
Whenever you apply a huge number of changes of all types to a database at once, the contents of certain
fields may not be transferred. In that rare case, restore the backup copy of your database and apply your
changes once more – but this time, do this in multiple steps instead of performing all changes at once.

Using the "Change database structure" dialog box for SQLite

Tip: A list of all available field types, together with their properties, can be found in Creating a new SQLite
database.

The aforementioned dialog box of the command Change structure  can be used as follows:

§ Inserting a new field 

To insert a new field, enter a unique name for the field under Name and choose a suitable field type for
Type.

Once you have entered all relevant information for a field, click on Append to add the new field after the
last field. Alternatively, click on Insert to insert the field above the current field.

§ Changing a field 

To change the properties of a field (name, type, length, etc.), click on the relevant field in the list Fields, and
its properties will be applied to the controls at the bottom of the dialog box. Make the desired changes there
and then click on Replace.

§ Deleting a field 

To delete a field, select it in the list Fields and click on Delete.

Note on the command "Table settings" (available for SQLite only):

In the database module, the group Manage also contains the command Table settings . In the dialog box of
this command, you only change the display of the relevant field type for an SQLite database. Here, you only
determine the way in which fields are displayed, but you do not change the actual database structure. This is
useful if the database was created in another program with different field types.

For more information on the field types, see Creating a new SQLite database.
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Using the "Change database structure" dialog box for dBASE

Tip: A list of all available field types, together with their properties, can be found in Creating a new dBASE
database.

The aforementioned dialog box of the command Change structure  can be used as follows:

§ Inserting a new field 

To insert a new field, enter a unique name for the field under Name and choose a suitable field type for
Type. If necessary, enter the desired Length and the number of decimal places for Dec..

Once you have entered all relevant information for a field, click on Append to add the new field after the
last field. Alternatively, click on Insert to insert the field above the current field.

Note: A database can contain a maximum of 254 fields, but the total length of all fields cannot exceed 4000.

§ Changing a field 

To change the properties of a field (name, type, length, etc.), click on the relevant field in the list Fields, and
its properties will be applied to the controls at the bottom of the dialog box. Make the desired changes there
and then click on Replace.

§ Deleting a field 

To delete a field, select it in the list Fields and click on Delete.
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Importing individual addresses
Why do you usually need a word processing program? Normally, it is because you want to quickly write letters.
TextMaker is a particularly efficient tool for such routine work.

All you need for such tasks is a suitable document template – that is, a document template to which an address
database is assigned and in which database fields are inserted. Some such templates (for personal and business
letters) and a suitable database are supplied with TextMaker.

If you use the command File | New  to create a new document and select such a template, TextMaker
automatically displays the database. Scroll to the desired recipient and click on the Insert button. The rest
happens automatically. TextMaker replaces the database fields in the template with the contents of the fields
from this record – in other words, the address is inserted into the text. The result is a completed letterhead, for
example.

The following pages contain detailed explanations of these procedures.

Notes

Please note the following if you proceed according to the method presented here: When you Insert the selected
record, the database fields in the document are physically replaced by the content of the inserted record. This
means that you have created a document with a fixed record content, but the database fields themselves have
been removed from the document and are thus no longer editable. (You can continue to edit the inserted content
in the document, of course.)

The advantage of this method is that you obtain a personalized letter that can be saved and that does not change
depending on the content of the database.

If you do not want to do this, click on the Close button instead of Insert. You can then edit the database fields
of the document, switch between records, etc., as usual.

Preparing a document template

Note: To easily create a letter, you don't necessarily have to create your own document templates. Numerous
document templates with letterheads and flyers are already supplied with TextMaker. See Using document
templates to learn how you can try them out immediately.

To create a new document template for the insertion of individual addresses, proceed as follows:

1. Choose the ribbon command File | New  and select the Normal.tmvx template in the dialog box to start a
new text.

2. Fill the document with the desired text – for example, prepare a letterhead, a fax form, etc.
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3. Choose the ribbon command Mailings | Select database | Use existing database  to assign the desired
database to this document – for example, the supplied address database addressbook.sqlite.

4. Choose the ribbon command Mailings | Merge field  at the desired points in the text in order to insert
Database fields from the assigned database there. For more information, see also Inserting database fields.

5. Choose the ribbon command File | Save as.

6. Select the entry Template from the dropdown list Save as type.

7. TextMaker switches automatically to the folder for document templates.
Android/iOS: This step is not supported here. Navigate manually to the folder "SoftMaker/TextMaker NX templates".

8. Enter a name for the template under File name and confirm saving it.

In general, you must proceed as if you want to create a mail merge (but without entering the text of the letter),
and then save the merge as a document template.

If you want to learn more about working with document templates, see the basic information in Document
templates. To view an example, you can open one of the document templates supplied with the program.

Using document templates

Using a document template with an assigned database is easy:

Start a new document with the command File | New . In the dialog box of the command, you can specify on
which template this document should be based.

If you select a template that has a database assigned to it, TextMaker displays this database and lets you choose
the record to be inserted into your text. Scroll to the desired record, and then click on the Insert button.

The procedure is as follows:

1. Choose the command File | New  (click directly on the icon itself).

2. In the dialog box, choose a document template that you have created with a database connection or one of
the included templates, and confirm with OK.

3. The program will now open a dialog box in which the corresponding database will be displayed.

Tip: The two options in the bottom right of the dialog box allow you to switch between List and Form view.
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4. Use the buttons     to scroll to the record for the desired recipient.

You can also enter a new address after you create a new record via the Append button.

(For more information on using on this dialog box, see below.)

5. Click on the Insert button.

Note: The database fields in this document will then be physically replaced by the content of this single
inserted record. The database fields themselves will be removed from the document and will thus be no
longer editable. For more information, see also the "Notes" in Importing individual addresses.

As a result, TextMaker will now replace each database field in the template with the content of the
corresponding field from this record.

This results, for example, in a fully completed letterhead including the address of the letter recipient. All you
have to do now is write the letter and then print the document. To do so, choose the ribbon command File |
Print – and not File | Print merge.

Tip: In the dialog box of the command File | New, you can also see some folders. They contain prepared
document templates for writing letters. Most of these templates have been assigned to the supplied example
database addressbook.sqlite.
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The dialog box shown above has the following controls:

Data display

Most of the window is devoted to the display of data.

You can view the data either in tabular form in the list view or in more detail in the form view. To select the
desired view, click on the option List or Form in the lower part of the window.

Important: Note that the data can only be edited in the form view.

You do not have to choose a command to save changes to the data, as changes to the current record are
automatically saved when you browse to another record or exit the database.

Filter

You can filter the records if necessary. To do so, enter a search term in the Filter input field and click on the
Apply button. The display of data changes immediately and only records that contain the search term (in any
data field) are displayed.

If, for example, you filter by "Jones", only records are displayed where one of the fields contains the term
"Jones".

Use the cross icon  to remove the filter.

"Insert" button

This option inserts the content of the current record into the document. It is only available if the database was
accessed via a template as described above.

"Close" button

This option closes the database. All changes to the database are automatically saved.

"Search" button

This option opens a dialog box that allows you to search for specific data more accurately than with a filter (see
above). For more information on this dialog box, see Searching a database.

Button "Search again"

This button displays the next record containing the search term.

"Append" button (SQLite and dBASE only)

This option appends a new record to the database.

Note: This is not possible for databases from PlanMaker, Excel or text files. They are read-only.
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"Manage" button (SQLite only)

This option opens the dialog box Table settings, where you can customize the display of the selected field type
for SQLite databases. Here, you only determine the way in which fields are displayed, but you do not change
the actual database structure.

The options of the dialog box correspond to those of the command Table settings  in the group Manage of
the database module. For more information, see Changing the database structure.

List/Form

You can use the options List and Form to switch between the list view (several records listed one after another)
and the form view (a complete record in detail).

Tip: Where can I see which database is assigned?

To find out which database is assigned to your current document template, you have the following option: After
you have inserted the record as described above, you can open the database module by choosing the ribbon
command Mailings | group Recipients | Select recipients. Here, you can see the name of the assigned database
in the title bar and in the tab.

Exit the database module again by clicking on the Close database icon . For the purposes described in this
section, you do not need to work with the database module. If you want to learn more about using the database
module, however, see Using the database module and Selecting records for a mail merge.
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Creating lists and labels

You can use the ribbon command Mailings | group Create | List/Label  to create lists and labels of all kinds
with minimal effort. This command is primarily intended for creating address labels. The corresponding
addresses should be available in the form of a database. (For basic information on working with databases, see
the first sections of Database.)

In addition to labels, you can also use this command to create lists and tables with the data of a database. The
differences are as follows:

§ Labels: This option is used for producing labels, for example, address labels containing one address (from a
database) per label. 
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§ Lists: This option is used for producing lists, for example, address lists containing one address per line – for
example, Thomas Jones, 42 Main Street, Tucson, etc. 

§ Tables: This is similar to lists but with the data distributed over the cells of a table (one address per cell).

Working with lists and labels is easy: If you want to create, for example, address labels, choose the
aforementioned command. In the dialog box that appears, first specify the database to use (i.e., the database
containing the addresses). Then insert the desired database fields into the large input field – just as they should
appear later on the label (see screenshot above). Finally, select the label format from a predefined list of labels
of many manufacturers. Done! Printing can begin.

Tip: The Manage button in the dialog box allows you to save label definitions (that is, all settings made in
the dialog box) and retrieve them later at any time. This also works with lists and tables.

Creating lists/labels

To create labels, for example, proceed as follows:

1. Choose the ribbon command Mailings | group Create | List/Label .

2. Under Output as, select what you want to create: Label, List or Table. In our example, you would select
Label.

3. If you want to display the contents of a database in the label: Click on the Database button and select the
desired database – for example, the supplied address database addressbook.sqlite.

4. The large input field in the upper part serves as a "mask" for the content of the label. Enter the desired
content there – just as you want it to appear on the label later. You can insert database fields as well as
ordinary text and combine them to your liking.

To insert database fields, it is best to use the Database fieldbutton. A list of all fields in the database will be
displayed. If you click on one of the fields, it will be inserted at the current position of the text cursor.

The miniature formatting toolbar above the input field allows you to change the format (font, font size, etc.)
of the text in the input field if necessary. Select the text you want to change beforehand.

When you have finished filling in the input field, proceed as follows:

5. For labels, you now need to click on the Format button and set the format of the labels that you want to
print. The button opens another dialog box where you can select the manufacturer and product number of the
label from predefined lists.

If you are using a label that is not included in the lists, you can specify a new label format by clicking on the
New button and entering the measurements of the label. (See an explanation of the options in the dialog box
below.)

6. Set up the other options in the dialog box to your liking (see below).

7. When everything is done, press one of the following buttons:

Print: This option prints the labels. The usual "Print" dialog box appears for this purpose.

New document: This option creates a new document with the (completed) labels instead of printing them.

Manage: This button allows you to save label definitions (i.e., all settings made in this dialog box) and
retrieve them later at any time. This works with labels as well as with lists and tables. For more information,
see the end of this section.
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The creation of lists and tables works accordingly. There are only fewer options available in comparison to
labels. In addition, the Print button is replaced by an Insert button here. This inserts the list/table into the
document at the current position of the text cursor.

Options of the dialog box

The options in the dialog box of the above command have the following functions:

§ Large input field 

In the large input field at the top of the dialog box, enter the desired content for the label (or list/table) – just
as you want it to appear later on the label. The screenshot at the beginning of this section shows an example.

You can add text by simply typing it in.

You can also insert database fields (if you selected a database using the Database button). To insert a field,
click on the Database field button and then select the desired field. Alternatively, simply type the field's
name enclosed within curly braces (for example, {City}).

The miniature formatting toolbar above the input field can be used to change the text formatting. To do
so, proceed as in a normal document: First, select the text and then apply the desired formatting.

§ Output as 

Here, you can specify if the command should create labels, a list or a table.

§ Format 

Only for labels: Here, you can see which label format is currently selected (manufacturer, product name,
number of rows/columns).

Note: The format must be large enough to fully accommodate the content of the label. Otherwise, the
content will not appear completely in the subsequent printout.

To select a different format, click on the Format button and select the label's manufacturer and product
name from the lists. If required, you can also set the margins to be left blank on each (individual) label.

If you are using labels that are not included in the lists, click on the New button to create a new user-defined
label format. If known, specify the manufacturer name and product name/number. Then, use a ruler to
measure the labels and enter the resulting values into the dialog box.

The following figure shows how some of the values are related:

The Edit button allows you to edit existing user-defined label formats again. The default formats cannot be
changed – but you can always create a user-defined format based on a predefined format by selecting it in
the list and then clicking on the New button.
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The Delete button deletes the selected user-defined format.

§ "Database" button 

Lists and labels are often used to output the contents of a database. If you click on the Database button, you
can specify which database this should be – for example, the supplied address database
addressbook.sqlite.

§ "Database field" button 

This option is used to insert database fields. Clicking this button opens a list of all database fields available
in the selected database. If you click on one of these fields, it will be inserted into the large input field in the
dialog box.

§ "Database" section 

The "Database" section displays the path and name of the currently selected database (see the Database
button above).

Here, you can also specify which database records are to be used: All, only Selected (see Selecting records
for a mail merge) or a Range of records that you can specify by entering the first and last record numbers.

§ "Options" section 

This section changes depending on what you selected for the option Output as:

Label: 

You can make the following settings for the output of labels:

Full page with the current label: If you enable this option, a whole sheet of labels, containing identical
copies of the label, will be output for each individual label. This is useful for simple labels with fixed
text (without using a database) if you want to print whole sheets of one label at once.

Copies: Here, you can set how many copies of each label should be output.

Start row and Start column: Here, you can specify in which row and column of the first label sheet the
output should start. This is useful when reusing label sheets where some of the labels have already been
printed.

List:

There are no options for lists.

Table:

For tables, you can make the following settings:

Row height: Here, you can set the height of the table rows: Auto (determine optimum height
automatically), Exact (specify the exact height) or At least (specify the minimum height, but allow each
row to increase automatically if more space is needed).

Columns: Here, you can specify the number of columns the table should contain.

§ "Print" or "Insert" button 

For labels, the dialog box includes a Print button, among other things. This will take you to the "Print"
dialog box, where you can start printing the labels.

For lists or tables, the Insert button appears instead. By clicking on it, you insert the list/table into the
current document.
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§ "New document" button 

By clicking on this button, you create a new document containing the completed labels (or list/table) – just
as they would appear in the printout.

§ "Manage" button 

This button allows you to save label definitions (i.e. all settings made in this dialog box) and retrieve them
later at any time. It will open a dialog box with the following buttons:

Save: This option saves the label definition (i.e. all settings made in this dialog) under any name.

Load: This option restores a label definition. First, select the desired entry in the list.

Delete: This option deletes the selected label definition.

Rename: This option allows you to enter a new name for the selected label definition.

This not only works with labels but also with lists and tables.
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Printing envelopes
If you want to send a letter, you can either create an address label for it (as described in the last section) or
simply have TextMaker print the address directly on an envelope.

To do so, proceed as follows:

1. Choose the ribbon command Mailings | group Create | Envelope .

2. Click on the Paper settings button, set the paper format of the envelope to be printed and click on OK.

3. In the Sender field, enter your own address.

4. In the Recipient field, enter the recipient's address.

You can enter addresses manually or use database fields from an address database. To do so, click on the
Database field button and then select the field to insert.

5. When everything is entered, click on one of the following buttons:

Create new document: This option creates the envelope as a new document.

Append to document: This option appends the envelope to the end of the current document.
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Print envelope: This option prints the envelope once and then discards it.

6. If you have inserted database fields, TextMaker now displays the address database. Browse to the record
with the desired recipient and click on the Insert button.

The envelope will now be created and filled in.

Note that the above settings only have to be made once. TextMaker will remember the paper format you use for
envelopes and how you want to place the database fields. Of course, you can change the settings in this dialog
box whenever you like.

The following settings can be made in the above dialog box:

Sender

Use this field to enter the sender's address.

If necessary, you can use the button  above the field to change the font in which the address is to appear on
the envelope.

Recipient

Use this field to enter the recipient's address.

Tip: It is recommended that you use the database fields of your address database rather then type the address
manually. To insert a database field, click on the Database field button.

If you have not yet selected a database, you must first click on the Database button and select the desired
database.

If necessary, you can use the button  above the field to change the font in which the address is to appear on
the envelope.

Sender position

Here, you can change the position of the sender's address on the envelope (relative to the top left corner).

Recipient position

Here, you can change the position of the recipient's address.

Recipient margins

Here, you can change the right and the bottom margin of the recipient's address.

Paper settings button

This button opens an additional dialog box in which you can specify the exact paper format of the envelope.

The following options are available:

§ The Envelope type list offers all paper formats supported by the current printer. Here, select the format of
the envelope type used. Alternatively, you can also manually specify your own values under Width and
Height. 
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§ If your printer has multiple paper trays, you can use the option Paper tray to set the tray which the printer
should use. (This option is only available on Windows.)

§ Under Envelope orientation, you set how envelopes have to be inserted in your printer's tray (left-aligned,
centered or right-aligned; rotated or not rotated).

§ If required, you can also set an Additional offset if the printer prints the envelope slightly offset.

Tip: If you have created an envelope with this command and then saved it as a document, you can edit the
above settings in it at any time. To do so, click on the group arrow  in the bottom right corner on the ribbon tab
Layout | group Page setup in the document to open the dialog box. Switch to the Page format tab and click on
the Envelope settings button at the bottom.
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Mail merge
You find mass mails, created via mail merges, in your mailbox almost every day – for example, the seemingly
unavoidable advertising letters from mail order companies, insurance companies, etc.

A mail merge – the addresses will appear later in the fields {First name}, {Name1}, etc.

Of course, mail merges can also be used for useful things. How would you go about sending written invitations
to a meeting to all members of a sports club? Normally, you would type the letter, enter the first member's
address in the letterhead and then print the letter. You would then use the next member's address and print it
again, etc.

It is precisely this repeated manual insertion of addresses that TextMaker can assume when you create a mail
merge for the invitation.

In principle, proceed as follows (see the following pages for more information):

1. If you have not yet recorded the addresses of the recipients in a database, create or open a database and enter
the addresses in it. The supplied database addressbook.sqlite is very well suited for recording
addresses, but you can use any database you like.

2. Start a new document.



445Mail merge

3. Use the ribbon command Mailings | Select database | Use existing database  to assign the database
with the addresses to the document. This is necessary so that TextMaker knows which addresses it should
use later.

4. Write the letter.

5. Insert the corresponding database fields for name, street, city, etc., at the point where you want the address
to appear later.

Use the ribbon command Mailings | group Insert | Database field  for this purpose.

6. If you don't want to write to all the addresses: Open the database module with the ribbon command Mailings
| group Recipients | Select recipients and select all addresses to which you want to write.

7. Print the letter via the ribbon command File | group Print | Print merge.

When printing, TextMaker replaces the database fields with the data from the database – record by record. As a
result, the data from the first data record is used for the first letter, the data from the second record for the
second letter, etc.

The following sections describe each of the required steps in detail, from the creation of a mail merge document
to the printing of the completed document. The information covers the following topics:

§ Assigning a database to a document 

§ Inserting database fields

§ Viewing test records in the text

§ Sample letter

§ Selecting records for a mail merge

§ Printing a mail merge
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Assigning a database to a document
Before you insert the fields of a database into a mail merge document, you must tell TextMaker which database
you want to use by assigning a database to the document.

You use the ribbon command Mailings | group Recipients | Select database  | Use existing database to
open the dialog box in which you select the database. Type the file name of the desired database or select a file
from the list of databases that are displayed.

The following formats are supported:

File extension Description

*.sqlite or *.db Databases in SQLite format.

*.dbf Databases in dBASE format.

*.pmdx Open data from a PlanMaker file as a database.

*.xlsx Open data from an Excel file as a database.

*.txt or *.csv Open data from a text file as a database.

You determine the file format by selecting the required format from the list of file types in the aforementioned
dialog box. Depending on the database format, the program displays another dialog box in which you specify
the exact options for the selected database. For more information, see notes in Opening a database.

Note on dBASE: Most dBASE databases are stored in the dBASE/DOS format. Windows database
programs also generally use the DOS format instead of the Windows format.

Once you have selected and opened a database, TextMaker knows from which database you want to insert
fields, and you can proceed as described in the next section.

TextMaker remembers which database has been assigned to the document as soon as you save it. The next time
you open the document, this database will be reassigned to it. Of course, you can assign a different database to
the document at any time.

Clearing an assignment

You can undo the assignment by choosing the ribbon command Mailings | group Recipients | Select database |
Clear database assignment.

Alternatively: Mailings | group Recipient | Select database | Use existing database in the open file dialog box with the Clear database
button.
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Displaying the assigned database in the database module

To obtain an overview of the content of your assigned database, you can open the database module via the
ribbon command Mailings | group Recipients | Select recipients. For more information about the database
module, see Using the database module.

You can exit the database module again by clicking on the Close database icon . Changes to the database are
automatically saved.

Inserting database fields
Once you have decided which fields of the database should appear at which points in the mail merge, you can
insert them into the text using the ribbon command Insert | Field. When the letter is printed, these fields will be
replaced with the actual contents of the fields from the database, record by record.

Specifically, you proceed as follows to insert a database field:

1. Move the text cursor to the desired position.

2. Use the most convenient of the following options to insert a database field (the result is the same for all
options):

A. Mailings | group Insert | Merge field 

B. Mailings | group Insert | Field 

C. Insert | group Text | Field 

D. References | group Fields | Field 

If you click on the icon's arrow, you can directly access the fields of the database via the dropdown menu.

If you click on the icon itself or on the entry More in the dropdown menu, a dialog box opens. Here, you
will find the corresponding selection of fields in the list Field type with the entry Database field.

3. Select the desired field to insert it directly (in the dialog box: Insert button).

4. The field is inserted into the text and displays the field name in curly braces – for example, {Name}.

Proceed in exactly the same way to insert additional database fields at other points in the text until the mail
merge document has the desired appearance.

Database fields can be formatted like normal text, thus you can give them a different font, font size, etc., at any
time.

When printing the mail merge, TextMaker later independently ensures that the text is wrapped optimally. It
automatically adjusts the line break to the actual contents of the database fields, which can be of different
widths for each record.
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Viewing test records in the text
TextMaker usually displays database fields inserted into the text in the form of the field name in curly braces –
for example:

{Name}

To see how the mail merge document will actually look when printed, you can instruct TextMaker to display
the field contents from any record in the database instead of the field names. The prerequisite is that a database
has already been assigned to the document with the ribbon command Mailings | Select database | Use existing
database.

Once this has been done, turn to the command group Record on the ribbon tab Mailings (see figure below):
Here, enable the option Show merge record to display the field contents of the records.

Important: Make sure that the Field names button in the group Fields is not enabled (the enabled option is
indicated by the darker gray of the button). This option is responsible for switching between showing only
the field names or showing the field contents.

Using the command group "Record" for mail merges

The display of test records can be conveniently controlled using the input field on the ribbon tab Mailings|
group Record.

After you have selected the Show merge record checkbox, you can use the input field below it as follows:

§ Click on the left or right arrows to scroll from record to record. (If you only want to scroll between the
selected records, use the inner arrows.) 

§ Alternatively, enter the number of the record to be displayed in the input field and press Enter¿.

§ If you want to see the field names again instead of the test record, disable the option Show merge record by
deselecting it.

Note: The settings you have enabled here are also applied directly to the View tab of the dialog box File |
Properties. The display of data records and field names can also be set here.

Tip: If you now choose the command Mailings (or File) | group Print | Print merge, mail merges are still
printed with all selected data records. If you choose the command File | Print, on the other hand, TextMaker
prints only one letter with the address you selected above.
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To select certain records for the mail merge, open the database module with the ribbon command Mailings |
group  Recipients | Select recipients. For more information, see Selecting records for a mail merge.

Sample letter
Practice makes perfect. Therefore, we want to practice creating a mail merge in this section.

Before you start, use the command File | New  to create a new document.

With the ribbon command Mailings | Select database | Use existing database , you assign the supplied
example database addressbook.sqlite to this document. On Windows, you can find it in your document
directory directly in the SoftMaker folder.

Then type the following text. Of course, you can abbreviate it or type something completely different. The only
decisive factor is the following:

Important: Do not type the text in curly braces – these are database fields.

Instead, choose the ribbon command Mailings | Merge field  at each of these points. Click on the
corresponding field name in the dropdown menu. In this way, the database fields are inserted into the text.

The Society of Calligraphers

{First name} {Name1}

{Address}

{City}, {Postal code}

Dear Sir or Madam,

We are pleased to inform you that the Society of Calligraphers will no longer have to rely
on handwriting for its official communications.

We have decided to equip all our office employees with personal computers. We are now
using TextMaker with its integrated database and can send a personalized form letter to
all our members.

All in all, TextMaker has saved us an enormous amount of time and money – not to mention
the savings in ink and quills...

Best regards,

You have now created a "template" into which TextMaker can insert the fields of the database records, one
after the other, when printing.
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Use the command Mailings | group Recipients | Select recipients to choose the database module for the
example database addressbook.sqlite and enter a few records – as described in Adding and editing data
records. Naturally, it is up to you to choose the names and addresses. Once you have entered the records, exit
the database with the command Close database .

All the basic steps have now been taken and you could print your mail merge now. In the rest of this chapter,
you will learn how to select the recipients of a mail merge – and how to actually print the mail merge.

Selecting records for a mail merge
If required, you can specify exactly which records of a database are to be selected for the mail merge. To do so,
open the database module with the ribbon command Mailings | group Recipients | Select recipients and select
the desired records.

Note: If you have not previously assigned a database – as described in Assigning a database to a document –
you first choose the command Select recipients to open the file dialog box and select a database. The
database module will then open.

There are three ways to select data records, which can be combined to your liking. You can, for example, first
select data records by means of a condition and then manually exclude some data records from the selection.

The following selection methods are available in the database module (in the group Records):

§ Selecting individual records manually 

With the ribbon command Select | Current record, you can include the current record in the selection or
remove it. If you choose this command for an unselected record, it will be selected and vice versa.

With the ribbon command Select | Select all records and Select | Deselect all records, you can select or
deselect all records at once.

The ribbon command Select | Invert selection deselects all selected records and selects all unselected
records.

§ Selecting by record numbers 

With the ribbon command Select | By record numbers, you specify a range of record numbers to be
selected or deselected.

§ Selecting by condition 

The ribbon command Select | By condition lets you apply selection conditions such as "Select all Smiths"
or "Select all from New York".

For more information on these selection methods, see the following pages.

Note: TextMaker saves the selection permanently. Thus, it permanently remembers which data records are
selected even after you exit and restart TextMaker.
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Navigating between selected records

You can jump to the previous or next selected record by using the icons  and  in the group Navigation or
the shortcut keys Ctrl+Alt+PageUpá and Ctrl+Alt+PageDownâ.

Tip: Furthermore, you can use the ribbon command Show only selected records  in the group View to
hide all records that are not selected

Selecting individual records manually

Note: If the database module is not displayed, open it with the ribbon command Mailings | group Recipients | Select recipients.

In the database module, you will find the command Select  | Current record in the group Records to select
or deselect the data record currently displayed in the database module.

If you choose this command for an unselected record, it will be selected and vice versa. If you choose this
command for an already selected record, the record will be removed from the selection.

Tip: For a better overview of the records, switch to the list view (using the Form/list button in the group
View). Here, you can also select/deselect records by enabling/disabling the checkbox in front of the record.

With the commands Select | Select all records and Select | Deselect all records, you can select or deselect all
records of the database at once.

The command Select | Invert selection deselects all selected records and selects all unselected records.

Display in the status bar: The status bar at the bottom of the window also shows whether a data record is selected
or not: The word Selected appears here for a selected data record.

Selecting by record numbers

Note: If the database module is not displayed, open it with the ribbon command Mailings | group Recipients | Select recipients.

The record number is a sequential number used to number the records. The first record has the number 1, the
tenth 10, etc. The record number is always displayed at the bottom left in the status bar in the database module.

In the database module, you will find the command Select  | By record numbers in the group Records. This
allows you to select or deselect a range restricted by record numbers.
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The program displays a dialog box in which you specify the range of record numbers to be selected. The entire
database is automatically specified. For example, enter 10 and 20 if you want to select the records 10 to 20
inclusive.

If you then click on the Select button, all records in this range will be selected; if you click on Deselect, on the
other hand, they will be deselected, that is, excluded from the selection.

Selecting by condition

Note: If the database module is not displayed, open it with the ribbon command Mailings | group Recipients | Select recipients.

In the group Records in the database module, you can use the command Select  | By condition to make a
selection based on a condition – for example, "Select all those that have 'Smith' in the Name1 field". All records
that fulfill this condition will then be included in the selection.

Tip: It is necessary only for the content of the field to begin with the search term. If the content of the field
Name1 in a record is "Smithson", TextMaker also selects this record.

You can also combine several conditions – for example, Name1=Smith and City=London to select all Smiths
living in London.

If you choose the command Select  | By condition, the following dialog box appears:

For example, to select all records where the Name1 field begins with "Smith", proceed as follows:

1. In the dropdown list Database field, select the desired field – thus Name1 in the above example.

2. In the Content input field, enter the value for which you want to search – thus "Smith" in the above
example.
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Note: The search is case-sensitive. When searching for "Smith", records with "SMITH" or "smith" are not
found.

3. Click on the Add button to define the condition, which is then entered in the list Conditions.

You could now add more conditions by repeating the above steps.

4. Click on Select to add all records that fulfill the condition to the selection. Alternatively, click on Deselect
to remove these records from the selection.

If you now click on Select, all data records will be added to the selection where the field Name1 starts with
"Smith".

You can use the Delete and Delete all buttons in the above dialog box to delete previously added selection
conditions at any time if they are no longer needed.

Note: Bear in mind that once data records have been selected, they remain selected until they are explicitly
deselected. Thus, if you select by Name1=Smith and then by Name1=Brown, all Smiths and all Browns will
be selected. If you really only want to write to the Browns, you must first deselect all records before applying
the condition Name1=Brown by selecting the ribbon command Select | Deselect all records.

Available logical operators

In addition to the equal sign =, you can also use other logical operators for conditions in the above dialog box.
The following operators are available (in the dropdown list to the right of the field name):

Operator Explanation

= The field for which the search was performed must contain a term that is identical to the search term or a term
that at least starts with it.

<> The field for which the search was performed must not contain a term that is identical to the search term or a
term that at least starts with it.

< Less than (for use with numeric fields)

> Greater than (for use with numeric fields)

<= Less than or equal to (for use with numeric fields)

>= Greater than or equal to (for use with numeric fields)

contains The field for which the search was performed must contain the search term at any position.

If the condition Name1 contains Smith, the program will select all records for which this field contains the
contents "Smith", "Smithson" or "Jones, Smith & Co.", for example.

is empty The field for which the search was performed has no entry.



454Mail merge

Printing a mail merge
Once you have created a mail merge and selected the desired records from the database, you can let TextMaker
merge the two and print the mail merge.

To do so, use the command File | Print merge in the group Print rather than the usual command File | Print.

Alternatively: Mailings | group Print | Print merge.

For more information about this command, see Printing a mail merge.

Automatic suppression of superfluous blank spaces

If, when printing, TextMaker encounters two database fields that are separated by one or more spaces, it
automatically suppresses those spaces if the first of the two database fields is empty.

An example: You have inserted fields for first and last names into the text and have separated them with a
space:

{First name} {Name1}

By default, TextMaker prints the first name, a space and the last name at this point. If the {First name} field is
empty for a record, however, TextMaker prints only the last name and does not print the space that has become
superfluous.

Automatic suppression of empty lines with database fields

If a line of text contains only one or more database fields separated by spaces or tabs, the entire line is omitted
if these database fields do not contain content.

An example – your mail merge contains the following section of text:

{First name} {Name1}
{Name2}
{Address}
{City}, {Postal code}

If the {Name2} field is empty for a record, TextMaker automatically removes the resulting blank line. Thus, it
prints the first and last names followed by the street on the next line.

If both {First name} and {Name1} were empty, this line would be completely suppressed.

Preventing the automatic suppression of blank spaces

In certain cases, TextMaker's automatic suppression of blank spaces and blank lines may not be desirable. To
prevent such suppression, use non-breaking spaces instead of normal spaces. You can insert them with the key
combination Ctrl+Shift+Space.

An example – your mail merge contains the following section of text:
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{First name}<non-breaking space>{Name1}

Here, the space is printed even if {First name} is empty. Furthermore, the row is not suppressed even if both
fields are empty.
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Calculations in the text
TextMaker enables you to easily perform calculations in your documents:

§ You can insert calculations directly into the text; the results are displayed and printed. 

§ Variables can also be used in calculations. In this way, you can determine intermediate results and calculate
with them.

§ You can use both database fields and the contents of objects in calculations. Table1.A1, for example, returns
the contents of cell A1 in table "Table1".

You can easily enter the formula via the dialog box of the ribbon command Insert | group Text | Field  |
Calculation. This dialog box also contains lists of all variables, database fields, functions and operators.

The calculation functionality is especially useful due to the fact that it allows the contents of database fields to
be included in the calculations. Do you want to create invoices? No problem: If your invoice database has fields
for quantity and price, you can have TextMaker perform calculations like QUANTITY * PRICE in order to
create and print invoices as a mail merge.

You can also perform calculations with the contents of objects. For example, the formula "Textbox1.Value * 2"
reads the numeric value in the text field named "Textbox1" and multiplies it by two.

The following pages contain detailed information on calculations. The information covers the following topics:

§ Inserting calculations 

§ Formatting and rounding calculations

§ Updating calculations

§ Conditional text

§ Simple calculations at the touch of a button

§ Formulas and functions

Inserting calculations

Calculations can be inserted into the text via the ribbon command Insert | Field  | Calculation. Alternatively,
here: References | Field or Mailings | Field or simply the F2 key.

If you choose this command, the program displays a dialog box in which you enter the formula. The formula
may contain up to 255 characters. After confirming with OK, the result of the calculation will be in the text
(maximum 100 characters).

Options: You can specify the format of the result with the options Decimals, Thousands separator and Hide
result. For more information, see Formatting and rounding calculations.
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Inserting calculations

A simple example to illustrate the use of the calculation command:

You want to calculate the volume of a swimming pool that measures 23x13x7 feet. To do so, proceed as
follows:

1. Type the text "The volume is: ", for example.

2. Choose the ribbon command Insert | group Text | Field  | Calculation or press F2.

3. Enter "23*13*7" for Formula and confirm with OK.

The result is now inserted into the text: 2093.

Although this number "2093" looks like normal text, it is actually a field, that is, an iconic placeholder for the
calculation "23*13*7". You can see this if you enable the option Display field names on the View tab in the
dialog box of the ribbon command File | Properties. Then {formula: 23*13*7} appears in the text instead of
2093.

Tip: You can switch the option Display field names even faster using the shortcut keys Alt+F9.
Alternatively, you can use the Field names button on the ribbon tab Mailings | group Fields. The respective

mode is adopted at the same time by choosing File | Properties  and the "View" tab.

Editing calculations

The formula for the calculation can be changed at any time. Select the result "2093" and choose the ribbon

command Insert | Field  | Calculation again. The formula 23*13*7 is displayed in the dialog box. If the
swimming pool has different dimensions, simply change the formula accordingly. After you confirm with OK,
the recalculated result will be in the text.

Tip: You can also open the dialog box by double-clicking directly on the field.

More information

For more information on inserting calculations, see the next pages. The information covers the following topics:

§ Variables in calculations 

§ Table cells in calculations

§ Database fields in calculations

§ Objects in calculations
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Variables in calculations

You can save the result of a calculation as an intermediate result by assigning it to a variable.

Note: The names of variables may only contain letters, numbers, and underscores. The name must always
begin with a letter. A maximum of 16 characters is allowed. The cases of letters are ignored.

To use variables in calculations, proceed as follows:

1. Choose the ribbon command Insert | group Text | Field  | Calculation.

2. In the dialog box, type the variable name followed by an equals sign and then the value or formula – for
example: "VOLUME=23*13*7".

Important: If you now confirm with OK, two things happen:

§ The calculation is performed and the result is displayed in the text. 

§ At the same time, the result is saved in the variable VOLUME.

The variable VOLUME can now be used in other calculations: for example, the formula VOLUME+10 would
produce the result 2093+10, that is, 2103.

You can also just output the content of the variable VOLUME at another point in the text. Simply move the text

cursor there, choose the ribbon command Insert | Field  | Calculation and enter only the variable name
VOLUME as the calculation in the dialog box. When you confirm with OK, the content of the variable will
appear in the text.

If you take a closer look at the dialog box of the command Insert | Field  | Calculation, you will see that the
list Variable/field displays all currently valid variables. These can be conveniently inserted into the formula by
double-clicking on the entry in the list.

Important: A variable only applies from the point in the text where it was defined. So if you insert the
formula VOLUME=23*13*7 in the third paragraph of your document and try to output or calculate
VOLUME in the second paragraph, TextMaker acknowledges this with the error message "Unknown
variable name".

An application example

A tennis center wants to write invoices for renting its tennis courts. You want the computer to calculate the
final total and add 19% tax. Such an invoice would be written more or less in this (much abbreviated) form:



459Calculations in the text

I N V O I C E

? Hours @ ??.??

------------

Net amount = ??.??

------------

+ 19% tax = ??.??

Gross amount = ??.??

------------

Those points in the invoice indicated by question marks would have to be filled in by hand after calculating the
amounts with a pocket calculator. TextMaker assumes this work.

Let's say that the tennis players rented a court for 2 hours and that each hour costs $10.00 plus tax:

1. Delete the question mark before "Hours", choose the ribbon command Insert | Field  | Calculation and
use it to enter the following calculation: DURATION=2.

(First, you assigned the value 2 to the DURATION variable. Then the content of DURATION – i.e., 2 – is
displayed in the text.)

2. On the right, enter the calculation PRICE=10 instead of the question marks after "@".

(The same applies here: First, you assign the value 10 to the PRICE variable, and then the content of this
variable – i.e., 10 – appears in the text.)

3. The formula that you must enter using the command Insert | Field   | Calculation for the question marks
after "Net amount" is: NET=DURATION*PRICE.

(The result of the calculation DURATION times PRICE is now assigned to the NET variable, and this result
is displayed in the text. The decisive factor here is that if you subsequently change the value of DURATION
or PRICE, the content of the NET variable will also change accordingly.)

4. After "+ 19% tax", use Insert | Field  | Calculation to insert the formula TAX=NET*19/100 and
calculate the tax.

(This formula uses the currently calculated result for NET as the basis for a further calculation. The same
applies here also: If something changes in the NET result, the TAX result is automatically corrected.)

5. The "gross amount" is finally calculated with NET+TAX.

(In the final step, we refrain from defining a new variable again. After all, we only want to have the result in
the text.)

If you enable the option Display field names on the View tab in the dialog box of the ribbon command File |
Properties (alternatively: on the ribbon tab Mailings | group Fields with the Field names button) the formulas
will be visible in the text. The invoice should look as follows:
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I N V O I C E

{Formula: DURATION=2} Hours @ {formula: PRICE=10}

------------

Net amount = {formula: NET=DURATION*PRICE}

------------

+ 19% tax = {formula: TAX=NET*19/100}

Gross amount = {Formula: NET+TAX}

------------

If you disable Display field names again, you will see the results in the text.

Tip: Use the Alt+F9 shortcut to instantly switch the option Display field names.

If you want to write an invoice for another customer, you only have to change the value of the DURATION

variable. To do so, select the 2 in front of "Hours", choose the ribbon command Insert | Field  | Calculation
and simply replace the 2 in the formula with the desired number of hours. After you confirm with OK,
TextMaker performs the recalculation.

Decimal places: You might find it more desirable to show the amounts with two decimal places. However, you
can change this immediately: Select the corresponding calculations, choose the ribbon command Insert | Field

 | Calculation, select the option Fixed for Decimals and enter a "2" next to it.

Tip: You can also open the dialog box by double-clicking directly on the field.

Table cells in calculations

You can also use the cells in tables for calculations – similar to a spreadsheet!

If you are moving from cell to cell in a table, you should pay attention to the status bar at the bottom edge of the
program window. This is where the coordinates of the current table cell are displayed.

The rows of a table are numbered 1, 2, 3, etc., by TextMaker; the columns are assigned the letters A, B, C, etc.

A1 B1 C1 ...

A2 B2 C2 ...

A3 B3 C3 ...

... ... ... ...
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The first cell in the table thus has the coordinates "Column A" and "Line 1" or A1 for short.

To perform calculations within a table with the cell contents, choose the ribbon command Insert | group Text |

Field  | Calculation and enter the coordinates of the cell contents, led by a hash sign (#). For "Add the
contents of cells A1 and A2", the correct formula would be:

#A1 + #A2

The # sign tells TextMaker that it should treat the content of the cell as a number. If the cell's content is to be
treated as text, use the dollar sign ($) – for example, $A1.

Note that calculations such as #A1 + #A2 only work within the same table. If you want to add cells A1 and A2
outside this table, you have to put the table's name and a period in front of the cell address. So if the table is
called "Table1", the correct formula would be as follows:

Table1.#A1 + Table1.#A2

For more information, see also Objects in calculations.

Calculating the sum of a range of table cells

The SUM function is especially useful for adding numbers in table cells. Simply enter the first and last desired
cells as parameters, and TextMaker will add up the values in all cells of this range.

For example, you can use the formula SUM(#B2;#B5) to add the contents of cells B2 to B5.

Calculating with adjacent cells made easy

Tip: In some calculating functions (for example, SUM), you can also use symbolic cell references that represent
all cells directly adjacent to a cell.

The following types of symbolic cell references are available:

§ ABOVE (represents the cells above the current cell) 

§ BELOW (represents the cells below the current cell)

§ LEFT (represents the cells to the left of the current cell)

§ RIGHT (represents the cells to the right of the current cell)

For example, the formula SUM(ABOVE) calculates the sum of the cells directly above a cell.

Only those neighbors of the current cell that contain a number are taken into account. In other words, the
automatically determined range extends from the current cell to the next cell without a number.

The following functions support symbolic cell references:

AVG, COUNT, MIN, MAX, PROD, SUM

For descriptions of all computational functions, see Computational functions.
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Database fields in calculations

Fields from a database can also be used in calculations. The prerequisite for this is that you have assigned a
database to the document via the ribbon command Mailings | Select database | Use existing database.

You do not even have to enter the field names manually. If you look at the dialog box of the ribbon command

Mailings | Field  | Calculation, you will notice that the names of all database fields appear in the list
Variable/field as soon as you assign a database to the document. They can be entered in the formula via a
double-click.

As an example, we want to create an invoice form that can be easily printed as a mail merge. All you need is a
database that contains fields for customers' personal data (name, street, city, etc.). In addition, the database
should contain a QUANTITY field with the order quantity, an ITEM field with the item name and a PRICE
field with the unit price. Proceed as follows:

1. Use the command File | New  to create a new document.

2. With the ribbon command Mailings | Select database | Use existing database , you assign a suitable
database to this document (example: see below).

3. Next, create a normal mail merge, as described in Database. Insert the database fields with the customer data
(address, etc.) at the appropriate places in the letterhead.

4. Design the invoice itself according to your needs. Enter fields from your database with the ribbon command
Mailings | Merge field – for example, the QUANTITY field for the quantity ordered.

5. We now come to the highlight: You can calculate with the database fields. For example, the formula
"QUANTITY*PRICE" calculates the sum for the current record. Thus, use the ribbon command Mailings |

Field  | Calculation to insert suitable calculations in the desired places.

6. If everything has been entered, you can save the document. If necessary, select the desired records in the
database and print your invoices using the ribbon command File | Print merge.

Example

You will find an application example in the folder with the sample documents for SoftMaker Office: the
Invoice.tmdx file with its associated Invoice.sqlite database.

Depending on the operating system, you will find these files as follows:

§ Windows: In the SoftMaker\Samples folder in your Documents folder 

§ macOS: In the SoftMaker/Examples folder in your Documents folder

§ Linux: In the SoftMaker/Samples folder in your Home folder

§ Android: In the SoftMaker/Samples folder on your SD card

§ iOS: In the SoftMaker/Samples folder in your App folder

Tip: After opening Invoice.tmdx, enable the option Display field names on the "View" tab in the dialog box
of the ribbon command File | Properties.
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Alternatively: Use the ribbon command Mailings | group Fields | Field names or simply Alt+F9

You can now see all the formulas in plain text and can understand more fully how this self-calculating mail
merge works.

Objects in calculations

Certain types of objects can also be used in calculations. Thus, for example, you can create a form that contains
text fields and use the contents of these text fields in calculations.

All objects in a document have unique names as described in Changing the names of objects. In calculations,
you can address each object by its name. Textbox1, for example, returns the contents of the text field
"Textbox1".

You evaluate the content of objects in calculations as follows:

§ Text fields and text frames 

Textbox1.Text (or Textbox1 for short) returns the content of the text box named "Textbox1" as text
(without formatting).

Textbox1.Value, on the other hand, interprets the content of this text field as a number and returns it.

§ Tables 

Table1.A1 returns the content of cell A1 in Table1.

Table1.#A1 interprets the content of this cell as a number and returns it.

Table1.$A1 interprets the content of this cell as text and returns it.

Table1 returns the value of the first cell of Table1.

§ Checkboxes and checkbox frames 

Checkbox1.Sel (or Checkbox1 for short) returns 1 if the checkbox is checked or 0 if it is not checked.

Checkbox1.Text returns the text of this checkbox if it is checked, otherwise it returns an empty string.

§ Dropdown lists and dropdown list frames 

Dropdown1.Text returns the text of the selected item in Dropdown1.

Dropdown1.Sel (or Dropdown1 for short) returns the number of the selected item.

For example, the formula "Textbox1.Value * 2" reads the numeric value in the text field named "Textbox1" and
multiplies it by two.
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Formatting and rounding calculations
Not only can you enter new calculations and and edit existing calculations via the ribbon command Mailings |

Fields  | Calculation (see Inserting calculations), but you can also specify the format of a calculation.

You can specify the format immediately when inserting a new calculation or change it at any time by selecting

the calculation and choosing the ribbon command Mailings | Fields  | Calculation.

The following options in the dialog box determine the format of the calculation:

§ Thousands separator 

If you enable this option, numbers as of 1000 are represented with thousands separators. For example,
1230000 is displayed as 1,230,000.

§ Hide result 

If you selected this option, the result of the calculation will not be visible in the text. This makes sense if, for
example, you want to perform intermediate calculations with variables and do not want to show the results.

Note: To make a hidden calculation visible again, open the dialog box via the ribbon command File |
Properties, switch to the View tab and enable the option Display field names (alternatively: the ribbon
command Mailings | group Fields | Field names). You can now select the calculation again, choose the

ribbon command Mailings | Field   | Calculation and disable the option Hide result again.

§ Decimals 

With the default setting Floating, as many decimal places are shown as are required to fully represent the
result of the calculation. Alternatively, you can select the option Fixed and specify a fixed number of
decimal places to be shown. For monetary amounts, for example, the number of decimal places should be
fixed at 2.

Note: The value is not actually rounded by setting a fixed number of decimal places; only its representation
is rounded (see below)!

Actually rounding variables

It is essential to note that the aforementioned option for setting the number of decimal places only changes the
way the results of a calculation are displayed. In reality, however, the variable retains its actual number of
decimal places.

In practice, this means that if you assign a value of 2.5 to variable A and set the number of decimal places to 0,
it will be shown as 3, but if you multiply A by 2, the result shown will be 5, not 6.

Thus, TextMaker also has a function called ROUND for real rounding. This can be used, for example, as
follows:

A = ROUND (2.5; 0)

As a parameter, you specify the value to be rounded and the number of decimal places separated by a
semicolon. For example, the above statement assigns a value of 3 to variable A.
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For more information on all of TextMaker's computational functions, see Formulas and functions.

Updating calculations

If you enter or edit a calculation via the ribbon command Mailings | Field  | Calculation, TextMaker
automatically updates all other calculations in the document as soon as you confirm with OK.

In certain situations, however, calculations may show "outdated" results. If, for example, you copy from another
document a section of text containing variables that also occur in the current document, TextMaker will
inevitably display incorrect results on the screen.

The ribbon command Mailings | Update fields  is provided for such cases (alternatively: keyboard
command F9). If you choose this command, TextMaker updates the screen display of all calculations and fields
in the document.

Note: This command is only necessary in the above cases to update the display of calculations on the screen.
Before printing a document, TextMaker automatically updates all calculations and fields. TextMaker thus
ensures that you will never print a document with results that are out of date.

Conditional text
TextMaker also allows you to work with conditions via the function IF. Thus, you can use "conditional text" in
your documents, for example.

A typical case: You have an address database with a field called GENDER, which contains a key for the gender
of the respective person: "M" for male or "F" for female. You could use the following IF expression to ensure
that TextMaker forms a salutation according to gender:

IF (GENDER="M"; "Dear Sir"; "Dear Madam")

If you use this calculation in a mail merge, TextMaker will check each record to see whether the GENDER field
contains an "M". If this is the case, the above formula provides the result "Dear Sir", otherwise "Dear Madam"
appears.

Simple calculations at the touch of a button

There is another alternative to the ribbon command Insert (or Mailings) | Field  | Calculation presented in
the last sections: the keyboard command F8.

The difference:
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The ribbon command Insert (or Mailings) | Field  | Calculation is suitable for any complex calculations
with variables, etc.

The keyboard command F8 is only suitable for simpler calculations, but it is much easier to use: You simply
type a formula directly into the text, select it and press the F8 key – the result is already in the text.

An example:

1. Type: "The sum is: 90+55+220".

2. Select "90+55+220".

3. Press the F8 key.

4. The formula "90+55+220" is now calculated, and the result is inserted into the text.

Tip: As an alternative to pressing the F8 key, you can also right-click on the selected formula "90+55+220" to
open the context menu and select the menu item at the bottom: Replace with result "365".

Important: In contrast to calculating with the ribbon command Insert | Field  | Calculation, the result is
not created as a field with the F8 key or via the context menu here but is written into the document in plain
text.

Order of operations: The order of operations rule applies, i.e., multiplication and division before addition and
subtraction. Multiplication and division operators take precedence over addition and subtraction operators, thus
multiplication and division are performed before addition and subtraction. Thus, 2+3*4 equals 14. The order of
operations can be modified by parentheses: (2+3)*4 equals 20.

Using functions: Not only the basic arithmetic operations are allowed but also functions (see Formulas and
functions): Type "SQRT(2)", select it and press the F8 key to display the root of 2.

One line limit: The selected calculation must be within one line of text. If you select several lines of text, the F8

keyboard command is not available. In this case, use the ribbon command Insert | Field  | Calculation.

Summing the contents of table cells

Such calculations can also be performed in tables. There is yet another function here:

§ If you have selected a calculation within a table cell, you can calculate it as described above using the F8
keyboard command. 

§ If you select several entire table cells, TextMaker uses the F8 keyboard command to calculate the sum of
the values in the selected table cells. A window then appears and indicates the result. If you simply want to
take note of this and no longer use it, click on Close. Alternatively, you can select the Copy button.
TextMaker then copies the result of the calculation to the clipboard. You can now insert the value at any
position in the document using the ribbon command Home | Paste.

Tip: Adding the "Evaluate" button to the ribbon

For convenient access, you can also add the command Evaluate  as a separate button on a ribbon tab. If you
use this command, it does exactly the same as the F8 keyboard command.
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To do so, choose the ribbon command File | Customize | Customize ribbon to open the dialog box for
customizing the user interface, and search there for the command "Evaluate". Then proceed as described in
Customizing icons and groups in the ribbon.

Note: The "hamburger menu"  can be used to access the "Evaluate" command directly by default as in the
classic menu interface with the menu command Edit > Evaluate.

Formulas and functions
On the following pages, you will learn about the rules you have to observe when constructing formulas. Then
all of TextMaker's calculating functions will be presented.

Note: This section is about formulating formulas (for performing calculations in the text). For more
information about the SoftMaker Equation Editor (for the graphical representation of mathematical
formulas), see Using the SoftMaker Equation Editor.

Structure of a formula

Formulas may contain up to 255 characters. Results are limited to 100 characters.

You can construct formulas from the following components:

Fixed values

In its simplest form, a formula results from a fixed value, as in the following examples:

§ Text strings 

Example: "Hello!"

A formula with this content always results in the string "Hello!

(A string is a series of characters – letters, numbers, or special characters.)

Strings may be up to 100 characters long.

Important: If you enter fixed strings directly into a formula (for example, "Hello!"), they must be enclosed
within "quotation marks". Otherwise, TextMaker will try to interpret it as the name of a function or variable.

§ Numeric values 

Example: 42.50

Of course, a fixed value can also be a numeric value as in a number. This formula always returns the number
42.5.
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§ Date entries 

Example: "20.04.18"

This formula represents the date 4/20/2018.

Format of dates:

When entering fixed dates in formulas, please note the following:

1. If you enter fixed dates in formulas, you must add "quotation marks" to them.

2. The day and month must always be specified with two digits. "20.04.18" would be correct, "20.4.18"
wrong (month has one digit).

3. The year can be specified with either two or four digits. Thus, both "20.04.18" and "20.04.2018" are
allowed.

4. If you enter a two-digit year between 0 and 29, TextMaker automatically prefixes "20...". For years
between 30 and 99, TextMaker prefixes "19...". The date "01.01.29" is thus interpreted as 1.1.2029, and the
date "01.01.30" as 1.1.1930.

Database fields, table cells and objects

You can also use the contents of database fields, table cells and objects in formulas.

For more information, see Table cells in calculations, Database fields in calculations, and Objects in
calculations.

Calculations

A formula can contain different types of calculations.

Example: 6*5

This always returns the fixed value 30, and it is actually a fixed value and not a calculation.

Example: 5*NUMBER

In this formula, the fixed value 5 is multiplied by the NUMBER variable. If NUMBER is currently 10, the
formula returns 50.

TextMaker also provides a number of computational functions. For detailed descriptions, see Computational
functions. Here are some examples in advance:

Example: TODAY()

The function TODAY() returns the current date. On September 16, 2018, for example, it would return 09/16/18.

Example: MONTH(TODAY())

Here, one function is applied to another. The function TODAY() returns the current date. However, this result
is immediately evaluated by the MONTH() function, which returns only the month of the date (as a number).
On September 16, 2018, the formula would thus produce the value 9.

Example: INT(B/1000)
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Here, the FUNCTION INT, which removes the decimal places of a value, is applied to the calculation B/1000.
If B has the value 3752.70, the formula produces the value 3.

Thus, the argument for functions can be a different function, any calculation, a database field, a table cell and,
of course, a combination of all of them.

Variables

The result of a formula can be assigned to a variable.

Tip: In the dialog box of the ribbon command Insert | Field  | Calculation, all currently defined variables
appear in the list Variable/field. You can insert any of the variables in the formula by double-clicking on them.

Example: PRICE=17.99

The "formula" here is only the constant value 17.99. The entry as a whole defines the variable PRICE and sets
it to 17.99. Its value is valid from the position in the text at which you insert it to the end of the text – unless
you assign another value to the PRICE variable further down in the text.

Note: Whenever you assign a value or a calculation to a variable, the result of the variable appears at the
current position in the text. If you do not want this – for example, because you only want to perform an
intermediate calculation whose result is not to be displayed – enable the option Hide result when entering

the formula in the dialog box of the ribbon command Insert | Field  | Calculation.

Example: MONTH=MONTH(TODAY())

Here, the month of today's date is calculated and shown. At the same time, the result is also saved in the
MONTH variable.

Of course, such variables can also be used in other formulas.

Example: PRICE*1.19

This formula returns the current value of the PRICE variable multiplied by 1.19.

Operators

The following operators can be used in formulas:

Operator Function

+ Addition (for numbers) or concatenation* (for strings)

– Subtraction

* Multiplication

/ Division

% Modulo (remainder after division)



470Calculations in the text

* The plus sign not only adds numeric values, but also merges strings. For example, "Text"+"Maker" results in "TextMaker".

The order of operations rule applies. Multiplication and division operators take precedence over addition and
subtraction operators, thus multiplication and division are performed before addition and subtraction. 2+3*4
equals 14. The order of operations can be modified by parentheses: (2+3)*4 equals 20.

There are also comparative and logical operators, such as those required by the IF function:

Operator Function

= Is equal?

< > Is not equal?

> Is greater than?

>= Is greater than or equal to?

< Is less than?

<= Is less than or equal to?

& Logical "And"

| Logical "Or" (AltGr+< key on a PC keyboard)

! Negation

Some notes on comparisons

§ When comparing two strings with "=", the result is only "true" if the strings match exactly and have the
same length. The cases of letters are taken into account. 

"Hans"="Hans" is true.

"Hans"="hans" is false.

"Hans"="Hans-Peter" is false.

§ If you construct a complex comparison with several "Ands" and "Ors", you should enclose the individual
conditions within parentheses. 

Overview of computational functions

In TextMaker, you can use the computational functions described below. The parameters required for the
function are given in parentheses:

    n a number

    s a string
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    d a date

For INT(n), for example, a number or other calculation that results in a number would have to be specified as a
parameter – for example, INT(3.14) or INT(1+SQRT(2)).

Important: If several arguments are required, they must be separated from one another by semicolons (;)
and not by commas.

Function Explanation

ABS(n) This results in the absolute value of the number n (The sign is removed.) – ABS(3) results in 3;
ABS(-3) also results in 3.

ASC(s) The position of the character s in the character set – ASC("A") results in 65.

AT(s1;s2) This returns as a numerical value the position of the string s1 at which the string s2 occurs for the
first time – AT("London";"on") returns 2.

AVG(n1;n2) This calculates the average value of the cells with the coordinates n1 (upper left corner) and n2
(lower right corner). The coordinates must be preceded by # signs. Example: AVG (#B2;#C5). For
more information, see also Table cells in calculations.

CHR(n) The character with the position n in the character set – CHR(65) results in an "A".

COUNT(n1;n2) This returns the number of numeric values in the cells with the coordinates n1 (upper left corner)
and n2 (lower right corner). Only numbers are counted – empty cells and cells containing text are
not counted. The coordinates must be preceded by # signs. Example: COUNT (#B2;#C5). For
more information, see also Table cells in calculations.

DAY(d) The day of the date d (as number) – DAY("25.09.18") results in 25.

DTON(d) This converts the date d into a serial day number. It is needed to calculate the difference between
two dates in days: DTON ("12.11.18") - DTON ("20.10.18") results in 23 (days).

IF IF(condition;value1;value2) returns value1 if the condition is true; otherwise it returns value2.
However,value2 can also be omitted. Example: IF (GENDER="F"; "Dear Ms."; "Dear Mr."). For
more information, see Conditional text. Value1 and value2 can be of any type (thus numeric, for
example).

INT(n) This truncates the decimal points of the number n (without rounding) – the formula INT(3.90)
would result in 3.

LEFT(s;n) This returns the first n characters of the string s – LEFT("TextMaker"; 4) returns "Text".

LEN(s) Length of the string s – LEN("John") results in 4.

LOWER(s) This converts the string s to lower case – LOWER("John") results in "john".

LTRIM(t) This removes all leading spaces from the string s – LTRIM("   Text   ") results in "Text   ".

MAX(n1;n2) This returns the maximum value of the cells with the coordinates n1 (upper left corner) to n2
(lower right corner) of a table. The coordinates must be preceded by a # sign. Example: MAX
(#B2;#C5). For more information, see also Table cells in calculations.
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MIN(n1;n2) This returns the minimum value of the cells with the coordinates n1 (upper left corner) to n2
(lower right corner) of a table. The coordinates must be preceded by a # sign. Example: MIN
(#B2;#C5). For more information, see also Table cells in calculations.

MONTH(d) The month of the date d (as a number) – MONTH("25.09.18") results in 9.

NTOD(n) This is the counterpart to DTON: You specify the serial day number with n and NTOD converts it
into a date.

POW(n1;n2) This returns the result of raising the number n1 to the power of n2 – POW(2;8) equals 256.

PROD(n1;n2) This calculates the product of the cells with the coordinates n1 (upper left corner) to n2 (lower
right corner) of a table. The coordinates must be preceded by a # sign. Example: PROD
(#B2;#C5). For more information, see also Table cells in calculations.

RIGHT(s;n) This returns the last n characters of the string s – RIGHT("TextMaker"; 5) results in "Maker".

ROUND(n1;n2) This returns the number n1 rounded to n2 decimal places – ROUND(2.44;1) equals 2.4 and
ROUND(2.45;1) equals 2.5.

RTRIM(s) This removes all trailing spaces from the string s – RTRIM("   Text   ") returns "   Text".

SQRT(n) This returns the square root of the number n – SQRT(4) equals 2.

STR(n) This converts the number n into a string – STR(17) would result in the string "17".

STRING(s;n) String s is repeated n times – STRING("Text"; 3) results in "TextTextText".

SUBSTR(s;n1;n2) This extracts n2 characters from the string s from position n1 – SUBSTR("Potato";2;3) results in
"ota".

SUM(n1;n2) This represents the sum of the cells with the coordinates n1 (upper left corner) and n2 (lower right
corner) of a table. The coordinates must be preceded by a # sign. Example: SUM (#B2;#B5). For
more information, see also Table cells in calculations.

TODAY() This returns today's date in the form MM/DD/YY – the empty pair of parentheses must be entered
after the function name.

TRIM(s) This removes all spaces at the beginning and end of the string s – TRIM("   Text   ") returns
"Text".

TRUNC(n1;n2) This returns the number n1 truncated to n2 decimal places (without rounding) –
TRUNC(1.2345;2) results in 1.23.

UPPER(s) This converts the string s to uppercase letters – UPPER("John") results in "JOHN".

USER() This returns the name under which the current user is logged into this system. The empty pair of
parentheses must be entered after the function name.

VAL(s) This converts the string s to a number. The string may also contain text; TextMaker then takes the
first number that it can find in it: VAL("9") results in 9. VAL("9 sausages") and VAL("Can I have
9 sausages and 3 rolls please?") also result in 9. VAL("sausages") results in 0, because no number
is included.
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YEAR(d) The year of a date as a number (two digits) – the formula YEAR("09/17/18") results in 18.
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Working with large documents
TextMaker has some very useful functions for writing large documents such as scientific papers or books:

§ Outlines 

Large documents are often organized according to an outline – that is, a hierarchical structure of headings.
TextMaker's clear outline view allows you to view and edit a document in outline form. With a click of the
mouse, you can change heading levels and move headings (along with the corresponding text).

§ Tables of references (TOC, index, etc.) 

TextMaker can help you create tables of references (table of contents, indices, etc.). The following types are
supported:

§ Indices 

§ Tables of contents

§ Captions and tables of figures

§ Bibliographies

§ Bibliographies with Zotero (insert sources for bibliographies with Zotero)

For more information, see the corresponding subsection.

§ Cross references 

It is also possible to apply cross-references to other text passages, for example, "See explanations on page
12".

§ Style references 

A style reference field searches the document backwards for text in the selected style, and then displays this
text. This allows you to display, for example, the current main heading (which is usually formatted in the
paragraph style "Heading 1") in the text.

§ Footnotes and endnotes 

Also practical in large documents: You can insert footnotes (at the end of a page) or endnotes (at the end of
the document) at any time. These are automatically managed by TextMaker.
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Outlines
You should use outlines to organize large documents. An outline presents the document according to topic and
subtopic and places a heading before each new topic section. This provides an overview and makes the text
easier to read.

To do so, you can use the outline view in TextMaker, which you can access with the ribbon command View |
Outline.

In the iOS version, the outline view is locked. (To unlock the command, see Welcome.)

The outline view is simply a different way of representing the document. Let's take a closer look at what it
contains:

As you can see, the individual sections of text are indented to different degrees. Main headings are on the far
left, while headings at the next level are a little further to the right, etc.

The context-related ribbon tab Outline also appears. This contains functions for structuring documents.
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When you choose the outline view for the first time, the entire document will always be visible. You will obtain
a better view of the document's structure if you hide the normal text and allow only the headings to be displayed
(provided the document contains headings). Use the Show body text checkbox on the ribbon tab Outline.

You can also use the dropdown list below it to specify which levels of headings are to be displayed. If you
select Show outline levels 1 to 3, for example, only headings from the first to the third outline level will be
displayed. The entry Show all outline levels ensures that all levels are visible again.

The outline view is not only useful for viewing the document but also for editing the outline. You can also use
the ribbon tab Outline for this purpose. By means of the arrow buttons, you can raise or lower the outline levels
of headings or promote paragraphs of normal text to headings.

Numbering headings: Headings are often numbered. TextMaker can take care of this numbering for you
automatically. For more information, see also Numbering headings.

The following pages contain detailed information on working with outlines. The information covers the
following topics:

§ Using the outline view 

§ Formatting headings

§ Expert tip: Managing headings via paragraph styles

§ Practical outlining

§ Numbering headings

§ Outlined documents and chapters

Using the outline view

In the iOS version, the outline view is locked. (To unlock the command, see Welcome.)

As mentioned in the introduction, TextMaker provides a special display mode for editing a document's outline:
the outline view.

To switch to the outline view, choose the ribbon command View | Outline. You can choose the command View
| Standard to return from the outline view to the standard view at any time.

In outline view, you see the document organized according to main headings and subheadings. The first-level
headings (main headings) are on the far left. Each lower level heading is indented to the right by an amount
corresponding to its level.

For more information about the outline view, see the following sections.
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Changing the outline levels of paragraphs

To give a document an outline or to edit an existing outline, switch to outline view and simply change the
outline level of the paragraphs that contain headings.

When you enter text into a document, all paragraphs of this text are assigned to outline level 0 by default. If, for
example, you assign outline level 1 to a specific paragraph, this paragraph is designated as a first-level heading.

By assigning outline level 1, you determine the main headings in the document. If you want to add subheadings
under the main headings, you assign the corresponding paragraphs to outline levels 2, etc.

To change the outline level of a paragraph, proceed as follows:

1. Use the ribbon command View | Outline to open the outline view.

2. Position the text cursor in the desired paragraph.

3. Click on one of the following icons on the ribbon tab Outline or use one of the following shortcut keys:

For Windows/Linux

Icon Function

This raises the paragraph's outline level by 1. 
Shortcut keys: Alt+Shift+ß

This lowers the paragraph's outline level by 1. 
Shortcut keys: Alt+Shift+à

This assigns outline level 0 (normal text) to the paragraph. 
Shortcut keys: Ctrl+Shift+N

Tip: Furthermore, the shortcut keys Alt+1 to Alt+9 are assigned by default to outline levels 1 to 9, and the
shortcut key Alt+0 is assigned to level 0 (for normal text). With these key combinations, you can create
headings levels 1 to 9 in a flash or convert a heading back into normal text. 
Incidentally, these key combinations not only work in the outline view but also in the standard view.

For Mac

Icon Function

This raises the paragraph's outline level by 1. 
Shortcut keys: Ctrl+Shift+ß

This lowers the paragraph's outline level by 1. 
Shortcut keys: Ctrl+Shift+à

This assigns outline level 0 (normal text) to the paragraph. 
Shortcut keys: Ctrl+Shift+N
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Tip: Furthermore, the shortcut keys Cmd+Alt+1 to Cmd+Alt+9 are assigned by default to outline levels 1
to 9, and the shortcut key Cmd+Alt+0 is assigned to level 0 (for normal text).

Selecting the outline levels to be displayed

To obtain a better overview of the structure of a document in the outline view, it is a good idea to hide the
normal text so that only the headings are visible. In addition, you can also hide headings below a specific level.

For this purpose, the ribbon tab Outline has the following two elements:

§ The option Show body text above the dropdown list is particularly useful. It determines whether only
headings or both headings and the associated text should be displayed. You can enable or disable this option
by clicking on the checkbox. If it is enabled, the text is displayed. If it is disabled, only the headings remain
visible. 

Tip: You can also use the shortcut keys Alt+Shift+A to enable or disable the text display instead of using
the checkbox.

§ You can use the dropdown list below to specify which outline levels are to be displayed. By clicking on the
entry Show outline level 1 only, you ensure that only the main headings are visible. By clicking on the entry
Show outline levels 1 to 3, you ensure that all headings up to and including level 3 are displayed, etc. 

Tip: Instead of the entries for the outline levels 1 to 9, you can also use the shortcut keys Alt+Shift+1 to
Alt+Shift+9.

By default, the All button is enabled; thus, TextMaker displays headings of all levels.

Expanding/collapsing a heading

As just described, you can hide some of the heading levels in the outline view with the dropdown list in order to
see only the headings of certain levels.
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What if you want to see the lower levels of a single heading? In this case, you have the following options:

§ Buttons  and  on the ribbon tab "Outline" 

Move the text cursor to the desired heading. Then click on one of the following icons on the ribbon tab
Outline or use one of the following shortcut keys:

Icon Function

This shows another sublevel.
Shortcut keys: Alt+Shift+(Num+) (plus key on the numeric keypad)

This displays one less sublevel.
Shortcut keys: Alt+Shift+(Num-) (minus key on the numeric keypad)

§ Symbols  and  directly in front of the text paragraphs 

Furthermore, a plus or minus symbol is displayed in the outline view before each heading.

A  indicates that this heading still contains subheadings or normal text paragraphs, but they are currently
hidden.

In the case of a , on the other hand, any text that is subordinate to this heading is already displayed.

If you double-click on , all levels below the paragraph become visible. By double-clicking on the , you
hide all levels again.

Tip: By doing this, the heading and its subordinate text are selected at the same time. For more information, see the next section.

Editing text in outline view

In the Outline view (ribbon command View | Outline), you can also theoretically enter, edit and format text.
However, the standard view is better suited for these tasks, and it is recommended that you switch back to
standard view to perform them.

Deleting, copying and moving text

On the other hand, the outline view is especially well suited to deleting, copying and moving headings together
with the associated text.

The easiest way to perform these tasks is to make use of the plus and minus symbols to the left of the headings.
By clicking on one of these symbols, you can select the heading and any subordinate text. You can now delete,
copy or move the contents of your selection with the usual commands in the ribbon tab Home. For more
information, see Working with selections).

To move a heading and its associated text, for example, proceed as follows:

1. Click on the plus  or minus  symbol to the left of the heading. Thus, you select the heading and all its
subordinate text.
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2. Choose the ribbon command Home | Cut.

3. Position the text cursor at the beginning of the line before which you want to reinsert the text that you just
cut.

4. Choose the ribbon command Home | Paste.

The heading and its associated text have now been moved together.

Tip: There are also two shortcut keys available for moving selected text: Alt+Shift+á moves the text one
paragraph up, while Alt+Shift+â moves it one paragraph down.

Formatting headings

There is nothing magical about headings. They are just paragraphs that have been assigned to different outline
levels. Thus, headings can also be formatted at will. Use the familiar format commands for this purpose.

Tip: Format all headings of an entire level (keyword "paragraph styles")

TextMaker formats headings automatically with specific paragraph styles: level one headings are always
formatted with the paragraph style Heading 1, and level two headings with the style Heading 2, etc.

Thus, if you want to change the appearance of all headings at a specific level, all you have to do is edit the
corresponding paragraph style. To do so, proceed as follows:

1. Right-click to open the context menu and select Paragraph style.

Alternatively: Click on the Organize button in the sidebar. For more information, see Paragraph styles.

2. In the dialog box, select the appropriate style from the list. If, for example, you want to change all level one
headings, select the style Heading 1.

3. Click on the Edit button.

4. The program displays a dialog box in which the desired paragraph formatting can be set.

Tip: If necessary, you can also change the character formatting by clicking on the Character button on the
Paragraph tab.

5. Make the desired changes.
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6. Click on OK.

7. Exit the dialog box with Close.

For more information on styles, see Styles.

Note: When you edit the structure of a document in outline view, TextMaker automatically applies the styles
Heading 1...9. You should not attempt to change the names of these styles or to apply other styles to the
headings. Any such attempts would work but not for long, because TextMaker would automatically reapply
its styles when you subsequently changed the outline levels of paragraphs in the outline view.

Expert tip: Managing headings via paragraph styles

When you change the outline level of a paragraph in outline view, nothing much really happens: TextMaker
merely applies one of the paragraph styles Heading 1 through Heading 9.

What would some bright spark make of this? Correct: You can also define headings by simply assigning text
paragraphs to one of the style templates Heading 1 to Heading 9.

If you want to create a new heading, you can also do this without the outline view. Simply type in the heading
and select the desired heading style on the ribbon tab Home | group Styles (or from the sidebar) – done.

You can just as easily change the outline level of a heading. If, for example, you position the text cursor in a
level 2 heading and apply the Heading 3 style, the heading is downgraded to level 3.

This can be done even faster: By default, the shortcut keys Alt+1 to Alt+3 are defined for the styles Heading
1 to 3, and the shortcut Alt+0 is defined for the style Normal. Thus, you can very quickly create headings,
change their levels or demote them to normal text via these key combinations.

Explanation: The outline level is paragraph formatting!

You may now be wondering what styles actually have to do with the outline.

Simply put, the outline level is very common paragraph formatting for TextMaker. If you open the dialog box
on the ribbon tab Home | group Paragraph with the group arrow  in the bottom right corner, you will find an
option called Outline level on the Paragraph tab.

In the styles Heading 1 to Heading 9, this option was set to 1 to 9 accordingly. This is why you can use styles
to change the level of headings.

Note: You should not normally change the option Outline level manually in the dialog box on the
Paragraph tab. To do so, use the outline view or the aforementioned styles. These methods are more
convenient and avoid potential sources of error.
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Practical outlining

To summarize, let's consider how outlines can be applied most effectively to your documents.

Outlining an existing document

Let's assume that you have already typed a document that includes headings and now want to use outlining to
restructure it.

All you need to do is use the ribbon command View | Outline to switch to the outline view and give the
headings the desired outline levels:

1. To do so, move the text cursor to the respective heading

2. Then use the buttons  (higher levels) and  (lower levels) to raise or lower the outline level.

3. Assign outline level 1 to the main headings, outline level 2 to the immediately subordinate headings, and so
on.

To exit the outline view again, choose the ribbon command View | Standard.

Outlining a new document

The procedure for outlining a new document is the same as described above, except that a new document will
have no headings at first.

You can write out the whole document in full and then focus on its outline. Alternatively, you can assign each
new heading to an outline level as soon as you have typed it, using the procedure described above.

Numbering headings

The headings of a large document are often numbered. For example, the main heading is numbered 1, the
corresponding subtopics are numbered 1.1., 1.2., 1.3., and so on.

You can use TextMaker to automatically number the headings of a document. To do so, proceed as follows:

1. Create the document and outline it.

2. Use the ribbon command Home | group Paragraph | Numbered lists to directly apply one of the predefined
heading lists.

Without having to do anything more, a number is immediately applied to each heading in the document in
accordance with its level and your specifications. Thus, main headings are numbered 1., 2., 3., etc., second-
level headings with 1.1, 1.2, 1.3, etc., and so on.

The detailed procedure for doing so is as follows:
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Step 1: Creating and outlining the document

First, you must create the document and outline it, of course. It doesn't matter if you apply the outline right at
the beginning or only after entering the complete text.

For more information on outlining documents, see Outlines.

Step 2: Apply the desired heading list

In the next step, you apply one of the predefined heading lists. To do so, proceed as follows:

1. Under Home | Numbered lists , click on the small arrow of the icon.

2. In the following dropdown menu, select a suitable list from the predefined headings lists in the Headings
lists section.

3. The heading list has now been created.

All existing and subsequently added headings will now be automatically provided with this headings list.

Adjustments to the heading list used

To remove, delete, rename or edit the heading lists used, proceed as follows:

§ Remove the heading list from individual paragraphs: 

To remove the applied heading list from certain paragraphs, select them and open the dropdown menu again
via the ribbon command Home | Numbered lists (click on the arrow of the icon). In the Remove list
section, select None.

Alternatively: Simply click on the icon itself after selecting the paragraphs.

The heading list is now removed from the selected paragraphs.

§ Delete the heading list:

To delete the heading list completely from the document, use the ribbon command Home | Numbered lists
to open the dropdown menu (click on the arrow of the icon) and select Format numbered lists. In the
following dialog box, select the heading list and click on the Delete button.

Note: When you delete a heading list, the numbering is removed from all paragraphs that were formatted
with this list.

§ Rename the heading list:

If you want to rename the heading list, use the ribbon command Home | Numbered lists to open the
dropdown menu (click on the arrow of the icon) and select Format numbered lists. In the following dialog
box, select the heading list and click on the Rename button. Type the desired text.

§ Edit the heading list:

If you don't like the format of the heading list used, you can adjust it individually at any time. Use the ribbon
command Home | Numbered lists to open the dropdown menu (click on the icon's arrow) and select
Format numbered lists. In the following dialog box, select the heading list and use the Edit button to make
individual numbering adjustments.
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Important: In the following dialog box of the Edit button, the options Hierarchical list and Use
paragraph's outline level as list level should be enabled for numbered lists.

You can change the other settings at will. For more information on the individual options, see Creating
numbered lists.

To create a completely new customized heading list, use the New button in the dialog box of the ribbon
command Home | Numbered lists  | Format numbered lists. For more information, see the next section
Creating your own heading list.

Advanced functions: Creating your own heading list

The headings of a large document are often numbered. For example, the main heading is numbered 1, the
corresponding subtopics are numbered 1.1., 1.2., 1.3., and so on.

With TextMaker, you can have the headings of a document numbered automatically and also create the
numbered list individually for this purpose.

To do so, proceed as follows:

1. Create the document and outline it.

2. Create a new numbered list with the desired type of numbering. Apply the option Hierarchical list and also
enable the option Use paragraph's outline level as list level.

3. Assign this numbered list to the paragraph style "Heading 1".

Without having to do anything more, a number is immediately applied to each heading in the document in
accordance with its level and your specifications. Thus, main headings are numbered 1., 2., 3., etc., second-
level headings with 1.1, 1.2, 1.3, etc., and so on.

The detailed procedure for doing so is as follows:

Step 1: Create and outline the document

First, you must create the document and outline it, of course. It doesn't matter if you apply the outline right at
the beginning or only after entering the complete text.

For more information on outlining documents, see Outlines.

Step 2: Create an appropriate numbered list

The next step is to create an appropriate numbered list. To do so, proceed as follows:

1. Under Home | Numbered lists , click on the small arrow of the icon and select Format numbered
lists to open the dialog box.

2. Switch to the Numbered lists tab.

3. Click on the New button.

4. Enter any name for the new numbered list (for example, "Headings") and click on the Edit button.
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5. Important: In the following dialog box, select the option Hierarchical list for Numbered list.

6. Important: You can also enable the option Use paragraph's outline level as list level here.

7. You can change other settings at will or simply retain the default settings. For more information on the
individual options, see Creating your own numbered lists.

8. Confirm with OK.

9. The numbered list is now defined, and you can exit the dialog box by clicking on Close.

Step 3: Assign this numbered list to the paragraph style "Heading 1"

The last step is the actual "highlight": If you now assign the numbered list created above to the paragraph style
"Heading 1", everything will now work by itself – any existing or newly inserted heading will be automatically
numbered.

Even subheadings (second order, third order, etc.) are also numbered, because their styles are all based on the
style "Heading 1".

Proceed as follows:

1. Right-click to open the context menu and select Paragraph style.

2. Select the paragraph style Heading 1 .

3. Click on the Edit button.

4. The program displays the dialog box for editing the style. Switch to the Paragraph tab.

5. Click on the Bullets button.

6. The program displays another dialog box for creating numberings. Switch to the Numbered lists tab.

7. Select the numbered list that you created in step 2.

8. Click successively on OK, OK and Close to exit all dialog boxes.

All existing and subsequently added headings will now be automatically numbered.

Tip: If you don't like the numbering format, you can adjust the numbered list created in step 2 to your liking
at any time. To do so, use the ribbon command Home | Numbered lists  to select Format numbered lists.
In the dialog box, select the list, click on Edit and make the desired changes. These changes will then affect
all headings in the document – including those already numbered.

Note for users of older versions of TextMaker

In older versions of TextMaker, the numbering of headings was not implemented automatically via numbered
lists but by manually inserting "auto number" fields.

If you have old documents in which the headings are still numbered via the old method, you can continue to use
them without restriction, of course. The "auto number" field is still supported by TextMaker.

When creating new documents, however, we recommend that you use the new method. Numbered lists have
several advantages:



486Working with large documents

§ You no longer have to manually insert "auto number" fields before each heading. 

§ Numbered lists are more flexible: more types of numbering and formatting are available.

§ Numbered lists can be easily changed retroactively. If, for example, you want to change the formatting of all
numbers, all you have to do is edit the formatting of the numbered list – the numbers of all headings will
immediately change accordingly.

Outlined documents and chapters

Outlined documents often have page headers and footers in which the reader can find information such as the
title of the current chapter.

Of course, TextMaker allows you to create such headers and footers. The only requirement is that you divide
the document into chapters, which are permitted to have their own headers and footers.

To do so, insert a chapter break before each new topic, usually before each main heading, with the ribbon

command Insert | Break  | Chapter break.

You can now create headers and footers with different content in each chapter. You can also change other
settings relating to page formatting (paper format, page margins, etc.) on a chapter-by-chapter basis.

For more information on working with chapters, see Dividing a document into chapters.
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Tables of references (TOC, index, etc.)
TextMaker provides functions that authors can use to make some of the most time-consuming work associated
with the preparation of large documents much easier:

 With TextMaker, the creation of tables of contents and indices is easy, captions and tables of figures can be
provided for pictures and even bibliographies (for referencing cited literature) can be created:

§ Indices 

For an index, you merely have to tell TextMaker what words are to be indexed, and where they are in the
text. This is done by selecting the word in the text and choosing the ribbon command References | group
Index | Add entry.

If all keywords have been defined, you can create the index with the ribbon command References | group
Index | Generate.

§ Tables of contents 

For a table of contents, you only need to provide your document with an outline, as described in Outlines.
TextMaker already knows the hierarchy of headings.

If you choose the ribbon command References | group Table of contents | Generate, TextMaker creates the
table of contents immediately.

§ Captions and tables of figures 

You can use the ribbon command References | group Captions | Insert caption to insert an automatically
numbered caption below pictures – for example, "Figure 1", "Figure 2", etc.

You can then also use the ribbon command References | group Captions | Generate, which inserts a table
of figures of all pictures with page numbers at the touch of a button.

§ Bibliographies 

For a bibliography, you first create a bibliography database in which you enter all the sources to which you
want to refer. You can now use the ribbon command References | group Bibliography | Insert field to
insert references to these sources into the document.

At the end of the document, you use the ribbon command References | group Bibliography | Generate  to
generate a bibliography that automatically lists all sources used.

§ Bibliographies with Zotero 

This feature is only included in SoftMaker Office Professional and NX Universal.

You also have the option of inserting source references to cited works and of creating a bibliography in
TextMaker via the connection to the literature management program Zotero if you have installed it.

You will find the commands for working with Zotero on the ribbon tab References | group Zotero.
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Our section about tables of references concludes with the following additional information:

§ Updating tables of references 

§ Editing and formatting tables of references

For more information on these topics, see the following pages.

Indices

An index is an alphabetically sorted list of the most important keywords of a document, indicating the pages on
which each of these words occurs.

You will find out how to create such an index on the following pages.

Preparing an index

Before TextMaker can create an index, you must specify the terms that should appear in it. To do so, you add
them to the document's keyword list.

Adding terms to the keyword list

To add a term to the keyword list, proceed as follows:

1. Select the term that should appear in the index. This can be a complete word, a part of a word or a phrase.

2. Choose the ribbon command References | group Index | Add entry .

3. From the dropdown menu, select Add selection.

TextMaker now only remembers the currently selected position of the term. If you want to include all
occurrences of the term in the keyword list, select Add all occurrences from the dropdown menu (see also
below).

Optional: If you want to change the keyword when adding the selected term so that it subsequently appears
in the index as a substitute for the term with a different wording, select More from the dropdown menu.
Enter the desired keyword in the dialog box. You can also enable the option Add all occurrences here in the
dialog box (see below).

You have now added the selected term to the list of keywords. TextMaker not only records the term itself in
this list but also the position in the text where it occurred. When the index is subsequently created, this term
will appear in it, and the number of the page on which the term was selected as a keyword will appear to the
right of the term.

In order for the index to fulfill its purpose, it is thus important to carefully select the location where you include
a term in the keyword list. For example, the word "print" often appears in a word processing manual. However,
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it makes sense to include it in the keyword list only in the section dedicated specifically to the topic of
"printing".

Including keywords multiple times

By the way, the same term can be added to the keyword list multiple times. Such a term appears only once in
the index, but several page numbers are indicated after it.

Note: The case of keywords is ignored. When the keywords "Print" and "print" are added, they appear
summarized in the keyword index under "Print".

Adding all occurrences of a term

In some cases, it makes sense to create an index entry that refers to all passages of text where a term appears.
Of course, you could select every single occurrence of the keyword and add it to the list as described above.
However, TextMaker can relieve you of this task.

When adding a keyword with the ribbon command References | group Index | Add index, select the option
Add all occurrences. TextMaker will then search the entire text for the specified term when it creates the
index, and it will include the page numbers of alloccurrences.

Editing the keyword list

The content of the keyword list can be edited retrospectively at any time.

To do so, choose the ribbon command References | group Index | Edit index entries . The program displays
a dialog box with a list of all keywords. Square brackets after each keyword indicate how often the keyword has
been included in the text.

To edit the keyword list, proceed as follows:

§ Retrieving a keyword entry 

You can find the position at which a specified entry in the keyword list occurs in the text with the Go to
button. To do so, select the keyword from the list and click on Go to. TextMaker places the text cursor at the
position in the text where the term occurs.

If several occurrences of the term were included, the cursor is positioned at the first occurrence. Click on the
Go to button again to jump to the second occurrence, etc.

Note: The Go to button is not available for keywords added with the enabled option Add all occurrences of
the command Add index.

§ Deleting a keyword entry 

The Delete button can be used to remove accidentally added keywords from the list. To do so, select the
keyword from the list and click on Delete.

If the keyword has been included in several text passages, you can use the Go to button to determine
beforehand which occurrence should be deleted (see above).
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The field {Index:'..'}

Finally, some information for advanced users:

When adding to the keyword list, TextMaker inserts an invisible "Index" field behind the selected term. If the
term is, for example, "fish", this index field contains: {Index: 'fish'}.

You can make these index fields visible by enabling the option Display field names on the View tab in the
dialog box of the ribbon command File | Properties (alternatively: on the ribbon tab References | group Fields
| Field names button or simply Alt+F9). This gives you an exact overview of which keywords you have added
at which points in the text.

Tip: Double-click on the index field to subsequently rename the keyword.

However, no index field appears for keywords that have been added to the list using the enabled option Add all
occurrences. They are handled by functions within the program.

Creating the index

A previous section described how to use the ribbon command References | group Index | Add index to specify
which words should appear in the index. When this task is complete, the index can be created.

To do so, proceed as follows:

1. Position the text cursor at the beginning of the line in which the index should be placed.

2. Choose the ribbon command References | group Index | Generate index .

3. Specify whether a new index is to be created at the current position or an existing index is to be updated by
selecting the appropriate option for Placement.

Note: If you have not yet created an initial index in the document or have set the cursor in an existing
index, the selection for Placement is not available and is automatically specified by TextMaker as
required.

As soon as you confirm with OK, TextMaker inserts the index into the text.

Q

Quantum mechanics, 78

R

Raster, 102, 163

Registration card, 11

Right arrow key, 20

Roman, 151

Excerpt from an index (style "with initial letters")
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The keywords appear in alphabetical order. To the right of each keyword, TextMaker inserts the numbers of the
pages on which the keyword appears.

Options of the dialog box

The options in the dialog box for this command have the following functions:

§ Heading 

Here, you can select the desired style of the index:

None: Index entries follow each other without breaks.

Blank line: A blank line is inserted before each index entry that begins with a new first letter.

First letter: A line with the first letter is inserted before each new first letter.

§ Use chapter number 

If you enable this option, the chapter number is also displayed before each page number (separated by a
hyphen).

Of course, it only makes sense to use this option if you have divided the document into multiple chapters

with the ribbon command Insert | Break  | Chapter break. For more information, see Dividing a
document into chapters.

§ Right align page numbers 

If this option is enabled, the page numbers are displayed in the right margin of the index pages.

§ Tab leader 

If the option Right align page numbers is enabled, you can select the character to be used to fill the area
between the index entry and the page number (for example, dots).

§ Placement 

If you have not yet created an initial index in the document or have set the cursor in an existing index, the
selection for Placement is not available and is automatically specified by TextMaker as required.

If you have already created an index in the document and place the cursor in a location that is not in an
existing index, however, the following options are available:

If you select Replace existing index, the existing index is replaced.

If you select Create new index, on the other hand, TextMaker adds another index in addition to the existing
index.

Additional information:

§ For information on updating tables of references, see Updating tables of references. 

§ For information on editing and formatting tables of references, see Editing and formatting tables of
references.
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Tables of contents

A table of contents (TOC) is a list of all headings in the document, each with a page number.

Unlike an index, you do not have to identify the entries that you want to appear in the table of contents
beforehand. Your document merely has to be outlined. For more information, see Outlines.

Based on the outline, TextMaker already knows which headings the text contains and which hierarchy they
have.

Thus, a table of contents is easy to create:

1. Position the text cursor at the beginning of the line in which the table of contents should be placed.

2. Choose the ribbon command References | group Table of contents | Generate .

As soon as you confirm with OK, the table of contents is inserted into the text. If a table of contents already
exists, it will be updated at the existing position.

 The Love Life of Trees.......1

  In Spring...................1

    March.....................1

    April.....................3

    May.......................4

  In Summer...................7

  In Autumn..................10

Excerpt from a table of contents

TextMaker displays the headings on the left. To the right of each heading, the corresponding page number is
displayed. If you click on an entry in the table of contents with the key combination Ctrl + left mouse button,
you can jump to the respective place in the document.

(Android/iOS: In the context menu with the command Go to hyperlink)

Options of the dialog box

The options in the dialog box for this command have the following functions:

§ You can use the option Include levels to specify the outline levels to be displayed in the table of contents.
All levels (1 through 9) are displayed by default. 

§ Show page numbers: If this option is enabled, the table of contents is output with page numbers (including
tab leader).

§ Right align page numbers: If this option is enabled, the page numbers will appear in the right margin, as
shown in the above figure. If you disable the option, the page numbers will be placed directly to the right of
the headings.

§ Tab leader: Here, specify the type of tab leader. Dots are selected in the above figure.
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§ Use hyperlinks instead of page numbers (only for web and EPUB files): If this option is enabled, you will
get the table of contents without page numbers when exporting your document as an HTML file or EPUB
file. Instead, the headings will be displayed as hyperlinks that you can click on to jump to the corresponding
section of text.

§ Use numbering: If you have numbered the headings in the document, they will also be numbered
accordingly in the table of contents when this option is enabled. If you do not want numbering, disable this
option.

For information on numbering the headings of a document, see Numbering headings.

§ Keep tabs after numbering: If the headings in the document are numbered and you have used tabs there,
these are also retained for the table of contents when this option is enabled. If this option is disabled, these
tabs are not included in the table of contents.

§ If you enable the option Use up to first tab, TextMaker checks each heading to see if there are any tabs in
it. If a heading contains tabs, any text behind the first tab is ignored when the heading is imported into the
table of contents.

Additional information:

§ For information on updating tables of references, see Updating tables of references. 

§ For information on editing and formatting tables of references, see Editing and formatting tables of
references.

Captions and tables of figures

You can insert automatically numbered captions below pictures – for example, "Figure 1", "Figure 2", etc. In
addition, you can generate a table of figures of all images thus captioned with minimal effort.

Not only can captions be inserted for images but also for any other part of a document. For example, the tables
in a document can also be captioned.

You can even insert captions for the images and tables in a document, with both of them using their own
numbering. Apart from that, you can insert an individual table of figures for each of them.

Working with captions and tables of figures is actually quite easy:

§ Inserting captions for pictures and other objects 

You can use the ribbon command References | group Captions | Insert caption to insert an automatically
numbered caption into the text.

If, for example, you want to caption the pictures in a document, simply select the respective desired image
and choose this command. TextMaker will insert a caption below the picture. It consists of a label and a
sequential number – for example, "Figure 1".

The numbering is automatic and adjusts automatically when you add or delete captions.

If desired, you can enter an explanatory text after each caption, for example, to extend the caption "Figure 1"
to "Figure 1: The larch".
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§ Generating a table of figures 

If you have inserted captions, you can then insert a table of figures into the text using the ribbon command
References | group Captions | Generate. It lists all captions that you have inserted into the document.

If, for example, you have inserted captions for all pictures in a document, you can then create a table of
these pictures. This also has page numbers so that the reader can see which picture is on which page.

Text entered directly behind a caption also appears in the table of figures. If you have extended the caption
"Figure 1" to "Figure 1: The larch", for example, this exact text will end up in the table.

For more information, see the next pages.

Inserting captions for pictures and other objects

You can use the ribbon command References | group Captions | Insert caption  to insert an automatically
numbered caption into the text.

If, for example, you want to caption the pictures in a document, simply select the respective desired image and
choose this command. TextMaker will insert a caption below the picture. It consists of a label and a sequential
number – for example, "Figure 1".

The numbering is automatic and adjusts automatically when you add or delete captions.

To add a caption to a picture, proceed as follows:

1. Select the picture to which you want to add a caption by clicking on it.

Alternatively, you can place the text cursor in the position where you want to insert the caption – for
example, insert a blank line below the picture and place the text cursor there.

2. On the ribbon tab References | group Captions | Insert caption , click on the small arrow of the icon to
open the dropdown menu.

3. Here, select the label which should appear in the caption – for example, "Figure". Note: You do not
necessarily have to select the label "Picture" for the caption of a picture.

4. Alternatively, select the entry More in the dropdown menu of the command to change further settings via
the dialog box if required (see "Options of the dialog box" below).

TextMaker will now insert the selected label, followed by a sequential number. For example, the entire label is
"Figure 1".

If desired, you can enter an explanatory text directly after each caption, for example, to extend the caption
"Figure 1" to "Figure 1: The larch". This text will also appear in the table of figures (see the next section).

Proceed in the same way for all pictures for which you want to insert captions.

Not only can captions be inserted for images but also for any other part of a document. For example, you can
caption all tables in the document in the same way. Simply select the desired entry in the list.
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Options of the dialog box

You reach the dialog box with additional options by selecting the entry More in the dropdown menu on the

ribbon tab References | group Captions | Insert caption  or by simply clicking directly on the icon itself.

Alternatively: Right-click on the picture to open the context menu and select the entry Insert caption.

The options in this dialog box have the following functions:

§ Labels 

Here, you can select which label to use in the caption.

The selected label will then appear as text in the caption. If you select the label "Figure," the label "Figure
1" will appear in the document.

Note: Each label uses its own numbering. This allows you to add independently numbered captions, for
example, to the pictures and tables in a document. To do so, simply select the label "Figure" for
illustrations and the label "Table" for tables when you insert a caption.

Furthermore, a separate table of figures can be generated for each label (see the next section).

§ Position 

The option Position is available only if you selected the object (for example, picture) to be captioned before
you chose this command. You can use this option to specify whether the caption should be inserted above or
below the object.

TextMaker will automatically insert a new paragraph to make room for the caption. If you have selected an
object that is a frame (for example, a picture frame), TextMaker will automatically insert a text frame above
or below the object and place the caption there.

§ Format 

Here, you can specify in which format the sequential number should be inserted – for example, as Arabic
numbers (1, 2, 3, etc.), as Roman numbers (I, II, II, etc.) or as letters (A, B, C, etc.).

§ Exclude label 

If you enable this option, TextMaker omits the label in the caption and inserts only the sequential number.

Instead of "Figure 1", for example, only "1" is inserted.

§ "New" button 

The New button allows you to create a new label.

The program displays a dialog box in which you can enter the name of the new label. The exact text that you
enter here will appear in the caption. If , for example, you create a label named "Illustration", the text
"Illustration 1" appears in the document when you insert a caption for this label.

As previously mentioned, each label has its own numbering, independent of the numberings of other labels.
Furthermore, a separate table of figures can be generated for each label (see the next section).

§ "Delete" button 

The Delete button allows you to delete a label. Select the label to be deleted beforehand from the list
Labels.
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When you delete a label, all existing captions are retained. However, you will no longer be able to insert
new captions with this label. You also cannot insert or update tables of figures for this label.

Tip: If you inadvertently deleted a label, you can fix it by simply creating a new label with exactly the
same name with the New button.

Notes

§ The label is inserted into captions as fixed text. 

§ The number, on the other hand, is a "sequential number" field type. This field returns a sequential number,
which is increased by one for each subsequent field (that uses the same label). A separate series of
sequential number fields with its own numbering is created for each label. For more information on working
with fields, see Fields.

Generating a table of figures

As described in the last section, you can use the ribbon command References | group Captions | Insert caption
to insert automatically numbered captions into the text. For example, the pictures in a document can be labeled
"Figure 1", "Figure 2", etc. This also works with other parts of a document, such as tables.

Once you have completed this task, you can also create a table of figures and insert it into the text if necessary.
It lists all captions that you have inserted into the document.

If, for example, you have inserted captions for all pictures in a document, you can create a table of these
pictures. This also has page numbers so that the reader can see which picture is on which page.

To insert a table of figures, proceed as follows:

1. As described in the last section, use the ribbon command References | group Captions | Insert caption to
insert any number of captions into the text.

2. Position the text cursor at the beginning of the line in which the table of figures should be inserted.

3. Choose the ribbon command References | group Captions | Generate .

4. In the list Labels, select the label for which a table of figures is to be inserted (for example, "Figure").

5. Specify whether a new table of figures is to be created at the current position or an existing table is to be
updated by selecting the appropriate option for Placement.

Note: The options for Placement are only available once a table of figures has been initially created.
Generate table of figures is thus initially predefined by TextMaker.

When you confirm with OK, TextMaker inserts the table of figures into the text.
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Figure 1...................9

Figure 2..................14

Figure 3..................17

Figure 4..................18

Figure 5..................21

Excerpt from a table of figures

TextMaker displays the label and sequential number on the left; to the right, it inserts a tab followed by the
corresponding page.

If you have typed explanatory text directly after the captions, it will also appear in the table of figures. If, for
example, you have extended the label "Figure 1" to "Figure 1: The larch", this exact text will appear in the
table.

Options of the dialog box

The dialog box for this command has the following options:

§ Labels 

As described in the previous section, different labels can be used in captions. For example, you can insert
captions with the label "Figure" – as well as captions with the label "Table". A separate table of figures can
then be created for each label used.

Here, you can select for which label the table of figures should be generated.

Note: The list only offers labels for which at least one caption has been inserted into the document.

§ Include label and number

As noted before, you can enter an explanatory text directly after captions, for example, to extend the caption
"Figure 1" to "Figure 1: The larch".

This option determines whether the label and the sequential number should also be displayed in the table of
figures.

It is enabled by default. This means that, in the above example, the text "Figure 1: The larch" would appear
in the table of figures.

If you disable this option, only the explanatory text will appear – here: "The larch".

§ Right align page numbers 

If this option is enabled, TextMaker separates the page numbers in the table of figures with a right-aligned
tab (filled with dots).

If disabled, only a space will be inserted to separate the page numbers.

§ Placement 

Use this option to specify what should happen if the document already contains a table of figures for the
selected label:

If you select Replace existing table, the existing table of figures is replaced.

If you select Create new table, on the other hand, TextMaker inserts another table of figures in addition to
the existing table of figures.
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Additional information:

§ For information on updating tables of references, see Updating tables of references. 

§ For information on editing and formatting tables of references, see Editing and formatting tables of
references.

Bibliographies

In the appendices to scientific literature, you often find a bibliography. This is a reference list of all the
publications to which the author refers in this work.

Lorem ipsum dolor sit amet et malesuada fames ac turpis egestas.
Proin pharetra nonummy pede et orci. [DNA1979]

Nunc viverra imperdiet enim [JRRT1954] fusce est vivamus a tellus.

Pellentesque habitant morbi tristique senectus. [TP1983]

[DNA1979]: Douglas Adams, The Hitch-Hikers Guide to the Galaxy
[JRRT1954]: J.R.R. Tolkien, The Lord of the Rings
[TP1983]: Terry Pratchett, The Colour of Magic

TextMaker has useful features that make it much easier for you to work with bibliographies.

The best way to use these features is as follows:

§ Step 1: First, you need a bibliography database. There, you enter all your cited sources. You can use the
ribbon command References | Manage to select Create new database or Use existing database (an
example is provided within the SoftMaker folder). 

The database can be constructed as desired, but must contain a field with a unique "abbreviation" for the
source. There must also be fields for the author and title of the source.

§ Step 2: Then choose the ribbon command References | Manage | Bibliography settings to open a dialog
box and assign this database as a bibliography database to the document using the File button. In the dialog
box, specify which database fields contain the abbreviation for cross-references, the author and the title. 

§ Step 3: You can now insert references in the text to the sources entered in the bibliography database (for
example, "As mentioned in [DNA1979], ...") using the ribbon command References | Insert field. 

§ Step 4: At the end of the document, you can finally generate a bibliography with the ribbon command
References | Generate. This lists all the records in the bibliography database for which you have inserted
references into the text (see step 3). 

For more information on using these functions, see the following pages.
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Step 1: Creating and editing the bibliography database

In order to be able to use the bibliography functions, you first need a bibliography database. This can be a
database in SQLite or in dBASE format in which all source information must be entered.

You can create a separate bibliography database for each document. If you are writing documents that use the
same sources, you can also use a common database for those documents, of course.

Structure of a bibliography database

A bibliography database must contain at least the following fields:

§ A field for a unique abbreviation for the source (see below) 
§ A field for the name of the author of the source 
§ A field for the title of the source 

The abbreviation must be different for each source. As a rule, the author's initials and the year of publication
are used for this purpose. If, for example, the source were a book published by the author Harry Smith in 1979,
HS1979 (or HS79) would be used as the abbreviation.

Apart from the three mandatory fields listed above, the database may be structured as desired, thus it may also
contain, for example, fields for the date of publication, the publisher, etc.

Tip: In the TextMaker document folder, there is a simple example database called biblio.sqlite which
you can use for practice purposes. On Windows, this file can be found in the SoftMaker folder below your
user directory.

Creating a new bibliography database

If you do not want to access an existing bibliography database, you must create a new database. To do so,
simply use TextMaker's database module.

To create a new bibliography database, proceed as follows:

1. Choose the ribbon command References | group Bibliography | Manage | Create new database.

2. Give the database any name, select the desired database format SQLite or dBASE from the list Save as type
and confirm saving.

For more information on the database formats SQLite or dBASE and on using the dialog box described in 3.,
see Creating a new database.

3. In the following dialog box, add the required fields to the database. In any case, the database must contain
fields for the unique abbreviation of the source, for the author and for the title.

4. When you are finished, click on Create.

5. TextMaker now creates the database and opens it in the database module. If you now want to enter your
sources into the database, you can do so.

Otherwise, click on the Close database icon  to exit the database module.
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Editing the bibliography database

The bibliography database must then be filled with sources, of course, if this was not already done when
creating it. Thus, enter the sources to which you refer in the document into the database. Of course, it is up to
you if you want to enter all sources at once or add sources only as required.

To do so, open the bibliography database in the TextMaker database module by choosing the ribbon command
References | group Bibliography | Manage | Edit database. For more information on using the database
module, see Database.

Step 2: Assigning the bibliography database

In the next step, you tell TextMaker what database you want to use as the document's bibliography database.
You must also specify which fields in this database contain the abbreviations for references, authors and titles.

To do so, proceed as follows:

1. Open the document for which you want to use the bibliography database created in Step 1, or start a new
document.

2. Choose the ribbon command References | group Bibliography | Manage | Bibliography settings.

3. If you are still in the document from Step 1, the database is still assigned and you can jump straight to point
4.

If you have started a new document, however, the created bibliography database is not yet assigned. In this
case, click on the File button. A file dialog box appears. In the dialog box, go to the directory containing the
bibliography database, select the database in it and open it.

4. In the dialog box Bibliography settings, you must now specify which fields of this database contain the
cross-reference (abbreviation), the author and the title. To do so, select these fields from the three dropdown
lists in the Settings section.

5. In the Reference style section, you can also specify how the references that you can insert in Step 3 should
be displayed if necessary.

6. When you are satisfied with all settings, confirm with OK.

TextMaker now knows which database contains information about the sources for this document and how this
information is distributed over the database fields. Thus, you can proceed to step 3.

Step 3: Inserting references to sources

When you have completed steps 1 and 2, you can insert bibliography fields in the text. These are references to
sources that are stored in the bibliography database.

Use such a reference if you refer to one of the sources in the text – for example "As mentioned in
[DNA1979], ...".
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You insert a reference to a source into the text as follows:

1. Move the text cursor to the desired position.

2. Choose the ribbon command References | group Bibliography | Insert field .

3. Select the desired database entry directly from the dropdown list that appears.

Optional: The last entry More opens a dialog box. Here, you can also select the desired database entry from
the list References.

Furthermore, this dialog box contains the following options:

Search/Search again: Use these buttons to search the bibliography database for a specific term. The dialog
box that now appears corresponds to the descriptions in Searching a database.

Edit: This button allows you to open the bibliography database in the Database module and to edit its
content there, for example, add a new entry.

Additional information: In this field, you can enter an additional text such as "Page 42" for an entry from
the list References. This text is then appended to the reference, separated by a comma.

Finally, click on OK to insert the selected entry from the list References.

4. The reference is now inserted into the text. Depending on the options selected in the bibliography settings
dialog box, either the abbreviation or the number of the source will appear in the text (see below).

Proceed as described above for each source to which you refer in your document.

Options for reference style

The bibliography settings dialog box allows you to change the appearance of references if necessary. For
example, you can specify whether they should appear as abbreviations taken from the database or as
automatically generated numbers.

To do so, choose the ribbon command References | group Bibliography | Manage | Bibliography settings and
make the desired settings in the Reference style section.

The following options are available:

§ If you select Use reference field, references display the "abbreviation" entered in the database for the
source – for example, [DNA1979]. 

§ If you select Number entries, on the other hand, references display an automatically generated number for
the source – for example, [42]. 

The source for the first reference that you insert gets the number [1], the source for the second reference gets
the number [2], etc.

Note: When you switch between these two options, all references in the document immediately change
their appearance accordingly. However, the bibliography (if it already exists) is not adjusted until you
update it. For more information, see Updating tables of references.

§ The option Parentheses allows you to specify the type of parentheses within which the references will be
enclosed. 

If, for example, you use the setting { } instead of the default setting [ ], references will be enclosed within
curly braces rather than within square brackets. Thus, {DNA1979} will then appear instead of [DNA1979].
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Step 4: Generating the bibliography

In the final step, you let TextMaker generate the bibliography at the end of the document. This lists all the
records in the bibliography database for which you have inserted references into the text (as described in step
3).

To insert a bibliography, proceed as follows:

1. Position the text cursor at the beginning of the line in which the bibliography should be placed.

2. Choose the ribbon command References | group Bibliography | Generate .

3. Specify whether a new bibliography is to be generated at the current position or whether an existing
bibliography is to be updated by selecting the appropriate option for Placement.

Note: Placement options are only available once a bibliography has been initially generated. Generate new
bibliography is thus initially predefined by TextMaker.

4. In the large input field below, you can also change the appearance of the bibliography (see below).

When you confirm with OK, TextMaker inserts the bibliography into the text.

Note: As mentioned at the beginning, only those records of the bibliography database for which you have
actually inserted references into the text appear in the bibliography (see step 3).

Changing the appearance of the bibliography

Before clicking on OK to close the aforementioned dialog box, you can change the appearance of the
bibliography if necessary:

Editing text: You can edit the text specified in the input field at any time. The well-known editing commands are
available for this purpose.

Changing formatting: The formatting can also be changed. To do so, first select the desired section of text in the
input field, and then use the miniature formatting toolbar displayed above it to change the character format.

Inserting fields: Fields from the bibliography database are indicated with curly braces. You can also insert
additional fields into the input field by simply typing them (for example, {AUTHOR}) or by double-clicking on
the desired field in the list Fields.

Tip: The first item in the list Fields is a field named {#REF}. This field is created automatically and has the
following special feature: It contains either the abbreviation or an automatically generated number for the
source, depending on which of these two options you selected for Reference style in the bibliography settings
dialog box.

Additional information:

§ For information on updating tables of references, see Updating tables of references. 
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§ For information on editing and formatting tables of references, see Editing and formatting tables of
references.

§ For information on creating Bibliographies with Zotero, see the next section.

Bibliographies with Zotero

This feature is only included in SoftMaker Office Professional and NX Universal. It is not available in the
Android or iOS version. Linux: Make sure to use the Zotero package from zotero.org, as unofficial snap,
DEB, or RPM packages can cause problems.

The previous section described how to create a bibliography using a bibliography database via the commands of
the ribbon tab References | group Bibliography.

Another way to insert source references to cited works and to create a bibliography is enabled in TextMaker via
the connection to the literature management program Zotero.

To do so, use the commands on the ribbon tab References | group Zotero.

Preparation: Install Zotero

If you do not already have Zotero installed on your computer, download the program from the manufacturer's
website and create a list of works that you would like to cite in Zotero.

Tip: For the 32-bit version of TextMaker, install the 32-bit version of Zotero.

Inserting references to Zotero sources in TextMaker

Note: Zotero must be open before you can insert the sources into TextMaker.

To insert source references from Zotero into a TextMaker document, proceed as follows:

1. Move the text cursor to the place in the text where the reference is to be inserted.

2. Choose the command References | group Zotero | Insert/edit citation .

3. In the Zotero bar, type a letter string (at least two letters) of the desired source. Zotero will then suggest a
list of hits that you can select via a mouse click.
Alternatively, click on the Z icon in the Zotero bar and select Classic view to display the available sources
clearly arranged in a dialog box.

Note: When you insert the first reference from Zotero into your current document, the dialog box Zotero -
Document Preferences automatically appears. (Note: This dialog box is usually hidden in the background of
the Zotero application.) Specify the Citation Style and other options here. These settings only need to be set
once for the current document and can always be changed later via the command Document preferences.
For more information, see below.

4. Press the Enter key ¿ to confirm.
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The source reference is now inserted as a footnote, endnote or field, depending on your choice of citation style
in the dialog box Zotero - Document Preferences.

Editing references

To edit an existing reference, select it in the text and choose the command Insert/edit citation again.
Alternatively: Double-click on the reference. The program displays the Zotero bar, which shows you the
existing source. You can now add another source or remove the displayed source in the Zotero bar as needed.

To add more information to the existing source in the Zotero bar (for example, a page number or a prefix such
as "cf."), click on this source in the Zotero bar. The program opens a small window in which you can enter the
desired additional information in the corresponding fields.

Please also note here: The Zotero bar may be hidden in the background of the Zotero application in some cases.

Tip: To confirm your entries in the Zotero bar, press the Enter key¿.
To exit the open Zotero bar without entering anything, press the Esc key.

Generating and editing a bibliography

You use the bibliography to list all sources for which you have included references in the text.

To generate a bibliography, proceed as follows:

1. Position the text cursor at the beginning of the line in which the bibliography should be placed.

2. Choose the command References | group Zotero | Insert/edit bibliography .

The bibliography is inserted into TextMaker.

If you want to manually revise Zotero's bibliographical references, choose the command Insert/edit
bibliography again. In the dialog box Edit Bibliography, make the desired adjustments and confirm with OK.
The bibliography will then be updated with the modified bibliographical references.

Updating references and the bibliography

If you subsequently make changes to the source data in the Zotero database (for example, author, year of
publication, etc.), you will usually also want to update the relevant information in the references and in the
bibliography of your TextMaker document. Thus, all information generated from Zotero can be updated for the
current document at the click of a button.

To do so, choose the ribbon command References | group Zotero | Refresh .

Changing document settings

If you choose the ribbon command References | group Zotero | Document preferences , you open the
dialog box Zotero - Document Preferences. Here, you can specify the Citation Style in which the references in
the text and the bibliography will be displayed for your current TextMaker document.

Depending on the chosen citation style, you can select from various options, such as whether you want to create
the references as footnotes, endnotes or reference marks (fields).
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Unlinking citations

The ribbon command References | group Zotero | Unlink citations  unlinks the current TextMaker
document from Zotero. The references and bibliography in this document, which were created from Zotero, can
then no longer be edited via Zotero.

Additional information:

§ For information on editing and formatting tables of references, see Editing and formatting tables of
references. 

Updating tables of references

Important: If you insert a table of references (table of contents, index, table of figures or bibliography) into
a document and then continue editing the text, these tables of references are not automatically updated on an
ongoing basis.

Thus, if the page numbers of the document change because you type additional text, the tables of references
will still display the old page numbers. If, for example, you add new headings, the table of contents does not
expand automatically.

To ensure that a document's tables of references reflect the current state of the document, you must update
them. To do so, proceed as follows:

§ For the index, choose the command References | group Index | Generate to open the dialog box again and
confirm with OK.* 

The faster alternative: References | group Index | Update 

§ For the table of contents, choose the command References | group Table of contents | Generate to open the
dialog box again and confirm with OK. 

The faster alternative: References | group Table of contents | Update 

§ For the table of figures, choose the command References | group Captions | Generate to open the dialog
box again and confirm with OK.* 

The faster alternative: References | group Captions | Update 

§ For the bibliography, choose the command References | group Bibliography | Generate to open the dialog
box again and confirm with OK.* 

The faster alternative: References | group Bibliography | Update 

§ For the bibliography with Zotero, choose the command References | group Zotero | Refresh .
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* Important: Make sure that the option "Replace existing ..." is selected for Placement when you proceed via
the dialog box. For the alternative path directly via the ribbon command Update, the existing table of
references is always replaced automatically.

TextMaker now removes the existing table of references and replaces it with an updated version.

Note: Before printing a document containing tables of references, always remember to update the tables, so
that they reflect the document's current state.

Editing and formatting tables of references

In theory, tables of references (tables of contents, indexes, tables of figures, bibliographies) can be edited just
like normal text. However, you should take note of the following:

Important: If you manually change the content or formatting of a table of references, your changes will be
lost the next time you update the table of references, as TextMaker removes and reinserts it.

As a result, manual changes to text or formatting in a table of references only make sense when your document
is 100% ready for printing and the table will not have to be updated again.

Text changes are usually unnecessary in tables of references anyway, and you can change the formatting in a far
more convenient manner. This is because tables of references are automatically formatted with Paragraph styles
that make it easy to change the formatting.

When you create one of the aforementioned tables of references, TextMaker generates the following paragraph
styles:

§ "TOC 1" to "TOC 9" 

These are paragraph styles for each level of the table of contents. The first outline level (i.e. the main
headings) is formatted with the "TOC 1" style, the second level with "TOC 2" and so on.

§ "Index" 

The paragraph style for entries in the index

§ "Index heading" 

The paragraph style for the initial letters that are used as headings for sections of the index (if the option
First letter was enabled when creating the index)

§ "Caption" 

The paragraph style for captions

§ "Table of figures" 

The paragraph style for entries in a table of figures

§ "Bibliography" 

The paragraph style for entries in the bibliography or in the Zotero bibliography
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If, for example, you want the main headings in the table of contents to be displayed in a larger font, you only
have to change the "TOC 1" style accordingly:

1. Right-click to open the context menu and select the entry Paragraph style.

2. Select the "TOC 1" style in the list and click on Edit.

3. The program displays a dialog box in which you can change the formatting. Switch to the Paragraph tab.

4. Click on the Character button.

5. Select the desired font size in the Size field.

6. Exit the dialog boxes by clicking successively on OK, OK and Close.

The main headings in the table of contents are now displayed in the new font size. This formatting will remain
in effect after you update the table and even if you remove and reinsert it.

For general information on using styles, see Styles.
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Cross references
You can use the ribbon command References | Cross reference to insert a reference to a specific text element
(for example, a bookmark) into the text.

This command inserts a field that displays, for example, the page number of the target text element. You can
jump to this target element using the key combination Ctrl + left mouse button.

Cross-references can be created with respect to the following text elements:

§ Bookmarks 
§ Footnotes/endnotes
§ Headings
§ Captions (for table, figure, image)

Cross-references to bookmarks are common in larger documents. Bookmarks can be placed anywhere in the
document.

If, for example, you want to insert a cross-reference to the index at the end of your document, first put a
bookmark at the beginning of the index. Type something like "See also the index as of page" in the desired
place in the document, and add a cross-reference to this bookmark. The cross-reference now shows the number
of the page on which the index begins.

Cross-references are updated automatically before the document is printed. If desired, they can also be updated
manually with the ribbon command References | group Fields | Update fields.

See the following pages for more detailed information on working with cross-references.

Inserting cross references

To insert a cross-reference in the text, proceed as follows:

1. If you want to create a cross-reference to a bookmark, for example, you must first set a bookmark at the
desired target position using the ribbon command Insert | group Links | Bookmark. For more information,
see also Bookmarks.

2. Then move the text cursor to the position in the text where the cross-reference is to be inserted.

3. Choose the ribbon command References | Cross reference .

Alternatively: Insert | group Links | Cross reference

4. For Type, select the type of target position for which the cross-reference should be created: a Bookmark, a
Heading, etc. In our example, it is a bookmark.

5. For Target, select the specific bookmark (or heading, etc.) to which the cross-reference should refer.

6. For Show, select the information which you want the cross-reference to display for the target position, for
example, the Page, the Number, etc. (For more information, see "Options of the dialog box" below.)
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7. Confirm with OK.

TextMaker now inserts the cross-reference into the text and you can jump to the target position at any time by
clicking on the cross-reference with the key combination Ctrl + left mouse button.

(Android/iOS: In the context menu with the command Go to hyperlink)

Note: If cross-references are not displayed correctly, you have to update the fields, for example, by pressing
the F9 key or by using the ribbon command References | Update fields.

Options of the dialog box

The options in the dialog box for this command have the following functions:

§ Type 

Here, you specify where to create the cross-reference: to a Bookmark, or a Footnote/Endnote, or a
Heading or to a caption (Table, Figure, Picture).

§ Target 

Here, you select the target for the cross-reference. If, for example, you set the Type to Bookmark, a list of
all bookmarks in the document appears here. Click to select the desired bookmark from the list.

§ Show 

Here, you specify what the cross-reference should show. Depending on the Type selected above, the
program displays a different selection of the following options:

Page: The cross-reference shows the number of the page on which the target is to be found.

Number: The cross-reference shows the number of the target itself:

For footnotes or endnotes, the number of the footnote/endnote is shown.

For bookmarks or headings, however, the number of the paragraph in which the bookmark/heading has been
set is shown. To do so, the paragraph must be numbered via the command Bullets and numbering (right-
click to open the context menu and select the command). If this is not the case, the cross-reference displays a
zero.

Text: The cross-reference shows the plain text of the target.

Relative position: If the target is above the current position of the cross-reference, the cross-reference
displays "above". If the target is below, "below" is displayed.

The following options for Show only appear for captions that you can find in the above Type list as Table,
Figure or Picture. This involves the sequentially numbered captions, such as those used to create a table of
figures, rather than the objects themselves. (For more information, see section Captions and tables of
figures.)

Full text: The cross-reference shows the label and sequential number of the caption. It also shows the
explanatory text added to a caption. Example: "Figure 2: The larch"

Caption number: The cross-reference shows the label and sequential number of the caption. Example:
"Figure 2"

Caption text: The cross-reference shows only the explanatory text that was added to a caption. Example:
"The Larch"
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Editing and updating cross references

Cross-references are fields. Thus, the same applies to them as to all fields: They can be formatted, deleted,
copied and moved like normal text, but their content cannot be edited directly.

However, you can always change the type or target of a cross-reference. To do so, double-click on the cross-
reference and make the required adjustments for Type, Show or Target in the aforementioned dialog box (see
previous section).

Tip: If you want to see which cross-references in the document refer to which targets, you can enable the
option Display field names in the dialog box of the ribbon command File | Properties, View tab
(alternatively: on the ribbon tab References | group Fields | Field names button or simply Alt+F9).
 All cross-references then display the type and target of the cross-reference instead of the page number – for
example: {cross-reference.bookmark.page:name_of_textmark}.

Updating cross-references

Just like all other fields, cross-references are not updated automatically. If, for example, you move the target of
a cross-reference to another page, the cross-reference will still display the old page number.

When you print the document, however, TextMaker automatically updates all fields (including cross-
references). Thus, you can be sure that all cross-references are correct when you print the document.

If necessary, you can also manually update the fields of a document by choosing the ribbon command
References | group Fields | Update fields. All fields and calculations are then updated.

Invalid references: If you delete the target of a cross-reference, it becomes invalid, of course. The cross-
reference then displays the text "Target not found!" when you update the document. You can correct this
problem by removing the cross-reference and inserting a new one (with a valid target).

Style references
In addition to cross-references (see previous pages), you can also insert style references into the text.

A style reference is a field that works as follows: It searches the document (from the place where you inserted
it) backwards for text that is formatted in the paragraph style you selected – and then displays this text.

This can be useful, for example, in the following situation:

Large documents are usually organized according to an outline, and thus have headings with several levels. The
easiest way to achieve this is to format the headings in the predefined paragraph styles "Heading 1", "Heading
2", etc. If you now insert a style reference field into any place in the text and let it search for the style "Heading
1", for example, the field automatically finds the main heading valid for this place in the text and displays it.
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Such fields are most often used in the headers or footers of books and other large documents in order to display
the main heading of the current chapter.

Inserting a style reference field

To insert a style reference field into the text, proceed as follows:

1. Move the text cursor to the place in the text where the style reference field is to be inserted.

2. Click on the arrow of the icon on the ribbon tab References | group Fields | Field.

3. Click on the entry Style reference in the dropdown menu, and select the style for which you want to search
from the submenu.

Alternatively, click on the entry More in the dropdown menu (or on the Field icon itself) to open the dialog
box with further options (see below).

4. Only in the dialog box: Click on the Insert button.

TextMaker now inserts the style reference field into the text.

The field then automatically searches for text formatted with the specified paragraph style. It first searches
backwards (towards the beginning of the document). If nothing is found in this direction, it also searches
forwards (towards the end of the document).

As soon as the program finds text formatted in the desired style, the field displays that text. If, for example, you
had selected the paragraph style "Heading 1", the field would display the current main heading for the section
of text in which the field was inserted. (Of course, this assumes that all headings in the document have been
formatted with the paragraph style "Heading 1".)

If nothing is found, the field shows the error message "Style reference: No matching text found!". Then verify
that you are looking for the correct style and that there is actually text that was formatted in this style.

Options of the dialog box

The dialog box contains the following options:

§ Style 

In this list, select the style for which you want to search.

§ Search for character styles 

Usually, style reference fields are used to search for paragraph styles. However, you can also search for
character styles by enabling this option. The Style list then contains character styles rather than paragraph
styles.

§ Search page from bottom 

This applies only to style reference fields inserted into headers or footers because they use a special search
order:

First, only the current page is searched for text in the selected style in the following direction:

If this option is disabled, the program searches the page from top to bottom.

If this option is enabled, the program searches the page from bottom to top (backwards).
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The search will then continue "normally" regardless of this option: So the pages before the current page
(backwards) are first searched. If nothing is found, the pages after the current page are also searched
(forwards).

§ Insert paragraph number 

If this option is enabled, the style reference field returns the numbering of the text rather than the actual text
formatted in the desired style.

Of course, this only works if numbering has been applied to the text. For more information, see also
Automatic numbering and Numbering headings.

§ Insert "above" or"below" 

If this option is enabled, the style reference field no longer returns the text formatted in the desired style
but only the specified position "above" or "below":

If the location is above the field, the field returns the text "above".

If the location is below the field, it returns the text "below".

In this way, references such as "see above" or "see below" can be inserted.

Updating style reference fields

Like all types of fields, style reference fields are updated automatically before the document is printed. If
desired, they can also be updated manually with the ribbon command References | group Fields | Update
fields. For more information on working with fields, see Fields.
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Footnotes and endnotes
When a word or phrase in your text requires explanatory comments, you can place such comments in footnotes
or endnotes.

§ Footnotes usually appear at the bottom of the page. You can also have them displayed below the text. 

§ Endnotes are also basically footnotes. The only difference is that they are displayed collectively at the end of
the document. However, you also have the option of having endnotes displayed at the end of each chapter. 

In TextMaker, it is always possible to subsequently convert footnotes into endnotes and vice versa.

See the following pages for all information on inserting, editing, and formatting footnotes. The descriptions for
endnotes will then follow in a separate section.

Footnotes

Footnotes always consist of two parts: a footnote reference mark as a superscript in the body text and the
associated footnote text in the bottom footnote area:

When you encounter heavy fog1, you should immediately slow down2 and turn on your fog
lights.

_______________

1 Visibility less than 150 feet

2 Maximum 30 mph

An example of the use of footnotes

TextMaker automatically numbers footnotes sequentially. If you insert a new footnote into the text or delete an
existing footnote, the numbers of all subsequent footnotes change accordingly.

By default, TextMaker automatically inserts a separator between the text and the footnote area. If desired, this
can be reformatted or disabled.

In this section, you will learn everything you need to know about footnotes. The information covers the
following topics:

§ Inserting and editing footnotes 

§ Changing the formatting of footnotes

§ Footnote options
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Inserting and editing footnotes

In TextMaker, you can quickly add a footnote to a text passage. Simply choose the ribbon command
References | Footnote after this text passage, and then type in the footnote text. TextMaker automatically
performs the numbering, placement and formatting of the footnotes for you.

To do so, proceed according to the following detailed steps:

1. Position the text cursor immediately after the term for which you want to create a footnote.

2. Choose the ribbon command References | group Footnotes | Footnote  (or Insert footnote via the small
arrow of the icon).

Alternatively: Insert | group Header and footer | Footnote

3. TextMaker now inserts a footnote mark as a superscript (an automatically generated sequential number) for
this footnote.

A footnote area is then automatically created in the bottom margin of the page, the same number is entered
there and the text cursor is placed behind it.

4. You can now type the text for this footnote.

To return from the footnote area back to the body text, simply click anywhere in the body text of the document.
Alternatively, you can use the ribbon command References | group Footnotes | Go to reference, which will
take you back to the appropriate footnote in the text.

Changing footnote text retrospectively

The footnote text in the bottom margin of the page can be edited at any time. All you have to do is position the
text cursor in the footnote area. You can use one of the following procedures:

§ Scroll to the page containing the footnote you want to change, and click in the footnote area in the bottom
page margin. 

Note: This only works in standard view. If you are in a different view, you must first use the ribbon command View | Standard to
switch to the standard view.

§ You can use the ribbon command References | group Footnotes | Go to footnote to let TextMaker search
for the next footnote in the text. If found, TextMaker automatically places the text cursor in the
corresponding footnote text in the footnote area. 

You can now edit the footnote text. You already know how to get back to the body text: simply click on any
text passage or use the command Go to reference.

Tip 1: Within the footnote area, you can use the arrow keys â and á to move to the next or previous
footnote text.

Tip 2: The key combination Ctrl + left mouse button on the footnote mark will take you from the body text
to the footnote area and vice versa. (Android/iOS: In the context menu Go to hyperlink)
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Inserting footnotes again

If you accidentally deleted the footnote number in a footnote text, you can insert it again at any time:

To do so, choose the ribbon command References | Footnote  | Insert footnote mark.

Moving, copying or deleting footnotes

Sections of text containing footnotes can be moved, copied or deleted in the usual manner. TextMaker
automatically rearranges the footnote texts and automatically corrects the numbering.

However, you should observe the following rule:

Important: If you want to copy, move, or delete footnotes, you should always do so in the text – and not in
the footnote area in the bottom margin of the page.

If, for example, you delete the footnote text of a footnote in the footnote area, the footnote is still preserved –
only its footnote text is empty. If you select and delete the footnote marker in the text, however, the whole
footnote (marker and text) is removed, and all remaining footnotes are renumbered.

Influencing the numbering of footnotes

As mentioned above, footnotes are numbered automatically – so you don't have to worry about them. If
necessary, however, you can manually influence the numbering as follows:

§ Changing the number of an individual footnote 

To change the number of an individual footnote, place the cursor behind it and choose the ribbon command
References | Footnote  | Change numbering. The program displays a dialog box in which you can
change the numbering of this footnote from Auto numbered to Custom and then enter the desired number.

Tip: You can also open this dialog box by double-clicking on the footnote.

§ Changing the overall numbering of footnotes 

To change the numbering of all footnotes in the document, choose the ribbon command References |
Footnote  | Footnote options. In this dialog box, you can set the start value and the type of numbering,
among other things. For more information, see Footnote options.

Converting footnotes into endnotes

Footnotes appear at the end of a page by default. If you want them to appear at the end of the document, you
have to use endnotes. You can also convert existing footnotes into endnotes at any time, both individual and all
footnotes of the document.

§ Converting an individual footnote into an endnote 

To change an individual footnote into an endnote, position the text cursor behind it and choose the ribbon
command References | Footnote  | Change numbering. The program will display a dialog box in which
you enable the checkbox Convert to endnote.

Tip: You can also open this dialog box by double-clicking on the footnote.
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§ Converting all footnotes into endnotes 

To change all footnotes in the document to endnotes, choose the ribbon command References | Footnote 
 | Footnote options. In this dialog box, you can click on the Convert button to make the desired adjustment.

Changing the formatting of footnotes

You can change both the formatting of the footnote text and the footnote marker (the footnote number) at any
time.

Formatting footnote text

To change the formatting of the text of an individual footnote, simply position the text cursor in the footnote
text and apply the desired formatting.

Tip: If you want to change the formatting of the text for all footnotes in the whole document, TextMaker can
save you a lot of work. All you have to do is change the paragraph style "Footnote Text", which TextMaker
automatically creates as soon as you insert the first footnote.

By default, the text of all footnotes is formatted with this paragraph style. As long as you have not manually
changed the formatting of the footnote texts, changes to the "Footnote Text" style will affect all footnote texts
in the document.

To edit this style, proceed as follows:

1. Right-click to open the context menu and select Paragraph style.

2. Select the "Footnote Text" style in the list, and click on Edit.

3. The program displays a dialog box in which you can change the formatting. Make the desired changes there.
Tip: You can also change the character formatting by clicking on the Character button on the Paragraph
tab.

4. Exit the dialog boxes with OK and then Close.

For general information on using styles, see Styles.

Formatting footnote marks

The footnote mark (i.e. the footnote number) of footnotes is automatically added as a superscript by TextMaker.
However, you can change the marker's character formatting according to your preference. Select the footnote
mark, right-click to open the context menu and select Character to open the dialog box (alternatively: choose
the ribbon tab Home | group Character with the group arrow ). Make the desired changes in the dialog box.

Tip 1: All footnote marks are automatically formatted with the "Footnote Reference" character style (note:
character style, not paragraph style!). If you edit this style via the context menu with the entry Character
style, all footnote marks in the document change their appearance accordingly.
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Tip 2: The sidebar is recommended to enable you to orient yourself better with respect to formatting
footnotes via paragraph styles/character styles. It will be easier for you to identify footnote text (function:
Paragraph style) and footnote marks (function: Character style) here.

Footnote options

You can use the ribbon command References | Footnote | Footnote options  to change settings for the
footnotes in the current document.

It opens a dialog box with the following options:

Position

The footnote texts are usually displayed in the bottom margin of each page. Change the option Position if you
want them to appear in a different location:

§ Bottom of page 

This is the default setting – the footnote texts are displayed at the end of each page.

§ Below text 

The footnote texts appear directly below the text.

Layout

If necessary, you can divide the footnote area into multiple columns, and the footnote texts are then distributed
among the number of columns that you set here.

The default setting here is Use section layout. The division of the footnote area is thus automatically based on
the column formatting of the text area in which the footnote is located. (For more information on sections, see
What are sections?.)

Numbering

Here, you can make settings for the automatic numbering of footnotes:

§ Type 

Here, you can change the type of numbering. For example, you can also use letters in addition to numbers.
The footnotes are then represented by A, B, C, etc., rather than by 1, 2, 3, etc.

§ Start at 

Here, you can specify the number with which the counting should start. The default value is "1". If, for
example, you enter "42", the first footnote will be given the number 42, the next 43, and so on.

§ Mode 

Here, you can specify whether the footnote numbering should be reset to "1", for example, on each page or
each chapter:
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Continuous numbering: The numbering is never reset. This is the default setting.

Restart on each page: The numbering is reset to "1" at the beginning of each page of the document.

Restart on each section: The numbering is reset to "1" at the beginning of each section. (For more
information on sections, see What are sections?)

Restart on each chapter: The numbering is reset to "1" at the beginning of each chapter. (For more
information on chapters, see Dividing a document into chapters.)

Separator line margins

Here, you can set the margins for the separator line that is inserted automatically above the footnote section:

The Top margin determines the minimum spacing between the text and the separator line, while the Bottom
margin determines the spacing from the separator line to the footnote texts.

As you increase the Left margin, the separator line starts further to the right; as you increase the Right margin,
the separator line ends earlier.

"Separator line" button

Click on this button if you want to change the appearance of the footnote line inserted above the footnote area.

For example, to change the thickness of this line, select the desired line thickness in Line style / Thickness.

If you don't want the footnote separator line to appear at all, select the option No line from the list Line style.

"Convert" button

If you want to convert all footnotes in the document into endnotes so that they appear at the end of the
document by default, click on the Convert button. In the dialog box that then opens, you can make the desired
adjustments.

Endnotes

Endnotes, like footnotes, always consist of two parts: an endnote mark as a superscript in the text and the
associated endnote text in the bottom endnote area. Unlike footnotes, endnotes are positioned at the end of the
document by default or at the end of each chapter.

TextMaker automatically numbers the endnotes sequentially. Thus, if you add a new endnote somewhere in the
text or delete an existing endnote, the numbers of all subsequent endnotes will change accordingly.

By default, TextMaker automatically inserts a separator line between the text and the endnote area. If desired,
this can be reformatted or disabled.

In this section, you will learn everything you need to know about working with endnotes. The information
covers the following topics:

§ Inserting and editing endnotes 
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§ Changing the formatting of endnotes

§ Endnote options

Inserting and editing endnotes

In TextMaker, you can quickly add an endnote to a text passage. Simply choose the ribbon command
References | Endnote after this text passage, and then type the endnote text. TextMaker automatically
performs the numbering, placement, and formatting of the endnotes for you.

To do so, proceed according to the following detailed steps:

1. Position the text cursor directly behind the term for which you want to create an endnote.

2. Choose the ribbon command References | group Footnotes | Endnote  (or Insert endnote via the small
arrow of the icon).

Alternatively: Insert | group Header and footer | Endnote

3. TextMaker now inserts an endnote mark as a superscript (an automatically generated sequential number) for
this endnote.

An endnote area is then automatically created at the end of the document, the same number is entered there
and the text cursor is positioned behind it.

4. You can now type the endnote text for this endnote.

To return from the endnote area back to the body text, simply click anywhere in the body text of the document.
Alternatively, you can use the ribbon command References | group Footnotes | Go to reference, which will
take you back to the appropriate endnote in the text.

Changing endnote text retroactively

The endnote text can be edited at any time. All you have to do is position the text cursor in the endnote area. To
do so, use one of the following procedures:

§ Scroll to the page where the endnote is to be changed and click in the endnote area. 

Note: This only works in standard view. If you are in a different view, you must first use the ribbon command View | Standard to
switch to the standard view.

§ You can use the ribbon command References | group Footnotes | Go to endnote to let TextMaker search
for the next endnote in the text. If found, TextMaker automatically places the cursor in the corresponding
endnote text in the endnote area. 

You can now edit the endnote text. You already know how to get back to the body text: simply click on any text
passage or use the command Go to reference.

Tip 1: Within the endnote area, you can use the arrow keys â and á to move to the next or previous footnote
text.

Tip 2: The key combination Ctrl + left mouse button on the endnote mark will take you from the body text
to the endnote area and vice versa. (Android/iOS: In the context menu Go to hyperlink)
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Reinserting endnotes

If you accidentally deleted the endnote number in an endnote text, you can reinsert it at any time:

To do so, choose the ribbon command References | Endnote  | Insert endnote mark.

Moving, copying or deleting endnotes

Sections of text containing endnotes can be moved, copied or deleted in the usual manner. TextMaker
automatically rearranges the endnote texts and automatically corrects the numbering.

However, you should observe the following rule:

Important: If you want to copy, move, or delete endnotes, you should always do so in the text – and not in
the endnote area in the bottom margin of the page.

If, for example, you delete the endnote text of an endnote in the endnote area, that endnote is still preserved –
only its endnote text is empty. If you select and delete the endnote mark in the text, however, the whole endnote
(endnote mark and text) is removed, and all remaining endnotes are renumbered.

Influencing the numbering of endnotes

As mentioned above, endnotes are numbered automatically – so you don't have to worry about them. If
necessary, however, you can manually influence the numbering as follows:

§ Changing the number of an individual endnote 

To change the number of an individual endnote, position the cursor behind it and choose the ribbon
command References | Endnote  | Change numbering. The program displays a dialog box in which you
can change the numbering of this endnote from Auto numbered to Custom and then enter the desired
number.

Tip: You can also open this dialog box by double-clicking on the endnote.

§ Changing the overall numbering of endnotes 

To change the numbering of all endnotes in the document, choose the ribbon command References |
Endnote  | Endnote options. In this dialog box, you can set the start value and the type of numbering,
among other things. For more information, see Endnote options.

Converting endnotes into footnotes

Endnotes appear at the end of a document by default. If you want them to appear at the end of the page, you
have to use footnotes. You can also convert existing endnotes into footnotes at any time, both individual and all
endnotes of the document.

§ Converting an individual endnote into a footnote 

To change an individual endnote into a footnote, position the text cursor behind it and choose the ribbon
command References | Endnote  | Change numbering. The program will display a dialog box in which
you enable the checkbox Convert to footnote.

Tip: You can also open this dialog box by double-clicking on the endnote.
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§ Converting all endnotes into footnotes 

To change all endnotes in the document into footnotes, choose the ribbon command References | Endnote
 | Endnote options. In this dialog box, you can click on the Convert button to make the desired

adjustment.

Changing the formatting of endnotes

You can change both the formatting of the endnote text as well as the endnote mark (the endnote number) as
desired.

Formatting endnote text

To change the formatting of the text of an individual endnote, simply position the text cursor in the endnote text
and apply the desired formatting.

Tip: If you want to change the formatting of the text for all endnotes in the whole document, TextMaker can
save you a lot of work. All you have to do is change the paragraph style "Endnote Text", which TextMaker
automatically creates as soon as you insert the first endnote.

By default, the text of all endnotes is formatted with this paragraph style. As long as you have not manually
changed the formatting of the endnote texts, changes to the "Endnote Text" style will affect all endnote texts in
the document.

To edit this style, proceed as follows:

1. Right-click to open the context menu and select Paragraph style.

2. Select the "Endnote Text" style in the list and click on Edit.

3. The program displays a dialog box in which you can change the formatting. Make the desired changes there.
Tip: You can also change the character formatting by clicking on the Character button on the Paragraph
tab.

4. Exit the dialog boxes with OK and then Close.

For general information on using styles, see Styles.

Formatting endnote marks

The endnote mark (i.e. the endnote number) of endnotes is automatically added as a superscript by TextMaker.
However, you can change its character formatting according to your preference. Select the endnote mark, right-
click to open the context menu and select Character to open the dialog box (alternatively: choose the ribbon
tab Home | group Character with the group arrow ). Make the desired changes in the dialog box.

Tip 1: All endnote marks are automatically formatted with the "Footnote Reference" character style (note:
character style, not paragraph style!). If you edit this style via the context menu with the entry Character
style, all footnote and endnote marks in the document change their appearance accordingly.
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Tip 2: The sidebar is recommended to enable you to orient yourself better with respect to formatting
endnotes or footnotes via paragraph styles/character styles. It will be easier for you to identify endnote
text/footnote text (function: Paragraph style) and footnote marks (function: Character style) here.

Endnote options

Settings for the endnotes in the current document can be made via the ribbon command References | group

Footnotes | Endnote  | Endnote options.

It opens a dialog box with the following options:

Position

The endnote texts are usually displayed at the end of the document. Change the option Position if you want
them to appear in a different location.

§ End of document 

This is the default setting – all endnotes are displayed collectively at the end of the document.

§ End of chapter 

If you have divided your document into several chapters using the ribbon command Insert | Break  |
Chapter break and want the endnote texts to appear collectively at the end of each chapter, select this
option.

(For more information on using chapters, see Dividing a document into chapters.)

Numbering

Here, you can make settings for the automatic numbering of the endnotes:

§ Type 

Here, you can change the type of numbering. For example, you can also use letters in addition to numbers.
The endnotes are then no longer numbered with 1, 2, 3, ... but with A, B, C.

§ Start at 

Here, you can specify the number with which the counting should start. The default value is "1". If, for
example, you enter "42", the first footnote will be given the number 42, the next 43, and so on.

§ Mode 

Here, you can specify whether the numbering should be reset to "1", for example, on each page or each
chapter:

Continuous numbering: The numbering is never reset. This is the default setting.

Restart on each chapter: The numbering is reset to "1" at the beginning of each chapter. (For more
information on chapters, see Dividing a document into chapters.)
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Separator line margins

Here, you can set the margins for the separator line that is inserted automatically above the endnote section:

The Top margin determines the minimum spacing between the text and the separator line, while the Bottom
margin determines the spacing from the separator line to the endnote texts.

As you increase the Left margin, the separator line starts further to the right; as you increase the Right margin,
the separator line ends earlier.

"Separator line" button

Click on this button if you want to change the appearance of the endnote line inserted above the endnote area.

For example, to change the thickness of this line, select the desired line thickness in Line style / Thickness.

If you don't want the endnote separator line to appear at all, select the option No line from the list Line style.

"Convert" button

If you want to convert all endnotes of the document into footnotes so that they appear at the end of each page
by default, click on the Convert button. In the dialog box that then opens, you can make the desired
adjustments.
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Reviewing documents
You can add comments to a document and track changes made to it. These two functions are useful, for
example, when several users review a document in succession.

§ Using comments 

You can select text anywhere in a document and then add comments to it.

If, for example, you receive a document for proofreading from a colleague, you can insert comments such as
"Shorten this section" and the like directly into the document and then return the document to your
colleague. Your colleague can now revise the document according to your comments.

§ Tracking changes in a document

The Track changes function goes a little further. If it is enabled, you can make changes to the document in
the usual way – thus delete or add text, change formatting, etc. However, your changes are not stored
immediately in the document, but are first saved as "change requests" highlighted in color.

Thus, if a colleague hands you a document for correction, enable the "Track changes" function, make the
desired changes and return the document to your colleague. Your colleague can then view your proposed
changes and separately accept a change (whereupon it is saved permanently in the document) or reject it
(whereupon it is discarded).

Of course, you can also use comments and the "Track changes" function in combination.

For more information on these two functions, see the following pages.

Using comments

In the Android/iOS version, some of the commands are locked. (To unlock the commands, see Welcome.)

You can use the ribbon command Review | group Comments | Insert  (alternatively: the ribbon command
Insert | Comment) to insert comments with respect to any text passage in a document.

Text with respect to which a comment is attached is highlighted in color. If you hover over such text, the
comment is displayed in a pop-up window.

You can also enable the Comments pane  (Review | group Comments). It then appears in the right margin
of the document and always displays all comments.

By default, comments are only displayed on the screen and are not printed – unless you have enabled the option
Print comments in the document properties. For more information, see Settings for comments.
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Using the command group "Comments"

All commands for using comments can be found on the ribbon tab Review | group Comments:

The command group Comments has the following buttons (from left to right):

§ Insert new comment 

§ Edit current comment

§ Delete current comment

§ Go to previous comment

§ Go to next comment

§ Enable/disable Comments pane

For more information on the individual functions, see the following sections.

Inserting comments

To insert a comment, proceed as follows:

1. Select the text with respect to which you want to attach a comment.

2. Choose the ribbon command Review | group Comments | Insert .

Alternatively: Choose the ribbon command Insert | Comment.

Note: Comments appear with your initials if you have entered something in the "Initials" or "Name" field
in the User info. (For more information, see Settings, General tab.) If nothing is entered here, TextMaker
will now prompt you once for the current document.

3. The program displays a pop-up window in which you can enter the comment. Type your comment into it.

4. When you have completed your comment, click anywhere in the text to close the comment window.

The comment has now been inserted, which is apparent from the colored background of the relevant text.

Editing comments

To edit a comment, proceed as follows:
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1. Position the text cursor anywhere within the text whose comment you want to edit.

2. Choose the ribbon command Review | group Comments | Edit .

Tip: If the Comments pane  is enabled, you can also type directly into the comments window.

3. Make the desired changes in the comments window.

4. When you have finished editing, click anywhere in the text to close the comments window.

The comment has now been changed accordingly.

Tip: You can also use shortcut keys to jump to a comment and back again: If you position the text cursor
somewhere inside a section of text that has a comment and press Ctrl+Alt+â, TextMaker jumps to the
corresponding comment, and you can edit it. To return to the body text, press Ctrl+Alt+á.

Deleting comments

To delete a comment, proceed as follows:

1. Position the text cursor anywhere within the text whose comment you want to delete.

2. Choose the ribbon command Review | group Comments | Delete .

Tip: This command can also be chosen via the context menu (right mouse button).

The comment has now been removed.

Displaying and printing comments

There are two ways of viewing comments:

§ In the comments pane (always visible) 

When you insert a comment into a document for the first time, or when you open a document that already
contains comments, the comments pane automatically appears in the right margin of the document. It
displays all comments for the current page. A connector between the comment and the corresponding text
indicates to which section of text the comment refers.

You can enable or disable this comments pane at any time:

To do this, click on Review | group Comments | Comments pane .

Note: This command corresponds to the option Show in the comments pane in the dialog box. For more
information, see Settings for comments.
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§ In pop-up windows (made visible by pointing) 

If the comments pane is disabled, comments will only become visible when you hover over a section of text
that has a comment. A pop-up window will open and display the comment.

Print comments

Comments usually only appear on the screen; they are not printed. If you want comments to also appear on the
printout, enable the option Print comments in the dialog box. For more information, see Settings for
comments.

Note: Regular text will be reduced in size to make room for the comments. Thus, the proportions of the
printout will not correspond to the actual dimensions of the document.

Locating comments

The command group Review | Comments contains two commands that you can use to jump back and forth
between all comments in the document:

§ Previous  jumps to previous comment 

§ Next  jumps to next comment

Settings for comments

If you choose the ribbon tab Review | group Comments and then open the dialog box by clicking on the group
arrow  in the bottom right corner, you can make various settings for comments.

Note: You can also open this dialog box with the ribbon command File | Properties, Review tab.

The following options are available in the dialog box on the tab:

"Comments" section

§ Show in the comments pane 

This option corresponds to the icon  in the command group Comments (ribbon tab Review).

The comments pane is an area in the right margin that displays all comments for the current page of the
document.

If this option is enabled, the comments pane is displayed automatically when you insert the first comment
into a document or when the document already contains comments.
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If the option is disabled, the comments pane is not displayed. In this case, however, you can still make
comments visible: Simply hover over a section of text that has a comment. The comment is then
automatically displayed in a pop-up window.

§ Highlight comments in text 

If this option is enabled, all sections of text with respect to which comments are attached are highlighted in
color.

§ Print comments 

If this option is enabled, comments also appear in the printout (instead of only on the screen).

Note: Regular text will be reduced in size to make room for the comments. Thus, the proportions of the
printout will not correspond to the actual dimensions of the document.

§ Color 

This option determines the color in which comments and color highlighting appear in the text.

If you use the default setting Author, a different color is selected automatically for each user who edits the
document. If the first user adds comments, they appear in red. If another user then opens the document and
also adds comments, they appear in blue, etc.

Note: For this to work correctly, all users who edit the document must have specified their name in the
TextMaker settings.

To enter your name, choose the ribbon command File | Options , switch to the General tab and enter
your name (or at least your initials) using the User info button.

"Comments pane" section

The comments pane is an area in the right margin that displays all comments for the current page of the
document.

§ Width 

This option allows you to change the width of the comments pane.

§ Position 

This option lets you change the position of the comments pane: in the right/left margin (or outside/inside for
documents in book layout, i.e., with opposite pages).

Note: You can set the width and position of the comments pane here in the same way as for the Track
changes feature, because tracked changes and comments are displayed together in the comments pane
(see next section).

"Changes" section

This section contains other options that are not relevant for comments but are related to the the "Track
Changes" function (see next section).
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Tracking changes in a document

In the Android/iOS version, some of the commands are locked.(To unlock the commands, see Welcome.)

If you enable the Track changes function, you can still continue to make whatever changes you like to a
document. However, these changes are not stored immediately in the document but are first saved as "change
requests" highlighted in color.

Then you – or another user – can review these changes and separately accept or reject each of them. If a change
is accepted, it will be applied permanently to the document; if it is rejected, it will be discarded.

This is especially useful when several users review a document in succession. An example: A colleague writes
a document and gives it to you to correct. You enable the "Track changes" function and make the desired
changes. You then return the document to your colleague. Your colleague can now accept or reject each of
these changes at the touch of a button.

The revision of a document with the "Track changes" function thus involves three steps:

§ Step 1: Enabling the Track changes function 

§ Step 2: Making the desired changes

§ Step 3: Accepting/rejecting the individual changes

Using the command group "Changes"

All commands for revising documents can be found on the ribbon tab Review | group Changes:

The command group Changes has the following buttons (from left to right):

§ Track changes on/off 

§ Accept change and go to next

§ Reject change and go to next

§ Go to previous change

§ Go to next change

§ Show changes on/off

§ Review all changes

For more information on the individual functions, see the following sections.
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Step 1: Enabling the Track changes function

Choose the ribbon command Review | group Changes | Track changes  in the open document that you want
to revise.

The "Track changes" function is now enabled. All changes which you now make to the document will be
tracked. (If you no longer need the "Track changes" function, you can disable it at any time by clicking on this
command again.)

Step 2: Making the desired changes

Then make the desired changes to the document as usual. You can change, delete and add text, change the
formatting, etc.

The document can still be edited exactly as if the "Track changes" function did not exist at all. There is only
one important difference: Any changes you make now will be indicated as follows by default:

§ When you add text, it is colored and underlined in the document. 

§ When you delete text, it is colored and struck through in the document.

§ When you change the formatting of text, it is colored in the document.

In addition, a vertical line appears in the left margin beside each line that contains a change, indicating that a
change was made at that point.

Note: You can customize the default behavior described above (how the various change actions are
indicated) according to your needs. For example, deleted text and text with changed formatting can be
displayed in a separate Comments pane to the right of the document. For more information, see Settings for
the Track changes function.

Step 3: Accepting/rejecting changes

Once all the desired changes have been made, they can be either accepted or removed one by one.

To do so, use the aforementioned command group Changes (ribbon tab Review):
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The command group Changes has the following functions for revising documents:

Icon Function

Track changes on/off

This option enables/disables the "Track changes" function.

Accept change and go to next

Clicking on this button will accept the change at which the text cursor is presently positioned, which means
that it will be saved permanently in the document. TextMaker will then jump to the next change.

When you click on the black arrow of the button, however, the program displays a dropdown menu with the
following functions:

Accept change and go to next: does exactly the same as the button.

Accept current change: does the same as the button, but won't jump to the next change afterwards.

Accept all changes: accepts all changes in the whole document at once.

Reject change and go to next

This button works just like the button described earlier – only that the change is rejected. TextMaker will
then jump to the next change.

When you click on the black arrow of the button, a dropdown menu appears with the following functions:

Reject change and go to next: does exactly the same as the button.

Reject current change: does the same as the button, but does not jump to the next change.

Reject all changes: rejects all changes in the whole document at once.

Go to previous change

This option positions the text cursor at the previous change.

Go to next change

This option positions the text cursor at the next change.

Show changes on/off

This enables/disables the option Show changes. If this option is enabled, changes are indicated (as described
previously). If it is disabled, the document appears as if all changes have been accepted.
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Icon Function

Review all changes

This option opens a dialog box in which all changes are listed. Click on one of the listed changes and then
click on the Accept or Reject button to accept or discard it.

Settings for the Track changes function

If you open the dialog box by clicking on the group arrow  in the bottom right corner of the ribbon tab Review
| group Changes, you can make various settings for the "Track Changes" function on the Review tab.

Note: You can also open this dialog box with the ribbon command File | Properties .

The following options are available:

"Comments" section

This section is responsible for inserting comments and not for the track changes feature. For more information,
see Using comments.

"Comments pane" section

The comments pane is an area in the right margin of the page where the details of the changes can be clearly
displayed.

For this purpose, the change actions Deleted text and Changed formatting in the "Changes" section (see below)
must be set to In the comments pane. The change action Inserted Text is only displayed in the document text
itself and never in the comments pane.

§ Width 

This option allows you to change the width of the comments pane.

§ Position

This option lets you change the position of the comments pane: in the right/left margin (or outside/inside for
documents in book layout, i.e., with opposite pages).

Note: You can set the width and position of the comments pane here in the same way as for the
Comments function, because tracked changes and comments are displayed together in the comments
pane. For more information, see also Using comments).
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"Changes" section

§ Track changes 

This option enables/disables the tracking of changes.

This button corresponds to the icon  on the ribbon tab Review | group Changes.

§ Show changes 

This option enables/disables Show changes. If this option is enabled, changes are indicated. If it is disabled,
the document appears as if all changes have been accepted.

This button corresponds to the icon  on the ribbon tab Review | group Changes.

§ Print changes 

If you enable this option, tracked changes will also be indicated in the printout instead of just on the screen.
If it is disabled, the document will be printed as if all changes had been accepted.

§ Show tooltips 

If this option is enabled, information about a change is automatically displayed on the screen when you
hover over it (author, date and type of change).

§ Inserted text, Deleted text, Changed formatting, etc. 

In the lower part of the dialog box, you can specify exactly how tracked changes should be indicated in the
document: How would you like changes to be displayed in the document and in what color should such
changes be highlighted?

Deleted text is displayed with a strikethrough in the document text by default, Changed formatting is
displayed colored by default, and Inserted text is underlined by default.

Tip: You can also display the change actions Deleted text and Changed formatting in a separate
Comment pane to the right of the document, for example, if you set the default behavior for changes in
this document accordingly (document-related).

If you use the default setting Author for a color, a different color will be selected automatically for each
user who edits the document. If the first user makes changes, they appear in red. If another user then opens
the document and makes additional changes, they appear in blue, etc.

Note: For this to work correctly, all users who edit the document must have specified their name in the
TextMaker settings.

To enter your name, choose the ribbon command File | Options , switch to the General tab and enter
your name using the User info button.

The setting Edited lines causes a vertical line to appear in the page margin next to each change to further
indicate that a change has been made at that point.
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Using hyperlinks
With the ribbon command Insert | group Links | Hyperlink, you can add a hyperlink to text. Hyperlinks are
links to web pages or other documents, for example, which can then be opened simply by pressing Ctrl + left
mouse button on this text.

(Android/iOS: In the context menu with the command Go to hyperlink)

If, for example, you link a word in the text to a web page, the web browser will automatically start when you
click on this word and will access this page in it.

By the way, the file path of another document is also allowed as a destination for hyperlinks. This is then
opened automatically when you click on the link.

Tip: It is also possible to use an e-mail address as a destination by placing "mailto:" in front of it.

Creating a hyperlink

To create a hyperlink, proceed as follows:

1. Select the text to which you want to attach a hyperlink.

2. Choose the ribbon command Insert | group Links | Hyperlink .

3. For URL or file name, specify the destination for the hyperlink: Enter the path and name of the Internet
resource or file to which you want the selected text to refer.

For links to web pages, "http://" and the address of the page should be entered – for example,
"http://www.example.com".

For links to an e-mail address, enter "mailto:" and the recipient's address – for example,
"mailto:xy@example.com".

For links to a file, the Browse button can be used.

4. Optional: In the Bookmark field, you can also specify the target position in the document to be opened (see
below). However, this field is usually left empty.

5. Optional: In the Hyperlink text field, you can change the text that is currently selected in the document. If
nothing has been selected in the document, TextMaker automatically inserts the path specified in step 3. as
the text.

6. Confirm with OK.
Note: The Reset button allows you to undo all changes made in the open dialog box provided that you have not yet confirmed them with OK.

The hyperlink is now created. You recognize this by a change in the color of the text, which indicates the
presence of a link.
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Tip: Links to URLs and e-mail addresses can be created faster and easier if the option Format URLs as
hyperlinks is enabled in the dialog box of the ribbon command Review | Auto correction. You can then
type the destination address (for example, "www.example.com" or "mailto:xy@example.com") directly into
the text and press the space bar. TextMaker recognizes that you have entered an Internet address or e-mail
address and automatically formats it as a link.

This setting is global and not document-specific. If, in some cases, you do not want the conversion to a link
at certain points, right-click on the link to open the context menu and select Remove hyperlink.
Alternatively, use the Undo command directly after the conversion to a link.

Jumping to a specific bookmark

The aforementioned dialog box also gives you the option of specifying the target position in the document to be
opened, if necessary. For Bookmark, enter the bookmark to which you want to jump.

Example: If you enter Report.tmdx for URL or file name and the name of a bookmark in this document for
Bookmark and then open this link, the file Report.tmdx will be opened and the text cursor will be positioned
at the specified bookmark.

For information on how to add a bookmark to a text passage in the current document, see Bookmarks.

Opening hyperlinks

To open a hyperlink, simply click on the text with the hyperlink using the key combination Ctrl + left mouse
button. TextMaker then opens the linked document.

Alternatively, you can also set the text cursor to any position within the link text, and then right-click to open
the context menu and select the entry Go to link.

Editing or removing a hyperlink

Existing hyperlinks can be edited as follows:

§ Changing destination 

To change the destination of a hyperlink, select the complete link text and then choose the ribbon command
again Insert | group Links | Hyperlink (alternatively via the context menu: Edit link). The program again
displays the dialog box in which you can edit the destination for the link.

To remove a hyperlink, proceed as follows:

§ Removing a hyperlink by deleting the link text 

If you delete text that contains a hyperlink, the link is also removed.

§ Removing only the hyperlink 

If you only want to remove the hyperlink but retain the associated section of text, select it and then right-
click to select the entry Remove hyperlink in the context menu.
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Outputting documents

In the Android/iOS version, the commands listed below are locked. (To unlock the commands, see
Welcome.)

This chapter provides information on how to output documents via TextMaker.

The chapter contains the following sections:

§ Print preview 

The first section deals with the command File | Print preview. This displays the document on the screen
exactly as it will appear on the printout, thus saving unnecessary test prints.

§ Printing a document 

To actually print the current document on the printer, choose the command File | Print.

§ Printing a mail merge 

Mail merges – documents that are to be sent to several addressees – can be printed with the command File |
Print merge.

§ Exporting a document as a PDF file 

You can also export a document to a PDF file by choosing the command File | PDF export.

PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there.
All formatting and objects of the document are retained exactly as in the original file.

§ Exporting a document as an EPUB file 

Alternatively, you can export a document to an EPUB file by choosing the command File | EPUB export.

EPUB is an open standard for e-books (electronic books) and other electronic publications. The EPUB
format can be read by most e-book readers. In addition, there are numerous viewer applications for PCs and
mobile devices.

§ Sending a document by e-mail 

Finally, documents can also be sent by e-mail. The command File | Send is responsible for this process.

§ Finalize document (remove personal data) 

Choose the command File | Finalize if you want to remove personal data that is not intended for the public
before sharing a document.

See the following pages for more detailed information on the above functions.
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Print preview
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

The print preview displays a document on the screen exactly as it will look in the printout. This feature enables
you to avoid wasting paper on test prints.

To start the print preview, choose the ribbon command File | Print preview .

To exit it again, click on the Close button  in the preview module (see below) or press the Esc key.

Using the preview module

The print preview module has the following functions (from left to right):

§ Print corresponds to the ribbon command File | Print, which you can use to print the document. For more
information, see also Printing a document. 

§ Print merge corresponds to the ribbon command File | Print merge with which you can output a document
as a mail merge after assigning records. For more information, see also Mail merge.

§ PDF export corresponds to the ribbon command File | PDF export with which you can create a PDF file
from the document. For more information, see also Exporting a document to a PDF file.

§ Page margins are found in the ribbon command Layout | Page margins, which you can use to open a
dropdown list of predefined values for the page margins.

§ Page orientation is found in the ribbon command Layout | Page orientation, which lets you choose
between portrait and landscape orientation.

§ Page size is found in the ribbon command Layout | Page size, which you can use to open a dropdown list of
predefined values for the paper size.

Note: Click on the group arrow  at the bottom right corner of the command group Page setup to open the
dialog box with individual settings for the page format (such as page margins and page size). For more
information, see also Page setup.

§ The buttons of the command group Pages are used to scroll through the document: 

 To the first page
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 To the previous page

 Go to a specific page number. To do so, type the page number in the small input field in the middle and then
press the Enter key¿.

 To the next page

 To the last page

§ You can set the zoom level in the command group Zoom. Enter the desired percentage value in the lower
input field and press the Enter key¿. If you click on the small arrow next to it, you can select predefined
zoom levels from a list.

Alternatively, you can use the buttons above it to set the following zoom levels:

 Actual size of document (zoom level 100%)

 Display one full page

 Display two full pages side by side

 Enable magnifying glass: Then use the mouse to drag a rectangle around the area you want to magnify.

§ Print comments: The comments are also output in the printout. 

§ Print changes: Highlighting for all changes to the document that were recorded with the "Track changes"
function are also output in the printout. For more information, see Reviewing documents)

§ Print pictures: The pictures are also output in the printout (enabled by default).

§ Record: This option only appears for Mail merges: Select the record that you want to print.

§ Standard: This command switches the document view to the standard view. This is the view that you
normally use when working with TextMaker.

§ Book layout: This command switches the document view to the book layout view. You get a two-page view
with the odd pages displayed on the right instead of on the left, as they would be in an open book.

To exit the print preview, click on Close  or press the Esc key.

Printing a document
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)



539Outputting documents

To print the current document, choose the ribbon command File | Print .

In the dialog box, you can make the following settings:

Printer

Here, select which of the installed printers should print the printout.

The Setup button opens a window for setting up and configuring the printer. For more information, see your
printer manual.

Linux users can also specify here the command to be used to initiate the printing process.

MacOS and iOS users select the printer including its setup via the Print button.

Pages

Specify here the pages of the document to be printed:

§ All: Print all pages of the document. 

§ Selection: Print only the section that is currently selected.

§ Current page: Print only the page on which the text cursor is positioned.

§ Pages: Print only the specified pages. To do so, enter the desired page numbers.

Some examples:

12 Print page 12 only
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12-15 Print pages 12 to 15

12- Print page 12 and all of the following pages

-12 Print pages 1 to 12

You can also enter more than one such page number by separating them with commas:

2-5, 12 Print pages 2 to 5 and page 12

etc.

§ You can also use the option Pages to print to specify whether all selected pages or only the pages with a
even or odd page number should be printed. 

§ For Pages per sheet, you can specify how many pages to print on a sheet of paper. TextMaker usually prints
only one page per sheet. However, you can instruct the program to output four pages (scaled down
accordingly) per sheet at a time.

Options

This section of the dialog box contains additional printing options:

§ Copies 

Here, you can specify the number of copies of the document to be printed.

§ Collate copies

This option specifies whether to sort the print output by page number when printing multiple copies of a
document.

If you enable this option and print multiple copies of a document with, for example, three pages, the pages
will be output in the following order: 1-2-3, 1-2-3, 1-2-3, and so on.

If it is not enabled, the order will be: 1-1-1..., 2-2-2..., 3-3-3...

Note: Not all printers support this feature.

§ Print to file

This option redirects the print output to a file instead of a physical printer.

§ Drop pictures

This option skips all pictures and drawings when printing (useful for fast test printouts).

§ Reverse order

This option prints the pages from last to first.

§ Double-sided printing (Windows and Linux only)

Instead of Single-sided printing only on the front of a page, you can set here for printing to also be
performed on the back of a page ("duplex printing"):

Double sided, long edge means that you can turn the pages like a book.

Double sided, short edge means that you scroll the pages upwards like a clipboard.



541Outputting documents

Note: Your printer must support duplex printing in order to be able to use this feature.

To start printing, click on OK.

Tip: Before actually printing a document, you can preview the printout via the command File | Print
preview. This feature enables you to avoid wasting paper on test prints.

Printing a mail merge

In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

To print a mail merge, proceed as follows:

1. Open or create a mail merge. For more information, see Mail merge.

2. Make sure that the database with the desired addresses has been assigned to the mail merge via the ribbon
command Mailings | Select database | Use existing database. For more information, see Assigning a
database to a document.

3. If necessary, select the database records to be printed. For more information, see Selecting records for a mail
merge).

4. Choose the ribbon command File (or Mailings) | group Print | Print merge .

5. In the Records section of the open dialog box, select the records of the assigned database which you want to
use:

All (all records in the entire database)

Selected (all records selected in the database)

Range (a range of record numbers – in this case, you must enter the first and last numbers in the range)

Finally, confirm with OK to start the print job.

For more information on creating mail merges, see Mail merge.

Exporting a document as a PDF file

In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

You can also export documents to a PDF file.
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PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there (for
example, Adobe Reader). All formatting and objects (pictures, drawings, etc.) of the document are retained
exactly as in the original file.

To export a document to a PDF file, proceed as follows:

1. Choose the ribbon command File | group Document | PDF export .

2. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

3. Now another dialog box appears. Enter a file name under which you want to save the PDF file and confirm
with OK.

The PDF file will then be created. To view it, open the PDF file in a PDF viewer of your choice.

Tip: If no viewer application for PDF documents is installed on your device, simply search for "PDF viewer"
using your web browser. You will find numerous suitable programs, many of which are free.

In the dialog box of the above command, you can make the following settings for the PDF export:

General tab

On this tab, you can specify whether to output only parts of the document and make other settings. The options
are similar to the ribbon command File | Print described in Printing a document.

In addition, the following options are also available:

§ Create table of contents 

If this option is enabled, TextMaker automatically saves a bookmark in the PDF file for each heading that
your document contains.

Your PDF viewer will then display these bookmarks in a pane to the left of the document. You can use this
pane as an interactive table of contents: Just click on one of the headings to jump to the corresponding
section in the document.

Tip: If your PDF viewer does not display this pane, search for a command for displaying bookmarks in it
and enable it.

Note: Of course, this feature only works if you have previously outlined the document (by adding
headings). For a description of this process, see Outlines.

§ Create interactive form 

This option determines whether form objects (text boxes, dropdown lists, etc.) as well as text frames and
tables should be fillable.

By default, this option is disabled. If you enable it, such objects can be edited when the PDF file is viewed
in a PDF viewer (provided that the corresponding permissions are set – see Protection tab).

For more information on creating forms, see Forms.

§ Create tagged PDF 

If this option is enabled, information about the logical structure of the document will also be saved in the
PDF file.
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This information ensures that your PDF files are accessible for the disabled and can also be used, for
example, with PDF viewers that reproduce or read aloud the document content in Braille.

§ Export comments 

You can add comments to a document using the ribbon command Insert | Comment (as described in Using
comments).

If this option is enabled, these comments will not only appear in the original document, but they will also be
displayed in a similar form in the PDF file.

Note: The pages of the document will be slightly reduced in the PDF file to make room for the comments.
Thus the page size in the PDF file is not the same as that of the original document.

§ Export tracked changes 

You can use the ribbon command Review | Track changes to ensure that all changes made to a document
will be indicated. For more information, see Tracking changes in a document).

If you enable this option, the text in the PDF file will be highlighted in a similar manner to the original
document.

§ Reset (see "Reset" button at the end of this section) 

Preferences tab

On the second tab, you can make settings for the output quality:

§ AutoShape options 

Here, you can set the resolution (i.e., number of pixels) in which AutoShapes and all other types of drawings
are exported. The higher the resolution, the larger the generated PDF file will be.

§ Picture options 

The option Compress to sets the upper limit for the resolution of the images (number of pixels) in the
current PDF export. The value set here is the maximum value for all images in the document, regardless of
whether they have a higher or lower resolution. If the resolution of the images in your document is lower
than the set value anyway, their resolution will not change.

Note: The images in your TextMaker document itself will not be compressed in the process, but you can achieve this with the
command Compress pictures.

With the options below, you can specify whether to save images with lossless compression or with lossy
JPEG compression. If you opt for JPEG compression, you can set the quality level of the compression.

Tip: Normally, you should choose lossless compression here because it ensures perfect image quality. If
your document contains a large number of images (especially photographs), however, the resulting PDF
file may be very large. In this case, we recommend that you use JPEG compression, which provides a
much higher compression ratio for photographs.

The option Use alpha channel for transparencies determines whether an alpha channel should be used to
represent transparency in pictures and drawings. Usually, they look best when this option is enabled.
However, some PDF viewers represent alpha channels incorrectly, thus you can also disable this option.
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§ Other options 

Include TextMaker document: This option saves a copy of your TextMaker document inside the PDF file.
You can then open this PDF file directly in TextMaker, whereupon the program will extract the original
TextMaker document from the PDF file and display it.

Open the file in a PDF viewer after exporting: This option launches your PDF viewer automatically and
displays the PDF file after it has been created (provided that you have a PDF viewer installed on your
computer).

Use relative paths for file links: This option automatically converts the file path from hyperlinks (links) to
files into a relative path (rather than an absolute path). If, for example, you have inserted a link to the file C:
\Documents\Lists\Test.txt and export the PDF document to the folder C:\Documents, this link will
be automatically converted into "Lists\Test.txt".

§ Font options 

The option Font embedding allows you to specify whether the fonts used in the document should be
embedded in the PDF file.

If font embedding is enabled, the resulting PDF file can be viewed in its original fonts on any computer –
even if the relevant computer does not have the fonts installed. If, on the other hand, the option is disabled,
the PDF file will be displayed with automatically selected replacement fonts.

The option Embed only used characters determines whether all characters of a font or only the characters
actually present in the document should be embedded when embedding fonts. The advantage of enabling this
option is that the resulting PDF file is smaller in size.

§ Archiving 

This option enables you to select from various variants in the standard PDF/A to create standard-compliant
PDF files. This standardized format allows the long-term archiving of documents and is considered a
prerequisite when documents must be stored in a non-editable manner and in an identical format to the
original documents.

§ Reset (see "Reset" button at the end of this section) 

View tab

This tab contains advanced options for displaying the PDF file in a PDF viewer:

§ Navigation pane 

Use this option to specify what should be displayed in the navigation pane of the PDF viewer. (The
navigation pane is a bar displayed to the left of the PDF document.)

Available options:

Default: Use the PDF viewer's default setting.

Empty: Do not display anything in the navigation pane.

Bookmarks: Display the document's bookmarks in the navigation pane.

Page thumbnails: Display thumbnails of the document's pages in the navigation pane.
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§ Zoom 

This option specifies the zoom level at which the PDF file should be displayed:

Default: Use the PDF viewer's default setting.

Full page: Select the zoom level at which the entire page fits in the window.

Fit width: Select the zoom level at which the page width fits in the window.

Fit height: Select the zoom level at which the page height fits in the window.

Custom: Set the zoom level to a custom value (in percent).

§ Page layout 

This option specifies the layout with which the pages should be displayed:

Default: Use the PDF viewer's default setting.

Single pages: Display as single pages.

Two pages - odd pages left: Display as two facing pages (odd pages on the left).

Two pages - odd pages right: Display as two facing pages (odd pages on the right).

§ Additional options 

This section provides the following additional options:

Display document title: Display the document's title in the title bar of the PDF viewer (instead of its file
name). Tip: You can enter the title of a document on the Summary tab in the dialog box of the command
File | Properties.

Center viewer on screen: This option automatically centers the program window of the PDF viewer on the
screen when the PDF file is opened.

Full-screen mode: This option automatically switches the PDF viewer to full-screen mode when the PDF
file is opened.

Hide menu bar: This option hides the menu bar of the PDF viewer.

Hide toolbars: This option hides all toolbars of the PDF viewer.

Hide navigation pane controls: This option hides all controls of the navigation pane.

§ Reset (see "Reset" button at the end of this section) 

Protection tab

This tab provides options that enable you to encrypt the resulting PDF file and to use passwords to protect the
file from being opened or changed.

§ Encryption type 

Here, you can specify whether the PDF file should be encrypted. You can choose between 40 bit encryption
(low level of security) and 128 bit encryption (high level of security).

Note: The other options in this dialog box are not available until you have selected an encryption type.
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§ Password to open the document 

If you enter a password here, the PDF viewer will ask for this password when users try to open the PDF file.
If an incorrect password is entered, the user cannot open the file.

If you leave this field empty, any user can open the file without having to enter a password.

§ Password to set permissions 

You can also restrict the permissions for the PDF file. To do so, enter a password to change the permissions.
Then use the options in the Permissions section of the dialog box to specify which permissions should be
granted to users.

Background information: Some PDF viewers have a command for changing the permissions. If a user
chooses this command, they can only continue if they enter the password that you have set here.

§ Permissions 

Here, you can specify which permissions users should have with respect to the PDF file when they open it in
a PDF viewer. (This is only available if you have entered a password above for setting permissions.)

§ Reset ("Reset" button below) 

"Reset" button

All changes to the PDF export options are retained as global settings in TextMaker and are thus applied to the
next export of a PDF document. You can restore the original default settings by clicking on the Reset button in
the lower left corner of the dialog box.

You can click on this button on any tab of the dialog box PDF Export, thereby resetting the options of all tabs
at once.

Exporting a document as an EPUB file

This function is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

As an alternative to the PDF format, you can also export documents in the EPUB format.

EPUB is an open standard for e-books (electronic books) and other electronic publications. The EPUB format
can be read by most e-book readers. In addition, there are numerous viewer applications for PCs and mobile
devices.

In contrast to the PDF format, where the text formatting is retained exactly as in the original document, the
formatting of an EPUB file may differ significantly from the original document. This is also the intention: In
the case of e-books, the e-book reader regulates the text flow themselves and ensures that it is optimally adapted
to the display size of the device used.

To export a document to an EPUB file, proceed as follows:
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1. Choose the ribbon command File | group Document | EPUB export .

2. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

3. Now another dialog box appears. In the dialog box, specify the file name under which you want to save the
EPUB file and confirm the entry.

The EPUB file will then be created. To view it, start a suitable viewer application and open the file in it.

Tip: If no viewer application for EPUB documents is installed on your device, simply search for "EPUB
reader" using your web browser. You will find many suitable applications, many of which are free.

The dialog box of the above command allows you to make the following settings for the EPUB export:

General tab

On this tab, you can enter the document's summary information and some additional information and make
further settings.

Available options:

§ Title, Author, Subject, Keywords, Description 

Here, you can change the document info for the document, thus enter the title, author and so on. If you plan
on publishing the generated EPUB file, you should also fill in these fields.

Note: Alternatively, you can change these fields via the Summary tab in the dialog box of the ribbon
command File | Properties.

§ Language, ISBN, UUID, Publishing date, Publisher, Copyright notice 

Here, you can enter additional information about the document. If you plan on publishing the generated
EPUB file, you should also fill in these fields.

The UUID (Universally Unique Identifier) is a unique number that can be used to identify an individual
document. If you click on the New button, you generate a new random UUID. (Technically, UUIDs are not
actually unique but, due to their sheer length, the probability of inadvertently generating an already assigned
UUID is close to zero.)

Note that the UUID of a document should not be changed once it is published – unless you want to release a
new revision of the document.

The ISBN (optional) is in turn an actually unique identification number for a publication. ISBNs are
primarily required by the book trade. You usually obtain an ISBN from your publisher.

§ Cover 

Enable the option Create cover page if you want to add a cover page to the EPUB file in the form of a
picture file. Most EPUB readers will then not only display this picture as a cover page in the document
itself, but they will also use it as a preview image for the document (for example, in the user's "library").

To select the desired picture for the cover page, click on the three dots next to the input field below this
option. This will open a corresponding file dialog box.

You can also change the background color of the cover page if desired.
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§ Table of contents 

If the option Create table of contents is enabled, TextMaker will automatically save a bookmark in the
EPUB file for each heading that your document contains.

Some EPUB readers can display these bookmarks, for example, in a bar to the left of the document. You can
then use this bar as an interactive table of contents: simply click on one of the headings in it to jump to the
corresponding section in the document.

Tip: If your reader does not display a bookmark bar, search for a command to display bookmarks or the table
of contents and enable it.

Note: Of course, this feature only works if you have previously outlined the document (by adding
headings). For a description of this process, see Outlines.

Preferences tab

On the second tab, you can make settings for the output of the EPUB file:

§ Picture options 

The option Quality sets the upper limit of the resolution (number of pixels) for compressing the images for
the current EPUB export. The value set here is the maximum value for all images in the document,
regardless of whether they have a higher or lower resolution. If the resolution of the images in your
document is lower than the set value anyway, their resolution will not change.

Note: The images in your TextMaker document itself will not be compressed in the process, but you can achieve this with the
command Compress pictures.

With the options below, you can specify whether to save images with lossless compression or with lossy
JPEG compression. If you opt for JPEG compression, you can set the quality level of the compression.

Tip: Normally, you should choose lossless compression here because it ensures perfect image quality. If
your document contains a large number of images (especially photographs), however, the resulting EPUB
file may be very large. In this case, we recommend that you use JPEG compression, which provides a
much higher compression ratio for photographs.

§ Split EPUB text 

When exporting documents with a lot of text, it is advisable to have TextMaker split this text into several
small "pieces". Otherwise, some low-end EPUB readers might be unable to process the document.

Normally, this option should always be enabled. TextMaker will split the text into segments of about 100
KB in the resulting EPUB file. All EPUB readers should be able to cope with these segments.

The display is not changed – EPUB readers also display such files as a single continuous document.

§ Font options 

The option Font embedding enables you to specify whether the fonts used in the document should be
embedded in the EPUB file.

This is usually not required, as most EPUB readers only display the document in their own fonts anyway.

However, some readers have an option for displaying the document in its original fonts. Of course, this only
works with documents that have this option enabled. TextMaker then automatically determines which fonts
were used in the document and embeds them in the EPUB file.
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Note: This can make the resulting EPUB file much larger.

Note: Please respect the license terms of the fonts' vendors. For most commercial font packages,
embedding in EPUB files is not allowed (or requires the payment of additional charges).

§ CSS options 

EPUB files usually also contain a CSS file. It stores all the styles that you use in your document. This CSS
file is generated automatically by TextMaker, so you don't have to worry about it.

If you have manually created your own CSS file, you also have the option of using it instead of the
automatically generated file. Enable the option Append custom CSS. Then click on the three dots next to
the input field below this option. This will open a file dialog box in which you can select the desired file.

Note: Not all readers support the use of a custom CSS file.

§ Other options 

Open the file in an EPUB viewer after exporting: This option launches your PDF viewer automatically
and displays the PDF file after it has been created (provided that you have a PDF viewer installed on your
computer).

Sending a document by e-mail

In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

If you have a suitable e-mail program installed on your device, you can send documents by e-mail directly from
TextMaker.

To do so, proceed as follows:

1. Create or open the document that is to be e-mailed.

2. In TextMaker, choose the ribbon command File | group Document | Send .

Note for users of Android/iOS and Windows 10 or higher: Here you can use the command Share, which
enables sharing via different channels.

Select the format in which the document is to be sent.
Note: If you select the TextMaker document format here, the recipient will receive an e-mail with the TextMaker file as an attachment. In order to
open this attachment, the recipient must also have TextMaker installed.

TextMaker now generates an e-mail with the file as an attachment and passes it to your e-mail program.
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Finalize document (remove personal data)

This feature is only included in SoftMaker Office Professional and NX Universal.
In the Android/iOS version, the command is locked. (To unlock the command, see Welcome.)

When sending documents to colleagues or business partners, it may be desirable to remove certain personal data
from the document beforehand.

To do so, TextMaker provides the command Finalize . You can use this to specify how you want to handle
the following information that may be included in your document:

§ Document summary 

§ Comments

§ Tracked changes

Note: Your User info itself will not be affected, only its appearance in comments and tracked changes (name,
initials). The user info is not document-specific, as it is a global setting and can be changed in the Settings,
General tab.

Important: The command Finalize should be executed in a backup copy of the document and not in the
original document. The removed data cannot be restored.

Choose the ribbon command File | group Document | Finalize  to remove personal data before saving your
document to share it with others.

The program opens a dialog box with the following options:

Document summary

The document's summary information can be viewed via the ribbon command File | group File Management |
Properties. There, on the Summary tab, you will find additional information (title, subject, author, etc.) about
a document For more information, see Document summary.

If the option Remove the document summary is enabled, this additional information of the Summary tab will
be removed from the document. This applies to the entries for Title, Subject, Author, Keywords and
Description, and not to the entries for File name, Folder and Last changed.

Tracked changes

If you have worked with the Track changes feature in your document (see Tracking changes in a document),
you can specify here how you want to handle the information from tracked changes:

§ Keep tracked changes 

If you select this option, all changes to the document from the tracked changes will still be displayed.
However, you can set the following restrictions:
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Remove date and time: The contents of what was edited are displayed, but a placeholder appears
instead of the date/time of the edit.

Anonymize participants: The contents of what was edited are displayed, but "Unknown" appears
instead of the author of the edit.

§ Accept all tracked changes

If you select this option, all changes to the document will be accepted and finally applied to the document.
You can no longer identify what was previously in the text and who edited it at what time.

Tip: If you are only interested in ensuring that the tracked changes do not appear in the printout, you can
disable the Print changes button in the Print preview for this purpose.

Comments

If comments have been inserted in your document (see Using comments), you can specify here how you want
to handle the information contained in comments:

§ Keep comments 

If you select this option, all comments in the document will still be displayed. However, you can set the
following restrictions:

Remove date and time: The contents of the comment will be displayed but without the date/time of the
inserted comment.

Anonymize participants: The contents of the comment will be displayed, but "Unknown" will appear
instead of the author of the comment.

§ Remove all comments

If you select this option, all comments will be permanently deleted from the document. You can no longer
see what was commented on in the text.

Tip: If you are only interested in ensuring that the comments do not appear in the printout, you can disable
the Print comments button in the Print preview for this purpose.

When all options are set to your needs, press OK. The information will now be (irreversibly) removed from the
document based on your selection.



552Document management

Document management
TextMaker has functions that make it easier for you to manage and access your documents faster:

§ Quick paths 

You can create quick paths in TextMaker in order to quickly switch to frequently used folders when opening
or saving files.

§ Document summary 

Every document can have some additional info that you can display and edit using the Summary tab in the
dialog box of the ribbon command File | Properties. You can enter the title, subject and author of the
document, specify keywords for the file manager's search function and write a brief summary of the content.

§ File manager 

You can use the integrated file manager to easily access your documents. It allows you to see the names and
the document infos on the Summary tab for all documents at a glance. You can view, open, print or delete
documents at the touch of a button.

The Search function of the file manager not only lets you search for your documents by file name, but it
also allows you to search by topic, title, author, etc.

§ Backup copies (file versions) 

If desired, TextMaker creates a backup copy of the document each time the document is saved. You can
even instruct the program to automatically take "snapshots" of the document at regular intervals while you're
working on it.

The following pages provide detailed information on these functions.

Quick paths
TextMaker allows you to create up to twenty quick paths via which you can quickly switch to a specific folder
when opening or saving files.

A quick path is a symbolic specification, such as "Letters to the tax office", which represents a specific folder
on the hard disk (for example, the folder C:\Letters\Tax).

If you want to open a letter from this folder, you must first choose the ribbon command File | Open and then
simply click on the Quick path button in the dialog box to select the created quick path. The dialog box then
switches immediately to the C:\Letters\Tax folder.

Quick paths are not only available in the dialog box of the command Open, but they are also in all other dialog
boxes that are used to open or save files.
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Creating quick paths

To create a new quick path, proceed as follows:

1. Open any file dialog box, for example, with the ribbon command File | Open. (Click directly on the icon
itself to open the file dialog box.)

2. Click on the Quick path button in the file dialog box.

3. A menu opens below the button. Choose the command Create new quick path from it.

4. Enter any name for the quick path in Name of quick path – for example, "Letters to the tax office".

5. Enter the desired folder under Path – for example "C:\Letters\Tax".

Tip: Alternatively, click on the button with the three dots next to this input field. This opens a file dialog
box in which you can easily select the desired folder.

6. Confirm with OK.

TextMaker now knows that the quick path "Letters to the tax office" should switch to the folder C:
\Letters\Tax.

Opening quick paths

Quick paths are available in all file dialog boxes – for example, in those of the ribbon commands File | Open or
Insert | Picture. (Click on the icon itself to open the file dialog boxes.)

To use a quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu of all the previously created quick paths opens. Select the desired quick path.

TextMaker now switches to the folder specified for the quick path.

Editing and deleting quick paths

To edit or delete an existing quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu opens. Choose the command Change quick paths in it.

3. A dialog box appears. Select the desired quick path in it.

4. Click on Change to edit the name or path, or click on Delete to remove the quick path.
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Document summary

The ribbon command File | group File management | Properties  not only enables you to make document-
specific settings but also to enter some document info on the Summary tab.

You can enter additional information (such as subject, author, keywords, etc.) about a document here. To view
or edit this information, choose the command File | Properties and switch to the Summary tab:

Make the desired changes and confirm with OK.

Tip: You can use the file manager (see next section) to search for documents by their document info, for
example, to find all documents on a specific topic.

Automatic prompt for summary information when saving: You can have TextMaker prompt you to fill in the
document info on the summary tab whenever you save a new document.

To do so, choose the ribbon command File | Options , switch to the Files tab and enable the option Prompt
for summary information when saving. The dialog box for entering the document info on the summary tab
will now appear every time you save a new document for the first time.
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File manager

Android/iOS: The File manager is not available in these versions.

The file manager displays a list of documents from one or more folders and lets you open, print, delete or view
any document by clicking on it.

You start the file manager with the ribbon command File | File manager .

You can use the mouse to move or resize the file manager window at any time. You can also change the column
widths by dragging the separator lines between the column headings.

By clicking on one of the column headings, you can specify the column according to which the files are to be
sorted.

You can use the Search button to select a different folder and also use the Search function to start searching for
files. Furthermore, you can search for a specific title, subject, author, keyword, etc., within the Document
summary located on the Summary tab.

To perform an action with a file, select the file and then click on one of the buttons. The individual buttons
have the following functions:

§ Open 

If you click on this button, TextMaker opens the selected file.

Tip: You can also double-click on a file name to open the file.

§ Search 

Click on this button to search for specific files or simply to select the folder you want to display in the file
manager. For more information on Searching with the file manager, see the next section.
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§ Output 

Use this button to output the selected file. When you click on the button, a menu opens with the following
functions (depending on the operating system):

E-mail: Send the document by e-mail

Print: Print the document

Print merge: Print the document as a mail merge
 

§ Delete 

If you click on this button, the selected file will be deleted (after confirmation).

§ Preview 

Click on this button to open a preview window where you can view the selected document without having to
open it.

To actually open this document, click on the Open button in the preview. To exit the preview window, click
on the Cancel button.

§ Rename 

If you click on this button, you can rename the selected file.

§ Close 

Clicking on this button will close the file manager.

Searching with the file manager

Android/iOS: The File manager is not available in these versions.

You can use the Search button in the file manager to have TextMaker search for specific files or simply choose
the folder to be displayed in the file manager.
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You can search for files that meet the following criteria: file name, folder, file type and the document info (title,
subject, author, keywords) on the Summary tab.

Several search criteria can also be combined. If, for example, you specify a specific folder in the dialog box,
TextMaker will display all documents in this folder. If you also enter a search term in the Title field, however,
TextMaker will find only those documents that are both in the selected folder and contain the specified search
term in the Title field on the Summary tab.

With the dialog box shown above, you control the search function:

§ File name 

You can use this input field to search for specific files.

If you do not enter anything here (thus accept the default setting), the search function will find all
documents of the selected file type in the selected folder.

If you specify a unique file name like Reminder.tmdx, only documents with the exact same name will be
found.

If you specify an ambiguous file name like Rem*.tmdx, the search will find all TextMaker documents
whose file name begins with "Rem".

§ File type 

You can use this list to select the type of the files to be targeted in the search. If, for example, you want to
search for files in Rich Text Format, select this format from the list File type.

§ Title, Subject, Author, etc. 

By entering content in these fields, the file manager will search the document info of your documents (see
Document summary).

If you fill in several fields, the file manager will search for documents that meet all of your specified
conditions. If, for example, you enter "court" in the Keywords field and "Smith" in the Author field, only
documents whose document info contain corresponding entries for both fields will be found.

You can also specify only part of the term for which you are searching. If, for example, you entered "court"
as the search term in the Keywords field, your search would return all documents that contained the word
"court" – thus terms like "courthouse", and "district court" would be found.
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Case is of no significance for search terms. If the search term is entered as "court", the search will also find
documents whose keywords contain "Court".

§ Folders 

Here, you can select the folder in which the file manager should perform the search.

§ Include subfolders 

If this option is enabled, the file manager not only searches the selected folder but also all folders that are
subordinate to it.

§ New list button 

If you click on this button, you start a new search with the current settings.

§ Add to list button 

Clicking on this button also starts a new search; however, any previous search results remain in the list
instead of being cleared from the list.
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Backup copies (file versions)

Android/iOS: The features are not available in this form in these versions. Only simple backups can be
made on Android/iOS, and this setting can be found on the Files tab.

If desired, TextMaker creates a backup copy of the previous version of the document each time the document is
saved. You can even instruct the program to automatically take "snapshots" of the document at regular intervals
while you're working on it (similar to the common Auto-Recover function). You can also access these snapshot
versions later even if you have not saved the document manually using the command File | Save.

The settings for this can be found on the Backup tab in the dialog box of the command File | Options .
Select here whether and how file backups are to be created:

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is selected, the command File | Versions  (in the group File management) is also
available and can be used to easily return to a previous file version of the document that is currently open
(see below).

Use the Number of versions to keep field to specify the maximum number of versions of backups
(generations) to be kept per document.

§ Automatically created file versions ("snapshots")

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

In the dropdown field below, enter the maximum number of snapshots you want to save.

§ Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

§ "Clean up" button

This button provides two options for deleting file backups from the backup folder:

Delete orphaned file versions removes all TextMaker backups for which the corresponding original
document no longer exists.

Delete file versions of all documents removes all TextMaker backups.

How do I use the command "File | Versions"?

If you enable the creation of file backups (see above), all backups end up in a special Backup folder. This
folder is managed automatically by the program. We do not recommend that you manually move or rename the
files in this folder.



560Document management

To return to a previous version of a document, you don't need to be interested in this folder at all – as there is a
separate command for it: File | Versions.

You can use this command to revert to a previous version of a document as follows:

1. Open the desired document (if it is not already open).

2. Choose the ribbon command File | group File management | Versions . (Click directly on the icon itself
to open the version manager.)

Tip: You can proceed even faster by clicking on the icon's arrow for the dropdown menu instead of on the
icon itself. The available backups are listed here. Restore the desired version by clicking on the version
entry – this will open the version in a new document window.
However, the icon  to the right of it will open the version in the current document window. (Warning:
This will overwrite the currently open document with an older version.)

If you click on the small black arrow of the Versions icon and select the entry File versions in the menu that
appears, you will reach the version manager, which will provide you with additional details for a better
overview. For more information, see the following steps 3. and 4.

3. Version manager: The program displays a dialog box that lists all available backups for the current
document. Use the dates and times to find and select the version that you want to restore. You can use the
Preview button to display a preview of the selected version.

The version manager list shows that a backup for the Test.tmdx file might be called
Test.tmdx.135.tmbak, for example. Thus, a sequential number and the extension .tmbak are always
appended to the file name (and an "s" is also inserted into the sequential number for snapshots).

4. If you click on the Restore button, the selected previous version of the document will be restored in the
current window.

Warning: The currently open document is now replaced by the selected previous version. So if you save
it now, you're overwriting the current version with an older version!

Alternatively, you can also click on the Open as copy button. This opens the selected file version in a new
document window (instead of replacing the document in the current window). This is useful if you want to
compare the current version with an older version.

What should I do if I lose the original file?

If the original file of a document is lost because it has been deleted, for example, the aforementioned procedure
will not work. What can you do?

Even in this case, you can still access the backup copies of this document (unless they have been deleted as
well). Simply open the backup copy itself.

You can see where the backups are in the dialog box of File | Options . On the Backup tab, the file path is
displayed below in the Folder for file versions field. By default, this is a folder called Backup within the
SoftMaker folder.

When you choose a backup from this folder in your file browser, TextMaker immediately starts to open the file.
The procedure is as follows:
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1. In your file browser (for example, Windows Explorer), navigate to the Backup folder.

2. In this folder, search for files whose name starts with the name of the original file. A backup for the
Test.tmdx file might be called Test.tmdx.135.tmbak, for example. Thus, a sequential number and the
extension .tmbak are always appended to the file name (and an "s" is also inserted into the sequential
number for snapshots).

Tip: The higher the sequential number in the file name, the more recent the file version.

3. In the file browser, double-click on the file version that you want to open.

4. TextMaker detects that you are trying to open a backup and asks you what you would like to do now. It
displays a dialog box with the following options:

Open the backup file: This option opens the selected file version.

Invoke the version manager: This option opens the version manager like the command File | group File
management | Versions. This then offers all available earlier versions of the original document for
selection. For more information on using this command, see above.

Open the original file: This option opens the original file for this file backup. (Of course, this only works if the
original file still exists.)

5. Make your choice, and then click on OK.

Once again, please note that TextMaker automatically creates and manages the files in the Backup folder.
Thus, you should not make any manual changes to these files, such as renaming or moving the files.

If you need more space on the disk, you can delete all files in this folder at any time, but then you will lose all
file backups as a result.
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Document protection
You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

To protect a document, choose the ribbon command File | Properties, switch to the Protection tab in the
dialog box and select the type of document protection. Also enter the desired read and/or write password.

The following types of protection are available:

§ No protection (this is the default setting whereby the document is not protected) 

§ Write protection (the document can be opened, but saving is only possible with the password)

§ Read protection (the document can be opened only with the password)

§ Protection depending on password (a combination of read and write protection)

For more information on enabling and disabling document protection, see the following pages.

Enabling document protection
You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

Read protection also encrypts the document so that it cannot be viewed with programs other than TextMaker.

To protect a document, proceed as follows:

1. Choose the ribbon command File | group File management | Properties .

2. Switch to the Protection tab.

3. Select the desired type of document protection (see below).

4. Enter the read and/or write password (between 4 and 15 characters).

Important: If you forget a password, you can no longer open or save the document. It is thus advisable to
make a note of the password. Pay close attention to uppercase/lowercase!

5. Confirm with OK.

6. The program displays a dialog box in which you are required to verify the read and/or write password by re-
entering it.

7. Confirm with OK.
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8. Exit the dialog box with OK.

9. Save the document in order for the changes to take effect.

From now on, anyone who attempts to open this document will be asked automatically for the password. If the
correct password is entered, the protection is temporarily overridden.

Types of document protection

You can choose between the following types of document protection in the above dialog box:

§ No protection 

The document is not protected. This is the default setting.

§ Write protection 

When the document is opened, the user is prompted to enter the write password. The document can only be
saved if the correct write password has been entered here.

However, it is still possible to open the document as read-only, even if the user does not have the password.
However, it cannot be saved – not even under a different name.

§ Read protection 

If you try to open the document, you are prompted to enter the read password. If you enter an incorrect
password, you will not be able to open the document.

The document is saved in an encrypted form so that it cannot be viewed with programs other than
TextMaker.

§ Protection depending on password 

Here, two dialog boxes prompting for a password appear in succession when the document is opened. The
first dialog box asks for the read password, while the second one asks for the write password.

If the user enters the read password, he is permitted to open the document but not to save it.

If he also enters the write password, he has full access and can thus save the document.

If he enters an incorrect password or nothing at all, access to the document is completely denied.

Encryption method: "Most compatible" or "Most secure"?

For documents with Read protection or Protection depending on password, you can also select the desired
Encryption method.

Note: This setting primarily affects newly created documents. When you open an existing encrypted
document, the encryption method used in it is automatically determined and this option is set accordingly.

Choosing an encryption method is especially important for documents in Microsoft Word file format (.doc and
.docx). Some old versions of Microsoft Office may not be able to open documents encrypted with the new
"Most secure" encryption method.

Available options:
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§ Most compatible 

When you save the document, an old encryption method is used that can be read by all versions of Microsoft
Office. However, this method is less secure than the other method.

§ Most secure 

Here, a more modern and more secure encryption method is used. However, some old versions of Microsoft
Office may not be able to read documents encrypted with this method.

Detailed information about the currently selected encryption method is displayed at the bottom of the dialog
box.

Disabling document protection
When you succeed in opening a read-protected or write-protected document by entering the correct password,
protection is disabled – but only temporarily. If you close this document, the protection will be enabled again;
the next time you open it, the password prompt will appear again.

To permanently remove the protection on a document, proceed as follows:

1. Open the document.

2. Choose ribbon command File | group File management | Properties .

3. Switch to the Protection tab.

4. Select the option No protection.

5. Confirm with OK.

6. Save the document in order for the change to take effect.

Document protection is now permanently disabled.

The next time someone opens the document, no password prompt will appear. All users can now open and save
it.
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Working with other file formats
TextMaker normally saves documents in its "in-house" file format called TextMaker document. TextMaker
documents can be recognized easily by the name extension .tmdx. If, for example, you save a document under
the name "Letter", its complete file name will be Letter.tmdx.

You can also instruct TextMaker to save files in another file format. This is necessary, for example, if you want
to edit a TextMaker document with another program. You can also open documents in TextMaker, which have
been created with other word processing programs.

In this chapter, you will learn everything you need to know about working with other file formats. It is divided
into the following sections:

§ Saving and opening files in other file formats 

The first section explains how to save or open documents in a different file format: Simply choose the
ribbon command File | Save as or File | Open and select the desired format from the dropdown list of file
types.

§ Notes on the text format

When you open or save a text file, its character set is usually determined automatically. If desired, you can
also specify the character set manually. You will learn how to do so in this section.

§ Notes on the HTML format

The last section deals with saving documents in HTML format.

See the following pages for more information.

Saving and opening files in other file formats
This section provides information on saving and opening documents in another file format.

Saving a document in another file format

To save the current document in another file format, choose the ribbon command File | Save as and open the
dropdown list Save as type. Select the desired format, enter a different file name if required and confirm
saving.

Opening a document in another file format

To open a document in another file format, use the ribbon command File | Open (click directly on the icon
itself) to open the file dialog box, open the dropdown list of file types and select the format in which the file is
available. Then select the desired file, and confirm that you want to open it.
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Supported file formats

In the dialog boxes for opening and saving documents, the list of file types includes the following file formats:

§ Document 

The in-house format for TextMaker documents in which you usually save documents (name
extension: .tmdx).

§ Template 

Document template for TextMaker documents (name extension:.tmvx). For more information, see Document
templates.

§ Microsoft Word 

You can also open and save documents in Microsoft Word file format. The program supports .doc files
(Word 6.0 to 2003) as well as .docx files (Word 2007 or higher).

§ OpenDocument Text 

Documents in the file format "OpenDocument Text" (.odt) can also be opened and saved. This enables data
exchange with programs such as OpenOffice Writer.

§ TextMaker 2016 

Documents are saved in the file format of TextMaker 2016, an older version of TextMaker (name extension:
.tmd).

§ Rich Text Format 

The RTF format is very suitable for document exchange. It understands all basic text formatting and can be
read by many other programs.

§ HTML 

Documents are saved in HTML format. For more information, see Notes on the HTML format.

§ Text file 

Plain text file (without formatting)

§ Text file with additional options 

Same as above. Before the file is opened/saved, however, the program opens an additional dialog box in
which you can make advanced settings with respect to the file format (for example, change the character
set). For more information, see Notes on the text format.

§ TextMaker/DOS (open only, available on Windows only) 

This opens a document that was created with TextMaker for DOS version 3.0 or higher. (Saving in this file
format is not possible.)
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Notes on the text format
As mentioned in the previous section, you can also open and save plain text files with TextMaker.

When you do so, make sure that the correct character set is set:

Letting TextMaker determine the character set automatically

Normally, you don't have to worry about setting the character set, as TextMaker does this automatically:

§ When you open a text file, TextMaker automatically attempts to determine its character set. If it fails, your
system's default character set is used. 

§ When you open a text file and then save it, TextMaker automatically uses the character set in which the file
was opened.

§ When you save a document as a new text file, your system's default character set is used.

Setting the character set manually

Alternatively, you can specify the character set manually when you open (or save) a text file.

To do so, proceed as follows:

1. Use the ribbon command File | Open (click directly on the icon itself) to open the file dialog box or File |
Save as.

2. Important: Select "Text file with additional options" from the dropdown list of file types.

3. Select a file or specify the file name of the text file. Confirm with Open (or Save).

4. The program now displays an additional dialog box where you can specify the character set.

The following settings can be made in it:

§ Character set 

Here, you can specify which character set to use when the text file is opened/saved.

Note: TextMaker suggests a suitable character set automatically. Usually, there is no need to change this
setting.

§ Encoding of newlines 

Only when saving: Here, you can select the control characters to insert at the end of each line (to indicate
the beginning of a new line).

Note: TextMaker suggests suitable control characters automatically. Usually, there is no need to change this
setting.

Available options:

CR+LF: This is the recommended setting for Windows.
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LF: This is the recommended setting for Linux and Mac.

CR: This control character was common on older Apple Mac systems (before macOS).

Notes on the HTML format
You can also open or save HTML formats with TextMaker.

Opening an HTML document

Internet pages are usually stored in HTML (Hypertext Markup Language) format. HTML documents can be
identified by the name extension .htm or .html. They can be opened in TextMaker as follows:

1. Choose the ribbon command File | Open (click directly on the icon itself).

2. Select the HTML format in the dropdown list of file types.

3. Select the desired file and open it.

TextMaker opens the HTML document and displays it on the screen.

Note: The presentation of a document in TextMaker may differ from that in a web browser. However, you can
check the actual appearance of the document at any time by opening it in your browser.

Saving an HTML document

To save a document in HTML format, proceed as follows:

1. Choose the ribbon command File | Save as.

2. Select the HTML format from the dropdown list Save as type.

3. For File name, enter the name under which the file is to be saved and confirm saving.

The document is now saved in HTML format.

All formatting not supported in HTML format will be automatically removed. 

Tip: After saving, open the document with your web browser to check its final appearance.

Horizontal lines

With the command Horizontal line, you can insert a horizontal line into the text – for example, if a separator
line is required. Of course, such lines are not limited to HTML documents; they can also be used in normal
documents.
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Note: This command is not on the ribbon by default. However, you can choose it directly via the hamburger

menu  (on the left in the Quick access toolbar) as in the classic menu interface with the menu command
Objects > New horizontal line.

To insert such a line, place the text cursor on the desired line and choose the menu command Object > New
horizontal line. The line is now inserted. By default, it extends all the way from the left to the right margin.

To change the appearance of the line, select the line by clicking on it and then right-click to open the context
menu. Select the entry Line properties. (Tip: This command can also be chosen by double-clicking on the line)
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Working with Arabic text
In this chapter, you will learn everything you need to know about composing and editing text in Arabic font. It
is divided into the following sections:

§ Enabling extended support for Arabic text 

§ Changing the text direction of paragraphs

§ Changing the direction of tables

§ Changing the direction of multi-column text

§ Changing the font of Arabic text

§ Inserting dates in Arabic

For more information, see the following pages.

Important: The functions described in this chapter are only available if you have enabled the option
Extended support for Arabic text in the program settings. For more information, see the next section. 

Enabling extended support for Arabic text
TextMaker has "extended support for Arabic text", which provides some additional functions for editing text in
Arabic font.

To enable this option, proceed as follows:

1. Choose the ribbon command File | Options .

2. Switch to the General tab.

3. Enable the option Extended support for Arabic text.

Important: The functions described in this chapter are only available if this option is enabled.

Changing the text direction of paragraphs

If the option Extended support for Arabic text is enabled in Options , you can switch the text direction
between left-to-right and right-to-left in a paragraph at any time.
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To do so, proceed as follows:

1. In the relevant paragraph, right-click to open the context menu and select Paragraph.

2. In the dialog box, switch to the Paragraph tab.

3. Under Text direction, select the desired option: "Left to right" or "Right to left".

Tip: Using the keyboard

You can change the text direction of a paragraph much quicker with the following shortcut keys:

§ If you press Ctrl and the left Shift keyñ at the same time, the text direction is set to left-to-right. 

§ If you press Ctrl and the right Shift keyñ at the same time, the text direction is set to right-to-left.

Mac/Linux: On some systems (including macOS and several Linux distributions), these shortcut keys do not
work. Alternatively, you can use the shortcut keys Ctrl+Shift+A (for left-to-right) and Ctrl+Shift+D (for right-
to-left).

Changing the direction of tables

If the option Extended support for Arabic text is enabled in Options , you can change the text direction of
tables at any time.

To do so, proceed as follows:

1. After creating a table, switch to the contextual ribbon tab Table.

2. Choose the ribbon command Table | Properties  to open the dialog box (click directly on the icon itself
or on the entry Table properties via the icon's arrow).

3. Switch to the Properties tab.

4. Under Text direction, enable the option Right to left to change the direction to right-to-left.

The direction of the table then changes accordingly.

Thus, if you change the direction of a table to right-to-left, the column on the far right becomes the first column
(instead of the column on the far left).

This means that the table is mirrored horizontally, as shown in the following figure:

Left: Table with text direction set to left-to-right
Right: Table with text direction set to right-to-left

Note: The text direction of the text in each individual table cell can still be defined individually, of course (as
described in Changing the text direction of paragraphs).
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Changing the direction of multi-column text

If the option Extended support for Arabic text is enabled in Options , you can change the text direction of
a multi-column text area at any time.

To do so, proceed as follows:

1. In the area, choose the ribbon command Layout | group Section | Columns (click directly on the icon
itself).

2. In the dialog box, switch to the Columns tab.

3. Under Text direction, enable the option Right to left to change the direction to right-to-left.

The direction of the multi-column area now changes accordingly.

Thus, if you change the text direction in a multi-column area to right-to-left, the column on the far right
becomes the first column (instead of the column on the far left).

Note: The text direction of the text in each individual paragraph can still be set individually, of course (as
described in Changing the text direction of paragraphs).

For general information on working with multi-column text, see Multi-column page layouts.

Changing the font of Arabic text

If the option Extended support for Arabic text is enabled in Options , three lists for selecting font, font
size, font style and language appear on the Font tab in the dialog box of the command group Home |
Character :

§ For Latin scripts (for example, German, English) 

§ For East Asian scripts (Chinese, Japanese, Korean) 

§ For complex scripts (for example, Arabic)

Thus, you can make the settings for each type of script separately.

If, for example, you set the Latin character font to Arial and the complex character font to "Simplified Arabic",
all Latin characters that you type will automatically appear in Arial, and all Arabic characters will appear in
"Simplified Arabic".

TextMaker automatically recognizes whether the characters entered are Latin, Asian or complex (for example,
Arabic) scripts.
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Inserting dates in Arabic

If the option Extended support for Arabic text is enabled in Options , the following additional options for
inserting dates are available in the dialog boxes of the ribbon commands Insert | Date/time and Insert | Field
(both in the group Text):

§ Font 

Here, you can select the language in which day and month names are to be displayed in the date. You can
choose between the language for Western scripts, Asian scripts or complex scripts (for example, Arabic).

Note: The three Language options on the Font tab in the dialog box of the ribbon group Home | Character
can be used to specify the language to be used.

§ Calendar 

Here, you can specify whether the date should be based on the Gregorian calendar or the Islamic (Hijri)
calendar.

For more information on inserting dates and other fields, see Fields.
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Inserting dummy text
Inserting dummy texts is useful if you do not yet have any text available as content, but you want to check the
structure of templates or styles, for example. In TextMaker, you can use the "lorem" or "rand" commands to
automatically generate filler texts of various lengths.

While "lorem" generates a Latin-sounding fictitious dummy text, "rand" gives you a random text in real
language.

Note: The two commands =lorem() and =rand() only work if the option Automatically correct common
typos is enabled for the Auto correction.

Inserting dummy text with the "=lorem()" command

If you want to insert a fictitious Latin text (lorem ipsum...), proceed as follows:

In your TextMaker document, type =lorem() directly at the start of the line and press Enter¿ after the input to
trigger text generation. A dummy text of 5 paragraphs with 3 sentences each will then be inserted automatically.

Additional functions:

=lorem(8) creates a text with 8 paragraphs of 3 sentences each

=lorem(6,2) creates a text with 6 paragraphs of 2 sentences each

Inserting dummy text with the "=rand()" command

Inserting random text in real language works in the same manner:

In your TextMaker document, type =rand() directly at the start of the line and press Enter¿ after the input to
trigger text generation. A random text of 5 paragraphs with 3 sentences each will then be inserted
automatically.

Additional functions:

=rand(7) creates a text with 7 paragraphs of 3 sentences each

=rand(5,8) creates a text with 5 paragraphs of 8 sentences each



575Scripts (BasicMaker)

Scripts (BasicMaker)

Note: BasicMaker is only available for Windows and is not included in all versions of SoftMaker Office.

You can use the BasicMaker program to write and run scripts written in the programming language SoftMaker
Basic. SoftMaker Basic is based on Visual Basic for Applications (VBA), the programming language of
Microsoft Office.

Scripts can be used to automate workflows in the word processing application TextMaker and the spreadsheet
application PlanMaker.

Starting BasicMaker

To start BasicMaker or to run a BasicMaker script, use one of the following procedures:

§ Starting BasicMaker via the Start menu 

You can start BasicMaker by clicking on the Start menu (the Windows logo button) in the lower left corner
of the screen and choosing SoftMaker Office > BasicMaker.

§ Starting BasicMaker from within TextMaker/PlanMaker 

You can also start BasicMaker from within TextMaker or PlanMaker.

To do so, choose the ribbon command File | Edit script  in TextMaker/PlanMaker.

§ Running a script directly from within TextMaker/PlanMaker 

In TextMaker/PlanMaker, choose the ribbon command File | Run script  to run a script. A file dialog
appears. Select the script to be run, and confirm with OK.

All further information about BasicMaker and how to "program" TextMaker and PlanMaker can be found in the
help of BasicMaker, which can be accessed via the ? menu in BasicMaker.
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Working with multiple documents

Android/iOS: This function is not available for smartphones. For tablets, multiple documents can be opened
in the same program window.

You can have multiple documents open at any time – to compare them, edit them at the same time, exchange
data between them, etc.

You work with multiple documents as follows:

§ Opening multiple documents in the same program window 

You can open any number of documents at the same time in the current program window.

There are many ways to switch between these documents, including a bar that contains tabs for each
currently open document (displayed above the current document):

 

§ Opening files in a new program window 

You can also open documents in a new program window.

To do so, select the option New program window in the dialog box of the command File | New or of the
command File | Open when you create/open the document.

Note: To open the dialog box of the ribbon commands File | New or File | Open, click directly on their
actual icons and not on their small arrow.

The methods can be combined as desired. You can open as many program windows as you like and open any
number of documents as tabs in each of these windows. You can also open all documents in just one program
window. Alternatively, you can ensure that each document appears in its own program window. It is entirely
your choice.

In this chapter, you will learn everything you need to know about working with multiple documents at the same
time. For more information, see the following pages.
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Creating or opening a document
To create a new document or to open a document, proceed as follows:

§ To create a new document, choose the ribbon command File | New . 

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, the document templates used so
far will be displayed for quick access.

§ To open an existing document, use the ribbon command File | Open .

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, you can choose from the most
recently opened files.

These two commands New and Open are described in detail in Basics.

Option "New program window"

The option New program window in the dialog box of these two commands has the following significance:
When it is enabled, the document appears in a new program window. If it is disabled, the document will be
opened with a new tab in the existing program window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones, a separate program window is always opened, while in the
version for tablets, a new tab is always opened in the same program window.)

Switching between open documents

Android/iOS: This function is not available for smartphones. For tablets, you can switch between document
tabs within the same program window.

If you have multiple documents open at the same time, you can switch to a specific document and thus make it
the active document:

§ Ribbon interface: "Windows" icon 

In the ribbon, you will find an icon called Windows  on the ribbon tab View. If you click on it, a list of
all open documents appears. Click on the desired document.

§ Classic menu interface: "Window" menu item 

For classic menus, you will find a list of all currently open documents in the Window menu. Select the entry
for the document to which you want to switch.
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§ Toolbars interface (Android/iOS only): "Window" menu item 

You will find a list of all currently open documents for tablets via the hamburger menu  in the Window
menu. Select the entry for the document to which you want to switch.

§ Mouse: Clicking on a document tab 

Above the document, you will find a bar with document tabs for all currently open documents. Click on the
tab for the document to which you want to switch.

 

§ Mouse: Clicking into the program window containing the document 

Of course, if you have documents open in multiple program windows (see previous section), you can also
simply click into the program window with the desired document to make this document the active
document.

§ Keyboard: Ctrl+F6 

You can also use the keyboard to switch between the currently open documents: Ctrl+F6 switches to the
next document and Ctrl+Shift+F6 switches to the previous one.

Mac: On a Mac, you have to use the key combinations Cmd+F6 or Cmd+Shift+F6 to switch between
documents.

Arranging documents on the screen

Android/iOS: This function is not available for smartphones. For tablets, document tabs can be moved
within the program window.

 If you have multiple documents open, you can arrange them as follows:

§ The document tabs (the tabs in the bar above the document) can be moved within the bar and thus arranged
in any order. 

You can even drag a document tab out of the program window with the mouse in order to have a separate
program window for this document.

Alternatively, you can drag a document tab from one program window to another. The document will then
be integrated into the tab bar of the other program window.

§ If documents are open in different program windows, you can move the individual program windows
manually and resize them, of course – just as you can with all types of program windows.

§ If you choose the ribbon command View | group Side by side | View side by side  (in the classic menu
interface: Window > View side by side), you can display the current document side by side with another
open document on the screen. If more than two documents are currently open, the program first asks which
of them is to be used in the other window.
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After you have enabled the function View side by side, you can scroll synchronously through both
documents. For more information, see Viewing documents side by side.
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Closing a document

Android/iOS: Not all of the listed methods are available in these versions.

If you want to stop working on a document, you can close it at any time. If the document has been modified
since it was last saved, the program automatically asks you if you want to save the document first.

To close a file, you have the following options:

In the ribbon interface

The ribbon tab File contains a Close icon  which closes the current document.

Tip: Use the ribbon command View | Windows  | Close all to close all currently open documents at once.

In the classic menu interface

Choose the menu command File > Close to close the current document.

Tip: Use the menu command Window > Close all to close all currently open documents at once.

In the toolbars interface (Android/iOS only)

In the group File , choose the command Close .

Tip: For tablets, you can close all currently open documents at once via the hamburger menu  by choosing
the menu command Window > Close all.

Tabs for documents

Above the document, you will find a bar with tabs for all currently open documents. If you click on one of these
tabs with the middle mouse button, the corresponding document is closed.

Alternatively, left-click on the x icon displayed on the far right of each tab to close it.

Furthermore: If you right-click on a tab, a small menu appears with commands for closing the current document
(Close tab) or all other open documents (Close all other tabs).

Via the keyboard

You can also use the shortcut key Ctrl+F4 or alternatively Ctrl+W to close the current document.

Mac: On a Mac, you have to use the key combination Cmd+F4 or Cmd+W for this purpose.
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Customizing TextMaker
TextMaker lets you determine a variety of program settings so that you can customize the program to suit your
personal work style.

In this chapter, you will learn everything you need to know about it. It is divided into the following sections:

§ Changing TextMaker settings 

You can use the ribbon command File | Options to change the program settings. These settings apply to the
program as a whole and thus to all documents.

§ Changing document properties 

The document properties, on the other hand, are settings that only affect the current document and are also
saved in this document. They can be changed with the command File | Properties.

§ Customizing the document display 

This section describes how to customize the appearance of the document on the screen. Most of the required
commands can be found on the ribbon tab View.

§ Customizing the ribbon 

Only for "Ribbon": This section is relevant only for users who have selected in the settings that they want
to operate the program with the "ribbon".

Here, you will learn how to configure and customize the ribbon.

§ Customizing toolbars 

Only for "Classic menus with toolbars": This section is relevant only for users who have selected in the
settings that they would prefer to operate the program with "Classic menus with toolbars".

Here, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the menu
command View > Toolbars and how to customize them to your liking with Tools > Customize.

§ Creating user-defined icons 

You can create user-defined icons at any time and add them to the ribbon or to a toolbar. Such icons can be
used to start any program.

§ Customizing shortcut keys 

You can also customize the shortcut keys for choosing frequently used commands. The ribbon command
File | Customize is responsible for this purpose.

§ Using the grid and Using guides 

Grid and guides are positioning aids for moving objects such as frames and drawings with your mouse. They
can be enabled and configured with the ribbon command View | Grid and guides.

§ Installing dictionaries 

In this section, you will learn how to install dictionaries for the spell check.

For more information on the above topics, see the following pages.
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Changing TextMaker settings

General settings can be changed with the ribbon command File | Options . These settings apply to all
documents.

The options in the dialog box of this command are distributed by topic across multiple tabs. If you click on the
Files tab header, for example, you can make settings for opening and saving files.

The following pages contain detailed information on all available settings.

Settings, View tab

On the View tab in the dialog box of the ribbon command File | Options , you can make settings for the
appearance of documents on the screen:

Document window section

Here, you can select the tools to be displayed in document windows:

§ Table guidelines 

Here, you specify whether or not a grid of gray guidelines should be displayed between the cells of tables.
These lines are only for your orientation on the screen. They are not printed.

This option is enabled by default.

§ Frame guidelines 

Here, you specify whether or not gray guidelines should be used to make the boundaries of text frames
visible. These lines are only intended to reflect the position and size of the text frame on the screen. They
are not printed.

By default, this option is enabled.

§ OLE object guidelines 

Windows only: Here, you specify whether or not gray guidelines should be used to make the boundaries of
OLE objects visible. These lines are only intended to reflect the position and size of the object on the screen.
They are not printed.

By default, this option is enabled.

§ Guides 

As described in Using guides, you can set up guides in a document to simplify the flush positioning of
objects.

With this option, you specify whether or not these guides should be displayed on the screen.

By default, this option is enabled. (Note: If you disable this option, the guides will become invisible but will
retain their function.)
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Tip: You will also find this option directly in the dropdown menu of the Grid and guides icon  on the
ribbon tab View (in the group View).

§ Page margins 

Here, you specify whether or not the page margins should appear as dotted lines in the document. These
lines are only intended for orientation on the screen. They are not printed.

By default, this option is enabled.

§ Horizontal ruler 

Here, you can enable or disable the horizontal ruler.

The horizontal ruler is displayed above the text and is usually called the ruler in this manual. It not only
displays the current paragraph formatting, but it also lets you change indents and tabs with the mouse. For
more information, see Paragraph formatting: Indents.

By default, this ruler is enabled.

Tip: The horizontal  and vertical rulers  can also be enabled and disabled directly on the ribbon tab
View (in the group View).

§ Vertical ruler 

Here, you can enable or disable the vertical ruler.

The vertical ruler is displayed to the left of the text. It is for informational purposes only and does not allow
formatting changes.

By default, this ruler is disabled.

§ Overflow mark 

If this option is enabled, TextMaker displays a red bar at the bottom of text frames, table cells, comments,
etc., whenever there is too much text to fit completely into the frame.

Note: The red bar will appear only if the object Height is set to Fixed or Growing (Max value) on the "Format" tab of Object
properties and the defined limit has been reached.

Show non-printable characters section

Here, you specify whether to display formatting marks for paragraph marks, tabs, spaces, etc., in the text so that
they are easier to recognize.

The markers for paragraphs, tabs and spaces have been enabled here
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§ Paragraph marks 

If you enable this option, TextMaker displays a paragraph mark at the end of each paragraph. This is
represented by the icon ¶. This lets you see exactly where paragraphs end.

§ Tabs 

If you enable this option, all tabs will be identified by small arrows on the screen.

§ Spaces 

If you enable this option, all spaces on the screen will be identified by small dots.

§ Soft hyphens 

If you enable this option, all soft hyphens will become visible on the screen and will be displayed as
hyphens with a gray background.

§ All 

This option enables all of the above options together.

Note: If you choose the ribbon tab Home | group Paragraph and enable the icon for formatting marks ,
the option All will also be automatically enabled here in the dialog box and vice versa.

Show scrollbars section

Here, you can specify whether to display a horizontal and/or vertical scrollbar for the document.

Wrap text to window (in continuous and outline view)

If this option is enabled, the lines of text are wrapped at the right edge of the document window, regardless of
their actual width. You won't see the actual layout of the document, but it will be easier to read the text on
devices with a small display (without having to constantly scroll left and right).

Note: Enabling this option only affects the continuous and outline views (ribbon command View |
Continuous or Outline).
In standard view (ribbon command View | Standard), it has no effect.

Show multiple pages side by side

With this option, you can specify if TextMaker should display multiple pages of a document side by side when
the document is viewed at a very low zoom level:

§ Enabled: As many pages as possible are displayed side by side. This allows you to view multiple pages at
the same time. 

§ Disabled: The pages are never displayed side by side but only beneath one another.
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Settings, General tab

On the General tab in the dialog box of the ribbon command File | Options , you can make general settings:

Maximum number of undo steps

Here, you can set how many actions can be undone with the command Undo  (in the Quick access toolbar).
You can increase this number up to a maximum of 999 undo operations.

Note: On devices with little main memory, it is not recommended to increase this value.

For information on the command Undo, see Undoing changes.

"User info" button

Here, you can enter your name, address and other contact information. This information is used, for example,
by the supplied document templates to automatically fill letterheads with your address. For more information,
see also Document templates.

Note: In older versions of TextMaker, there were two buttons at this point because you could specify your
user info separately for your home address and company address. Since TextMaker 2018, only one user info
record is supported in order to improve compatibility with Microsoft Word.

Enable dictation support

Mac only: If you enable this option, you can make better use of the macOS dictation feature in TextMaker.
However, you must expect the program to run more slowly as a result.

Extended support for Asian fonts

If this option is enabled, three lists for selecting font, font size, font style and language appear on the Font tab
in the dialog box of the command group Home | Character :

§ For Latin scripts (for example, German, English) 
§ For East Asian scripts (Chinese, Japanese and Korean) 
§ For complex scripts (for example, Arabic)

Thus, you can make the settings for each type of script separately.

If, for example, you set the font to "Arial" for Latin scripts and the font to "SimHei" for Asian scripts, all Latin
scripts that you type will automatically appear in Arial, and all Asian scripts will appear in SimHei.

TextMaker recognizes automatically whether the characters entered are Latin, Asian or complex (for example,
Arabic) scripts.



586Customizing TextMaker

Extended support for Arabic text

If you enable this option, some additional features will become available for editing text in Arabic script. For
more information, see Working with Arabic text.

Display of digits

This option allows you to specify which type of numerals to use when displaying numbers in your documents:

§ Arabic: Display Arabic numerals (1234567890), as used in English, for example. This is the default setting. 

§ Hindi: Display Hindi numerals, as used in Arabic, for example.

§ Context: Adapt automatically from the context. (If the number is surrounded by Arabic text, Hindi numerals
are used, otherwise Arabic numerals are used.)

Select whole words when selecting

Windows, Mac and Linux only: If this option is enabled, TextMaker automatically extends any selection that
you make with the mouse to whole words. If it is not enabled, the selection is extended on a character-by-
character basis.

Add or remove spaces when pasting

If this option is enabled, spaces before and after words are automatically added or removed when you delete,
cut, or paste words from the clipboard.

If, for example, you select the word "is" in the sentence "This is a test" and cut it with the command Cut,
TextMaker automatically deletes the space behind "is" that is now superfluous.

If you now insert the word "is" before another word using the command Paste, TextMaker automatically inserts
a space after "is".

Default paste option

Here, you can define how the formatting of the text should behave by default when content from the clipboard
is pasted into the document after choosing the ribbon command Home | group Edit | Paste. For more
information, see also Paste special.

Middle mouse button

Mac and Linux only: Here, you can specify what should happen when you click somewhere using the middle
mouse button. Available options:

§ No function: The middle mouse button doesn't have any function. 

§ Paste selected content: If you click in the document with the middle mouse button, a copy of the currently
selected content is inserted at this point (for example, the currently selected text).
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Apply character formatting to entire words

Enabling this option has the following effect:

If the cursor is inside a word and you change the character formatting (for example, select a different font or
enable bold), this will affect the entire word.

This allows you to quickly change the formatting of a single word without first having to select it.

Set left and first-line indent with Tab and Backspace keys

If this option is enabled, you can use the Tab key and the Backspace keyÕ on the keyboard to change the
indents of paragraphs.

To do so, either place the text cursor at the beginning of an existing paragraph or select multiple paragraphs.
Then press Tab to increase the indent or press BackspaceÕ to decrease it.

Use the Insert key to toggle overwrite mode

This option is enabled by default and allows you to use the Ins key on your keyboard to switch between insert
mode and overwrite mode (see also Insert or overwrite?).

If you remove the check mark in front of the option, this typical function of the Ins key will be disabled when
working in TextMaker. This prevents accidental switching to overwrite mode.

Insert frames and drawings immediately

This option determines what should happen if you insert a frame or a drawing into a document (text frame,
picture frame, AutoShape, etc.) – for example, with the ribbon command Insert | Text frame:

§ Always: The corresponding object is inserted immediately. Its position and size are fixed without further
action. 

(Of course, you can always change the object's position after insertion by simply dragging it to the desired
location with the mouse. You can also resize it by dragging one of the round handles that surround the
object.)

§ Never: Before the object is actually inserted, the mouse cursor changes to a crosshair. In order to proceed,
drag a rectangle in the document to specify the desired position and size. The object will then be inserted
exactly according to your specifications. 

§ Auto: This is a smart combination of the two aforementioned options that is already preset in TextMaker for
each specific object type. Objects such as charts or tables are inserted directly (as with Always), for
example, while objects such as AutoShapes or text frames are inserted via the mouse cursor (as with Never).
 

"Auto correction" button

TextMaker can automatically correct common typos and also provides other useful auto correction functions. If
you click on the Auto correction button, the program opens an additional dialog box in which you can make
the appropriate settings.
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Tip: The ribbon command Review | group Spelling | Auto correction  can also be used to open the auto
correction dialog box.

For more information on this topic, see Auto correction.

Use left Alt for shortcut keys

Mac only: This option determines which function the left Alt key on your keyboard should have:

§ Off: The left Alt key does the same as the right Alt key: It inserts icons into the text. 

Alt+E, for example, returns a euro sign €.

§ On: The left Alt key can be used to open menus in the classic menu. 
Note: This only works if you use the program with the classic menu interface instead of the ribbon interface.

Here, Alt+E no longer returns a euro sign, but opens the Edit menu instead.

Show warning when loading OLE objects

For Mac, Linux and Android/iOS: If this option is enabled, the program displays a warning that OLE objects
cannot be displayed when you open a document containing such objects. (OLE objects can only be displayed on
Windows.)

Settings, Appearance tab

On the Appearance tab in the dialog box of the ribbon command File | Options , you can make settings that
affect the appearance of the TextMaker user interface:

Dialog language

Here, you can select the language in which the user interface (ribbon, menus, dialog boxes, etc.) is to be
displayed.

"User interface" button

If you click on the User interface button, the program displays a dialog box in which you can select the type of
user interface that the SoftMaker Office applications should use:

§ Ribbon (top row) 

If you select one of the styles from the top row, the programs use a "ribbon" as the user interface. The only
difference between the individual styles is in the color scheme used: colorful, light grey or dark.

§ Classic menus with toolbars (bottom row) 

If you select one of the styles from the bottom row, the programs will use classic menus with toolbars. You
can also choose between different color schemes here.
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Android/iOS: If you are using these versions, select the user interface via the dropdown list. Here, you
have an additional option: Toolbars. For more information, see User interface on Android/iOS. The options
Quick access toolbar and Touch mode can be found separately elsewhere on this Appearance tab and work
as described below.

Furthermore, the following settings can also be made for the user interface:

§ Quick access toolbar (only in the ribbon interface) 

This option determines where the Quick access toolbar, which contains icons for some of the most
frequently used commands, should be displayed: to the left of the document tabs – or in a separate toolbar
directly below the ribbon.

§ Touch mode 

If you enable this option, all icons in the ribbon user interface or menu interface and toolbars will be slightly
enlarged. This is useful when operating the software with your finger (for example, on a tablet).

Tip: Alternatively, you can also enable/disable touch mode with the following commands:

Ribbon user interface: Here, you choose the command Touch mode  in the Quick access toolbar.

Classic menu interface: Here, you choose the command View > Touch mode.

§ Update dark and light design automatically from the system 

If you enable this option, the style of the user interface (light or dark) will be based on the color settings of
your operating system. Thus, if you operate your device in dark mode, the SoftMaker Office applications
will automatically switch to this mode also.

(This option is not available in the Linux version.)

"User interface size" button

This button opens a dialog box that allows you to reduce or enlarge the user interface (menu, toolbars, dialog
boxes, etc.).

If you select a lower setting here, all user interface elements will be reduced, which will allow you to see more
elements at a time. A higher setting, on the other hand, increases legibility.

Use the mouse (or your finger) to drag the Size of dialog elements slider to gradually change the size of the
user interface.

The Sample field acts as a small tool to help you find a suitable setting: It gives you a preview of how a
checkbox in a dialog box or even in the Quick access bar will look after you have applied your changes.

Note: Inappropriate settings may cause the user interface to be far too small or too large, especially on
devices with a relatively low resolution. If this happens, you can always click on the Reset to default button
in the lower left of this dialog box to return to the default settings.

The option Touch mode only enlarges the icons (see also description above). Incidentally, you will also find
this function directly in the Quick access bar.
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Document scaling (DPI)

You can scale the document higher or lower for a larger/smaller view. To do so, select Custom and enter the
desired value.

Show full path in title bar

Enable this option if you want the title bar to display not only the name of the document but also its file path.
(Not available in the Android/iOS version.)

Show status bar in ribbon mode

This applies only to the ribbon interface: You can enable/disable the display of the status bar here. To change
this for the classic menu interface, see Showing and hiding toolbars.

Show fonts in font list

If this option is enabled, TextMaker displays all font names in the respective font in font lists (for example, in
the font list of the command group Home | Character in the ribbon or in the Formatting toolbar in the classic
menu interface). This lets you see the actual appearance of each font at a glance.

Show tooltips

This option lets you specify whether or not tooltips should be displayed. These are short info texts that are
displayed next to the mouse cursor when you hover over a screen element (for example, a button in the ribbon
or in the Standard toolbar for the classic menu interface).

Beep on errors

If this option is enabled, TextMaker emits a beep for error or warning messages.

Use system file dialogs

This option controls the type of dialog boxes that appear when you use commands for opening and saving files.
The options are:

§ Disabled: TextMaker uses its own file dialogs. 

§ Enabled: The default file dialogs of the operating system appear, which you know from the majority of
applications.

The former are easier to use; the latter offer more options.

Note for users of the iOS version: The system file dialogs are always used automatically here.

Note for users of Linux: You must be running the Gnome desktop environment so that this function is available. (This automatically
means you have the Gtk libraries installed).

Live preview

Here, you can enable/disable a live preview for the dropdown lists that are located, for example, in the
command group Home | Character.
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If this is enabled, for example, you can select text, open the font list in the command group Home | Character
and then hover over the fonts in it. The document immediately shows how the selected text would look "live" in
the corresponding font.

To actually apply the font, simply click on it. To discard the change, click anywhere outside the font list or
press the Esc key.

Smooth edges of screen fonts

If this option is enabled, TextMaker uses a technology called "anti-aliasing" to smooth the edges of fonts and
improve their appearance on the screen.

Different options are available depending on the operating system.

Workspace color

This option allows you to change the background color of document windows.

Measurement

Mac, Linux, Android/iOS only: Here, you can specify the units of measure which TextMaker should use by
default: Metric (centimeter) or U.S. (inch).

(On Windows, this option is not required because the program automatically uses the setting that was selected
in the options "Region and Language" of the Windows Control Panel.)

Tip: You can always override this setting and enter a value into dialog boxes in another unit of measure by
typing one of the following unit of measures after the value:

Unit Explanation

cm Centimeter

in Inch – 1 in equals 2.54 cm.

pt Point – 72 pt equal 1 in.

pi Pica (character) – 1 pi equals 12 pt

If, for example, you type "5.08 cm" for the left margin, TextMaker sets it to 2 inches (5.08 cm).

Desktop mode

Android/iOS only: If you are using a tablet, you should enable this option so that TextMaker is displayed in an
optimized manner on tablet devices. If you are using the application on your smartphone, leave this option
disabled.
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Settings, Language tab

On the Language tab in the dialog box of the ribbon command File | Options , you can make settings for
TextMaker's language tools:

Default language

Here, you can select the default language to be used for spell check, hyphenation and the thesaurus. To do so,
open the dropdown list and select the desired language from the available options.

Note: Please note that there are two entries in this list for German:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Tip: If you want to use several languages simultaneously in a document, you can format any sections of text in
another language on the Font tab in the dialog box of the command group Home | Character .

For more information on this topic, see Setting the language.

Spell check

Here, you can make the following settings for the spell-check:

§ Check spelling as you type 

If you enable this option, the spelling of the entire document will be continuously checked in the
background. Incorrectly spelled words are indicated with wavy red underlines and can be corrected at any
time. For more information, see Checking the spelling as you type.

Note: If this option is disabled, you don't have to do without a spell check – you can always start it manually
with the ribbon command Review | Spell check. For more information, see Manual spell check.

§ Color 

Here, you can change the color of the red underlines used by the function "Check spelling as you type" to
indicate misspelled words.

§ Underline old German spellings in blue 

If this option is enabled, the function Check spelling as you type also underlines with a blue wavy line all
words that correspond to the old German spelling but should be spelled differently according to the new
spelling of the spelling reform of 1996. For more information, see also Conversion to the new German
spelling.

Note: This option only works for text in the language "German (Germany)", "German (Austria)" or "German
(Switzerland)".
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§ Use Duden Korrektor for German spell check 

This feature is only included in SoftMaker Office Professional and NX Universal.

If you enable this option, the spell check will no longer use the module integrated in TextMaker but will
instead use the spelling module of Duden Korrektor (and its dictionary, of course). For more information,
see also Using the Duden spell check.

Note: The Duden Korrektor only works for text in the language "German (Germany, Austria, Switzerland,
etc.)".

§ Ignore words that start with a number 

If you enable this option, the spell check ignores all words that start with a number (for example, "1980s").

§ Manage dictionaries 

As an alternative to its own dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries.
They are available free of charge for installation. Most of them were created by private users or non-profit
organizations.

The Manage dictionaries button allows you to install dictionaries and also specify which of these
dictionaries should be used for a language. For more information, see Installing dictionaries.

Hyphenation

Here, you can make settings for hyphenation:

§ Use automatic hyphenation 

This option corresponds to the ribbon command Review | Hyphenation  | Automatic hyphenation.

Hyphenation usually occurs fully automatically when typing. If you disable this option, however, there will
be no automatic hyphenation for the current document, and all existing hyphens will be removed. For more
information, see also Hyphenation.

Important: Unlike all other options on this tab, this setting is a document option rather than a global setting.
TextMaker thus remembers the state (on/off) of this setting per document.

However, if you want TextMaker to remember the currently selected hyphenation state (on/off) as a global
setting, click on the Set as default button. From now on, the currently selected hyphenation state is retained
for all new documents that are created based on the "Normal.tmvx" document template.

§ Use Duden Korrektor for German hyphenation 

This feature is only included in SoftMaker Office Professional and NX Universal.

If you enable this option, the hyphenation module of Duden Korrektor will be used for hyphenation instead
of the module integrated into TextMaker. For more information, see also Using the Duden hyphenation.

Note: The Duden Korrektor only works for text in the language "German (Germany, Austria, Switzerland,
etc.)".
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Grammar check

Here, you can make settings for the grammar check:

§ Use Duden Korrektor for German grammar check 

This feature is only included in SoftMaker Office Professional and NX Universal.

If you enable this option, the Duden Korrektor grammar check is enabled. This works according to the same
principle as the option Check spelling as you type. However, it does not search for spelling errors, but for
grammatical errors. If an error is found, it marks it with a green underline. For more information, see also
Using the Duden grammar check.

Note: The Duden Korrektor only works for text in the language "German (Germany, Austria, Switzerland,
etc.)".

§ Color 

Here, you can change the color of the green underlines that the grammar check uses to identify misspelled
words or phrases.

Duden Korrektor options

This feature is only included in SoftMaker Office Professional and NX Universal.

This button opens a dialog box in which you can configure all modules of Duden Korrektor (i.e., Duden spell
check, Duden hyphenation and Duden grammar check).

For more information, see Configuring Duden Korrektor.

Settings, Files tab

On the Files tab in the dialog box of the ribbon command File | Options , you can make settings for opening
and saving files:

Template folder

Here, you can specify the folder in which the templates for TextMaker documents are stored.

The dialog box that appears when you choose the ribbon command File | New to let you select a document
template displays all templates that are in this folder.

Note: Normally, this setting should not be changed. Change it only in the event that you have actually moved
the template folder to another place.
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Default file format

Here, you can select the file format in which TextMaker should save newly created documents by default.

If you create a new document with the ribbon command File | New and then save it for the first time, the Save
dialog box always suggests the file format set here as default.

You can choose between the TextMaker format, the Microsoft Word format in several versions, the
OpenDocument format and the RTF format.

Important: Note that the other formats offered here do not know all of TextMaker's functions. If, for
example, you save a TextMaker document in Word format, certain formatting options or functions could be
lost. We thus recommend that you use the default setting "TextMaker" here.

Saving section

In the Saving section, you can make settings for saving documents:

§ Prompt for summary information when saving 

If you enable this option, a dialog box will appear automatically the first time you save a new document to
enable you to enter some additional information about it. For more information, see Document summary.

§ Display warning when saving documents in text format 

If this option is enabled, saving a document in plain text format will result in a warning being displayed that
all objects and formatting will be lost.

Opening section

In the Opening section, you can make settings for opening documents:

§ Return to the last editing position when a document has been opened 

When you open a document and this option is enabled, TextMaker automatically positions the text cursor at
the place where it was located the last time you saved the document.

Note: This works only with documents in the following file formats: TextMaker (.tmd or .tmdx) and
Microsoft Word (.doc or .docx).

Tip: Even if you have not enabled this option, you can always return to the last editing position after
opening the document by pressing Shift+F5.

§ Recently used files in File menu

If you click on the small arrow on the ribbon command File | Open , TextMaker displays a list of the most
recently opened files. If you select one of these entries, the corresponding file will be opened immediately.
Here, you can specify the number of files to be displayed in the list.

Android/iOS only: Backup section

The Android/iOS-Version does not contain a "Backup" tab and its settings, which are described in the next
section. Instead, you have to choose either No backup or Simple backup in the dropdown list on the "Files" tab.
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§ No backup 

If you select this option, no backups will be created when documents are saved. (This option is not
recommended.)

§ Simple backup 

This makes one backup per document. It contains the previous version of the document. It has the name
extension .bak and is in the same folder as the document itself.

The Android/iOS version has also the following option for the Opening section above.

§ Auto recovery: Save state every ... minutes 

If this option is enabled, TextMaker automatically makes a temporary backup copy of every opendocument
on a periodic basis. You can enter a period of 1 to 100 minutes.

Note: These temporary backup copies work completely independently of the Simple backup/No backup
option described above.

When you exit TextMaker in the normal manner, these temporary backup copies are automatically deleted.
However, if it is not terminated correctly (for example, due to a crash), TextMaker will detect this the next
time the program is started. It then opens (after prompting) the temporary backup copies of all documents
that were open when the crash occurred and contained unsaved changes.

You can then check each of the restored documents to determine if any of the most recently made
changeshave actually been lost, and then save them.

Settings, Backup tab

Android/iOS: This tab is not available in the Android and iOS versions. However, simple backups can be
made here. This setting can be found on the Files tab.

On the Backup tab in the dialog box of the ribbon command File | Options , you can make settings for
creating backup copies:

"When you save a file manually..." section

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is enabled, the command File | Versions  (in the group File management) is also
available, which allows you to easily return to a previous file version of the currently open document.

§ Number of versions to keep 

Here, you specify the maximum number of versions of backups (generations) to be kept per document.
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"Automatically created file versions (snapshots)" section

§ Save unsaved changes every ... minutes 

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

§ Number of snapshots to keep

In this dropdown field, you specify the maximum number of snapshots you want to keep.

Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

"Clean up" button

This button provides two options for deleting file backups from the backup folder:

§ Delete orphaned file versions

This option removes all TextMaker backups for which the corresponding original document no longer
exists.

§ Delete file versions of all documents

This option removes all backups from TextMaker.

For more information on using file backups, see Backup copies (file versions).

Settings, System tab

On the System tab in the dialog box of the ribbon command File | Options , you can make the following
system settings:

Smooth edges of pictures

If this option is enabled, TextMaker uses anti-aliasing to smooth edges and lines in pictures. Advantage: The
display quality of scaled pictures is improved. Disadvantage: This procedure consumes some CPU time when
displaying pictures, of course.

Enable OpenGL AutoShapes

If this option is enabled, TextMaker uses the OpenGL graphics engine to display AutoShapes optimally. If you
disable this option, 3D effects used for AutoShapes may no longer be displayed correctly. Thus, you should
usually leave this option enabled.
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Check for updates

Windows, Mac and Linux only: Here, you can specify how often you want the software to check whether
there are updates for SoftMaker Office. Updates provide bug fixes and feature improvements.

Note: Checking for updates only works if your device can access the Internet.

You can also disable the automatic update check (not recommended) by selecting Never from the dropdown
list. Checking for updates can then only be done manually – by clicking on the Check now button.

Tip: Subscribe to our free newsletter at www.softmaker.com to automatically receive an e-mail whenever
updates are available. The newsletter will also provide you with other useful information and special offers
with respect to SoftMaker Office on a regular basis.

Android/iOS: For applications installed from the Google Play/Apple App Store, your device will automatically
notify you of updates (unless disabled in the settings of the respective store).

Associate file types

Windows only: This button opens a dialog box where you can associate certain file types with TextMaker.
This will make TextMaker the default application for the corresponding file types.

If, for example, you link the file type "Microsoft Word documents" with TextMaker, files of this type will
always be opened in TextMaker when you double-click on such a file in Windows Explorer.

Show a message during program launch when TextMaker is not the default program

Windows only: The aforementioned button enables you to set TextMaker as the default program for opening
certain file types. Over time, another application may assume the role as the default program for opening such
file types.

If this option is enabled, a message will then appear the next time you open this file type in TextMaker asking
whether you want to set TextMaker as the default program again. If this option is disabled, the message will no
longer be displayed.

Show/hide keyboard automatically

Android/iOS only: If this option is enabled, the on-screen keyboard opens automatically when you can type
something (for example, if you tap into the document or tap into an input field in a dialog box).

Change keyboard layout automatically

Android/iOS only: If this option is enabled, the layout of the on-screen keyboard will automatically adapt to
the current situation. If, for example, you type into an input field in a dialog box which only accepts numbers,
the keyboard will automatically be switched to numeric mode.

Enable OpenGL engine

Linux only: If this option is enabled, the program uses the OpenGL graphics engine. This speeds up the screen
display. Thus, this option should usually be enabled.

http://www.softmaker.com/
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Note: On systems with a very outdated or faulty OpenGL installation, display errors may occur within the
application. This depends on your individual system configuration and especially on the graphics driver you are
using. In this case, disable this option and restart the application.

Furthermore: If the program detects problems with the installed OpenGL engine at startup, it will automatically
disable this option.

Use SHM extensions

Linux only: This option is only available if the option Use OpenGL engine is disabled (not recommended).

If the SHM extensions are enabled, the program uses shared memory (if available), which can speed up the
responsiveness of the display.

Use XIM

Linux only: If this option is enabled, TextMaker supports the composition of accented characters (à, ô, é etc.)
using "XIM".

On a German keyboard, for example, the character "ô" can be created by first pressing the ^ key and then the O
key.

If you disable this option, you can no longer compose characters in this way.

Note: On some systems, disabling this option improves the responsiveness of the display when you are typing
text quickly.

Show hidden files and folders

Mac, Linux only: If this option is enabled, hidden files and folders are also displayed in file dialogs (for
example, those of the ribbon command File | Open).

Lock files for exclusive write access

Mac, Linux only: If this option is enabled, some distributions of macOS and Linux can prevent a TextMaker
file from being changed by different programs at the same time. If the option is disabled, different programs can
access a file at the same time.

User-defined font paths

Mac, Linux, Android/iOS only: Here, you can specify paths for additional fonts that TextMaker should use.
To do so, enter the subdirectory in which the font files are located. If you want to enter multiple directories,
separate them with a colon.

TextMaker can then use these fonts in addition to the fonts available in your system.

Note: Changes to this setting only become effective after the program is restarted.

Mouse wheel

Mac, Linux only: If your mouse has a mouse wheel, you can set the scrolling increment for a turn of the wheel
either by page (one complete page) or by a certain number of lines.
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External applications

Mac, Linux only: This button opens a dialog box where you can specify the external programs that start
automatically for specific events. When a PDF file is created, for example, the application specified in the PDF
viewer field will be launched to display the result.

Note: You don't have to fill in these fields. For all fields that you leave empty, your system's default application
will be automatically used for this action. Make changes to this dialog box only if you want an application other
than the default application to be used. To do so, simply enter the file name of the corresponding executable file
(including the entire file path, if necessary).

Settings, Fonts tab

On the Fonts tab in the dialog box of the ribbon command File | Options , you can specify which fonts are
to be displayed in font lists (for example, the font list on the ribbon command Home | group Character).

The tab presents a list of all fonts installed on your system. To enable or disable a font in the list, click on the
checkbox in front of its name. All fonts for which you have removed the check mark are no longer displayed in
font lists.

Background information: The fonts installed on your system by default include several fonts that you will
probably never need – for example, fonts that only contain scripts for foreign languages that you don't use. If
you like, you can hide such fonts as described above.

Windows: Use font filtering of the operating system

Windows users will also find the option Use font filtering of the operating system on this tab. If this option is
enabled, Windows will automatically hide in font lists all fonts that only contain scripts for foreign languages
(for example, Asian/Arabic fonts).

Mac: Load only fonts relevant for installed keyboard layouts

MacOS users will also find an option on this tab called Load only fonts relevant for installed keyboard
layouts.

Explanation:

On macOS, there are numerous fonts installed on the system with foreign language characters that you usually
do not need (for example, Asian/Arabic fonts).

If this option is enabled, such fonts are automatically hidden in the font lists. These fonts will continue to
appear in the font lists only if you use appropriate keyboards for Asian/Arabic fonts or enable font support. For
more information, see Settings, General tab.

If you disable this option, all system fonts are always available in the font lists.
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"Manage" button

In the dialog box of the ribbon command File | Options , you will find the Manage button on each tab. You
can use it to save the settings of the program and, for example, transfer them to a new version.

For more information, see the following pages.
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Exporting/importing settings
You can save your individual settings that you have configured in the SoftMaker Office applications. In the first
step, export the settings data – for example, before you install a new version. Then, in the second step, import
this data into the newly installed version.

For both steps, use the Manage button in the dialog box of the command File | Options .

For information on which settings you can export/import exactly, see below.

Note: Export and import of settings data is only possible as of version 2021.

What reasons could there be to export/import settings?

The following reasons could be considered for exporting/importing your settings:

§ You want to apply the settings of the old version to a new version of SoftMaker Office that you are
installing on the same computer. 

§ You have also installed the current version of SoftMaker Office on another computer and want to use the
same settings there.

§ You want to apply the settings of an old version of SoftMaker Office to another computer on which you
have installed the new version of SoftMaker Office.

Which files are backed up?

For the export, TextMaker accesses the settings files (...config.ini, ...tools.dat, etc.) that are stored on your
device in the SoftMaker > Settings folder. Depending on the operating system, these files are located in
the following directory:

§ Windows: In the SoftMaker\Settings folder in your Documents folder. 

§ macOS: In the SoftMaker/Settings folder in your Documents folder.

§ Linux: In the SoftMaker/Settings folder in your Home folder.

§ Android: In the SoftMaker/Settings folder on your SD card.

§ iOS: In the SoftMaker/Settings folder in your App folder.

Note: The above information is for illustrative purposes only and you usually do not need to do anything
here. TextMaker will automatically replace these files for you if you perform the steps described below for
exporting/importing the settings.
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Step 1: Export the settings

To export settings, choose the command File | Options , and the "Options" dialog box will open. Here, click
on the Manage button located at the bottom left of each tab of this dialog box.

This will open another dialog box "Manage settings for Office". Here, select which settings you want to save
from the following options:

Tip: You can also just export all of them, but you will have to ensure when subsequently importing that you
only select the options you really want.

§ Configuration files 

This option saves all the settings you have made in the dialog box of the command File | Options. Some of
these settings are also located directly on the ribbon tabs (or in the toolbars).

§ Customized ribbon/toolbars

If you have changed the arrangement on the ribbon, in the Quick access toolbar or in toolbars (see section
Customizing the ribbon), you can save your individual arrangement with this option.

Please note for the import of the settings from an old to a new version of SoftMaker Office: If this option is enabled, command
icons that have been newly added in the more recent version will not be displayed there. Thus, if you would prefer the new icons to
be displayed instead of keeping your old arrangement, you should disable this option. Alternatively, you can import your old
arrangement anyway and look for the new symbols relevant to you afterwards using the command File | Customize (see section
Customizing icons and groups in the ribbon).

§ Keyboard shortcuts

This option allows you to apply shortcut keys that you have assigned yourself (see Customizing shortcut
keys).

§ User dictionaries

This option allows you to save the words that you have added to your user dictionaries (see section Editing
user dictionaries).

§ Other (SmartText, Labels, ...)

Enable this option if you want to apply all other settings that can be saved in SoftMaker Office (for example,
SmartText).

When you finally click on the Export button, a zip file will be created with the options selected above. Save
this file to any location that you can easily access for subsequent import.

Note: The settings of all SoftMaker Office applications are exported (TextMaker, PlanMaker, Presentations,
BasicMaker). The same applies to the import in the following step. In the iOS version, the export/import
must be performed separately for each application.

Step 2: Import the settings

To transfer the settings to another installation of the program, choose the command File | Options there. In the
dialog box "Options", click on the Manage button.
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In the following dialog box "Manage settings for Office", insert a check mark in front of the settings you want
to import. (Details of the options are described above in step 1.)

Now click on the Import button, and select the zip file that you created in step 1. The imported settings will
take effect in the current TextMaker application when you restart the program.

"Reset" button

The Reset button resets all program settings back to their delivery state.

Note: This action resets the settings for all SoftMaker Office applications (TextMaker, PlanMaker,
Presentations, BasicMaker) of this version. For iOS users, the reset applies to each application separately.
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Changing document properties

You can use the ribbon command File | group File management | Properties  to change settings that only
affect the current document and are saved with it. These settings are called document properties.

The available document properties are distributed by topic across multiple tabs. If you click on the Summary
tab, for example, you can edit the document info.

The following pages provide detailed explanations of all available document properties.

Document properties, Summary tab

On the Summary tab in the dialog box of the ribbon command File | Properties , you can enter some
additional info for the current document.

This can include explanatory information about the current document (subject, author, keywords, etc.) that the
file manager can use in searches.

For more information, see Document summary.

Document properties, View tab

On the View tab in the dialog box of the ribbon command File | Properties , you can make settings for the
appearance of the document on the screen.

Display field names

This option determines whether fields (date, page number, etc.) should display the result or field name within
curly braces. Normally, you want to see the result. You should thus leave this option disabled. For more
information, see also Fields.

This option is disabled by default.

Show bookmarks

You can use the ribbon command Insert | Bookmark  to add "bookmarks" to a document. For more
information, see Bookmarks.

These bookmarks are usually invisible. If you enable Show bookmarks, however, they are displayed in the text
(enclosed within angle brackets).
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This option is disabled by default.

Shade fields

If you enable this option, all fields (date, page number, etc.) inserted into the document with the ribbon

command Insert | group Text | Field  will be grayed out so that you can see more clearly where fields are
located in the document.

This option is disabled by default.

Show merge record

This option is only available if you have assigned a database to the current document with the ribbon command
Mailings | Select database | Use existing database.

If you enable this option, all database fields in the document display the field contents from the database rather
than the field name. To the right of this option, you can enter the record number of the record to be displayed. If
you enter "10", for example, the tenth record will be displayed.

This option is useful for checking the final appearance of a mail merge before printing it. For more information,
see also Mail merge.

This option is disabled by default.

Objects section

As described in Hiding objects, you can make inserted objects invisible on the screen and/or on the printed
page.

You can still make such objects visible again by means of these two options:

§ Show invisible objects: If you enable this option, any object whose Visible property is disabled becomes
visible on the screen. 

§ Print unprintable objects: If you enable this option, any object whose Printable property was disabled
will also be printed again.

Both options are disabled by default.

Hidden text section

Text can also be be hidden in addition to objects. For more information, see Hiding text.

The options Show hidden text and Print hidden text respectively determine the display and printing of text
that has been formatted as hidden.

By default, the option Show hidden text is enabled and the option Print hidden text is disabled. Thus, hidden
text can be seen on the screen, but it does not appear on a printout.

If you enable Print hidden text, hidden text will also appear on a printout.

Pictures and OLE objects section

With the default setting Show pictures, all the pictures and OLE objects in the text are displayed on the screen.
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If you select Use placeholders, however, only a gray box is displayed instead. Advantage: This speeds up the
responsiveness of the display when scrolling through a document with a lot of pictures.

Locking section

These options allow you to "lock" all objects on the master page and all guides to prevent unintentional
movement:

§ Lock objects on master page: If you enable this option, all objects inserted on the master page can only be
moved in the master page view. For more information, see also Master pages. 

§ Lock guides: If you enable this option, guides can no longer be moved with the mouse but can only be
edited via the dialog box of the ribbon command Layout | Grid and guides. For more information, see also
Using guides.

Both options are disabled by default.

Options section

The following settings are available here:

§ Use printer-independent formatting: 

Note: This option is only available in TextMaker for Windows.

Enabled (recommended default setting): The document is formatted in a much higher internal resolution
than the resolution of the printer that is used. Advantage: Switching to a different printer does not affect the
document. 

Not enabled: The resolution of the currently selected printer is used to format the document. This may lead
to changes in line breaks and even page breaks when you switch to a different printer.

§ Print page background: 

This option determines whether a page background created with the ribbon command Layout | group

Section | Background  should also be displayed in printouts. This option is disabled by default; the
background thus only appears on the screen.

Note: This option has no effect on a page background created with the ribbon command Layout | Chapter.
This type of background will always be printed.

For more information, see also Changing the page background.

§ Decimal separator: 

Here, you can specify the character to be used as a decimal separator.

This setting only affects the behavior of decimal tabs (see also Using tabs). If you change the separator from
a period to a comma, for example, numbers will be aligned at commas rather than periods when you use
decimal tabs.

Compatibility button

Here, you can make internal settings for compatibility with documents created in older versions of TextMaker,
Microsoft Word or other file formats. These options are set automatically when the document is opened and
should not normally be changed manually.
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The Layout is compatible to section displays the file format that you have accessed in TextMaker. At the same
time, you can choose from different file formats where the optimal compatibility settings are already specified.

Document properties, Colors tab

On the Colors tab in the dialog box of the ribbon command File | Properties , you can edit the color palette
of the current document.

When you open a color list – for example, the color list for the font color – you see only a small selection of the
up to 16 million colors available. This selection is called the color palette of the document.

You can modify this color palette at any time. You can add new colors and change colors that you have added.
However, the first 24 colors in the palette are default colors that cannot be changed.

Important: Changes to the color palette are saved in the document. This means that you can create a
separate color palette for each document.

Adding a color

To add a color to the palette of the current document, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.

Tip: Alternatively, this color palette can be accessed via any button that contains a color list (for example,
font color). To do so, select the entry Define color... in the color list (the last entry).

2. Set the desired color. For more information, see "Working with the color controls" section below.

3. Click on the New button.

4. Give the new color whatever name you like and confirm with OK.

5. Exit the dialog box with OK.

TextMaker now adds the new color to the document's color palette. From now on, the color will be available in
all dialog boxes where a color can be selected.

Changing a color

Note: You can only change colors that you have added. The first 24 colors in the color palette are default
colors that cannot be changed.

To change a color, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.

Alternatively: You can also select the entry Define color... in any color list (for example, font color) to open
this dialog box.

2. Select the color to be changed from the Color palette list.
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3. Make the desired changes. For more information, see "Working with the color controls" section below.

4. Click on Change.

The color has now been changed for the current document.

Renaming a color

You can change the name of self-defined colors at any time. To do so, open the color dialog, select a color from
the dropdown list Color palette and click on the Rename button.

Working with the color controls

The controls in the above dialog box let you set colors in many ways. All these ways lead to the same result –
just select your preferred method:

§ Using the color field and luminance slider 

The easiest way to set colors is to use the large color field and the luminance slider to its right. The color
field presents all available hues in all available saturations, while the luminance slider next to it provides a
means of varying the luminance.

To set a color, first click on the desired color in the large color field. Then click on the desired luminance in
the luminance slider.

§ Using the hue, saturation and luminance controls 

Alternatively, you can set colors with the controls labeled Hue, Sat (saturation) and Lum (luminance).
Values between 0 and 240 are allowed.

§ Using the Red, Green and Blue controls 

Colors can also be set via their red, green and blue components. The controls labeled Red, Green and Blue
are provided for this purpose. Values between 0 and 255 are allowed.

§ Typing the hex code for a color 

You can also specify a color by typing its hex code in the input field with the hash (pound) sign #.

Such hex codes are common in the HTML code of web pages, for example. The hex code consists of 3 two-
digit hexadecimal values for the colors red, green and blue (RRGGBB). For example, 00FF00 represents
pure green.

Document properties, Statistics tab

On the Statistics tab in the dialog box of the ribbon command File | Properties , you can retrieve statistical
information about the current document (number of characters, number of sentences, average word length, etc.).

Tip: If you select a section of text before you choose this function, it will show statistics for the selected text
only; otherwise, it will show them for the entire document.

The items of information are mostly self-explanatory. Only the difference between the first two options needs
to be explained:
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§ Characters counts the visible characters only. 

§ Keystrokes also counts all white spaces (space bar, tab key).

Thus, the sentence "This is a test" has 14 characters or 17 keystrokes (because it contains three spaces).

Tip: Add buttons for "Statistics" to the status bar/ribbon tab

If you need the above statistics functions regularly, you can add corresponding buttons to the status bar or to
any ribbon tab to ensure that this information is permanently displayed on the screen.

To do so, choose the ribbon command File | Customize  | Customize ribbon and select the entry Statistics
in the Categories section (top left) in the open dialog box.

In the Customize section (top right), then select the entry "Status bar" or the ribbon tab on which you would
like to place the button. Now, add the desired button from the list Commands on the left: Count keystrokes,
Count characters, Count words, etc.

For more information on customizing the ribbon buttons, see Customizing the ribbon.

Document properties, Protection tab

On the Protection tab in the dialog box of the ribbon command File | Properties , you can provide
document protection to the current document.

You can ensure that opening or saving a protected document is only possible after entering the correct
password. Documents with read protection are also encrypted, so that they cannot be viewed with programs
other than TextMaker.

For more information, see Document protection.

Document properties, Form tab

On the Form tab in the dialog box of the ribbon command File | Properties , you can enable or disable the
form mode and secure it with a password if desired.

If form mode is enabled, you can only fill in form objects (text fields, checkboxes, dropdown lists, etc.). The
rest of the document cannot be changed.

Note: When you save a document in form mode, it will be opened again in form mode.

You can enable or disable form mode via the option Form mode active.

Tip: You can also use the ribbon command View | Form mode  for this purpose.
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If you enable form mode and also enter a Password to deactivate, anyone who subsequently attempts to
disable this mode will be prompted for the password. Form mode can only be exited if the user enters the
correct password.

Important: If you save a document with a password in form mode and then forget the password, you will no
longer be able to disable this mode. Thus, note the password and keep it in a safe place!

For more information on working with forms, see Forms.

Shade form objects

This tab also has an option called Shade form objects. If it is enabled, all form objects (text fields, checkboxes,
dropdown lists, etc.) are highlighted in the text with a light gray shading. This makes them stand out better from
the rest of the form.

Tip: You can also use the ribbon command View | Shade form objects  for this purpose.

Document properties, Review tab

On the Review tab in the dialog box of the ribbon command File | Properties , you can make settings for the
functions for commenting and reviewing documents.

For more information on these settings, see the following sections:

§ Settings for comments 

§ Settings for the Track changes function

For general information on commenting and reviewing documents, see Reviewing documents.

Document properties, Fonts tab

On the Fonts tab in the dialog box of the ribbon command File | Properties , you can embed the fonts that
you used in a document into the document file.

Embedding fonts into a document file is useful when you are sharing a Textmaker file with others. To ensure
that the fonts used in your document look exactly the same on your computer as on other devices, we
recommend that you embed all fonts in the file.

If a file with embedded fonts is then opened on another computer, TextMaker will install all embedded fonts
temporarily. After you exit TextMaker, they are automatically removed.

To embed fonts into a TextMaker file, proceed as follows:

1. Create or open the desired TextMaker file.
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2. Choose the command File | Properties  and switch to the Fonts tab.

3. The dialog box presents a list of all fonts that were used in the document. A checkbox is displayed in front
of each font. Click to place a check mark in front of all fonts that you want to embed in the document.

Tip: You can use the Select all and Deselect all buttons to select or deselect all embeddable fonts at once.

4. Confirm with OK.

5. Save the file.

The selected fonts are now embedded into the document file.

Notes

§ Embedding fonts works with Microsoft Word documents in addition to TextMaker documents. 

§ Some fonts generally do not allow users to embed them into documents. For such fonts, the checkbox for
embedding is unavailable.

§ Many commercial fonts allow embedding, but not editing documents in these fonts. When you embed such
fonts, a message will appear when the document is opened on a different computer. The user can then decide
whether he wants to edit or print the document. If he chooses "Edit", the embedded fonts will not be
available.

§ When sharing documents (for example, by e-mail), keep in mind that embedding fonts can significantly
increase file size, especially when using fonts with large character sets (for example, Asian fonts).

§ System fonts like Arial, Courier New, Times New Roman or Symbol cannot be embedded. These fonts are
available on every Windows system anyway.
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Customizing the document display
In this section, you will learn how to customize the appearance of the document on the screen. Most of the
required commands can be found on the ribbon tab View.

The ribbon tab "View", left section

The ribbon tab "View", right section

The ribbon tab View contains the following commands for displaying the screen:

Command Function

Object mode This command enables/disables object mode. Text editing is no longer possible in object mode,
but objects (pictures, frames, etc.) can be edited more conveniently. For more information, see
Object mode.

Standard This command switches the document view to standard view. This is the view that you
normally use when working with TextMaker.

Continuous This command switches to the continuous view, which displays the document in a simplified
way (in order to improve the legibility of the plain text in the document). 

In this view, the document is no longer presented in the form of single pages, but as long,
continuous text.

Furthermore, the lines of the text are automatically rewrapped to the full width of the document
window. (This behavior can be disabled if desired by disabling the option Wrap text to

window on the View tab in the Options  dialog box.)

Note: In continuous view, some parts of documents are no longer displayed. This includes all
types of frames and drawings, as well as page headers/footers and footnote texts.

Master pages This command switches to the master pages view. In this view, you can edit only the
document's master page(s).
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Objects that are on the master page are printed on every page of the document. For more
information, see Master pages.

Outline This command switches to the outline view. The outline of the document can be edited here.
You can "designate" text as a heading and upgrade or downgrade existing headings. For more
information, see Outlines.

Book layout This command is used to switch to the book layout view. You get a two-page view with the odd
pages displayed on the right instead of the left, as they would be in an open book. The first
page starts accordingly on the right side.

Also note the "Mirror margins" option in Page setup if you want to optimize the page margins
setting for book printing.

Form mode This command enables/disables form mode. In form mode, you can only fill in form objects
(text fields, checkboxes, dropdown lists, etc.). The rest of the document cannot be changed. For
more information, see Forms.

Grid and guides Grid and guides are positioning aids for moving objects such as frames and drawings with your
mouse. For more information, see Using the grid and Using guides.

Horizontal ruler This command enables/disables the horizontal ruler. For more information, see Ruler and
Settings, View tab.

Vertical ruler This command enables/disables the vertical ruler. For more information, see Settings, View
tab.

Group Zoom You can use the group commands Zoom to specify the zoom level at which the document is
displayed. For more information, see Zoom level.

Group Side by side The commands of the group Side by Side allow you to display two documents side by side on
the screen and scroll synchronously through both documents. For more information, see
Viewing documents side by side.

Sidebars This command enables/disables the sidebars. You can use the sidebar to navigate, search, etc.,
in the document. For more information, see Sidebar.

Full screen This command allows you to switch to full screen view, where the program uses the entire
screen to display the document. For more information, see Full screen view.

Windows You can use this command to close all currently open documents or select one from the list of
all open documents to enable. For more information, see Working with multiple documents.

Further settings for displaying the screen can be made via the following commands:

§ The ribbon command File | Options  allows you to make general settings that apply to all documents. For
more information, see Settings, View tab. 

§ The ribbon command File | Properties  allows you to make settings that apply only to the current
document. For more information, see Document properties, View tab.
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Zoom level

TextMaker offers you many options for determining the zoom level at which a document should be displayed
on the screen.

The command group "Zoom" on the ribbon tab View

Use the following commands of the ribbon tab View | group Zoom for this purpose:

Command Function

Set zoom This option allows you to select the zoom level from a list. You can also enter a value manually
(for example, "125" for a zoom level of 125%).

Zoom This command enables the magnifying glass. Then use the mouse to drag a frame around any
section of the document to enlarge it.

Actual size This command sets the zoom level to 100%. This is the default setting.

Fit margins This command automatically sets the zoom level so that the page width fits exactly in the
document window (including comments and text frames).

Text width This command automatically sets the zoom level at which the width of the text area fits exactly
into the document window (without comments and text frames).

Note: The command "Text width" is not available as a default button on the ribbon. However,
you can choose the command via the Set zoom button (see above) or add it to the ribbon as a
separate button. For more information, see Customizing icons and groups in the ribbon).

Full page This command displays one full page of the document.

Two pages This command displays two full pages next to each other.

Using the zoom slider

You can also use the zoom slider in the bottom right corner of the screen to change the zoom level:

To change the zoom level, either drag the slider with your mouse or click on the plus or minus icon.

If you click on the percentage to the right of the zoom slider, you open the dialog box of the aforementioned
command View | group Zoom | Set zoom.
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Tip: Also note the key combination Ctrl+middle mouse wheel for continuous zooming.

Full screen view

With the ribbon command View | group Windows | Full screen , you can switch to the full screen view in
which the program uses the entire screen to display the document. TextMaker enlarges its program window to
the full screen size. (In the classic menu interface, all other toolbars are then hidden.)

To exit this view mode, press the Esc key or choose the ribbon command View | Full screen again.

Using the toolbar of the full screen view

When you enable full screen mode, an additional mini toolbar appears on the screen.

The mini toolbar "Full screen mode"

The icons in this toolbar have the following functions (from left to right):

§ Show/hide ribbon 

§ Show/hide sidebar

§ Enable/disable "Drag sheet" mode

If you enable "Drag sheet" mode, you can scroll your document using the mouse. Simply click into the
document and drag the mouse cursor in the desired direction (with the mouse button still held down).

Note: Clicking on text to set the text cursor or selecting text or objects is no longer possible in this mode.

To exit "Drag sheet" mode, click on this icon again.

§ Clicking on the Close button exits full screen mode. 

Dark document mode

You can use the ribbon command Dark document  in the Quick access toolbar to switch the document
pages from their usual white to a dark display.

Note: If this button is not available, click on the  icon on the far right of the Quick access toolbar. Select Add/remove buttons and
enable Dark document.

If you click on this command once, the document pages will be displayed in dark mode. If you click on this
command again, the document pages will be displayed in white again.

Switching this display has no effect on the printout of the document. For more information on how to print
colored pages, see Changing the page background.



617Customizing TextMaker

Viewing documents side by side

Android/iOS: This function is not available in the Android or iOS version.

The command View side by side  allows you to display the contents of two documents side by side on the
screen, while scrolling synchronously through both documents. This is useful if, for example, you want to
compare a revised document with the original document.

Proceed as follows:

1. First, open the two TextMaker documents that you want to compare.

Tip: It does not matter whether you open the two documents in different program windows or as document
tabs in the same program window.

2. Choose the ribbon command View | group Side by side | View side by side .

Note: If more than two documents are currently open, TextMaker first asks which of them is to be used in
the other window.

The screen now displays the two documents side by side.

Scrolling synchronously through both documents

To make it easier to compare the two documents, the Synchronize scroll  feature is automatically enabled
after you choose the command View side by side. As a result, you can scroll through the two documents in
parallel. Thus, if you scroll up or down in one of the documents, the other document follows synchronously.

If you want to cancel parallel scrolling, disable the Synchronized Scrolling feature by clicking on the button.
The two documents will still be displayed side by side, but scrolling in the documents will now be independent
of each other.

Moving and restoring window positions

If necessary, you can adjust the width and height of the two windows separately by dragging the edges of the
respective document with the mouse.

Use the command Restore positions  to rearrange the windows evenly next to each other on the screen.

Undoing "View side by side" again

If you want to undo the enabled View side by side feature, click on the button again. The side-by-side
arrangement of the two windows will then be released, and they will be displayed on the screen in their original
position and size.
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Customizing the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section you will learn how to configure the ribbon and add additional icons.

The "Ribbon" (section) and the Quick access toolbar (below)

Topics covered:

§ Showing and hiding the ribbon 

§ Customizing icons and groups in the ribbon

§ Changing the position of the Quick access toolbar

§ Customizing icons on the Quick access toolbar

For more information, see the following pages.
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Showing and hiding the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The ribbon is usually fully visible:

The "Ribbon" and the Quick access toolbar (below)

However, you can hide the ribbon at any time by minimizing it. This is useful if you want to have as much
screen space as possible to display the document.

Proceed as follows:

1. Choose the ribbon command File | group Settings | Customize .

Also possible: Right-click anywhere on the ribbon.

2. A menu opens. There, you will find the option Minimized ribbon, which can be enabled or disabled by
clicking on it (a check mark appears in front of the option if it is currently enabled).

After you enable this option, the ribbon will be minimized. Only the ribbon tabs and the quick access toolbar
can then be seen.

Tip: Alternatively, you can use the icon  in the upper right corner of the program window next to the ?
icon to minimize the ribbon. If you click on the icon again, the ribbon is restored to its full size.

In addition, you can use the key combination Ctrl+F1 (Mac: Cmd+F1) to enable/disable minimization of the
ribbon.

Working with a minimized ribbon

You work with a minimized ribbon as follows:

§ When you click on one of the ribbon tabs of the minimized ribbon, the ribbon becomes completely visible
again temporarily and displays the corresponding ribbon tab. As soon as you trigger a command (for
example, click on the icon for a command), however, the ribbon will be automatically minimized again. 

§ If you double-click on one of the ribbon tabs, the ribbon will be permanently visible again, thus removing
the minimization.
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§ As mentioned above as a tip, you can also use the icon  in the upper right corner of the program window
to enable/disable the minimization of the ribbon.

Customizing icons and groups in the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The command Customize ribbon  allows you to customize the ribbon to a certain extent. The main purpose
of this command is to add additional icons, command groups or even complete ribbon tabs to the ribbon.

Important: The icons in the predefined command groups on the ribbon cannot be changed. This means that
you cannot add, remove, or change the order of icons in the existing command groups. Additional icons can
only be inserted in new command groups at the end of a ribbon tab (or optionally in a completely new ribbon
tab).

To customize the ribbon, proceed as follows:

1. Choose the command Customize ribbon under File | group Settings | Customize  to open the dialog box.
Alternatively: Right-click anywhere on the ribbon with the mouse button.

Tip: The dialog box can be opened even faster by double-clicking on any empty area of the ribbon.

2. Use one of the procedures described below to edit the ribbon tabs.

Basic structure of the dialog box

The dialog box of the command Customize ribbon contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected ribbon tab 

The right list displays the icons contained in the currently selected ribbon tab.

You define the ribbon tab to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:
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Adding an icon

Note: You can only add icons to command groups that you have added yourself (or to completely new
ribbon tabs). You cannot insert an icon into the predefined groups.

To add an icon to a specific ribbon tab, perform the following steps in the dialog box of the command File |
group Settings | Customize | Customize ribbon:

1. In the dropdown list Customize (top right), select the ribbon tab to which you want to add an icon.

The right list now displays all icons that are currently on the selected ribbon tab.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the ribbon tab. If you have not yet created a new group here, the program
automatically creates a new command group for the icon at the end of the ribbon tab.

Removing an icon

Note: You can only remove icons that you added to the ribbon yourself. You cannot delete any of the
predefined icons.

To remove one of the icons you added from a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be removed.

3. Click on the button .

Even faster: Simply double-click on the icon in the right list.

The icon is now removed from the ribbon tab.

Moving an icon

Note: You can only move icons that you added to the ribbon yourself. You cannot change the position of any
of the predefined icons.

To move an icon in a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the ribbon tab.

Note: If you want to move an icon to a different ribbon tab, you must first remove it from its current ribbon
tab and then add it to the other ribbon tab.
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Adding a new command group

Note: New command groups can only be added after the default command groups. You cannot insert a user-
defined group between the predefined command groups.

To add a new command group (a new section) to a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Click on the New group button (displayed below the right list).

The new command group is now created (at the end of the ribbon tab).

Renaming a command group

Note: Only user-defined command groups can be renamed. You cannot rename any of the predefined
command groups.

To rename a user-defined command group in a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the Rename button (displayed below the right list).

4. Type in the new name and confirm it.

The command group will now be renamed accordingly.

Removing a command group

Note: Only user-defined command groups can be removed. You cannot delete any of the predefined
command groups.

To remove a user-defined command group from a ribbon tab, follow these steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the button . (Any icons must have been removed from the group.)

Even faster: Simply double-click on the command group in the right list.

The command group is now removed from the ribbon tab.

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.
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Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

"Edit" button

The Edit button is only enabled if you have selected a user-defined icon in the list on the left side of the dialog
box. For more information see Creating user-defined icons.

Buttons for managing the ribbon tabs (right side)

Above and below the list on the right side of the dialog box, there are buttons for managing the ribbon tabs.
Some of these buttons have already been mentioned in this section. To ensure that users understand them better,
all buttons and their functions are clearly listed again below.

Above the list on the right:

§ New 

This button creates a new, empty ribbon tab. You can then customize this ribbon tab by adding icons and
command groups.

§ Rename

Use this button to rename the ribbon tab selected in the dropdown list Customize (only available for user-
defined ribbon tabs).

§ Reset

This button resets the ribbon tab selected in the dropdown list Customize back to its delivery state.

§ Delete

This button deletes the ribbon tab selected in the dropdown list Customize (only available for user-defined
ribbon tabs).

Below the list on the right:

§ New group 

This button adds a new command group to the ribbon tab selected in the dropdown list Customize.

§ Rename

Use this button to rename a command group (only available for user-defined command groups). First, select
the desired command group in the list on the right of the dialog box.

§ Reset all

This button resets all ribbon tabs back to their delivery state.

The Close button closes the dialog box and all changes are applied.
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Changing the position of the Quick access toolbar

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.

The "Ribbon" and the Quick access toolbar (below)

The Quick access toolbar can either share the space with the document tabs – or it is located in its own toolbar.
To change this, proceed as follows:

1. Choose the ribbon command File | group Settings | Customize . 

Alternatively, right-click anywhere on the ribbon.

2. The program opens a menu that contains one of the following two commands:

Show Quick access toolbar as separate toolbar: By default, the Quick access toolbar is displayed in the
toolbar that also contains the document tabs. When you choose this command, the Quick access toolbar
moves to its own toolbar instead.

Show Quick access toolbar beside the document tabs: This command does exactly the opposite: If the
Quick access toolbar is currently displayed as a separate toolbar, choosing this command will cause the
Quick access toolbar to be moved back to the toolbar that also contains the document tabs.

Tip: You can also click on the double arrow button  directly in the Quick access toolbar itself. There, you
can use the entry Position to find the corresponding options for displaying the Quick access toolbar: Beside the
document tabs or Below the ribbon.

Customizing icons on the Quick access toolbar

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.
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The "Ribbon" and the Quick access toolbar (below)

If desired, you can customize the icons on the Quick access toolbar at any time, for example, you can add,
remove and reposition icons.

To do so, choose File | group Settings | Customize  | Customize Quick access toolbar (or click on the icon
 in the Quick access toolbar and select Customize there). In the following dialog box, you can edit the Quick

access toolbar according to the descriptions in Customizing toolbar icons – except for the passage "Managing
toolbars".

Tip: Alternatively, you can simply drag a command from the dialog box into the Quick access toolbar with
the mouse. Even quicker (without opening the dialog box): Hold down the Alt key and drag a command icon
directly from the ribbon to the Quick access toolbar. To remove it, drag the icon back into the ribbon while
holding down the Alt key.



626Customizing TextMaker

Customizing toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the
menu command View > Toolbars and how to customize them with Tools > Customize.

A toolbar (here: the Standard toolbar)

The following topics are covered:

§ Showing and hiding toolbars 

§ Positioning toolbars on the screen

§ Managing toolbars (creating, deleting, renaming, resetting toolbars)

§ Customizing toolbar icons (adding, removing, moving icons)

§ Using the toolbar menu (for extra quick access to the above functions)

For more information, see the following pages.

Showing and hiding toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can enable or disable the available toolbars at any time to make them visible or to hide them.

To do so, proceed as follows:

1. Choose the menu command View > Toolbars.

Alternatively, click on the double arrow  at the end of a toolbar and select Toolbars.

2. Click on the checkbox in front of the desired toolbar to enable or disable it. When the toolbar is enabled, a
check mark appears in the box.
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3. Exit the dialog box with Close.

The corresponding toolbar has now been enabled or disabled.

Tip: There is a faster way to do this: If you right-click on any toolbar, a list of all available toolbars is
displayed. If you click on one of these menu items, the corresponding bar will be enabled or disabled.

Visible in mode...

Some toolbars are visible only in particular situations. The Picture toolbar, for example, appears only when you
select a picture.

This is due to the option Visible in mode, which determines when a toolbar should be visible. Some examples:

Option Explanation

All modes The selected toolbar is always visible (unless it has been disabled). Example: the Standard toolbar

Edit mode The bar is only visible in normal editing mode but not in object mode. For more information, see
also Object mode. Example: the Formatting toolbar

Outline The bar is only visible in the outline view. For more information, see also Using the outline view.
Example: the Outline toolbar

Object The bar is only visible in object mode but not in normal editing mode. For more information, see
also Object mode. Example: the Object toolbar

Chart The bar only appears if a chart is selected in the document.
Example: the Chart toolbar

Picture The bar only appears if a picture is selected in the document.
Example: the Picture toolbar

Header/footer The bar only appears if the text cursor is in a header or footer.

Table The bar only appears if the text cursor is in a table.
Example: the Table toolbar

Track changes The bar only appears if you have enabled Track changes.
Example: the Review toolbar

AutoShape The bar only appears if a drawing or text frame is selected in the document.

To change this setting for one of the toolbars, choose the menu command View > Toolbars, select the toolbar
in the list Toolbars and select the desired option for Visible in mode.

Note: Changing this setting in the default toolbars (Standard toolbar, Formatting toolbar, etc.) is usually not
recommended. This option is primarily intended for user-defined toolbars.
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Positioning toolbars on the screen

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can position each toolbar as desired on the screen. To do so, use one of the following procedures:

Changing the position with the command View > Toolbars

You can change the position of a toolbar at any time with the menu command View > Toolbars. To do so,
proceed as follows:

1. Choose the menu command View > Toolbars.

2. Select the desired toolbar by clicking on it in the list.

3. Select the desired position for the toolbar in the list Position.

Note: If you select the option Floating, the toolbar icons are displayed in a window that can be freely moved or
resized just like an application window.

Changing the position with the toolbar menu

Each toolbar has a button with a double arrow  at its right edge. Select the entry Position for the desired
toolbar. The following submenu provides a dropdown list of possible positions for the toolbar.

Note: If you have selected the option Floating, you can also use this button  to integrate the toolbar back into
a desired fixed position via the entry Position entry.

For more information on the toolbar menu options, see Using the toolbar menu.

Changing the position with the mouse

Some toolbars can also be repositioned with the mouse. To do so, proceed as follows:

1. Position the mouse cursor over an empty area of the toolbar.

2. Press the left mouse button and hold it down.

3. While still holding the mouse button down, drag the toolbar to the desired position.

4. Release the mouse button to place the toolbar in the new position.

Note: By default, most toolbars are locked to prevent unintentional movement with the mouse. However, you
can release this lock at any time: To do so, choose the menu command View > Toolbars, select the toolbar
and disable the option Locked. From now on, this bar can also be moved with the mouse.
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By the way, a positioning aid is enabled while dragging a toolbar: If you drag the toolbar near one of the edges
of the program window, it automatically jumps to the corresponding edge. If, for example, you release the bar at
the top edge, this corresponds to selecting the Top position in the dialog box of the menu command View >
Toolbars.

Managing toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can create new toolbars at any time and delete or rename existing toolbars, etc. To do so, use the buttons in
the dialog box of the menu command View > Toolbars.

Creating new toolbars

The program lets you create your own toolbars at any time.

If, for example, you frequently need to use commands of the Window menu that are not present in the Standard
toolbar, it might be worth your while to create your own toolbar for them.

You create a new toolbar as follows:

1. Click on the New button (in the dialog box of the menu command View > Toolbars).

2. The program displays a dialog box in which you enter a name for the new toolbar – for example, "My
toolbar". Then confirm with OK.

3. The new toolbar has been created. Close the dialog box or click on the Customize button to add icons to the
toolbar. For more information, see Customizing toolbar icons.

Customizing toolbar icons

You can edit the icons on toolbars with the Customize button. For more information, see the next section.

Deleting toolbars

The Delete button allows you to delete a user-defined toolbar as follows:

1. Select the toolbar to be deleted from the list.

2. Click on the Delete button.

Note: You can only delete user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be removed.

However, you can disable a default toolbar at any time if you don't need it by removing the check mark in front
of it. For more information, see Showing and hiding toolbars.
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Renaming toolbars

The Rename button can be used to rename a user-defined toolbar as follows:

1. Select the desired toolbar from the list.

2. Click on the Rename button.

3. Type in the new name and confirm it with OK.

Note: You can only rename user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be renamed.

Resetting toolbars

You can undo any changes you have made to one of the default toolbars by clicking on the Reset button:

1. Select the desired toolbar from the list.

2. Click on the Reset button.

The toolbar now contains the default icons again. In addition, the default settings for the options Visible in
mode and Position are restored.

Note: This command only applies to the default toolbars (Standard toolbar, Formatting toolbar, etc.) but not to
user-defined toolbars.

Resetting all toolbars

To reset all toolbars at once, click on the Reset all button.

Note: This command only resets the default toolbars. User-defined toolbars remain unchanged.

Customizing toolbar icons

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

The menu command Tools > Customize allows you to customize the icons as desired on a toolbar. You can add
icons and remove or reposition existing icons, among other things.

Proceed as follows:

1. Choose the menu command Tools > Customize to open the dialog box. Alternatively: Click on the button

 at the end of a toolbar and select the entry Customize here.

Even faster: Double-click on an empty area in any toolbar.

2. Use one of the procedures described below to add, remove or reposition icons.
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Basic structure of the dialog box

The dialog box of the menu command Tools > Customize contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected toolbar 

The right list displays the icons contained in the currently selected toolbar.

You define the toolbar to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:

Adding an icon

To add an icon to a specific toolbar, perform the following steps in the dialog box of the command Tools >
Customize:

1. In the dropdown list Customize (top right), select the toolbar to which you want to add an icon.

The right list now displays all icons that are currently in the selected toolbar.

Optional: In the right list, select the icon behind which the new icon is to be inserted.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the toolbar.

Tip: Alternatively, you can add an icon to any toolbar as follows: Choose the command Tools > Customize.
Then simply drag the icon out of the dialog box with the mouse and drop it at the desired position in the
toolbar. (Do this in the toolbar itself and not in the dialog box!) Of course, this procedure only works when
the toolbar is currently visible on the screen.

Removing an icon

To remove an icon from a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize (top right).

2. In the right list below it, select the icon to be removed.

3. Click on the button .

Even faster: Simply double-click on the icon in the right list.

The icon is now removed from the toolbar.
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Tip: Alternatively, you can remove an icon from a toolbar as follows: Choose the command Tools >
Customize. Then simply drag the icon out of the toolbar with your mouse and drop it somewhere outside the
toolbar, for example, in the document. (Do this in the toolbar itself and not in the dialog box!)

Moving an icon

To move a toolbar icon to a different position, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the toolbar.

Note: If you want to move an icon to a different toolbar, you must first remove it from its current toolbar and
then add it to the other toolbar.

Tip 1: Alternatively, you can also move an icon as follows: Choose the command Tools > Customize. Then
drag the icon directly in the toolbar to the desired position (in the toolbar itself and not in the dialog box!).
This method also allows you to move an icon directly from one toolbar to another.

Tip 2: Moving icons works even if this dialog box is not open: When you hold down the Alt key, you can
move a toolbar icon by clicking on it and then dragging it to the desired position (while still holding down
the mouse button).

Inserting a separator

To insert a separator in front of an icon in a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list, select the icon in front of which the separator is to be inserted.

3. Click on the New separator button (displayed below the right list).

The separator is now inserted.

Tip: Alternatively, you can proceed as follows: Choose the command Tools > Customize. To insert a
separator to the left of an icon in any toolbar, simply drag the icon slightly to the right (in the toolbar itself
and not in the dialog box!).

Removing a separator

To remove a separator from a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar in the dropdown list Customize.

2. In the right list below it, select the separator to be removed.

3. Click on the button .
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Even faster: Simply double-click on the separator.

The separator is now removed from the toolbar.

Tip: Alternatively, you can also use the following procedure: Choose the command Tools > Customize. If
you now drag the icon that is to the immediate right of the separator a little bit to the left, the separator will
be removed. (Do this in the toolbar itself and not in the dialog box!)

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.

Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

"Edit" button

The Edit button is only enabled if you have selected a user-defined icon in the list on the left side of the dialog
box. For more information see Creating user-defined icons.

Buttons for managing the toolbars

The dialog box of the command Tools > Customize also has buttons for managing toolbars:

§ New 

This button creates a new, empty toolbar.

§ Rename 

Use this button to rename the toolbar selected in the dropdown list Customize (only available for user-
defined toolbars).

§ Reset 

This button resets the toolbar selected in the dropdown list Customize back to its delivery state.

§ Delete 

This button deletes the toolbar selected in the dropdown list Customize (only available for user-defined
toolbars).

§ Reset all (displayed below the right list) 

This button resets all default toolbars back to their delivery state.

Further options for managing and configuring toolbars are available in the dialog box of the menu command
View > Toolbars. For more information, see Managing toolbars.
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Using the toolbar menu

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Some toolbars end on the right with a double arrow , as shown in the following figure:

If you click on this double arrow, the toolbar menu will open for this toolbar.

This menu gives you quick access to all toolbar-related commands described in the previous sections. The
toolbar menu contains the following commands:

§ Add/remove buttons 

This command displays a list of all icons available for a toolbar. If you click on one of the entries, the
corresponding icon in the bar will immediately be enabled or disabled.

(Note: This command is only meant for quickly enabling or disabling icons. For information on customizing
the icons in a toolbar, see Customizing toolbar icons.)

§ Position 

You can use this command to change the position of a toolbar. The available options include top, bottom,
left, right or floating (in a little window that can be moved and resized with the mouse).

§ Toolbars 

This option chooses the menu command View > Toolbars that allows you to enable or disable, configure
and manage toolbars.

For more information, see Customizing toolbars.

§ Customize 

This option chooses the menu command Tools > Customize that allows you to edit the icons on a toolbar
(add, remove, reposition icons).

For more information, see Customizing toolbar icons.

§ Reset this toolbar 

This option resets the toolbar. The bar then displays its default icons again. In addition, all settings made for
the bar are discarded.
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Creating user-defined icons
You can create user-defined icons at any time and then add them to the ribbon or a toolbar. Such icons can be
used to start other desired programs.

To create a user-defined icon – for example, an icon to start the Windows Editor – proceed as follows:

1. Choose the following command in the ribbon or menu:

Ribbon: File | group Settings | Customize  | Customize ribbon

Menu: Tools > Customize

2. In the dropdown list Categories, select the User category.

3. Select one of the icons from the list Commands.

The first three icons are pre-assigned (as examples) to the Windows Calculator, the Windows Character
Map and the Windows Control Panel. Select the fourth icon, for example.

4. Click on the Edit button displayed below the list. Another dialog box appears.

5. Enter a short description of the program to be started in the Description field – for example, "Notepad".

6. Enter the complete path and file name for the program to be started in the Command line field, for example,
C:\Windows\notepad.exe.

7. Optional: If you want the program to display an icon other than its default icon, enter the path and file name
of the desired icon file in the Icon file field.

Note that icons in toolbars are slightly smaller than the usual Windows icons.

As soon as you confirm with OK, the user-defined icon is created.

If you now want to add the user-defined icon to the ribbon or toolbar, proceed as described in the following
sections:

§ Ribbon: Customizing icons and groups in the ribbon 

§ Toolbars: Customizing toolbar icons 

Customizing shortcut keys
Commands that are frequently used in a program can also be chosen via shortcut keys. For example, the
command for saving the current document can be chosen very quickly by pressing the key combination Ctrl+S.

The predefined shortcut keys can be customized at any time in the dialog box of the ribbon command File |
Customize | Customize ribbon. You can assign a shortcut key to any command and change or remove existing
shortcut keys.
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To do so, proceed as follows:

Adding shortcut keys

To assign a shortcut key to a command, perform the following steps:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.

3. In the left or right list, select the command to which you want to assign a shortcut key.

The left list shows all commands available in the program. (You can use the option Categories to filter this
list by a specific category and perform a search using the Quick search field.)

The right list displays only the icons that are in the currently selected ribbon tab or toolbar.

4. Once you have selected the desired command, click into the Press new shortcut key field and press the
intended key combination (starting with Ctrl or Alt).

Tip: If you make a typing mistake, you can always press the BackspaceÕ key to delete the shortcut key you
entered.

5. Do not forget: Click on Add to assign this shortcut to the command now.

6. Exit the dialog box with Close.

From now on, you can execute the selected command with the specified shortcut key.

Editing shortcut keys (removing, changing, etc.)

You can also edit existing shortcut keys for commands (for example, delete or change them) at any time.
Proceed as follows:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.

3. In the left or right list, select the command whose shortcut keys you want to edit.

4. In the Shortcut keys section, perform one of the following actions:

Remove shortcut keys: The list Current shortcut keys displays all shortcut keys currently assigned to the
selected command. To remove a shortcut key, select it from the list and click on Remove.
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Change shortcut keys: To change the shortcut key for a command, first remove it (as described above) and
then assign it a new shortcut key (as described at the beginning of this section).

Reset shortcut keys: To reset all shortcut keys for the entire program to their default values, click on the
Reset all shortcut keys button and confirm the confirmation prompt. Any changes you have made to
shortcut keys will then be discarded.

Display a list of all shortcut keys: When you click on the Export button, a table listing all currently assigned
shortcut keys is displayed. The buttons next to the table allow you to copy it to the clipboard, for example.

5. Exit the dialog box with Close.

Available shortcut keys

Note that some of the key combinations that are possible on your keyboard are not allowed for shortcut keys.

As a rule, you should use alphabetic keys, numeric keys or function keys for shortcut keys. You can combine
them with Ctrl, Alt and/or the Shift keyñ.

You can easily check whether the desired key combination is allowed. Click in the Press new shortcut key
field in the dialog box described above, and then enter the key combination. If it does not appear in the field, it
is not allowed.

Some examples of valid shortcut keys include:

§ Ctrl+A 

§ Alt+A (However, key combinations with the Alt key are not recommended – Alt+A, for example, is
responsible for opening the View menu!)

§ Ctrl+Alt+A

§ Ctrl+Shift+A

§ Ctrl+Alt+Shift+A

§ Ctrl+F2

§ etc.

Note: Letters on their own are not allowed, of course. Thus, you can't use A or Shift+A as shortcut keys.

Shortcut key already assigned: If you press a shortcut key that is already assigned, the current assignment will be
shown just below the input field. You should then press the Backspace keyÕ to delete your shortcut key and
try a different shortcut key. Otherwise, you will overwrite the existing assignment of this shortcut key.

Two-part shortcut keys: You can also use two-part shortcut keys (according to the WordStar standard) – for
example, Ctrl+K+X. However, only shortcut keys according to the scheme "Ctrl + letter + letter" are allowed
here.



638Customizing TextMaker

Using the grid
The grid is a positioning aid for frames and drawings. When the "Snap to grid" function is enabled, such
objects can no longer be moved freely with the mouse because they snap from one grid point to the next
instead. Something similar happens when you resize an object with your mouse.

Enabling the "Snap to grid" function

To enable or disable the "Snap to grid" function, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.

2. In the dialog box, switch to the Grid tab.

3. Enable or disable the option Snap to grid.

Alternatively: Choose the ribbon command View | Grid and guides  by clicking on the arrow of the icon and
selecting the entry Snap to grid directly in the dropdown menu. A check mark in front of it indicates that the
option is enabled.

If the option is enabled and you move a picture frame by dragging it with the mouse, for example, it can no
longer move freely. It snaps from grid point to grid point instead.

If you disable this option again, however, the frames and drawings can be moved completely freely with the
mouse.

Temporarily disabling this function: If the option Snap to grid is enabled, you can temporarily disable it at any
time by holding down the Alt key while moving an object with the mouse.

Changing the grid distance

You can set the distance between two grid points to any value.

To do so, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.

2. In the dialog box, switch to the Grid tab.

3. Enter the desired values in the Grid distance section.

Showing the grid on the screen

By default, the grid is not shown on the screen. If you want it to appear on the screen, enable the option Show
grid in the above dialog box.

Alternatively: Click on the arrow of the icon  and select Show grid in the dropdown menu.
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Note: The grid appears only on the screen and not in the printout.

Using guides
In addition to the grid discussed in the previous section, there is another positioning aid for frames and
drawings: guides.

You can add horizontal and vertical guides (see below for more information) and enable the "Snap to guides"
function. As soon as you move frames and drawings near a guide with the mouse, the object automatically
snaps on it – as if the guide were magnetic. Something similar happens when you resize an object with your
mouse.

Enabling the function "Snap to guides"

To enable or disable the "Snap to guides" function, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.

2. In the dialog box, switch to the Guides tab.

3. Enable or disable the option Snap to guides.

Alternatively: Choose the ribbon command View | Grid and guides  by clicking on the arrow of the icon and
selecting the entry Snap to guides directly in the dropdown menu. A check mark in front of it indicates that the
option is enabled.

Note: Even if this option is disabled, the guides can still be displayed and changed, but they will not have any
effect on the repositioning of objects.

Temporarily disabling this function: If the option Snap to guides is enabled, you can temporarily disable it at any
time by holding down the Alt key while moving an object with the mouse.

Showing guides

The option Show guides in the above dialog box allows you to specify whether guides should be displayed on
the screen.

Alternative 1: Click on the arrow of the icon and select Show guides in the dropdown menu.

Alternative 2: File | Options, on the View tab, in the Document window section.

By default, this option is enabled.

Tip: If the option Show guides is disabled, but the option Snap to guides is enabled, the guides become
invisible, but they still retain their function.

Note: Guides only appear on the screen and are not displayed in the printout.
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Adding guides in a dialog-box-controlled manner

To set up a new guide, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.

2. In the dialog box, switch to the Guides tab.

3. Under Horizontal or Vertical, enter where the guide should be set.

4. Click on the Add button.

Note: Guides can only be seen on the screen if the option Show guides (see above) is enabled.

Adding guides with the mouse

Alternatively, guides can also be added with the mouse:

1. Click on the icon  in the Quick access toolbar or on the far left of the ribbon tab View to enable object
mode.

2. You can now "drag" vertical guides from the vertical ruler and horizontal guides from the horizontal ruler.
To do so, click with the mouse on one of the rulers and drag the mouse cursor into the text area while
holding down the mouse button. Release the mouse button at the point where you want to set the guide.

3. Finally, click on the Object mode icon  again to exit object mode.

Tip: If the required ruler is not displayed, enable the options Horiz. ruler and/or Vert. ruler on the ribbon tab
View.

Repositioning and deleting guides

To reposition or delete a guide, proceed as follows:

Dialog box: Choose the ribbon command View | Grid and guides to open the dialog box and switch to the
Guides tab. To remove a guide, select it from the list and click on the Delete button. To reposition a guide,
delete it and then set a new guide at the desired position.

Mouse: In object mode , guides can simply be grabbed with the mouse and dragged to another position.
Furthermore: If you slide a guide into the horizontal or vertical ruler, it will be deleted. The same thing happens
if you press the Del key while dragging a guide.

Locking guides

To prevent guides from being inadvertently moved with the mouse, they can be "locked".

To do so, choose the ribbon command View | Grid and guides and enable the option Lock guides in the dialog
box.

Alternatively: File | Properties, on the View tab, in the Locking section.

Guides can no longer be moved with the mouse. Their position can only be changed via the dialog box of the
ribbon command View | Grid and guides.



641Customizing TextMaker

Using the "Snap to page margins" function

If you enable the option Snap to page margins via the ribbon command View | Grid and guides, the four page
margins of the document behave exactly like guides.

Tip: If the page margins are not displayed, choose the ribbon command File | Options, switch to the View
tab and enable the option Page margins.

Temporarily disabling this function: If the option Snap to page margins is enabled, you can temporarily disable it
at any time by holding down the Alt key while moving an object with the mouse.

Using the "Snap to other objects" function

If you choose the ribbon command View | Grid and guides and enable the option Snap to other objects, the
program automatically creates "magic" guides for the edges of each object on the current page. These guides
make it a lot easier to position objects perfectly aligned and evenly distributed.

These "magic" guides are usually invisible. They only become visible when you drag an object near such a
guide with the mouse. As soon as the guide appears, the object automatically snaps to it. Something similar
happens when you resize an object with your mouse.

Some examples of such guides:

§ If you drag an object to a position where it is roughly left-aligned with another object, a guide will appear
representing the left edge of the other object. If you let your object snap to it, it will be exactly left-aligned
with the existing object. 

§ The same applies to the right edge of objects.

§ If you drag an object to a position where it is roughly centered with another object, a guide will appear
representing the center of the object. If you let your object snap to it, it will be aligned exactly centered with
the other object.

§ If you drag an object to a position below two other objects, you will also see a horizontal guide at the
position where this third object would have exactly the same relative distance as the other two objects. (The
three objects would then be distributed evenly.)

All of this works in both directions (horizontally and vertically) – for example, an automatic guide is generated
for the top and bottom edges of each object.

Temporarily disabling this function: If the option Snap to other objects is enabled, you can temporarily disable it
at any time by holding down the Alt key while moving an object with the mouse.

Changing the tolerance of guides

By default, a frame or drawing snaps automatically to a guide when it is moved with the mouse to within 8
pixels of the guide. However, you can change this tolerance at any time. If, for example, you increase the
tolerance to "20", the mouse cursor will already snap to the guide if it is within 20 pixels of the guide.

To change the tolerance, use the ribbon command View | Grid and guides (click directly on the icon itself) to
open the dialog box and enter the desired value in pixels in the option Tolerance on the Guides tab.
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Installing dictionaries
As an alternative to its own dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries. They
are available free of charge for installation.

You can install dictionaries for the spell check and also specify which of these dictionaries should be used for a
language. For information on how to install these dictionaries, see the following sections:

§ Installing additional dictionaries 

In this section, you will learn how to add more dictionaries that are not currently installed.

Note: This is particularly important for the Android and iOS versions, since most dictionaries are already
pre-installed in SoftMaker Office for Windows, Mac and Linux.

§ Choosing a different dictionary for a language 

If you have multiple dictionaries installed for a language (for example, one from SoftMaker and one from
Hunspell), you can also specify which of these dictionaries to use. Read this section for details.

For more information on these topics, see the following pages.

Installing additional dictionaries

SoftMaker Office comes with premium dictionaries for numerous languages. In addition to SoftMaker
dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries. These dictionaries are available
as free downloads. Most of them were created by private users or non-profit organizations.

Hunspell dictionaries are available for numerous languages. If there is no SoftMaker dictionary for a language,
you will certainly find a Hunspell dictionary for it.

In this section, you will learn how to install dictionaries that are not currently installed:

Windows, Mac and Linux

When you install SoftMaker Office for Windows, Mac or Linux, all relevant dictionaries are already
integrated automatically – so there is usually no need to subsequently install additional dictionaries.

Note, however, that you can choose between different dictionaries here (Hunspell, SoftMaker) by clicking on
Switch for the respective dictionary. For more information, see the next section Choosing a different dictionary
for a language.

Android and iOS

The situation is different with SoftMaker Office for Android and iOS: Here, dictionaries are not automatically
integrated and must be subsequently installed for a language as needed.

Proceed as follows:
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1. Launch any of the apps (TextMaker, PlanMaker or Presentations) on your Android/iOS device.

2. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

3. Click on the Manage dictionaries button.

4. The program displays the dialog box "Dictionaries" with a list of all available languages. To download a
dictionary for a language, select it from the list and press the Install button.

The dictionary is now installed and will be available from now on in any SoftMaker Office application.

Note: In addition to Hunspell dictionaries (with Hunspell added at the end), the above list also includes in-
house SoftMaker dictionaries (nothing added to the end) for many languages. If both dictionaries are
installed for a language, you can select which dictionary to use by clicking on the Switch button. For more
information, see the next section.

Ask to install dictionaries when necessary

This option in the dialog box "Dictionaries" is also particularly important for the Android and iOS versions, as
dictionaries are not pre-installed in these versions.

When enabled, the option has the following effect: If you enter text in your document in a language for which a
dictionary is not yet installed, the program will automatically ask you whether you want to install the dictionary
now.

Note: Of course, the automatic prompting by the program only occurs if the Spell check is enabled.

Choosing a different dictionary for a language

If you have multiple dictionaries installed for a language (for example, a SoftMaker dictionary and a Hunspell
dictionary), you can always choose which of these dictionaries to use for the language. Proceed as follows:

1. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

2. Click on the Manage dictionaries button.

The program displays the dialog box "Dictionaries" with a list of all installed languages/dictionaries.

3. Navigate to the desired Language in this list. The dictionaries of a language can appear in the list with the
following additions:

No addition: SoftMaker Office's in-house dictionary for this language.

Hunspell: Free Hunspell dictionary for this language.

Duden: The official Duden dictionary (only included in SoftMaker Office Professional and NX
Universal, only available in German). For more information, see below.

4. Now specify which of these dictionaries should be used for the desired language. Here, the icons to the left
of a dictionary have the following meaning:
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Blue icon: The dictionary is already installed and switched on.

Gray icon: The dictionary is already installed and is not switched on.

No icon: The dictionary is not yet installed.

A blue icon thus indicates the currently active dictionary for the respective language. If you want to change
the active dictionary, select another dictionary for this language from the list and click on the Switch button.

(If the dictionary is not installed yet, click on the Install button beforehand.)

5. Confirm your changes by pressing OK.

From now on, the spell check will use the selected dictionary for the specified language.

Use Duden Korrektor for German spell check

For users of SoftMaker Office Professional and NX Universal (not in the Android/iOS version), an additional
option is also available:

If you enable the option Use Duden Korrektor for German spell check in the dialog box "Dictionaries", the
dictionary for all variants of the German language (Germany, Austria, Switzerland, etc.) will be set to the
corresponding Duden dictionary.

This option can also be found under the same name in the main dialog box of the ribbon command File |
Options (on the Language tab) and has the same effect.

Show only installed dictionaries

Enable this option if only the installed dictionaries should be displayed in the list.

Ask to install dictionaries when necessary

For more information on this option, see the descriptions in the previous section Installing additional
dictionaries.
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Appendix
The appendix of the manual contains the following information:

§ Ribbon commands and corresponding menu commands 

In this section, you will find a table of all commands in the ribbon interface and the respective
corresponding menu command in the classic menu interface.

§ Shortcut keys 

This section contains tables with the most important shortcut keys that you can use in the program.

§ Command-line parameters 

Here, you will find an overview of parameters that can be used to directly trigger a specified program option
when you start TextMaker.

Ribbon commands and corresponding menu commands
In this section, you will find a table of all commands in the ribbon interface and the respective corresponding
menu command in the classic menu interface.

Tip 1: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

Tip 2: Use the "hamburger menu" (the icon  on the left in the Quick access toolbar) if you still want to
access the classic menu commands from the ribbon interface.

The subsequent table contains the following columns:

§ Left column: The left column lists all ribbon commands in the program, listed according to the order of
ribbon tabs and in the following format: Ribbon tab | Command group | Command 

§ Right column: The right column lists all corresponding classic menu commands in the program in the
following format: Menu > Command

Example: The ribbon command File | Document | Save can be found under File > Save in the classic menu
interface.

Another entry >> is also added for some commands if the command can only be found in the submenu of an
icon or in a dialog box.

Thus, here is the aforementioned table:
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Ribbon Menu

File | File | New File > New

File | File | Open File > Open

File | File | Close File > Close

File | Document | Save File > Save

File | Document | Save as File > Save as

File | Document | Save all File > Save all

File | Document | EPUB export File > Export as EPUB

File | Document | PDF export File > Export as PDF

File | Document | Send File > Send

File | Document | Finalize File > Finalize

File | Print | Print preview File > Print preview

File | Print | Print File > Print

File | Print | Print merge File > Print merge

File | File management | Properties File > Properties

File | File management | Versions File > File versions

File | File management | File manager File > File manager

File | File Management | Compress all pictures Object > Compress all pictures

File | Scripts | Edit script Tools > Edit script

File | Scripts | Run script Tools > Run script

File | Settings | Options Tools > Options

File | Settings | Customize >> Customize ribbon Tools > Customize
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Ribbon Menu

File | File | Exit (if no document is open) File > Exit

in the Quick access toolbar Edit > Undo

in the Quick access toolbar Edit > Redo

in the Quick access toolbar View > Touch mode

in the Quick access toolbar View > Dark document mode

Home | Edit | Paste Edit > Paste

Home | Edit | Paste >> Paste special Edit > Paste special

Home | Edit | Cut Edit > Cut

Home | Edit | Copy Edit > Copy

Home | Edit | Format painter Format > Transfer formatting

Home | Character | Change capitalization

Home | Character | Bold Toolbar: Formatting

Home | Character | Italic Toolbar: Formatting

Home | Character | Underline Toolbar: Formatting

Home | Character | Strike out

Home | Character | Subscript

Home | Character | Superscript

Home | Character | Font color Toolbar: Formatting

Home | Character | Highlight text Toolbar: Formatting

Home | Character | Reset character formatting Format > Standard

Home | Character | Increase font size Toolbar: Formatting

Home | Character | Decrease font size Toolbar: Formatting



648Appendix

Ribbon Menu

Home | Paragraph | Toggle bullets Toolbar: Formatting

Home | Paragraph | Toggle numbering Toolbar: Formatting

Home | Paragraph| Apply numbered lists Toolbar: Formatting

Home | Paragraph | Increase indent Toolbar: Formatting

Home | Paragraph | Decrease indent Toolbar: Formatting

Home | Paragraph | Sort text/table Edit > Sort

Home | Paragraph | Paragraph marks Toolbar: Standard

Home | Paragraph | Left align paragraph Toolbar: Formatting

Home | Paragraph | Set line spacing

Home | Paragraph | Paragraph shading Format > Shading

Home | Paragraph | Set borders of selected paragraphs Format > Borders

Home | Styles | Paragraph style Toolbar: Formatting

Home | Search | Search Edit > Search

Home | Search | Replace Edit > Replace

Home | Search | Search again Edit > Search again

Home | Search | Go to Edit > Go to

Home | Selection | Select all Edit > Select all

Insert | Breaks | Break Insert > Break

Insert | Table | Table Table > New table

Insert | Table | Table >> Convert text to table Table > Convert text to table

Insert | Objects | Picture Object > New picture

Insert | Objects | Picture >> From scanner File > Acquire
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Ribbon Menu

Insert | Objects | Picture >> Select source File > Select source

Insert | Objects | Text frame Object > New text frame

Insert | Objects | Chart frame Object > New chart frame

Insert | Objects | AutoShape Object > New drawing > AutoShapes

Insert | Objects | Lines Object > New drawing > Line

Insert | Objects | Equation Object > New OLE object >> SoftMaker Equation
Editor

Insert | Objects | TextArt object Object > New drawing > TextArt

Insert | Objects | QR code/Barcode frame Object > New QR code/Barcode frame

Insert | Objects | Form object >> Text field Object > New form object > Text field

Insert | Objects | Form object >> Checkbox Object > New form object > Checkbox

Insert | Objects | Form object >> Dropdown Object > New form object > Dropdown

Insert | Objects | Form object >> Checkbox frame Object > New form object > Checkbox frame

Insert | Objects | Form object >> Dropdown frame Object > New form object > Dropdown frame

Insert | Objects | Form object >> Label Object > New form object > Label

Insert | Objects | Form object >> Groupbox Object > New form object > Groupbox

Insert | Objects | Form object >> Tab order Object > Tab order

Insert | Objects | OLE object frame Object > New OLE object frame

Insert | Objects | OLE object frame >> PlanMaker worksheet
object

Object > New OLE object frame >> PlanMaker
Spreadsheet

Insert | Objects | OLE object frame >> PlanMaker chart
object

Object > New OLE object frame >> PlanMaker
Chart

Insert | Objects | OLE object frame >> Presentations object Object > New OLE object frame >> Presentations
Slide

Insert | Links | Hyperlink Format > Link
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Ribbon Menu

Insert | Links | Bookmark Insert > Bookmark

Insert | Links | Cross reference Insert > Cross reference

Insert | Comments | Comment Tools > Comments > Insert comment

Insert | Header and footer | Header Insert > Header

Insert | Header and footer | Footer Insert > Footer

Insert | Headers and footer | Page number Toolbar: Header and footer

Insert | Header and footer | Footnote Insert > Footnote > Insert footnote

Insert | Header and footer | Footnote >> Change numbering Insert > Footnote > Edit footnote

Insert | Header and footer | Footnote >> Insert footnote mark Insert > Footnote > Footnote mark

Insert | Header and footer | Footnote >> Footnote options Insert > Footnote > Options

Insert | Header and footer | Endnote Insert > Endnote > Insert endnote

Insert | Header and footer | Endnote >> Change numbering Insert > Endnote > Edit endnote

Insert | Header and footer | Endnote >> Insert endnote mark Insert > Endnote > Endnote mark

Insert | Header and footer | Endnote >> Endnote options Insert > Endnote > Options

Insert | Text | Date/time Insert > Date/time

Insert | Text | Character

Insert | Text | Field Insert > Field

Insert | Text | Field >> Calculation Insert > Calculation

Insert | Text | SmartText Insert > SmartText

Insert | Text | Symbol Insert > Symbol

Insert | Text | Document Insert > Document

Layout | Page setup | Page margins File > Page setup
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Ribbon Menu

Layout | Page setup | Page orientation File > Page setup

Layout | Page setup | Page size File > Page setup

Layout | Page setup | Insert break Insert > Break

Layout | Chapter | Chapter Format > Chapter

Layout | Section | Columns >> More Format > Section

Layout | Section | Line numbers Format > Line numbers

Layout | Section | Background Format > Page background

Layout | Paragraph | Tabs Format > Tabs

Layout | Paragraph | Drop caps Format > Drop caps

Layout | Paragraph | Hyphenation

Layout | Paragraph | Hyphenation >> Automatic
hyphenation

Tools > Automatic hyphenation

Layout | Position | Wrapping mode Toolbar: Picture, AutoShape

Layout | Position | Bring to front Object > Order > Bring to front

Layout | Position | Bring to front >> Bring forward one level Object > Order > Bring forward one level

Layout | Position | Bring to front >> Bring in front of text Toolbar of the respective object: Object order >>
Bring in front of text

Layout | Position | Send to back Object > Order > Send to back

Layout | Position | Send to back >> Send backward one level Object > Order > Send backward one level

Layout | Position | Send to back >> Send behind text Toolbar of the respective object: Object order >>
Send behind text

Layout | Position | Rotate object Object > Rotate or flip

Layout | Position | Align objects Object > Align or distribute

Layout | Position | Grid and guides Object > Grid and guides
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Ribbon Menu

Layout | Objects | Group Object > Group

Layout | Objects | Duplicate Edit > Duplicate

Layout | Objects | Convert Toolbar of the respective object

References | Fields | Field Insert > Field

References | Fields | Shade fields Toolbar: Mail merge

References | Fields | Field names Toolbar: Mail merge

References | Fields | Update fields Tools > Update fields

References | Table of contents | Generate Tools > Generate table of contents

References | Table of contents | Update Tools > Generate table of contents

References | Footnotes | Footnote Insert > Footnote > Insert footnote

References | Footnotes | Endnote Insert > Endnote > Insert endnote

References | Footnotes | Go to footnote Insert > Footnote > Go to footnote

References | Footnotes | Go to endnote Insert > Endnote > Go to endnote

References | Footnotes | Go to reference Insert > Footnote > Go to footnote reference

References | Bibliography | Insert field Tools > Bibliography > Insert bibliography field

References | Bibliography | Insert field >> Use existing
database

Tools > Bibliography > Attach an existing
bibliography database

References | Bibliography | Insert field >> Create new
database

Tools > Bibliography > Create a new bibliography
database

References | Bibliography | Generate Tools > Bibliography > Generate bibliography

References | Bibliography | Update Tools > Bibliography > Generate bibliography

References | Bibliography | Manage >> Bibliography
settings

Tools > Bibliography > Bibliography settings

References | Bibliography | Manage >> Edit database Tools > Bibliography > Edit the bibliography
database
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Ribbon Menu

References | Zotero | Insert/edit citation Tools > Zotero > Add or edit a citation

References | Zotero | Insert/edit bibliography Tools > Zotero > Add or edit the bibliography

References | Zotero | Document preferences Tools > Zotero > Document preferences

References | Zotero | Refresh Tools > Zotero > Refresh

References | Zotero | Unlink citations Tools > Zotero > Unlink citations

References | Captions | Insert caption Insert > Caption

References | Captions | Generate Tools > Generate table of figures

References | Captions | Update Tools > Generate table of figures

References | Index | Add entry Tools > Index > Add index entry

References | Index | Generate Tools > Index > Generate index

References | Index | Update Tools > Index > Generate index

References | Index | Edit entries Tools > Index > Edit index entries

Mailings | Recipients | Select database Toolbar: Mail merge

Mailings | Recipients | Select database >> Use existing
database

Tools > Set database

Mailings | Recipients | Select database >> Create new
database

Tools > Create database

Mailings | Recipients | Select recipients Toolbar: Mail merge

Mailings | Insert | Merge field Toolbar: Mail merge

Mailings | Insert | Field Insert > Field

Mailings | Fields | Shade fields Toolbar: Mail merge

Mailings | Fields | Field names Toolbar: Mail merge

Mailings | Fields | Update fields Tools > Update fields
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Ribbon Menu

Mailings | Record | Show merge record Toolbar: Mail merge

Mailings | Record | Previous record Toolbar: Mail merge

Mailings | Record | Next record Toolbar: Mail merge

Mailings | Print | Print merge File > Print merge

Mailings | Create | Envelope Insert > Envelope

Mailings | Create | List/Label Insert > List/label

Mailings | Database | Edit database Tools > Edit database

Mailings | Database | New database Tools > Create database

Review | Spelling | Spell check Tools > Check spelling

Review | Spelling | Spell check >> Edit user dictionaries Tools > Edit user dictionaries

Review | Spelling | German (Germany) Status bar

Review | Spelling | Hyphenation

Review | Spelling | Hyphenation >> Automatic hyphenation Tools > Automatic hyphenation

Review | Spelling | Auto correction Tools > Auto correction

Review | Language tools | Thesaurus Tools > Thesaurus

Review | Language tools | Translation Tools > Translation

Review | Language tools | Research Toolbar: Standard

Review | Language tools | SmartChat Tools > SmartChat

Review | Speek | Speech Tools > Text to speech

Review | Comments | Insert Tools > Comments > Insert comment

Review | Comments | Edit Tools > Comments > Edit comment

Review | Comments | Delete Tools > Comments > Delete comment
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Ribbon Menu

Review | Comments | Previous Tools > Comments > Previous comment

Review | Comments | Next Tools > Comments > Next comment

Review | Comments | Show in the pane Tools > Comments > Automatically show
comments pane

Review | Changes | Track changes Tools > Changes > Track changes

Review | Changes | Accept Toolbar: Review

Review | Changes | Accept >> Accept current change Toolbar: Review

Review | Changes | Accept >> Accept all changes Toolbar: Review

Review | Changes | Reject Toolbar: Review

Review | Changes | Accept >> Reject current change Toolbar: Review

Review | Changes | Accept >> Reject all changes Toolbar: Review

Review | Changes | Previous Tools > Changes > Previous change

Review | Changes | Next Tools > Changes > Next change

Review | Changes | Show Tools > Changes > Show changes

Review | Changes | Review Tools > Changes > Review all changes

View | Mode | Object mode View > Object mode

View | Views | Standard View > Standard

View | Views | Continuous View > Continuous

View | Views | Master page View > Master pages

View | Views | Outline View > Outline

View | Views | Book layout View > Book layout

View | Forms | Form mode View > Form mode

View | Forms | Shade form objects Toolbar: Form
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Ribbon Menu

View | Fields | Toggle bookmarks Insert > Bookmarks >> Display bookmarks in the
document

View | Fields | Field names Toolbar: Mail merge

View | Fields | Shade fields Toolbar: Mail merge

View | View | Grid and guides Object > Grid and guides

View | View | Horiz. ruler View > Horizontal ruler

View | View | Vert. ruler Tools > Options: View tab >> Vertical ruler

View | Zoom | Set zoom View > Zoom level

View | Zoom | Zoom View > Magnifying glass

View | Zoom | Actual size View > Actual size

View | Zoom | Fit margins View > Fit margins to window

View | Zoom | Full page View > Full page

View | Zoom | Two pages View > Two full pages

View | Side by side | View side by side Window > View side by side

View | Side by side | Synchronize scroll Window > Synchronize scroll

View | Side by side | Restore positions Window > Restore positions

View | Windows | Sidebars View > Sidebars

View | Windows | Full screen View > Full screen

View | Windows | Windows >> Window >

View | Windows | Windows >> View side by side Window > View side by side

View | Windows | Windows >> Close all Window > Close all

Table | Table | Select Table > Select > Table

Table | Table | Select >> Select rows Table > Select > Row
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Ribbon Menu

Table | Table | Select >> Select columns Table > Select > Column

Table | Table | Select >> Select current cell Table > Select > Cell

Table | Table | Properties Table > Table properties

Table | Table | Properties >> Row properties Table > Row properties

Table | Table | Properties >> Cell properties Table > Cell properties

Table | Style | Table styles Table > Table style

Table | Style | Header row Toolbar: Table

Table | Style | Total row Toolbar: Table

Table | Style | First column Toolbar: Table

Table | Style | Last column Toolbar: Table

Table | Style | Banded rows Toolbar: Table

Table | Style | Banded columns Toolbar: Table

Table | Format | Shading Toolbar: Table

Table | Format | Borders Toolbar: Table

Table | Format | Text alignment Toolbar: Table

Table | Cells | Delete cells Toolbar: Table

Table | Cells | Delete cells >> Delete rows Table > Delete cells > Delete rows

Table | Cells | Delete cells >> Delete columns Table > Delete cells > Delete columns

Table | Cells | Delete cells >> Delete cells Table > Delete cells > Delete cells

Table | Cells | Delete cells >> Delete table Table > Delete cells > Delete table

Table | Cells | Insert rows Toolbar: Table

Table | Cells | Insert rows >> Insert row above Table > Insert cells > Insert row above
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Ribbon Menu

Table | Cells | Insert rows >> Insert row below Table > Insert cells > Insert row below

Table | Cells | Insert rows >> Insert cells Table > Insert cells > Insert cells

Table | Cells | Insert columns Toolbar: Table

Table | Cells | Insert columns >> Insert column left Table > Insert cells > Insert column left

Table | Cells | Insert columns >> Insert column right Table > Insert cells > Insert column right

Table | Cells | Repeat table row Table > Row properties >> Repeat as header row

Table | Cells | Distribute rows Table > Distribute rows

Table | Cells | Distribute columns Table > Distribute columns

Table | Cell size | Row height Table > Row properties

Table | Cell size | Cell width Table > Cell properties

Table | Merge and split | Merge cells Table > Merge cells

Table | Merge and split | Split cells Table > Split cells

Table | Merge and split | Split table Table > Split table

Table | Data | Sort table Table > Sort table

Table | Data | Convert table to text Table > Convert table to text

Outline | Outline | Promote level Toolbar: Outline

Outline | Outline | Demote level Toolbar: Outline

Outline | Outline | Set to body text Toolbar: Outline

Outline | View | Expand level Toolbar: Outline

Outline | View | Collapse level Toolbar: Outline

Outline | View | Show body text Toolbar: Outline

Outline | View | Show outline levels Toolbar: Outline
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Ribbon Menu

Outline | | Close outline view

Header and footer | Header and footer | Header Insert > Header

Header and footer | Header and footer | Footer Insert > Footer

Header and footer | Header and footer | Delete header or
footer

Toolbar: Header and footer

Header and footer | Header and footer | Page number Toolbar: Header and footer

Header and footer | Size and position | Minimum height Toolbar: Header and footer

Header and footer | Size and position | Distance to page edge Toolbar: Header and footer

Header and footer | Size and position | Distance to text Toolbar: Header and footer

Header and footer | Format | Shading Toolbar: Header and footer

Header and footer | Format | Borders Toolbar: Header and footer

Header and footer | Insert | Date/time Toolbar: Header and footer

Header and footer | Insert | Field Toolbar: Header and footer

Header and footer | Insert | Alignment tab Toolbar: Header and footer

Header and footer | Navigation | Next header or footer Toolbar: Header and footer

Header and footer | Navigation | Previous header or footer Toolbar: Header and footer

Header and footer | | Leave header/footer

Database | Edit | Paste Edit > Paste

Database | Edit | Cut Edit > Cut

Database | Edit | Copy Edit > Copy

Database | Navigation | First record Toolbar: Database

Database | Navigation | Search Edit > Search

Database | Navigation | Search again Edit > Search again
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Ribbon Menu

Database | Records | Append Edit > Append record

Database | Records | Duplicate Edit > Duplicate record

Database | Records | Delete Edit > Delete current record

Database | Records | Delete >> Selected records Edit > Delete selected records

Database | Records | Delete >> Restore deleted records Edit > Restore deleted records

Database | Records | Delete >> Purge database Edit > Purge database

Database| Records | Sort Edit > Sort database

Database | Records | Select Select > Current record

Database | Records | Select >> By record numbers Select > By number

Database | Records | Select >> By condition Select > By condition

Database | Records | Select >> Select all records Select > Select all records

Database | Records | Select >> Deselect all records Select > Deselect all records

Database | Records | Select >> Invert selection Select > Invert selection

Database | View | Form / list view View > Form

Database | View | Show only selected records View > Show only selected records

Database | View | Update View > Update

Database | Manage | Save as SQLite table File > Save as SQLite table

Database | Manage | Table settings File > Table settings

Database | Manage | Change structure File > Change table structure

Database | | Close database File > Close

Object | Insert | New object Toolbar: Standard

Object | Format | AutoShape templates Toolbar: AutoShape



661Appendix

Ribbon Menu

Object | Format | AutoShape templates >> More Object > Properties

Object | Format | AutoShape effects Toolbar of the respective object

Object | Format | Fill color Toolbar of the respective object

Object | Format | Line color Toolbar of the respective object

Object | Format | Line style Toolbar of the respective object

Object | Format | Line thickness Toolbar of the respective object

Object | Format | Line endings Toolbar: AutoShape

Object | Edit | Change AutoShape Toolbar: AutoShape

Object | Edit | Edit points Via the context menu

Object | Edit | Combine objects Via the context menu

Object | Inner text | Text rotation Toolbar: AutoShape

Object | Inner text | Vertical alignment Toolbar: AutoShape

Object | Inner text | Change text area Toolbar: AutoShape

Object | Inner text | Link text frames Toolbar: AutoShape

OLE object | OLE | OLE object Edit > OLE object

OLE object | OLE | Edit link Edit > Link

OLE object | Size | Cropping Toolbar: Picture

OLE object | Adjust | Recolor picture Toolbar: Picture

Picture | Adjust | Compress pictures Object > Compress selected pictures

Picture | Adjust | Change source Object > Properties: Picture tab >> File...

Picture | Adjust | Reset Toolbar: Picture

Picture | Format | Photo frame Toolbar: Picture



662Appendix

Ribbon Menu

Chart | Type | Chart type Toolbar: Chart

Chart | Type | Chart subtype Toolbar: Chart

Chart | Data | Edit data Object > Chart > Edit data

Chart | Design | Chart colors Toolbar: Chart

Chart | Chart elements | Add chart element Toolbar: Chart

Chart | Chart elements | Select chart element Toolbar: Chart

Chart | Chart elements | Edit properties Object > Chart > xy element: Properties

Chart | Chart elements | Fill color

Chart | Chart elements | Line color

Chart | Chart elements | Line style

Chart | Chart elements | Line thickness

not available Edit > Delete

not available Edit > Evaluate

Home | Character >> group arrow Format > Character

Home | Paragraph >> group arrow Format > Paragraph

Via the context menu Format > Remove link

Via the context menu Format > Character style

not available Object > New horizontal line

Via the context menu Object > Chart > Save as picture
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Shortcut keys
The following pages contain tables with Textmaker's most important shortcut keys:

§ Shortcut keys in Windows and Linux versions 

§ Shortcut keys in Mac version

Tip: If you choose the ribbon command File | Customize , you can customize the default shortcut keys
and create new shortcut keys. For more information, see Customizing shortcut keys.

Shortcut keys in Windows and Linux versions

In the Windows and the Linux version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Ctrl+Z

Quick access toolbar: Redo Ctrl+Y

File | New Ctrl+N

File | Open Ctrl+O

File | Close Ctrl+F4 or Ctrl+W

File | Save Ctrl+S

File | Print Ctrl+P

File | File manager F12

File | Exit Alt+F4 or Ctrl+Q

Home | Paste Ctrl+V

Home | Paste Special Ctrl+Alt+V

Home | Cut Ctrl+X

Home | Copy Ctrl+C
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Command Shortcut key

Home | Format painter (copying step) Ctrl+Shift+C

Home | Format painter (pasting step) Ctrl+Shift+V

Home | group Character:

Select font from the list Ctrl+D

Reduce font size Ctrl+8

Increase font size Ctrl+9

Change uppercase/lowercase of text 
(from "test" to "Test" to "TEST")

Shift+F3

Bold on/off Ctrl+B

Italics on/off Ctrl+I

Underline on/off Ctrl+U

Superscript Ctrl+Shift+Plus key (numeric keypad)

Subscript Ctrl+Shift+Minus key (numeric keypad)

Remove superscript or subscript Ctrl+Shift+Multiply key (numeric keypad)

Reset character formatting Ctrl+Space

Home | group Paragraph:

Increase left indent Ctrl+M

Decrease left indent Ctrl+Shift+M

Increase hanging indent Ctrl+T

Decrease hanging indent Ctrl+Shift+T

Alignment: Left Ctrl+L

Alignment: Centered Ctrl+E

Alignment: Right Ctrl+R

Alignment: Justified Ctrl+J

Automatic single line spacing (1 line) Ctrl+1

Automatic one and a half line spacing (1.5 lines) Ctrl+5

Automatic double line spacing (2 lines) Ctrl+2
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Command Shortcut key

Home | group Styles:

"Normal" paragraph style Alt+0 or Ctr+Shift+N

Paragraph style "Heading 1" to "Heading 9" Alt+1 to Alt+9

Increase the paragraph's outline level by 1 Alt+Shift+ß

Reduce the paragraph's outline level by 1 Alt+Shift+à

Home | Search Ctrl+F

Home | Replace Ctrl+H

Home | Search again (or Replace again) F3

Home | Go to F5 or Ctrl+G

Home| Select all Ctrl+A

Insert | Break | Line break Shift+¿

Insert | Break | Column break Ctrl+Shift+¿

Insert | Break | Page break Ctrl+¿

Insert | Hyperlink Ctrl+K

Insert | Insert footnote Ctrl+Alt+F

Insert | Date Ctrl+. (period)

Insert | time Ctrl+Shift+. (period)

Insert | Character

Insert a soft hyphen(optional hyphen) Ctrl+Hyphen

Insert a non-breaking hyphen Ctrl+Shift+Hyphen

Insert an en dash (–) Ctrl+Minus key (numeric keypad)

Insert an em dash (—) Ctrl+Alt+Minus key (numeric keypad)

Insert a non-breaking space Ctrl+Shift+Space

Insert | Field | Calculation F2

Insert | Calculate
(not available in ribbon by default)

F8

References | Field | Calculation F2
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Command Shortcut key

References | Show field names or field contents Alt+F9

References | Update fields F9

Mailings | Field | Calculation F2

Mailings | Show field names or field contents Alt+F9

Mailings | Update fields F9

Review | Spell check F7

Review | Thesaurus Shift+F7

Review | Track changes Ctrl+Shift+E

View | Show field names or field contents Alt+F9

View | Full screen F6

Shortcut keys for selecting text

Command Shortcut key

Select single characters (forward) Shift+à

Select single characters (backward) Shift+ß

Select single words (forward) Ctrl+Shift+à

Select single words (backward) Ctrl+Shift+ß

Select up to the end of the line Shift+End

Select up to the beginning of the line Shift+Home

Select paragraph (down) Ctrl+Shift+â

Select paragraph (up) Ctrl+Shift+á

Select entire screen pages (down) Shift+PageDownâ

Select entire screen pages (up) Shift+PageUpá

Select up to the end of the document Ctrl+Shift+End

Select up to the beginning of the document Ctrl+Shift+Home

Select entire document Ctrl+A
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Other useful shortcut keys

Command Shortcut key

Display help content F1

To the next open document Ctrl+F6

To the previous open document Ctrl+Shift+F6

Show/hide ribbon Ctrl+F1

Move to the next ribbon tab Ctrl+F12

Move to the previous ribbon tab Ctrl+Shift+F12

For open dialog boxes: move to the next tab Ctrl+Tab

For open dialog boxes: move to the previous tab Ctrl+Shift+Tab

Move to the next form object
(or in tables: move to the next cell)

Ctrl+F11

Move to the previous form object
(or in tables: move to the previous cell)

Ctrl+Shift+F11

Move to the next form object (in form mode)
or select the next object (in object mode)

Tab

Move to the previous form object (in form mode)
or select the previous object (in object mode)

Shift+Tab

Move to the beginning of the document Ctrl+Home

Move to the end of the document Ctrl+End

Return to the last editing position when opening Shift+F5

Convert a hexadecimal character code into Unicode characters* Ctrl+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).

Shortcut keys in Mac version

Note: For most shortcut keys with the Cmd key, you can also use the Ctrl key instead of the Cmd key. For
the shortcut key Cmd+S, for example, you can also press Ctrl+S.
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In the Mac version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Cmd+Z

Quick access toolbar: Redo Cmd+Y

File | New Cmd+N

File | Open Cmd+O

File | Close Cmd+F4 or Cmd+W

File | Save Cmd+S

File | Print Cmd+P

File | File manager F12

File | Exit Alt+F4 or Cmd+Q

Home | Paste Cmd+V

Home | Paste Special Cmd+Alt+V

Home | Cut Cmd+X

Home | Copy Cmd+C

Home | Format painter (copying step) Cmd+Shift+C

Home | Format painter (pasting step) Cmd+Shift+V

Home | group Character:

Select font from the list Cmd+D

Reduce font size Cmd+8

Increase font size Cmd+9

Change uppercase/lowercase of text 
(from "test" to "Test" to "TEST")

Shift+F3

Bold on/off Cmd+B

Italics on/off Cmd+I

Underline on/off Cmd+U

Superscript Cmd+Shift+Plus key (numeric keypad)
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Command Shortcut key

Subscript Cmd+Shift+Minus key (numeric keypad)

Remove superscript or subscript Cmd+Shift+Multiply key (numeric keypad)

Reset character formatting Ctrl+Space

Home | group Paragraph:

Increase left indent Cmd+M

Decrease left indent Cmd+Shift+M

Increase hanging indent Cmd+T

Decrease hanging indent Cmd+Shift+T

Alignment: Left Cmd+L

Alignment: Centered Cmd+E

Alignment: Right Cmd+R

Alignment: Justified Cmd+J

Automatic single line spacing (1 line) Cmd+1

Automatic one and a half line spacing (1.5 lines) Cmd+5

Automatic double line spacing (2 lines) Cmd+2

Home | group Styles:

"Normal" paragraph style Cmd+Alt+0 or Ctrl+Shift+N

Paragraph style "Heading 1" to "Heading 9" Cmd+Alt+1 to Cmd+Alt+9

Increase the paragraph's outline level by 1 Ctrl+Shift+ß

Reduce the paragraph's outline level by 1 Ctrl+Shift+à

Home | Search Cmd+F

Home | Replace Cmd+H

Home | Search again (or Replace again) F3

Home | Go to F5 or Cmd+G

Home| Select all Ctrl+A

Insert | Break | Line break Shift+¿

Insert | Break | Column break Cmd+Shift+¿



670Appendix

Command Shortcut key

Insert | Break | Page break Cmd+¿

Insert | Hyperlink Cmd+K

Insert | Insert footnote Cmd+Alt+F

Insert | Date Ctrl+. (period)

Insert | time Ctrl+Shift+. (period)

Insert | Character

Insert a soft hyphen (optional hyphen) Cmd+Hyphen

Insert a non-breaking hyphen Cmd+Shift+Hyphen

Insert an en dash (–) Cmd+Minus key (numeric keypad)

Insert an em dash (—) Cmd+Alt+Minus key (numeric keypad)

Insert a non-breaking space Cmd+Shift+Space

Insert | Field | Calculation F2

Insert | Calculate
(not available in ribbon by default)

F8

References | Field | Calculation F2

References | Show field names or field contents Alt+F9

References | Update fields F9

Mailings | Field | Calculation F2

Mailings | Show field names or field contents Alt+F9

Mailings | Update fields F9

Review | Spell check F7

Review | Thesaurus Shift+F7

Review | Track changes Cmd+Shift+E

View | Show field names or field contents Alt+F9

View | Full screen F6
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Shortcut keys for selecting text

Command Shortcut key

Select single characters (forward) Shift+à

Select single characters (backward) Shift+ß

Select single words (forward) Alt+Shift+à

Select single words (backward) Alt+Shift+ß

Select up to the end of the line Shift+End

Select up to the beginning of the line Shift+Home

Select paragraph (down) Alt+Shift+â

Select paragraph (up) Alt+Shift+á

Select entire screen pages (down) Shift+PageDownâ

Select entire screen pages (up) Shift+PageUpá

Select up to the end of the document Ctrl+Shift+End

Select up to the beginning of the document Ctrl+Shift+Home

Select entire document Ctrl+A

Other useful shortcut keys

Command Shortcut key

Display help content F1

To the next open document Cmd+F6

To the previous open document Cmd+Shift+F6

Expand or collapse the ribbon Cmd+F1

Move to the next ribbon tab Ctrl+F12

Move to the previous ribbon tab Ctrl+Shift+F12

For open dialog boxes: move to the next tab Ctrl+Tab

For open dialog boxes: move to the previous tab Ctrl+Shift+Tab
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Command Shortcut key

Move to the next form object
(or in tables: move to the next cell)

Ctrl+F11

Move to the previous form object
(for tables: move to the previous cell)

Ctrl+Shift+F11

Move to the next form object (in form mode)
or select the next object (in object mode)

Tab

Move to the previous form object (in form mode)
or select the previous object (in object mode)

Shift+Tab

Move to the beginning of the document Ctrl+Home

Move to the end of the document Ctrl+End

Return to the last editing position when opening Shift+F5

Convert a hexadecimal character code into Unicode characters* Cmd+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).
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Command-line parameters

Note: The command-line parameters described here only work on Windows.

Command-line parameters allow you to specify that TextMaker is started immediately with a specific program
option rather than with the usual default behavior. Example: You would like TextMaker to switch to the dialog
box for selecting a document template directly upon startup.

To insert a command-line parameter, proceed as follows:

1. Create a new shortcut to TextMaker on the desktop. Ideally, give the link a distinctive name in order to
distinguish it more clearly.

2. Choose the properties of the shortcut: Right-click on the link for the context menu and select the entry
Properties.

3. The following dialog box with the Shortcut tab will then appear:
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4. In the input field Target after the file path "...\TextMaker.exe", enter the desired parameter from the
table below. In the figure, for example, this is the parameter -FN.

Important: There must be a space in front of the parameter and the parameter starts with a hyphen.

5. Confirm with OK.

When you open TextMaker via this newly created link (double-click the link), the program will start directly
with the behavior of the parameter that was used.

Command-line parameters

Parameter Description

-N TextMaker starts without opening a new default document.

-FO TextMaker starts with an open dialog box for selecting a file.

-FN TextMaker starts with an open dialog box for selecting a document
template.

-P"Path\FileName" TextMaker starts and prints the specified file directly on the default
printer.

-Q"PrinterName","Path\FileName"
Note: No space is inserted
within the parameter.

TextMaker starts and prints the specified file directly on the specified
printer.
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3
3D effect (for objects)   322

A
ABOVE   460

ABS function   470

Actual size (view)   615

Add or remove spaces when pasting   585

Add spacing around punctuation marks (French)   393

Add/edit text  
for AutoShapes   342
for text frames   342

Address   183, 411, 585

Address database   411

Address labels   436

Address lists   436

addressbook.sqlite   420

AI-based texts   407

Align (object)  
align and distribute objects   307
snap to grid   638
snap to guides   639
snap to page margins   639
to other objects with guides   639

Alignment  
of page   130
of tabs   94
of text in tables   223
of text in text fields   356
of text in text frames   328, 330

Alignment tabs   120

All caps   76

All lowercase   76

ALL UPPERCASE   76

Anchor (of objects)   302, 314

Android/iOS  
context menu   33
input mode   30
select   68
share a document   549
unlock commands   30
unlock locked commands   16
user interface   30

Anti-aliasing   588

Arabic scripts   570, 585

Area chart   251

ASC function   470

Asian scripts   585

Assign database (mail merge)   446

Associate file types   597

AT function   470

Auto correction   393, 585

Auto number   183
reset   206

AutoFormat (table style)   228

Automatic hyphenation   383, 592

Automatic translation   405

Auto-Recover   594, 596

AutoShape  
add/edit text   342
AutoShape effects   343
AutoShape templates   343
change on ribbon tab Object   343
change on the ribbon tab Object   309
change text area   332
change via the dialog box   324, 345
drawing   340

AutoText   400

Avery labels (for addresses)   436

AVG function   470

Axes (in charts)   258, 277, 278, 280, 282

Axis title (in charts)   258, 281

B
Background color  

of document pages   134
of text   78
of the program   588

Backup copies   559, 596

Backup folder   559, 596

BAK files   559

Bar chart   251

Barcode, generate   369

Based on (for character styles)  
floating   145

Based on (for paragraph styles)   156

BasicMaker   575

Beep on errors   588

BELOW   460

biblio.sqlite   499

Bibliography   498, 503
assign existing bibliography database   500
bibliography settings   500
create new bibliography database   499
edit bibliography database   499
format bibliography   506
generate bibliography   502
insert bibliography field   500
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Bibliography   498, 503
search bibliography database   500
update bibliography   505
Zotero   503

Bi-fold marks   136

Bold (font)   76

Book layout (view)   613

Book printing (mirror margins)   114

Bookmarks   177, 508
for hyperlinks   534
show   177, 605

Borders  
of entire tables   227
of master pages   130
of objects   321
of paragraphs   104
of table cells   223

Borders and lines   104

Box and whisker plot   251

Boxplot chart   251

Bring forward one level (object)   305

Bring to front (object)   305

Bubble chart   251

Bullets and numbering   97, 193, 198, 201, 202, 482

C
Calculate   465

Calculate in the text   456

Calculations   456, 464, 465
format   464
insert   456
round   464
update   465
with database fields   462
with objects   463
with table cells   460
with variables   458

Capitalize first letter of sentences   393

CAPITALS (all capital letters)   76

Captions (for objects)   493, 494

Category axis (in charts)   258, 277

Cells (table)  
cell properties   223
cell width   223
delete   216
insert   217
merge   220
split   219

Center (paragraph)   92

Change database structure   428

Change page background   134

Change shape   309

Change tab order (form object)   366

Change text area  
of AutoShapes   332
of text frames   332

Changes to the document   529
next change   530
previous change   530
remove personal information   550
review all changes   530
settings   532
show changes   530
track changes   530

Chapter   124, 130
formatting   130
use   128

Chapter break   128

Chapter number   130, 183

Chapters  
formatting   129
navigate   129

Character field (database)   416

Character format   73
all caps   76
background color   78
bold   76
change default character formatting   85
character pitch   80
font   75
font color   78
font size   75
hide text   82
italic   76
kerning   81
letter spacing   80
point (pt)   75
protect text   83
small caps   76
strikethrough   76
superscripts and subscripts   79
text styles   76
underline   76

Character formatting   73
apply to entire words   585
change   73
change for whole paragraph   93
reset   84, 144
search and replace   176
transfer   82

Character pitch   80

Character styles   140, 161
apply   142
based on   145
based on: floating   145
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Character styles   140, 161
change   143
create   140
default style "Normal"   85, 145
sidebar   147

Characters, count   609

Chart (dialog box)   285

Chart (ribbon tab)   249

Chart area   268

Chart title   259, 282

Charts   246
add/delete data series   255, 285
change chart type   251
change properties   285
edit   249
enter/edit data   248, 255
insert   246
insert manually   248
insert via PlanMaker   247
save as picture   288
select chart elements   266

ChatGPT   407

Check for updates   597

Checkbox (form object)   351

Checkbox frame (form object)   351

Checkbox frames (form object)   360

Checkboxes (form object)   358

CHR function   470

Classic menus with toolbars   16, 588
list of all ribbon commands and menu commands  
645
user interface   28

Clear database assignment (mail merge)   446

Clearance (for borders)   104

Close (File)   580

Color  
of objects   319
of text   78

Color gradient (for objects)   319

Column break  
always before this paragraph   109
insert   166
options   109
show   111

Column chart   251

Column width (table)   223

Columns (multi-column page layouts)   166

Combine (object shapes)   310

Combine shapes   310

Command-line parameters   673

Comments   524

delete   526
edit   525
insert   525
next comment   527
previous comment   527
remove personal information   550
settings   527
show comments pane automatically   526, 527

Compatibility (document option)   605

Complex scripts   585

Compress (database)   427

Compress pictures   240

Computational functions   470

Conditional text (IF function)   465

Cone chart   251

Context menu   33

Continuous (view)   613

Contour (for frames)   314

Contour set   314

Convert (objects)   307

Convert embedded object into object frame   307

Convert frame into embedded object   307

Convert text into a table   230

Copy  
objects   69
text   69

Corners (in charts)   271

Correct first TWo UPpercase LEtters   393

Count characters   609

COUNT function   470

Count keystrokes   609

Count words   609

Create database   414

Create envelope   441

Create new database   414

Create new document   577

Creation date   183

Creation time   183

Cropping (of pictures)   242, 243, 335, 337

Cross references   508

Cross-references   508

Customize  
create user-defined icons   635
customize shortcut keys   635
customize toolbars   630
ribbon   620

Customize document display   613

Cut  
object   69
text   69
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Cylinder chart   251

D
Dark mode   588, 616

for document pages   616
for the user interface   588

Data labels (in charts)   260, 271

Data points (in charts)   271

Data series (in charts)  
add   255
delete   255
edit   271

Database   411
access record directly   423
append record   425
assign to a document   446
change structure   428
clean up database   427
clear assignment   446
close   428
create new, dBASE   416
create new, SQLite   414
delete record   427
edit record   425
form view   423
insert individual address in the document   163, 164
insert individual addresses in the document   431
list view   423
mail merge   444
open   412
operating the database module   419
restore record   427
save as SQLite table   425
search   424
select   450
select recipients   450
sort   427
table settings   428
use existing database   446

Database field   183

Database info (insert as field)   183

Date last changed   183

Date/time, insert  
as field   183, 189
as fixed text   189
define your own format   188
in headers and footers   119
in other language   188, 189
key combination   189

DAY function   470

dBASE/DOS format (database)   412, 416

dBASE/Unicode format (database)   412, 416

dBASE/Windows format (database)   412, 416

Decimal separator   605

Decimal tab   94

Default character formatting   85

Default character style "Normal"   85, 145

Default file format when saving   594

Default font   85, 145

Default language for spell check   372, 592

Default paragraph style "Normal"   156

Default paste option   585

Default program to open   597

Default template (document template)  
"Normal"   41, 165
change   41
switch   165

Default unit of measure   86, 588

Delete  
objects   69
table   216
text   39, 69

Design Science   296

Desktop mode (Android/iOS)   588

Dialog language   588

Dictionaries for spell check  
edit user dictionaries   381
export/import user dictionaries   602
install   642

Different first page   130

Different left-hand and right-hand pages   130

Display field names   183, 605

Display field names or field content   187

Display field names or field contents   605

Display of digits   585

Display warning when saving documents in text format  
594

Distribute (object)   307

Distribute columns evenly (table)   221

Distribute rows evenly (table)   221

Divider line, horizontal   568

DOC file format   565

Document check (remove personal data)   550

Document management   552

Document map in the sidebar   181

Document properties   605
Colors tab   608
Fonts tab   611
Form tab   610
Protection tab   562, 610
Review tab   527, 532, 611
Statistics tab   609
Summary tab   554, 605
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Document properties   605
View tab   605

Document protection   562

Document statistics   609

Document summary  
enter   554
insert as field   183
prompt for summary information when saving   594
remove on finalizing   550

Document tabs   33, 576

Document templates  
apply   164
change template folder   594
create   163
default template "Normal"   165
edit   164
insert address   163, 164
insert addresses   431

Document, close   580

Document, print   45, 538

Document, save   45

Documents, view side by side   578, 617

DOCX file format   565

Doughnut chart   251

Drag and drop   69

Draw circles   340

Draw connectors   340

Draw curves   340

Draw ellipses   340

Draw rectangles   340

Drawing object (dialog box)   345

Drawing object (ribbon tab)   343

Drawings   340
change properties   343, 345
combine   310
edit retroactively   312
group   308
insert   340
rotate   304, 318

Drop caps   101

Dropdown list frames (form object)   351, 363

Dropdown lists (form object)   351, 361

DTON function   470

Duden grammar check   388

Duden hyphenation   387

Duden Korrektor   386, 592

Duden Korrektor style check (only NX Universal)   390

Duden Korrektor, configure   390

Duden spell check   387

Dummy text, insert   574

Duplicate (objects)   306

E
Edit chart elements   266

axis title   281
chart area   268
chart title   282
corners   271
data labels   271
data series   271
error bars   271
floor   270
gridlines   283
legend   284
lines   271
plot area   269
trendline   275
up/down bars   271
walls   270
X axis   277
Y axis   278
Z axis   280

Edit color palette   608

Edit database   411, 412

Edit fields   186

Edit mode and object mode   301

Edit points (of objects)   312

Edit script   575

Edit shapes retroactively   312

Editing position (return to the last editing position upon
opening a document)   594

Editing position (return to the last one when opening)  
594

Effects (for objects)   323

Ellipsis ("...")   191

E-mail a document   549

En dashes, different widths   191

Enable OpenGL engine (Linux only)   597

Enable OpenGL for AutoShapes   597

Encryption   562

Endnotes   518
edit endnote   519
endnote mark   519
format endnote   521
go to endnote   519
go to endnote reference   519
insert endnote   519
options (position, numbering)   522
separator above endnote area   522

Enter key   38

Envelope, create   441
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EPUB export   546

Equation Editor   296

Error bar (in charts)   261, 271

Exit (file)   46

Export (other file format)   565

Export/Import of the settings   602

Extended support  
for Arabic text   570, 585
for Asian fonts   585

F
Field shading   187

File  
export as EPUB document   546
export as PDF   541
send by e-mail   549

File formats   565

File manager   555

File name   183

File path, show in title bar   588

File properties   605
Colors tab   608
Fonts tab   611
Form tab   610
Protection tab   562, 610
Review tab   527, 532, 611
Statistics tab   609
Summary tab   554, 605
View tab   605

File type   565

File versions   559, 596

File: Close   580

File: Exit   46

File: New   41, 163, 164, 431

File: Open   43, 164, 565

File: Print   45, 538

File: Print preview   537

File: Properties   605

File: Save   45

File: Save all   45

File: Save as   45, 163, 565

Fill (of objects)   319

Finalize (remove personal data)   550

First Character Uppercase   76

First line (indent)   87

Fixed distance   109

Flip (objects)   304

Floor (in charts)   270

Fold marks   136

Folder for file versions   559, 596

Font   75
bold   76
italic   76
underline   76

Font color   78

Font lists, hide fonts   600

Font size   75

Footers   117

Footnotes   513
edit footnote   514
footnote mark   514
format footnote   516
go to footnote   514
go to footnote reference   514
insert footnote   514
options (position, layout, numbering)   517
separator above footnote area   517

Footnotes and endnotes   513

Form field shading   349, 610

Form mode   349, 367, 610

Form objects   355
calculations   368
change tab order   366
edit   353
protect contents   366

Form objects, insert   352
checkbox frames   360
checkboxes   358
dropdown list frames   363
dropdown lists   361
groupboxes   363
labels   363
text field frames   358
text fields   355

Form view (database)   423

Format painter   82

Format URLs as hyperlinks   393

Formatting toolbar   28

Forms   348
create   351
example   353
fill   349
protect contents of form objects   366
protect forms   367

Formulas   467

Frame  
resize   318

Frames   298, 299
align and distribute   307
change margins   303
change order   305
change position   302, 314
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Frames   298, 299
change size   303
combine   310
convert   307
distribute   307
edit retroactively   312
group   308
insert   300
select   300

Freehand drawing   340

Full page (view)   615

Full screen mode (view)   616

Functions (in calculations)   470

G
German spelling reform   378, 592

Glow effect (for objects)   323

Go to   178, 181
bookmark   177
hyperlink   534

Grammar check   388

Grid and guides for objects   638, 639

Grid between table cells   223

Gridlines in charts   261, 283

Group (objects)   308

Groupboxes (form object)   351, 363

Guides   582

Guides for objects   639

Gutter   114

H
Hamburger menu   23, 25

Header and footer  
create   117

Header and footer (ribbon tab)   117

Headers and footers   117
alignment tabs   120
delete   124
different first page   124
different left and right pages   124
insert date/time   119
insert fields   120
insert page number   118

Heading list  
apply   482
create manually (advanced)   484

Headings   475
format   480
numbering   482

Help content, display (F1 key)   663, 667

Hide  
objects   308, 323
text   82

Highlighter   78

High-low chart   251

Horizontal line   568

Horizontal position (of objects)   314

Horizontal ruler   34, 582

HTML format   568

Hunspell dictionaries   592, 642

Hyperlinks (links)   393, 534
for objects   323
for OLE objects   292
format URLs as hyperlinks   393
in text   534
remove   534
to bookmark   534

Hyphen   383
non-breaking hyphen   191, 383
soft (optional) hyphen   383
soft hyphen   191

Hyphen, soft   582

Hyphenation  
non-breaking hyphen   383
set language   372
soft hyphen   383
use   383, 592
with Duden Korrektor   387

I
IF function   465, 470

Ignore words that start with a number   592

Images  
copy to document’s folder   237
insert   237
save within document   237

Import (other file format)   565

Import/Export of the settings   602

Indentation   87

Indents   87

Index   488
add keyword   488
create index   490
edit keyword list   489
format index   506
update index   505

Inner margins  
of text frames   328, 330
of text in AutoShapes   346

Inner text (Object properties tab)   346

Input method (Android)   30
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Insert  
bookmarks   177
breaks   210
calculations   456, 464
captions   494
characters   191
charts   246
comments   525
cross-references   508
date/time   119, 189
documents   72
drawings   340
envelope   441
equations   296
fields   183
form objects   352
headers and footers   117
lists/labels   436
objects   69, 300
OLE objects   289
pictures   237
SmartText entries   400
special characters   191
tables   212
text   69

Insert a document   72

Insert address into document   431

Insert break   210
chapter break   128
column break   109, 166
line break   111
page break   109, 114
section break   169, 206, 207

Insert characters   191

Insert database fields (mail merge)   447

Insert fields   183
calculation   183, 456
date/time   188
in headers and footers   120

Insert frames and drawings immediately   585

Insert mode / overwrite mode   36, 40
disable   585

Insert section break   169

Insert special characters   191

Installation   20
Android   22
iOS   22
Linux   22
macOS   21
Windows   20

INT function   470

Invoice.sqlite   462

Invoice.tmdx   462

iOS/Android  
context menu   33
input mode   30
select   68
share a document   549
unlock commands   30
unlock locked commands   16
user interface   30

Italic (font)   76

J
Justification (in text frames)   328, 330

Justify (paragraph)   92

K
Keep aspect ratio   318

Keep scaling   318

Keep together   109

Keep with next   109

Kerning   81

Keystrokes, count   609

L
Labels (for addresses)   436

Labels (form object)   351, 363

Landscape format   114

Language  
for spell check and hyphenation   372
for user interface   588

Last edited by   183

LEFT   460

Left (indent)   87

Left align (paragraph)   92

LEFT function   470

Legend (in charts)   262, 284

LEN function   470

Letter spacing   80

LibreOffice file format   565

Line break – insert manually   111

Line chart   251

Line numbers   207
are not displayed?   110
show   207
suppress   110, 207

Line spacing   89

Linear regression  
show trend in charts   275

Lines  
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Lines  
around paragraphs   104
as borders of objects   321
drawing   340
horizontal lines   568

Lines (in charts)   263, 271

Links (hyperlinks)  
for objects   323
format URLs as hyperlinks   393
in text   534
to bookmark   534

Links (OLE objects)  
edit   292
update   292

List   97, 193, 197
with bullets   97
with numbering   193, 197

List view (database)   423

Lists/labels (for addresses)   436

Live preview   588

Lock  
guides   605, 639
objects   304, 323
objects on the master page   126, 605

Logical field (database)   416

Lorem ipsum (insert dummy text)   574

LOWER function   470

Lowercase (all small letters)   76

LTRIM function   470

M
Mail merge   444, 454

assign database   446
clear database assignment   446
insert database fields   447
print   454, 541
sample letter   449
select recipients   450
select records   450
suppress blank spaces   454
view test records   448

Mail merge printing   541

Mail the document   549

Manage (button in the settings)   601

Manage styles   161

Manual (TextMaker)   18

Margins  
inner margins of AutoShapes   346
inner margins of text frames   328, 330
of objects   303
page margins   114

Markers for formatting marks   111, 582

Master pages (view)   126, 613

MathType   296

MAX function   470

Maximum number of undo steps   585

Memo field (database)   416

Menu bar   28

Menus with toolbars or ribbon?   23, 588

Microsoft Word file format   565, 594

Middle mouse button   585

MIN function   470

Mirror (objects)   304

Mirror margins (book printing)   114

MONTH function   470

Multi-column page layouts   166

N
Names (of objects)   306

Navigation area in the sidebar   181

New (File)   41, 163, 164, 431

New horizontal line   568

New program window   577

Non-breaking hyphen   191, 383

Non-breaking space   109, 191, 454

Non-printable characters, show   111, 582

Normal  
character style   85, 145
paragraph style   156

Normal.tmvx   41, 165

NTOD function   470

Numbered list   197
apply   198
change   201
create manually (advanced)   202

Numbering   193
headings   482
numbered lists   197
paragraphs   193
with auto numbers   206

Numeric field (database)   416

O
Object  

copy   69
cut   69
delete   69
insert   300
paste   69
select   66, 300
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Object (dialog box)   314, 330

Object mode and edit mode   301

Object properties  
change default settings   325
for charts   285
for checkbox frames   359
for checkboxes   359, 360
for drawings   343, 345
for dropdown list frames   361
for dropdown lists   361, 362
for footers   121
for groupboxes   364, 365
for headers   121
for labels   364, 365
for OLE objects   293, 295
for picture frames   337
for pictures   243
for tables   227
for text fields   356, 357
for text frames   328, 330
general properties   314

Objects   298, 299
align and distribute   307
caption   494
change name   306
change order   305
change position   302, 314
change properties   314
change size   303
combine   310
convert into embedded or frame   307
distribute   307
duplicate   306
edit retroactively   312
grid and guides for alignment   638, 639
group   308
hide   308
lock   304
print unprintable objects   605
resize   318
rotate   318
rotate or flip   304
show hidden objects   308, 605
show invisible objects   605
show OLE object guidelines   582
show text frame guidelines   582
ungroup   308

ODT file format   565

OLE object (dialog box)   295

OLE object (ribbon tab)   293

OLE object guidelines   582

OLE objects   289
change position and size   292
change properties   293, 295
edit   291

edit links   292
Equation Editor   296
insert   289
update links   292
warning when loading   585

Open (File)   43, 164, 565

OpenDocument file format   565, 594

OpenOffice file format   565

Operators (for calculations)   469

Optional hyphen   383

Order (of objects)   305

Ordinal numbers, add superscript (auto correction)   393

Orientation of the page   114

Other file formats   565

Outlines   475
outline level   108, 475
outline toolbar   475
outline view   476
select heading and content   479

Overflow mark   582

Overlapping objects   330, 346

Overwrite mode / insert mode   36, 40
disable   585

P
Page break  

always before this paragraph   109
insert   114
options   109
show   111, 114

Page count  
insert as field   183
of a selected section (status bar)   36
of the whole document (status bar)   36

Page formatting   113

Page margins  
set up   114
show in document   582

Page number   118, 130, 132
format   132
insert   118
insert as field   183
insert in headers and footers   118
status bar   36

Page setup   114
page format   114
page margins   114
page orientation   114
page size   114

Page thumbnails in the sidebar   34

Page width (view)   615
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Paper size   114

Paper tray   114

Paragraph alignment   92

Paragraph control   109

Paragraph format   86
Border tab   104
change character formatting   93
Drop caps tab   101
indentation   87
indents   87
line break   111
line spacing   89
paragraph alignment   92
paragraph spacing   91
Paragraph tab   87, 89, 91, 93
ruler   87
Shading tab   102
Tabs tab   94, 95
Text flow tab   109, 110, 383

Paragraph formatting   86
change   86
search and replace   176
transfer   82

Paragraph spacing   91

Paragraph styles   151, 161
apply   153
based on   156
change   154
create   151
default style "Normal"   156
sidebar   157

Password  
for documents   562
for forms   367

Paste copied content   69

Paste copied contents   70

Paste special   70

Pattern   102

PDF export   541

PDF/A, create   541

Photo frames   242, 309, 335

Picture (dialog box)   243, 337

Picture (ribbon tab)   242, 335

Picture frames   333
change properties   337
insert   237, 334

Pictures   236
caption   494
change position and size   239
change properties   243
change source   242, 335
compress   240
copy to document folder   334

copy to document’s folder   237
export   243
from scanner   238
insert   237
insert from the gallery/camera (Android/iOS)   239
recolor   242, 243, 335
rotate   318
rotate or flip   304
save within document   237, 334
select source   238
show or use placeholder   605

Pie chart   251

Pinned files   43

Pinned templates   41

Plain text file format   565, 567

Plot area (in charts)   269

Point (pt)   75, 86

Portrait format   114

Position (of objects)   302, 314

POW function   470

POWER function   470

Prevent hyphenation of words   109

Preview (of a document)   43

Print   538
file   45, 538
mail merges   541

Print date   183

Print page background   605

Print preview   537

Print time   183

Print unprintable objects   605

Printable (object property)   323

PROD function   470

Prompt for summary information when saving   594

Properties (document)   605
Colors tab   608
Fonts tab   611
Form tab   610
Protection tab   562, 610
Review tab   527, 532, 611
Statistics tab   609
Summary tab   554, 605
View tab   605

Properties (object)  
for charts   285
for checkbox frames   359
for checkboxes   359, 360
for drawings   343, 345
for dropdown list frames   361
for dropdown lists   361, 362
for footers   121
for groupboxes   364, 365
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Properties (object)  
for headers   121
for labels   364, 365
for OLE objects   293, 295
for picture frames   337
for pictures   243
for tables   227
for text fields   356, 357
for text frames   328, 330

Properties (objects in general)  
change default settings   325
general properties   314

Protect  
contents of form objects   366
documents   562
forms   367
text   83

Pyramid chart   251

Q
QR code, generate   369

Quick access toolbar   25
change position   588, 624
customize icons   624

Quick paths   552

Quotes, smart  
search   174
use   393

R
Radar chart   251

Rand (insert dummy text)   574

Random text, insert   574

Read aloud   409

Record number   420

Redo   40

Redo (changes)   40

References   508, 510

Reflection effect (for objects)   323

Remove personal data (Finalize)   550

Repeat search   173

Repeat table row   222

Replace   174
formatting   176
text   173

Replace again   173

Research via the Internet   406

Reset  
character formatting   84, 144
PDF export options   541

picture settings   242, 335
ribbon   620
search dialog   174
SoftMaker Office settings   602
toolbars   629

Revert to previous version (file)   559

Review documents   524

Ribbon   16
create user-defined icons   635
customize   618
customize groups   620
customize icons   620
list of all ribbon commands and menu commands  
645
manage   620
reset   620
show/hide   619
user interface   25, 588, 618

Ribbon or menus with toolbars?   23, 588

RIGHT   460

Right (indent)   87

Right align (paragraph)   92

RIGHT function   470

Rotate  
axis labels   277, 278, 280, 282
drawings   318
objects   304, 318
pictures   318
text in AutoShapes   346
text in text frames   328, 330

Rotate or flip (objects)   304

ROUND function   464, 470

Row height (table)   222

Row properties (table)   222

RTF file format   565, 594

RTRIM function   470

Ruler   34
for indents   87
for tabs   96
show   34, 582, 613

S
Save (File)   45

Save all (File)   45

Save as (File)   45, 163, 565

Scale document   588

Scan pictures   238

Scribble mode on iOS   30

Scripts   575

Scroll synchronously through two documents   617

Scrollbars, show   582
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Search   171
files   556
formatting   176
go to   178
in bibliography databases   500
in databases   424
text   172

Search (advanced search options)   174

Search (file manager)   556

Search again   173

Search and replace   171

Search files (file manager)   556

Search with the sidebar   179

Section (by section break)  
adding line numbers   207
multi-column page layouts   166, 169
restart auto number   206

Select  
always select whole word   585
in the Android/iOS version   68
object   66, 300
records in the database   450
table   215
text   66

Select all   66, 301

Select chart elements   266

Select recipients (mail merge)   450

Select records  
by condition   452
by record numbers   451
current record   451
deselect all records   451
invert selection   451
select all records   451

Select whole words when selecting   585

SELX files   411

Send a document by e-mail   549

Send backward one level (object)   305

Send to back (object)   305

Sender   183, 585

Sequence number (field)   183, 494

Series axis (in charts)   258, 280, 282

Set as default  
character format   85
document template   41
object properties   325

Set left and first-line indent  
with Tab and backspace keys   585

Settings (SoftMaker Office)  
export/import   602
reset   602

Settings (TextMaker)   581, 582

Appearance tab   588
Backup tab   596
Files tab   594
Fonts tab   600
General tab   585
Language tab   592
System tab   597
View tab   582

Shade   102

Shade fields   187, 605

Shading  
of paragraphs   102
of table cells   223

Shadow (for objects)   321

Share a document (via Android/iOS and via Windows
10 and higher)   549

Shortcut keys  
[export/import   602
customize   635
for character styles   140, 142
for paragraph styles   151, 153
for special characters   191
predefined shortcuts: Mac   663
predefined shortcuts: Windows/Linux   663
view list of all shortcut keys   635

Show chapter break   111, 128

Show fonts in font list   588

Show formatting marks   111, 114, 582

Show full path in title bar   588

Show hidden files and folders   597

Show hidden objects   605

Show hidden text   82, 605

Show invisible objects   308, 605

Show line break   111

Show merge record   605

Show multiple pages side by side   582

Show non-printable characters   111

Show paragraph marks   111, 582

Show section break   111

Show spaces   111, 582

Show tooltips  
for changes   532
for commands   588
for Duden Korrektor   390

Show unprintable characters   582

Show warning when loading OLE objects   585

Show/hide chart elements   257
axes (X, Y, Z)   258
axis title   258
chart title   259
data labels   260
error bars   261
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Show/hide chart elements   257
gridlines   261
legend   262
lines   263
trendline   264
up/down bars   265

Show/hide keyboard automatically   597

Sidebar  
for character styles   147
for document map (navigation)   181
for page thumbnails   34
for paragraph styles   157
for search function   179

Sidebars (view)  
functions   34
show   34, 613

Size (of objects)   303, 318

Small caps   76

Smart quotes  
search   174
use   393

SmartChat   407

SmartText   400
export/import   602

SmartText entries  
create   400
edit   402
expand   393
insert   401
replace automatically   401

Smooth edges of pictures   597

Smooth edges of screen fonts   588

Snap to grid   638

Snap to guides   639

Snap to other objects   639

Snap to page margins   639

Snapshots (backup copies)   559, 596

Soft edges effect (for objects)   323

Soft hyphen   191, 383, 582

SoftMaker Basic   575

SoftMaker Equation Editor   296

SoftMaker support   18

Sort  
databases   427
tables   232
text   233

Sort text/table   111, 233

Source for picture files   238

Space, non-breaking   109, 454

Spaces, different widths   191

Speak   409

Spell check   375
edit user dictionaries   381
in the background (as you type)   377, 592
install additional dictionaries   642
manual   375
set language   372
with the Duden Korrektor   387

SQLite format (database)   412, 414

SQRT function   470

Standard (view)   613

Standard toolbar   28

Start script   575

Statistics (of document)   609

Status bar   36
show/hide   588

Stock chart   251

STR function   470

Strikethrough   76

STRING function   470

Style reference (field)   183, 510

StyleRef field   510

Styles   139, 161
character styles   140
paragraph styles   151
table styles   228

Subscripts   79

SUBSTR function   470

SUM function   460, 470

Superscript of ordinal numbers (auto correction)   393

Superscripts   79

Support   18

Surface chart   251

Synchronized scrolling for two documents   617

Synonym dictionary (thesaurus)   403

System requirements   19

T
Tab alignment   94

Tab leaders   94

Tab stops   95

Table   211
AutoFormat   228
cell properties   223
cell width   223
change position   227
convert table into text   229
convert text into a table   230
delete   216
delete cells   216
delete, copy, move cell contents   216
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Table   211
distribute columns evenly   221
distribute rows evenly   221
format   221, 222, 223, 228
insert   212
insert cells   217
merge   220
merge cells   220
move   212
move within body text   227
repeat header row   222
row height   222
row properties   222
select   215
sort   111, 232
split cells   219
split table   220
table properties   227
table styles   228

Table (dialog box)   227

Table (ribbon tab)   213

Table guidelines, show   582

Table of contents  
create   492
format   506
update   505

Table of figures   493
create   496
format   506
update   505

Tablet mode (Android/iOS)   588

Tabs   94
delete   95
move   95
show   582

Tabs for documents   33, 576

Tabs, close   580

Technical support   18

Template folder for document templates   594

Templates  
document templates   163, 565

Text  
copy   69
cut   69
delete   69
hide   82
highlight   78
paste   69
protect   83
select   66
show hidden text   82

Text (Object properties tab)   347

Text alignment  

of paragraphs   92
of table cells   223

Text cursor   38

Text direction   570, 571, 572

Text field frames (form object)   351, 358

Text fields (form object)   351, 355

Text file format (database)   446

Text flow (for frames)   314

Text frames   327
add/edit text   342
change properties   328, 330
change text area   332
insert   328
link   332
show text frame guidelines   582

Text styles   76

Text width (view)   615

Text wrapping   314

Text, translate   405

TextArt objects  
change properties   347
drawing   340
transformation   347

TextMaker  
basics   38
customize   581
set as default program   597
settings   582
user interface   23

TextMaker basics   38

TextMaker file format   565

TextMaker manual   18

TextMaker tour   47

TextMaker/DOS file format   565

Thesaurus   403
set language   372
use   403

Time   183

Time last changed   183

Time, insert  
as field   183
as fixed text   189
in headers and footers   119
key combination   189

Title bar   24

TMBAK files   559

TMD file format   565

TMDX file format   565

TODAY function   470

Toolbars for Android/iOS  
customize   30
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Toolbars for Android/iOS  
user interface   30, 588

Toolbars for classic menus  
create user-defined icons   635
customize   626, 630
delete   629
locked   628
manage   629
position   628
rename   629
reset   629
show/hide   626
user interface   28, 588, 626
visible in mode   626

Touch mode   588

Transformation (of TextArt objects)   347

Translate text   405

Transparency (of pictures)   243, 337

Trendline (in charts)   264, 275

TRIM function   470

TRUNC function   470

Two full pages (view)   615

U
Underline (font)   76

Underline old German spellings in blue   379, 592

Undo (changes)   40

Ungroup (objects)   308

Unicode databases   412, 416

Unit of measure   86, 588

Unpinned files   43

Unpinned templates   41

Up/down bars (in charts)   265, 271

Update fields   183, 186, 465

Updates   597

UPPER function   470

UPPERCASE (all capital letters)   76

Use existing database   446

Use left Alt for shortcut keys   585

Use placeholders (for pictures)   605

Use SHM extensions   597

Use system file dialogs   588

Use XIM   597

User dictionaries  
edit   381
export/import   602

USER function   470

User info   183, 585

User interface (ribbon or menus?)   23, 588

User interface on Android/iOS   30, 588

User interface size   588

V
VAL function   470

Value axis (in charts)   258, 278

VBA scripts   575

Version management   559, 596

Vertical alignment  
of page   130
of text fields   356
of text frames   328, 330
of text in AutoShapes   346

Vertical position (of objects)   314

Vertical ruler   582

View  
book layout   613
continuous   613
edit mode   301
form mode   349, 367
full screen   616
grid and guides   638, 639
magnifying glass   615
master pages   613
object mode   301
outline   476, 613
ruler   613
sidebars   34
standard   613
touch mode   588
windows   578
zoom   615
zoom level   615

View side by side (two documents)   578, 617

Visible (object property)   323

Visual Basic   575

W
Walls (in charts)   270

Watermark   126

Whole word, select   585

Widows/orphans, avoid   109

Window  
close all   580
view side by side   578, 617

Word file format   565, 594

Words, count   609

Workspace color   588

Wrap text to window   582
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X
X axis (in charts)   258, 277

XY scatter chart   251

Y
Y axis (in charts)   258, 278

YEAR function   470

Z
Z axis (in charts)   258, 280, 282

Zoom (view)   615

Zoom level (view)   615

Zotero bibliography   503
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